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R12 New Functionality (Draft) 

R12 Functionality Enhancements 

This DRAFT documentation is provided as an overview for new or enhanced functionality provided in 
the R12 Open Enterprise system.  This document currently covers most new features provided up to 
the patch V12-015-2HF level. 

Important Note 

Please note that some modifications and enhancements may require licensing and specific 
configurations and setup, and additional training by CMiC Consultants may be required.  For more 
information, please contact your Account Manager/Project Manager. 
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1099 

Added 1099-NEC & Modified 1099-MISC (20.29519) & (21.36582) 

Overview: 

Added 1099-NEC, which is introduced by IRS in the year 2020. This is for reporting Non-Employee 
Compensation and Non Employee Compensation is no longer reported in 1099-MISC. 

Modifications: 

1. 1099- NEC 

a. Beginning with tax year 2020, IRS recommends use of Form 1099-NEC to report Non-
Employee compensation. 

2. 1099- MISC 

a. Due to the creation of Form 1099-NEC, IRS has revised Form 1099-MISC and rearranged 
box numbers for reporting certain income. 

Setup and Processing - 1099-NEC 

Form Codes 

Insert a record and select 1099-NEC from the dropdown menu. 
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Accumulator Codes 

Setup Accumulators as required. Here in this example, the accumulator codes are for most 1099 
Form types such as 1099-MISC & 1099-NEC. 

 

Accumulator Codes 

Under Box codes and Minimums, select 1099-NEC and add the below box numbers as shown. These 
codes/Box Number List are newly created for the purpose of using 1099-NEC. 

Also enter any minimum amounts as required. 
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Box Code / Accumulator Relations 

Maintain the Box/Accumulator relation as per the user setup. 

Please note that this may differ based on the user setup. Below screenshot is an example. 
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Process 

Perform the following process in steps as required. 

1. Maintain Payer Info for 1099-NEC 

2. Update Checks if required 

3. Update/Create 1099 Info for the required Year (Mandatory Requirement) 

4. Adjust 1099 Vendor Balances, if required 

5. Create 1099 working files (Mandatory Requirement) 

6. Edit 1099 Working Files, if Required. This may be performed to adjust the amounts for reporting. 

7. Print 1099 (Jasper Report if printing on IRS Form) 

8. Create Media Files (XML Output if using ‘Greenshades’ to file 1099 reporting to IRS) 

 

Printing 1099-NEC (Jasper Report) 
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Creating Media File for 1099-NEC (XML Output) 
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Changes to 1099-MISC 

As per the new changes to 1099-MISC, the Non-Employee compensation info (Box 7) is no longer a 
part of the MISC form. This has been removed. The form for 2020 has the following changes. 

• Box#7  -  Payer made direct sales of $5,000 or more (Check Box) 

• Box#9  -  Crop insurance proceeds 

• Box#10 - Gross proceeds to an attorney 

• Box#14 - Nonqualified Deferred Compensation 

Users must make the following changes in CMiC to their existing 1099-MISC setup. 

1. Navigate to Box Codes and Minimum (N1099MIN) 

a. Select 1099-MISC as the form code, select box 7 and delete the entry, as Non-Employee 
compensation is no longer a part of 1099 Misc. form and ‘Save’. 

b. CMiC created a new box code ‘D: Nonqualified Deferred Compensation’, for reporting in 
Box#14. If required, create this new entry, and set any maximums and ‘Save’. 

2. Navigate to Box/Accumulator Relations (N1099BOX) 

a. Select 1099-MISC as the form code, select Box 7 if exists, and delete the entry and ‘Save’. 

b. Add Entry ‘D’, if required to report Nonqualified Deferred Compensation and ‘Save’ 
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The following screens show the entries for 1099-MISC after corrections: 
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Printing 1099-MISC (Jasper Report) 
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Creating Media File for 1099-MISC (XML Output) 

 

NOTE: The accumulator codes, box codes and minimums and the relationship are setup for testing 
purposes and are indicative only. Users must setup as per their business requirements and as 
referred to IRS documents. 

1099 – Name Printing Order in Jasper Report & XML Output 
Standardization (20.20874) 

The ‘Recipient’s Name’ in 1099 forms Jasper printout and in XML Output file are programmed to be 
identical and match each other. 

CMiC supports printing of two names and in different orders as per the client’s settings in AP Control 
File and Business Partner Maintenance screens. 

Check List of settings and their descriptions: 

There are three phases of development regarding the 1099 Recipient’s Name Printing in 1099 and 
are described below in the chronological order. 

1. Business Partner Maintenance > SSN Flag (Original Implementation in CMiC 1099 application) 

a. Un-Checked:  

i. The Registration Number can be of any length 

ii. Business Partner AKA Name may be left blank 

iii. The 1099 Jasper Report & XML output will print the names in the following order 
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1. Name1: Business Partner Name 

2. Name2: Business Partner AKA Name 

b. Checked:  

i. The Registration Number must be of 9 digits long 

ii. Business Partner AKA Name must be populated in order to successfully print 
1099 reports 

iii. The 1099 Jasper Report & XML output will print the names in the following order 

1. Name1: Business Partner AKA Name 

2. Name2: Business Partner Name 

2. Business Partner Maintenance > 1099 Print Name (Name to Print on 1099 to substitute AKA 
Name – Implemented in the year 2008 under issue# 08.25961) 

a. This field is hidden by default. When required, users may unhide using the Lite Editor  

b. This is a free form field and users may enter a Business Partner Name as required 

c. When this field is populated, then  

i. BP AKA Name will be substituted (replaced) with this ‘1099 Print Name’ 
value. 

3. AP Control File Settings > Other > 1099 Controls > Print Business Partner Legal Name 
(Implemented in the year 2015, under issue# 14.95789) 

a. Un-Checked: 

i. Business Partner Legal Name will NOT be used/printed in 1099 Report/XML 
output 

b. Checked: 

i. Business Partner Legal Name will be printed as First Name  

The following tables show the results of printing Name1 and Name2 as per the three different logics 
defined above. 

 

SSN Flag and the Name1 & Name2 printing in Jasper Report and XML File output 

 

SSN Flag and 1099 Print Name value and the Name1 & Name2 printing in Jasper Report and XML File output 
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AP Company Control > Other > 1099 Controls >Print Business Partner Legal Name on 1099s = Y (Checked) 

NOTE: There is no change to the name printing and their order. The discrepancies in some scenarios 
above are corrected and the XML output is adjusted exactly as per the Jasper Report. 

Accounts Payable 

Add Payee Name to the positive Pay File (15.09595) 

Overview: 

CMiC has modified the existing Wells Fargo Positive Pay Format and populate Payee Name 
when creating Positive Pay File. 

Settings and examples:  

The Positive Pay File format is compliant to the Standard ARP Inbound Specification: 
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Example 1:  Create 3 checks to the different payees and then create The Positive Pay File: 
 
1.1. Create 3 vouchers for the following vendors: for ZZ-ACME ($118.33); ZZ-BCBS($222.22); ZZ-

HDEPO($321.67): 
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1.2. After selecting payment, preparing, printing, and posting the checks go to Account Payable -> Check -> 

Positive Pay Register -> Create Bank Group. Make sure that the bank group exists and Include Void 

check box is checked: 

 
 
1.3. Go to Account Payable -> Check -> Positive Pay Register -> Create Register 

And press [Process] button.  
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Note: If you would like to see new items only please check the Include New Items Only check box. 
 

1.4. The created Positive Pay File will look like: 

 
 
The file includes the payee names equivalent to the names on the vouchers and checks. 
 
Note:   According to the Standard ARP Inbound Specification the code 320 indicates that these are Check 
Register items. The next example will show how this code is changed when the checks are voided. 
 
Example 2:  Create The Positive Pay File with 3 cancelled checks. 
 
2.1. Create additional voucher for ZZ – Acme Supply for $827.51 
2.2. After posting the check void newly created check and the check for Acme Supply created in the Example 
1 (for $118.33). 
2.3. Create Register (Include New Items Only check box should be unchecked). 
2.4. The created Positive Pay File will look like: 
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The file includes the payee names equivalent to the names on the vouchers and checks. 
 
Note:   According to the Standard ARP Inbound Specification the code 320 indicates that these are Check 
Register items and the code 370 indicates the Cancelled Register.  
 

Bancomer Payment File Modification – Interbank Payments (15.09039) 

Overview: 

CMiC has modified the Bancomer Format to identify transactions as International Payments 
when the type of payment is "PSC" and “OPI”.  

When the Payment Type is "PSC" then the system will pick up vouchers that have the following 
conditions: 

- Cash Account Bank different from the Vendor Bank 

- Cash Account Bank Country is same as Vendor Bank Country 

- Voucher Company Currency is same as Vendor Currency 

 

When the Payment Type is "OPI" then the system will pick up vouchers that have either 

- Cash Account Bank different from the Vendor Bank 

- Cash Account Bank Country different from the Vendor Bank Country 

- Voucher Company Currency is same as Vendor Currency 

OR 

- Cash Account Bank different than the Vendor Bank 

- Cash Account Bank Country different from the Vendor Bank Country 

- Voucher Company Currency different from the Vendor Currency. 

 

The modifications have not affected the following existing logic: when the Payment Type is 
“PTC” then the system will pick up vouchers that have Cash Account Bank the same as the 
Vendor Bank. 
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SETTINGS and EXAMPLES: 

Conditions 1: Cash Account Bank is the same as the Vendor Bank 

Company ZZ has the following Cash Accounts (Account Payable-> Setup -> Global Tables -> 
Banking -> Bank Account) 

 
 

The vendor ASCCONT has the following settings (Account Payable-> Setup -> Vendor 
Maintenance -> press [Accounting] button): 
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In this setting vendor ABSCONT and company ZZ both have BOA banks. 

The resulting EFT file starts with PTC: 

 
 

Conditions 2: 

- Cash Account Bank different from the Vendor Bank 

- Cash Account Bank Country is same as Vendor Bank Country 

- Voucher Company Currency is same as Vendor Currency 

 

Change bank for vendor ABSCONT: 
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HSBC bank, HSBC branch (Account Payable -> Setup -> Global Variables -> Banking -> Branch 
Maintenance -> press Address button) has country “US”; the address of the Company ZZ Cash 
account 1000.100.7365465 (Bank BOA, branch 01001) has also “US” as a country code. 

The setting also shows that both vendor and the company have the same currency US, and they 
are using different banks.  In this case EFT file will start with ‘PSC’: 

 

 
 

Conditions 3: 

Setting 3.1. 

- Cash Account Bank different from the Vendor Bank 

- Cash Account Bank Country different than the Vendor Bank Country 

- Voucher Company Currency is same as Vendor Currency. 

New setting: for Company ZZ department 00 and G/L account 1000.100.7365465 (corresponds 
to the branch with the address = ‘US’); change the bank for the vendor ABSCOUNT to 
MEXBANK – the address for the bank for vendor ABSCOUNT is ‘MX’). 
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EFT file will start from ‘OPI’: 

 
 

Setting 3.2. 

- Cash Account Bank different from the Vendor Bank 

- Cash Account Bank Country is the same as the Vendor Bank Country 

- Voucher Company Currency is different from Vendor Currency 

In this case the vendor ABSCOUNT is set up to use CAN $ as currency through the HSBC bank. 

  
 

The Bank Branch address for the vendor could be verified in Account Payable -> Setup -> 
Global Variables -> Banking -> Branch Maintenance and press Address button. In this case the 
country of the branch is US. 

The company ZZ has US currency. Company ZZ also has a CAN cash account in the CITI bank, 
CITI branch: 
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After the verification of the  CITI bank, CITI branch address (Account Payable -> Setup -> Global 
Variables -> Banking -> Branch Maintenance -> press Address button), it is established that the 
country code for this branch is US, the same as for HSBC bank for the vendor ABSCONT). 

In this case the EFT file will also start with OPI: 

 

Ability to query AP invoices by Department in Voucher/Registry 
Query (15.09770) 

Overview: 

CMiC has modified the Voucher/Registry List screen: the new Department field has been added 
to provide a new parameter to the query – Department Code. When this parameter is specified, 
only vouchers/registered invoices with the same department code on the header will be shown.  

CMiC has also introduced additional functionality: either Job or Vendor values must be entered 
in order for the query to take place. 

Modifications: 

Department field is added to the Voucher/Registry List 

Treeview Path for the screen: Account Payable -> Query -> Registry/Invoice Query 
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If the user enters an existing Department Code into the Department field or select the value from 
the Department List the program will retrieve all the vouchers and registered invoices that have 
this department code defined as the Expense Department Code. 

Additional functionality  

Either Job or Vendor value must be entered in order for the query to take place. If the user does 
not enter either Job, or Vendor and press [Query Data] button, the program will issue the 
following alert in a pop-up window: “Alert: Either Job or Vendor must be entered”. 

In this case the user has to press OK button on the alert popup window and return to 
Voucher/Registry List screen. 

Allow securing Check Release All/Unrelease All buttons (15.11066) 

Overview: 

CMiC has added a new negating privilege to disable the [Release All/Unrelease All] buttons on 
the AP Check Release program. If the privilege is given to a User, then the Release Check 
program will disable the buttons; otherwise the existing functionality is intact. 

NOTE: If enabled the button [Release All/Unrelease All] changes the name upon a click. If the button 
is disable the name by default stays as [Release All].  

Modifications: 

CMiC has created a new negative privilege CHQRELBT. If given to a User, then this user will 
have the button [Release All/Unrelease All] disabled on the Release Check program screen.  

 

Settings and Examples: 

1. User DA has the privilege CHQRELBT assigned: 
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For the User DA the Release Check program screen will disable the button [Release All/Unrelease 
All]. As noted above the name of the button, if disabled, stays as [Release All]. 

The button [Released] is intact – enabled and fully functional. 

 
2. The User Irina2 does not have the negative privilege CHQRELBT assigned. 
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For the User Irina2 the Release Check program screen enables the buttons [Release All/Unrelease 
All]. 

All buttons on the screen are fully functional. 

Business Partner AKA name fields (14.95789) 

Overview: 

CMiC has introduced a new flag “Print Business Partner Legal Name” on AP Control File. This 
flag allows the users to choose whether AKA Name or Business Partner Legal Name will be 
printed on 1099s Reports. 

If this flag is unchecked the system will print the 1099s Reports as before using both Business 
Partner Name as well as AKA Name in the following fashion: 

• If the SSN box is un-checked then the system will use the Business Partner Name as the 
1st line followed by AKA name on 1099 Reports.  

• If the SSN box is unchecked and AKA Name does not exist, then the system will use the 
Business Partner Name on 1099 Reports.  

• If the SSN box is checked then the system will use AKA Name as the 1st line followed by 
the Business Partner Name on 1099 Reports. 
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Modifications: 

The new flag “Print Business Partner Legal Name” is located on the  tab of AP Control 
File: 

 

 

New functionality:  

If the flag “Print Business Partner Legal Name” is checked on the AP Control File then, while 
printing 1099 Report, the system will replace the 1st line with Business Partner Legal Name (or 
empty line if Business Partner Legal Name is not entered).  

For the Business Partners above the 1099s Report will print the following: 

• If the SSN box is un-checked, then the system will use the Business Partner Legal Name 
as the 1st line followed by AKA name on 1099 Reports.  

• If the SSN box is checked then the system will use the Business Partner Legal Name as 
the 1st line followed by the Business Partner Name on 1099 Reports. 

• If the SSN box is unchecked and AKA Name is not entered, then the system will use the 
Business Partner Legal Name as the 1st line and the 2nd line remains empty on 1099 
Reports.  
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Example: 

1. Business Partner IH01US has SSN flag unchecked; AKA Name entered (“IH01US company 
AKA”); Legal Name is “IHUS Partner 01 Legal”. 

2. Business Partner IHBP1490 has SSN flag unchecked and no AKA Name entered; Legal Name is 
“IHBP1490 Legal”. 

3. Business Partner IHBP1462 has SSN flag checked and AKA Name entered (in this case AKA 
Name is mandatory). AKA Name is “IHBP1462 AKA”, Legal Name is “IHBP1462 Legal”. 

The 1099s Report will print the following: 
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Invoice Series Code on Adjust Voucher Status (15.12502) 

Overview and Modification: 

CMiC has modified the Adjust Voucher Status Program to add the display only Invoice Series 
Code and Discount Amount fields from the Voucher Header populated as a column on both 
Normal Vouchers and Deferred Vouchers Tabs.  

NOTE: This change is for ADF only. 

AP Invoice Date and Posting date on Same Date (16.14829) 

The AP Invoice Posting program has been modified to use the Invoice Date as the Voucher Posting 
Date (the Date of Record) based on the AP Control File flag “Invoice Date Is Voucher Post Date”. The 
system will prevent the posting if the Invoice Date is in a closed period.  

This new functionality is available to all invoices regardless if they were manually entered, or came 
through the imaging system or from the Invoice Register. If the flag “Invoice Date Is Voucher Post 
Date” is unchecked the system works as before: it uses the Batch Posting Date as the official Date of 
Record. 

NOTE: No other transaction types, such as Debit/Credit Notes, Manual Checks, or Invoice 
Adjustments have been modified to alter the Date of Record in such a way. They all continue to use 
the Date of Record as associated with the Batch. 

Setting: 

In order to set up the system to use the Invoice Date as the Voucher Posting Date the user first 
should check the flag “Invoice Date Is Voucher Post Date” in AP Control File: 
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New functionality summary: 

The AP Invoice Posting program has been modified. The new flag “Invoice Date Is Voucher Post 
Date” has been introduced to AP Control File. 

If the flag “Invoice Date Is Voucher Post Date” is checked the system will use the Invoice Date 
as the Voucher Posting Date (the Date of Record). The system will validate the Invoice Date and 
prevent the posting if the Invoice Date is in a closed period.  

If the flag “Invoice Date Is Voucher Post Date” is unchecked the system works as before: it uses 
the Batch Posting Date as the official Date of Record. 

Limit the Alternate Address selection for AP (15.11860) 

CMiC has added a new flag in System Options “Display Only Remit to Addresses for Alternate 
Address Codes”. When this flag is checked the AP Voucher Entry, AP Recurring Entry, AP Invoice 
Registry, Enter Subcontract/Change Order would validate the List of Values for Alternate Addresses 
and display only the Alternate Addresses that are marked as "Remit To". 

Settings and Examples for ADF (based on example in V10_x standard environment): 

 

1. In order to activate this new functionality, the user has to check the flag “Display Only Remit To 
Addresses For Alternate Address Codes”. The flag could be found in System -> Setup -> System 
Option -> Financials Tab). 
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2. The Business Partner IH-PC has been selected to demonstrate the new functionality. The 
Business Partner IH-PC settings include 4 alternate addresses. The alternate addresses with 
Address Codes IH001, IH002 have the “Remit To” flag checked while the alternate addresses 
with Address Codes IH003, IH004 have this flag unchecked. 

Register Invoice screen (Treeview path: Account Payable -> Voucher -> Register Invoices): 

A Register Invoice INV001 has been created for the Vendor IH-PC. In accordance with the 
System Option settings (paragraph 1) the Address Code LOV for the Register Invoice shows 
only the Address Codes IH001, IH002 which have the “Remit To” flag checked. 

 

 
 

If the user manually types in any of the existing alternate address codes that do not have the 
“Remit To” flag checked (such as IH003 or IH004 for this example) and try to save the record the 
system will issue the validation error: “Only alternate address codes are allowed that are marked 
as Remit To”: 
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The same functionality will be demonstrated for AP Voucher Entry, AP Recurring Entry, and 
Enter Subcontract / Change Order further in this document. 

 

Enter Voucher screen (Treeview path: Account Payable -> Voucher -> Enter Vouchers): 

A sample invoice IHINV009 has been created for the Vendor IH-PC. According to the System 
Option Settings (paragraph 1) the Address Code LOV shows only the Address Codes IH001, 
IH002 which are marked as “Remit To”. 

 

If the user types in an existing alternate address code that is not marked as “Remit To” (such as 
IH003 or IH004 for this example) and attempts to save the record the system will issue the 
validation error: “Only alternate address codes are allowed that are marked as Remit To”: 
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Setup Recurring Entries screen (Treeview path: Account Payable -> Voucher -> Process 
Recurring Entries): 

A sample Recurring Invoice has been created for the Vendor IH-PC. According to the System 
Option Settings (paragraph 1) the Address Code LOV shows only the Address Codes IH001, 
IH002 which are marked as “Remit To”. 

 

The print screen below demonstrates the validation error occurred when the user had tried to 
save a record with typed-in existing alternate address that is not marked as “Remit To” (“IH004” 
in this example).   
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Subcontract Maintenance screen (Treeview path: Subcontract Management -> Contracts -> 
Enter Subcontract/Change Order):  

A sample subcontract 009 has been created for the Vendor IH-PC. As in the previously 
described screens the Address Code LOV shows only the Address Codes IH001, IH002 which 
are marked as “Remit To” in accordance with the System Option settings (see the paragraph 1). 

 
 

Note: This alternate address LOV limitation is not applicable for the Corresp. Address LOV (the 
field Corresp. Address locates right below the field Address on the picture above). LOV for the 
Corresp. Address will show all four Address Codes: IH001, IH002, IH003, and IH004.   

The print screen below shows the validation error when the user had tried to save a record with 
an existing alternate address that is not marked as “Remit To” (“IH003” in this example).   
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The same functionality has been introduced for the corresponding screens in FORMS (AP 
Invoice Registration Form; AP Voucher Entry Form; AP Recurring Voucher Setup Form; PM – 
Enter Subcontract/Change Order Form; Enter Subcontracts and Changes) and PM JSP 
Subcontract Entry screen. 

New Functionality Summary: 

CMiC has added a new flag in System Options “Display Only Remit to Addresses for Alternate 
Address Codes”. When this flag is checked the AP Voucher Entry, AP Recurring Entry, AP 
Invoice Registry, Enter Subcontract/Change Order for both ADF and FORMS would validate the 
List of Values for Alternate Addresses and display only the Alternate Addresses that are marked 
as "Remit To". The same functionality is also applicable to PM JSP Subcontract Enter screen.  

In addition to the existing LOV validations the system issues one more: if the user types in an 
existing alternate address code that is not marked as “Remit To” and attempts to save the record 
the system will issue the validation error: “Only alternate address codes are allowed that are 
marked as Remit To”: 

Override Unit Price on Receiver Entry Screen (15.07393) 

Overview: 

CMiC has introduced a new privilege “MSMROPDPRC” to allow the user to override the Item 
Price field on Enter Receipt screen (APMATERIALRECEIPT). In the meantime, the changes 
described below are applicable to FORMS only.  

Settings and Examples: 

 
1. The Enter Receipt screen could be accessed either from Material Management or Account 

Payable. 
 

To access the program from the Material Management: 
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To access the program from the Account Payable: 

 
 

The both paths lead to the same form – APMATERIALRECEIPT: 
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2. The new privilege “MSMROPDPRC” should be assigned to the user in order to enable him to 
override the price field on the receipt. Otherwise, the price field will be disabled. 

 

Example 2.1:  The privilege “MSMROPDPRC” is not assigned to the user. 
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In this case the Price field on the Material Receipt Entry form is disabled and could not be 
overridden by the user: 
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Example 2.2:  The privilege “MSMROPDPRC” is assigned to the user. 
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In this case the Price field on the Material Receipt Entry form is enabled and could be overridden 
by the user: 
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New functionality summary: 

The new privilege “MSMROPDPRC” allows the user to override the Item Price field on Enter 
Receipt screen (APMATERIALRECEIPT). 

Select Payments Neglects to Remove Invoices (16.16305) 

Overview: 

CMiC has modified the Payment Selection program and add a new alert message that would 
display the total amount and the invoices remaining in the Payment Selection Code. This new 
alert message will only be displayed if the payment selection includes the Vouchers with posting 
date after the payment date, and the user decides to exclude these vouchers from the Payment 
Selection. The changes are applicable only to the FORMs. 

Summary: 

The AP payment selection program has been modified. The new alert message has been 
introduced. If the Payment Selection Code has included the vouchers that have their posting 
date after the payment date and the user decides to remove those vouchers from the payment 
selection, the new message displays the number and total amount of the remaining vouchers. 

 

New EFT Format for RBC (15.03984) 

CMiC has created a new EFT file format for RBC to match the following specifications: 
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Header: (Total fields = 39; Total length of header record = 891) 
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Record Format: 

 

 

The new Royal Bank EFT File Format is named as ROYAL BANK MARANT; the new EFT File Code is 
ROYAL_BANK as shown on the print screen below: 
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AP: Select Payment Enhancement (16.16218) 
  
1. CMiC has modified the AP Control File to have a new flag "User in Payment Selection is the one 

who posted the Voucher".  

 
 

If the new AP Control flag is checked, then the program will select vouchers that are posted by 
the User specified for that Payment Selection. If the flag is unchecked, then the program will 
behave as before – the program will select vouchers that are created by the User specified for 
that Payment Selection. 
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2. CMiC has modified The AP Payment Selection program to have new selection criteria for Job 

Department; the new button  has been added to Select Payment screen. 
 

 

If the Job Department is specified, then the program will select only the vouchers that have a 
Job Distribution and the Job has the Default Department specified for that Payment Selection. 

Change to Private Bank Upload Format (16.19118) 

Overview: 

CMiC has modified the existing Private Bank Format for the Bank Reconciliation file according to 
the provided specification to comply with Private Bank’s modified Trailer Record format. 

Settings:  

The CITI Bank was set up to have the modified Private Bank Reconciliation Format (PVT-
BANK2): 
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The Company ZZ is setup to have GL account 1000.400 associated with CITI Bank: 
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The Modified Private Bank Format for Bank Reconciliation: 

 

Summary: 

CMiC has modified the existing Private Bank Format according to the provided specification to 
comply with Private Bank’s modified Trailer Record format. The reconciliation functionality 
remained intact. 

Joint Checks and EFT (16.15972) 

Overview: 

CMiC has modified the System Options program and add a new flag "Change EFT Vouchers To 
Non-EFT When A Joint Payee Is Entered". If this option is checked, the system will update the 
EFT Flag on the voucher and make it Non-EFT if the Joint Payee has been defined. 

Settings and Examples: 

The new flag is added to the System Options: 
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Create EFT voucher; distribute: 

 

Define additional payee and Save: 
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As the result of adding joint payee the EFT flag on the Voucher Detail tab gets unchecked 
automatically. 

 

Please note that if the user checks off the EFT flag again and clicks the Save or 
Distribution/Accept buttons, the EFT flag gets unchecked again. Clicking Post Invoices will also 
uncheck the EFT flag.  

Then the voucher is treated as a non-EFT voucher with joint payees. 

If the flag in the System Option is unchecked the system behaves as before the changes. 

Summary: 

CMiC has introduced the new flag "Change EFT Vouchers To Non-EFT When A Joint Payee Is 
Entered" in the System Options. When this flag is checked off, the system will uncheck the EFT 
Flag on the voucher if the Joint Payee has been defined; then the voucher will be treated as 
NON-EFT.  
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Positive Pay Format for First Bank (16.21664) 

Overview: 

CMiC has created a new AP Positive Pay Format for First Bank per the format provided:  

<Account Number>, <Payment Amount>, <Check Date>, <Check Payee Name>, (the last 
character of each line is coma).  

Settings and Examples: 

 

1. 3 vouchers have been created: 
a.   

 
 

b. 
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c.  

 
 

2. Select Payment (the screen below allows to verify the payment amount per vendor: 
$2793.00 for the Vendor IH1RBP; $1862.00 for the Vendor IH01US; $931.00 for the Vendor IH-
PC): 

 
 

3. Prepare 3 checks and Post the Check Run: 
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4. In order to verify the functionality of the AP Positive Pay Register for the new format we will void 
one of the check (for the Vendor IH1TBP for the sum of $2,793.00): 
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5. Create a Bank Group for the created new Format FIRSTBANK and the bank account used for 
the prepared vouchers (Account Payable -> Check -> Positive Pay Register): 

 
 
 

6. Create the Register: 
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7. The following csv file has been created: 

 
 
The File Format corresponds to the requested format (Account Number, Amount, Check Date, Check 
Payee Name). 
 
Note: The void check (payment of $2793.00) is included in the csv file because the flag “Include Void” 
was checked off during Bank Group creation. 

 
8. Modify The Bank Group to exclude the void checks: 
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9. Create Register again (uncheck the flag “Include new items only”): 

 

 

 
10. The resulting csv file has only 2 records – the void check payment is not included in the file: 

 
 

Summary: 

A new AP Positive Pay Format for First Bank has been created according to the new format 
provided. Each record (line) in the file consists of: 

<Account Number>, <Payment Amount>, <Check Date>, <Check Payee Name>, (the last 
character of each line is coma).  

 

The EFT Harris Bank Format adjustment: eliminate prefix 1 for the 
Company ID (16.24632) 

Overview: 

CMiC has created a new EFT Format for Harris Bank (Harris Bank 2). This format is the same 
as the existing Harris Bank format, but without the prefix 1 before Company ID. 

Settings and Examples: 

ADF: 
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1. Set Company ID (Company ID is populated from Tax Registration2 field): 
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2. Select Payments: 

 

 

3. Prepare and Print the Check: 
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EFT file: 

 

Summary: 

A new EFT Format for Harris Bank has been created. This format is based on the existing Harris 
Bank format; the only difference between these 2 formats is that in the new format the prefix 1 
before Company ID is eliminated. 

 

AP Payments via ACHEFT (16.23404) 

Overview: 

CMiC has created a new EFT Format for BB&T Bank per the specification attached to the issue. 
While the modifications are available in Forms as well as in ADF.  

Settings and Examples: 

ADF: 

New EFT Format for BB&T Bank has been created: 

 

 

Three different vendors are used in the examples below. The EFT file created by the system is 
populated with data from the company and vendors’ settings. 
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1. Company IH2T setting: 
 

 
 
2. Vendor IH-PC setting: 
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3. Vendor IH01US setting: 

 

 
 
4. Vendor IH1TBP setting: 

 

 
  
Three vouchers for the vendors above have been selected for the payment: 
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Print Check: 
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Checks stubs: 

 

 

 
 
EFT File has been created: 
 

 
 
 
The created EFT file is consistent with the specification provided. 

 

Summary: 

CMiC has created a new EFT Format for BB&T Bank according to the specification attached to 
the issue.  
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New Compass Bank EFT File for PCard (16.22151) 

Overview: 

CMiC has created a new Compass Bank EFT File for PCard processing per customer 
requirements.  

Settings and Examples: 

According to the user requirements, each record in the CSV file should have the following 
format: 
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Note: The CVS file does not have a Header row; the records are created only for the positive check 
amount. 

 
ADF: 

1. Set up Vendor IH-PC for Third Party Payment with Compass Bank: 
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2. Set up Vendor IH01US for Third Party Payment with Compass Bank: 

 
 

3. Verify the Bank Account settings for the company IH2T: 
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4. Create 3 vouchers (one for the vendor IH-PC and two – for IH01US): 

 
a.  

 
 
 
 
 
 
 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  67 

 
b.  

 
 

c.  
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5. Select Payment: 

  
 

6. Print Check 
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7. Check stubs: 

 
 

 

The Third Party Paymode File has been prepared: 
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The CSV File has been created: 

 

The file is created according to the specification provided by the customer. 

Summary: 

A new Compass Bank EFT File for PCard processing has been created per specification 
provided by the customer.  

Cut-Off Date to be Sole Payment Selection Criteria (16.23474) 

Overview: 

The existing AP Control file flag "Use Invoice Date As Cut-off Date For Payment Selection" is 
used for this functionality. When this flag is checked, then the Payment Date and Next Pay Date 
fields are ignored for payment selection purposes, and payment selection is solely based on the 
Cut Off Date field (used as invoice date); i.e. ONLY invoices on or before the Cut Off Date would 
be included in the selection process regardless of the Payment Date and Next Pay Date. 

Settings and Examples: 

IN ADF: 

Check off the flag “Use Invoice Date as Cut-off Date for payment selection” in AP Control file: 
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Create a Payment Selection: 

 
 

Only the invoices with the Invoice Date equal or early than Select Payments Cut-Off Date are 
included in the selected.  

 

Summary: 

The AP Control file flag "Use Invoice Date As Cut-off Date For Payment Selection" is used to 
alter the Selection Payments procedure: if the flag is checked, the payment selection will include 
ONLY the invoices that have the Invoice Date on or before the Select Payments Cut Off Date. If 
the flag "Use Invoice Date As Cut-off Date For Payment Selection" is unchecked, the Select 
Payments program functions as before. 

BMO Harris File Format (16.27015) 

Overview: 

CMiC has created a new EFT Format for BMO Harris Bank. 

Settings and Examples: 

In the example described in this document, the system creates an EFT file that includes the 
payments coming from 2 different cash accounts (GL account 1000.100 corresponds to the 
Bank Account 123456789; GL account 1000.160 corresponds to the Bank Account 975468777) 
for the sending company IH2T; as the result the EFT file will have 2 blocks. 
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1. Bank Setting (System -> Global Tables -> Banking -> Bank Account): 

 
 

2. EFT Format Setting for the new format BMO_HARRIS (Account Payable -> Setup -> Global Tables -> 
EFT Formats): 

 
 
Note: The value in the column Code 5 defines how many records will be in the EFT file block (by default it is 
set to be 10 – as per file specification provided); the value in the column Code 18 defines if the addenda 
records will be included in the EFT file (by default it is set to be 0 – no addenda records).   
From the Company setup (General Ledger -> Setup -> Company Setup -> Company Detail 
 

3. From the Company setup (General Ledger -> Setup -> Company Setup -> Company Detail button) 
the system takes Company Tax Id (please see the screenshot below). 
 

Note: To comply with the EFT file specification, the 10-digit Company Tax ID must have the first character as 
‘1’. 
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4. The vouchers used in the example are created for the Vendors IHBP1, IHREGINV, IHBP113, 
IHBP2711, and IHBP5965. The system uses the Bank Transit and Account Number information from 
the vendors’ settings to create fields 3, 4, and 5 in the Entry Detail Record (Record Type ‘6’) in the 
EFT file. 

 

Here is the example of the vendor’s setting: 
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The vouchers included in the EFT have been created using two different cash accounts for the paying 
company IH2T (GL 1000.100 and GL 1000.160) to demonstrate that the resulting EFT file will have 2 
blocks. Below is the example of one of the vouchers created: 
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The following payments have been selected to create BMO Harris File format EFT file: 

 

 
 

After preparing the checks, the Print Check screen should have The EFT File Format field set BMO 
Harris Bank (the selection is available in the field LOV), and EFT File Code field should be set as 
BMO_HARRIS: 
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Below is the EFT file created. 

 

Note: The file does not have optional Entry Detail Addenda Records in accordance with the EFT 
Format Setting (the value in the Code 18 column is set as ‘0’). 
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Summary: 

The new EFT Format for BMO Harris Bank has been created in accordance with the file 
specifications provided by the customer. 

Category Column added in AP Invoice Query (16. 26878) 

Overview: 

CMiC has modified AP Invoice Query and AP Invoices Log. Two columns – Category Code and 
Cost Code – have been added to AP Invoice Query; three columns – Job Code, Category Code 
and Cost Code have been added to the AP Invoices Log. Category Code and Cost Code will 
appear only if they were entered on the Invoice (Voucher) Header. 
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Settings and Examples: 

 
1. Create an Invoice IH-55 with Distribution Type “General Distribution” on the Invoice Header: 

 
 
 

2. Create an Invoice IH-56 with Distribution Type “Job Distribution” on the Invoice Header: 
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3. Create two Invoices with Distribution Type “Multi Distribution” on the Invoice Header: 

 
a. Invoice IH-59: Actual Distribution for this invoice has J-line: 
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b. Invoice IH-60: Actual Distribution for this invoice has E-line: 
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4. The invoices above will be shown on the AP Invoice Query (Account Payable -> Query -> Invoice 

Query) as following: 

 
 
 

5. The invoices above will be shown on the AP - Invoice Log (Account Payable -> Log -> Invoices) as 

following: 

 

Summary: 

The AP Invoice Query has been modified to display Category Code and Cost Code for the 
invoice; The AP Invoices Log has also been modified to display Job Code, Category Code and 
Cost Code. Category Code and Cost Code data are populated from the Invoice Header only. 
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AP Positive Pay Format for PNC Bank(PNC_2) (17.44096) 

A new AP Positive Pay Format for PNC Bnak(PNC_2) has been added. 

 
 

Third Party payment format for US Bank (Paymode US Bank 2) 
(18.57746) 

A New Third Party payment format for US Bank (Paymode US Bank 2) has been added. While 
Printing Checks some information like Company name(file header) and Zip/Postal Code(payment 
record) will get the values from Third Party Payment setup. 
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AP Positive Pay Format for FULTON Bank (FULTON) (18.68267) 

A new AP Positive Pay Format for FULTON Bank (FULTON) has been added 

 
 

Pos Pay, ACH & Bank Recon. file formats for CITI Bank (19.70918) 

Overview: 

To create new ACH, Positive Pay and Bank Reconciliation file formats for CITI Bank. 

Modifications: 

The following programs are modified to include CITI Bank in the ACH, positive pay file creation and 
the bank reconciliation programs 

1. apchqprt.pb   - Added new ACH format CITIBANK 

2. appospay.pb   -  Added new Positive Pay format CITIBANK 

3. GT_BACHKREC.pb  -  Added new Bank Reconciliation format CITIBANK 
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Users must setup necessary Banking Information for Citi Bank. The Payable entries must have the 
cash account associated with the Citi Bank. 

 

1. ACH File: 

The following screen shows the ACH/EFT file format layout. The column fields must be updated by 
the user according to Banker’s instruction. 

 

Once a Payment selection is created using EFT Payments, Checks can be prepared using the same 
Payment Selection Code. 

The following screen shows the check preparation and ACH/EFT file generation. 

 

Financials>AP>Check>Print Check screen 
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Screenshot below shows the Generated EFT File: 
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The following file format shows the EFT specification document provided by CITI Bank. 
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2. Positive Pay File: 

The following screens show the positive pay file format layout. 

 

Financials>AP>Check>Positive Pay Register screen– TRAIN (Create Bank Group) 

 

Financials>AP>Check>Positive Pay Register screen – TRAIN (Create Register) 

Users have to Select the From & To Date, the Bank Group Code (CITI in this case), and the File 
name and press [Process]. 

The following screen shows the Positive Pay file generated. 
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The following file format shows the Positive Pay specification document provided by CITI Bank. 
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3. Bank Reconciliation 

The following screen shows importing the Reconciliation file 

 

System>Global Tables>Banking>Electronic Reconciliation>Bank Reconciliation 

The following screen shows the processing of Recon File. 

 

System>Global Tables>Banking>Electronic Reconciliation>Bank Reconciliation 

The following screen shows the Reconciliation File. 
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The above Reconciliation File created follows the Bank specification documentation as shown below. 

 

 

Selection Criteria of Register/Invoice Query screen to have Invoice 
Number Field (19.76623) 

AP Register/Invoice Query screen will have a new field “Invoice Number” for selection criteria on 
header.  

This new field is hidden by default. Can be added using Lite Editor. 

Invoice Number field is not case sensitive for searching records. 

New field searches with wildcard characters as well. 

Invoice Number must be entered along with either Department, Job or Vendor. 

Below screenshot shows the alert message when only Invoice number is mentioned. 
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Below screenshot shows the newly added “Invoice Number” field in TESTR12. Querying with just the 
Invoice number gives specific details of only those invoices which matches the invoice number from 
various vendors having same invoice number.  

 

Added new field “Invoice Number” to Register/Invoice Query Selection Criteria screen. 

Signature Bank – Multi positive Pay Format (19.84254) 

There is a requirement to create POSITIVE PAY format for Signature BANK. The requirement details 
are further mentioned. 

A new Multi-positive pay format (AP/PY combined) for SIGNATURE BANK based on the Specification 
document has been created. 

Following screen shows the new positive pay file format code created and associated to the 
Signature Bank. 
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Systems>Global Tables>Banking>Banks screen 

Following screen shows how to generate the file using multi-positive pay. 

User must click on Create “AP/PY Combined Positive Pay” button on the train before generating the 
file. Once after entering all the details like company, Bank Code, check date and file path where the 
file needs to be stored, click on Process and the file is generated. 

 

AP>Check>Positive Pay Register screen 

The below screen shows the specification document, which specifies the file format. 
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The following screen shows the sample file generated using multi-positive pay. 

 

Wells Fargo Positive Pay file – Positive Pay Format (19.85258) 

There is a requirement to create POSITIVE PAY format for Wells Fargo BANK. The requirement 
details are further mentioned. 

A new positive pay format WFARGO_DSG in R12 ADF for Wells Fargo BANK based on the 
Specification document has been created. 

In R12 this format will only be available in ADF. 

FCBUILD EFT Format for Village Bank & Trust (19.87990) 

Created a new EFT/ACH – NACHA file format for Village Bank & Trust.  

Modifications: 

Created an entry VBT_NACHA in EFT Format setup. 

The following screens show the typical setup for the EFT Format. Users may update the code values 
as required. 



96  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

 

 

Bank Format for Cheque Fraud Prevention Program (19.86724) 

Client request for new AP positive pay file format. 

CMIC will create a new AP positive pay file format as per the file specification 
"CFPIssuedChequeFileFormat.pdf" 

New Format Code: TD_BANK_4  

          Description: TD Bank (Format# 4) 

Two new fields Positive Pay Cust Id. and TD PosPay Last File Number added to Bank Account 
Maintenance Screen. 

HORIZON Positive Pay file – Positive Pay Format Enhancement 
(19.83748) 

Client (HORIZON) would like a quote on a positive pay format - They currently use the ASCII Text 
Comma Delimited option, and include the Payee (optional) but don't include anything in the User Data 
column (optional). 

CMIC created AP Positive pay format as per the sample file "WBTUpload 07-31-2019(1).csv" 
attached to the issue. 

Positive Pay File for National Exchange Bank (19.91821) 

Added a Positive Pay File Format for ‘National Exchange Bank’. The following 6 fields are available in 
the following format and sequence. 
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Issue 
Type 

Account 
Num. 

Check Num. Issued Date Amount Payee 

I = issue 
V = void 

Up to 17 
numeric 
digits. 

Up to 15 
numeric digits. 

In MMDDYY 
format.  

Between 00-
100,000,000.00 

Vendor name up to 
96 characters 
(accepts special 
characters) 

 

There is a new entry (‘NATEXGBANK’) added to the LOV for the ‘Format Code’ list field in bank 
group maintenance program.  

Users may create a new group for National Exchange Bank by choosing the format code 
‘NATEXGBANK’ and associate Company, Bank Account combinations as required. 

 

AP>Checks>Positive Pay Register>Create Bank Group 

To create the Positive Pay Register, click on the create register in the process train.  

Select the bank group that was created for this purpose. 

Enter the From / To dates to limit the checks selection for which you want to print the positive pay file.  

Click on Process to proceed. 
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AP>Checks>Positive Pay Register>Create Register 

 

 

National Exchange Bank Positive Pay File Format Sample generated from CMiC 

Positive Pay File Format for Union Bank (20.18504) 

Added an AP Positive Pay Format (comma delimited) for ‘Union Bank’. The 4 fields are available in 
the following format and sequence. 

 

Check 
Num. 

Issue Date Amount Issue Type 

Up to 10 
numeric 
digits. 

In 
MM/DD/YYYY 
format. 

Cents must be separated by decimal 
point. 
(Note: voided check records must 
contain zeroes in this field) 
 

I = issue 
V = void 

 

There is a new entry (‘UNIONBANK’) added to the LOV for the ‘Format Code’ list field in bank group 
maintenance program.  

Users may create a new group for Union Bank by choosing the format code ‘UNIONBANK’ and 
associate Company, Bank Account combinations as required. 
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AP>Checks>Positive Pay Register>Create Bank Group 

To create the Positive Pay Register, click on the create register in the process train.  

Select the bank group that was created for this purpose. 

Enter the from/to dates to limit the checks selection for which you want to print the positive pay file.  

Click on Process to proceed. 

 

AP>Checks>Positive Pay Register>Create Register 
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Union Bank Positive Pay File Format Sample generated from CMiC 

Positive Pay File Format for Hartland Financials (19.83748) 

Added a new AP Positive Pay Format (comma delimited) for ‘Heartland Financials’.  

The new Positive Pay format for ‘Heartland Financials’ will have 8 fields. There is a new entry 
(‘HEARTLAND’) added to the LOV for the ‘Format Code’ list field in bank group maintenance 
program. Users may create a new group for Heartland Financials by choosing the format code 
‘HEARTLAND’ and associate Company, Bank Account combinations as required. 

 

Tree view: Financials>AP>Checks>Positive Pay Register>Create Bank Group 

To create the Positive Pay Register, click on the create register in the process train.  
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Select the bank group that was created for this purpose. 

Enter the from / To dates to limit the checks selection for which you want to print the positive pay file.  

 

Click on Process to proceed. 

 

 

Tree view: Financial>AP>Checks>Positive Pay Register>Create Register 

 

 

Heartland Financials Positive Pay File Format Sample generated from CMiC 

AP/PY Combined Positive Pay File for Regions Bank (20.18508) 

Added an AP/PY combined Positive Pay File Format for ‘Regions Bank’ with 6 data fields. 

Users will be able to add the ‘REGIONSBANK’ Positive pay File Format to Bank maintenance, upon 
entering a new bank or to an existing bank record. 
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System Data>Global Tables>Banking>Banks 

The following screen shows the Bank Account maintenance program, where an account is associated 
with the bank that is created with the specific file format. 

 

System Data>Global Tables>Banking>Bank Account 

In AP Positive Pay Register go to the ‘Create AP/PY Combined Positive Pay’ in the process train. 
Select the same bank code that was associated with the ‘REGIONSBANK’ Positive pay File Format. 
Select the date as of the checks to be printed for. Enter the path where it needed to be saved after file 
generation. 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  103 

 

Financials>AP>Check>Positive Pay Register>Create AP/PY Combined Positive Pay 

Check the ‘Include previous process checks’ to add the previous checks according to the selection. 

Check the ‘Include void checks’ to get the void checks data printed in the file. 

 

The following is the File Format Specifications from Regions Bank. 
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New ‘Account Name’ Columns in AP invoice Log (19.91131) 

Added the following two columns to the AP Invoices Log View (DA.AP_INVOICE_LOG_V): 

VOU_CASH_ACC_NAME  

VOU_DIST_ACC_NAME 

Users may create new AP Invoices Logs, based on the existing log view DA.AP_INVOICE_LOG_V. 

These columns can be repositioned and made visible as required. 
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EFT File Format for Regions Bank (20.18787) 

Added a new entry (‘REGIONSBANK’) added to the LOV for the ‘EFT Format’ list field in global tables 
of AP setup. 

Users may create a new file for Regions Bank by choosing the EFT format ‘Regions Bank’. 

 

Financials>AP>Setup>Global Tables>EFT Format 

To print the EFT file for Regions Bank, go to AP print check. Activate the ‘Create EFT File’ flag and 
select the ‘EFT File Format’ and ‘EFT File Code’ from the list. Give the file name by which EFT file 
should be saved. 
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Financial>AP>Check>Print Check>Print Check 

 

Regions Bank EFT File Format Sample generated from CMiC 
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Regions Bank Prescribed EFT File Format 

EFT File Format for RBC Bank (19.79780) 

Added a new entry (‘RBCBANKACH’) added to the LOV for the ‘EFT Format’ list field in global tables 
of AP setup. 

Users may create a new file for RBC Bank by choosing the EFT format ‘RBCBANKACH’. 

 

Financials>AP>Setup>Global Tables>EFT Format 
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To print the EFT file for RBC Bank, go to AP print check. Activate the ‘Create EFT File’ flag and select 
‘Royal Bank ACH Format’ for EFT File Format and ‘TEST’ for EFT File Code from the list. Give the file 
name by which EFT file should be saved. 

 

Financial>AP>Check>Print Check>Print Check 

 

RBC Bank EFT File Format Sample generated from CMiC 

 

RBC Bank Prescribed EFT File Format 
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EFT File Format for Village Bank and Trust (19.87990) 

Added a new AP EFT file format for ‘Village Bank and Trust’. 

There is a new entry (‘VBT_NACHA’) added to the LOV for the ‘EFT Format’ list field in global tables 
of AP setup. 

Users may create a new file for Village Bank and trusts by choosing the EFT format ‘VBT_NACHA’. 

 

Financials>AP>Setup>Global Tables>EFT Format 

Enter the bank account number under Code 3. 

 

To print the EFT file for Village Bank and Trust, go to AP print check. 

• Activate the ‘Create EFT File’ flag. 

• Select ‘Village Bank & Trust NACHA Format’ for EFT File Format. 

• Select ‘VBT_NACHA’ for EFT File Code from the list. 

• Give the file name by which EFT file should be saved. 

User can press ‘Generate EFT’ button on the bottom if only the EFT file needs to be printed or can 
press ‘Print Checks’ button if the checks and EFT both need to be printed. 
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Financial>AP>Check>Print Check>Print Check 

 

Village Bank and Trust EFT File Format Sample generated from CMiC 

Check Format for JP Morgan Chase Bank (20.20546) 

Added a check format ‘APCHECK_HIKUU_6’ in Jasper reports for JP Morgan Chase Bank Check as 
per specifications provided by the bank. 

New AP EFT File Format Added – SunTrust Bank (20.30025) 

Change Request: 

To add a new AP EFT file format for ‘SunTrust Bank’. 

 

Modifications: 

There is a new entry (‘SUNTRSTBNK’) added to the LOV for the ‘EFT Format’ list field in Global 
tables of AP setup.  
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Choose the EFT Format ‘SUNTRSTBNK’. Users may have to update the code values as required by 
the SunTrust Bank. 

 

AP>Setup>Global Tables>EFT Format 

To print the EFT file for SunTrust Bank, go to AP print check.  

Activate the ‘Create EFT File’ flag and select the ‘EFT File Format’ and ‘EFT File Code’ from the list. 

 

AP>Check>Print Checks>Print Check 
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SunTrust Bank EFT File Format Sample generated from CMiC 
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SunTrust Bank Prescribed EFT File Format: 
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Working Document R12 New Functionality R12 New Functionality (Draft)  •  115 

 

 

New Third Party Payment Mode Added – SunTrust Bank (20.30024) 

Change Request: 

To add a Third Party Payment Mode selection for ‘SunTrust Bank’. 

 

Modifications: 

There is a new entry (‘Paymode Suntrust bank’) added to the drop-down list for the ‘Third Party 
Payment Mode’ field in the following screens: 
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1. Maintain Vendors Program under Accounting tab: 

 

AP < Setup < Maintain Vendors 
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2. AP Enter Voucher Screen:  

 

AP < Voucher < Enter Vouchers 

 

3. Select Payments Program: 

 

AP < Payment < Select Payments 

 



118  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

To print the ‘Third Party Payment Mode’ file for SunTrust Bank, go to AP print check.  

Activate the ‘Create Third Party Paymode File’ flag and click on Print Checks. 

 

 

AP>Check>Print Checks>Print Check 

 

 

SunTrust Bank Third Party Payment Mode File Format Sample generated from CMiC 
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SunTrust Bank Prescribed Third Party Payment Mode File Format: 
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New AP EFT File Format Added – BMO Bank (20.32984) 

Change Request: 

To add a new AP EFT file format for ‘BMO Bank’ (BMO Bank CPA-005). 

 

Modifications: 

There is a new entry (‘BMOBNKCPA’) added to the LOV for the ‘EFT Format’ list field in Global tables 
of AP setup.  

Choose the EFT Format ‘BMOBNKCPA’. Users may have to update the code values as required by 
the BMO Bank. 

 

AP>Setup>Global Tables>EFT Format 
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To print the EFT file for BMO Bank, go to AP print check.  

Activate the ‘Create EFT File’ flag and select the ‘EFT File Format’ and ‘EFT File Code’ from the list. 

 

 

AP>Check>Print Checks>Print Check 

 

1. If Code 2 if value is ‘N’ then ‘Actual Sequence Number’ will print. 

 

 

BMO Bank EFT File Format Sample generated from CMiC when Code 2 – ‘N’ 

 

2. If Code 2 if value is ‘Y’ then ‘Test’ will print. 
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BMO Bank EFT File Format Sample generated from CMiC when Code 2 – ‘Y’ 

New AP EFT File Format Added – Union Bank (20.33454) 

Change Request: 

To add a new AP EFT file format for ‘Union Bank’. 

 

Modifications: 

There is a new entry (‘UNIONBNK’) added to the LOV for the ‘EFT Format’ list field in Global tables of 
AP setup.  

Choose the EFT Format ‘UNIONBNK’. Users may have to update the code values as required by the 
Union Bank. 

 

 

 

AP>Setup>Global Tables>EFT Format 

 

To print the EFT file for Union Bank, go to AP print check.  

Activate the ‘Create EFT File’ flag and select the ‘EFT File Format’ and ‘EFT File Code’ from the list. 
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AP>Check>Print Checks>Print Check 

 

 

Union Bank EFT File Format Sample generated from CMiC 

 

Note:  

a. Header Record – Position 14-23: Immediate Origin (Your Company Id as agreed by the Bank) – 
Taken from Tax Reg2 for the company 

b. Batch Header Record – Position 41-50: Company Identification (Your Company Id as agreed by 
the Bank) - Taken from Tax Reg2 for the company 
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Union Bank Prescribed EFT File Format: 
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128  •  R12 New Functionality (Draft) Working Document R12 New Functionality 
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Added Select All option in Invoice Selection Screen (20.34145) 

Change Request: 

To add a Select All option in Invoice Selection Screen. 

Modifications: 

 

AP>Payment>Select Payments>Select Payments 

Ability to Group Checks by Approver (Beta Release) (20.32165) 

Overview 

New flags are added in the following screens:  

1) AP Control File: Group Checks by Approver  

2) Prepare Checks: By Approver   

Modifications 

• ‘Group Checks by Approver’ is checked by default as per existing logic.  
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• ‘By Approver’ flag will default from ‘Group Checks by Approver’ flag in AP control file. Flag is 
checked by default and user can override it.  

When the ‘Group Checks by Approver’ is checked, existing logic applies. 

When Un-checked, the invoices with different approvers will be put under the same check.  

 

Group Checks by Approver:  

 

AP > Setup > Local Tables > Control File – Checks 

By Approver: 

 

AP > Checks > Print Checks 

IMPORTANT NOTE: This is to support the new functionality of AP Workflow approvers for invoices 
from the payment selection program, which is not in the standard release yet. 
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Added New Label ‘Print Company Legal Name’ (21.42531)  

Overview 

Added new Label ‘Print Company Legal Name’ on T5018 Forms. 

Modifications 

1. Added new Label ‘Print Company Legal Name’ on T5018 Forms. 

 

Financials> Account Payables > Utilities> Print T5018 Forms  

Implementation 

Provide Company’s Legal name in Company setup.  
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Financials> General Ledger> Setup> Maintain Companies 

Upon checking ‘Print Company Legal Name’ checkbox would print company’s legal name in XML and 
T5018 report. 

 

T5018 Report 
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XML File 

Added New LOV in ‘Print T5018 Forms’ (21.40809)  

Overview 

Added 2 new LOVs that allow users to select print type option – T5018 Forms.  

Modifications 

1. Added following 2 new LOVs that allow users to select print type option – T5018 Forms. 

a. Print on pre-printed form 

b. Print on blank page  

 

Financials> Account Payable> Utilities> Print T5018 Forms 

‘Print on pre-printed form’ option is selected by default. 
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Implementation 

If user selects ‘Print on blank page’, T5018_BOX prints data in CRA format.  

 

Financials> Account Payable> Utilities> Print T5018 Forms 

If user selects ‘Print on’pre-printed form, T5018 prints data in a pre-defined format.  
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Financials> Account Payable> Utilities> Print T5018 Forms 

Similarly for summary reports, if user selects ‘Print on blank page’, T5018S_BOX prints data in CRA 
format.  
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Financials> Account Payable> Utilities> Print T5018 Forms 

Similarly for summary reports, if user selects ‘Print on’pre-printed form, T5018S prints data in a pre-
defined format.  
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Financials> Account Payable> Utilities> Print T5018 Forms 

BBVA Cash Net USA Positive Pay File Format (20.35679) 

Created a Positive Pay Format File ‘BBVA Net Cash’. Users must create a bank group code, select 
the format code and assign companies and bank accounts as required. 

 

AP > Check > Positive Pay Register > Create Bank Group 
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AP > Check > Positive Pay Register > Create Register 

The following text file is generated by the program as per the specification provided by the BBVA Net 
Cash USA. 
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Bank Specifications: 

 

CNBANK Positive Pay Format (20.35880) 

Modified the CNBANK Positive Pay File Format 

 
Modifications: 

The CNBANK Positive Pay format will be modified to: 

• Include all 10 digits of the bank account number. 
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Setup and Creation of the File: 

 

 

The following sample Positive pay file is created. The comma from the payee’s name will not be 
removed and all 10 digits of the bank account number will printed in the Register. 

 
 

AMERIS Bank EFT Format (21.36848) 

Created an EFT File Format ‘AMERISBNK’. 

Modifications: 

The EFT Format Setup has an entry for ‘AMERISBNK’ and the code values may be set as required 
by the bank or the customer. During check printing, users must select this format code to produce an 
EFT File. 
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Batch Header Record - Record# 5  

• Service Class Code "220" will be used in the file. 

• Standard Entry Class "CCD" will be used in the file. 

• Company entry description "PAYMENTS" will be used in the file. 

• Company Identification "Company Tax Reg 2" field value will be used in the file. 

Entry Detail Record - Record# 6 

• Transaction Code "22" will be used. 

Batch Control Record - Record# 8 

• Service Class Code "220" will be used in the file. 

• Company Identification "Company Tax Reg 2" field value will be used in the file. 

Setup and Printing EFT File: 

 

AP > Setup>Global Tables > EFT Formats 

 

AP > Check>Print Checks 

The following is a test EFT file generated for AMERISBNK format. 
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The following screens shows the AMERISBNK EFT File specifications:  
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Working Document R12 New Functionality R12 New Functionality (Draft)  •  145 

 
 

 
 
 
 
 



146  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

TRUSTMARK Bank EFT Format (20.35555) 
 

Created an EFT File Format ‘TRUSTMARK’. 

 

Modifications: 

The EFT Format Setup has an entry for ‘TRUSTMARK’ and the code values may be set as required 
by the bank or the customer. During check printing, users must select this format code to produce an 
EFT File. 

Batch Header Record - Record# 5  

• Service Class Code "220" will be used in the file. 

• Standard Entry Class "CCD" will be used in the file. 

• Company entry description "PAYMENTS" will be used in the file. 

• Immediate Destination will read from EFT setup.  

• Immediate Origin, Company Identification "Company Tax Reg 2" field value will be used in the 

file. 

Entry Detail Record - Record# 6 

• Transaction Code "22" will be used. 

• ORIGINATING DFI IDENTIFICATION will read from EFT setup. 

Batch Control Record - Record# 8 

• Service Class Code "220" will be used in the file. 

• Company Identification "Company Tax Reg 2" field value will be used in the file. 

Setup and Printing EFT File: 

 

AP > Setup>Global Tables > EFT Formats 
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AP > Check>Print Checks 

The following is a test EFT file generated for ‘TRUSTMARK’ format. 

 

 

SCOTIABANK EFT Format (21.36999) 

Created a new AP EFT Format “SCOTIABANK” with a description of “ScotiaBank-Standard 152”. 

Modifications: 

Created a new AP EFT file Format "ScotiaBank - Standard 152" for Scotia Bank by using an existing 
AP EFT file format "ROYAL" with following changes only. New EFT code and setup will be created for 
this new format. 
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1. First line is removed. 

2. On detail record (Type C), Customer ID all ten characters will be read from the Code 4 field from 
EFT setup. 

 

Setup and printing EFT File formats 

 

 

AP > Setup>Global Tables > EFT Formats 
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AP > Check>Print Checks 

The following is the EFT File generated for “SCOTIABANK” format. 

 

BMO EFT 80-Byte Format (21.37563) 

Created an EFT File Format ‘BMO EFT 80-BYTE FORMAT’. 

Modifications: 

Created a new AP EFT fixed length file format for BMO Bank "BMO EFT 80- BYTE FORMAT" with 
following fields mappings. 

File Header Record Type A (80 Character) 

• Field#1(Logical Record ID) - AP EFT SETUP - 'A' 

• Field#2(Originator ID) - AP EFT SETUP - 'VENDR002OC' 

• Field#3(File Creation #) - Unique File Sequence - 0001 

• Field#4(File Creation Date) - Sysdate - format 0YYDDD 

• Field#5(Destination Data Centre Code) - AP EFT SETUP - '00120' 

• Field#6(Blanks) - Space fill 
 

Batch Header Record Type X (80 Character) 

• Field#1(logical Record ID) - AP EFT SETUP - 'X' 

• Field#2(Batch Payment Type) - AP EFT SETUP - 'C' 
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• Field#3(Transaction Type Code) - AP EFT SETUP - '430' 

• Field#4(Funds are payable) - Payment Date - Format 0YYDDD 

• Field#5(Originator's Short Name) - Company Code (Company Setup) 

• Field#6(Originator's Long Name) - Company Name (Company Setup) 

• Field#7(Premforms Bank & transit) - Cash Account Bank Transit Number (Bank Account Setup) 

• (0BBBTTTTT) 0 - Constant, BBB - Bank number 001, Branch Transit# 04702 
Note: Whole 9-digit value must be setup on Bank Account Transit field 

• Field#8(Premforms account) - Cash Account Bank Account Number (Bank Account Setup) 

• Field#9(Blanks) - Space fill 

 

Detail Record Type C (80 Character) 

• Field#1(logical Record ID) - AP EFT SETUP - 'C' 

• Field#2(Amount) - Cheque Amount 

• Field#3(Payee Institution ID) - Vendor's Bank Transit Number (Vendor Setup) 
(0BBBTTTTT) 0 - Constant, BBB - Bank number xxx, Branch Transit# xxxxx 

• Note: Whole 9-digit value must be setup on Vendor's setup field Transit Number 

• Field#4(Payee Account#) - Vendor's Bank Account Number (Vendor Setup) 

• Field#5(Payee Name) - Vendor Name (Business Partner Setup - Field BP_NAME) 

• Field#6(Blanks) - Space fill 

 

Batch Control Record Type Y (80 Character) 

• Field#1(logical Record ID) - AP EFT SETUP - 'Y' 

• Field#2(Batch Payment Type) - AP EFT SETUP - 'C' 

• Field#3(Batch Record Count) - Total Batch Records 

• Field#4(Batch Amount) - Total Batch Amount 

• Field#5(Blanks) - Space fill 
 

File Control Record Type Z (80 Character) 

• Field#1(logical Record ID) - AP EFT SETUP - 'Z' 

• Field#2(Blanks) - Zero fill 

• Field#3(Blanks) - Zero fill 

• Field#4(Total value of C records) - Total value of C records 

• Field#5(Total number of C records) - Total number of C records 

• Field#6(Blanks) - Space fill 

 

Setup and Printing EFT File: 

 

AP > Setup>Global Tables > EFT Formats 
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AP > Check>Print Checks 

 

The following is a test EFT file generated for ‘BMO Bank-80 Characters’ format. 
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WELLS FARGO Bank EFT Format (21.41242) 

Created a new Wells Fargo ACH Format ‘WELLSFARGO_5’ 

Modifications: 

The EFT Format Setup has an entry for ‘WELLSFARGO_5’ and the code values may be set as 
required by the bank or the customer. During check printing, users must select the format code to 
produce an EFT File. 

 

Batch Header Record-Record#5 

• Service class code (Field position 2-4) – ‘225’ value will be used, this will be taken from AP EFT 
Setup 

• Standard Entry Class Code (Field position 51-53) - Default "CCD" value will be used; this value 
will be taken from AP EFT Setup. To use "PPD" for different company, user will have to setup 
new record in EFT Setup manually) 

 

Entry Detail Record - Record# 6 

• Transaction code (Field position 2-3) – ‘27’ value will be used, this will be taken from AP EFT 
Setup 

• Individual ID (Field position 55-76) - This will be taken from AP EFT Setup, by default blank in 
setup. Need to setup manually by the user. If using different value for different companies then 
user will have to setup new record in EFT Setup manually for each company using different 
value. 

• Individual Name (Field position 77-78) - This field will be blank. 
 

Addenda Record- Record#7 

• No Addenda record will be shown in the file. 
 

This will be done on R12(ADF). 
 

EFT File Format Setup and Check Printing: 
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The user can choose the file code required for processing, based on the values required. 

 

The user should enter Code 18 and 19 for processing based on their requirement. 
 

 

AP>Setup>Global Tables>EFT File Format 

 

AP>Checks>Print Checks 

Sample EFT File generated with File Code WELFRG_CCD: 
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Sample EFT File generated with File Code WELFRG_PPD: 

 
 

The following screens show the WELLSFARGO ACH File Specifications: 
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Bangor Bank EFT Format (21.42060) 

Overview 

Added new EFT Format for Bangor Bank. 

Pre-requisites 

The EFT Format Setup has an entry for ‘AMERISBNK’ and the code values may be set as required 
by the bank or the customer. During check printing, users must select this format code to produce an 
EFT File. 

 

Implementation 

  
 Prepare Checks:  
 Selection Code: D1 
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Printing Checks:  

 

 

Bangor Bank Format  

NOTE: Balance offset record for each transaction detail 6 record. Balance entry will be copy of detail 
6 record line, only transaction code and last field detail line sequence number will be different rest will 
be same. 
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File Header (“1” Record) 

 

Field Name Width Format Ultimate Source Comments 

Record type 1   Always ‘1’ 

Priority code 2 Numeric, left 
pad with zeroes 

 Always “01” Set 
at Create Batch 

blank 1   Always a space.  
The immediate 
destination id 
starts with a 
blank, but it is 
not 
entered/saved by 
the profile or 
application. 

Immediate 
destination id 

9 right pad with 
spaces 

Bank Settings: 
ImmedDestinationId. 

Stored at Create 
Batch. 

Immediate origin 
id 

10 right pad with 
spaces.  
Truncate if 
necessary. 

Company Settings: 
Immediate Origin ID. If 
not there, Master 
Company: Immediate 
Origin ID. If not there, 
Bank Settings 
ImmediateOriginID. 

If that is null, the first 9 
characters of 
ACHIDNumber for this 
Company. 

Stored at Create 
Batch. Insert a 
blank as 1st 
position in the 
NACHA file. 

Date 6 yymmdd Date the scoop run 
was started. 

 

Time 4 hhmm (military) Time that the scoop 
run was started. 

 

Id modifier 1  Starts at “A” each day 
for each file created. 

 

Record size 3   always ‘094’ 

Blocking factor 2 Numeric, left 
pad with zeroes 

Stored in Payments 
database 

always “10” 

Format code 1 Numeric, one 
digit 

Stored in Payments 
database 

always “1” 

Immediate 
destination 
name 

23 Right pad with 
spaces 

Bank Settings: 
ImmedDestName.  
May  be blank. 

Stored at Create 
Batch 
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Field Name Width Format Ultimate Source Comments 

Immediate origin 
name 

23 Right pad with 
spaces 

Company Settings: 
ImmediateOrigin 
Name.  If not there, 
Master Company 
Setttings: 
ImmediateOrigin 
Name. If not there, 
Bank Settings:  
ImmediateOriginName. 

May be blank. 

Stored at Create 
Batch 

Reference code 8 Right pad with 
spaces 

Bank Settings: 
FileHeaderRefCode.  
May be blank. 

Stored at Create 
Batch 

 

Batch Header (“5” Record) 

 

Field Name Width Format Source Comments 

Record type 1   Always ‘5’ 

Service class 
code 

3 Numeric, left 
pad with zeroes 

Application: 
ServiceClassCode 

Stored at Create 
Batch 

Company name 16 Right-pad with 
spaces, 
truncate if 
necessary. 

Application: 
CompanyName.  If null,  
Company Name for this 
Company. 

Stored at Create 
Batch 

Company 
discretionary 
data 

20 right pad with 
spaces 

Application: 
CompanyDiscretionaryData 

Stored at Create 
Batch 

Company id 10 right pad with 
spaces.  
Truncate if 
necessary. 

Application: ACH ID 
Number.  If not there, ACH 
ID Number from the 
Company Profile 

Stored at Create 
Batch 

Standard entry 
class code 

3 right pad with 
spaces 

Application: 
StandardEntryClassCode 

Stored at Create 
Batch 

Company entry 
description 

10 right pad with 
spaces 

Application: 
CompanyEntryDescription 

For returns, if these are 
empty, use Bank Settings: 
ImmedDestId. 

Stored at Create 
Batch 

Company 
descriptive date 

6 right pad with 
spaces 

Application: 
CompanyDescriptiveDate 

Stored at Create 
Batch 
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Field Name Width Format Source Comments 

Effective date 6 yymmdd Batch: BatchEffectiveDate  

Settlement date 
(Julian) 

3   three spaces 

Originator 
status 

1 Numeric, one 
digit 

Application: 
OriginatorStatus. 

If not there, then Company 
Settings Originator Status. 
If not there, then Master 
Company Originator 
Status.  If not there, Bank 
Settings: OriginatorStatus 

Stored at Create 
Batch 

Originating 
bank id 

8 Right pad with 
spaces.  May 
need to be 
truncated from 
9 to 8 
characters. 

Application: 
OriginatingBankId. 

If not there, Company 
Settings: 
OriginatingBankId.  If not 
there, then Master 
Company 
OrigintatingBankId.  If not 
there, Bank Settings: 
OriginatingBankId.  If not 
there, Bank Settings: 
ImmedDestId. 

Stored at Create 
Batch 

If using the 
ImmedDestId, 
drop the check 
digit (9th 
position) 

Batch number 7 Numeric, left 
pad with 
zeroes. 

 Use 1-up 
number,  
starting at 1 
each system 
day. 

 

Transaction (“6” Record) 

 

Field Name Format Source 

Record type   

Transaction 
code 

Numeric, left 
pad with zeroes 

Calculated based on application 
fields for TransactionType and 
Checking/Savings/Loans/General 
Ledger 

Destination bank 
id 

right pad with 
spaces 

Application: ReceivingBankID.  If 
not there, Bank SettingsBank 
Profile: ImmedDestId 
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Field Name Format Source 

Destination bank 
account 

right pad with 
spaces 

Application: 
ReceivingBankAcctNo. 

Amount numeric, left pad 
with zeroes 

Application: amount 

Individual Id right pad with 
spaces 

Application: 
IndividualIDNoOverride.  If null, 
application: IndividualIDNo. 

Individual Name Right pad with 
spaces.  
Truncate if 
necessary. 

Application: 
IndividualNameOverride.  If null, 
application: IndividualName 

Discretionary 
data 

Right pad with 
spaces. 

Application: 
EntryDetailDiscretData 

Addenda 
Indicator 

0 if no 
addendum.  1 if 
there is (at least) 
one. 

 

Trace number numeric, left pad 
with zeroes 

Always use the Trace Number 
Positions 1-8 from Originating 
Bank ID in the 5 record. 

 

Addenda   (“7” Record) 

 

Field Name Width Format Source 

Record type 1   

Addenda code 2 numeric, left pad 
with zeroes 

Application: 
AddTypeCode 

Free form 80 right pad with 
spaces 

assorted application 
fields 

Addenda 
sequence 
number 

4 numeric, left pad 
with zeroes 

first addendum for the 
entry is 1.  Second 
addendum for the 
same entry is 2...  For 
the next entry, resume 
at 1. 

Entry sequence 
number 

7 numeric, left pad 
with zeroes 

same as last 7 places 
in associated entry 
detail record 
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Offsets 

 

Field Name Format Comment 

NACHA 6-record 
field 

Offset Transaction 

Data Type Table Fields 

Where to get Offset Transaction Information 
from the Original Transaction or from other 
places in the system 

Record Type Code “6”-handled by TFD “6”-handled by TFD 

Transaction Code TransactionType Opposite TransactionType from Original 
Transaction 

CheckingorSavings CheckingOrSavings OffsetCheckingorSavings from Data Type 
Table 

ELSE default to “C” 

RDFI ID (Receiving 
Bank ID) 

ReceivingBankID OffsetBankID from Application 

ELSE OffsetBankID (Company Offset 
Routing Number) from Company  Settings.  
If blank, then Master Company Offset 
Routing Number. 

ELSE Bank Setting’s ImmediateDestination 
ID 

ELSE Fatal Error 

DFI Acct Number 
(Receiving Bank 
Account No.) 

ReceivingBankAccountNo OffsetBankAccountNo in DataEntry 

ELSE OffsetAccountNumber from 
CompanySettings.  If blank then Master 
Company OffsetAccountingNumber 

ELSE Fatal Error 

Amount (for Batch 
Offsets) 

Amount Amount-sum of the “6” record Amounts of 
the original transactions 

Amount (for 
Individual Offsets) 

Amount Amount of the original trans. 

Identification 
Number 

(for Batch Offsets) 

Individual ID OffsetIndividualID from Application 

ELSE insert text “BATCH OFFSET” 

Identification 
Number (for 
Individual Offsets) 

IndividualID OffsetIndividualID from Application 

ELSE IndividualID from Application 

ELSE Blank 

Individual Name 
(for Batch Offsets) 

Individual Name OffsetIndividualName from Application 

ELSE insert text “OFFST ” plus 
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Field Name Format Comment 

CompanyName from Company Settings. 
(note space after OFFST) 

Individual Name 

(for Individual 
Offsets) 

Individual Name OffsetIndividualName from Application 

ELSE text “INDIVIDUAL OFFSET” 

Discretionary Data EntryDetailDiscretData OffsetEntryDetailDiscretData from 
Application 

ELSE Blank 

Addenda Record 
Indicator 

Not applicable. Not applicable to offset creation.  Handled 
by the TFD. 

Trace Number 
[positions 1-8] 

TraceNo1to8 Always use the Trace Number Positions 1-8 
from Originating Bank ID in the 5 record. 

Trace Number 
[positions 9-15] 

System generated System generated.  Handled by the TFD. 

NACHA 7-record 
field 

Not applicable Not applicable to offset creation.  Handled 
by the TFD. 

Addenda Record AddInfo OffsetAddendaInfo in the Application 

ELSE Blank 

 

Batch Footer (“8” Record) 

 

Field Name Format Comment 

Record type  Always ‘8’ 

Service class 
code 

Numeric, left 
pad with zeroes 

Copied from the “5” record 

Entry addenda 
count 

Numeric, left 
pad with zeroes 

This equals the sum of the number of entry 
detail records and the number of addenda 
records 

Entry hash Numeric, left 
pad with zeroes 

hashes are the sums across entries of first 
8 digits of destination bank ID, with any 
overflow beyond 10 digits discarded from 
the total (we write the last 10 digits of the 
sum). 

Total Debit 
Amount 

Numeric, left 
pad with zeroes 

to two decimal places with no decimal point 

Total Credit 
Amount 

Numeric, left 
pad with zeroes 

to two decimal places with no decimal point 
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Field Name Format Comment 

Company Id  same as in batch header 

Reserved  first 8 are MAC.  Next 11 are blank (but held 
for big macs).  Last 6 are truly reserved.  all 
spaces 

Originating bank 
id 

 same as in batch header 

Batch number  same as in batch header 

 

NOTE: The Company ID field should match the one supplied in the corresponding “5” record. 

 

File Footer (“9” Record) 

 

Field Name Format Comment 

Record type  Always ‘9’ 

Batch count numeric, left 
pad with zeroes 

 

Block count numeric, left 
pad with zeroes 

Take number of records in the file, including 
this trailer record.  Add one less than the 
block factor.  Block Count = result (integer) 
divide by Block Factor. 

Entry addenda 
count 

numeric, left 
pad with zeroes 

This equals the sum of the number of entry 
detail records and the number of addenda 
records in the file. 

Entry hash numeric, left 
pad with zeroes 

Hashes are the sums across entries of first 
8 digits of destination bank ID, with any 
overflow beyond 10 digits discarded from 
the total (we write the last 10 digits of the 
sum). 

Total Debit 
Amount 

numeric, left 
pad with zeroes 

to two decimal places without decimal point 

Total Credit 
Amount 

numeric, left 
pad with zeroes 

to two decimal places without decimal point 

Reserved  all spaces 
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New functionality change in the [Move to new Selection Code] button 
while preparing Checks through Comdata Integration (21.39640) 
 

Overview:  

Move to New Selection Code functionality has been modified to select Vendors instead of individual 
Invoices while performing Move operation for unreconciled payments for the Vendors. 

NOTE: A Vendor must be paid in Full in regard to COMDATA Integration. Meaning a Vendor must be 
paid completely for all the Invoices or cannot have any payment at all. Partial payment of Checks or 
Invoices is Not Allowed. 

Modifications: 

The New Move to New Group/Selection pop-up window - Enter New Code, varies depending on 
whether it is launched for a selection code or pay run group. 

New Move Functionality while Preparing Checks for a Selection Code: 

The Comdata screen in the Prepare Checks screen has been modified to hide the Select Flag. 

The MOVE column has been removed from the below screen. 

 

Pop-up window launched from [Comdata] button on the Prepare Checks screen (Accounts Payable> Check) 

While performing the Move operation, User will not be able to select invoices individually, rather the 
system will allow User to select the Vendor. So, all the invoices attached to the Vendor whose 
payment is due will be moved at once. 

System will not allow to Move invoices of Vendor if the payment is complete.  

Under one Selection Code, when selected all the invoices would be moved to the new selection code. 

“Move to New Selection Code” will open a new screen to allow User to select the Vendor. 
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Pop-up window launched from [Move to New Selection Code] button for selection codes. 

Upon clicking the [Accept] button, users will be allowed to enter new Selection Code in the new pop-
up screen Enter New Code. 

 

Pop-up window launched from [Accept] button from Select Vendor window for selection codes. 

Upon Clicking on the [Move] button, new Selection code is created. 

 

Comdata screen with new Selection Code will appear as shown below. 

 

 

Pop-up window launched from [Comdata] button on the Prepare Checks screen. 

 



166  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

Comdata screen with old Selection Code will now appear as shown below. 

 

Pop-up window launched from [Comdata] button on the Prepare Checks screen 

New Move Functionality while Preparing Checks for a Pay Run Group: 

The logic to move Vendors under Group Code which may have single or multiple selection Codes is 
basically the same as preparing checks for a selection code.  

Vendor Selection window display for Pay Run Group appears to be the same as that of Select Vendor 
window for Selection Code. Only difference is that the Vendor may belong to single or multiple 
Selection codes in the Pay Run Group. 

 

Pop-up window launched from [Move to New Selection Code] button for pay run groups. 

Users will be allowed to select the vendor on Select Vendor Screen, on clicking the [Accept] button 
system will retrieve all invoices for that vendor from single or multiple Selection codes.  

The New Enter New Code window for Pay Run Groups will display unique company wise selection 
codes.  
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Pop-up window launched from [Accept] button from the Select vendor window for pay run groups. 

 

Select vendor window for pay run groups erroring out for not entering new codes for all the records for a vendor. 

The screenshot above shows records from the old pay run group being moved to a new group, 
AUTGRP06. Users should enter all the new selection codes failing which System will raise error. 

Once Users enter all the new Selection Codes, a new Group Code AUTGRP06 will be created with all 
the previously unreconciled checks from Original Group Code. 

 

Select vendor window for pay run groups. 
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System generates a meaningful description for the newly created Group Code. It says from which 
original group code it was created. 

 

Pay Run Group LOV from Prepare Checks screen. 

Now the Original Group Code NNE can be posted as post button is enabled as all the checks are 
reconciled. Unreconciled checks were moved to new Group Code AUTGRP06, explained in previous 
step. 

 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  169 

 

Comdata screen. 

Create Recurring Voucher – Added ‘Select All’ Option (21.44385) 

Added ‘Select All’ option to create recurring voucher program. 
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Check Release Date Feature for T5018 Forms (20.35213) 

Overview 

Added check release date feature in ‘Statement of Contract Payments’ program.  

• Use Check Release Date checkbox – The flag is un-checked by default.  

Modifications 

Checkbox is introduced in ‘Statement of Contract Payments’ program.  

Checked: System will use check release date to include the checks. 

Un-checked: System will user check post date to determine the checks to be included.  

 

Accounts Payable > Utilities > Print T5018 Forms – ‘Use Check Release Date’ flag 

Implementation 

Vendor: YYZCONS 

 

Accounts Payable > Setup > Maintain Vendors 
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Unreleased Check:  
Amount: 2646.00 

 

Accounts Payable > Check > Release Check - Unreleased 

Released Check:  
Amount: 2558.24 

 

Accounts Payable > Check > Release Check - Released 

Case1:  

Print T5018 Forms:  

 

Accounts Payable > Utilities > Print T5018 Forms – Print T5018 
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T5018: 
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T5018S:  

 

 

Case2: When unchecked system will include check based on check post date  

Print T5018 Forms:  
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Accounts Payable > Utilities > Print T5018 Forms – Print T5018 

T5018: 
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T5018S: 
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SC Waiver report for joint check functionality (21.41887) 

Overview 

New SC waiver report added in ‘Print Check’ program.  

• Unconditional Waiver and Release of Lien for Nevada Joint Payee  

• Report Code: SC_JOINT_UNC_NEVADA 

Modifications 

SC Unconditional Joint Waiver for Nevada report format is added to ‘Select SC Waiver Report’ drop-
down in ‘Print Check’ program.  

 

Accounts Payable > Payments > Check – ‘Print Check’ tab – ‘Select SC Waiver Report’ drop-down 

Implementation 

Company: CMIC 

Request for Payment is entered and following invoices are created with Joint Payee.  

 

Subcontract Management > Payments > Enter Request for Payment 

 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  177 

 

Subcontract Management > Payments > Enter Request for Payment 

Selection Code: 50 

 

Accounts Payable > Payment > Select Payments 

Prepare Check: 

 

Accounts Payable > Check > Prepare Checks 
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Print Check: 

 

Accounts Payable > Check > Print Check 

 

Accounts Payable > Check > Print Check – SC Unconditional Waiver and Release of Lien for Nevada Joint 
Payee report configuration 
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AP/PY Positive Pay format for Bank of Hawaii (21.42447) 

Overview 

Added AP/PY Positive Pay format.  

• HAWAIIBANK: Positive Pay file format to be assigned in ‘Banks’ program.  

Modifications 

Highlighted record shows the new ‘HAWAIIBANK’ positive pay file format. 
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System Data > Global Tables > Banking > Banks 

Implementation 

Assign HAWAIIBANK positive file format to a bank code in bank maintenance program.  

 

System Data > Global Tables > Banking > Banks 

Process Multipositive Pay File using ‘Create AP/PY Combined positive pay program.  

 

Accounts Payable > Checks > Positive Pay Register > Create AP/PY Combined positive pay file 

File Format:  

 

EFT Format for BMO Harris 3 (21.41494) 

Overview 

Added EFT format for BMOHarris3.   

Modifications 

The EFT Format Setup has an entry for ‘BMOHARRIS3’ and the code values may be set as required 
by the bank or the customer. During check printing, users must select this format code to produce an 
EFT File. 
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System Data > Global Tables > Banking > Banks 

Implementation 

Prepare Checks 

Selection Code: T1 

 

Accounts Payable > Check > Prepare Checks 

Print Checks: 

EFT File Format: BMO Harris Bank – NACHA Format 3  

EFT File Code: BMOHARRIS3 

 

Accounts Payable > Check > Print Checks 
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Generated EFT File: 

 

Specifications: 
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Rabobank Euro Payment and World Payment EFT xml format 
(21.39508) 

Overview 

Added EFT xml format for Rabobank Euro payment and world payment.   

Modifications 

The EFT Format Setup has an entry for ‘RABOBNKEP’ and ‘RABOBNKWP’, the code values may be 
set as required by the bank or the customer. During check printing, users must select this format code 
to produce an EFT File. 

 

Accounts Payable > Setup > Global Tables > EFT Formats 

 

Accounts Payable > Setup > Global Tables > EFT Formats 

Implementation 

Print Checks: 

EFT File Format: Rabo Bank Euro Payment XML Format  

EFT File Code: RABOBNKEP 

Selection Code: D5 
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Accounts Payable > Checks > Print Checks – Print Checks 

XML File: 

 

Print Checks: 

EFT File Format: Rabo Bank World Payment XML Format  

EFT File Code: RABOBNKWP 

Selection Code: D5 
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Accounts Payable > Checks > Print Checks – Print Checks 

XML File: 

 

Specifications:  

 

WORLD Payment XML File Format File Comments 

<?xml version="1.0" encoding="UTF-8"?> 

 

-<Document xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns="urn:iso:std:iso:20022:tech:xsd:pain.001.001.03"> 

-<CstmrCdtTrfInitn> 

 

-<GrpHdr>   
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<MsgId>GPF.1B-WP1P-20180208</MsgId> Unique file identification.  

<CreDtTm>2018-02-08T13:54:00</CreDtTm> Creation date and –time of the file. Example: “2017-
02-28T09:10:15”.  

<NbOfTxs>1</NbOfTxs> Number of payments in the file. 

<CtrlSum>0.94</CtrlSum> Total/sum of all the individual payments, regardless 
of the currency. Decimals are separated by a point 
“.”.  

-<InitgPty> 

 

<Nm>Rabobank</Nm> Name of the ordering party.  

</InitgPty> 

 

</GrpHdr>   

-<PmtInf>   

<PmtInfId>1B-SCT1P-01</PmtInfId> Unique reference number for the batch/PI 

<PmtMtd>TRF</PmtMtd> Fixed mandatory value ‘TRF’ for payments 

<BtchBookg>false</BtchBookg> When the value ‘true’ is provided for Europayments, 
only the total amount will be shown in one debit 
transaction in the account information. When the 
value ‘false’ is provided all Europayments will be 
presented individually in the account information.  
When this tag is not provided Rabobank will use the 
value ‘true’ when processing the Europayments.  

-<PmtTpInf> 

 

-<SvcLvl> 

 

<Cd>NURG</Cd> The Rabobank only accepts one of the following 
values: NURG, URGP, SDVA, SEPA.  
SEPA for Europayments 
URGP for Urgent Domestic Europayments and 
Urgent Europayments.  
SDVA, NURG and URGP1 for Worldpayments and 
Multibank Payments  
For Worldpayments, Urgent Europayments, Urgent 
Domestic Payments and Multibank payments it is 
mandatory to provide one of the mentioned values. 
When the Servicelevel/Code is omitted all payments 
will be processed as Europayments and 
consequently be rejected.  This tag/field may only be 
provided on (this) batch level.   

</SvcLvl> 

 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  191 

</PmtTpInf> 

 

<ReqdExctnDt>2018-02-08</ReqdExctnDt> This is the date on which the originator’s account is 
to be debited. When a date is provided which is until 
14 days in the past this date is changed by 
Rabobank to the first possible processing date; 
when a date is provided which is older than 14 days 
the batch will be rejected. It is possible to provide a 
date for future processing until 365 calendar days. 

-<Dbtr>   

<Nm>Initiating Account</Nm> The name of the initiating party is mandatory. For 
Urgent Domestic Europayments the name provided 
in this tag/field will be used; For Europayments, 
Worldpayments, Multibank payments and Urgent 
Domestic Europayments the name provided will be 
overwritten with the statutory name as registered for 
the account by Rabobank.  

</Dbtr> 

 

-<DbtrAcct> 

 

-<Id> 

 

<IBAN>NL10RABO0350800375</IBAN> IBAN account number of the initiating party. Only 
use numbers and capital letters in the IBAN, usage 
of spaces is not allowed. 

</Id> 

 

<Ccy>EUR</Ccy> ISO currency code of the account. For 
Europayments, Urgent Europayments, Urgent 
Domestic Europayments and Multibank payments 
the currency code of the account is not mandatory.  
For Worldpayments it is mandatory to provide the 
currency code of the account in this tag/field.   - 
When the currency code of the account is provided, 
the following rules apply: EUR-account, payment 
currency non-EUR, is allowed (will be processed). 
USD-account (example), payment currency JPY: will 
be processed for Rabobank WRR1  accounts. USD-
account (example), payment currency JPY: will not 
be processed for Rabobank (Nederland)2 accounts, 
the payment will be rejected 

</DbtrAcct>   

-<DbtrAgt> 

 

-<FinInstnId> 

 

<BIC>RABONL2U</BIC> SWIFT BIC code from the bank of the initiating 
party. This field/tag is optional [0..1] however 
necessary (and therefore mandatory) for Multibank 
payments when the account of the initiating party is 
held with a bank outside of the SEPA area . Only 
numbers and capital letters are allowed. 
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</FinInstnId> 

 

</DbtrAgt> 

 

<ChrgBr>DEBT</ChrgBr> For Europayments only the value ‘SLEV’ is allowed.   
For Urgent Domestic Payments, Urgent 
Europayments, Worldpayments and Multibank 
payments within the EER only the value ‘SHAR’ is 
allowed.  
For all other Worldpayments and Multibank 
payments the following values are allowed: CRED - 
all costs for the beneficiary (BEN) DEBT - all costs 
for the initiating party (OUR) SHAR - costs are 
shared between the initiating party and the 
beneficiary  (SHA) Note: When no value is provided 
the option SHAR will be used. 
ChargeBearer may be present on this level or 
transaction level (2.51) but not on both levels.  

-<CdtTrfTxInf>   

-<PmtId> 

 

<InstrId>InstrId-1B-WP1P-01</InstrId> Instructions from the initiating party for Rabobank. 
This tag/field is not forwarded to the bank of the 
beneficiary.  

<EndToEndId>End2EndId-1B-WP1P-
01</EndToEndId> 

End-to-End ID for the payment, will be forwarded to 
the beneficiary bank for Europayments. Note: the 
payment order will be rejected when this tag is only 
filled with one or more spaces.   

</PmtId> 

 

-<PmtTpInf>   

<InstrPrty>NORM</InstrPrty> Either the value ‘NORM’ or ‘HIGH’ is allowed.  The 
value specified will be ignored during processing 

</PmtTpInf> 

 

-<Amt> 

 

<InstdAmt Ccy="USD">0.94</InstdAmt> Amount of the payment. Decimals are separated 
with a point “.”. The amount provided must be a 
value between 0.01 and 999,999,999.99 (technical 
limit), where the ‘real’ possible upper limit is 
determined by regulatory restrictions for the selected 
payment type. The currency for the amount must be 
provided within the tag: <InstdAmt Ccy=”XXX”> 
where XXX must be a valid ISO currency code (f.e. 
EUR, USD, GBP, JPY, etc.).  

</Amt> 

 

-<CdtrAgt> 

 

-<FinInstnId> 

 

-<ClrSysMmbId> 

 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  193 

-<ClrSysId> 

 

<Cd>USABA</Cd> This field is mandatory to identify the MemberID.  

</ClrSysId> 

 

<MmbId>026005092</MmbId> The national bank code for the “Clearing System” 
bank in the country where the bank of the 
beneficiary resides.  
Specifications of which the National Bank codes 
must fulfill can be found in ‘Appendix B – Payment 
information per country’ 

</ClrSysMmbId> 

 

<Nm>Wells Fargo Bank</Nm> Name of the bank of the beneficiary. For 
Worldpayments, Multibank payments and Urgent 
Europayments it is mandatory to provide this name 
when no BIC is provided.  

-<PstlAdr> 

 

<Ctry>US</Ctry> Country code of the country where the bank of the 
beneficiary resides. For Worldpayments, Multibank 
payments and Urgent Europayments it is mandatory 
to provide this code when no BIC is provided.  

</PstlAdr> 

 

</FinInstnId> 

 

</CdtrAgt> 

 

-<Cdtr> 

 

<Nm>United States Beneficiary</Nm> Name from the beneficiary, mandatory for all 
payment types.  
Note: for payments from RNB accounts applies that 
the name of the Creditor have a maximum length of 
35. If exceeding, the payment will be rejected.  

-<PstlAdr> 

 

<StrtNm>ONE WALL STREET</StrtNm> 

 

<PstCd>10286</PstCd> 

 

<TwnNm>NEW YORK</TwnNm> 

 

<Ctry>US</Ctry> 

 

</PstlAdr> 

 

</Cdtr> 

 

-<CdtrAcct> 
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-<Id> 

 

-<Othr> 

 

<Id>4527364524</Id> Account number of the beneficiary.  When a BBAN 
is specified for a country where usage of an IBAN is 
mandatory the payment will be rejected 

</Othr> 

 

</Id> 

 

</CdtrAcct> 

 

-<RmtInf> 

 

<Ustrd>Batch containing one World Payment 
(WP)</Ustrd> 

For Europayments all 140 positions will be read and 
processed. For Urgent Domestic Europayments only 
the first 96 positions will be read and processed. For 
Worldpayments, Multibank payments and Urgent 
Europayments only the first 98 positions will be read 
and processed. Please note: For all 
payments/payment types there is a maximum of only 
one (1) Unstructured remittance line.   

</RmtInf> 

 

</CdtTrfTxInf>   

</PmtInf>   

</CstmrCdtTrfInitn> 

 

</Document> 

 

 

 

EURO XML File Format File Comments 

-<Document xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns="urn:iso:std:iso:20022:tech:xsd:pain.001.001.03"> 

-<CstmrCdtTrfInitn> 

 

-<GrpHdr>   

<MsgId>GPF.1B-SCT1P-20171214-01</MsgId> Unique file identification.  

<CreDtTm>2017-12-14T11:30:00</CreDtTm>  Creation date and –time of the file. Example: 
“2017-02-28T09:10:15”.  

<NbOfTxs>1</NbOfTxs> Number of payments in the file. 

<CtrlSum>0.12</CtrlSum> Total/sum of all the individual payments, 
regardless of the currency. Decimals are 
separated by a point “.”.  

-<InitgPty> 

 

<Nm>Rabobank</Nm> Name of the ordering party.  
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</InitgPty> 

 

</GrpHdr>   

-<PmtInf>   

<PmtInfId>1B-SCT1P-01</PmtInfId> Unique reference number for the batch/PI 

<PmtMtd>TRF</PmtMtd> Fixed mandatory value ‘TRF’ for payments 

<BtchBookg>false</BtchBookg> When the value ‘true’ is provided for 
Europayments, only the total amount will be 
shown in one debit transaction in the account 
information. When the value ‘false’ is 
provided all Europayments will be presented 
individually in the account information.  When 
this tag is not provided Rabobank will use the 
value ‘true’ when processing the 
Europayments.  

<ReqdExctnDt>2017-12-15</ReqdExctnDt> This is the date on which the originator’s 
account is to be debited. When a date is 
provided which is until 14 days in the past 
this date is changed by Rabobank to the first 
possible processing date; when a date is 
provided which is older than 14 days the 
batch will be rejected. It is possible to provide 
a date for future processing until 365 
calendar days. 

-<Dbtr>   

<Nm>Initiating Party Name</Nm> The name of the initiating party is mandatory. 
For Urgent Domestic Europayments the 
name provided in this tag/field will be used; 
For Europayments, Worldpayments, 
Multibank payments and Urgent Domestic 
Europayments the name provided will be 
overwritten with the statutory name as 
registered for the account by Rabobank.  

-<PstlAdr> For Europayments and Urgent Domestic 
Europayments the fields Country and 
AddressLine are available, these are not 
mandatory.           For Worldpayments, 
Urgent Europayments and Multibank 
payments the fields StreetName, PostCode, 
TownName en Country are available.  

<Ctry>NL</Ctry>   

<AdrLine>Dbtr Streetname Housenumber 
123</AdrLine> 

 

<AdrLine>Dbtr Postal Code and City</AdrLine> 

 

</PstlAdr> 

 

</Dbtr>   
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-<DbtrAcct>   

-<Id> 

 

<IBAN>NL10RABO0350800375</IBAN> IBAN account number of the initiating party. 
Only use numbers and capital letters in the 
IBAN, usage of spaces is not allowed. 

</Id> 

 

<Ccy>EUR</Ccy> 

 

</DbtrAcct> 

 

-<DbtrAgt> 

 

-<FinInstnId> 

 

<BIC>RABONL2U</BIC> SWIFT BIC code from the bank of the 
initiating party. This field/tag is optional [0..1] 
however necessary (and therefore 
mandatory) for Multibank payments when the 
account of the initiating party is held with a 
bank outside of the SEPA area . Only 
numbers and capital letters are allowed. 

</FinInstnId> 

 

</DbtrAgt>   

<ChrgBr>SLEV</ChrgBr> When present, i.e. when no BIC has been 
provided, Rabobank advises to provide the 
value ‘NOTPROVIDED’ in this field, however 
this value is not validated by Rabobank.  

-<CdtTrfTxInf>   

-<PmtId> 

 

<InstrId>InstrId-1B-SCT1P-01</InstrId> Instructions from the initiating party for 
Rabobank. This tag/field is not forwarded to 
the bank of the beneficiary.  

<EndToEndId>End2EndId-1B-SCT1P-
01</EndToEndId> 

End-to-End ID for the payment, will be 
forwarded to the beneficiary bank for 
Europayments. Note: the payment order will 
be rejected when this tag is only filled with 
one or more spaces.   

</PmtId> 

 

-<PmtTpInf> 

 

-<SvcLvl> 

 

<Cd>SEPA</Cd> For Europayments via Generic Payment File 
this tag is not mandatory and may be 
presented on this (payment) level or on 2.8 
batch level, but not on both levels.  When 
specified on this level for Europayments, only 
the value SEPA is allowed. For 
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Worldpayments, Urgent Europayments, 
Urgent Domestic Payments and Multibank 
payments it is not allowed to provide a value 
for this tag/field, for these payments it is only 
allowed to provide a value on 2.9 batch level. 

</SvcLvl> 

 

</PmtTpInf> 

 

-<Amt> 

 

<InstdAmt Ccy="EUR">0.12</InstdAmt> Amount of the payment. Decimals are 
separated with a point “.”. The amount 
provided must be a value between 0.01 and 
999,999,999.99 (technical limit), where the 
‘real’ possible upper limit is determined by 
regulatory restrictions for the selected 
payment type. The currency for the amount 
must be provided within the tag: <InstdAmt 
Ccy=”XXX”> where XXX must be a valid ISO 
currency code (f.e. EUR, USD, GBP, JPY, 
etc.).  

</Amt> 

 

-<CdtrAgt> 

 

-<FinInstnId> 

 

<BIC>RABONL2U</BIC> SWIFT BIC code of the bank of the 
intermediary agent.  Only numbers and 
capital letters are allowed.  

</FinInstnId> 

 

</CdtrAgt> 

 

-<Cdtr> 

 

<Nm>Beneficiary Name</Nm> Name from the beneficiary, mandatory for all 
payment types. Note: for payments from 
RNB accounts applies that the name of the 
Creditor have a maximum length of 35. If 
exceeding, the payment will be rejected.  

-<PstlAdr>   

<Ctry>NL</Ctry> 

 

<AdrLine>Cdtr Streetname Housenumber 
123</AdrLine> 

 

<AdrLine>Cdtr Postal Code and City</AdrLine> 

 

</PstlAdr> 

 

</Cdtr> 

 

-<CdtrAcct> 
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-<Id> 

 

<IBAN>NL26RABO0300091494</IBAN> 

 

</Id> 

 

</CdtrAcct> 

 

-<RmtInf> 

 

<Ustrd>Batch containing one Sepa Credit Transfer 
(SCT)</Ustrd> 

For Europayments all 140 positions will be 
read and processed. For Urgent Domestic 
Europayments only the first 96 positions will 
be read and processed. For Worldpayments, 
Multibank payments and Urgent 
Europayments only the first 98 positions will 
be read and processed. Please note: For all 
payments/payment types there is a maximum 
of only one (1) Unstructured remittance line.   

</RmtInf> 

 

</CdtTrfTxInf>   

</PmtInf>   

</CstmrCdtTrfInitn> 

 

</Document> 

 

 

Nvoicepay Integration with CMiC (20.28619) (Beta Version) 

Overview 

Nvoicepay integration with CMiC 

Pre-requisites 

The following prerequisites are required prior to using Comdata: 

 • CMiC Nvoicepay license. Please contact a CMiC Account Manager for more information. 

 • Nvoicepay account or need to be an existing Nvoicepay user.  

Set Up EFT File Format 

 

Account Payable > Setup > Global Tables > EFT Formats 
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Use the EFT File Format screen to set up the Electronic File Transfer (EFT) format for the banks from 
which EFT payments will be made. 

Client ID and Client Secret information is provided by Nvoicepay and maintained by system 
administrators.  

Display [Comdata/NVP] Button on Prepare Checks Screen using Lite Editor 

 

Pgm: APCHQPRE – Prepare Checks; standard Treeview path: Accounts Payable > Check > Print Checks – 
[Comdata/NVP] button 

The [Comdata/NVP] button is located on the Prepare Checks screen in the Accounts Payable 
module and by default it is hidden. This button is made visible using Lite Editor. 

 

Displaying [Comdata/NVP] button on Prepare Checks screen using Lite Editor 

Maintain Vendors 

Vendor maintenance must have the highlighted mandatory fields entered. Once all the required fields 
are entered, user will be able to generate request file.  
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Pgm: BPVENFM – Maintain Vendors; standard Treeview path: Accounts Payable > Setup > Maintain Vendors – 
Accounting tab 

The mandatory fields to be completed in the ‘Accounting’ tab are shown in the screenshot below. 

Although banking details are not requested or processed by NVP, when the ‘EFT Payments’ radio 
button is selected on the Select Payments screen, a vendor’s bank account details must also be 
completed in the Maintain Vendors screen. A valid bank account number can be entered in the 
Account Number field, or a dummy account number can be entered (e.g. #999999). 

 

Pgm: APCHQPRE – Prepare Checks; standard Treeview path: Accounts Payable > Check > Print Checks 
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Preparing Checks for a Selection Code 

Step 1: Create Payment Selection Code and Select Payments 

 

Pgm: PAYSEL – Select Payments; standard Treeview path: Accounts Payable > Payment > Select Payments 

Use the Select Payments screen to create a one-time payment selection code. Select the ‘EFT 
Payments’ radio button and specify any other criteria by which to select invoices associated with the 
payment selection code. Click the [Add Invoices] button on the Select Payments screen to display 
the list of matching invoices and select which invoices to associate to the payment selection code. 
When finished, click on [Save]. 

Step 2: Generate NVP Payment/Request File 

On the Prepare Checks screen, enter/select the company and selection code, and check the ‘Use 
Voucher Bank Acc’ checkbox. Click on the [Prepare Checks] button.  

 

Accounts Payable > Checks > Print Checks – Prepare Checks 

The [Prepare Checks] button changes to [Renumber Checks]. A message appears at the top of the 
screen to indicate the total number of checks prepared and the [Comdata/NVP] button is enabled. 
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Accounts Payable > Checks > Print Checks – Prepare Checks – [Comdata/NVP] button 

Click on the [Comdata/NVP] button to launch a pop-up window to initiate the payment/request file 
generation process. 

 

Pop-up launched from [Comdata/NVP] button on Prepare Checks screen 

All records must be valid in the Status column for the [Generate Request File] button to be enabled.  

If mandatory fields are not entered properly in the Maintain Vendors screen, as discussed in the 
previous step, the [Generate Request File] button will not be enabled. 

Clicking on [Generate Request File] will launch prepare checks pop-up. Select the file code and EFT 
format from the LOV.  

File Code: NVOICEPAY 
EFT Format: NVOICEPAY 
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Accounts Payable > Checks > Print Checks – Prepare Checks – [Comdata/NVP] button – [Generate Request 
File] button pop-up 

 

Accounts Payable > Checks > Print Checks – Prepare Checks – [Comdata/NVP] button – [Generate Request 
File] button pop-up 

[Transfer Payment Info to NVP] button is enabled once the mandatory fields are populated. 

 

Accounts Payable > Checks > Print Checks – Prepare Checks – [Comdata/NVP] button – [Generate Request 
File] button pop-up 

Taskflow process runs upon clicking on [Transfer Payment Info to NVP] button.  
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Accounts Payable > Checks > Print Checks – Prepare Checks – [Comdata/NVP] button – [Generate Request 
File] button pop-up – Taskflow process 

Alert message is displayed with status as ‘DoneParsing’.  

 

Accounts Payable > Checks > Print Checks – Prepare Checks – [Comdata/NVP] button – [Generate Request 
File] button pop-up – Alert box 

Use [Comdata/NVP] button to verify the NVP status column in prepare checks pop-up.  

 

Accounts Payable > Checks > Print Checks – Prepare Checks – [Comdata/NVP] button pop-up 

Step 3: Approve NVP Payments 
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Go to AP Gateway to approve the payments. 

Click on [View] button to approve the file which is awaiting approval.  

 

AP Gateway - Payments 

Status of the file is ‘Awaiting Approval’ Click on [Approve Batch] button to the approve the whole 
batch.  

CMiC integration requires BATCH APPROVAL only. 

 

AP Gateway - Payments 

Once the batch is approved, status is changed to Approved.  
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AP Gateway - Payments 

 

AP Gateway - Payments 

Step 4: Post Checks 

Once the payment is approved on AP Gateway, go to AP > Prepare Checks – populate the same 
selection code as in step 1. Click on [Comdata/NVP] button to launch the pop-up.  

NVP Batch status is updated to ‘ReturnFileReady’, alert message is displayed upon clicking [Get 
NVP Batch Status].  

 

Accounts Payable > Checks > Print Checks – Prepare Checks – [Comdata/NVP] button – [Get NVP Batch 
Status] status alert box 
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[Post Checks] button is enabled when the NVP Status column reads ‘ReturnFileReady’  

 

Accounts Payable > Checks > Print Checks – Prepare Checks – [Comdata/NVP] button pop-up – [Post Checks] 

Post Check pop-up will be launched upon clicking [Post Checks] button. Populate the posting date 
and click on [Post] button.  

 

Post Check pop-up 

Report configuration runs and batch is posted successfully.  

 

Post Checks pop-up – Report Configuration 

‘Batch Posted successfully’ is displayed in the message box and batch number is auto-populated.  
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Check Reconciliation and Check Release features 

‘Check Reconciliation Date’ field will be enabled when the AP control file flag ‘Automatically Populate 
Check Reconciliation Date’ is set as Y (checked).  User must enter reconciliation date as required. 

‘Check Release Date’ field will be enabled when the AP control file flag ‘Use Check Release Feature’ 
is set as Y(checked). User must enter release date as required 

Vat Payment Enhancement - International (21.40611) (Beta Version) 

Overview 

Modification to VAT payment calculation for international clients.  

New fields are added in the following programs: 

 AP Control File: Reverse Tax Charge flag  

Tax Table Maintenance: Tax Authorities, Tax English Translation, Tax Reverse Charges flag, Tax 
Description  

New VAT Submission report (GL_VATINFO) is created. 
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Modifications 

 

Accounts Payable > Setup > Control File – Reverse Tax Charge Flag 

Reverse Tax Charge Flag: By default, the flag is un-checked. 

 

System Data > Global Tables > Tax Code – Tax Table Maintenance 

Tax Reverse Charge: By default, the flag is un-checked. 

Implementation 

AP Control File: Reverse Tax Charges flag must be checked  
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Tax Maintenance: Tax code on Tax Table maintenance program must have Tax Reverse Charges 
flag checked, Tax Authorities, Tax Description and Tax English Translation fields must be entered as 
required.  

 

Voucher Entry: 

Tax1: 495.00  

Click on [Distribution] button, system will automatically create reverse tax and nullify the tax amount. 
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Accounts Payable > Voucher > Enter Voucher 

 

Accounts Payable > Voucher > Enter Voucher – Distribution Pop-up 
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Accounts Payable > Voucher > Enter Voucher 

Posting Reports:   
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New AP EFT Format for First Republic Bank ‘FREPUBLBNK’ 
(21.43534) 

New AP EFT Format for First Republic Bank ‘FREPUBLBNK’ 

 
Modifications: 
 
Created a new AP EFT format for ‘First Republic Bank’-FREPUBLBNK 
Following field values will be used in the file format. 
 
File Header Record 
Immediate Destination (321081669) 
Immediate Origin (321081669) 
Immediate Destination Name (FIRST REPUBLIC BANK) 
 
Batch Header Record 
Service Class Code (200) 
Company Identification (Company Federal Tax ID from company setup) 
Standard Entry Class Code (CCD) 
Company Entry Description (PAYMENT) 
Originating DFI Identification (32108166) 
 
Entry Detail Record (One details record per vendor) 
Transaction Code (22) 
Receiving DFI Identification (Bank Transit number from vendor setup) 
DFI Account Number (Bank Account number from vendor setup) 
Receiving Company Name (Vendor name) 
Addenda Record Indicator (1) 
 
Addenda Record (One addenda record for each detail record) 
Addenda Type Code (05) 
Payment Related Information (List of invoice codes - up to 80 chars max length file limit). 
 
Batch Control Record 
Service Class Code (200) 
Originating DFI Identification (32108166) 
 
Setup and Printing: 
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AP>Setup>Global Tables>EFT Formats 

 
 

 

AP>Check>Print Checks 

 
The following sample EFT file is generated as per the FREPUBLBNK format code: 
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New AP EFT Format for CIBC Bank Wire Transfer (21.47984) 
 

Added new EFT format for CIBC Bank Wire Transfer 
 
Modifications: 
 
Created a new AP EFT file format for CIBC bank for WIRE payments. There will be no change in the 
EFT payment process. 
This file will be Comma Delimited file format. There will be no header and trailer record, only detail 
records. 
This will print one single payment line for each vendor on payment selection. 
 
Debit Field Properties Information (Required) -- This section contains the Payer details 
 
ABA / TRC (Bank Account setup - Transit field) 
Account Type (C - Checking - will be used) 
Account Number (Bank Account setup - Bank Account Number field) 
Amount (Total Vendor payment amount) 
Send on date (Check date on payment selection) 
Currency (Payment currency) 
 
Recipient Field Properties Information (Required) -- This section contains the Payee details 
 
Bank ID type (ABA will be used) 
Bank ID (Vendor setup - Accounting Tab - Bank Transit field) 
Recipient Account# (Vendor setup - Accounting Tab - Bank Account Number field) 
Bank Name (Bank setup - Name field, associated with vendor bank ID field) 
Bank Address 1 (Blank as this is optional) 
Bank Address 2 (Blank as this is optional) 
Bank Address 3 (Blank as this is optional) 
Recipient Name (Payee name - BP Name on business partner) 
Recipient Address 1 (Vendor setup - Vendor Tab - Street field) 
Recipient Address 2 (Vendor setup - Vendor Tab - Suite field) 
Recipient Address 3 (Vendor setup - Vendor Tab - City field) 
Additional Info for Recipient (Keeping Blank as this is optional) 
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Wire Initiator Field Properties (Required) 
 
Wire Initiator Name (Since this is same for all records printed on the file so, this field must be defined 
on AP EFT setup screen) 
Wire Initiator Address1 (Since this is same for all records printed on the file so, this field must be 
defined on AP EFT setup screen) 
Wire Initiator Address2 (Since this is same for all records printed on the file so, this field must be 
defined on AP EFT setup screen) 
Wire Initiator Address3 (Since this is same for all records printed on the file so, this field must be 
defined on AP EFT setup screen) 
 
Note: The following two sections columns are optional, nothing will be printed on this section. 
 
First Intermediary Field Properties Information (Optional) 
Second Intermediary Field Properties Information (Optional) 
 

Setup and Printing: 

 

AP>Setup>Global Tables>EFT Formats 
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AP>Check>Print Checks 

The following sample EFT file is generated as per the CIBCBNKWIR format code: 

 

New AP Positive Pay File Format for Key Bank (21.50180) 
 

New AP Positive Pay file format for Key Bank- KEYBANK_3 
 
Modifications: 
 
CMiC added a new positive pay format for key bank (KEYBANK_3) that includes payee 
name. 
 
Setup and Testing: 
 
Create a bank group using the new format code and add bank accounts. 
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Create a register by entering the bank group and clicking on [PROCESS] 
 

 
 
A positive pay file is generated as per the specs showing the payee’s name: 
 

 
 

New AP Bank Reconciliation File Format for Scotia Bank (21.51435) 
 
New AP Bank Reconciliation format added - ‘SCOTIABANK ‘ 
 
Modifications: 
 
CMIC added a new Bank Reconciliation format for Scotia bank as per the file format "Delimited ASCII 
Format File Specifications". 
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Following field values from the file will be used for reconciliation: 
 
Field#6 - Transit & Account Number TTTTTAAAAAAA - Account Number will be read from this 
column, last 7 digits 
Field#25 - Amount - Amount Paid will be read from this column 
Field#28 - Value Date (Format: DDMMMYYYY) - Reconciliation Date will be read from this column 
Field#32 - Reference Information - Cheque Number will be read from this column 
 
From the file, only TRANSACTION RECORDS will be read for Cheque payments which have the 
following values for reconciliation: 
 
Field#14 - Debit or Credit Indicator - D = Debit (Only read D type of transactions) 
Field#18 - BAI2 Code of the Transaction - 475 (Only read 475 code of transactions) 
Field#22 - Mnemonic Code Description - CHQ (Only read CHQ code type of transactions) 
 
Setup and Printing: 
 
Assign the new format ‘SCOTIABANK’ to the bank 
 

 

System Data > Global Tables > Banking > Banks 

Sample Bank Reconciliation file: 
 

 
 
Process the Bank check Reconciliation 
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System Data > Global Tables > Banking > Electronic Reconciliation > Bank Reconciliation 

 

System Data > Global Tables > Banking > Electronic Reconciliation > Bank Reconciliation 

 
Verify by printing the Bank Reconciliation Report (BA1000) 
 

 

COMDATA – Discrete Checks and Payments (22.52492) 

AP Check Preparation program prepares discrete checks for a vendor when the AP Invoice flag 
‘Discrete Checks’ is set as ‘Y’. Users can now configure the COMDATA settings on their COMDATA 
account log in in the following two ways. The radio option ‘Create Virtual Card By’ can be set as 
required by the client’s business requirements.  

1. Create virtual Card By: Supplier Code 

a. Setting the option ‘Supplier Code’ will generate PS21 files with the Card Token unique by 
a Vendor code and hence regardless of discrete checks flag at CMIC, all the payments 
will be grouped by COMDATA and payment is made as a single payment. 

2. Create Virtual Code By: Virtual Card Invoice Number 
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a. Setting the option as ‘Virtual Card Invoice Number’ will generate PS21 files with discrete 
token numbers by COMDATA as per the check numbers. The payments from COMDATA 
will then be discrete for discrete checks and grouped for grouped checks for a vendor. 

The PS20 file generated from CMIC now will have the Column 33 populated with full check numbers 
with 11 characters as generated by CMiC Check preparation program. This column 33 values are 
used by COMDATA to issue discrete or grouped payments when the radio option in COMDATA 
configurations is set to ‘Virtual Card Invoice Number’. 

 

The following examples show how the payments are issued by COMDATA based on the 
configuration settings. 

 

 

Comdata Configuration screen for client’s accounts 
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COMDATA – Delete Check Button (21.48799) 

The COMDATA pop-up in Prepare Checks screen is added with ‘Delete Check’ button. This button 
will be enabled only on records where the card token numbers are not populated. Users now can 
delete the checks that are in a selection code, with some of them already with card token numbers 
and linked to COMDATA processing.  



Working Document R12 New Functionality R12 New Functionality (Draft)  •  223 

 

NOTE: This ‘Delete Check’ button will be disabled for records with Card Token Numbers as they are 
linked to COMDATA processing already. 

EFT Last Check Sequence Number (21.47899) 

Overview 

AP Control file is modified to include ‘EFT Last Check Sequence Number’ input field.  

This field is hidden by default, users must use lite editor to make it visible.  

 

Accounts Payable > Setup > Local Tables > Control File – Check tab 

EFT Last Check Sequence Number: Input field showing the last check sequence number for EFT 
check. The latest EFT check sequence number will be an increment to last check sequence number 
in AP control file.  

EFT Last Check sequence number is updated as soon as checks are prepared.  
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If checks are processed using Pay Run group, system will use the last check sequence number of the 
paying company.  

NOTE: Going forward CMiC may have SAME check sequence number across multiple companies. 
Previously check sequence numbers were unique across all companies and hence the sequence 
number was used by Non-EFT and EFT checks. With this modification, EFT check numbers will have 
company specific check sequence number.  If EFT Last check sequence number is 0 or NULL, the 
next EFT check sequence number will be 1.  

Warning: Users normally should not be updating this field unless otherwise required and be 
performed by administrators. A role level system privilege to access this field will be provided in the 
future release, also validations will be added when users update this field. 

The field will be automatically updated to current last check sequence number in the system for all the 
companies with this installation.  

Implementation 

 
Selection Code: E1  

EFT Last Check Sequence Number for CCC company: 843 

 

Accounts Payable > Setup > Local Tables > Control File – Check tab 
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Accounts Payable > Payment > Select Payments 

Prepare Checks for E1 selection code  

 

Accounts Payable > Payment > Print Checks – Prepare Checks 

 

Accounts Payable > Setup > Local Tables > Control File – Check tab 
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Accounts Payable > Payment > Print Checks – 2nd Party Checks 

 

 

AP Check Report 

 

 

Accounts Payable > Payment > Print Checks – Post Check Run 

 

EFT and NON-EFT Checks  

Selection Code: E2  
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Accounts Payable > Payment > Select Payments 

 

Prepare Checks  

 

Accounts Payable > Payment > Print Checks – Prepare Checks 

 

Accounts Payable > Payment > Print Checks – 2nd Party Checks 
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AP Check Report 

 

Accounts Payable > Setup > Local Tables > Control File – Check tab 

 

 

Un-prepare Checks  

Selection Code: P3  
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Accounts Payable > Payment > Select Payments 

Prepare Checks  

 

Accounts Payable > Payment > Print Checks – Prepare Checks 

 

 

Accounts Payable > Payment > Print Checks – 2nd Party Checks 
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EFT Last Check Sequence is updated to 857. 

 

Accounts Payable > Setup > Local Tables > Control File – Check tab 

Unprepared Checks for selection code P3. 

 

Accounts Payable > Utilities > Unprepare Checks 

EFT Last Check Sequence number is still 857.  

 

Accounts Payable > Setup > Local Tables > Control File – Check tab 
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Prepare Checks for selection code P3.  

 

Accounts Payable > Payment > Print Checks – Prepare Checks 

 

Accounts Payable > Payment > Print Checks – 2nd Party Checks 

EFT Last Check sequence number is control file is updated to 861. 

 

Accounts Payable > Setup > Local Tables > Control File – Check tab 
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If Checks are unprepared, unprepared check numbers will be skipped. 

 

AP Check Logs 

Pay Run Group 

Selection code is selected from DHCOM and ZZ company for pay run group 2147899.  

 

Accounts Payable > Payment > Select Payments – Pay Run group 

EFT Last Check Sequence number:  

DHCOM – 843 

ZZ – NULL  

In the pay run group, paying company is ZZ. System will use EFT last check sequence number from 
ZZ company control file. Since, the value is NULL, system will start numbering from 1.  
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Accounts Payable > Setup > Local Tables > Control File – Check tab 

 

Accounts Payable > Setup > Local Tables > Control File – Check tab 

 

Accounts Payable > Payment > Print Checks – Prepare Checks   
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Accounts Payable > Payment > Print Checks – 2nd Party Check 

EFT Notification Email - Customization (21.51322) 

This enhancement is to pull the EFT notification email content from the TEXT Code Program and 
allow users to customize their EFT email notification Subject and Body. 

Modifications: 

1. The Attachment file name has been changed from APEFT to Vendorname.dateofeftfile- Example: 
BlockIron.20210806  

2. The Email Subject line is being pulled from the Text Code ‘Subject’ in TEXTFM Program 

3. The Email Body is being pulled from the Text Code ‘Email Body’ in TEXTFM Program 

Following shows the modifications performed: 

A new Text Type is added for EFT Notification Email 

 

 

Two new Text Codes have been created: 
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1. Subject  

2. Body 

 
 

On the Print Checks screen, there is an option to select EFT Email Body. As some of the clients 
process PY checks from AP, this field ‘EFT Email Body Text Code’ gives an option to choose a 
different email body. 

‘EFT Email Body Text Code’ field gets enabled when ‘EFT/TPPM Distribution’ checkbox is checked. 
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Below is an example of the EFT notification email content. 

 

Privilege to Edit Discount Amount through Adjust Voucher Status 
(21.51508) 

This enhancement is designed to give User a new privilege to change the discount amount through 
the Adjust Voucher Status program. 

Modifications: 

A New privilege ‘APVOUDISC’ has been added. This privilege is required to be able to update the 
discount amount on Adjust voucher status screen. 

Once the privilege has been given to the user, only for the open unpaid invoices (Not Partially/Fully 
paid) i,e vouchers that do not have any previous paid amount , discount amount field will be enabled 
in the Adjust voucher status screen. 

It is also required that in AP Control File options under Voucher tab, the Invoice Method is set to 
GROSS method. In case it is set to NET Method, the discount amount field will not be made available 
for update. 
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Also, this field will be enabled only for Normal vouchers. 

Following shows the modifications performed: 

New privilege ‘APVOUDISC’ required to be able to update the discount amount on Adjust voucher 
status screen. 

 

Path: System Data < Security < Users < User Maintenance 

AP Control File options under Voucher tab, the Invoice Method should be set to GROSS method. 

 

Path: AP < Setup < Local Tables < Control File Options 

Once the privilege has been given to the user, only for the open unpaid invoices (Not Partially/Fully 
paid) i,e vouchers that do not have any previous paid amount , discount amount field will be enabled 
in the Adjust voucher status screen. 
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Path: AP < Payment < Adjust Voucher Status 

For Partial Paid Vouchers the Discount Amount field will not be enabled with the privilege 
‘APVOUDISC’. 

 

For Deferred Vouchers the discount Amount field will not be enabled even with the privilege 
‘APVOUDISC’. 
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When the Invoice Method is set to ‘Net Method’, the Discount field will remain disabled even with the 
privilege ‘APVOUDISC’. 

 

'Vendor Name' Added to the List of Available Columns in 'Vendor 
Pick-List' Selection Criteria (22.53854) 

'Vendor Name' added to the list of available columns in 'Vendor pick-list' selection criteria. (13.81450 
was a customization for Pomerleau in V10 Forms, needs to be brought to R12 as well.) 

Modifications: 

It may be necessary to have vendor pick-list based on the starting alphabet of vendor names to group 
the vendors for reporting/querying purposes. 



240  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

The list of columns in the 'selection criteria' popup is modified with the addition of Vendor Name 
(BPVENDORS) 

 

Modification with an example: 
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Record Renumbered Checks as Wasted (21.50780) 

This enhancement is to maintain a proper Audit Trail of automatic check numbers 
generated/consumed by the system when the Checks are Renumbered. 

Modifications: 

A new flag “Record Renumbering Checks As Wasted” has been added on AP control file under 
Check tab. By default, this flag will be unchecked.  User will have to check this option manually.  

This flag when checked, records the renumbering checks as Wasted Checks. 

Following shows the modifications performed: 

New flag “Record Renumbering Checks As Wasted” added on AP control file under Check tab. By 
default, this flag will be unchecked.  User will have to check this option manually. 
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The Last Check Number on the Account 1000.100 is 159. 
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Check is prepared for Selection Code: ZM. 

 

 

The System picks up Check#160 as expected. Six checks are generated 160,161, 162, 163, 164, 
165. 
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Checks are Renumbered for Selection Code: ZM. 

 

 

Checks got renumbered starting from #166 as expected.  
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Six checks that got renumbered: 160,161, 162, 163, 164, 165 are present in Wasted Checks for Audit 
Trail purpose. 

 
 

New `Include Deposit’ Flag in AP Aging Summary Report AP1000S 

(21.50840) 

New `Include Deposit’ flag added in AP Aging Summary Report AP1000S 

Modifications: 

Include Deposit LOV parameter has been added in the AP Aging Summary Report AP1000S. 

Following shows the modifications performed with example: 

As shown below a Deposit is created for Vendor: N1Bricks for $500.00. 
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Run the ‘AP Aging Summary Report AP1000S’ with the ‘Include Deposit’ as Y. 
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As marked below, the Deposit entered for Vendor N1Bricks populates in the ‘AP Aging Summary 
Report AP1000S’. 
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Run the ‘AP Aging Summary Report AP1000S’ with the ‘Include Deposit’ as N. 
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As marked below, the Deposit entered for Vendor N1Bricks does NOT populates in the ‘AP Aging 
Summary Report AP1000S’ as the ‘Include Deposits’ parameter is set ‘N’ this time. 

 

 

Nvoicepay Rebranding to Corpay (22.53572)  

Overview 

Corpay integration with CMiC 

Pre-requisites 

The following prerequisites are required prior to using Corpay: 

 • CMiC Corpay license is required. Please contact a CMiC Account Manager for more information. 

 • Corpay account or need to be an existing Corpay user.  

Setup 

Set Up EFT File Format 
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Account Payable > Setup > Global Tables > EFT Formats 

Use the EFT File Format screen to set up the Electronic File Transfer (EFT) format for the banks from 
which EFT payments will be made. 

Client ID and Client Secret information is provided by Corpay and maintained by system 
administrators.  

Display [Corpay] Button on Prepare Checks Screen using Lite Editor 

 

 

Pgm: APCHQPRE – Prepare Checks; standard Treeview path: Accounts Payable > Check > Print Checks – 
[Corpay] button 

The [Corpay] button is located on the Prepare Checks screen in the Accounts Payable module and 
by default it is hidden. This button is made visible using Lite Editor. 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  251 

 

Displaying [Corpay] button on Prepare Checks screen using Lite Editor 

Maintain Vendors 

Vendor maintenance must have the highlighted mandatory fields entered. Once all the required fields 
are entered, user will be able to generate request file.  

 

Pgm: BPVENFM – Maintain Vendors; standard Treeview path: Accounts Payable > Setup > Maintain Vendors – 
Accounting tab 

The mandatory fields to be completed in the ‘Accounting’ tab are shown in the screenshot below. 

Although banking details are not requested or processed by CORPAY, when the ‘EFT Payments’ 
radio button is selected on the Select Payments screen, a vendor’s bank account details must also be 
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completed in the Maintain Vendors screen. A valid bank account number can be entered in the 
Account Number field, or a dummy account number can be entered (e.g., #999999). 

 

 

Pgm: APCHQPRE – Prepare Checks; standard Treeview path: Accounts Payable > Check > Print Checks 

Preparing Checks for a Selection Code 

Step 1: Create Payment Selection Code and Select Payments 

Selection Code: CP 
Prepare Checks  

Use the Select Payments screen to create a one-time payment selection code. Select the ‘EFT 
Payments’ radio button and specify any other criteria by which to select invoices associated with the 
payment selection code. Click the [Add Invoices] button on the Select Payments screen to display 
the list of matching invoices and select which invoices to associate to the payment selection code. 
When finished, click on [Save]. 
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Pgm: PAYSEL – Select Payments; standard Treeview path: Accounts Payable > Payment > Select Payments 

Step 2: Generate Corpay Request File 

On the Prepare Checks screen, enter/select the company and selection code, and check the ‘Use 
Voucher Bank Acc’ checkbox. Click on the [Prepare Checks] button. 

 

Accounts Payable > Checks > Print Checks – Prepare Checks 

 

Accounts Payable > Checks > Print Checks – Prepare Checks 

The [Prepare Checks] button changes to [Renumber Checks]. A message appears at the top of the 
screen to indicate the total number of checks prepared and the [Corpay] button is enabled. 
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Click on the [Corpay] button to launch a pop-up window to initiate the payment/request file generation 
process. 

 

Pop-up launched from [Corpay] button on Prepare Checks screen 

All records must be valid in the Status column for the [Generate Request File] button to be enabled.  

If mandatory fields are not entered properly in the Maintain Vendors screen, as discussed in the 
previous step, the [Generate Request File] button will not be enabled. 

Clicking on [Generate Request File] will launch prepare checks pop-up. Select the file code and EFT 
format from the LOV.  

File Code: CORPAY 
EFT Format: CORPAY 

 

Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button – [Generate Request File] 
button pop-up 

[Transfer Payment Info to Corpay] button is enabled once the mandatory fields are populated. 

Taskflow process runs upon clicking on [Transfer Payment Info to Corpay] button.  
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Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button – [Generate Request File] 
button pop-up – Taskflow process 

Alert message is displayed with status as ‘DoneParsing’.  

 

Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button – [Generate Request File] 
button pop-up – Alert box 

Use [Corpay] button to verify the Corpay status column in prepare checks pop-up.  
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Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button pop-up 

Step 3: Approve Corpay Payment batch 

Go to AP Gateway to approve the payments. 

Click on [View] button to approve the file which is awaiting approval.  

 

AP Gateway - Payments 
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AP Gateway - Payments 

Status of the file is ‘Awaiting Approval’ Click on [Approve Batch] button to the approve the whole 
batch.  

CMiC integration requires BATCH APPROVAL only. 

Once the batch is approved, status is changed to Approved.  

 

 

AP Gateway - Payments 

Step 4: Post Checks 

Once the payment is approved on AP Gateway, go to AP > Prepare Checks – populate the same 
selection code as in step 1. Click on [Corpay] button to launch the pop-up. Click on [Generate 
Request File] to launch Prepare Checks pop-up and click on [Get Corpay Batch Status] button. 
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Corpay Batch status is updated to ‘ReturnFileReady’, alert message is displayed upon clicking [Get 
Corpay Batch Status] button. 

 

 

Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button – [Get CORPAY Batch Status] 
status alert box 

[Post Checks] button is enabled when the CORPAY Status column reads ‘ReturnFileReady’.  

 

Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button – [Get CORPAY Batch Status] 
status alert box 

 

Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button pop-up – [Post Checks] 
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Post Check pop-up will be launched upon clicking [Post Checks] button. Populate the posting date 
and click on [Post] button.  

 

Post Check pop-up 

Report configuration runs and batch is posted successfully.  

 

 

Post Check pop-up – Report configuration 
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Post Check pop-up 

‘Batch Posted successfully’ is displayed in the message box and batch number is auto populated.  

Check Reconciliation and Check Release features 

‘Check Reconciliation Date’ field will be enabled when the AP control file flag ‘Automatically Populate 
Check Reconciliation Date’ is set as Y (checked).  User must enter reconciliation date as required. 

‘Check Release Date’ field will be enabled when the AP control file flag ‘Use Check Release Feature’ 
is set as Y(checked). User must enter release date as required.  

Hold Batch and Cancel Batch  

In AP Gateway payment approval, batch status can be set to ‘Hold Batch’ and ‘Cancel Batch’. 
Examples of these options are provided below. 

Hold Batch Option 

Payment Selection Code: CP 

Request file is generated and payment info is transferred to Corpay.  

 

 

Accounts Payable > Checks > Print Checks – Prepare Checks 
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Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button – [Get CORPAY Batch Status] 
status alert box 

Click on [Hold Batch] button, the payment status is changed to ‘On Hold’.  

 

 

 

 

 

 

 

AP Gateway - Payments 
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AP Gateway - Payments 

Click on [Get Corpay Batch Status] button, status returned is ‘DoneParsing’ and the [Post Checks] 
button is disabled, payment must be approved to post checks.  

 

 

 

 

 

Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button – [Get CORPAY Batch Status] 
status alert box 
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Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button 

Approve the ‘On Hold’ payment batch.  

 

 

AP Gateway - Payments 

Click on [Get Corpay Batch Status] button, status returned is ‘ReturnFileReady’ and the [Post 
Checks] button is enabled for posting.  
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AP Gateway - Payments 

  

 

Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button 

 

Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button 
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Post Check pop-up – Report configuration 

  

Cancel Batch Option 

Payment Selection Code: CP 

NOTE: Since the Cancel Batch option sets the batch as voided, users must take manual action in the 
CMIC application and cancel payments as required. 

 

Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button 
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AP Gateway – Payments 

 

File status is ‘Voided’.  

 

AP Gateway - Payments 
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Click on [Get Corpay Batch Status] button, status returned is ‘ReturnFileReady and the [Post 
Checks] button is enabled for posting.  

PCM Reports on Jasper Quartz to Send EFT Notifications Fast 
(22.55452) 

A new feature is added to schedule PCM reports on Jasper Quartz for sending EFT Notifications fast. 
This feature is optional. 

To turn on this feature, add the property below in cmicapp.properties file: 

uireport2.pcm.use.schedule=true 

There is no need to restart the server. 
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EFT Last Check Sequence Number (21.47899) 

AP Control file is modified to include ‘EFT Last Check Sequence Number’ input field.  

This field is hidden by default, users must use lite editor to make it visible.  



Working Document R12 New Functionality R12 New Functionality (Draft)  •  269 

 

Accounts Payable > Setup > Local Tables > Control File – Check tab  

EFT Last Check Sequence Number: Input field showing the last check sequence number for EFT 
check. The latest EFT check sequence number will be an increment to last check sequence number 
in AP control file.  

EFT Last Check sequence number is updated as soon as checks are prepared.  

If checks are processed using Pay Run group, system will use the last check sequence number of the 
paying company.  

NOTE: Going forward CMiC may have SAME check sequence number across multiple companies. 
Previously check sequence numbers were unique across all companies and hence the sequence 
number was used by Non-EFT and EFT checks. With this modification, EFT check numbers will have 
company specific check sequence number.  If EFT Last check sequence number is 0 or NULL, the 
next EFT check sequence number will be 1.  

Warning: Users normally should not be updating this field unless otherwise required and be 
performed by administrators.  

The field will be automatically updated to current last check sequence number in the system for all the 
companies with this installation.  

Hotfix V12-015-2HF Revision 1.0 

System Privilege: APUPDEFCHQ: Allow the user to update EFT cheque sequence number in AP 
control file. By default, privilege is un-checked for all the users. 

Checked: EFT Last Check Sequence field in AP control file is enabled for update, 

Un-checked: EFT Last Check Sequence field in AP control file is disabled. 
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System Data > Users > User Maintenance > System Privileges  

EFT Last Check Sequence number field in AP control file is disabled for update.  

 

Accounts Payable > Setup > Local Tables > Control File – Check tab 

Update the privilege for the user, EFT Last Check Sequence Number field will be enabled in AP 
control file.  

 

System Data > Users > User Maintenance > System Privileges 
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Accounts Payable > Setup > Local Tables > Control File – Check tab 

Updating EFT Last Check Sequence Number in AP Control file:  

Alert message will be displayed along with the last check sequence number in the system. Updated 
EFT last check sequence number to 4009, alert message is displayed since the system’s last check 
sequence is greater than the number entered. Alert message will also be displayed if user input last 
check sequence number greater than the maximum(system’s) last check sequence number.  

 

Accounts Payable > Setup > Local Tables > Control File – Check tab – Alert pop-up 

Click on [Continue] to update the EFT last check sequence number. Click on [Cancel] to abort the 
update of last check sequence number. Alert message will not be displayed if the updated last check 
sequence is equal to the maximum(system’s) last check sequence number.  
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 Accounts Payable > Setup > Local Tables > Control File – Check tab 

 

Implementation 

Selection Code: E1  

EFT Last Check Sequence Number for CCC company: 843 

 

Accounts Payable > Setup > Local Tables > Control File – Check tab 
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Accounts Payable > Payment > Select Payments 

 

Prepare Checks for E1 selection code  

 

 Accounts Payable > Payment > Print Checks – Prepare Checks  

 

 Accounts Payable > Setup > Local Tables > Control File – Check tab 
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Accounts Payable > Payment > Print Checks – 2nd Party Checks 

 

 
AP Check Report  

 

 Accounts Payable > Payment > Print Checks – Post Check Run  

 

EFT and NON-EFT Checks  

Selection Code: E2  
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 Accounts Payable > Payment > Select Payments 

 

Prepare Checks  

 

Accounts Payable > Payment > Print Checks – Prepare Checks 

 

Accounts Payable > Payment > Print Checks – 2nd Party Checks  
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AP Check Report 

 

Accounts Payable > Setup > Local Tables > Control File – Check tab 

 

 

Un-prepare Checks  

Selection Code: P3  
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Accounts Payable > Payment > Select Payments 

Prepare Checks  

 

Accounts Payable > Payment > Print Checks – Prepare Checks 

 

Accounts Payable > Payment > Print Checks – 2nd Party Checks 

EFT Last Check Sequence is updated to 857. 
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Accounts Payable > Setup > Local Tables > Control File – Check tab 

Unprepare Checks for selection code P3. 

 

Accounts Payable > Utilities > Unprepare Checks 

EFT Last Check Sequence number is still 857.  

 

Accounts Payable > Setup > Local Tables > Control File – Check tab 

Prepare Checks for selection code P3.  
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Accounts Payable > Payment > Print Checks – Prepare Checks 

 

Accounts Payable > Payment > Print Checks – 2nd Party Checks 

EFT Last Check sequence number is control file is updated to 861. 

 

Accounts Payable > Setup > Local Tables > Control File – Check tab 

If Checks are unprepared, unprepared check numbers will be skipped. 
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AP Check Logs 

Pay Run Group 

Selection code is selected from DHCOM and ZZ company for pay run group 2147899.  

 

Accounts Payable > Payment > Select Payments – Pay Run group 

EFT Last Check Sequence number:  

DHCOM – 843 

ZZ – NULL  

In the pay run group, paying company is ZZ. System will use EFT last check sequence number from 
ZZ company control file. Since, the value is NULL, system will start numbering from 1.  
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Accounts Payable > Setup > Local Tables > Control File – Check tab 

 

Accounts Payable > Setup > Local Tables > Control File – Check tab 

 

Accounts Payable > Payment > Print Checks – Prepare Checks   
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Accounts Payable > Payment > Print Checks – 2nd Party Checks 

PCM Reports on Jasper Quartz to Send EFT Notifications Fast 
(22.55452) 

A new feature is added to schedule PCM reports on Jasper Quartz for sending EFT Notifications fast. 
This feature is optional. 

To turn on this feature, add the property below in cmicapp.properties file: 

uireport2.pcm.use.schedule=true 

There is no need to restart the server. 
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Accounts Receivable 

Send AR Statements to multiple customers at once (15.05946) 

Overview: 

In addition to the existing E-mail field on the Maintain Customers screen CMiC has added two 
new fields: Check Box “AR Statement Email Flag” and Text Area “AR Statement Email 
Addresses” that is used to for entering multiple email addresses (coma separated). These two 
fields will be used for sending the AR Statement to multiple email addresses at once. 
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Modifications: 

 
1. Two new fields Check Box “AR Statement Email Flag” and Text Area “AR Statement Email 

Addresses” have been added to the Customer Maintenance screen: 
 

 
 

2. The additional option Preferred Contact Method has been added to Destination Drop-Down Menu 0n 
“Report Configuration for: AR Print Statement (ARSTMT)” for Print Statement screen: 
 

 

New Functionality:  

When the user presses [Print] button on the Account Receivable -> Statement -> Print Statement 
screen, the “Report Configuration for: AR Print Statement (ARSTMT)” pop-up window appears. In 
order to use new email functionality, the user should select “Preferred Contact Method” option from 
the Destination Drop-Down menu and press [Run Report] button.  

The system will analyze the “AR Statement Email Flag” from the Account Receivable -> Setup -> 
Maintain Customers screen:  
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1. If the Flag is checked and the Text Area is not empty, the statement will be sent to the email addresses 
located the Text Area; the email address in the E-mail field will be ignored: 
 

 
 
 
 
2. If the Flag is checked and the Text Area is empty, the statement will be sent to the address located in the 

E-mail field. 
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3. If the Flag is checked and both Text Area and E-mail the user will not be able to save this information: the 
system will raise the error after the user presses [Save] button. 

 

 
 

 

4. If the Flag is not checked the system will print AR statement in regular fashion.   

MS Billing Invoice Address Printing Option (15.11148) 

To provide the ability to print or suppress the Company Address Information in MS Billing Invoices. 

Modifications: 

The MS Control form > Invoices Tab is modified with a new checkbox ‘Print Company Address 
on Invoice’. 

The default value is ‘Checked’. The address information will always be printed, which is the 
existing functionality.  

When ‘un-checked’, then the address information will NOT be printed. This enhancement is 
provided so that when only logo is required to be printed and that the logo may already be 
having the address details. 

Front Office Cashier (19.84350) – BETA Version 

Conversion from Forms to ADF under development. 
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Treasury Receipt functionality in AR Receipt Entry (20.21731) 

Overview 

Added Treasury Receipt functionality to ‘Receipt Entry’ Program. 

Treasury Receipt may be used when dedicated company/department is set up to handle inter-
company/department receipts. 

This functionality was existing as a separate program in previous version of CMiC and now integrated 
into Receipt Entry Program itself in the current version. 

Modifications 

The following hidden fields are added to the Receipt Entry > Header Block. User must use Lite Editor 
to make these fields visible. 

Cash Comp:  Cash Company selected here, will be defaulted into the Receipt Detail Block. Cash 
Comp must have the same Chart Code as that of the batch company. 

Department:  Cash Department selected here, is defaulted into the receipt detail. 

Account:  Cash Account selected here is defaulted in receipt detail. 

Treasury Receipt Checkbox 

• Checked – Allows Treasury Receipts in Cash Company and allows the selection of cross 
company Jobs and related invoices. When Job not selected, users will be able to select cross 
company invoices for the same customer as well. 

• Un-checked – Standard Functionality of AR Receipt Entry applies, and no inter-company jobs 
will be allowed to be selected. 

This is also a convenient way of auto-populating the cash account information, if entering multiple 
receipts with the same cash account. 
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Accounts Receivable > Receipt > Enter Receipts. 

 

Implementation 

Select Cash Company, Department and Account and check the Treasure Receipt checkbox. These 
values will be defaulted in the receipt detail. 

 
Accounts Receivable > Receipt > Enter Receipts. 

Treasury Receipt checkbox is checked – Cross Company jobs are available. 
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Accounts Receivable > Receipt > Enter Receipts. – Job List LOV 

 

Treasury Receipt Checkbox is un-checked – Cross company jobs are not available.  
Only batch company jobs are listed in the LOV.  

 

Accounts Receivable > Receipt > Enter Receipts – Job List LOV 

New Button ‘Recalculate’ in AR Receipt Entry (20.21079) 

Requirement: 

To refresh the payment amount and the detail write off amounts when user changes the amount 
value on the header. 
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Functionality Design: 

A new button [Recalculate] is added in order to refresh the Payment amount and the detail write off 
amounts when user changes the amount value on the header. 

Example: 

Newly added button [Recalculate] is Disabled by default. It gets enabled when Current Amount is 
changed. 

 

Accounts Receivable > Receipt > Enter Receipts 

As soon as User changes the Current Amount, the new button [Recalculate] is enabled. 
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When User clicks on the [Recalculate] button, the payment amount and the detail write off amounts 
get updated. 
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Sales Invoice Entry – Import Button (18.56105) 

Enabled [Import] tool button in AR Sales Invoice Entry > Invoice  Header tab. 

 

 

Pay when Paid Invoice Matching-New Invoice Date Column and 
Filtering Enabled for additional columns (20.33377) 

 

Overview: 

 

1.To enable the filtering option on the following three columns of the ‘Pay when Paid Invoice 
Matching’ program 

• Pay Status  

• Contract and  

• Draw 

2.Also to add Invoice Date column on both blocks of the ‘Pay when Paid Invoice Matching’ Program. 

 

Modifications: 

 

The program has been modified and the filtering option is now available for the following three 
columns of the ‘Pay When Paid Invoice Matching’ program: Pay Status, Contract and Draw. 

The program has been modified and now both the AR invoices and SC invoices blocks will now have 
the new column: Invoice Date. 

 

Screen Prints: 
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New AR Invoice format-ARINVPRT_UK (21.42827) 

New AR Invoice format ARINVPRT_UK. 

Modifications:  

 

Created a new AR Invoice format ARINVPRT_UK. 

• New report option will be added to AR Control file Field "Free form invoice Name".  

• ‘Print invoice’ button on Enter invoice screen will be modified to read invoice format report 
from AR Control file. 

• Banking details on the report, AR Cash account on accounting tab on AR control file will 
be used. 

• A User Defined Field is added on the Enter Invoice Screen called "Remarks". This should 
be printed in a box at the bottom of the Invoice. 

 

The details of how the fields are populated are listed below: 

• Company Legal Name: COMP_LEGAL_NAME in DA.COMPANY 

• Address format: Street (COMP_ADD1) 

Suite (COMP_ADD2) 

City (COMP_ADD3), State (the name of the state not the code)( 

COMP_REGION_NAME) 

ZIP (COMP_POSTAL_CODE) 

Country (COMP_COUNTRY) 
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• Vat Reg No: COMP_VAT_REG_NUM in DA.COMPANY 

• Invoice details: 

Invoice No: INV_NUM in AR#INVOICE 

Invoice Date: INV_DATE in AR#INVOICE 

Order No: INV_ORD_NUM in DA.INVOICE 

Account Ref: Customer code (INV_CUST_CODE in AR#INVOICE) 

Quantity: INVD_QTY in DA.INVDETAIL 

Description: INVD_TEXT in DA.INVDETAIL 

Unit Price: INVD_UNIT_PRICE in DA.INVDETAIL 

Net Amt: INVD_AMT in DA.INVDETAIL 

VAT %: the percentage on the tax code assigned to that line item 

VAT: Tax amount for that line item 

Total Net Amount: INV_SALES_AMT in AR#INVOICE 

Total tax amount: INV_TAXES in AR#INVOICE 

Invoice Total: INV_NET_AMT in AR#INVOICE 

 

• The bank details should be driven from the GL account selected at the customer level for 
that company. The account name, account number, sort code, IBAN, swift and bank 
name should all be the ones associated with (Global tables→Banking→Bank account) 
the GL account for that company. 

Account name: BAB_ACC_TITLE in DA.BABANKACCT 

Account Number: BAB_ACC_NUMBER in DA.BABANKACCT 

Sort Code: BAB_ROUTING_CODE_A in DA.BABANKACCT  

IBAN: BAB_IBAN_NUM in DA.BABANKACCT 

Swift: BAB_MICR_CODE in DA.BABANKACCT (Transit field) 

 

• Logo should be populated form the AR control file. 

Note: There will not be more than one tax per line. 

Setup and printing the AR Invoices: 
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AR>Local Tables>Control File Options 

Create an AR Invoice and print the invoice. The invoice will need to be launched from the print invoice 
button in the Enter Invoices program. 

 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  297 
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Select All Option in Enter Receipt (22.54697) 

Overview 

Added ‘Select All’ option in Enter Receipt program.  
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Accounts Receivable > Receipt > Enter Receipt – Invoices 

Implementation 

Select All checkbox in AR > Receipt > Enter Receipt  
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Selecting all the invoices. 
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Update Post Date in AR (21.51353) 

Overview 

Ability to update batch post date in AR. 

Modifications 

System privilege PSTCHGAR - Allows the user to change post dates on transactions is added in 
user maintenance to provide access to this utility. Be default, this privilege is un-checked for the user.  

 

System Data > Security > User Maintenance > System Privilege 

Change Batch Post Date and Change Batch Post Date Query are the new programs added under the 
following path in Treeview: 

Accounts Receivable > Utilities > Change Batch Post Date 
Accounts Receivable > Utilities > Change Batch Post Date Query 
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Accounts Receivable > Utilities > Change Batch Post Date 

 

Accounts Receivable > Utilities > Change Batch Post Date Query 

Implementation 

PSTCHGAR: Un-checked  

User will not have access to the program 

 

System Data > Security > User Maintenance > System Privilege 
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Accounts Receivable > Utilities > Change Batch Post Date 

Check the flag for the user and user will get access to the utility.  

 

System Data > Security > User Maintenance > System Privilege 

 

Case 1: Updating Batch post date  

1) Invoice Batch  

 

Accounts Receivable > Utilities > Change Batch Post Date 
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Accounts Receivable > Utilities > Change Batch Post Date 

 

Accounts Receivable > Utilities > Change Batch Post Date 
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2) Updating Memo type batch  

 

Accounts Receivable > Utilities > Change Batch Post Date 

 

Accounts Receivable > Utilities > Change Batch Post Date 
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3) Adjustment Entry batch  

 

Accounts Receivable > Utilities > Change Batch Post Date 

 

Accounts Receivable > Utilities > Change Batch Post Date 
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4) Receipt Batch  

 

Accounts Receivable > Utilities > Change Batch Post Date 

 

Accounts Receivable > Utilities > Change Batch Post Date 
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5) Void Invoice Batch  

 

Accounts Receivable > Utilities > Change Batch Post Date 

 

Accounts Receivable > Utilities > Change Batch Post Date 

 

 

6) Void Receipt batch  

 

Accounts Receivable > Utilities > Change Batch Post Date 
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Accounts Receivable > Utilities > Change Batch Post Date 

 

 

Accounts Receivable > Utilities > Change Batch Post Date Query 

  Change Batch Post Date query screen will display all the changed post date log  

 

Banking 

This section is currently under development. 
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BI Analytics 

 

CMiC Analytics 

CMiC’s BI Analytics is a tool used for organizing and launching dashboards, queries, and card views. 
Users can create customized canvases to fan out their data analyses by dragging and dropping 
object cards (dashboards, queries, and card views) into specific user-defined groups called buckets 
to display and launch their analytics in a convenient, logical manner.  

BI Analytics is used in conjunction with CMiC’s other BI tools, which include BI Dashboard Builder, BI 
Catalog Builder, and BI Query Builder. For more information, please refer to the BI Dashboard Builder 
guide, which includes a quick guide for BI Query Builder, and the BI Catalog Builder guide. 
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Overview 

 

CMiC Analytics  

The main console contains buttons to conveniently launch Business Intelligence (BI) tools directly from the 

Analytics tool. These BI tools include BI Catalog Builder, BI Dashboard Builder, and BI Query Builder. 

The Analytics screen is divided into two panels: Menu and Canvas, as shown in the screenshot above. 

For further information, please refer to the Analytics Reference Guide as well as the various mentioned guides 

for BI. 

BI Application Code and Setting Security Roles for Analytics 
(21.37385) 

CMiC has replaced the previous application code ‘BIC’ (Catalog Builder) with ‘BI’ (CMiC BI).  In 
addition, we have added the ability to customize privileges of existing roles for Analytics via the 
security option “Assign Roles to Programs”: 
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How to use: 

• Open program “Assign Roles to Programs”. 

• Select application BI. 

• Select program Analytics. 

• Select a Role that needs to be customized. 

• Select/Unselect Update or Delete checkboxes as required. 

Analytics Enhancement (21.42008-122,125) 

Modifications have been made to enable users to assign roles to bucket objects without removing 
prior assignments.  CMiC also added informative messages to clearly indicate the purpose of the 
feature. 
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BI Catalog Builder 

BI Catalog – Export/Import Specific Business Areas or Folders 
(20.31878) 

➢ Ability to Export/Import specific Business Areas or Folders. 

To import: 

Navigate to “Import Data Source” screen and select an import file as usual. 

Once the file is validated, select Destination Data Source if importing a Business Area or 
select both a Destination Data Source and a Destination Business Area when importing a 
folder. 

Press Import 

Usage notes: 

When importing a specific Folder or a Business Area, the program will also import Joins. 

If the destination data source already has a folder or business area with the same name as 
the one to be imported, then it will be imported with a new name (adding a number suffix). 
The new name will be displayed in the Import log. 

Export files extensions: 

*.ds – export file for an entire Data Source 
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*.dsf – export file for a Specific Folder 

*.dsb – export file for a Specific Business Area 

 

BI Catalog (19.69431 – 602-618) 

Enhancements 

➢ Whenever folders or fields are about to be deleted, a warning will appear showing a list of 
affected Dashboards/Queries. 

Functionality that uses this feature: 

Refresh. 

Refresh will check if any folders or fields are going to be deleted and will show a list 
of such folders and fields along with a list of Dashboards/Queries where they are 
used. 

Add/Remove User-Defined Fields dialog. 

If a User-Defined field is going to be deleted while it’s used in a Dashboard/Query, a 
warning will appear showing a list of affected Dashboards/Queries. 

Field Visible property. 

A warning with the usage report will appear if a user changes Visible property to N on 
a field that is used in Dashboards/Queries. 

Edit Business Area dialog. 

Removing a table/view from a Business Area will show a list of folders that are going 
to be deleted. 

Manual delete of a folder or Business Area. 

 

➢ Added the following folders: 

"GLBI Transactions with Year Period" 

"AP Registered Invoices" 

"EC Posted Transaction Detail" 

BI Catalog (19.69431 – 619-638) 

New feature: List of available Context Variables for Folders. 

As it is now possible to utilize Context Variables used in database views in Dashboard/Query Builder, 
users are now able to see the list of Context Variables for a corresponding folder in Catalog Builder. 

The folders now have a new button “Context Variables”. S ee screenshot. 

 

Refresh process: 
Refresh process will also refresh the list of context variables. 
 
Custom (customer’s own) views: 
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If context variables in customer’s own views are modified, to bring the updated list of variables into 
Catalog Builder, users can either use a new button “Refresh Variables” in the Context Variables 
popup or execute Refresh on the folder. 
 
In order to be used in CMIC BI, the Context Variables must use namespace “CMIC_BI”. 
 
Please, refer to Dashboard Builder’s manual on how to utilize Context Variables in your Dashboards 
and Queries. 
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Defects resolved: 

• Compare Data Sources: Fixed an issue where joined fields were not cleared when navigating 
to folders with no joins. 
 

• Fixed references to not-existing or not-default reports  

BI Catalog - Context Variable for GLBI Transactions with Year 
Period (19.69431 – 641,642) 

In Catalog Builder: 

Context variables defined for folder GLBI Transactions with Year Period: 
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BI Catalog – Navigation Panel (19.69431 – 653) 

New Features: 

• Navigation Panel for trees. 

• Ability to change Sorting in data sources (Edit Data Sources screen). 

• Ability to hide/show hidden fields (Edit Data Sources screen). 

 

Navigation Panel is now available for trees in Edit Data Sources and Folder Joins screens. 

Panel functionality: 

o The panel allows users to navigate the trees and select tree nodes using drop-down lists. 

o Each Drop-Down List has Search functionality. 

o Users can quickly navigate to top levels by pressing an Arrow icon next to the required level. 
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Sort Panel: 

Sort Panel allows users to sort Business Areas, Folders and Fields by 

o Default (using Position property) 

o Name Ascending 

o Name Descending 

Filter: 

Show Hidden Fields checkbox. 

When Unchecked – fields that have “Visible” property set to No will be hidden. 

NOTE: The filter is unchecked by default meaning the hidden fields won’t be shown until users check 
this flag. 
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BI Catalog – Sort Panel (19.69431 – 656) 

New Features: 

• Added Sort Panel to Folder Joins screen: 

 

BI Catalog - Updates to CMiC Default Data Source (20.31272) 

The following updates have been made to the CMIC Default Data Source: 
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Added Folders: 

"GLBI Transactions with Year Period" 

"AP Registered Invoices" 

"EC Posted Transaction Detail" 

"JC Contract Forecast Cost To Complete Details" 

"Workflow Look up User" 

 

Removed Folder: 
  "JC WIP". 

Added Business Area: 

"Workflow" 

 
Added field to folder "GLBI Transactions with Year Period": 
 "Conschart Code"  

Added fields to Folder "PY Employee Master": 

"Reports To Name" 

"Student Loan Plan Type" 

Added field to Folder "PY Employee Time Sheets": 

"Exempt Ref Bch Num" 

Added fields to Folder "PY Trades Codes": 

"Craft Code" 

"Labor Class" 

 

Fixed Join between folders "SC Subcontract Headers" and "SC Subcontract SOV Details": 

 Removed "Job Code" field condition. 

Added join: 

 "GL Transactions" - "JC Transactions" 

BI Catalog – Enabled UDFs for PM Daily Journals (20.32146) 

Enabled UDFs for PM Daily Journals (PMDJUDFTAB Classifier type). 

BI Catalog – Enabled UDFs for PCI Header (20.34143) 

Enabled UDFs for PCI Header (PCIHEADER Classifier type). 

BI Catalog – Partial Data Source Export (20.31878) 

Implemented Partial Data Source Export.  

Fixed a defect where a multiline text (like for calculated fields) transferred into a single line text after 
Data Source Import. 
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Improved Search in Edit Available Tables/Views and Edit Business Area screens. 

BI Catalog – Modified CMiC Default Data Source (21.36490) 

The following changes have been made: 

• Added join:  "CM PCI Detail" - "AP Vendors" 

• Added these fields to folder "RQ Requisition Details": 

"User Field5" 

"User Field6" 

"User Field7" 

"User Field8" 

"Itm Desc" 

BI Catalog – Variable Value for Folders Context Variable (19.69431-

678,681,685) 

A new feature has been added into Catalog Builder for Folders Context Variables: 

It is now possible to specify for each Context Variable if the variable value is required and if the 
variable can handle multiple values. 

Once specified, this information will be used by Dashboard and Query Builders (for example in filters). 

 

BI Catalog – Updates to Data Source, Folder, Queries (21.39361-1-5) 

The following updates have been made to the BI Catalog : 

• Released updated version of CMIC Default Data Source. 

• Released new Queries.  
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• Released updated CMiC Standard Objects Canvas in Analytics. 

 

CMIC Default Data Source changes: 

New default dashboards: 
- Project Manpower Report 

- Current Project Manpower Report 

 

Added folders: 

"PY Leave Master" 

"PY Employee Leave Table" 

"PYBI Employee Leave" 

"OM Opportunity Risk Detail" 

"OM Sales Team" 

 

Added Join: 

"SD System Contacts" - "PM Project Contacts" 

 

Added field: 

Folder "PY Employee Master" - Field "Employee" 

 

Removed obsolete field: 

Folder "AP Invoices" - field "Image Manager". 

 

New Queries: 

Aged Payables Crosstab 

Aged Payables Crosstab Drill-Down 

Aged Receivables Crosstab 

Aged Receivables Crosstab Drill-Down 

AP Checks Crosstab 

AP Checks Crosstab Drill-Down 

AP Invoices Crosstab 

AP Invoices Crosstab Drill-Down 

AR Cash Receipts Crosstab 

AR Cash Receipts Crosstab Drill-Down 

AR Invoices Crosstab 
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AR Invoices Crosstab Drill-Down 

GL Transaction Crosstab 

GL Transaction Crosstab Drill-Down 

GL Transaction Drill Down 

JC Transactions Crosstab 

JC Transactions Crosstab Detail 

JC Transactions Crosstab Drill-Down 

Leave Details 

 

Deleted folder "JB Change Orders" as the corresponding view da.JB_CHANGE_ORD was deleted. 

The folder was not used in any Dashboard or Query. 

BI Catalog – New PO, PY Folders and JB Joins (21.39361-6) 

Changes made: 

New folders added: 

"PO Requisition Details" 

"PY Control File" 

"PY SUI Magnetic Media" 

"PY SUI Magnetic Media - California" 

 

New fields added to "PY Employee Master" folder: 

"US Employee Count" 

"California Employee Count" 

 

New field added to "PM Documents" folder: 

"Count" 

 

New joins added: 

"JB Contract Details" - "CM Owner Change Order - Posted" 

"JB Contract Headers" - "CM Owner Change Order - Posted" 

 

BI Catalog – Default Data Source Changes (21.45771-3) 

Changes made to the Default Data Source include: 

- Fixed incorrect field names in folder "PM Project Labor Distribution". 
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- Updated calculation for field "Object Type" in folder "PMBI Outstanding Action Items" 

- Added new folders: 

"From Project Contact" 

"Responsible Project Contact" 

"To Project Contact" 

BI Catalog – Resource Planning-related Updates Made (21.50685-1,2) 

Changes made: 

Default Data Source: 

- Added new field "Forecast Period Date" to folder "JC Period Balances". 
- Added joins: 
  "Needs" to "GL Companies" 
  "Needs" to "JC Jobs" 
- Fixed join between "JC Period Balances" and "JC Job Phases" folders. 
 
Default Dashboards: 

- Added new dashboards: Profit Fade and Resource Planning. 
- Default Canvas: Added Profit Fade and Resource Gantt cards. 

BI Catalog - Updates Made to Most Modules (21.50685-3,4) 

 

Default Dashboard: 

• Added new Purchase Order Dashboard 

 

Default Data Source changes: 
 
Fields modifications: 
- folder "GL Companies" - added new fields "Rbq Num" and "Neq Num". 
- folder "AP Vendors" - added new field "Payment Purpose Code". 
- folder "AP Invoices" - added new fields "Deposit Amt" and "Workflow Status". 
- folder "AP Checks" - added new fields "Nvp Pay Batch Id" and "Down Payment Flag". 
- folder "AP Voucher Distributions" - added new field "Deposit Amt". 
- folder "AP Voucher Payments" - added new field "Rev Code". 
- folder "AR Tax Codes" - added new fields "Reverse Chrg Flag", "Authorities Code", "Description", 
"Eng Translation". 
- folder "JC Jobs" - added new fields "Phs Template Code", "Apply Phs Template Flag", "Show Cost 
Amt Wip Flag". 
- folder "JC Transactions" - added new field "Deposit Amt". 
- folder "JC Contract Forecast Detail" - added new field "Unposted Pci Spent Amt". 
- folder "JCBI Cost Status Query" - folder renamed to "JCBI Cost Status Snapshot". 
- folder "SC Subcontract Headers" - added new fields "Deposit Pct", "Deposit Amt", "Deposit 
Approval Date". 
- folder "SC Subcontract SOV Details" - added new fields "Cont Deposit Pct", "Cont Deposit Amt", 
"Curr Deposit Pct", "Curr Deposit Amt", "Prev Deposit Amt", "Prev Deposit Pct". 
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- folder "SC Vendors" - added new field "Payment Purpose Code". 
- folder "SC Control" - added new field "Deposit Approval Flag". 
- folder "SC Voucher Details" - added new fields "Deposit Amt", "Workflow Status". 
- folder "CM PCI Detail" - added new field "Markup Flag". 
- folder "CM PCI Header" - added new fields "Workflow Status", "Allow Cost Flag". 
- folder "CM PCI Detail - Unposted" - added new field "Markup Flag". 
- folder "CM PCI Header - Unposted" - added new field "Allow Cost Flag". 
- folder "CM Posted PCI Detail" - added new field "Markup Flag". 
- folder "CM Posted PCI Header" - added new field "Allow Cost Flag". 
- folder "CM Detail Original Budget Posted" - added new field "Markup Flag". 
- folder "CM Master Original Budget Posted" - added new field "Allow Cost Flag". 
- folder "JB Contract Headers" - added new field "Remit Details". 
- folder "JB Risk Management Codes" - added new field "Amt". 
- folder "JB Risk Management Rates" - added new field "Amt". 
- folder "JBBI Transaction Detail Query" - added new field "Comp Code". 
- folder "PO Blanket Purchase Order Headers" - added new fields "Wkfl Status", "Wkfl Signed Date", 
"Wkfl Routing Comp", "Wkfl Routing Job". 
- folder "PRM Transactions" - added new field "Exchg Curr Code". 
- folder "PY Employee Master" - deleted fields "Salary Frq" and "Monthly Salary". 
- folder "PY Employee Pay History" - added new fields "Exchg Curr Code", "Exchg Rate". 
- folder "PY Employee Time Sheets" - added new field "Exchg Curr Code". 
- folder "PY Trades Codes" - added new field "Apprentice". 
- folder "PY Control File" - added new field "Use Work Comp Curr Flag". 
- folder "PM Projects" - added new field "Pre Win Proj Code". 
- folder "PM Documents" - added new fields "Sheet Number", "Location Code", "Trade Name". 
- folder "PM History" - added new fields "Required Reviewer Flag", "Seq Num". 
- folder "PM Journal Headers" - added new field "Wf Approval Status". 
- folder "PM Project Partners" - added new fields "Approver Partner Code", "Approver Partner 
Type", "Approver Cont Code". 
- folder "PM Submittals" - added new fields "Curr Review Start Date", "Curr Review End Date", 
"Curr Review Lead Time", "Review Start Date", "Review End Date", "Review Lead Time". 
- folder "DRW Drawings" - added new fields "Location Code", "Sheet Number 1", "Trade Name". 
- folder "DRW Annotations" - added new field "Thumbnail Available Flag". 
- folder "DRW Documents" - added new fields "Location Code", "Sheet Number", "Trade Name". 
- folder "OM Project Table" - added new field "Pre Win Proj Code". 
- folder "OMBI Opportunity Query" - added new fields "Job Orig Contract Amt", "Job Contract Amt". 
- folder "SP References" - added new fields "Clv Value Code1", "Clv Value Code2", "Clv Value Code3", 
"Clv Value Code4", "Clv Value Code5", "Clv Value Code6". 
- folder "WO Jobs" - added new fields "Phs Template Code", "Apply Phs Template Flag", "Show Cost 
Amt Wip Flag", "Certrep Email". 
- folder "PM Document Types" - added new fields "Sheet Num Title", "Location Code Title", "Trade 
Name Title", "Sheet Num Active Flag", "Location Active Flag", "Trade Name Active Flag". 
- folder "PM Security Roles" - added new field "Internal Only Flag". 
- folder "From Project Partner" - added new fields "Approver Partner Code", "Approver Partner 
Type", "Approver Cont Code". 
- folder "To Project Partner" - added new fields "Approver Partner Code", "Approver Partner Type", 
"Approver Cont Code". 
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- folder "Responsible Project Partner" - added new fields "Approver Partner Code", "Approver 
Partner Type", "Approver Cont Code". 
  
Added new folders: 
- "PYBI Timesheet Query" 
- "Py Bi Ca Det" 
- "Py Bi Ca Hours" 
- "Py Bi Ca Payment" 
- "Py Bi Ca Sum" 
- "REST API Audit" 
- "AR Tax Codes 1" 
- "AR Tax Codes 2" 
- "AR Tax Codes 3" 
  
Added new Joins between folders: 
- "JCBI Phase Unit Summary - Earned Value" and "JC Jobs" 
- "JC Jobs" and "PO Purchase Order Headers" 
- "PO Purchase Order Detail" and "JC Jobs" 
- "PO Purchase Order Detail" and "PO Free Form Item Detail" 
- "PO Purchase Order Detail" and "IV Item Master" 
- "PO Purchase Order Headers" and "PO Purchase Order Batches" 
- "PM RFIs" and "Responsible System Contact" 
 

BI Catalog - Updates Made to JC,SD,PM (21.50685-5,6) 

 

New Default Dashboards: 
"Expected RFI Dashboard", "Expected Cost Dashboard", "Project and Employee Map" 
 
Default Data Source changes: 
 
Added new folders: 
JC Expected Cost 1 
JC Expected Cost 2 
JC Expected Cost 3 
Comparison Project List 
Comparison Project List IDs 
Comparison Project Details 
PM Expected RFI Counts 
 
Deleted folders: 
SD System Privileges 
PM Programs 
PM Project Privileges 
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BI Dashboard Builder 

BI Dashboard (19.69431 – 602-618) 

Enhancements 

• Added BACK and REFRESH buttons to the Card View. 

 The [Back] button is available only when a “drill-in-place” has occurred. 

 

• Calculated Fields 

o The switch function can be used to replace blank values with a field reference or a 
constant.   This feature is supported for all data types.  

The switch function converts a field reference’s values against a list of values and 
returns  one of  multiple possible result. 

  Syntax:  

               switch(<field reference>, <value>, <result>[, <value>, <result>]…[, <else>])   

The data type of the field reference must be the same as the comparison value’s data type. 
The data type of the result must be the same as the calculated field’s data type.  The blank() 
function can be  used in place of the comparison value. 

 Expression Examples 

New Amount A = -15 * ('Folder 1'[Amount 1] - 'Folder 2'[Amount 2]) / 'Folder 3'[Amount 3] + 29.76 

New Amount B = 100 * switch('Folder 2'[String Field], blank(), -1, "One", 1, "Two", 2, "Three", 3, 0) 

Status = "Status: " & switch('Folder 2'[Amount 2], blank(), "Undecided", 1, "Approved", 2, "Denied","Other") 

Two Lines = "Line 1\nLine2" 

Address = 'Folder 1'[Address Line 1] & "\n" & 'Folder 1'[Address Line 2] 

Full Name = 'Folder 1'[First Name] & " " & 'Folder 2'[Last Name] 

Message = "The file \"" & 'Folder 1'[File Name] & "\" is located at C:\\Temp\\" 

 

o Added the date function that returns the specified date in the DATE data type. 

    Syntax: 
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           date(<year>, <month>, <day>) 

   + year: a number representing the year. 

    + month: a number from 1 to 12 representing the month. 

    + day: a number from 1 to 31 representing the day.   

 
 Notes on Calculated Fields 
  
 BI supports calculated fields for all visualizations.  

 
Rules: 
- A calculated field may not be created from another calculated field. 
- A calculated field’s data type may be number, date, string or URL.. 
- To construct a number calculated field, the following arithmetic operators are supported: 

  + (addition) 
  - (subtraction) 
  * (multiplication) 
   / (division) 

- To construct a string or URL calculated field, the operator & is used for concatenation. 
- A field reference is constructed in the following format: 
                ‘Folder Name’[Field Name] 
   The folder name part is enclosed in single quotes ‘ and the succeeding field name part is enclosed 
in square brackets [] 
- When constructing a string or URL calculated field, the values of a number/date field reference is 
converted to string using the field’s default format pattern. 
- String literal is enclosed in double quotes “ 
- In a string literal, a double quote can be specified as \”, a line break can be specified as \n and the 
escape character \ can be specified as \\ 

 

Defects Resolved 

• Dashboard/page filters cannot filter other visualizations using a visualization calculated field 
(a calculated field created on dashboard builder). 

 Resolution:  Since a visualization calculated field is localized to the page filter, it cannot be 
used to  filter other visualizations. Disable the ability to create visualization calculated fields in a page 
 filter.  

• Unable to export a table to Excel when the table contains a calculated column – resolved. 

 

• Issue 20.32578: PDF export prints [Blank] on inactive subtotal cells. 

• Changes for issue 20.27270 (When a table data value of group sorted cell is null, display it as 
[Blank] on ADF, Excel and PDF) are causing too many side effects, including issue 20.32578 
above.  Resolution: Revert changes for issue 20.27270. 

• Table visualization raises error when it contains an aggregated column and an aggregated 
filter from the same field. 

• The default canvas export module releases default canvas containing cards referencing 
invalid dashboards (not exist or not default).  Resolution:  Add validation for this condition, 
stop the process and produce a detail HTML error report (see attachment). 

• The default dashboard export module releases default dashboards containing invalid drill-in-
place or invalid visual references (not exist or not default).  Resolution: Add validation 
detecting default dashboard containing drill-in-place or visual reference point to: 
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           -- A non-default dashboard 

           -- A dashboard that does not exist 

           -- A visualization that does not exist  

    stop the process and produce a detail HTML error report (see attachment). 

BI Dashboard (19.69431 – 619-638) 

Enhancements 

- Change Dashboard/Query Builder banner 

- Add Crosstab Visual for experimental mode only. 

- Enhance validation for visualization calculated field switch function for the date data type. 

Defects Resolved - Analytics 

- default canvas export validation is always false. 

- default canvas and default dashboard export validation is always false. 

BI Dashboard – Asynchronous Data Refresh (19.69431 – 639,640) 

Changes: 

• Crosstab: Added “Drill in Place”, removed sort panel, remove disable autoload data, swap 
rows and columns, add auto row-column sort 

• Display "(Refresh Pending)" for data source that is queued for refresh. 

For performance reasons, data source refresh is asynchronous.  Dashboard users are not 
blocked waiting for a data source refresh.   When a data source is queued for refresh, the 
(Refresh Pending) suffix is added to the data source name on the fields selection popup. 
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BI Dashboard - Dashboard Filter as Context Variable (19.69431 – 641,642) 

Changes made: 

When a dashboard filter (page filter) is a context variable1, any changes to its value or when it is 
removed, will refresh all visualizations that are affected by the context variable2. 

1  A dashboard filter is a context variable when its property Format -> Context Variable contains a 
context variable name. 

2 A visualization is affected by a context variable when one of its folders contains the context variable 
name.  For more information about  

Example: 
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BI Dashboard – Supported Context Variable (19.69431 – 643,644) 

Defects Resolved: 

Issue 20.35822: BI Reports Exporting Differently in Excel Than Formatted.   

 

Enhancements: 

For dashboard designers without access to Catalog Builder, a folder’s supported context variables 
are also available on Dashboard Builder. 
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BI Dashboard – Page Filter – Added Support for Single-valued 
(19.69431 – 651,652) 

Changes: 

• Crosstab: -- Add total/subtotal 

            -- Allow total/subtotal cell to be drillable 
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            -- Add total/subtotal configuration (visible, label, font weight, font color, background color) 

            -- Add custom label for column/row/value 

            -- Add sort order option (ascending/descending) 

            -- Add custom format for column/row/value 

• Dashboard/page filter: added support for single-selection only.  The Single-valued setting is 
available for dashboard designers to indicate that the filter can use a single value only. This 
enhancement is especially needed when using legacy parameterized views with context variables 
in BI.  There are many instances when the legacy views cannot consume multi-valued context 
variables. 

 

BI Dashboard Crosstab Visualization Added (19.69431 – 654,655) 

Enhancements: 

Added the Crosstab visualization.  For subtotal/total to be available, all “Values” fields must use one 
of the following aggregations: 

Count 

Count (Distinct) 

Sum 

Example: 
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BI Dashboard – Crosstab View for Queries (19.69431-661,662) 

Enhancements: 

- Added crosstab view for queries.  
   -- All visible non-aggregated columns are converted to crosstab rows.  This behavior can be 
changed in the Crosstab View properties section. 
   -- All aggregated columns are converted to crosstab values. 

   -- In crosstab view, the edge members can be rearranged.  Their positions can be saved. 

   -- Support crosstab drill in place and total. 

   -- The query starts in crosstab view. 

   -- Support dashboard/page filters in crosstab view. 

   -- Calculated column is not supported. 

 

- For visualization calculated field, add support for number field in the date.addDays function.  The 
number of days parameter can be a number field. 

 

BI Dashboard - Substitution Variables for Query Builder (19.69431-

672,673) 

Enhancements: 

- Added substitution variables to Query Builder 

- Added an option to turn a substitution variable to a context variable. 
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BI Dashboard - Dashboard Filter Enhancements (19.69431- 682,683,686) 

Enhancements: 
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- Dashboard filter:  Support an optional Description plotting field.  The values of the Description field 
will  be displayed within the list (LOV) instead of the values of the Filter By field.  This feature 
allows  dashboard designers to: 

          1. Optimize performance by using an indexed code or oraseq for the Filter By field.  This usage 
is  highly recommended. 

          2. Provide a user-friendly list by using the Description field. 

 Add Selected Value(s) Details popup to display the selected Filter By values and Description values 
in detail. 

- Dashboard filter:  Support visualization calculated field for the Description plotting field. 

- Dashboard filter:  Support filter by [Blank] or NULL.  The value [Blank] is displayed in the list (if 
exists)  for selection. 

- In the Supported Folder’s Context Variables popup:  Display context variable attributes (Value 
Required, Single-valued).  These attributes are specified in Catalog Builder. 

-- When a context variable is “Value Required”, the underlying SQL view of the folder will only return 
data when it receives the context variable with a value.  It is recommended that any dashboard filters 
representing the context variable should be labelled as required or mandatory. 

  -- Unless a context variable can have more than one value at one time (as specified in Catalog 
Builder), it is assumed to be single-valued.  Any dashboard filter(s) representing a single-valued 
context variable is automatically single-valued.   Multiple value selection is disabled and the 
dashboard filter’s Single-valued property is automatically checked. 

- When default dashboards and queries are released, clear all selected values of table pivot items but 
keep all selected values for dashboard filters and substitution variables. 
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Working Document R12 New Functionality R12 New Functionality (Draft)  •  341 

BI Dashboard – Correction of Calculated Visualization Dropdown 
Lists (19.69431-687) 

Defects resolved: 

- In the calculated column and calculated visualization field popups, the insert dropdown lists did not 
work in certain browser versions. 

  Resolution: Use the dropdown lists for selection only.  A button is added to each list to explicitly 
insert the selected value. 
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BI Dashboard – Table Visualization; Deep Linking for Filters (19.69431-

689) 

Changes: 

- Table visual: When a column's label is used in a calculated column expression, its label is not 
allowed to change. 

- Add deep linking feature for dashboard filters that use the description plotting field (ex: GL 

Transaction Drilldown query). 

BI Dashboard – Visualizations Require Value (19.69431-692, 693) 

Enhancements: 

- Allow visualizations to require a value in a dashboard filter/substitution variable in order to fetch 
data.  When a value required dashboard filter/substitution variable is empty, the dependent 
visualization data is cleared. 

  *This feature is necessary for visualizations that cannot run without being filtered because the 
dataset is too large. 
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BI Dashboard – Crosstab Enhancements; Defects Resolved (19.69431-

695,696) 

Defects Resolved 

- An error occurs when a visualization requires a value in an incomplete dashboard filter/substitution 
variable.   

  For examples: 

       -- When a dashboard filter does not have a Filter By field. 

       -- When a substitution variable does not have an Identifier. 

- Table Visual: Excel export and PDF export does not respect the “Value Required Conditions”. 

Crosstab Enhancements 

- Add layer selection. 

- Add the split view functionality. In a split view, the crosstab is split into multiple panes vertically 
and/or horizontally, facilitating a side-by-side viewing of rows or columns not located next to each in 
the crosstab. 
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Crosstab View Layer Selection  

 

 

 

Crosstab Visualization Layer Selection 
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Column Only Split View of Crosstab Data 
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Row Only Split View of Crosstab Data 
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Column and Row Split View of Crosstab Data 
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BI Dashboard – Panel Visualization (19.69431-698,699,700) 

- Added the panel visualization. A panel is a container in which to arrange and group visualizations in 
a flow layout dashboard. The visualizations inside a panel are arranged in fixed layout. 
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BI Dashboard – Updates to Fixed Layout; Defects Resolved (19.69431-

703,704) 

- Remove fixed layout. Visualizations in a dashboard are arranged in flow layout only. Fixed layout is 
only available inside a panel.  

- Migrate all fixed layout dashboards to flow layout. This includes moving all visualizations to a panel. 
The positions of the visualizations are retained. The panel is given the same dimension as the 
dashboard.  

- Defect resolved: When a visualization calculated field is used in a Text visual as a plotting field, 
disclosing the Callout Value properties section causes a dashboard error. 
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BI Dashboard – Gantt Chart Visualization etc. (21.42008-63, 64) 

• Added the Gantt chart visualization (see screenshots below). 

• Added support for export and import dashboards to the same data source in multi-tenant 
environments (CLOUD). 

Defects resolved: 

• Issue 21.46383: Unable to recover a visualization containing a folder that is no longer available in 
a data source. 

• Unable to change the number format of the Values plotting fields in Crosstabs. 
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Right click on a header to show the Time Scale menu 
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BI Dashboard – Treemap and Sunburst Visuals (21.42008-40, 41) 

The following enhancements have been made: 

• Renamed the "Drill in Place" feature to "Drillthrough". All “Drill in Place” labelling is changed to 
“Drillthrough” (screenshots further below). 

 

• Added the Treemap visual and the Sunburst visual (screenshots further below). 

-     All standard features are supported. Ex: visual calculated fields, drillthrough, etc... 

-     Support multiple Group plotting fields. When multiple plotting fields are dropped on the Group    

 section, the multi-group controls are revealed for the following multi-group features: 

o  Traversing through one group at a time 

o  Expanding/collapsing one group at a time 

o  Drill down and drill up the group plotting fields. The drillthrough feature is replaced with 

the drill-down feature when drill-down mode is turned on.  

      The following options are supported: 
- Display the value next to the label. This includes number formatting with display unit. Ex: 100K, 

20M. 

- Display negative values by using the absolute value to determine size. For example, 7 and -7 are 

shown as the same size. 

- Format data point background color by color scale. The format can be based on the value field 

(default) or another field. By default, the minimum and maximum values are the minimum and 

maximum values of the field that the color scale is based on. The values can be provided by the 

user.  

o Minimum color:  The color given to the minimum value. 

o Maximum color: The color given to the maximum value. 

For values between the minimum value and the maximum value, the data points are given 
gradient background colors from the minimum color to the maximum color. 

       -      Layout (treemap only) 
       -      Group Gaps (treemap only) 
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Drillthrough Screenshots 
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Treemap and Sunburst Screenshots 
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Dashboard Builder – Visualization Toolbar Enhancements (21.42008-

75,76) 

• Visualization toolbar enhancements:  
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• Move title text below the toolbar to support longer text  

• Show toolbar controls (Excel export, PDF export, maximize, etc...) on hover  

• Change toolbar colors to grey  

Dashboard Builder – Filters and Substitution Variables (21.42008-82,83) 

• Automatically save the selected values of dashboard filters and substitution variables per 
user.  The persisted values will be used to prepopulate the same dashboard filters and 
substitution variables when the dashboard is open:  

o Using File -> Open  

o Using a URL obtained from Dashboard -> Get Link...  

• Allow the dashboard filters to load data when autoload data is off (Preferences -> 
Autoload Data).  This allows the user to select filter values before turning autoload data 
back on.  

• Add Show Description menu option to allow dashboard builder users to view the folder 
description specified in Catalog Builder.  
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Dashboard Builder – Selection of Text Color (21.42008-90,91) 

Allow Dashboard Builder users to select the text color of a table cell using a format expression. 
Currently, the feature is not applied to Excel/PDF export yet. 

The format expression supports the following operators: 

 

Comparison 
Operators 

Description Examples 

== Equal to [Account Type] == “Equity” 

!= Not equal to [Account Type] != “Equity” 

> Greater than [Invoice Date] > date(2017,12,17) 

< Less than [Account Type] < “Equity” 

>= Greater than 
or equal to 

[Invoice Amount] >= 1000  

<= Less than or 
equal to 

[Invoice Amount] <= 1000 

 

Logical 
Operators 

Description Examples 
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&& The double 
ampersand 
performs a 
logical AND 
operation. It 
combines two 
expressions 
and returns 
true only if 
both 
expressions 
are true. 

([Account Type] == “Equity”) && ([Invoice 
Amount] <= 1000) 

|| The double 

pipe performs 

a logical OR 
operation. It 
combines two 
expressions 
and returns 
true if one of 
the 
expressions is 
true. 

 

([Account Type] == “Equity”) || ([Invoice 
Amount] <= 1000) 

 

 

The switch function is enhanced (for format expressions only). 

The switch function converts an <expression>’s values against a list of values and returns one 

of multiple results. 

Syntax: 

switch(<expression>, <value>, <result>[, <value>, <result>]…[, <else>]) 

<expression can be a <field reference>, true, false 

<value> can be an expression: a field reference, a number, a string, a URL, a date, a function 
(including another switch function call), combinations of arithmetic/comparision/logical expressions.   

<result> can be a field reference, a number, a string, URL or a date. 

<else> can be a field reference, a number, a string, URL or a date. 

The data type of the <expression> must be the same as the comparison <value>’s data 

type.  

 

Examples: 

color = switch([Balance Amt], blank(),"#ff0000", 0, "#0000ff", "#00ff00") 

 

color = switch(true, [Account Type] == "Assets", "#00ff00") 
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color = switch(true, [Account Type] <= "Expense", "#00ff00") 

 

color = switch(true, trim([Account Name]) == "", "#ff0000") 

 

color = switch(true, [Balance Amt] == blank(),"#ff0000", [Balance Amt] > 0, "#00ff00") 

 

color = switch(true, (-15 *([Amount 1]-[Amount 2])/[Amount 3] + 29.76) > 0, "#00ff00", [Amount 4] == 
blank(), "#ff0000") 

 

color = switch(true, [Account Type] != "Expense","blue",  "#00ff7f", [Balance Amt] >= 50, "#b8860b", 
"#ed6647") 

 

color = switch(true, ([Balance Amt] >= 0) || ([Account Type] == "Assets") || ([Account Type] == 
"Revenues"), "#00ff00") 

 

color = switch(true, [Balance Amt] == blank(),"#ff0000", ([Balance Amt] > 0) && ([Account Type] == 
"Assets"), "#00ff00") 

 

color = switch(true, [Balance Amt] == 0,"#ff0000", ([Balance Amt] + [Credit Amt]) > 0  && ([Account 
Type] == "Assets"), "green") 

 

color = switch(true, [Balance Amt] < 0,"#ff0000", ([Balance Amt] + switch([Account Type],"Assets", 
100, 0)) <= 10000, "#00ff00", "#0000ff") 

 

color = switch(true, [Invoice Date] < date(2017,12,23), "blue", ([Invoice Date] >= date(2017,12,23) ) 
&& ([Invoice Date] <= date(2020,12,27) ), "#ffff00") 
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Dashboard Builder – Background Color Selection (21.42008-96,97) 

Allow Dashboard Builder users to select the background color of a table cell using a conditional 
format expression.  The selected color is applied to the Excel/PDF exports. 
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Dashboard Builder – Visualization Calculated Field Enhancements 
(21.42008-111,112) 

Below are some Visualization calculated field enhancements (like table conditional formatting):  

Support comparison expressions and logical expressions switch statements. 

• Unlike table conditional formatting: Comparison expressions and logical expressions do 
not support the STRING data type. 

o Support nested function calls. 

• Example:  
Rating = switch(true,  
                            'Folder'[Amt] <  10, "A",  

                         ('Folder'[Amt]  +  switch('Folder'[Type],"Assets", 100, 0)) <= 10000, "AA",  
                          "Other") 

Dashboard Builder – Bubble Map Visualization (21.42008-118,119) 

The Bubble map visualization has been added: 

Example: 
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https://solutionsr12.cmicpaas.com/cmictest/CmicBi/faces/main.jsf?id=kzjxgc61-
82403bd363e64f26ad62322e6ed2f6a7 

 

 

https://solutionsr12.cmicpaas.com/cmictest/CmicBi/faces/main.jsf?id=kzjxgc61-82403bd363e64f26ad62322e6ed2f6a7
https://solutionsr12.cmicpaas.com/cmictest/CmicBi/faces/main.jsf?id=kzjxgc61-82403bd363e64f26ad62322e6ed2f6a7
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Dashboard Builder – Table Visual (21.42008-120,121) 

Table Visual: 

Enables the user to change the final display of numbers without affecting calculations.  Specifically, 
the following options are supported. 

- Change the sign of numbers from positive to negative and from negative to positive (reverse sign). 
- Change the sign of negative numbers to positive (absolute value). 
- Display negative numbers in brackets. 
- All enhancements above are applied to Web, Excel, PDF, Card view and Crosstab view.  They are 
also applied to pivot items, subtotals and totals.  
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Change Management 

Added Margin Fields to OCO program (19.79664) 

Added 2 new columns (Total Margin Amount and Margin %) to Owner Change Order screen (invisible 
by default and to be added using lite Editor), same as available in PMJSP Owner Change Order 
Screen. 
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The Calculation is as follows: 

Example of 1 OCO with 2 PCI's: 

PCI 1 = 20500 (billing) - 12500 (budgeted) = 8000 

PCI 2 = 2411 (billing) - 2210 (budgeted) = 201 

Final Margin and Margin % 

Total Margin Amount = $8201 (8000 + 201) 

Margin % = 35.8% (8201 / 22911) 

 

 

 

Selective Markups for PCI (21.40801) 
 

Overview: 

 

The purpose of this feature is to provide the ability of calculating Markups for selected PCIs. A new 
column as checkbox called ‘Markup’ has been added to the PCI Detail Tab in ‘Enter PCI’ screen, so 
user can specify which line items will have the markup rules applied to.   

 

Modifications: 

 
Modified ADF screen - Enter PCI (PMCHGFM): 
CM > Change Orders > Enter PCI 
A new checkbox column called ‘Markup’ has been added to ‘Enter PCI’ screen that indicates which 
line will have markups applied to. 
 
Markup flag: 

• When checked and enabled, indicates only the selected lines will have a markup applied to, if 
the job, cost code and category satisfy the markup rules.   

• When unchecked and enabled, indicates Markup has been removed from the PCI line or 
markup has not been calculated for that PCI line. 
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• When unchecked and disabled, indicates the line is a Markup line. 
 

Note: For new PCIs, Markup flag is set to ‘Y’ by default which leads to save the corresponding value 
in database. For existing PCIs (created before this feature), Markup flag is set to ‘Y’ on the screen to 
facilitate calculating Markup if user wishes to do so.  
 
Screenshots: 
 
Calculation of Markups: 
CM > Change Orders > Enter PCI 
Markup checkbox is now available on Enter PCI screen 

 

 

As mentioned earlier, for existing PCIs, Markup flag shown as ‘Y’ on the screen to facilitate 
calculating Markup if user wishes to do so.  

By pressing ‘Calc. Markups’ button, Markups will be calculated and applied to the selected PCI lines 
based on the Markup Rules Details defined in the following screen. 

CM > Local Tables > PCI Markup Rules 
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As the result of Markup Calculation (Calc. Markups button) for the selected PCIs, Markup lines will be 
generated that satisfy the Markup rules (Detail Rules marked in the above screen), followed by a 
confirmation alert. 

 
 

By acknowledging the alert, generated Markup lines appear on the PCI Detail tab. 

 

 
 

Please note that Markup flag is disabled for the generated Markup lines and cannot be selected. 

Remove Markup on specific PCIs: 

To remove generated Markups for one or more PCIs, unchecking the Markup flag and recalculating 
Markups using ‘Calc. Markups’ button will remove the Markup lines for selected PCIs.  
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A confirmation alert indicates the success of the removal Markup line(s) for unchecked PCI and 
generating Markup lines for PCIs that still checked and satisfy the Markup Rules Details. 

 

 
 

Following screen shows the Detail tab after removing and recalculating Markups: 
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If Markup flag is unchecked for one or more PCI line, no Markups will be generated even though the 
detail line(s) satisfies the Markup Rules Details. 

In this example Markup flags unchecked for all PCI lines.  

 

 
 

Calculating Markups using ‘Calc. Markups’ button, results in the following screen with no Markup lines 
and an alert to indicate that no markups have been generated. 
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Security: 

Standard Security has been implemented to control the column with the following options: 
Unrestricted, Read Only, Hidden 

 

Unrestricted: Markup flag is shown on Potential Change Items screen and user can check/uncheck 
the flag to calculate/remove the markups for the PCI lines. 
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Read only: Markup Flag is shown on Potential Change Items screen, but user cannot 
edit(uncheck/check) the flag. 
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Hidden: Markup flag is not visible on the screen, and it is not available to the user 
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New ‘Year’ Field Added so that Latest AIA Report Version is Printed 
(21.46274) 

 

New year field added to JB Control so that latest version of AIA G701 (PMG701) report prints. 

 

Modifications: 

New field 'Year' is added on Invoice tab in JB Control. 

The AIA related fields need to be grouped under 'AIA' section on Invoice tab of JB Control program. 

Changed the prompt of AIA License Flag from 'AIA G702 and G703 Forms Licensed by Company' to 
read as 'AIA G701, G702 and G703 Forms Licensed by Company'. 

 When AIA License Flag is unchecked, the fields AIA License Number, AIA License Expiry Date and 
Year are cleared and disabled.  

‘Year’ field is validated to be a positive number. 

 

Set up and Printing: 

In JB Control, Check the AIA Licence flag 'AIA G701, G702 and G703 Forms Licensed by Company'. 
Enter the AIA License Number, AIA License Expiry Date and Year of new version of G701 you want 
to print on the PMG701 report.  
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Print the Owner Change Order document (PMG701) report. 
 

 
 

When the year field is left blank in JB Control, then the document would print 2017 which is the 
current date of the official AIA G701. 
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Print the Owner Change Order document (PMG701) report. 
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Enhancement Request-For Markups (21.42130) 

Overview: 

CMiC has added the ability for PCI Markup amounts to round to the nearest thousands and hundreds 
of thousands. 

Modifications: 

The program has been modified so that the ‘Maintain PCI Markup Rules’ screen will now include the 
following Rounding rule/options while setting up the markup rule 

No Rounding 

Round to Nearest .01 

Round to Nearest 1 

Round to Nearest 10 

Round to Nearest 100 

Round to Nearest 1,000 

Round to Nearest 10,000 

Round to Nearest 100,000 

Round to Nearest 1,000,000 

Screenshots: 

 
 

Example 1:  

 

PCI Amount: 3,000,000 
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Markup Rounding Rule: Round to Nearest 100,000 (hundreds of thousands) 

Markup Rule: 8%  

Markup Amount with No Rounding:240,000 

Markup Amount with Rounding Applied:200,000  

 

 
 

 
 

Example 2 

PCI Amount: 3,000,000 
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Markup Rounding Rule: Round to Nearest 1,000 (thousands) 

Markup Rule: 8.05% 

Markup Amount with No Rounding: 241,500 

Markup Amount with Rounding Applied: 242,000  
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New Flag ‘Allow Cost’ is added to the PCI header in PCI Entry 
screen (21.38030)-Beta version released 

Overview: 

A new flag ‘Allow Cost’ is added to the PCI header in PCI Entry screen.  

Modifications: 

The new flag ‘Allow Cost’ is added to header in the general tab on PCI Entry screen. The default 
value for Allow Cost=Y. This new flag is editable for the unposted and posted PCIs. When unchecked 
the PCI does not appear for selection in cost transaction screens, MCT, Crew timesheets, Imaging. 

 

Screenshots: 

 
 

When Allow cost is checked for a PCI, the PCI is available for selection in the cost transaction entry 
screen. 
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When Allow cost flag is not checked for a PCI, the PCI is not available for selection in the cost 
transaction entry screen. 
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Note that changes has been made only to ADF and CMIC Field changes are under development. 

CMiC Field  

Cost/Budget Status Query UD Logs – Temp Table Population 
(15.06485) 

BACKGROUND 

Prior to the changes below, user-defined logs created off the Cost Status Query log types did not 
show any data because the temporary table that is used for populating the Cost Status Query 
did not also populate data for related user-defined logs.  The changes under this work order are 
programmed to rectify this problem by populating the temporary table with data for the user-
defined logs. 

SUMMARY OF CHANGES 

Created the field ‘Link Log Type’ on the User Defined Log Type screen.  This field has default 
field  security set to `HIDDEN` on the *ALL* role: 
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The possible setting is Unrestricted/Read-only/Hidden: 

 

When set to Unrestricted, the User Defined Log Types screen has the ‘Link Log Type’ field displayed. 

Clicking on the drop-down arrow will display the list of system log types that this log type can be 
linked with.   

 

NOTE: As of now changes have only been made for Cost and Budget Status Query logs. 
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Once the link is established, user-defined logs created for the Owner Job Status Query and linked to 
log type Owner Job Status Query or Owner Job Status Query (Category), will display the temporary 
table data. 

Example: 

 

Request for Payment – SOV for Posted Record (15.04564) 

Changes have been made so that the SOV section of posted RFP screen shows the Completed 
Amount to date according to the chronology of the posted vouchers for the same contract (unposted 
RFP screen remains unchanged).  For example,  

Voucher 1 for Contract A 

Current Amount = 4000.00 

Completed Amount = 4000.00   

 

Voucher 2 for Contract A 

Current Amount = 1784.15 

Completed Amount = 5784.15 
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Voucher 3 for Contract A 

Current Amount = 5410.00 

Completed Amount = 11194.15 

Analyze Bids – Copy Estimated to Quoted Amount (15.06491) 

 

Added the [Copy Est to Quoted] button to the Analyze Bids FORM.  When this button is clicked it 
will allow the user to select the bidder under which to copy the Estimated Amount to the Quoted 
Amount for applicable bid items.  If a value already exists in the Quoted Amount field, it will not be 
overwritten. 

A different popup window is displayed when there is a single bidder versus multiple bidders in the bid 
package: 
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Single Bidder: 

 

 

Multiple Bidders: 

 



402  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

Sort Order for SOV in Subcontract, Change Order, RFP and 
Flysheet (15.04863) 

A Sort Order field will now appear on Subcontract, Subcontract Change Order, Request for Payment 
and in the Imaging Flysheet detail section.  The field is numeric and auto-generated, but can be over-
written in un-posted /posted SC/SCCO.  There is no validation for this new field.  

The Sort Order field is controlled by a flag on the Subcontract Control File (ADF).  When this flag is 
checked it will take precedence over the sort order of the SOV lines in all the above-mentioned 
applications.  

Bcc added to Communication, Issue, RFI, Submittal (15.05536) 

The [Bcc] button has been added to Communication, Issue, RFI and Submittal screens.  Field 
security can be applied to this button if desired. 

Changes were applied to allow the users to add Bcc contacts and to send I/O Email to these 
contacts. 

Six Classifiers for Subcontract SOV (15.05229) 

Added the ability to add 6 User Defined Classifiers to the Schedule of Values (SOV) of subcontracts. 

This is achieved by accessing CMiC Enterprise (Forms) through the following paths: 

 

The object is ‘Subcontract Schedule’.  Select the desired user-defined fields from the LOV of each 
classifier in the ‘Classifiers’ section of the screen and save the entries.   

For example: 
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In PM JSP, when a subcontract is created, the schedule will show the classifiers that are in use: 
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Field Security 

Field security can be applied to any or all of the six classifers if needed: 

 

Possible setting is Unrestricted/Read-only/Hidden. 

Subcontract Detail Sequence Number (15.05296) 

A Sequence number field has been added to the subcontract detail section.   

This sequence number is unique within a subcontract and begins at 1 for every contract and 
incrementing by 1 when additional detail lines are being added to that contract.  

If a detail line is deleted, the sequence number for that line is not re-used. 
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The field is not editable. 

 

Field Security 

Field security can be applied to the sequence number if needed: 

 

Possible setting is Unrestricted Read-only/Hidden.   

Daily Journal – Labor tab Copy Previous Row (15.10940) 

The changes of this work order include:  

a) the addition of an icon to represent the ‘copy of the previous row’ action in the Labor tab of a 
Daily Journal record 

b) the application of field security for this icon   

 

a) Copy Previous Row 

When the blue  is clicked, a new row is opened above it and includes an additional action icon 

 which represents the action ‘copy the contents of the previous row into this row’.   

See the screenshot below: 
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b) Field Security 

Field security can be applied to the Copy Previous Row icon if needed: 

 

Possible setting is Unrestricted/Hidden.  The default setting is ‘Unrestricted’. 

 

Update: 

THE SAME APPLIES TO OTHER TABS – FIELD SECURITY ALSO AVAILABLE 
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Enter Bid added to PM Systems Options – Document Types tab (15.08109) 

  

Added 'Enter Bid' as a valid entry on the Document Types tab in Project Systems Options. 

Multiple Form Letter Print - Merge Attachments after Report (14.87559) 

 

There is an additional flag in the Print Multiple Form Letter screen to 'Merge Attachments after 
Report'. This option involves a new process to add the valid attachments (PDF, JPG, PNG, BMP, 
JPEG, TIFF) to the report generated. All ‘converted’ attachment types will have their original state and 
should retain the markups as well. 
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NOTE: When this new flag is un-checked, the Print Multiple Form Letter functionality will function in 
the original way. 

 

 

When the ‘Merge Attachments after Report’ flag is checked valid destinations are 'Preview with 
Attachments' and 'Email' only.  Also note that with the 'Email' option you will need to select the 
attachments in the ‘Email Information’ popup display (see below), and this will add an additional 
report (report+attachments.pdf) to the Email, which is the merge: report + attachments: 
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ITB/RFQ Broadcast Email Enhancements (15.07544) 

The following enhancements have been made: 

1. ITB Email and ITB Name on Project Maintenance screen have been made more generic since 
they are used by ITB and RFQ broadcasts;  

2. Also, messages are displayed for cases where Broadcast email is missing, RFQ contact email is 
missing or contact already responded to RFQ broadcast/ Received Date is not null/Quoted 
Amount is not null. 
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Post OCO ‘Sub’ Privilege (15.11781) 

 

Enhancement - addition of a sub-privilege to  the 'Post OCO' privilege.  This sub-privilege allows the 
user to post external PCI's via the OCO instead of directly with the original 'Post External PCI's' 
privilege. 

Cost Status Queries – Send to Spreadsheet for PCI Popup (15.13478) 

Cost Status Queries - Provided Send to Spreadsheet functionality on PCI transaction popup in Cost 
Status Query including the Category level queries. 

Field Security for Issue Resolution Date (15.11912) 

Added field security to RESOLUTION DATE field on the JSP Issue screen. 

Field Security for Quantity & WM in Cost Status Queries (15.12019) 

Cost Status Queries - field security can be set for Quantity and WM in Cost Status Queries drill down. 

Cost Status Query Logs – Variance Field (16.14379) 

Added a Variance field (as per Manual Forecast) to the Cost Status Query (also category level) Log 
Builder.  This variance field (PMOJSQ_PROJ_VARIANCE_CALC_AMT) is the difference between 
the Current Budget and the Projected Cost. 

Archive Forecast upon Store Forecast Function (15.04092) 

Added an option to ‘Archive’ forecast when performing ‘Store Forecast’ function. 

Modifications: 

The Project System Options > Contract Forecasting tab is modified with a check box ‘Allow Archiving 
On Store Forecast’. The default value is ‘N’.  

The value set in Project System Options will default into ‘Store Forecast’ popup, which users may 
override as required. When checked, upon store forecast, ‘Archive’ function will also be performed. 
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Project System Options > Contract Forecast Tab 

 

 

Contract Forecast > Store Forecast pop-up 

ADF PCI Owner Allowance – Read-only for Out of Scope (14.98430) 

The ADF PCI Entry screen has been modified so that the Owner Allowance amount is not editable in 
the PCI header for ‘Out of Scope’ allowance type. Instead, when the user invokes the Allowance 
Tracking screen from the PCI detail line, the Owner Allowance on the Allowance Tracking screen will 
be defaulted as the Revenue Budget from the phase/category for which the screen was invoked.  

There is no change to any other calculations. 

Note that this functionality will only be for new PCIs being entered. If an existing PCI already has an 
Owner Allowance specified, the Allowance Tracking screen will continue to consider that as Owner 
Allowance. The Revenue Budget is not defaulted as the Owner Allowance for such PCIs. 

These changes do not apply to the FORMS version of the screen. 

Subcontract – Tax Codes in Header (15.06063) 

Modifications have been made to Subcontract Entry to include the three Tax fields (Tax1, Tax2, Tax3) 
on detail) on the SC Header, where the user is able to enter tax codes when the checkbox [Default 
Taxes] is checked. The Tax Code LOV is also made available for selection.  
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The tax codes entered in the SC header will be populated on the SOV lines otherwise if they are not, 
then the system will populate these tax codes in the same way it currently does (i.e. Taxes on SC 
header will take the precedence).  

Users are only allowed to make this setup on base subcontracts.  However, these fields are available 
on the change orders as read-only. 

Field security for these SC Header Tax Codes can be applied.  The default is set as HIDDEN. 

Project Contact Directory Report – New Fields (15.12274) 

Modifications have been made to the Project Contact Directory Report - PM1600.REP - to include 
Contact Code, Partner Abbreviation, and Trade/Scope (user-defined field). 

PM Role Privileges for Disabling Printing Subcontract /SCCO 
(15.05451) 

 

Added two project level privileges for disabling print button on Subcontracts and Subcontract Change 
Orders. 

The default value for these privileges is 'unchecked' to allow printing, thereby retaining current 
functionality. 

ITB/RFQ Broadcast – Email and Messages Enhancement (15.07544) 

  

The ITB Email and ITB Name on the Project Maintenance screen have been made more generic 
since they are used by ITB and RFQ broadcasts.  Also, messages will be displayed for cases where 
Broadcast email is missing, RFQ contact email is missing or contact already responded to RFQ 
broadcast/ Received Date is not null/Quoted Amount is not null. 
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Activities Maintenance – Float and Percent Complete (16.15258) 

The following changes have been implemented for the Activities Maintenance program: 

1. Addition of Float (in days – positive number – allows decimals) and Percent Complete (positive 
number – allows decimals) to Activity Maintenance screen and Activity Import control file and 
validation screen. 

 

These fields are added for use in custom reports and dashboards.  They are not used anywhere else 
in the application. 

By default the field security on these fields are set to ‘Hidden’ on the *ALL* role: 

  

Please note that on the Import screen and Edit mode of the Activities screen Float Days and Percent 
Complete fields are visible for input only if UNRESTRICTED. 

If any of these fields is not unrestricted - no values will be imported for these fields even if provided in 
the source file. 
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Activity Import validation screen 

 

When the field security is set to ‘Read-only’, the two new fields can only be viewed…they are not 
editable on the Activities Maintenance screen. 

 

2. Also, the Activity Description field has been increased to 120 characters. 

3. The security for the Activities program is now listed under both Security > Role Maintenance > 
Assign Programs as well as Assign Menu Items.  Therefore the user will need to be given 
access from both screens in order to use the Activities program. 
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User Defined Fields Tab in Daily Journal (15.12414) 

Added User Defined Fields tab on Daily Journal. Also provided Tab security with default HIDDEN set 
on the *ALL* role: 

  

 

The tab is also listed as an object in the User Defined Fields list: 
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Define the Daily Journal UDFs (example): 

  

 

Once the UDFs are defined in this screen they can be seen in the Daily Journal records in the tab: 
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Meeting Topic and Minutes added to Meeting Import (15.07894) 

 

Meeting Topic and Minutes (notes) have been added to the Meeting Minutes Import control file   
(pmmeetingitem.ctl). 

Revision Number and Date added to Order Multiple Form Letter 
Display (15.11801) 

 

Multiple Form Letter Print - Added two columns (Revision Number and Date) to the "Order Multiple 
Form-Letters" pop-up. 

Fields Editable for Posted PCI (16.15824) 

Changes have been made to allow editing of fields the fields: Description, Scope Description, Source, 
Start Date, End Date for posted PCI’s. 
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Six Classifiers for Punch List Header (15.09153) 

The changes of this work order includes the ability to add 6 User Defined Classifiers to the Punch List 
Header. 

The object is ‘Punch List’ as shown: 

 

Select the desired user-defined fields from the LOV of each classifier in the ‘Classifiers’ section of the 
screen and save the entries.   

In PM JSP, when a Punch list is created, the header will show the classifiers that are in use. 

 

Field Security 

Field security can be applied to any or all of the six classifiers if needed: 
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Possible setting is Unrestricted/Read-only/Hidden. 

Subcontract and SCCO Pre-qual Limits for Bonded Contract Types 
(16.15012) 

The following changes have been made to the Subcontract/SCCO programs as they relate to Vendor 
Pre-qualification Limits: 

1. Addition of a ‘Bonded’ checkbox to the FORMS Contract Types local table: 
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If the checkbox is checked against a contract type it indicates that any subcontract or subcontract 
change order of that contract type is excluded from consideration when determining the 
Subcontractor Pre-qualification limits remaining – Single Project Limit Remaining and Aggregate Limit 
Remaining. 

It also means that if the subcontract/subcontract change order is a ‘Bonded’ type, there will be no 
message to the user if the Single Project Limit and/or Aggregate Project Limit is exceeded. 

 

2. The Contract Type field can have field security applied to it. 

Subcontractor Prequalification Enhancements (15.07422) 

The following changes have been made to the Vendor Pre-qualification programs: 

1.   Website field added to the Subcontractor Prequalification as well as to the Self Service – 
Page 1 screen.  Field security can also be applied to the field. 

a) Website field in SC Pre-qualification header: 
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b) Website field in Self Service – Page 1: 

 

c) Website field – Self Service field security: 

 

 

  

d) Website field - SC Pre-qualification field security: 

 

 

 

2. Bonding Rates Per $1000 prompt added as shown, to Page 4 of the Self Service screen.  
This prompt can be modified in Prompt Maintenance. 
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3. Pre-qualifications Control  

The following changes have been made to the Pre-qualifications Control screen: 

a) addition of the flag ‘Enable Financials Required Prompt’ 

b) addition of the field ‘Number of Required Attachments’. 

 

These new settings in the Pre-qualification Control have the following effects: 

a) i. When the flag ‘Enable Financials Required Prompt’ is checked, the prompt and checkboxes 
for   the question ‘Are you interested in bidding work greater than $50,000?’ [Yes/No] 
becomes visible in Page 4 of the Self Service screen. 

           Self Service screen Page 4: 

 

 

If ‘Yes’ is checked, then certain financial data cannot be zero, namely: Gross Profit Margin, 
Operating Income, Earnings Before Taxes, Net Income, Total Assets, Total Liabilities, Total 
Equity and ‘Total Liabilities and Equity. 

 If ‘No’, then there is no requirement for these fields to be non-zero. 

       ii. Field security can be applied to the checkboxes for this question: 

 

 

 

iii. When the control flag ‘Enable Financials Required Prompt’ is un-checked, the prompt and 
checkboxes for the question are not visible in Page 4 of the Self Service screen.   

 

b)  The value in the field ‘Number of Required Attachments’ (Pre-qualification Control), determines 
the number of attachments that is required on Page 6 of the Self Service screen. 
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More attachments can be added, but less than the required number will result in rejection of the 
application during the submission process, forcing the user to add the documents. 

 

4. The Credit Line Available field in the enhanced Financial Information screen (SC 
Prequalification screen) is now calculated as: (Amount Line of Credit - Against Line of Credit).  

Previously the field was not being calculated. 

Submittal Activity LOV – Start and End Date added (15.11583) 

Added the Start and End Date of the Activity in the Activity LOV in the Submittal Entry screen. 

Units Complete – Source Shown in History (15.07928) 

Changes have been made to display all units completed entries, including where the data was 
entered, on the "Phase Unit Transaction History" pop-up in both the Units Complete program and the 
Daily journal program, regardless of whether they were entered from the Daily Journal or the Units 
Complete screen or other. Units entered from FORMS or ADF will not be singled out. 

Field Security on Pre-qual Limit Fields in SC/SCCO (15.07671) 

Added field security for the Pre-qualification Limit fields on both the Subcontract and Subcontract 
Change Order screens. 
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PCI Quoted Amount for SCCO Amount (16.14940) 

The changes for this work order include the following: 

1. Addition of the flag ‘Default SCO Amount from PCI Quoted Amount’, to the PM Control – 
Change Management tab: 

 

 

When the flag is checked, the subcontract change order Amount will be populated with the Quoted 
Amount from the associated PCI detail line. 

When the flag is unchecked, the subcontract change order Amount will be populated with the Final 
Amount from the associated PCI detail line (previous functionality). 
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Field security is available for this flag: 

 

 

2. Ability to change the prompt of the Amount field on the Subcontract Change Order screen to 
‘Sub Quote Amount’ or any other desired text. 

NOTE:     Field security can be applied to the Quoted Amount field on the Subcontract Change 
Order screen.  The field security can be used to hide it (programmed from previous work order). 

 

 

3.  The current functionality to override the amount in the Subcontract Change Order screen still 
exists. 

a) There is an existing flag called "Synchronize SCO and PCI amount", but this synchronization 
is on the “Final Amount”.  The flag is found in the PM JSP > Project Maintenance > Defaults 
tab. 

b) If this flag is checked, then if the Amount is modified in the Subcontract Change Order 
screen, it needs to synchronize the PCI “Quoted Amount” field ONLY. 

c) In this scenario, the PCI detail “Final Amount” remains unchanged. 
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Allow Only PCIs Associated with JB Contract in OCO 
(16.15287) 

The changes for this work order were made so that users will be able to filter out available PCI's in an 
Owner Change Order (OCO) based on the selected JB Contract in the OCO Header. 

1. A new PM Control flag has been added to the Change Management tab: “Allow Only PCIs 
Associated with JB Contract in OCO”: 

 

2. Field security is available for this flag. 

 

  

3. If the flag is checked in the PM Control, when the user is in the OCO entry screen, only the 
PCI’s that have details that are associated with the JB Contract selected in the OCO Header 
are available for selection in the PCI LOV of the OCO.   If the control flag is not checked, then 
the availability of the PCI’s in the LOV does not include consideration of the JB Contract in 
the OCO Header, regardless of whether the JB Contract is selected in the OCO Header or 
not (this is original functionality). 

Tax Codes in Subcontract and Subcontract Change Order 
Headers (15.06063) 

The changes of this work order include the following: 

1. Addition of fields for the Tax Codes in the Subcontract and Subcontract Change Order 
header.  By so doing, the user can set default values that are to be populated in the SOV, 
and these default values will not necessarily be coming from the vendor record. 

2. Field security can be applied to the Tax Codes in the header of the Subcontract and 
Subcontract Change Order: 
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The field security is initially set as ‘HIDDEN’ on the *ALL* role for both the Subcontract and 
Subcontract Change Order programs: 

 

 

Possible settings on the Subcontract are: Unrestricted, Read-only, Hidden. 

 

Possible settings on the Subcontract Change Order are: Read-only, Hidden. 

How the new functionality works: 

In the Subcontract program, when the ‘Default Taxes’ checkbox is checked, the Tax Code boxes are 
visible: 

 

If the ‘Default Taxes’ checkbox is unchecked, then the Tax Code boxes are not visible: 
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When the ‘Default Taxes’ checkbox is checked, and the Vendor is selected, any tax codes defined at 
the vendor level will default into the Tax Codes boxes in the Subcontract Header.  They can be 
overridden. 

The Tax Codes entered in the Header will default to the SC SOV lines created.  These can be 
overridden as well. 

 

For the Subcontract Change Order, the header will default with the values from the Subcontract 
header, but these values in the change order are presented as Read-only.  The change order SOV 
will also default with the values from the header, but these can be overridden if desired. 
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IMPORTANT NOTE:  Regardless of the tax codes that are set in the SC or SCCO Header, it is 
those at the SOV level which will be used to calculate the tax, as per original standard 
functionality.  The codes set in the header are simply for defaulting to the SOV level when new 
SOV lines are created. 

Daily Journal – Previously Submitted Billing Units (16.20007) 

A 'Previously Submitted Units' column has been added to the Billing Units Complete tab. It is the 
Total of "Today's Units" accumulated for daily journals prior to the current journal date, for 
SUBMITTED journals. 

 

 

The Daily Journal Reports (PM4010.REP, PM4010_2.REP, PM4010_3 (Jasper)) have been modified 
to show this new column as well. 
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Vendor LOV – Pre-qualification and Approval Status (16.15818) 

 

Added the columns: Pre-qualification Status and Approval Status in the Vendors LOV. 

PM Logs – Highlight Record Accessed (16.15823) 

 

PM Logs - Added functionality to highlight the current row when user returns to a PM Log after 
clicking [Back to Log]. 

Converting DOCX to PDF when Printing Documents (15.11771) 

SETUP 

1) LibreOffice Installation - Apache LibreOffice is used to do the conversion of the DOCX to PDF 

It is a manual installation, and required to be the following: 

{cmHome}\{version}\{environment}\sql\LibreOffice 

(ex. D:\cm\v10\prod\sql\LibreOffice) 

NOTE: Changes are not available for Unix. 
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2) LibreOffice license link 

https://www.libreoffice.org/about-us/licenses/ 

RULES 

To convert an MS Word DOCX file to PDF, the following rules apply: 

a) DOCX template must not be in compatibility mode on MS Word 2016 

b) for layout, use tables, otherwise there will be a misalignment issue and CMiC will not be supporting 
this 

FEATURE DESCRIPTION 

This feature allows the user to print a DOCX file as a PDF rather than only as a DOCX, the only 
option which was available in CMiC up to this point. 

When printing a Form Letter based on a DOCX template the available destinations are “Preview” and 
“Email”. 

When “Email” is selected, the Email popup offers additional format options: PDF or DOCX. 

Below are sample screenshots for a possible path to printing a PDF from a DOCX report. 

First, select the DOCX report from the reports list when the [Print Report] button is clicked: 

 

 

Next, select the Destination and Format on the Report Config popup window: 

 

https://www.libreoffice.org/about-us/licenses/
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When the Destination is ‘Preview’, you can chose the Format as either DOCX or PDF.   

 

PDF will display the DOCX as a PDF document.  DOCX will display the DOCX in its unconverted 
format (as per original functionality). 

When the Destination is set to ‘Email’ the Email Information screen is displayed with the ability to 
select the Format.  In this screen you can select the PDF format for the DOCX report.  You can also 
select any attachments you want to have accompany the main report. 
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Select PDF then click [Send], and the resulting e-mail that is sent will have the DOCX report 
converted to a PDF: 

 

Forecast Date Defaults as Posting Date (16.15822) 

Changes applied to default the JC Control - Forecast Period - End Date as the Posting Date for 
Subcontracts, Subcontract Change Orders, PCI's, Owner Change Orders, Request For Payment. 
This is achieved via a PM Systems Options flag (PMSYS_POST_DT_ON_FRCST_PER_FL):  when 
set to Y = If the forecast period is different from current month, last day of period or current date 
comes as default date for posting, whichever is earlier.  This flag is updated in the table – there is no 
user interface screen. 

Quick Print (15.09655) 

 

The underlying concept of Quick Print is to allow users to assign a Report or Form Letter relevant to a 
particular PM object, such as an RFI, to the [Quick Print] button on the screen that displays 
individual records of the PM object.  Also, Quick Print gives users the option of merging any 
attachments associated with the currently displayed PM object record to the Report/Form Letter 
assigned to the [Quick Print] button. 

As an example, the above screenshot shows the [Quick Print] button on the Request for Information 
screen when it is displaying the details of an RFI.  If clicked, the Report/Form Letter assigned to this 
screen’s [Quick Print] button will be initiated, and if opted, any attachments for the displayed RFI will 
be merged to the assigned Report/Form Letter. 
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Assign Report to Quick Print Button  

 

Sample of Report Assignment screen; standard Treeview path: PM > File Maintenance > Report Assignment 

In the Report Assignment screen, the Default checkbox is used to indicate that the Report is the 
default to print when the [Quick Print] button is clicked on the screen displaying records of the PM 
object selected via the Object field.   

The Merge checkbox is used to indicate whether any attachments associated with a particular record 
are to be merged with the default report set to print by the [Quick Print] button for the PM object 
selected via the Object field (shown above). 

As an example, in the above Report Assignment screenshot, the selected PM object is an RFI, and 
the Report checked as its default is RFI Urgent Response Needed.  So, the [Quick Print] button on 
the RFI screen displaying individual RFI records (shown in previous screenshot) will generate the RFI 
Urgent Response Needed Report, and if opted, any attachments for the displayed RFI record will be 
merged to the Report. 

Only one Report/Form Letter at a time can have these checkboxes checked.  When a Merge flag is 
checked, it makes sense to ensure that the corresponding Default flag is also checked. 

The Quick Print feature is available for the following PM objects: Communications, Meeting Minutes, 
RFI’s, Issues and Submittals. 

Auto Indexing of Object Metadata (15.06721) 
 

Introduction  

This application automatically transfers the Object metadata to attachment metadata. Initially, 
mapping must be done for binding the object to the document type and their fields. 

Prerequisites:  

This application is Admin managed application. The mapping will be done by Admin.  

For mappings the following conditions should be fulfilled: 

1. This is a licensing based application. The data would be transferred only if the licensing flag 
is enable. If licensing flag is disable. No data would be transferred. 

2. The mapping should only be done as explained in the below steps.  

Functions: 

• Mapping of Object to document types. 
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• Upload the new attachment and transfer the metadata to mapped fields of selected 
document type. 

How it Works  

Phase 1:   Mapping Phase:  

Go to the Attachment tab of any existing object of the Object type which needs to be mapped. 

 

1. Click the Show Mapping button : The Mapping screen will pop- up 

2. Select Document type : 

 

 
  

3. Enable the check box corresponding to Object field, it will enable the mapping for that Object 
column. Select document type column. Maximum 10 mappings can be selected. 
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4. Click the save button after selection. A pop-up message will appear after saving the 
mappings. 

5. One Object type can map to multiple document types but one document type can map to a 
single Object type. 

6. Delete button is for delete the mapping for selected document type. 

7. Delete all button works for delete the all mappings for current object. 

 

 

8. Enable check-box appear for enable/disable the metadata transfer. Mapping can be disabled 
by click on the save button after uncheck the “Enable check-box”. 
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Note: The [Show Mapping] button will not work if launched from anywhere except explained above. 
Do not do the mapping while adding new object.  

  
Phase 2:  Upload Attachment: 

1. Go to Attachment tab of existing Object and click the Add/Upload New button. 

 

2. Pop-up will appear. Select the document type. 
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3. Upload the file and click save button. 

 

4. Open the history of attachment and check the metadata transferred. 
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5. The same works for ‘Multiple Upload’ and adding existing attachment. 

 

Issues – Linked Objects and Related Objects tabs (14.87892) 

 

The following changes have been applied to the Issues program: 

• the ‘Related Objects’ tab that previously appeared on the Issues screen has been renamed to 
‘Linked Objects’, and a new tab called ‘Related Objects’ has been added to show the objects 
related via the new method used by other objects. As such, the Issues screen now has two 
separate tabs. One labelled ‘Related Objects and the other labelled ‘Linked Objects’.) 

• the button on the ‘Linked Objects’ tab has been renamed to ‘Link Objects’ rather than ‘Assign 
Objects’ so the terminology is consistent. 

• For objects added in the Related Objects tab of an Issue, the issue will be available in the 
Related Objects tab of that object and vice versa. 

• whatever is added via the Linked Objects tab in the Issues screen will not be available in the 
Related Objects tab of other objects anymore and will be visible in the  Link to Issue screen 
(after click on Link to Issues button) and vice versa. 

• field security can be applied to both tabs. 
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Submittal/Submittal Package CSI and Free Form Defaults (15.07938) 

 

An enhancement has been made to the Spec Section and Spec Sub-Section LOV Options in PM 
System Options, as they relate to Submittal and Submittal Packages.  Previously, there was an option 
to Allow Both CSI Code and Free Form codes in the LOV.  This has been separated into two options 
so that when the LOV allows both options, the user can indicate which option it will default with.  The 
two new options are: 

• Allow Both CSI Code and Free Form (Default by Free Form) – both options are available in 
the LOV’s but the default is set at Free Form 

• Allow Both CSI Code and Free Form (Default by CSI) – both options are available in the 
LOV’s but the default is set at CSI 

For example: 

With the settings: 

 

The corresponding LOV’s will display: 
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Meeting Minutes Action Item Link (16.15079) 

 

Added the ‘Action Item’ link to view related action items for agenda items.  This link is visible when 
the PM Control – Project Calendar tab flag is checked: 

 

When Action Items are created for Meeting Minutes as a result of this flag being checked, the link 
provides a way of openng up the Action Item from within the Meeting Minutes, so that any edits made 
by the person responsible (from their My Actions page) are easily accessible.   
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Also, changes are made for not allowing a user to modify the action item if the user is not responsible 
for the action item. 

For example, after setting the privileges for the current user, in the screenshot below, current user 
Darlene Pottinger, can view but not edit the action item that has George Allen as responsible contact: 
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Meeting Minutes Notes Status (16.21054) 

 

Modifications have been made to allow for a Status field to be set on each Meeting Minute Note.  The 
list of Statuses used are from the same list used for Meeting Minute Items.  There is no link or 
synchronization between a Meeting Minute Note Status and its associated Meeting Minute Status.  
This field is not considered mandatory, and is being provided for informational purposes only.  No 
reports were adjusted in relation to this change. 
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Auto Assignment of Project Selection Program to Security Role 
(16.21215) 

 

PM Menu - Project Selection - when a new role is created, access to this program is defaulted as 
'checked' and read-only, so that the user assigned to this role will automatically have access to 
project selection, and no one will 'accidentally' un-check the program when assigning security access. 

‘Add Attachment’ changed to ‘Edit Details’ (16.23568) 

 

Documents - Changed the button label on all Attachment Tabs from 'Add Attachment' to 'Edit Details' 
to distinguish from the [Add/Upload New] button. 

Special Terms & Conditions Flag - Vendor Level (16.21149) 

Overview: 

CMiC has added a new checkbox labeled “Special Terms & Conditions” to the Maintain Vendor 
screen. The Subcontract screen in PM JSP has also been modified to show the notification as 
“Note: Special Terms and Conditions exist for this vendor” on the screen for the vendors with the 
flag “Special Terms & Conditions” checked. 
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Settings and Examples: 

1. Check the new flag “Special Terms & Conditions” on the Maintain Vendors screen for the vendor 

ZZ-ACME: 

 

 

2. Create a Subcontract for the same vendor ZZ-ACME: 

 

 

As soon as the vendor ZZ-ACME is selected from the LOV, the notification “Note: Special Terms and 
Conditions exist for this vendor” appears on the subcontract screen (as shown above).    

 
3. The notification has remained on the screen upon Saving the Subcontract: 
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If the user closes the Subcontract, returns to the Log view, and re-opens the same Subcontract (it has 
a status “Pending”), the notification will still be present on the Subcontract screen.  

 
4. Post the subcontract: 

 
 

5. The notification on the subcontract screen will remain upon posting the subcontract: 

 

Summary: 

The new flag “Special Terms & Conditions” has been added to the Maintain Vendor screen. If 
this flag is checked, the new subcontract created for this vendor will have the notification as 
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“Note: Special Terms and Conditions exist for this vendor” on the screen. The notification 
remains on the subcontract even after posting.  

Work Days and Comments added to Bid Items (16.19739) 

Two fields have been added to the PM JSP Bid Items screen as well as the Bid Item Import.  In 
addition, these two fields have been included in the Cost Status and Budget Status Queries 
(Category level). 

The fields are: 

Work Days - numeric 

Comments – up to 4000 characters 

 

 

 

The fields can be added to the Bid Items sigma grid by using the [Configure View] button: 

 

 

The fields are populated in the Bid Items sigma grid either manually or via the Bid Items Import, and 
then when the Budget is updated during the Bid Item ‘Update Budget’ function, they will populate the 
necessary tables that are used by the Cost and Budget Status Queries. 
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Bid Item Import  

The Import control file has the updated definition (file = pmpbiimj.ctl): 
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The Import Validation screen will display the Work Days and Comments fields: 

 

 

Cost and Budget Status Queries (Category level) – Log Builder 

To include the Work Days and the Comments fields in the query screens, the user will be required to 
go to the Log Builder and select the columns for the two logs: 

Cost Status Query (Category) Log: 
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Budget Status Query (Category) Log: 

 

 

Copy From Bid Package or Subcontract to Bid Package (15.12824, 

15.12888) 

Changes have been made to the Copy From functionality in Bid Package to  

a) allow copying from Bid Packages that exist in a different Company than the source company 

b) allow copying from a Subcontract (in or out of the source company) 

Prior to the changes, the Copy From Bid Package had the following look: 
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To facilitate the changes itemized above, a Company field (with LOV) and a Subcontract field (with 
LOV) have been added to the Copy From Bid Package screen: 

 
 

The following notes should be considered for the Copy functionality: 

1. user company/project security is enforced 

2. the company of the current project is defaulted in the Copy From popup 

3. Bid Package/Subcontract cannot be selected without first selecting a Project 

4. attachments are not copied across companies, nor across projects, for Bid Packages 



452  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

5. the user can only copy from Bid Package OR Subcontract, not both at the same time…if Bid 
Package is selected, when you try to select Subcontract, Bid Package will be wiped out 

6. the Subcontract option only allows the following to be copied (within the same company and 
project): 

                 
 

7. the Subcontract option only allows the following to be copied across companies or same 

company but different project: 
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8. As a general rule, when copying across companies,  if the job/phase/category does not exist 

in the target company then such combination is not copied due to this invalid/incomplete 

combination.  In this case, the user has to make sure that the target company has the 

required setup of valid job/phase/category. 

In this case, no data is copied for the Buyout tab.  For Special Pricing, Inclusions and 
Exclusions, the data is copied but the job/phase/category information is left blank. 

Bid Items Popup in Cost Queries and Contract Forecast (16.19617) 

Changes have been made to add a pop-up screen to the 'Cost Status Query by Category', 'Revenue 
Status Query by Category', and the 'Contract Forecasting' screens showing the bid items information. 
The data included in the pop-up is: Bid Item Name, Closed flag, WM, Estimate Quantity, Estimate 
Price, Estimate Amount, Revenue Quantity, Revenue Price, and Revenue Amount. The pop-up is 
accessible by clicking on the cost code (phase code). 

To set up the link in the Cost Status (Category) and Revenue Status (Category) queries, go to the 
Log Builder for each of these queries and do the following: 

for the Phase field, select ‘JC Transactions (Cost)’ in the Link column, and enter ‘Click to see bid 
items’ (for example) in the Link Description column: 
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When done, go to the queries to see the effect of the changes: 

 

 

 

 

In the case of the Contract Forecast, the changes are coded in the program directly, so when the user 
launches the program for a period, the Bid Items popup will be displayed after clicking the Phase of 
any line (the blue color indicates that there is an underlying link): 
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PM Role Privilege - Adding Contacts To Company (16.21805) 

This enhancement includes a PM Role privilege in the MAINTENANCE section of the PM Role 
Privileges screen.  The privilege is "Add Contacts To Company", to allow the user with this privilege 
the ability to add new Project Contacts to C-Type partners, otherwise only existing project contacts 
can be added for C-Type partners, by selecting them from the contact LOV. 

If the user tries to add new C-Type contacts without this privilege assigned to his PM Role, a 
message will be displayed, and the user will be required to select a contact from the Contact LOV 
instead.  On selection of the contact code, it will back-fill the company/partner of the selected contact 
code (i.e. act as if the company code was not entered and left blank). 

Also added the following columns to the Contact LOV: 

Abbrev 

Company Code 

Company Name 

Type 

Prequalification Approval Status Warnings (16.21138) 

The changes of this work order include the following: 

1. Addition of a button: [Approval Status Setup] to the Prequalification Control screen: 
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2. Field security can be applied to this button.  It can be set as Unrestricted or Hidden: 

 

 
3. Click the button to get a popup window that allows the set up and entry of warning messages for 

each Approval Status that has been defined for the Vendor Prequalification screen. 

 

Enter the warning message that you wish, in the Warning field, for each Status Code.  If default 
values are already in place after installation of the files for this work order, these can be overridden 
with different values. 

Select ‘Soft Warning’, ‘Hard Warning’ or ‘No Warning’ in the Type column and save the changes.   

Example: 
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How it works 

Once the setup is in place, whenever a subcontract or subcontract change order is created, on 
saving, a soft/hard no warning will be displayed according to the prequalification Approval Status of 
the vendor. 

EXAMPLE 

Setup: 

 

Vendor Prequalification record: 

 

Subcontract: 

On clicking Save Draft/Save, the warning message will be displayed in the subcontract/subcontract 
change order screen:  
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APPROVAL STATUS WARNINGS 
• In the case of a Soft Warning, a warning message corresponding to the approval status will be 

displayed when the user saves the subcontract or subcontract change order.   
If the ‘SC Prequal – Issue Contracts To Non-Qualified Vendor’ privilege is not assigned to the user, 
the standard message “Vendor XXX requires Prequalification and does not currently qualify….” will 
follow the soft warning.  Otherwise, the record will be saved. 

 

• In the case of a Hard Warning and:  
 i) Scenario 1 : In case the privilege 'SC Prequal - Issue Contracts To Non-Qualified Vendor' is 
                          assigned to the user, the warning message will be displayed to the user when he 
                          clicks the Save/Save Draft button and he will be allowed to save the subcontract/ 

                    subcontract change order as usual 
  ii) Scenario 2 : In case the privilege 'SC Prequal - Issue Contracts To Non-Qualified Vendor' is 
                                  not assigned to the user, the warning message will be displayed to the user when  
                                  he clicks the Save/Save Draft button.  However, the flow of the 'Save' operation  

     will be halted and the user will not be allowed to save the subcontract or  
     subcontract change order 
 

• In the case of 'No warning', no warning messages will be displayed to the user irrespective of any 
message that had been maintained in the 'Approval Status Setup' in the Prequalification Control.   
If the ‘SC Prequal – Issue Contracts To Non-Qualified Vendor’ privilege is not assigned to the user, 
the standard message “Vendor XXX requires Prequalification and does not currently qualify….” will 
be displayed.  Otherwise, the subcontract/subcontract change order will be saved. 

 

• The messages will be displayed in both Add and Edit modes. 
 
Below are example screenshots of the warnings: 
Soft Warning: 

 
 
Hard Warning (with privilege assigned): 

 
 
Hard Warning (with privilege not assigned): 
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Form Letter View for Issues (16.18983) 

The new form letter view DMISSUE_FL_V has been created to allow the user to create  MIP 
Document Templates for Issue records created in PM JSP. 

When the files from this work order are installed, the Form Letter Definition screen will show the entry: 

 

 

In PM JSP, the Document Merge Field List screen will show the entry for DMISSUE FL, to be used in 
the creation of MIP Document Templates based on Issues: 
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And the Document Merge Maintenance screen will show the entry in the ‘Report’ drop-down: 

 

Importing PCI Details (16.15826) 

Changes have been made to allow for the importing of PCI Detail records into an already existing 
PCI.  The PCI Header must have already been created, then the details can be imported from Excel 
(or a text file). Imported columns include WBS fields and Classifiers. 

The IMPORT option is available as a link on the PCI Detail tab of an unposted PCI, where the user 
can import details after passing through all validations that currently exists in the PCI details. 

 

The Control File for the import has the following layout: 
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The following table gives the detail description for each field: 

File Layout Details– PCI Details Import 

Control File = CMDETAIL.ctl 

Column Name Description Required Type Length 

CMDI_COMP_CODE    A valid CMiC company 
code  

Yes Varchar2 10 

CMDI_CHG_CODE PCI Code (should 
match with code from 
PCI Header record)  

Yes Varchar2 10 

CMDI_MAST_JOB_CODE   A valid CMiC job code  Yes Varchar2 10 

CMDI_JOB_CODE This is the job in the 
detail of the change 
order.  It may be a sub-
job of the job in the 
header.  

Yes Varchar2 10 
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Column Name Description Required Type Length 

CMDI_SC_VEN_CODE Subcontract Vendor 
Code - required if a 
subcontract is related to 
the change. 

No Varchar2 8 

CMDI_SC_CONT_CODE Subcontract Code - 
required if a subcontract 
is related to the change. 

No Varchar2 20 

CMDI_PHS_CODE Must be a valid phase 
code for the job 

Yes Varchar2 16 

CMDI_CAT_CODE Must be a valid 
category for the job 

Yes Varchar2 16 

CMDI_REF_NAME This field populates the 
Long Description 
column displayed in the 
PCI Details 

No Varchar2 4000 
 
 

CMDI_BUDG_WM_CODE A valid WM code must 
be entered 

No Varchar2 2 

CMDI_BILL_CODE Bill Code – required if 
External or OBC class 
PCI and a Job Billing 
type job, otherwise it is 
optional 

No Varchar2 50 

CMDI_SC_CHG_CODE Subcontract change 
code - required if a 
subcontract is related to 
the change. 

No Varchar2 12 

CMDI_SC_TASK_CODE Subcontract change 
task code - required if a 
subcontract change 
code is entered 

No Varchar2 16 

CMDI_DAYS_IMPACT The impact of the 
change in Number of 
Days  

No Num 10 

CMDI_ACT_CODE Activity Code No Varchar2 10 

CMDI_PHS_UNIT Phase Quantity - leave 
blank if not required 

No Num 16,8 

CMDI_BUDG_QTY Budget Quantity related 
to Change order – may 
be left blank if not 
applicable. 

No Num 16,8 

CMDI_BUDG_EST_UNIT_RATE Estimated Rate No Num 16,4 

CMDI_EST_BUDG_AMT Estimated Amount No Num 18,2 

CMDI_BUDG_QUOTED_UNIT_RATE Quoted Rate No  Num 16,4 

CMDI_QUOTED_BUDG_AMT Quoted Amount No Num 18,2 

CMDI_BUDG_UNIT_RATE Budgeted (Final) Rate No Num 16,4 

CMDI_BUDG_AMT Enter the Budget (Final) 
Amount 

No Num 18,2 

CMDI_BILL_UNIT Billing units are added 
here. It is optional. 

No Num 10,3 

CMDI_BILL_UNIT_RATE Billing Rate No Num 18,4 
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Column Name Description Required Type Length 

CMDI_BILL_AMT Required if External or 
OBC class PCI and a 
Job Billing type job- if 
left blank it will be 0. 

No Num 18,2 

CMDI_STATUS_CODE Change Order Status – 
must be a valid CMiC 
change order status 
code; *if left blank it will 
be updated with the 
status from the header 
on editing the PCI. 

Yes* Varchar2 10 

CMDI_OWNER_CHG_CODE Owner Change Order 
Number if required 

No Varchar2 20 

CMDI_WBSV_CODE1 WBS Code 1 Value No Varchar2 10 

CMDI_WBSV_CODE2 WBS Code 2 Value No Varchar2 10 

CMDI_WBSV_CODE3 WBS Code 3 Value No Varchar2 10 

CMDI_WBSV_CODE4 WBS Code 4 Value No Varchar2  10 

CMDI_CLV_VALUE_CODE1 Classifier Value 1 No Varchar2 16 

CMDI_CLV_VALUE_CODE2 Classifier Value 2 No Varchar2 16 

CMDI_CLV_VALUE_CODE3 Classifier Value 3 No Varchar2 16 

CMDI_CLV_VALUE_CODE4 Classifier Value 4 No Varchar2 16 

CMDI_CLV_VALUE_CODE5 Classifier Value 5 No Varchar2 16 

CMDI_CLV_VALUE_CODE6 Classifier Value 6 No Varchar2 16 

 

Importing the PCI Details. 

The PCI Import functions in much the same way as other PM JSP imports.  Below is an outline of the 
steps and a description of the Validation screen. 

 

Pre-requisites 

• Prepare a .txt or .csv file with the details to be imported, using the layout guide 
above.   

• For numeric codes, leading zeroes are usually removed in a .csv file, so make sure to 
adjust these appropriately before. 

IMPORTANT NOTE: The file must be .TXT or .CSV.  Also note that if the file is opened using 
Excel, it may lose some of its original formatting.  It is preferable to open and edit using 
Notepad.  For example, if the value of a field is “01”, editing in Excel will possibly change it to 
‘1’. 

Example input: 
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• Create or open up the PCI record that the details will be imported into.  It can be in 
Edit or View mode. 

 

 

Carry Out the Importation 

Click the ‘Import’ link in the detail section of the PCI, to display the popup window where you 
will select the .txt or .csv file to be imported. 
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Next, click [Upload] to bring the imported records to the Validation screen: 

 

The initial validation will report any errors.  By default, only records with errors are displayed 
on the Validation screen. 

The ‘Show lines with errors only’ checkbox, can be un-checked to display all records – 
those with and without errors. 

Proceed to make corrections and changes on this screen.   

Click the [Re-Validate] button to re-validate the corrections and changes each time they are 
made. Changes include any records selected for deletion. 
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When there are no more errors, the [Accept] button becomes enabled. 

Click [Accept] to pull the validated records into the PCI Detail section. 

 

IMPORTANT NOTE: 

• If a value is entered for any WBS field that is related to the PCI Code, the value will 
be ignored, and that WBS field will be read-only.  This is due to a feature in CMiC 
which allows a WBS Code to be linked to the PCI Code, for certain requirements.  A 
message has been included in the Import Validation screen to inform the user. 

Subcontractor Prequalification Enhancements (15.07422) 

The changes of this work order include the following: 

1.  Website field added to the Subcontractor Pre-qualification header as well as to the Self Service – 
Page 1 screen.  Field security can also be applied to the field. 

a) Website field in SC Pre-qualification header: 

 

 

b) Website field in Self Service – Page 1: 
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c) Website field – Self Service field security: 

 

 

d) Website field - SC Pre-qualification field security: 

 

 

 

 

2. Bonding Rates Per $1000 prompt added as shown, to Page 4 of the Self Service screen.  
This prompt can be modified in Prompt Maintenance. 

 

 

 

 

 

3. Pre-qualifications Control  

 

The following changes have been made to the Pre-qualifications Control screen: 

a) addition of the flag ‘Enable Financials Required Prompt’ 

b) addition of the field ‘Number of Required Attachments’. 

 

These new settings in the Pre-qualification Control have the following effects: 
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a)  i. When the flag ‘Enable Financials Required Prompt’ is checked, the prompt and checkboxes 
for the question ‘Are you interested in bidding work greater than $50,000?’ [Yes/No] becomes visible 
in Page 4 of the Self Service screen. 

 

           Self Service screen Page 4: 

 

 

If ‘Yes’ is checked, then certain financial data cannot be zero, namely:  

Gross Profit Margin,  

Operating Income,  

Earnings Before Taxes,  

Net Income,  

Total Assets,  

Total Liabilities,  

Total Equity and  

Total Liabilities and Equity. 

If ‘No’, then there is no requirement for these fields to be non-zero. 

 

 ii. Field security can be applied to the checkboxes for this question: 

 

 

 

iii. When the control flag ‘Enable Financials Required Prompt’ is un-checked, the prompt and 
checkboxes for the question are not visible in Page 4 of the Self Service screen.   

 

b)  The value in the field ‘Number of Required Attachments’ (Pre-qualification Control), determines 
the number of attachments that is required on Page 6 of the Self Service screen. 
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More attachments can be added, but less than the required number will result in rejection of the 
application during the submission process, forcing the user to add the documents. 

 

4. The Credit Line Available field in the enhanced Financial Information screen (SC Pre-
qualification screen) is now calculated as:  

Amount Line of Credit - Against Line of Credit  

Previously the field was not being calculated. 

User Defined Fields for PCI Header (17.30277) 

Added the PCI Header as an object for User-Defined Fields association: 

 

When the screen is opened, the user can select previously defined UDF’s for assignment to the PCI 
Header: 
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The PCI Header screen will display these UDF’s: 

 

Remaining To Be Billed Added to Vendor Prequalification Logs 
(17.34586) 

Added the field: ‘Remaining To Be Billed’ to the Applicants and Partners logs in Vendor 
Prequalification. 
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APPLICANTS 
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PARTNERS 

 
 

 
 

Last Review Cycle in Collaboration Submittals Log (17.34395) 

Added the ‘Last Review Cycle’ to the Collaborator Submittals Log: 
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Invitation to Bid - Delete Multiple Bidders (17.31708) 

Changes have been made to allow users to delete multiple lines in the Invitation to Bid – Bidders 
section all at once. 

BEFORE: 

Prior to the changes of this work order, in the Invitation to Bid (ITB) screen, the User could only 
delete individual lines in the Bidders section by clicking the ‘X’ beside it. 

 
 

AFTER: 

The changes of this work order have introduced a checkbox in the Bidders section of the ITB 
screen to allow deletion of multiple selected lines.   

Field security can be applied to this checkbox.  The default setting is ‘Unrestricted’. 
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When the field security is set at ‘Unrestricted’, the checkbox can be seen in EDIT mode: 

 

 

If multiple lines are selected for deletion, they are deleted on saving. 

 

If ALL lines are selected for deletion, a confirmation message will appear: 

 

 

[Cancel] will cancel the action. 

[OK] will select all the lines for deletion, and they will be deleted after clicking [Save]: 
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All lines deleted: 

 

OCO Number Added to OCO Log (16.26851) 

The Owner Change Number field has been added to the Log Builder and Log Filter for OCO. 

Active Checkbox Added to Contract Type Maintenance in Forms 
(16.25552) 

An 'Active' checkbox has been added to the Contract Type in PM FORMS to indicate whether the 
Contract Type is still in use (i.e. ‘Active’).  In the Subcontract Entry header, if the Contract Type is not 
active, it is not displayed in the LOV.  Existing subcontract records are not validated, so this only 
applies to new subcontracts. 

Deletion of Multiple Lines in SC, SCCO and Submittal Packages 
(16.22874) 

Changes have been made to Subcontracts, Subcontract Change Orders and Submittal Packages to 
allow deletion of multiple SOV/details lines at once using a ‘Select All’ checkbox. 
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Copying Inclusions/Exclusions in Subcontracts (16.18326) 

Modified the 'Copy From' functionality of Inclusion/Exclusions to append records when copying from 
multiple subcontracts. The system will add all inclusion/exclusions as additional lines when copying 
rather than overwriting by Sequence Number. 

Additional Email Notifications for Submittals (16.23544/16.24594/16.26604) 

Changes have been made to the Email Preferences of a Contact to include notifications for New, 
Modified, Notes and Attachments for SUBMITTALS, and to also include notifications for ‘CC’ and 
‘ALL’.  Previously, only notifications for modifications could be sent under the ‘TO’ column. 

Budget Status Query Logs – 2 New Fields Added (16.19314) 

Two new fields have been added to the Log Builder for Budget Status Query and Budget Status 
Query (Category): 

PMOJSQ_CALCULATED_REV_AMT (Calculated Revenue) and 

PMOJSQ_BILLED_COMMITTED_AMT (Billed/Committed) 
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PCI Details - Multi-select LOV for VENDOR or PHASE (16.15948) 

PCI Entry - enhancement made to Vendor LOV to allow multi-selection, OR to the Phase LOV to 
allow multi-selection, but not both in the same detail line, in order to speed up data entry. 

If one or more vendor is selected, then on clicking [Accept] in the LOV, one or more detail line will be 
created with each vendor selected.  The other fields can then be populated by the user. 

If one or more phase is selected, then on clicking [Accept] in the LOV, one or more detail line will be 
created with each phase selected.  The other fields can then be populated by the user. 

Examples are given below. 

For Vendor LOV:  
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For Phase LOV: 

 

 

 

Project Partner – Checkmark for Notes (16.27347) 

Project Partner Directory - Added a checkmark if partner has notes: 
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Mobile License Maintenance (16.23027) 

 

Added Mobile Licenses menu option under the Security tree-view node. 

Punch List – CC and Bcc Buttons Added (16.20428) 

 

Added the CC and Bcc buttons to the Punch List entry screen.  When the buttons are clicked they 
open up entry lines for adding contacts as cc’s and Bcc’s.  They are available in Add and Edit modes 
of the Punch List program. 

Field security can be applied to the Bcc button if desired. 
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Delete PM Project Role (17.36171) 

 

Added the ability to DELETE PROJECT ROLES once the user has access to the security privilege: 
“Project Role – Delete”. 

When the user has this privilege the ‘Action’ column in the project role screen will display the red ‘X’ 
to delete a role.  On clicking this ‘X’ beside a role, a confirmation popup box is displayed: 

 

[Cancel] will cancel the deletion and [OK] will un-assign the project role from all its association with 
objects in the system.  

Subcontract - Position Field in Contact LOV (17.35709) 

 

Subcontract Entry - Added a new column "Position" in the Contact LOV. 
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Not Automatically Posting OCO with Posted PCIs Linked to it 
(17.34026) 

The flag ‘Post OCOs when Posting Linked PCIs’ has been introduced. 

By default it is checked to maintain standard functionality whereby if a Posted PCI is linked to an 
unposted OCO, the entire OCO gets posted so long as every other PCI linked to the OCO has 
already been posted. 

When unchecked, the OCO will not be posted if a Posted PCI is linked to the unposted OCO, even 
though every other PCI linked to the OCO is already posted. 

 

Field security can be applied to this flag as well: 

 

 

User-defined URLs for Prequalification (17.30817) 

Two fields have been introduced in the Prequalification Control screen to allow the user more 
flexibility in setting the URLs that are generated in the password reset emails sent to Subcontractors 
and Applicants. 
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Alternate Rest Password URL pertains to Applicants  

Alternate Renew Application URL pertains to Subcontractors 

 

 

 

If these fields are null, the system determined urls will be used, otherwise the urls defined by the user 
will be used. 

Subcontract Header – Contact Email (17.31037) 

 

Added a new field named Contact Email in the header of subcontract page.  The value of it will be 
shown in the TO list when printing/sending (by email) this subcontract.  

Also added field security for contact email address in the subcontract header. 

Manual Self Billed Payment Response (17.37285) 

 

A new PM Role privilege has been added.  It is: “Allow for Manual Creation of A New Payment 
Response”.  

Background 

This enhancement is related to the Payment Response/Textura integration.   

Textura will provide the payment response record that will be imported into CMiC. 

The imported Textura record will be set to approved and this will make the record read-only. 

To facilitate manual entry of a new payment response for a project being managed through Textura 
the new privilege has been introduced. Only users with this privilege will be allowed to create a 
payment response for a project managed by Textura. 

By Default the privilege is unchecked (= N), that is, the user cannot do a manual entry. 
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Issues Reports (10.53363) 

 

 

CMiC has added a new Issues Report launch screen which is accessed from the PM JSP path: 
Reports > Communication Reports > Issues 

The reports are associated with Issue records belonging to the current project only. 

Screen prints of the LOVs are shown below: 

Report Type 

 

 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  485 

Issue Type 

 

 

Group By 

 

Sort By 

 

 

Checkboxes for Include Notes, Include History, Include Related Objects, Include Attachments and 
Include Internal Notes are only available for the detail reports (Issues Detail or Corrective Actions 
Detail). 

Bid Items Pop-up in Cost Status Queries and Contract Forecast 
(16.19617) 

Changes have been made to add a pop-up screen to the 'Cost Status Query by Category', 'Revenue 
Status Query by Category', and the 'Contract Forecasting' screens showing the bid items information. 
The data included in the pop-up is: Bid Item Name, Closed flag, WM, Estimate Quantity, Estimate 
Price, Estimate Amount, Revenue Quantity, Revenue Price, and Revenue Amount. The pop-up is 
accessible by clicking on the cost code (phase code) and Category. 

To set up the link in the Cost Status (Category) and Revenue Status (Category) queries, go to the 
Log Builder for each of these queries and do the following: for the Phase field, select ‘JC 
Transactions (Cost)’ in the Link column, and enter ‘Click to see bid items’ (for example) in the Link 
Description column: 
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When done, go to the queries to see the effect of the changes: 

 

 

 

 

In the case of the Contract Forecast, the changes are coded in the program directly, so when the user 
launches the program for a period, the Bid Items popup will be displayed after clicking the Phase of 
any line (the blue color indicates that there is an underlying link): 
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NOTE:  Additional changes were made so that drill down can be done on Category as well, to see 
the Bid Items.  In this case, the link would be, for example: 

 

 

E-Time Approver and E-Time Priority for Project Roles (17.31774) 

 

The E-Time Approver flag and E-Time Approver Priority (priority level for the E-Time Approver) 
have been added to the PM Project Roles screen.  This is to allow users with a particular Project Role 
to approve timesheets for their projects.  The E-Time Approver Priority is numeric. 

These PM settings only take effect if the ‘Project Manager’ flag is checked in the E-Time Access 
Code Detail screen.  That is, E-Time Approval authority is based on PM Project role settings. 
Otherwise, if the Project Manager flag in the E-Time Access Code Detail screen is unchecked, E-
Time Approval authority is based on previous E-Time Approval rights. 
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I/O Email- Unique ID After Subject (16.14098) 

Added checkbox "Unique ID After Subject" to "Miscellaneous" tab of the CMIC I/O Form. 

Subcontractor LEMS (Labor, Equipment, Materials, Subcontract) 
(15.04070) 

 

Added new program - Subcontractor LEMS (Labor, Equipment, Materials, Subcontract) Tracking 
sigma grid. 

Restrict Deletion of PCI Detail Lines (16.23601) 

 PM JSP/ADF:  
1. Added a new option to PM System Option - "Restrict Deletion of PCI Detail Lines". 
Unchecked by Default to preserve existing functionality. 

       2. Added a new privilege to PM Roles: Delete PCI Detail line when restricted. 

Search PM Notes (17.31620) 

Added [Search PM Notes] functionality to Meeting Minutes to allow user to search through Meeting 
Minutes Notes and locate items with a common search phrase.   

Field security can be applied to the [Search PM Notes] button. 
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SC Contract Mask for Contract Types (15.13370) 

Overview of changes made:  

 

1. Added Code to Contract Type screen. 

 
 

2. Added mask for Contract No. at the Project level (path: Project Maintenance > Defaults tab 
– [Masks] button).  The mask can include ‘t’ for Contract Type Code. 

 

 Also added ‘Allow Override’ and ‘Sequence Within Project’ checkboxes. 

 

 
 
 

3. In Subcontract Entry, the project level mask will be used to determine the Contract Number. 
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If the Contract Type is selected in the subcontract record, it will overwrite the default Contract Code, 
and include the contract type as part of the mask: 

 
 

NOTE:   If No Subcontract mask is set at the project level, then the auto-numbering setting 

from the SC Control file will take effect. 

PCI Entry – Allow/Not Allow Billing Amount (17.41246) 

  

PCI Entry – Checkbox in PCI Type, update of checkbox applicable only to External Class Type – to 
Allow/Not Allow Billing Amount. 
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Only Class Type ‘External’ is allowed to have the new flag checked/unchecked. 

The system validates for the other class types and will issue a message if the user tries to update the 
flag for Internal, OBC and Transfer types 

In PCI Entry, the PCI Type with this checkbox checked will default the Billing Amount, but on saving it 
will be changed to 0, and the field is also Read-only: 

 

 
 

On Saving: 
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Including Markups: 

 

 
 
 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  493 

 
 

 

Tax Codes in SC/SCCO Header (15.06063) 

 

Tax codes have been added to the SC/SCCO header. The User will be allowed to make this setup on 
base subcontracts only, however, these fields will be available as (Read Only) on change orders. 

Modifications were made to the Subcontract program to provide three fields (Tax1, Tax2, Tax3 similar 
as available on detail) on the SC Header, where the user will be able to enter tax codes when the 
checkbox [Default Tax] is checked. 

By Default, these fields are HIDDEN on the header by field security. 
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Bidders – Filter By Location (16.22688) 

 

Added Filter by Location to the Bidders popup in Bid Packages and Invitation to Bid.  Zip Code and 
Radius are added to filter by. 

RFQ Broadcast – Store Info in PCI History Tab (17.36832) 

RFQ Broadcast - Modifications to store RFQ Broadcast information on the PCI History tab. 

Activities – Warning Message when Updating Start Date (17.37332) 

 

Modified Activities JSP program so that on updating the Start Date, the system issues a warning 
message if there are Submittals linked to this Activity with options [OK] or [Cancel]. 

Warning message: 'There are some submittals linked with this activity code, all linked Submittals will 
be updated. Do you want to proceed?' 
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On pressing OK the program will update Submittal Start Date and recalculate all other dates for all 
submittals that use that Activity Code. 

Document Strip (17.44725) 

Added the document strip to all PM JSPs where there is an attachments tab. 

 
 

• Hover on a document opens up a popover with details and action buttons. 

• Clicking on a document icon would open and download the document. 

• Documents can be added by clicking on ‘New Document’ or on  
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Refresh Contract Forecast – PM Systems Options Flag (17.33189) 

 

Added functionality to refresh forecast if the PM Systems Options – Contract Forecast tab flag ‘Auto 
Refresh Forecast’ is set, and after pressing 'Go' in the forecast, if the Period is unchanged. 
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Path field in PM Systems Options (16.21156) 

 

PM Systems Options - Added [Path to "Draft" Image File] input field in General tab. 

Field Security for RFI Suggestion Cost/Amount Fields (17.38203) 

Provided field security for Cost Impact, Schedule Impact, Cost Amount and Days field (that appear 
right after suggestion field text area). Also modified existing prompts (on Prompt Maintenance screen) 
to differentiate field security for both sets (after Suggestion and Answer fields). 

User Maintenance – Segment Field (17.34607) 
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Added SEGMENT LOV to the User Maintenance screen. Freeform values entered in the field are 
used to update the LOV on saving.  There are icons to Edit/ Delete existing LOV entries.  It behaves 
in the same way as the ‘Via’ LOV in Transmittals.  

This field is created as an interface to an external program called WalkMe.  The entries made will 
allow WalkMe to understand who the user is and their role. 

Submittals - Enhancements (17.36127) 

Enhancements to Submittal Collaboration Process:  

a) Made Edit History available for external collaborators -User will be able to Add Reviewer and edit 
the Status on the submittal history screen. 

(b) this is controlled by a PM Role privilege:" Allow Collaborators to edit Submittal History". 

Submittal Activity Start Date Mandatory (17.39779) 

Submittal Activity Start Date can be set as mandatory. The setup flag is in PM Control (Defaults tab) 
and defaults to Project Maintenance (Defaults tab). 

RFI Entry – Update Required Date when Changing Create Date 
(17.41968) 

RFI Entry – made changes to update RFI's Required Date when changing Create Date based on 
Default RFI Review Period. 

Personal Name by Company (15.09662) 

Changes have been made to the CMiC I/O setup to allow Personal Name to be set by Company. 

This is done via the Companies tab of the ADF CMiC I/O Options screen as shown below. 

Only one record per company is allowed to be entered in the Companies tab. 

When an I/O is sent, the Personal Name for the Company will be taken from the entry set up in the 
Companies tab.  If there is no entry in the tab for the Company then the entry in the Personal Name 
field in the header will be used instead. 
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PM Systems Options Setting for Ball in Court (BIC) (17.41356) 

 

Added a new field to the PM Systems Options screen: Due Within(Days) with a default of 5 days (pre-
existing standard).  The value will be used to select the records for the Due within x Days section of 
the BIC report.  If no value is entered the report will be run with all the other sections displayed except 
this section. 

 

Submittal Changes for Collaborators (17.45726) 

The following changes have been made for Submittals: 

 
1. Changes to make the Submittal Edit History screen available for collaborators by using a Project Role 

privilege to control access: “Allow Collaborators to edit Submittal History” 
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The Collaborator will also need to be given security access to the PM History program: 

                                                                                                                                    

 
 

2. Added the [Complete Review] button to the Collaborator Submittal screen.  This new button is 

available for collaborators and will mark their “Action” completed and the current Responsibility will 

move on to the next reviewer in the list.    

When the collaborator selects the  [Complete Review] button it will auto populate the Action Date in 

the submittal history. Then the Current Responsibility will move to the next user in the submittal 

history.  

So, Additional Reviewer lines default the FROM Contact from the previous action to be the TO 

contact in the current action. 

The [Submit] and [Complete Review] buttons are only available to the Responsible collaborator user. 

 
3. Submittal Edit History screen has been modified to  

a. not allow collaborators to edit Due Dates of any row 
b. if a collaborator adds an additional reviewer they need to be able to set the Due Date, FROM 

and TO fields 
 

4. Submittal Log – added the Current Responsibility Partner and Contact 

 

 
 

5. Collaborator Submittal Log now includes 
a. current review cycle 
b. attachments (with drill down link) 
c. Responsibility Partner and Contact 
d. Sent Date, Sent Due Date 
e. removal of the hardcoded WHERE clause that only shows submittals where the user 

(viewing the log) is currently responsible.  
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Subcontractor Prequalification Control File Flag for Insurance 
Section (17.37428) 

 

Subcontractor Prequalification - Control file flag to display or do not display the Insurance Section. 

Answer RFI PM Role Privilege; Suggestion Notification Email 
(17.34341) 

 

PM Project Role privilege: Allow to answer an RFI is added to allow the user with the privilege 
checked to Answer an RFI. 

When this privilege is checked for the user’s PM role, the [Answer] button on the RFI screen will be 
available to answer the RFI: 
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2. Changes have been made so that an email notification message is sent if the RFI Suggestion field is 
modified and the contact’s Email Preferences is set up to receive alerts for RFI modifications 
(whether as TO, CC or ALL): 

 
 

To modify the RFI (for updating the Suggestion field), a collaborator will need to have the UpdateAll 
privilege on his PM Role.   
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The latter privilege will make the [Edit] button available on the RFI: 

 
 

Below is a sample of the RFI Suggestion email notification the contact would receive: 

 

 
 

Document Strip (17.44725) 

CORRECTION to V12-002 – Not all PM objects with Attachments tab are affected. 

Currently the document strip is only available in the following objects: 

Communications, RFIs, Issues, Submittals, Daily Journals, Field Work Directives and Notices. 
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PCI Entry has Quick Print Feature (18.50584) 

 

The PCI Entry screen now has the [Quick Print] button.  This allows the user to quickly print a preset 
report for the current record.   

JB Contract Date Considered for OCO Completion Date (17.45031) 

 

CMiC has modified Owner Change Order to consider the JB Contract Date if the JB Contract has 
been entered on the OCO header. 

A flag: [OCO Completion date by JB contract] has been added to the Project Maintenance - 
Defaults screen to be used in the determination of OCO Completion Date. 

By default, the new flag is HIDDEN with default value `N'. 

If the new flag is checked - OCO Completion Date will be calculated based on JB Contract Date 
instead of the Project Date in Project Maintenance. 
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Lite Editor – Header Buttons Configurable for PM Screens (17.36323) 

 

Changes have been made to allow the configuration of buttons in the Header Section of some PM 
JSP screens, by using the Lite Editor. 

The Lite Editor now consists of two sections: Header Buttons and Column/Field Security.  The latter 
section already existed in the Lite Editor screen. 

Each section can be expanded (use ‘+’) and collapsed (use ‘-‘)  in order to see the details of each.  
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These are some of the features: 

- Buttons can be ordered using drag and drop. 

- Button label is configurable. 

- Button hover text is configurable. 

- User can hide a button for himself. 

- Button can be configurated to show text only but not icon. 

Removed Add/Upload New Button from Attachments tab (17.44725) 

 

CMiC has removed the ['Add/Upload New] button from the Attachments tab of PM objects.  The 
reason behind this change is that the functionality is already provided through the [Upload Multiple] 
feature. 

PCI Notes Mandatory if Reason field is Populated (17.43868) 

This functionality is controlled by the PM Systems Option – General tab flag: “PCI Reason Note 
Required”. 

Modifications have been made to the PCI Entry screen such that if this PM Systems Option flag is 
checked then 

a) the REASON field becomes Read-only when creating a PCI 

b) if a user populates the REASON field in a PCI for the first time, the program validates if a note 
with the specific Subject: “Lessons Learned” exists.   

If not, the program requires that such a note to be added. 

o 2. The subject string can be changed via Prompt Maintenance, key = 
'pci.ReasonNoteSubject'. 

o 3. For ease of use, CMIC has provided a [Reason Note] button next to the Reason 
field every time the Reason is updated. 

On the button click, a new pop-up window opens to add/update the Reason Note. 

Note: Subject field is read-only and pre-populated with "Lessons Learned" (or 
whatever is set for pci.ReasonNoteSubject key) string.  

o 4. On Reason update, the program prompts the user to update the Reason Note 
without a hard stop. 

o 5. Every time a Reason is wiped out, the program will remove this note without 
warning. 
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Field security can be applied to the flag in the PM Systems Options screen: 

 

I/O with Project Short Name (17.43202) 

The following modifications were made in PM JSP for I/O: 

1. PM Systems Option - Added a new flag named ‘Show Project Short Name in I/O Email Subject 
Line’ in the General tab 

 

2. Project Maintenance - Added a new field named ‘Project Short Name’ in the header 

 

3. Field security can be applied to the flag: 

 

When sending I/O Email, the program will check if this field is populated. If yes, Project Short 
Name text will be added to the start of the Subject line. 
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Action Items for CCs on PM Objects (17.40163) 

 
Modified the mechanism of showing contacts on project calendar/action items for those who are not 
primary responsible contacts to include those who are CCd as well. 
 
This is achieved through a checkbox against each PM object in the PM JSP Company Control - 
Project Calendar tab. 
The changes apply to RFIs, Communications, Notices, Submittals, Transmittals and Issues. 
 
For example, when RFI is checked for both ‘ACT’ (action item) and ‘CC’ in the Project Calendar tab, 
an action item will be created for the RFI Responsible Contact as well as any CCs on the RFI.  The 
CC contacts will see the object (view access only) in their My Actions page and Project Calendar 
when they log into the system 
 
This does not affect the Ball in Court Report. 
 

PCI RFQ Status in PCI RFQ Tab (17.40032) 

The following enhancements have been made to the system in relation to PCI: 
a) addition of an RFQ Status Maintenance program 
b) addition of RFQ Status to the PCI RFQ tab 

 
 

a) RFQ Status Maintenance  
Created a new File Maintenance -> Local Tables -> RFQ status screen. This screen is used to 
maintain RFQ Statuses. 
 
To set the Security for the new screen use Role Maintenance > Security > Assign Programs: 

 
As well as Role Maintenance > Security > Assign Menu Items (File Maintenance > Local Tables) 
 
It will be displayed in the PM JSP tree-view once the security is in place. If you have a custom tree-
view you may need to modify it to include this new program. 
 

Use the RFQ Status Code Maintenance screen to add, edit or delete records.   
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The color is selected from a color palette when the mouse-pointer is clicked in the field: 

 
 
 

b) Using the RFQ Status in the PCI RFQ tab 

The RFQ Statuses are available in the PCI RFQ Status field once they are set up: 

 

 

Validations exist for the following statuses, if they are defined: 

RECEIVED - Received 
INREVIEW – In Review 
ACCEPTED - Accepted 
RETURNED - Returned 

 

i) If a Date Received is entered the status is automatically changed RECEIVED.  

ii) If status is RECEIVED, IN REVIEW or ACCEPTED, Date Received becomes mandatory. 
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iii) If status is changed to RETURNED, the Date Received and Quoted Amount are wiped out, but this 
is logged in the History tab 

RFQ Log (17.40032) 

 

Added a system RFQ Log with fields from the PCI header (PCI number, PCI Type, Date, 
PCI Status) and all columns from RFQ tab including the new RFQ Status. If RFQ is past 
due, the Due Date field turns red. 

Submittal Activity Start Date Mandatory (17.39779) 

Submittal Activity Start Date can be set as mandatory. The initial setting is made in the PM Company 
Control (Defaults tab): 

 

This setting will then default to the Project Maintenance (Defaults tab) of any newly created projects 
and can be overridden. 

Project Maintenance: 
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When the flag is checked for the current project, any submittals being created or existing ones that 
are edited will require that the Activity Start Date be entered (if it is null): 
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Responsibility for Agenda Item Note (17.37520) 

Enhancements have been made to Meeting Minutes to enable users to add Responsibility to agenda 
item notes. 

 

When the user clicks on the [Add Note] button in the Minutes popup window, it allows the user to add 
the Responsibility Partner and Contact to the note: 
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Field Security for Close RFI (17.34341) 

Modifications have been made to allow field security to be applied to the [Close RFI] button. 

Submittals Displayed Bolded if Note Added (17.28883) 

Submittals - Modifications have been applied to show submittals as bolded (on tree-view menu) when 
a new note is added. It is based on email notification setup from project contact directory screen. 

Removed Bid Items Link from Phase for Cost Status Query Etc. 
(16.19617) 

Contract Forecast and Cost Status Queries – a modification to the reference linking these 
queries and Contract Forecasting to Bid Items popup has been made to only link to the 
CATEGORY column for: 

1. Cost Status Query (Category) 

2. Budget Status Query (Category) 

3. Contract Forecasting 

To achieve this, the following change has been made in Log Builder for these programs. 

In the Log Builder: 

CMiC is now using the link option 'Bid Items' with the Category column: 
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For Cost Status Query (Category): 

 

 

To give: 

 

 

For Budget Status Query (Category): 
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To give: 

 

 

For the Contract Forecast there is no set up in the Log Builder, the link is directly in the 
program: 

 

Docusign (Esign) Maintenance screen (15.12875) 

CMiC has made changes that allow users to set default signers and CCs for DocuSign by project and 
PM object type. 

This screen provides a maintenance area to go so users can define signers up front on each project 
and not have to select the same person(s) each time they send a specific document type.  The 
screen is available from the Esign Maintenance tab in the Project Maintenance screen: 
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Field security can be applied to the Esign Maintenance tab if necessary. 

Modifications have been made to the Esign popup to retrieve default signers and CCs from the 
Project Maintenance tab first, then from the Key Players tab (existing functionality).  

NOTES:  

a) If there is no record is defined for a specific PM object, any documents sent from that PM object 
will use the default setup in the key players Esign order column. 

b) Regarding default message/advanced options: the system supports system-level default value 
settings for each PM object type.  If in the specified project there is no default message/advance 
options setup for a specific PM object type, the system will load the system-level default value 
settings and show them in the project maintenance screen for the project.  The values can be 
changed to be specific for a project per PM object.  

c) The subcontract functionality of defaulting the subcontract contact as the first signer will remain 
but will not be implemented for other PM objects. 

 

When the user enters the Esign Maintenance tab for the first time, a message box will be displayed 
asking if the user is ready to set up defaults.  This is for system-level defaults. 
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If the user responds with [Cancel] the system-level defaults for Message and Advanced Options can 
be set up later.  In edit mode of the current project, project-level Esign settings can be made for each 
PM Object Type that is selected. 

The [Default Value] button at the top of the screen allows the setting up of system-level defaults per 
object type that is selected in the header.   The following window will be displayed: 
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When this window is completed, the values will be displayed at the bottom of the screen: 

 

 

Use the [Edit] button (available in view mode) to edit the screen and add the Esign rules for the object 
type: 

 

 

When the user goes to the Attachments tab of the PM object that has been set up for ESign, the 
values will default there.  Click the [Esign Documents] button in the Attachments tab (of an Addendum 
record, in this example) to get: 
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System-level defaults will default to each project, but can be overwritten by editing the project and 
changing the values.  

PCI Entry – Changing Posted PCI to another Approved Status 
(18.50436) 

 

Changes have been made to the PCI Entry to make PCI header Status editable for a 
POSTED PCI, but have the Status drop down only lists those pending types with Approved 
value so that it can be updated from one status to another with Pending Type = 
APPROVED. 
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Issue Entry – COPY Issue is Enhanced (17.37987) 

 

The COPY issue function has been enhanced to allow the user to select additional data if 
desired.  This additional data includes Related Objects, Linked Objects, Linked PCI. 

Daily Journal – Sorting Labor Records (17.46476) 

Modifications have been made to Daily Journal to sort Labor records by Emp#, Employee 
Name and Phase.  The sorting is available in View mode only. 

When the user clicks the column header to sort by that column this sorting will be preserved 
in both View and Edit modes. 

Printing Jasper Reports with Embedded Attachments (18.51700) 

Modifications have been made to the Reports popup - Embedded attachments -  to allow for 
selection of one or more attachments to merge with a Jasper Report.   
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When the Server Type is ‘Jasper Server’ the Embed Attachments radio buttons can now be 
set at ‘Select’ or ‘Select All’.  Previously it was only set at ‘None’ and was read-only. 

PM Role Privilege – Disallow Creating Contacts For Company 
(16.21805, 18.51029) 

IMPORTANT NOTE: 

The enhancement previously programmed in issue 16.21805 has been modified so that the PM Role 
privilege "Add Contacts To Company", has been changed to “Disallow User From Creating 
Contacts For Company".   

 

 

When checked, this privilege prevents the user from creating new contacts for a Company (C-Type 
partner). The user can only add existing contacts for a Company by selecting them from the contact 
LOV. 

If the user tries to create new C-Type contacts with this privilege assigned to his PM Role, a 
message will be displayed, and the user will be required to select a contact from the Contact LOV 
instead.   

On selection of the contact code, it will back-fill the company/partner of the selected contact code (i.e. 
act as if the company code was not entered and left blank). 

Also added the following columns to the Contact LOV: 

Abbrev 

Company Code 

Company Name 

Type 

Subcontract/SCC) Add SOV screen – Amounts and Units (17.43196) 

Subcontract/SCCO - Modified the existing [Add SOV] feature for Posted Subcontract/SCCO 
functionality to allow for the entry of Amount and Unit. The user can already enter Rate. 
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Field security can be applied to the Amount and Unit fields on both the Subcontract and 
SCCO screens.  The default field security is ‘Read-only’: 

 

Enhancements to Subcontract/SCCO based on Contract Types 
(16.20746,16.21146,16.21941,16.21156, 17.44009) 

These changes include the requirements of the Work Orders: 16.21146, 16.20746, 16.21941, 
16.21156 and 17.44009. 

CMiC has introduced extensive modifications to the Subcontract and SCCO programs as they relate 
to a subcontract’s Contract Type. 

A new PM Systems Options flag ‘Default SC Settings for Contract Type’ has been introduced to 
control the use of this feature in the Subcontract and Subcontract Change Order programs. 

Also in the PM Systems Options screen, a System File Path field has been created to support the 
archiving of subcontract documents in a defined location after subcontract posting. 

In addition, a Contract Type Maintenance screen has been added so that users can associate a 
given Contract Type with default settings for: 

✓ Retainage % 

✓ Pay When Paid (PwP) and Days 

✓ Not Allowing subcontract posting if Contract exceeds Budget 

✓ Not Allowing RFP Posting when RFP exceeds Contract Amount 

✓ Sender Email for subcontract documents  

✓ Subcontract Documents and related attachments for printing and archiving 

✓ Text Codes 

✓ Compliance Codes 

✓ Category Codes. 

The program is located in the File Maintenance section of the PM JSP tree-view.   

An outline of the Contract Types feature and the required setup is given below.  
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PM Systems Options 

 

When the PM Systems Options flag ‘Default SC Settings for Contract Type’ is checked, the new 
association feature will take effect according to the Contract Type Maintenance.  In addition, the 
Contract Type field becomes mandatory in any subcontract that is created or edited.    

The field: System Utility Files Path is used for defining the path that the Archived document will be 
located. 

Security Setup 

To assign security to this new program, use both the Assign Programs and Assign Menu Items 
options in the Security section: 

Assign Programs 

 

 

Assign Menu Items 

Under ‘File Maintenance’: 

 

 

After security is set up for the user, the program will be displayed in the tree-view.  If a custom tree-
view exists for the user, make sure to use Menu Maintenance to make the adjustments to the custom 
tree-view. 
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Contract Type Maintenance - COMPANY LEVEL SETUP 

 

When the new program is launched, the screen allows Contract Types to be set up by Company. 

Enter the Contract Type Code and Description. 

For each Contract Type, a default value can be set for Retainage %, PwP, Days, Contract Exceeds 
Budget flag, Alternate Account, Do Not Allow To Post RFP When Exceeds Contract Amount, and 
Sender Email, Active and Bonded flags. The buttons are detailed below. 
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Contract Exceeds Budget Flag 

The Contract Exceeds Budget flag (company and project level) can only be checked if the 
corresponding flag in the Subcontract Control is also checked.   

 

Subcontract posting under this new feature will not occur if the Contract Amount will exceed the 
Budget, while the PM Systems Option flag ‘Default SC settings from Contract Type’ and the ‘Contract 
Exceeds Budget’ flag on the project are checked. 

Subcontract posting under this new feature will still occur if the Contract Amount will exceed the 
Budget, while the PM Systems Option flag ‘Default SC settings from Contract Type’ is checked and 
the ‘Contract Exceeds Budget’ flag on the project is unchecked, even though the SC Control flag is 
checked (and the override privilege is unchecked).   

In other words, subcontract posting is totally controlled by the settings for this Contract Types feature 
once it’s activated. 

The system considers The SC Control setting for subcontract posting only when PM system option flag ‘Default 
SC settings from Contract Type’ is unchecked. 

 

Do Not Allow To Post RFP When Exceeds Contract Amount 

This column has the following options: 

✓ Not Applicable – no validation takes place regarding the RFP Amount and the Contract 
Amount 

✓ SOV Line Is Greater Than Associated Contract SOV – validated to see if any individual 
SOV line in the RFP has a Current Amount plus any Previously Certified Amount that is 
greater than the corresponding Contract Amount for that SOV 

✓ Overall Request Payment Is Greater Than Contract Amount – validated to see if the 
overall payment request amount is greater than the Contract Amount 

If any of the latter two is an option for the Contract Type of a subcontract, the related RFP is not 
posted.  There will be a warning when the RFP is initially saved, that the Contract Amount is 
exceeded, and then on posting, the following message will be displayed: 

for setting - SOV Line Is Greater Than Associated Contract SOV: 
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  and 

for setting - Overall Request Payment Is Greater Than Contract Amount: 

 

 

NOTE: The setting for RFP Posting made at the company/project level in PM JSP does not update 
the similar field which is in the SC Control (RFP Defaults). 

Sender Email 

When the Contract Type is selected in the SC header, the associated Sender Email address is 
populated.  The value is taken from the project level defaults.  It can be overridden by the user. 

Field security can be applied to the field on Contract Type Maintenance and Subcontract.  The 
standard default value is HIDDEN. 

Documents 

To set the default Documents and Attachments for a selected contract type, click the [Documents] 
button.  Subcontract Form Letters will be shown in the popup window: 
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Any report and attachments selected at the Company level for the contract type will be shown as 
checked at the Project level.  Additional reports can be checked/unchecked at the project level. 

The [Report Order] button will display a window with the reports and any attachments and allow the 
user to change the order in which they should be printed. 

 

 

The [Attachments] (Exhibits) button will display a window to allow adding and editing of attachments: 
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Text Codes 

To set the default Text Codes for a selected contract type, click the [Text Codes] button and make 
your selection.   

 

 

Any codes selected at the Company level for the contract type will be shown as checked at the 
Project level.  Additional codes can be checked/unchecked at the project level.   

Click [Accept] to save your selection. 

 

Compliance Codes 

Compliance Codes will be shown in the popup window when the user selects a Contract Type by 
clicking on it, and then clicking the [Compliance Codes] button. 
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Any codes selected at the Company level for the contract type will be shown as checked at the 
Project level.  Additional codes can be checked/unchecked at the project level.   

Click [Accept] to save your selection. 

 

Category Codes 

To assign one or more default Categories to a Contract Type, first highlight the record then click the 
[Category Codes] button: 

 

Select the Category Codes from the list of values and save the changes. 

 

NOTE: Company level settings will default to new and existing projects (as long as the project-level 
setup was not yet edited). 
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Contract Type Maintenance - PROJECT LEVEL SETUP 

The [Contract Types] button is available from the General tab as well as the Defaults tab of the 
Project Maintenance screen. 

 

 

Project level Contract Types setup has the Project Name in the screen.  The company level Contract 
Types default settings are inherited, but changes can be made here. 

Note that Category changes are not made at the project level. 

The initial values shown are from the Company setup, but changes can be made and saved for the 
project level.   

Click on a Contract Type to highlight a record.   

Select or make changes to Retainage %, PwP, Days, Contract Exceeds Budget, Do Not Allow To 
Post RFP When Exceeds Contract Amount, Sender Email. 

Click the [Documents] button.  It will display the list of Documents and Attachments (defaulted from 
the company) for this contract type, and this can be changed as well by selecting different codes than 
those that were defaulted. 

Reports, attachments and their print order that were set at the company level will be defaulted to the 
project, but can be overridden by the user. 

Select the desired Documents and Attachments and click [Accept].  This action will save the codes 
selected. 

Click the [Text Codes] button.  It will display the list of Text Codes  (defaulted from the company) for 
this contract type, and this can be changed as well by selecting different codes than those that were 
defaulted. 

Select the desired text codes and click [Accept].  This action will save the codes selected. 

Click the [Compliance Codes] button.  It will display the list of Compliances  (defaulted from the 
company) for this contract type, and this can be changed as well by selecting different codes than 
those that were defaulted. 

Select the desired compliance codes and click [Accept].  This action will save the codes selected. 
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Any changes made in the Contract Type window must be saved using [Save] before closing the 
window. 

 

NOTE: Once changes are made at the project level for a given contract type, changes made later at 
the company level will not take effect on the project for that contract type.  This is true for all the 
default settings. 

 

Process and Validation 

Subcontract and Subcontract Change Order 

Once the setup is made at the Project level, the defaults will flow through to any new subcontracts. 

Changes to Contract Types at the project level will also take effect if the contract type in the 
subcontract is changed.  When the contract type is changed, any documents, text codes and 
compliances which were pulled in by the previous contract type will be removed, including any that 
were added directly in these subcontract screens (i.e. Compliance screen, Text Codes tab, 
Attachments tab), along with updating of the Retainage, PwP, Days and Sender Email.  All values will 
be replaced with the values from the selected contract type. 

These defaults can be overridden in the subcontract. 

Job level compliances will default along with any project level compliance code defaults for the 
contract type used in the subcontract. 

The contract amount will be validated against the budget on posting of the subcontract, based on the 
project level contract type setting for the flag. 

The posting process will automatically print the reports and attachments (which were set for the 
contract type at the project level) and create an archived copy in the Attachments tab of the 
subcontract.   

At the end of the archive process, the user will get a popup window with a chance to send print the 
report to Email.  The email will be sent to the Contact on the subcontract, and the Sender will be the 
address in the Sender Email field.  

Screen prints are shown further below. 

 

Phase and Category Validation in the Subcontract/SCCO SOV 

When a subcontract (or SC change order) is created or edited, Phases shown are based on phases 
that have the categories selected for the subcontract Contract Type.   

The categories shown will only be those selected for the Contract Type. If no Categories are selected 
for the Contract Type then all Phases and Categories are listed. 

 

Contract Exceeds Budget Validation in Subcontract/SCCO 

When this flag is checked on the project, any subontracts/change orders created will be validated to 
ensure that the Contract Amount does not exceed the Budget Amount.  The validation is against the 
total subcontract or subcontract plus change orders or total change orders (if subcontract is 0, which 
is unlikely). 

 



532  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

Archiving Subcontract Reports after Posting 

Feature Notes 

✓ takes effect when PM Systems Option flag ‘Default SC settings from Contract Type’ is 
checked 

✓ archived file path is set in PM Systems Option field ‘System Utility Files Path’ 

✓ posting of the subcontract is not allowed if the subcontract Contact is not specified  

✓ posting of the subcontract is not allowed if the Sender Email is not specified  

✓ without SC Contact the Archived report cannot be sent 

✓ field security is available for [Email Archived Report] button for subcontract 

✓ button label changes from [Print] (for an unposted SC) to [Email Archived Report] (for a 
posted SC) 

✓ when the default reports are printed for an unposted SC, the word ‘DRAFT’ is watermarked 
on the pages 

✓ the default documents do not show in the Attachments tab of the subcontract when the PM 
Systems Options flag ‘Default SC settings from Contract Type’ is checked 

 

PM Systems Options 

File path for storing archived documents: 

 
 

Field security: 
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Attachment (Exhibit) types allowed: BMP, IMG, JPG, JPEG, PNG, TIF, TIFF, PDF: 
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Sample Report page for unposted subcontract after printing: 

 

 

If Sender Email is not entered: 
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If Contact is not entered: 

 

 

When the contact is entered, posting can proceed: 

 

 

After Proceeding with the posting, the subcontract becomes posted, and the [Print] button changes to 
[Email Archived Report].  At the same time, the archiving process occurs, after which the system 
prompts the user to print the report to Email: 
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Email is currently the only option. 

 

On clicking ‘Email’, an email is sent to the Contact (valid email address is expected): 
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In addition, an archived report is created in the location defined in the PM Systems Options field 
‘System Utility Files Path’ and the archived file is available in the Attachments tab of the Subcontract: 

 

 

 

 

 

If no archived report is produced (possibly due to missing setup) and you try to email it using [Email 
Archived Report], you will get the message “Error while sending report.  Archived report not 
found.’ 

(17.44009-2,16.20746-33) 

 The 2 privileges below with red border lines are only used when the PM System Options flag for the 
 Contract Types feature is in use: Default SC settings from Contract Type. 
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Daily Journal – Submitted By added to Header (17.43782) 

 

Modifications have been made to add a Submitted By (username) to the Daily Journal header.  This 
field displays the user that submitted the record.  Field security can be applied to the field.  The 
default value is set as ‘Hidden’ on the *ALL* role in Security > Role Maintenance. 

 

Issues – Field Security to display/hide Text Codes tab (18.56886) 

 

Modifications have been made to display/hide the Text Codes Tab in a record within the Issue’s 
screen. Field security can be applied to this field. The default value is set as ‘Unrestricted” on the 
*ALL* role in Security > Role Maintenance. 

 
 

PRINT Not Available when WORKFLOW Active (18.54221) 

Modifications have been applied to ensure the [Print] button is disabled once the workflow is active.  
This is applicable to Subcontracts, Subcontract Change Orders, PCIs, Owner Change Orders. 
 
The Workflow Lookup “Prevent Printing in Workflow” needs to be activated for this functionality.  It 
must also have the value ‘Y’ in the Value 1 field: 
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Example below:  After setup and sending a PCI to Workflow, the [PRINT] button is disabled: 
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Bid Package – Select Bid Items – Job & Phase added (18.57782) 

 

Added the Job Code and Phase/Cost Code columns to [Select Bid Items] multi-select LOV in Bid 
Package (Buy Out tab).  

Field Security can be applied to these two fields in Bid package.  By default, they are set as 
‘HIDDEN” on the *ALL* role. 

PCI Log – Created/Entered By (17.47373) 

 

Added a column for Created by/Entered by in the PCI Log. 
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Submittal Log – Closed Date (18.51632) 

 
 
Added a column for Closed Date in the Submittal Log. 
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Compliance Status Log – Changes (18.53444) 

A) Modified the Compliance logic to redefine the Compliant column and added new two columns: 
Date Compliant and Fully Compliant to the Compliance Status Log. The value of these 3 columns 
are calculated by the following rules: 
 
Column 1: Header: Compliant  
If Compliant Checkbox from Vendor Compliance is checked and Date Complaint is unchecked = 
Y 
If Compliant Checkbox from Vendor Compliance is unchecked and Date Complaint is checked = 
Y 
If Compliant Checkbox from Vendor Compliance is unchecked and Date Complaint is 
unchecked = N 
If Compliant Checkbox from Vendor Compliance is checked and Date Complaint is checked = Y 
 
Column 2: (To the right of the Compliant Column on the side of the scrollbar) Header: Date 
Compliant 
If Compliant Checkbox from Vendor Compliance is checked and Date Complaint is unchecked = 
N 
If Compliant Checkbox from Vendor Compliance is unchecked and Date Complaint is checked = 
Y 
If Compliant Checkbox from Vendor Compliance is unchecked and Date Complaint is 
unchecked = N 
If Compliant Checkbox from Vendor Compliance is checked and Date Complaint is checked = Y 
 
Column 3: (To the right of the Date Compliant Column on the side of the scrollbar) Header: Fully 
Compliant  
If Compliant Checkbox from Vendor Compliance is checked and Date Complaint is unchecked = 
N 
If Compliant Checkbox from Vendor Compliance is unchecked and Date Complaint is checked = 
N 
If Compliant Checkbox from Vendor Compliance is unchecked and Date Complaint is 
unchecked = N 
If Compliant Checkbox from Vendor Compliance is checked and Date Complaint is checked = Y 
 

B)  
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Added three more columns to the Compliance Status Log: 
- Level 
- Contract No. 
- Contract Name 

 

 
 

Subcontract Change Order – Field Security for SOV Amount 
(18.55609) 

Subcontract Change Orders - Added new field security parameter to the SOV Amount field in 
subcontract change orders.  Field security can now be applied to this field and can be set as 
‘Unrestricted’ or ‘Read-only’ or ‘Hidden’. 

Multiple Document Upload – Field Security for Document ID (17.42017) 

Field security has been programmed for the Document Number during Multiple Upload.  The default 
value is set to “Read-only” on the *ALL* security role, to preserve the previous standard functionality. 

 

When set to Unrestricted, and the ‘Allow Override’ flag is set on the Document Type auto-numbering 
mask, the user can enter the Document ID during Multiple Upload.   
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The program validates and ensures the Document IDs entered are unique: 

 

 

Prequal Limits validated in Bid Packages and Buy Out Analysis 
(18.50229) 

Enhancements have been made to the “Purchase” action in both the Bid Packages and Analyze Bids 
(Buyouts) programs to incorporate validation of Subcontractor Prequalification limits. 
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Subcontract Entry – WM field in Special Pricing tab (18.58259) 

 

Modifications have been to show the WM field in the Special Pricing tab and control it with field 
security.  The Possible field security settings are Unrestricted, Read-only or Hidden. 

 

 

Budget Status Query – Profit column (18.57400) 

 

The PROFIT column has been added to the Budget Status Query. 

This field is calculated as the difference between the 'Current Revenue Budget' and the 
'Calculated Projection' columns. 
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Uploading Stamp Annotations (18.53332) 

 

CMiC has added a table and related UI (PM JSP page) for Uploading Stamp Annotations to PSPDF. 

The table will store the records when the data is entered via the JSP UI that will allow users to upload 
PDF, JPEG and PNG files to be used as stamps within PSPDF.  PSPDF is a PDF viewer CMiC uses 
in CMiC Field. 

The program is found in the File Maintenance node of the PM JSP tree-view. 

File Types to be uploaded can be System or Project level. 

[Upload New Document] which is available in Add mode, will open up the Add Document screen to 
allow selection of the Document Type and the document to be uploaded. 

The History link will display the Document Revisions screen: 

 

RFI Entry – Enhancements (18.54300) 

NOTE: These enhancements are only available through a PM System Options flag which is currently 
activated at the database level. 

Highlights 

• The RFI Entry screen has been enhanced to display the data as ‘field sets’ whereby all 
related data fields are kept together as a set of fields as shown below: 
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• A Reviewers section has been added to facilitate the process flow of information from 
additional contacts pertinent to the current RFI process stream. 

When a project contact is added to the Reviewers table, an action item is created for that RFI 
and assigned to the project contact. The creation of action items is dependent on the Project 
Systems Options flag for creating Action Items for RFIs being set, as well as the process 
stream must follow the in Sequence and Required flags outlined in the reviewer table. For 
example:  

 

Reviewer Required Sequence Due Date Action Date 

SB Y Y May 1st  

TY Y Y May 5th  

CA Y  May 1st  

BT Y    

ZH     

 

There are 2 in-sequence reviewers (SB and TY) 

An action item will be created for the RFI and assigned to SB with a due date of May 1st.  

No action item is created for TY until SB has completed review. 

When an action date is populated on SB’s row – the action item for TY will be created with a 
due date of May 5th 

CA is a required reviewer with a due date – but not in sequence.  This means an action item 
can be created for CA right away with a due date of May 1st 

BT is a required reviewer with no due date.  An action item will be created for this RFI and 
assigned to BT but with no due date. 
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ZH is not required so no action item is created for this reviewer. 

• The Notes section has been enhanced to provide a conversation-type area where contacts 
can reply to someone’s note and even add a relevant document attachment  

• Security privileges and project role privileges have been introduced to control which 
users will have access to Add Reviewers, make Notes Public or Maintain Reviewer 
Templates. 

PCI Entry – Projected Amount Calc. Method Added (18.58215) 

CMiC has added  the 'Projected Amount Calc. Method' to the PCI Entry screen. This field was 
missing from the screen, even though it was present in ADF and FORMS.  When the 'Update 
Projected Amount ‘ flag' is checked, it allows the user to select a method from the drop-down box: 
Add Change Budget Amount (A) or Recalculate Projected Amount (R).   

Field security for 'Update Projected Amount During Posting’ can be applied if desired. 

ITB Broadcast of Multiple Bid Packages (18.51000) 

CMiC has created a new JSP program which lists all the Bid Packages available for the current 
project with the ability to select/deselect all bidders and bid packages or individually, for ITB 
broadcasting.  

The only editable field on the screen is the ‘Select’ checkbox. Contacts without an e-mail address will 
not be included in the list.  

On clicking the [Send ITB] button, the program will let the user select the message template before 
sending the broadcast. 

A Broadcast History pop-up screen similar to that within Bid Packages has also been provided.  

 

Overview: 

The aim of this enhancement is to have a separate program where multiple Bid Packages and 
bidders from the current project can be selected for ITB Broadcast at once, rather than having to go 
into each bid package individually and then broadcast the ITB. 

 

The changes for this enhancement include the following: 

SETUP 

Assign the new program “Bid Packages ITB Broadcast” to the Project Management security role of 
the user(s): 

 Security > Assign Programs 



550  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

                

 

 Security > Assign Menu Items 

 

               
 

Make sure to adjust any custom PM JSP tree-view that needs to show this new program, using 
the Menu Maintenance screen. 

 

Once the program is assigned to the user it will display as shown below: 
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Program Highlights: 

• All Bid Packages with bidders for the current project are listed.  

• [Broadcast History], [Broadcast ITB], [Send to Spreadsheet] buttons are available. 

• Collapse (-)/Expand (+) icons are introduced to have a cleaner view when there is a large 
number of bidders.  

• Bidders are grouped by Bid Package, and the checkbox beside the bidder’s name is 
greyed out when the contact’s email is not available.  Any bidder without an email 
address cannot be selected for broadcast. 

• Bid Package hyperlink is available to allow drill-down (to get Bid Package details) 

• Accept and Decline checkboxes are display-only (values will be shown after bidders 
respond): 

• An [Attachments] button is located to the right side of a row and when clicked, displays a 
popup window with all available attachments. The attachment selection for each bid 
package should be done before launching ITB broadcast. 

• ITB Broadcast user experience is improved by introducing a spin wheel to indicate that 
the broadcast is in progress 

• Broadcast History is shown in the history popup 

Syncing SC/SCCO Amount with PCI Estimated/Quoted/Final 
Amount (18.49521) 

The following changes have been made to allow synchronization of the Subcontract/Subcontract 
Change Order SOV Amount with the PCI Estimated/Quoted/Final Amount when a PCI Detail line 
(TBD) is linked to a subcontract/subcontract change order SOV line. 
 
a) Introduction of the Company Control – Change Management drop-down to select which PCI 

Amount is to be used, whether Estimated, Quoted or Final Amount: 
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This drop-down display is controlled by field security in the Project Control program, and the field 
name is “Sync chosen PCI final, quoted or estimated amount with SCO SOV”.  The default 
value is set as HIDDEN.  Other possible values are UNRESTRICTED or READ-ONLY. 
 
For Example, if the value is set to Quoted and there is a TBD PCI with the values shown below: 

 
 
When pulling this PCI detail into a subcontract or subcontract change order, it is the Quoted 
Amount which will be used to update the SOV Amount: 
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(Subcontract) 
 

 
(Subcontract Change Order) 
 
NOTE: Issue 16.14940 deals with the display of the Quoted Amount in the SCCO screen and 
currently the field security is set to ‘not visible’.  The field security for this field will need to be set 
to visible in order to use the value of the Quoted Amount field. 
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SC/SCCO – Bid Items LOV has Job/Phase/Category (18.59765) 

 

The Bid Items LOV in subcontracts and subcontract change orders has been modified to include Job, 
Phase, Category. 

Budget Status Query – Profit Column added (18.57400) 

 

Budget Status Query - Added 'Profit' column to the query screen, and calculated as: 

Profit = [Current Revenue Budget] - [Calculated Projection]. 

The same column is available for the Cost Status Query as well. 

Enhanced ITB Broadcast Message Templates (18.49545) 

The ITB Broadcast Message Templates screen has been enhanced to allow the user to define 
separate templates for: 

 Invitation to Bid 

 Bid Package 

 Addendum  

 Request for Quotation (PCI). 
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Budget Status Query – Posted Billed to DateTitle (18.51105) 

CMiC has added a new field "Posted Billed To Date" to "Budget Status Query" and "Budget Status 
Query (Category)" in JSP. The new field "Posted Billed To Date" will include only posted invoices to 
date and will be the billed amount by Phase or by Phase Category depending on which query is 
executed. 

PCI Markup Rules Based on PCI Type (18.59093) 

Added functionality to facilitate the definition of PCI Markup Rules based on PCI Type. 

Contract Forecast – Spent/Committed Total Drilldown (18.59370) 

Contract Forecast - disabled drilldown on the Spent/Committed Total column in case of field security 
is read-only. 

BI Role Code Link to JSP and Forms (18.59694) 

Security Role Maintenance - Added a new LOV field for BI Role Code to link JSP roles and Forms 
Roles.; Added a new LOV action for Forms Roles. 

PCI Entry – Summary by Subjob (18.59750) 

PCI Entry - Added an allocation subtotal summary by sub-job within PCI summary screen. 

Printing Reports – Include After Report (18.61390) 

Added back the option during print multiple for "include after report", which is the new process or the 
original where attachments are embedded inside the report and modified to fit the report page layout. 

Drawing Management - PSPDF Viewer Updates (18.65721) 

The following modifications have been made: 
1) Upgraded PSPDF from 2018.4.2 to 2018.5.1. 
2) Used icons for buttons Create Revision and Toggle Attachments in CMiC/PSPDF Web 
Viewer. 
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Drawing Management – Annotations as Related Objects for Punch 
List Items (18.55428) 

CMiC has added support for Related Objects to be associated with Punch List Items via annotations 
from Drawing Management (currently for Mobile). 

Submittals 2.0 Enhancements (18.60353) 

A number of enhancements have been made to the Submittals program as part of the on-going 2.0 
development: 

a) updated user-interface (using HTML5) 

b) introduction of Reviewers that can be added directly, added from a Distribution List or added from 
a Reviewer Template, similar to the enhanced RFI 2.0 

c) integration with Action Items creation, for current Reviewer – viewed in My Actions page 

d) Submittal Approver default for TO field 

e) addition of Received Date, Submitted Date and Responded Date for the Submittal 

f) mandatory Required Finish Date 

g) update of document history on updating document 

h) Complete Review functionality with update of Action Date 

i) added document security and PM Role privilege to Hide Reviewer Section 

j) addition of Submittal Note Statuses 

k) ability to collapse/expand replies (Notes) 

l) denoting Notes as Public/Private and applying associated PM role privilege to make them 
Public/Private 

m) added field security for Submittal Notes tab. 

PCI Code added to Units Complete with Field Security (18.51734) 

The PCI Code has been added to the PM Daily Journal/Units Complete and PM Units Complete 
programs.  Field security can be applied to this field if desired. By default the field is Read-only on the 
*ALL* security role for both the Daily Journal and Units Complete programs.  



Working Document R12 New Functionality R12 New Functionality (Draft)  •  557 

 

 
 
The PCI Code value will come over from the ADF input: 
 

 

Field Security for RFI History tab (18.56963) 

Field security can now be applied to the RFI History tab.  Possible setting is Unrestricted or Hidden. 

User Password Rules (18.53381) 

First introduced in V12-004 for User Maintenance, the password rules have been added to the User 
Profile program as well.  The wording of the text is set up in the ADF Systems Options screen as 
shown below: 
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User Maintenance: 

 
 

User Profile: 
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Contract Forecast – PCI Code added (18.48189) 

CMiC has added the PCI code column in the Contract Forecast with PCI Projections grid.  The PCI 
code column shows the associated PCI code for the record.  If there are multiple PCIs for one record, 
the word “MULTIPLE’ is displayed in the cell.  If there is no PCI for this record, “NONE” is displayed: 

 

The tooltip for any PCI displayed will be the header Description of the PCI. 

Field Security – Submittal Notes tab (18.60353) 

 

CMiC has added field security for the Submittal Notes tab.  Possible setting is Unrestricted or Hidden. 

 

Added "Posted Billed To Date" column in the Budget Status Query 
in JSP (18.51105) 

Add a new column named “Posted Billed to Date” into the log queries: 
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• Cost status query 

• Budget status query 

• Cost status query (Category) 

• Budget status query (Category) 
The new field "Posted Billed To Date" will include only posted invoices to date and will be the billed 
amount by Phase or by Phase Category depending on which query is executed. 
 

Fig1. Posted invoices to date shown in JB transaction log:  

 
 

Fig.2 “Posted Billed to Date” column added into Cost Status Query. 

  

 

Fig3. “Posted Billed to Date” column added into Budget Status Query. 

 
 

Fig4. “Posted Billed to Date” column added into Cost Status Query (Category). 
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Fig5. “Posted Billed to Date” column added into Budget Status Query (Category). 

 

Autodesk (BIM) Changes (18.68873) 

1. From now on the "BIM Project Mapping" section will remain hidden permanently;  

2. CMiC has moved the BIM Integration menu item to the Communication Management node of the 
tree-view. 

RFP – Print Waiver and Print Certificate of Payment buttons (18.48577) 

 

Request For Payment - Added 2 new buttons: Print Waiver and Certificate of Payment Report.  By 
default, these buttons are set to HIDDEN on the *ALL* security role. 

When the field security is set to UNRESTRICTED, the buttons can be seen on the RFP screen: 
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JSP 2.0 Enhancements  
 On-going development:  

 
The screens below are undergoing user interface enhancements aimed at improving the user 
experience and visual appeal of the application. 
 
a) Issues – 18.59802 
 
b) Communications – 18.62719  
 
c) RFI Entry – 18.54300 

• Implemented field security for Potential Contract Change field.  This field is linked to the 
Disclaimer which changes value whenever the value in the Potential Contract Change 
field changes. 

• The Disclaimer’s text can be changed using Prompt Maintenance 

• Implemented gray-out/disable the fields in view mode  
 
d) Submittals - 18.60353 
 
e) Subcontract Entry – 18.62906  
 
f) Subcontract Change Order – 19.70315 
 
g) PCI Entry – 18.67900  
 
 

IMPORTANT NOTE: By default, the screens are set to the old (classic mode – classic mode flag is 
set to Y).  A version script is programmed with each work order and sets the classic mode flag to N so 
the new look & feel of  HTML5 will be displayed. This script is not included in any patch and should be 
run explicitly when needed. 

Daily Journal – Next and Previous buttons (18.64139) 

 

CMiC has added [Previous] and [Next] buttons to navigate daily journals.  These buttons allow the 
user to navigate from one journal to another (back and forth) without going back to the log. 
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Users can apply field security for the [Previous] and [Next] buttons in Daily Journal header if needed. 
By default, the field security of these buttons is set as HIDDEN on the *ALL* security role. 

Field Security for Copy Previous Daily Journal button (19.70304) 

 

Added field security to show/hide [Copy Previous Journal] button. 

Contract Forecast Status Assignment by User and Status Change 
History (17.46558) 

Enhanced the Contract Forecast screen to provide setup for Forecast Status by user as well as to 
maintain a history of forecast changes by status. An email notification will be sent to users whose 
Project Role is set to receive the alert. 

Here are the changes that are related to these enhancements: 

Project Role privilege: 

Addition of the “Notify on Forecast Status Change” project role privilege.  The user with the privilege 
will be notified via email whenever a forecast status change has occurred.  The email will include the 
Contract code and 

the status to which the forecast has been changed. 
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sample email: 

 

Field Security 

 
 

[Assign Status] button: 

This button allows the current user to assign one or more statuses to a selected user, from the 
Available list of statuses: 
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[Status History] button: 

This button will display the history of Status updates that have occurred for the selected Contract. 

a) Change the Status by selecting from this drop-down list.  The forecast is automatically 
updated with the selected status. 

b) The Status History will display the change: 

 
 

c) The user will receive an email notification if the user’s project role is set with the privilege: 
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Also, Added PM Role privilege 'Allow To Open Current Forecast' to change Forecast Status from 
Closed, if needed: 

 

Check Spelling Button removed (18.66834) 

The Check Spelling button and underlying functionality has been removed from some screens in PM 
JSP.  So far, the button has been removed from: 

Transmittals, Submittal Packages, Communications, Documents, Subcontracts, Issues. 

PCI Markup Rules by PCI Type (18.59093) 

Changes have been programmed to allow the creation of PCI Markup Rules by PCI Type (External, 
Internal, Transfer etc.) 

Highlights 

• PCI Type field is added to the PCI Markup Rules screen 

• PCI Type field is initially hidden by field security which is set as HIDDEN on the *ALL* role 

• When the PCI Type field is HIDDEN, the functionality behaves as it did prior to these 
changes, and all markup rules are displayed 

• Existing PCI Markups, prior to this change, are listed under PCI Type = null in the header, 
along with any new PCI markups created with the PCI Type specified under ‘Rules’. 

• To create PCI Markups which apply to PCIs regardless of Type, select the null value in the 
Type drop-down before creating new rules. 

• To create PCI markups for a given PCI Type, first select the PCI Type from the drop-down in 
the header, then click the [New] button in the lower section. 
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Field Security: 

 

 

When the field security for PCI Type is set as UNRESTRICTED: 
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Create Markup Rule for specific PCI Type: 

 

PCI Markup Rules - Total Markup (17.39285) 

CMiC has added a new type of PCI Markup named Total Markup which will calculate on the Total of a 
PCI (including all costs above the line and the markups). 

 

Field security can be applied to the Total Markup flag for PCI Markups.  By default, the field security 
is set at HIDDEN.  Other possible settings: UNRESTRICTED, READ-ONLY: 
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Cost Status Query – Additional Columns (18.67592) 

Three additional columns are available in the Cost Status Query. 

The names for the columns are as follows: 

1. PMOJSQ_BILL_AMT Billed to Date) 

2. PMOJSQ_IDEAL_REV_AMT (Job to Date) 

3. PMOJSQ_UNBILLED_JOB_AMT (Calculated as 2 minus 1) 

These columns are not initially visible in the Cost Status Query Log, but will need to be added by the 
user, by first going to the User Defined Logs – Cost Status Query and selecting them for inclusion in 
the Cost Status Query Log as shown below. 

a) Select them in the User Defined Logs – Cost Status Query, and then save: 
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b) Select them in the Log Builder – Cost Status Query, and then save: 

 

 

c) Review the Cost Status Query Log: 

Job To Date 

Billed To Date  

Unbilled Work = Job To Date – Billed to Date 
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Cost Status Query – Additional Columns (18.66226) 

 

CMiC has added the following columns to the Cost Status Query. If the value is negative it is 
displayed in red. 

1.  Variance to Committed = Current Budget - (minus) Committed 

2.  Variance to Spent = Current Budget - (minus) Spent 

Field Security for Buyout Analysis [Purchase] button (18.68164) 

 

Added field security for the [Purchase] button in Analyze Bids (Buyouts). 
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Analyze Bids (Buyouts) – Print button (18.58130) 

 

A [Print] button has been added to the Analyze Bids (buoyts) screen to enable users to generate 
reports with selected bidders in the Bid Analysis program. 

Disable Print until Record Approved via Workflow (18.68449, 18.60646) 

 

Changes have been made to disable the [Print] button until the record is approved in Workflow.  This 
applies to Subcontracts, Subcontract Change Orders, PCIs, Owner Change Orders. 

 

Unlinking Vendor and Subcontract from POSTED PCI (18.53277) 

This enhancement was released in Patch V12-004 but was not documented then. 

Enhancement: Provision of a utility that allows users to unlink Vendor and Subcontract from PCI 
detail lines of POSTED PCIs that do not have the subcontract Change Code and Task ID in the PCI 
detail line. 

The following changes have been made in relation to this enhancement: 

a)  Addition of a button [Unlink PCI Detail Line] to the PCI screen.  Field security can be applied 
to the button.  By default, the field security is set as ‘Unrestricted’ for the client. 

b)    The [Unlink PCI Detail Line] button is available on POSTED PCIs.  When the button is 
clicked, a popup window is displayed whereby all PCI detail lines with Vendor and 
Subcontract  

but their subcontract Change Order and Task ID are empty are shown.  The system allows 
users to carry out the unlinking of vendor and subcontract for selected item(s) in this list.    
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By default all lines are selected.  Use the Select All/Deselect All checkbox (header checkbox in the 
popup) if necessary. 

Select the line(s) to be unlinked and then click [Unlink]. 

               

 

 The following message box is displayed at the end of the unlinking process: 
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The Vendor and Contract will be removed from these detail lines.  Any RFQ lines associated/created 
with these PCI detail lines will remain unchanged. 

             

 

If the [Unlink PCI Detail Line] button is clicked and there are no detail lines that satisfy the condition, 
the following message is displayed: 

                  

Enhancements to PSPDF Viewer for Drawing Management (18.50703) 

1)  Zoom In and Zoom Out can be done using Shift + Mouse scroll.  
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2)  Enabled PANNING using shortcut key: when the user presses the space bar key and then 
scrolls with the mouse, panning is enabled.  When the user releases the space bar key then 
panning is disabled.  

3)  When the user creates an annotation and wants to link it with a CMiC object, the LOV for 
selecting the object now shows only RFI, Issue and Documents.  

4)  Added a button on the toolbar to Download the PDF.  

5)  A “NOT CURRENT” watermark now shows on old revisions. 

6)  A Filter feature is now available to filter annotations 

7)  On object associated with annotation, showing hover near object being hovered.  

8)  For non-Drawing document type documents in Document Management, we are showing the 
Revision button on the basis of Edit privileges set for the user role.  

9)  Display of Link, Publish and Show/Hide buttons (with Tooltip) on the basis security settings 
for user role.  

Source Type Mandatory in PCI Entry (18.62539) 

The Source Type field has been made mandatory in the PCI Header.  A default value of “NA (not 
applicable)” is set when the Maintain Source Type PM role privilege is unchecked.  If the privilege is 
checked, the default value of Source Type in the PCI screen is set to blank. 

New Document Type for Collaborate Pay Request (18.64559) 

 

CMiC has created a new document group type CLBPAYREQ, which stands for the Collaborate Pay 
Request, for every tenant. 
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Multiple Upload File Size Limit (18.65471) 

 

Multiple Upload - changed the maximum file size limit from 20 to 50 in the System Options table. 

Subcontract Change Order – Additional Fields Added (18.65471) 

Three additional fields have been added to the Subcontract Change Order screen: 

• Total SOV Lines 

• Total Including Taxes 

• Accounting Description (18.66357) 

Field security can be applied to these fields if needed. 

 

RFI Type Maintenance and Related Functionality (18.63957) 

The following changes have been made to facilitate the inclusion of RFI Type in the RFI ID of an RFI. 

1. A new program to maintain RFI Types has been added.  The security access for the program 
must be set up using: 

Security > Role Maintenance > Assign Menu Items…  File Maintenance > 
RFI Type  
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When done, the program will be visible in the PM JSP tree-view.  If you are using a custom tree-view, 
you will need to use Menu Maintenance to make adjustments to see this new screen. 

2. RFI Type Maintenance screen  

Once security is applied to the menu item, use the screen to enter the various RFI Types and 
their Description: 

 
 

3. Project Control - changes have been made to allow the RFI mask to include the RFI Type.  

The character ‘r’ is used to represent RFI Type: 
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4. Project Maintenance – similarly, changes have been made to allow the RFI mask to 

include the RFI Type.  The character ‘r’ is used to represent RFI Type. 

5. Field security in RFI object – field security can be applied to the RFI Type field if 

desired.  The possible setting: Unrestricted, Read-only, Hidden: 
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Addition of Detail Lines to Posted PCIs (18.48382) 

Changes have been made to allow modification of a posted PCI by adding Detail Lines to it.  This is 
controlled by the PM Role privilege “Modify Posted PCI”: 

 

 

Request For Payment – Job and Phase Added (19.73277) 

Added Job Code and Phase Code fields/columns to SOV lines in Request For Payment screen. 

 

 

Field Security can be applied to both Job Code and Phase Code fields. ‘Hidden’ is the default value 
set on the *ALL* role and Read-Only is the other option. 

 

 

Security> Role Maintainance > Assign Field Security > Payment Requisition > Job Code and Phase Code 
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Subcontract – Field Security for Textura Flag (19.69234) 

Field security has been added to the Textura Flag on the Subcontract Entry screen with options: 
Unrestricted (default), Read-Only and Hidden. 

 

 

 

 

Security> Role Maintainance > Assign Field Security > Subcontract > Textura flag 

Chat Bot added to Project Maintenance (19.77898) 

Added Chat Bot to PM JSP Pages and applied modifications to add a security privilege for it. 
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Assigning access to Chat Bot: 

 

Contract Forecasting – % Complete Enhancements (19.71214) 

Contract Forecasting - applied the following enhancements:  

• to make % Complete editable for Method A.  

• modified field security of %Complete to be Unrestricted, Read-only or Hidden. 

Document Strip Enhancements (19.74135) 

 

 



582  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

NOTE: This new feature may require switching on (i.e. to non-classic mode) by running of the version 
script under work item 7 of this issue. (19.74135-7) 

Overview: 

Changes have been applied to enhance the user experience when using Documents in Project 
Management. 

The enhancements are listed below: 

• Drag and drop documents or click the target drop area to select the documents to be 
added to any PM object that has the document strip. The Document Type of the resulting 
attachment will be determined based on the PM System Option setting for the PM object 
(RFI, Communication, Submittal etc.) 

• Automatic creation of a revision for a document that already exists on the PM object if it is 
selected again or dragged and dropped again 

• Adding revisions using the [Add Rev] button 

• Editing/Deleting revisions using the [Edit]/[Delete] button button: 

 

• Ability to change the Document Type of a document and apply the change using the 
[Update Changes] button.  In this case the Document Type change is applied to all 
revisions. 
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[Send to Spreadsheet] button added to Analyze Bids (Buyouts) 
(19.71261) 

 

CMiC has added a [Send to Spreadsheet] button to the Analyze Bids (Buyouts) screen to allow users 
to export the data from the analysis screen to a CSV plain text file. 

Sample output (opened using Excel): 

 

Field security can be applied to the Send to Spreadsheet ([Export]) button: 
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Populate OCO Field when Copying PCI – Project Control flag 
(19.71356) 

 

CMiC has added the flag: 'Populate OCO When Copying PCI' to the Change Management tab of the 
Project Control screen.  This flag is used to decide whether the value in the OCO (unposted) field in 
the PCI header should be copied to the target PCI during the Copy PCI process.  If the flag is 
checked, then the value of the OCO field is copied. If unchecked, the OCO field will not be populated 
on the new PCI record created from the copy. 

By default, the flag is checked to preserve original functionality. 

Field security can be applied to this new flag.  The default value of the field security is ‘Hidden’ set on 
the *ALL* security role: 
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Default Bill Codes in PCI Details for Unit Price Contract Job (18.65771) 

 

CMiC has added a Project System Options flag “Populate Bill Code for Unit Price Contract Job on 
PCI Detail records” to allow for bill codes to be automatically populated for a job that is flagged as a 
'Unit Price Contract'. 

By default, the flag is unchecked, to maintain existing standard functionality. 

With this flag checked PCI Entry (JSP) has been modified to remove the restriction of a bill code not 
being populated in the PCI details for a Job that is flagged as a 'Unit Price Contract.  

However, the bill code will still be populated based on all other existing bill code rules (such as the job 
type must be Job Billing, PCI type has to be external / transfer et.).  Also, the bill code will be 
populated as per mapping rules defined.  If WBS mapping is in use the bill code will only be 
populated on posting of the PCI. 

CORRECTION: Textura Flag Shown if RTI Mapping Defined (19.77363) 

Subcontract Entry - corrections applied to show the Textura Flag only when an RTI Mapping is 
defined and field security for the Textura Flag is Unrestricted or Read-only. 
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PCI Projection – At Risk Percentages (18.64836) 

 

PCI Projection enhancement - added At Risk Percentage default fields for Cost Budget and Revenue 
Budget to Company Control – Defaults tab, and these default to the Project Maintenance – Defaults 
tab when a new project is created, but can be overridden. 

 

From the Project Maintenance, they get carried to the PCI Projection, but can be overridden. 

If PCI is PENDING and UNPOSTED value is populated from Project Maintenance. 

If PCI is APPROVED and UNPOSTED value is 0%. 

PCI POSTED in current period is not shown in PCI Projection report. 

If PCI is posted in future, it is considered as PENDING PCI (even if status is APPROVED). 

Please note, that pre-existing logic (Refresh, Override, Edit Risk) applies to new functionality. 
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Field security can be set for the two fields on the Project Control and the Project Maintenance 
screens, and their default value is ‘Hidden’ on the *ALL* security role: 

 

 

Project Control/Project Maintenance – Submittal Lead Times 
Removed (19.80437) 

Project Control/ Project Maintenance - Submittals Preparation, Fabrication and Delivery fields have 
been removed from the Defaults tab of the screens, since they are no longer required by the new 
Submittal 2.0 screen/process. 
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Screen Editor – Added Privilege to Access *ALL* Security Role 
(16.18599) 

CMiC has added a System Role privilege “Access to Role *ALL* in the Screen Editor”. This privilege 
is unchecked by default. When checked, *ALL* option will be available along with other roles 
assigned to the user in the role dropdown list of Screen Editor pop-up. 

Otherwise, only roles assigned to the user will be available in the dropdown list (current functionality). 
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PSPDF Viewer – Modifications for Annotations (18.50703) 

The following modifications have been made to the PSPDF Viewer as it relates to Annotations: 

• When the user created, published, linked or saved an annotation there was a popup 
shown to the user which would allow page refresh. Now, we have removed the popup 
displayed in between and are directly refreshing the page after each operation.  

• If the PDF file is opened from the Related Objects tab, we are automatically zooming the 
annotation. 

• After Saving/Linking/Publishing, we are now Zooming into the annotation after refreshing. 

Inspection Location Maintenance (Drawing Management) (19.72265) 

 

Implemented mapping of Drawing Location to the Drawing Sheets. This is done from the Inspection 
Location Maintenance screen in the File Maintenance section of the PM JSP tree-view.  Locations 
can be added directly or imported from a csv/txt file.  An example is: North Tower>11>1101 to 
represent Building>Floor>Room; and are shown as segments in the maintenance screen and import 
file. 

• Click on an existing record to select it for Editing. 

• Description can be null.  By design, the segments are not aligned, so that it is easier to 
read vertically/horizontally, especially if there are a large number of them. 

• The Import file is limited to 15 Location segments. 

• Clicking the [Map Location] is a separate function and does not require first selecting a 
location record. 

• Field security can be applied to the [Map Location] button. 
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Layout of Locations Import Control File: 

 

Project Contact – JSP 2.0 Enhancements (19.68963) 

The new JSP 2.0 UI has been implemented for Project Contact Directory.  This enhancement can be 
turned on by running the version script that is delivered in the patch under work item 3 of issue 
19.68963.  The patch release is in classic mode (the old display). 

PCI Markup Rules – Flexible Rates Enhancement (19.73024) 

 

A [Markup Rates] link (or button) and [Use Flexible Rates rather than Fixed %] checkbox have been 
provided at the top on PCI Markup Rules setup screen.  Both fields are controlled by field security 
(default is HIDDEN). The flag will be unchecked (off) by default. 

The [Markup Rates] link will appear only when the user will check the ‘Flexible Rates’ flag. 
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Clicking on [Markup Rates] will open the Maintenance screen to set the Markup percentages. The 
Maintenance screen (table) contains all the setup for each Markup Rule detail line. 
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When [Use Flexible Rates rather than Fixed %] flag is checked, Budget and Billing % fields will 
become non-editable and flexible rates (set up in the Maintenance screen) will be applied. 

 

Important Points: 

• If Flexible Rates flag is checked but no setup is there then the rates defined in rules detail 
line will be applied to all the amounts. 

• In markup rates setup, if rate (Budget and Billing) is set to 0 then that mean this rule will 
not be applied to the amount within that range. 

• If one of the rates has non-zero value, then rule will be applied. 

• If minimum amount is set to null, system will consider that as 0. 

• If maximum amount is set to null, then system will consider that as infinite. 

• If user set more than one setup for same range of amount, then latest setup will be 
applied. 

• If the amount falls beyond the setup ranges, then percentages set for highest amount 
range will be applied. 

• The Flexible Rates flag is controlled by field security with HIDDEN, READ-ONLY and 
UNRESTRICTED. 

Submittal – Email Notification Enhancement (19.74466) 

CMiC has added a new field “Submittal Name” below the Submittal # in Notification Email body, to 
make it easy for the users to identify which submittal they are being notified about. 
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Project Contact – JSP 2.0 Enhanced (19.68963) 

The Project Contact Directory program has been modified to JSP 2.0 (HTML 5) to improve the visual 
appeal and the user experience. 

NOTE: This enhancement may require switching on (i.e. to non-classic mode) by running of the 
version script under work item 3 of this issue. (19.68963-3). 

Contract Forecast - Added “Unbilled Revenue” Column (19.84209) 

Field Security 

Expose Unbilled Revenue field (JCCF_UNBILLED_REV_AMT) on Contract Forecasting screen, 
apply Field Security with HIDDEN (default) and READONLY options. 

New column  

Unbilled Revenue field from JC detail table exposed on Contract Forecasting screen.  

This column is display only. 

 

Please note accumulative revenue amount will be shown regardless of whether the cost transaction 
has been billed before or not. 

Contract Forecast - Added “Cost Variance (New)” Column (19.72862) 

Added a column ‘Cost Variance (New)’ (JCCF_COST_VAR_AMT_NEW’) on Contract Forecasting 
screen. 

Field Security applies to the new column and is hidden by default for ‘ALL’ roles. 
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This is a display only column and the value is calculated as, 

Cost Variance (New) = Projected Cost Budget less Projected Cost Forecast. 

 

Contract Forecast - Completed Output Qty (19.72862) 

The Productivity pop-up > Completed Output Units field is available for update now. 

The field is secured and ‘Read-Only’ by default for ‘ALL’ Role. Users may allow users with specific 
roles to have the privilege to update the field. 

 

The Completed Output Units field is editable, and users can enter a value as required. Upon tabbing 
off the field, a red text message reading ‘Units Complete have been changed and xx.xxx units will be 
posted upon save.’  

Pressing ‘SAVE’ will post the JC Phase Units to the table and refresh the forecast to reflect the newly 
completed output units. All other columns will be recalculated as an existing functionality.  

Pressing ‘Cancel’ will cancel the qty update and close the pop-up.  
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The following example shows already ‘Overridden’ Productivity pop-up where user updated the 
completed Units and saves to post the same.  

Note: The Update of Completed Output Units and posting upon ‘SAVE’ is NOT considered as an 
override. Hence, when updaing the Output Qty with no previous overrides to any other field, will NOT 
be considered as an override to the CTC column in the main screen. 
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Posted Unit Transaction Batches: 

Users will be able to print the report from ‘print Posting Reports’ under the standard menu JC > 
Utilities.  

 

NOTE: The ‘Units’ will be posted with ‘System Date’ as ‘Post Date’, regardless of the current 
Forecasting Period in the Forecast header. 
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Project Control - Automatically Update Due Dates on Submittal 
(19.86143) 

 

CMiC has added a new flag to Project Control > Defaults tab:  "Automatically Update Action Due 
Dates". 

If this flag is checked., the system automatically updates the Due Dates for each stage in the 
submittal workflow – based on the user entering an Action Date. When an Action date is entered, the 
system uses that date plus the remaining lead times between each step, to update the Due Dates. 

PCI Source – Defaulting N/A Conditionally (19.84691) 

The logic for the PCI Source field has been modified to automatically default to N/A only when the 
PCI_SOURCE_TYPE is mandatory entry into sys_alternate_feature is made and Source Type is 
read-only or hidden. 

Bid Package – Edit functionality for Notes tab (19.82356) 

Bid Packages - Edit functionality added in Notes tab. Field security added for Edit and Delete Notes. 

Daily Journal - Import of Manhours (19.80677) 

Manhours can now be imported into the Daily Journal Tasks tab. 

OCO – Field Security for [Recalculate Markups] Button (19.79753) 

Added field security for the [Recalculate Markups] button in the Post popup. 

Communications – Free Form Entry Field added (19.75545) 

CMiC has added a FreeForm check-box next to the “To” field in Communications. When checked, the 
Contact LOV is replaced with the Free Form entry field. 

The FreeForm checkbox can be secured with field security providing two options: hidden (default) 
and unrestricted. 
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Units Complete – History shows Job Cost Transactions (18.67726) 

 

Units Complete - applied modifications to allow display of Job Units Complete transactions (from Job 
Costing - ADF) into the Transaction History popup. 

Daily Journal - JSP 2.0 Enhanced (19.71490) 

 

The Daily Journal program has been modified to improve the visual appeal and the user experience.  
There is no change in the underlying functionality of the various tabs. 

NOTE: This enhancement may require switching on (i.e. to non-classic mode – 2.0) by running of the 
version script under work item 5 of this issue. (19.71490-5).  Please contact CMiC. 
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JSP Logs and Document Folders - JSP 2.0 Enhanced (19.74476) 

JSP LOGS 

 

Example – Communication Log 

The JSP Logs program has been modified to improve the general visual appeal and user experience. 
Here are some of the features that this enhanced program delivers: 

• Search bar – type in the search term and press [Enter] 

• Ability to drag and drop one or more column headings in the grouping area to allow the 
log records to be grouped by that selection: 
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• Filter - click [Show Filter] to display the Data Filters that are currently defined for the log 
(use File Maintenance > Default Filters to make any changes for the default filters of a 
particular log). 

 

Example: 

 

 

• Click Sort on column headers – ascending and descending 
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• Edit column settings using : 

 

Current sort order is highlighted in orange. 

Columns selected: 

 

Column filter settings: 
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• A [Show All] button to display all log records for a given log (the first 50 records are 
shown by default). 

 

DOCUMENT FOLDERS 

The previous Documents program has also been modified.  It is now renamed to Document Folders 
(for 2.0), since it in fact displays folders for the document types that are defined in the system, and to 
which the user has access.   

• Security access will need to be assigned to this menu item (program) in Security > Role 
Maintenance > Assign Menu Items > Document Management > Document Folders, since 
it is a separate menu item from the older classic program: Documents. 
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The number of documents in each document type folder is displayed at the far right. 

• Click the [Upload] button to upload one or more files into any folder.  The user can select 
the document type folder that the files will go into: 
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• Click on a document type folder to see the documents within: 

 

 

• Select one or more documents using the checkbox on the left side then click  

Delete – to delete them 

Edit – to execute a mass update (Batch Edit) of the fields shown in the popup: 
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• The  icon provides toggle between thumbnail and log view: 

 

Thumbnail View 

• Use the [Upload] button to upload files to this document type…no document type folder 
selection is available in this case:  

 

• [Views] – this displays the Data Filters that can be applied to the log 

• Search – enter search term and press [Enter] to quickly get to a particular document 
record 
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• Use the drag + drop of the column headings in the area shown, to display the log in 
groups based on the selection: 

 

NOTE: This enhancement may require switching on (i.e. to non-classic mode – 2.0) by running of the 
version script under work item 12 of this issue. (19.74476-12).  Please contact CMiC. 

Project Role Privilege to Access Submittal Screen vs Collaborator 
Submittals (19.87055) 

 

CMiC has added a Project Role privilege to allow collaboration users access to the full Submittal 
screen (when accessing link from email or My Actions page) rather than the Collaborator Submittals 
screen. 
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PlanGrid/CMiC Synchronization – New User Interface (16.25644) 

 

CMiC has introduced a new R12 interface for the PlanGrid application. No functional change in the 
synchronization process has been made, changes have only been made to HTML, CSS and JS 
levels. 

Meeting Minutes – Field Security for [Copy Agenda items] (19.90215) 

Meeting Minutes - Added field security for the Copy Agenda Items button. Possible setting is 
Unrestricted or Hidden.  It is Unrestricted by default. 

Disable External File Sharing flag – Project Maintenance (19.72286) 

The following changes have been made to prevent downloading of files from PM JSP in some areas: 

• Introduction of the Disable External File Sharing flag- Project Maintenance - when 
external file sharing flag is checked, the attachment checkboxes become disabled;  

• applied changes to disable external file download if flag is checked in Project 
Maintenance program;  

• also changes made to hide the [Download (save as)] icon, [Download Drawing Set] 
button if the "Disable External File Sharing" flag is checked. 

These are the places modified so far: 

If Disable external files sharing flag is checked 

• PMDocument: download button is hidden, and the right-click context is 

• disabled when clicking the hyperlink (of files) 

• CmicioEmailUpdFrm: in the Attachment section, all checkboxes are disabled. I/O 

• email is not allowed to attach any files as attachment. 

• PSPDF Viewer: the download button is not available. 

• SysLogQuery: to hide [Download Drawing Set]> header button in the Drawings -ECM 

• program. 
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Privilege to Hide [Download Drawing Set] Button (19.83951) 

Drawing Management - Added privilege to Hide Download Drawing Set button in Documents screen 
– applies to document type = DRAWMGMT. 

 

Subcontract Entry – Total Taxes Included in Voucher (19.83664) 

This is new functionality for PM JSP, is to show the Tax Amount in the field “Total Taxes Included in 
Voucher” when the flag “Included in Voucher Amount” in the Tax Code setup screen (ADF) is 
checked. 

If the flag is unchecked, the Tax will show as it did before in the “Total Taxes” field in SC and SCCO. 
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When the flag is checked: 
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Submittals – Limit the Statuses Available to P-Type Reviewers 
(19.86806) 

The following enhancements were made for Reviewers in Submittals: 

• added changes to make Reviewers editable on the basis of privilege 

• added changes to limit statuses for P-type users based on review line 

• only statuses based on that Reviewer line and class code are shown 

• when a P-type user tries to add a new reviewer, user cannot set date beyond returned 
action date 

• when a C-type user accesses the submittal, all statuses are available to the user 

• when P-type user is not part of the any four reviewer and tries to add new reviewer, 
status field is disabled 

• [Complete Review] is unavailable when the submittal review is complete. 

Importing Manhours into Daily Journal Record (19.80677) 

Changes have been made to allow for the importing of Daily Journal manpower into an already 
existing Daily Journal (i.e. the Daily Journal header must have already been created). The IMPORT 
button will be available when user switches to ‘Manpower/Tasks’ tab in an already existing Daily 
Journal, where user can Import manhours after passing through all validations that currently exists in 
the Daily Journal.  

Field security (Unrestricted and Hidden) would be applied on the Import button in the Daily Journal 
screen. 
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Field security: 

 
 

The manhours can be imported from Excel file(.csv) or a text file(.txt).  The import file with following 
columns will be accepted in the Daily Journal: 

• Company 

• No. of workers 

• Man-Hours 

• OT Hours 

• DOT Hours 

• Activity Code 

• Notes 

 



612  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

 

 

The Control File for the import has the following layout: 

 

File Layout Details – Daily Journal Manpower Import 

 

The following table gives the detail description for each field: 

Control File = pmdjtaskimp.ctl 

Column Name Description Required Type Length 

PMFJTI_PARTN_CODE   
A valid CMiC 
partner code 

Yes Varchar2 8 

PMFJTI_WORKERS_NUMBER 
Total number of 
workers 

Yes Num 10 

PMFJTI_MAN_HOURS 

This field 
depicts the 
number of 
hours a worker 
worked for. 

Yes Num 12,2 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  613 

Column Name Description Required Type Length 

PMFJTI_OT_HOURS 
Over-Time 
Hours 

Yes Num 12,2 

PMFJTI_DOT_HOURS 
Double Over 
Time Hours 

Yes Num 12,2 

PMFJTI_ACT_CODE 
Schedule 
Activity Code 

Yes Varchar2 30 

PMFJTI_NOTES Notes Yes Varchar2 4000 

Notes 

• The Manhours import works the same way as other PM JSP imports. Below is an outline 
of the steps and a description of the Validation screen. 

• Prepare a .txt or .csv file with the details to be imported, using the layout guide above.   

• For numeric codes, leading zeroes are usually removed in a .csv file, so make sure to 
adjust these appropriately before. 

IMPORTANT NOTE: The file must be .TXT or .CSV.  Also note that if the file is opened using Excel, it 
may lose some of its original formatting.  It is preferable to open and edit using Notepad.  For 
example, if the value of a field is “01”, editing in Excel will possibly change it to ‘1’. 

Example input: 

 

 

 

Checklist Maintenance Enhancements (19.73960) 

Overview 

These enhancements involve the ability to copy a checklist type from another project so users can 
share checklist types or pull them into their next project without manually recreating them.  Users are 
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then able to use these modified checklist types on mobile but the ability to add or create new rows in 
the mobile application is not required at this time. 

Below is an outline of the enhancements that have been made to achieve the objective. 

 

1. A new security role privilege “Checklist Admin” has been added.  By default it is unchecked. 

This privilege controls the following:  

• Access (edit/delete) to Checklist Detail records which are locked. 
For example, user with all necessary field security must also have this new “Checklist 
Admin” privilege to edit or delete Admin-locked detail records.    

 

 

The “Checklist Admin” privilege allows the user to “Lock” checklist Types in the Checklist 
Maintenance screen: 
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2.    “Lock Checkbox” field security is used to apply field security to the “Lock” flag in the Checklist 
Maintenance screen.    By default, it is set to “Unrestricted”. 
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3. Added the [Copy From Project] button to the Checklist Maintenance screen. 

 

• User will be able to copy checklist types from existing projects to which they are 
assigned, but there will only be one copy of a project-specific checklist type per system-
level checklist type.  

• During the copy function, the Projects LOV will show the projects that the current user 
has access to. 

 
 

• If users try to copy the same type from another project into the current project, the 
copying process will overwrite the existing checklist type after user confirmation. 

 

 

• If users open a project-specific checklist type and then try to copy a checklist type from 
other projects, then it will overwrite the contents of the current checklist type. 
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4. Field Security can be applied to these objects in the Checklist Maintenance screen: 

• Copy From Project - button 

• Add Detail Record – ‘+’ action 

• Delete Detail Record –  ‘-‘ action 

Possible field security value:  Unrestricted or Hidden; default for all is “Unrestricted”. 

 

 

EXAMPLE:        
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5. Checklist Maintenance screen – Filter 

The filter allows the user to select All checklist types, (current) project-specific only or system-level 
only: 

 
 
6. The PM System Options flag “Show only Project-Specific Checklists” no longer determines the 

visibility of the “Assign to Project” flag on the Checklist Maintenance screen (this is already controlled 
by field security) but it still controls whether project-specific checklists are shown on the tree-view or 
not. 

In addition, the project-level masks are only visible in Project Maintenance > Defaults > Masks for 
project-specific checklist types when the “Assign to Project” flag is visible and checked for a type.  If a 
checklist type is no longer project-specific, the type and mask is removed from Project Maintenance. 

IMPORTANT NOTE: 

The Checklist Maintenance screen will show the system-level checklist types and the checklist types 
assigned to the current project only.  

However, the Checklist Log will continue to work as it previously did. 
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7. Now, the Delete icon is not available for project-specific checklist types. Users can only 
unassign them from the project. 

 

Punch List Item Status Maintenance (19.71005) 

 

A new maintenance screen has been added to the CMiC Field module. It is the Punch List Item 
Status Maintenance screen, which is used to add, edit or delete punch list item status codes, used in 
the Punch List Item screen. 

There are five status classes, any one of which a punch list item status code can be assigned to: 
Draft, Open, Closed, Contested, Review. 
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Users can be assigned to this new program through the Security >Role Maintenance > Assign Menu 
Items > Punch List Item Status screen.  Custom menus will need to be modified to include this menu 
item. 

Punch List Items (19.71005) 

 

A new screen has been added to CMiC Field that is to be used to create and manage Punch List 
Items.  It follows the new design standard of using field-sets to create a better UI/UX.   

This new screen will require security access assignment to the user through Security > Role 
Maintenance > Assign Menu Items > Punch List Items.  

Punch List Items Log: 
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An outline of some of the major features is given below: 

1. Mandatory fields are Description and Status 

2. Share icon  – this replaces the [Send I/O] button and is available for each punch item, in the log 
view. 

3. Punch Items Statuses 

 

• There are 5 Status Classes: 

Draft - Grey - Punch item has been created but not yet assigned for resolution. 

Open - Blue - Punch Item has a responsible party and an associated due date. Work to 
be completed. 

Review - Orange 

Contested - Red - Punch item has either been disputed in some form or has failed 
Review. Resolution is required. 

Closed - Green - Punch item work has been completed and approved. 

• When a punch item is created the default status is Draft. 

• When any Reviewer submits the response "Contested", the status is changed to 
CONTESTED 

 

4. Responsible Contractor: 

When Responsible Contractor is selected for Punch Item: 

• Current Responsibility field gets updated with Responsible Contractor record after Saving 
the Punch  

• Responsible contractor gets added to Reviewers table as the first party after Saving the 
record. 
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5. Reviewers Response: 

Two options for Reviewers Response are available in the drop-down 

• Completed (Green) 

• Contested (Red) 

6. Mass Update (Batch Edit) Actions 

Mass update actions can be performed after selecting one or more checkboxes beside punch items: 

• Delete - will delete all selected punch items 

• Edit - will display a Batch Edit popup window by which the following fields can be updated 
for the selected punch items: 

Status 

Responsible Contractor 

Trade/Type 

Location Code 

List (i.e. Punch List) 

Reviewer Template 
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The screenshots below illustrate this feature: 

 

 
 

7. List 

• The List field displays a drop-down list of Punch Lists, one of which can be selected to be 
associated with the punch item being created or edited. 

• If no List is selected, a value can be entered in the field and in this case a new Punch List 
with Title as entered in the List field is created (on the fly). 

• If the List field is left empty, then the Punch List Items created are listed under the default 
Punch List “NOCATEGORY” with title “Uncategorized” 
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8. Punch Items can be linked to a change item (PCI), similar to other PM objects 

 

 

9. Punch Items can be linked to drawings from Drawing Management.  The link is created in the PSPDF 
Viewer (link annotations).  The drawing can be accessed by clicking on the link from within the punch 
item: 

 

 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  625 

10. The standard Document strip and Notes section are also available for Punch Items. 

 

Ball in court Report: Enhancements (18.54684) 

Enhancements done on ‘Ball in court’ Report are: 

• Added a hyperlink to ‘Object No.’ to open corresponding screen. 

• ‘Object No.’ field color has been changed to Blue and text is set as underline.  

• This feature does not support Request For Quotation (RFQ) 

• Adobe Reader is the preferred PDF reader to view the report and use the hyperlink, so 
users may need to save it as an Adobe PDF file to drill down. 
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Linking Project Roles to BI Dashboards (19.92676) 

CMiC has added support to map Project Roles to BI Dashboards by adding the Dashboard column to 
the Project Roles Maintenance screen: 

 

The Dashboard LOV shows the list of dashboards to which the current user has access. 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  627 

On startup, the system will look for this setting to display the selected dashboard. If there is not any 
dashboard setup for any role then the URL from Start Page url (Project Maintenance), or Project 
System Options – Start Page or overall system start page will be used to display at the startup. 

If a user has multiple roles assigned and those roles have different dashboard settings, then roles will 
be sorted based on “Key Player” and “Order seq” and first one in this list will be picked up to show the 
dashboard. 

If no “Order Seq” is available, then list will be sorted based on same combination as used in screen. 
Again, the first role in the list will be picked up to show the dashboard. 

If there is a dashboard selected for a project role in a project, then the startup screen will show the 
selected dashboard, for example: 

 

 

If no setup is detected for project role then original setup (as indicated above) will used to display 
dashboard. 

Documents Mass Update include UDFs (19.74476) 

Mass update of documents now includes User Defined Fields (UDFs). 

NOTE: UDFs/Classifiers in Document Types can be added/removed on the ADF side from the 
“Document Options” screen. 
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CMiC has modified the Documents program to add the ability to Batch Edit the UDFs/Classifiers that 
users have added to various document types. 

 

 

 

User will be able to edit Status, Date, Copies and any User Defined Fields on the document type. 
User can also elect to move the selected Documents to a new folder (Document Folder). 
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When the changes made are Updated in the Batch Edit pop-up, the log screen refreshes and reflects 
the changes made by the user. 

 

 

Ability to Search Across all Document Folders (19.74476) 
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Document Folders - Search bar is added in the Document folder view. 

Users are now able to search across all folders from Document Folder view. When the keyword is 
entered and search is executed, the results are displayed with following columns – File type icon, 
Document type name, Document ID and Title. 

 

 

Checklist Header – UDFs Added (19.87379) 
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Checklists - Added  the ability to insert UDFs on the Checklist Header by including objects for defined 
Checklist Types in the User-Defined Fields screen of PM JSP (screenshot above). 

Every time a new checklist is created for a defined checklist type, users will see a new entry in the 
User Defined fields screen. They will be able to add or delete UDFs in this screen. 
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UDF Data Sources for Project Partners and Contacts (19.87379) 

 

In addition, three new data sources for User Defined Fields are added which will work as:  

1) ALLPPARTN: All Project Partners - which will show all partners.  

2) PROJCONT: Project Contacts - which will show all Project contacts.  

3) ALLPARCON: Project Contacts and Partners - which will show contacts and partners. 

Submittal Reviewers Table - Revise and Resubmit Status (19.92077) 

Users will be now able to Save the status of “Revise and Resubmit” under SENT or RETURNED 
actions and a new review cycle will be created. 
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NOTE: Users are also able to save Revise and Resubmit Status under SENT or RETURNED via Edit 
History pop up and new cycle is created: 
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Punch List/Punch List Items Changes (19.71005/19.92750) 

• Default status for Punch List items is set to Draft, when Responsible contractor and Date 
fields are filled, the status will auto-update to “Open”. 

 

 

 

• Trade/Type field is included in the Punch List Items import file: 
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• Users are now able to receive notifications for the Punch List created from Punch List Item. 
Punch List Items will no longer appear in contacts Email Notification and 
View/Create/Update/Delete All Objects settings in Project Roles (previous patch – V12-010). 

• If the Project does not have any Punch List Item existing, then a “NO CATEGORY” Punch 
List is created behind the scene (cannot be seen/hidden on Punch List screen) when the List 
field in Punch List Item is left empty. 

NOTES:  

1) NO CATEGORY Punch List will also be hidden now for Projects which has Punch List 
Items existing under this Punch List.  

2) Email Notification are not received when a NO CATEGORY Punch List is created. 
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Contract Types – Project Level Active Flag (19.89814) 

 

 

Contract Types (Project level) - modified Contract Types Maintenance program by adding an “Active” 
flag.  Also added the ability to secure it with field security (Unrestricted, Read-Only and Hidden). 

 

 

 

Now, user will be able to deactivate Contract Types by Project, using the Contract Types button 
within the Project Maintenance screen. And, as a result, in the Subcontract screen, only active 
Contract Types will be visible in the ‘Contract Type’ field dropdown. 
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The “Active” flag at the Company Contract Types level (found in File Maintenance menu item) 
defaults to the  “Active” flag at Project Level and can be overridden. 

 

 

 

PSPDF Web Viewer - Enhancements (18.50703) 

PSPDF has been upgraded to 2020.1.1 and the following enhancements have been added to PSPDF 
Web Viewer: 

• ‘Delete’ icon has been removed from the PSPDF Web Viewer: when an annotation is 
selected on a Drawing (DRAWMGMT), as the user is not capturing the delete of annotation at 
database level so this icon is made hidden from viewer. 

• Hide annotation creation tools from PSPDF viewer's toolbar when Edit flag is off for a specific 
document type. 
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• Reduced amount of zoom level when saving or opening a linked annotation. 
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• A [Settings] button has been added to the tool bar, which has a new feature: “Page Rotation” 
for rotating a PDF file for Project Management and Imaging. 

 

 

• Now, for Drawing Management when viewing old revisions of drawings, the toolbar is being 
displayed and shows some action icons such as: Pan, Zoom In, Zoom out, Fit Width, Print, 
Search and Download.  In the previous version of PSPDF Viewer the toolbar was hidden 
when viewing old revisions. 
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• When the “Disable External File Sharing” flag (in Project Maintenance screen > Defaults) is 
ON, the [Print] button is hidden in the viewer.  Also the action of Ctrl+P is restricted so the 
user cannot print the document by this means as well. 
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• When the user does not have the privilege to edit annotations, then the PSPDF Viewer 
displays a popup window to show linked objects with the heading "You do not have access to 
edit this annotation". 

 

 

 

• Editing of annotations is restricted when the user clicks on annotations in an old revision 
(usually has the watermark “Not Current”) for document type DRAWMGMT. 
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• Now, user is able to create a Custom Stamp annotation with space between the words, in 
case the stamp name has more than one words (as shown in screen shot). 

 

 

                                                

      

 

• Filter icon has been fixed for the PSPDF Viewer. Now, the user is able to hide/show 
annotations based on requirements  from the filter pop-up.  
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• Unwanted padding has been removed from the Viewer when viewing the PDF in Image 
Manager. 

 

 

• A form editor feature has been added to the PSPDF Viewer. i.e. if there is any form (consist 
of text fields) onto the PDF, then user will be able to edit/ change the form fields such as 
move the position of Input fields. And on saving this modified PDF form a new revision will be 
created. 
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Documents 2.0 (19.90538) 

 
 

The JSP Documents screen has been modified to improve the general visual appeal and user 
experience. 

Some of the features are itemized below: 

• Implementation of “Add Existing File” functionality to the document strip, to allow the user to 
add documents from document management to the PM object. 

• The Document Folder field (defined in Menu Maintenance) shows the folder to which the 
document belongs (not to be confused with Document Type folder).  It can only be selected 
during Add mode of a document record.  It is not visible thereafter. 

• New Revisions to the document can be added by the [Add Revision] button (enabled in 
[Edit] mode). 

• Related Objects section - where all the related objects for that document can be viewed and 
the object can be accessed by clicking on the link. 

• Field security for the [Add Document] button can be applied if desired. 
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[Attach Existing File] button: 

 

 

NOTE: This body of enhancements may require switching on (i.e. to non-classic mode – 2.0) by 
running of the version script under work item 2 of this issue. (19.90538-2).  Please contact CMiC. 

Internal Only Flag on Project Role (20.18912)  

 

Changes applied to prevent assignment of internal PM roles to external contacts by introducing a new 
‘Internal Only’ flag which has been added to the Project Role Maintenance screen. By default, the flag 
is HIDDEN (field security on the *ALL* role) and unchecked.  When checked, this role will be 
available for 'C' type contacts only. 
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In Project Contact Directory and System Contacts, the roles having ‘Internal Only’ flag checked will be 
visible in the Project Role LOV for ‘C’ type contacts and will not be visible for ‘P’ type Contacts. 

 

 

C Type Contact (Role with internal flag checked shows in LOV): 
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P type Contact (Role with internal flag checked does not show in LOV only regular roles are visible) : 
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In Key player tab of Project Maintenance for the roles with Internal Only flag checked, only ‘C’ type 
contacts will be available. 
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Condensed Mode for JSP Logs (20.23942)  

 

Condensed mode for all JSP logs - Added "Condensed" mode flag to User Defined Log Types 
screen. 

 

 

Condensed flag checked 
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Condensed flag unchecked 

RFI Standard Answer and its Related Button (18.54300)  

 

a)  Added field security for 'Select Standard Answer' button in RFI.  By default, the flag is HIDDEN 
(field security on the *ALL* role). 

b)  Added field security for  'RFI Standard Answer' text type  in Project Control.  By default, the flag 
is HIDDEN (field security on the *ALL* role). 
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Once these objects are opened up they can be used as described below. 

RFI TextTypes for Standard RFI Answer 

Text Types (and Codes) can be defined for RFI Answer if there are standard answers that the user 
wants to select from when responding to an RFI Question. 

These can be defined in ADF (Text Types, Text Codes), and then set in the Project Control – Defaults 
tab, as company defaults: 

 

The default Text Type code that is set as the company default, has one or more text codes defined 
for it, to which the desired possible standard answers are connected.  These will then be available for 
selection in the popup window displayed when the [RFI Standard Answer] button is clicked in an RFI 
record: 
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Form Letters – Fields for OCO Completion Date (20.21103)  

 

Added a Completion Date field for OCO -  with separate fields for Day, Month, Year in form letter view 
FLPM7000. 

 

Project Maintenance Pay Request tab - Added GCS_SC320 MIP 
Report to Publishable MIPs (20.28447) 

Changes have been applied to add the Certificate of Payment MIP report (GCS_SC320) to the LOV 
on the Select pop-up in the Pay Request tab - found on the Project Maintenance screen, once the 
GCS MIP template is defined in the system (an example is highlighted in the screenshot below). 
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The screen below displays the Form Letter Definition that has been created for this report:  

 

 

JSP Tree-view - Implemented program Search and other 
enhancements (20.27902/PM-615, PM-809) 

Enhancements  have been made to the JSP tree-view to allow users to Search for a program on the 
tree, similar to ADF.    This is available in the tree-view of all JSP modules. 
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A list of the Search results is displayed after the search term is entered.  The user can then select the 
menu item they want to get to (see screen below). 

 

The Menu Maintenance screen is also now available by the icon shown below.  
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In the case of PM JSP, there are some additional changes as shown:   
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Request For Quotation – Broadcast Template Placeholder for PCI 
Scope Description (20.27901) 

The PCI Header Scope Description has been added to the RFQ Broadcast Message Template as the 
RFQ PCI Scope Description field place holder.  The name of the placeholder is 
RFQ_PCI_SCOPE_DESC. 

 

 

An example is given below. 
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Scope placeholder shown in the template when the RFQ is about to be broadcast: 

 

 

RFQ Broadcast email showning the Scope: 
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Version Name (Revision Description) Filter for Document Type 
DRAWMGMT (20.27276/PM-739) 

CMiC has added a Version Name Filter which is applicable for the document log associated with 
document type DRAWMGMT (Drawing Management). 

Users will see a drop-down list for version names for Drawing Management type documents only. This 
will allow users to filter the revisions based on version names. 

The default state of this filter is “Current Set” which is the existing implementation prior to applying the 
filter. 

When this filter is applied, the screen displays all the different document records that have that 
Revision Name. 

 

Length Extension for Start Page Url and Project Photo Url (20.24753) 

Extended the character length of the  'Start Page URL' and 'Project Photo URL' in the Project  to up to 
2000 so that photos uploaded to Document Management logs can be used in these fields. 

JSP Logs – Removal of [Show All] Button (20.29061) 

Changes were made to remove the [Show All] button because it was impacting the performance of 
logs. The records in the log will load 50 records at a time, initiated when users reach the bottom of the 
50 record set. Searching, filtering, grouping and all line totals  will be calculated on the entire set 
regardless of it being loaded in the screen. 
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PCI Entry - Vendor Name added in PCI Detail with field security 
(20.25292/PM-808) 

 

In PCI Entry – Details section, the Vendor Name field has been added, and has a field security 
default set to HIDDEN on the *ALL* security role.   

Customers who want to see the Vendor Name in the PCI Details can set the field security to the 
“Unrestricted (Read-Only) option. 

When the “Unrestricted (Read-Only) option is set, the Vendor Name is displayed in the PCI Details: 

 

Reviewer Status Maintenance Screen (20.25277/PM-684) 

CMiC has added a maintenance screen for the Reviewers Statuses used in the Reviewer section of 
some PM objects such as RFIs, Punch Lists. 

Previously, the Reviewer Statuses were hardcoded values restricted to values: Concur, Disagree, 
Further Discussion Required. 



660  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

With this new Reviewer Status Maintenance screen, the user can add and maintain their own 
statuses. 

Program security (Security >Role Maintenance > Assign Menu Items) will need to be assigned to the 
user, as well as any custom tree-view will need to be modified to include the program.  

 

In the Reviewer Status Maintenance screen, users can select Object Type: Punch List or RFI, and 
the status created can be of Status Class: 

RFI Status Class:  Concur, Disagree, Requires Further Discussion  

Punch List Status Class: Completed, Contested 

By default, the maintenance screen already has values that were previously hardcoded, but now they 
also can add additional values as they desire. 

 
 
 

Security Privilege for new [Set as Default] Button in JSP Logs 
(20.24822/PM-701,PM-285,PM-387) 

Added a new button [Set as Default] and a privilege to go with it to allow system-wide setting of Log 
Defaults. The [Set As Default] button in all JSP Logs will be available to users with the Admin flag 
checked on their JSP security role or to the users who have the new privilege set for their role. 
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This new privilege can be found under Security->Role Maintenance->Assign Privileges: 

 

 

 

 

With either privilege the [Set as Default] button is available to the user in any JSP Log (even the 
System Log): 
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JSP Logs - Export Current and Export to MIP Template Options 
(20.22513/PM-613, PM-798) 

 

The Export feature in Logs has been enhanced to provide two options: 

Export Current  - records exported as displayed in the log 

Export to MIP Template - records exported to native spreadsheet program 

CMiC has also added the ability to [Export] the result set of applying filters and other groupings, 
hidden columns etc. to the JSP Logs, so that there will be no need to adjust the groupings in the 
resulting program. 

Example:  After grouping Transmittals by To Partner, exporting the results using [Export Current]: 
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 Result of export: 

 
 

Access Flag for PM Object URL from Ball in Court (BIC) Report 
(20.21296) 

CMiC has added a new flag "Access to BIC Object From Report" in the Defaults tab of Project 
Maintenance. 

The flag is enabled only when the “Ball in Court Report” flag is checked. 

When “Access to BIC Object From Report” is checked, the url link to access the PM object in the 
report is available for that project.  By so doing, users can control which projects the url link will show 
for, and also prevent unwanted access to PM objects, from the BIC Report. 

 
 

Project Maintenance – Field Security for Project Code and Project 
Name (19.79889) 

CMiC has added field security for the Project Code and the Project Name in Project Maintenance. 

Possible settings: Unrestricted or Read-Only. 
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Submittals – Fabrication and Delivery Dates – Control File and 
Project Defaults (19.92664)  

Submittal related changes - Project Control/Project Maintenance - Rolled back changes made under 
19.80437-3: Set Preparation Date as hidden; Submittal - Added Fabricated and Delivered dates back. 

Project Maintenance (applies to Project Control as well): 

 

 

 

The Fabrication Date and Delivered Date are now brought back to the Submittal screen: 
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These fields are only available for users to enter if they would like to override Fabricated, Delivered or 
Arrived Onsite date after completion of submittal workflow (i.e. after the Forwarded Action). During 
the submittal process they will remain non-editable. 

. 
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Project Role Privileges for Punch List Item (20.18933, PM-491) 

 

Project Role privileges have been added for the Punch List Item object.  Now user access to the 
Punch List Item is governed by the View/Create/Update/Delete All Object project role flags: 

View All 

When checked (Y) - the user can view all Punch List Items regardless of who created them or who 
they are assigned to.  

When unchecked (N) - the user can only view records that they created and records where their 
business partner records appear in the Responsible Contractor field. 
 

Create All 

When checked (Y)- the user will see the CREATE button in the Punch List Items Log.  

When unchecked (N) the user will not see the CREATE button. 
 

Update All 

When checked (Y), users can select the EDIT button when viewing a Punch List Item.  

When unchecked (N), the user will not see the EDIT button. 
 

Delete All 

When checked (Y), users can select the DELETE button from the Punch List Item Log.  

When unchecked (N), the user will not see the DELETE button. 
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Field Security for Subcontract/GCS Pay Request Fields (19.86283) 

 

Field security has been programmed for the GC Pay Request fields (Day of Month and Duration) that 
are on the Subcontract Entry screen.  The default setting is HIDDEN on the *ALL* security role. 

Possible settings are: Unrestricted, Read-Only or Hidden. 

Even with the Unrestricted or Read-Only settings, they will only be displayed if the related licence is 
installed.  

Bid Items - Field Security for [Show Imported Data] Button (20.25425) 

PM JSP/RTI/WKF/ integration 

CMiC has  created a web service for importing project job estimates.  As part of this work, the [Show 
Imported Data] button has been added to the Bid Items screen to allow the user to review and make 
changes to the bid item import before accepting it into the system.   

Field security has also been added to this button.  By default, it is set to HIDDEN on the *ALL* 
security role. 
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It will show any previously imported data set (imported to the Import Validation screen), that was not 
Accepted into the Bid Items grid.  Therefore, if the user imported a data set into the validation 
screen, and then click [Cancel], the same data set will be there when the user goes back and clicks 
[Show Imported Data]. 

 

Contract Forecast – 3 New Fields with Field Security (20.20785) 

The following fields have been brought to the Contract Forecast screen for display: 

Uncommitted Cost 

Committed Cost 

Total Committed Cost  

Field security for these three fields in the Contract Forecast screen can be applied if desired. 

The possible settings are: Unrestricted (Read-Only) or Hidden. 

By default, the field security is set as HIDDEN on the *ALL* security role for all three fields. 
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When they are all set to Unrestricted (Read-only), they are available for display in the Contract 
Forecast screen. 

Use the [Configure View] button to set them to visible on the sigma grid and move them to the 
desired position on the grid. 

By default they are programmed to be just after the Actual Cost: 
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Meeting Minutes Enhancements (19.70980) 

. The Meeting Minutes program has undergone extensive enhancements to provide a more desirable 

user experience. 

Below is an outline of the enhancements that have been made.  

Meeting Minutes Log 

 

The Log displays in the standard UI that has been applied to all the JSP Logs. 

               

 

Meeting Minutes Entry screen: 

The entry screen now displays in the standard “field set” view that is being adopted for PM objects: 

 

 
 
 
 NOTE: A number of  buttons are not considered in the new 2.0 UI, and are being HIDDEN by 

default,  because they are being considered for deprecation.  These include: 
 User Extensions 
 Printable 
 Quick Print 
 Import 
 Export 
 Submit (replaced by [Publish]) 
 Check Spelling 
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1. Create Meeting 
  Status = Pending 

[Publish] button (new)  is enabled – enable the showing of the meeting in the Logs of users 
who have the ability to see meetings that have the SUBMITTED status  

  
INVITEES SECTION 

   This section displays contacts who are categorized as follows: 
  Required 
  Optional 
  Guests – are all highlighted (i.e. denoted as a name card) 
 
 ATTENDANCE SECTION 

o Topics can be created ‘on the fly’ or selected from the LOV 
o Every Topic must have at least one item  
o Topics can be reordered by using the up-down arrows shown: 

            

 
 
 

 Copy Agenda Items (Edit mode)  

The [Copy Agenda Items] button is secured based on the security privilege to view these Meetings 
and their associated notes.  It is not needed in View Mode as it is used when setting up or conducting 
a meeting, which are both Edit states. 

By default, “Copy Existing Minutes” is unchecked for both R12 and classic mode. 
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2. Publish Meeting 

The [Publish] button is used to Publish a meeting. 

When a Meeting is published, Status = Published (changes from Pending) - to enable the showing of 
the meeting in the Logs of users who on have the ability to see meetings that have the SUBMITTED 
status. 

 

 

 

             

 

 

 

NOTE:  Once a meeting is published or active, email notifications will be sent out to the Attendees if their 
Email Notification settings for Meeting Minutes on the Project Contact record is checked for “CC” or “ALL”.  
“TO” does not apply since the Meeting is not directed to any particular “To” contact, but Attendees (both 
Required and Optional) can be regarded as “cc”s.  If the contact is not an Attendee on the Meeting no email 
notification will be sent to the contact in relation to that meeting.  This is pre-existing functionality. 

                   

3. Active Meeting  
In active meeting minutes mode users are able to capture meeting minutes, create and assign tasks 
with an associated due date, add additional topics and items and view past minutes. 

Users can set statuses on particular agenda items.  

On all new agenda items entered, the status defaults to 'New'. As this item moves to the next 
meeting, the status will change to 'Open'.  

The user can then edit the status to be On Hold, Closed or Deferred. Closed items are not carried 
forward to the next meeting agenda. 

The [Start Meeting] button is used to Start a meeting (applicable to Pending or Published meetings). 
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 When a meeting is Started, Status = Active 
 

NOTE: The Update All flag in the View/Create/Update/Delete window in Project Roles for the 
Meeting Minutes object controls the ability of a user to START a meeting. 

If the user’s role has this flag checked, the [Start Meeting] button is available in the screen  

If the user’s role has this flag unchecked, the [Start Meeting] button is not available in the 
screen. 

 

These are indicators of a meeting that has started: 

 

• Meeting Header is locked. 
 

  (Active Meeting – View mode) 

                         

 
 
 

• Meeting is in Edit mode with [Save Draft] button – no [Save] button. 

 

(Active Meeting – Edit mode): 
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• Next Meeting data is available for editing. 

Next Meeting Info is displayed in the top righthand corner in Active Meeting mode. If the user 
wants to edit the details for the next meeting they can select the [Edit] button. 

A popup window is displayed where the details can be edited and updated (with [Update 
Changes]). 

 

                    

 

 

 
 

• [Create Next Meeting] is available. 

• INVITEES section becomes ATTENDANCE section. 

• Attendance section has [Select All] buttons for Required and Optional. 
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In active meeting minutes mode there is the ability to take attendance by clicking the 
attendee’s name card. 
If selected as present the corresponding card for that person turns blue, otherwise it remains 
grey. 
There is also the ability to add additional attendees to a meeting during active meeting mode 
and the default is present. 
 

 
 
 

AGENDA ITEMS  
• Additional details available for Agenda Items are, for example: 

  Responsibility, Due Date, Minutes 
  Buttons:     Show History, Add Action Items, Create Change, Link to Change, Link to Issues 

 
Agenda items can be reordered by dragging and dropping using the object shown by the arrow:                         

 

Agenda items can also be moved from one topic to another. 

 

Action Items, Change Items, Linked Issues 

         

 
 

An Action Item can be created using the [Add Action Items] button or it will be automatically 
created for the Responsible Contact on an agenda item, based on PM Control setup and the 
Responsible Contact is entered and saved. 
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A link to the Action Item will be displayed where the button was.  This action item will be shown in the 
My Page screen for the contact. 

 
           

 
 
Change Items can also be created or linked to an agenda item, so too, Issues can be linked to an 
agenda item. 
 
 

Agenda Item - Show/Hide History  

The Show History displays only Meeting Minutes from meetings prior to the one being reviewed and 
does not include the present meeting since the user will already be seeing the current meeting 
minutes in its own designated text area.  

It displays the minutes that have been made for an agenda item during the lifecycle of the meeting. 

This button is only available in an Active meeting in Edit mode. 

          

 

 
Meeting Minutes Distribution 

When the meeting is finished, it can be printed and sent by email to all the attendees (Oracle report 
sample): 
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The following changes have been made in the Meeting Minutes Reports print popup window: 

• Changed the word ‘Show’ to ‘Include’. 

• Changed “Show Closed Notes” to “Include Last Historical Minute”. 

• “Include Closed Agenda Items” is checked by default. 

• Removal of “Group By Topic” when the Meeting Minutes report type is selected: 
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BEFORE 
 

            
 
 
AFTER 
 

            

            

 

4. Closed Meeting 
 

When a Meeting is Closed, Status = Closed 

• [Create Next Meeting] is available on the latest meeting in the track 

• [Print Report] is available 

• [Reopen] button – only available on the most recent meeting in a track: 
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NOTE:  There is the ability to edit old meetings to allow users to make adjustments and corrections 
(i.e. correct attendees, edit minutes ...etc.) to the meeting record for accuracy.   

The [Edit] button on Closed Meetings comes with field security. Clicking the [Edit] button 
will launch an Edit mode of the Closed Meeting which will look exactly like the Active Meeting 
Mode, except that the status will remain closed. 

                       

 

 

                      

 

 

Field security for the EDIT button: 
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Logs – [Show All] button removed (20.29061) 

Changes were applied to remove the [Show All] button because it was impacting the performance of 
logs. The records in the log will load 50 records at a time. The next 50 record load will be initiated 
when users reach the bottom of the previous 50 record set.  

Email Notifications for Reviewers When Action Items are Created 
(20.27074/PM-746) 

For RFIs, an email notification will now be sent to Reviewers whenever an Action Item is created for 
them, to inform them that the relevant record requires their attention.  The email will have a link to the 
record so that it can be easily accessed then. 

Mandatory/Non-mandatory Reviewers 

a) the Project Contact “TO” Email Notification settings should exist with the Modified flag checked 
for the RFI object 

b) the Status does not have to be completed to trigger the alert 

c) Action Date should be null for new reviewer. When any reviewer completes the review by 
populating the Action Date then the next mandatory reviewer in the sequence will get the 
notification.  

d) for mandatory reviewers the previous mandatory reviewers must have finished their reviews 

e) All non-mandatory reviewers will get the notification when they are added and their Action Date is 
null.  

f) All distribution list contacts become responsible as per their turn and all those contacts will see 
the Complete Review banner on the submittal when they log into the system. 

 

It is the “Responsibility…has been changed” alert that will be sent to the Reviewer (s) added: 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  681 

 

 

Cold Storage Options added to Print Multiple Reports (19.82610) 

Print Multiple Reports - Cold Storage options have been added to the Print Multiple Reports 
functionality: 

 

 

The two options: Cold Storage and Cold Storage with Review can be used to print the reports to Cold 
Storage.   
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The Preview option is the previous option that was always there in the initial implementation of Print 
Multiple Reports, and allows the user to either view the merged report or select a location for saving 
it.  

Project Role Privilege to Delete Revision (20.29898) 

 

CMiC has added  a Project Role privilege to allow users to delete a document revision: “Allow to 
Delete Document Revision”. 

 

Single MIP Report Printing with Merging of Attachments (18.65363) 

Modifications have been made so that the Single MIP printing process now allows for merging of  
attachments with the MIP report (with Template).  Previously the merge options were not available 
when a MIP template was selected: 

 

 

Now, they are: 
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PM System Options – Submittal Separated into Its Own Tab 
(20.21665/PM-897) 

In the PM System Options screen a separate tab has been created  to hold all Project Management 
system level settings related to Submittals.   

 

Also, changes have been made to hide the Send Reminder flag and Days Prior (to Start) field based 
on if the  Preparation Start Date flag (Track Prepapration Start) is unchecked in PM System Options. 
Additionally, If this flag is unchecked  then no default values  are set on these fields. 

If the Track Prepartion Start flag is checked, the submittal Preparation, Lead Time, Send Reminder, 
Days Prior to Preparation Start checkboxes/fields will be available in the Submittal, Project 
Maintenance and Company Control screens. 
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Subcontract Log – Remaining to be Paid (2) is Added (19.91381) 

Added another column in the Subcontract Log for Remaining to be Paid (2) which is determined in the 
following formula: 

Posted Subcontract + Posted Subcontract Change Orders - Posted Request For Payments (gross) 

 

 

The previously existing Remaining to be Paid Amount remains unchanged. 

Original (and still existing) Remaining to be Paid is based on the following calculation:  
Posted SC + Posted SCCO's - Posted RFP (gross) - Pending SC RFP (gross) 
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Meeting Minutes - Facilitate Best Practices with Meeting Minute 
Item Numbering (19.70980/PM-966) 

Add the following instructions in the space next to the Meeting Mask ID and Item ID Mask: 

*Tip: To follow industry best practice for Meeting Item numbering we recommend using the following 
steps when creating your Meeting and Item ID Mask 

1)  Create a Meeting ID Mask beginning with two (2) letters and three Next Available Number 
 characters (***). Example: HS*** 

2)  Create a Item ID Mask that includes the Meeting ID Mask (nnnnn-) followed by three Next 
 Available Number characters (***).  

3)  Resulting Item ID Mask nnnnn-*** 

Also added special text at the botton of track creation screen. 

 

 

Below is the example for Meeting Minutes with Meeting ID Mask amd Item ID Mask : 
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Meeting Minutes – Enhancements to Agenda Items Notes History 
(19.70980/PM-975, PM-1073) 

The Show History section of Agenda Items has been modified to use switches that can be turned 
ON/OFF for all agenda items Notes - (Show All Histories), or for individual agenda items Notes - 
(Show History): 

 

 

In Edit Mode, these Agenda Item Notes History switches are shown as blue when turned ON or grey 
when turned FF. 

Agenda Item Notes have been modified to be called “Starred” if they are Open or “Unstarred” if they 
are Closed. 

Starred refers to a yellow star that is filled - , and Unstarred refers to a star that is unfilled - .  
The user can also choose to see only Open Notes by switching to “Starred Only”. 
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Below is an example where the user chose to show the History of a single agenda item, and only the 
Starred Notes: 

  

Displaying Closed Notes (Unstarred) in the Meeting Report 

CMiC has added the checkbox “Include Unstarred Notes” to the Meeting Report Print popup box. 

When this checkbox is checked, Closed notes (Unstarred) will be included in the report. 
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Subcontract Log – Remaining to be Paid including Retainage is 
added (20.25909) 

 

Subcontract Logs - Added a new column Remaining to be paid including Retainage Amount which is 
determined by the formula:  

 

 Remaining to be Paid Including Retainage = Total Contract Amount – Total Amount paid + (Total  
                                                                                        Retainage Amount – Total Release amount)     
                  
                                                                         = [t_contr_amt - t_paid_amt + (t_retain_amt - t_released_amt)] 
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Below is the example for calculation of this column : 

 
Created a Subcontract  and Posted  : Amt – 15,0000 

Posted RFP = 2,000 

Retainage = 200 
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Payment on ADF side – Prepared checks = 1,764 (Amount paid) 

 

 
 

According to the formula: 
[Remain to be Paid Including Retainage] = t_contr_amt - t_paid_amt + (t_retain_amt - t_released_amt) 
                                          
                                                                   =   15,000 – 1,764 + (200  -   0) = 13,436 
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Print Multiple Options in MIP: Added Page Numbering and Location 
of Page Number (20.31950) 

The MIP Document Printing has been enhanced by adding Page Numbers and other details right 
before the Report Generation screen. If Cold Storage/ Cold Storage with Preview is selected, a 
number of fields: Page Numbering, Document Type, Document Name, Report ID, Report Title and 
Description are listed on the Print Setup Screen. 

 

Two new Text fields added: File Name and Page Numbering. The Page Numbering has a dropdown 
list as Top Right, Bottom Right to fit the page number and lastly, NONE option selected results in no 
numbering in the Page Document. 
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Cold Storage Options added to Print Multiple Reports (19.82610) 

Print Multiple Reports - Cold Storage options have been added to the Print Multiple Reports 
functionality: 

 

 

The two options: Cold Storage and Cold Storage with Review can be used to print the reports to Cold 
Storage.   

The Preview option is the previous option that was always there in the initial implementation of Print 
Multiple Reports, and allows the user to either view the merged report or select a location for saving 
it.  
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Multiple Reports to Email (restored) (20.34676) 

CMiC has added back the Emailing feature for Multiple Reports Printing.   
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After filling in the relevant fields and clicking [Proceed], the following screen is displayed: 

 

 

Also, upon failure it will send a notification to the contact who submitted the report. 

 

 

Additionally, Report Action Status records are being created for this (even though they do not include 
the reports and attachments which are being merged). 
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Contract Forecast - Comments field added to Labor Forecasting 
Pop-up (20.18550) 

Overview 

Added ‘Comments’ field to labor forecasting pop-up. Field is available for ‘P’ and ‘U’ method lines. 

Modifications 

Comment field included in Contract Forecasting – ‘P’ and ‘U’ method productivity pop-up.  

• Field security is hidden by default, filed must be unrestricted by the user to make it visible 

• Length up to ‘3968’ characters, includes alpha-numeric and special characters 

• 6 rows will be visible in the comment section and user can use scroll bar 

• Comment saved are visible through next year and period unless updated 

 

PMJSP > Budget & Cost Management > Contract Forecasting – ‘P’ & ‘U’ method productivity pop-up 

Implementation 

The comments column is hidden by default to ‘ALL’ roles. 
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User must make it ‘Unrestricted’ in order to make the field available in Productivity pop-up. 

 

PMJSP > Security > Role Maintenance > Column/Field Security  

In ‘Contract Forecasting’, click on ‘P’ or ‘U’ line productivity pop-up.  

 

PMJSP > Budget & Cost Management > Contract Forecasting – ‘P’ & ‘U’ method productivity pop-up 

Open the productivity pop-up and enter the comments. Six lines are visible, user can scroll through 
the comment section.  Period is 2020-11. 
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PMJSP >Budget & Cost Management >Contract Forecasting –‘P’ & ‘U’ method productivity pop-up – period 
2020-11 

Comments are visible for 2021-5 period.  

 

PMJSP > Budget & Cost Management >Contract Forecasting – ‘P’ & ‘U’ method productivity pop-up – period 
2021-5 

NOTE: This is also programmed for a client specific custom Productivity/Units pop-up 
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Project Role Privilege to Delete Revision (20.29898) 

 

CMiC has added  a Project Role privilege to allow users to delete a document revision: “Allow to 
Delete Document Revision”. 

Single MIP Report Printing with Merging of Attachments (18.65363) 

Modifications have been made so that the Single MIP printing process now allows for merging of  
attachments with the MIP report (with Template).  Previously the merge options were not available 
when a MIP template was selected: 

 

 

Now, they are: 
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PM System Options – Submittal Separated into Its Own Tab 
(20.21665/PM-897) 

In the PM System Options screen a separate tab has been created  to hold all Project Management 
system level settings related to Submittals.   

 

Also, changes have been made to hide the Send Reminder flag and Days Prior (to Start) field based 
on if the  Preparation Start Date flag (Track Prepapration Start) is unchecked in PM System Options. 
Additionally, If this flag is unchecked  then no default values  are set on these fields. 

If the Track Prepartion Start flag is checked, the submittal Preparation, Lead Time, Send Reminder, 
Days Prior to Preparation Start checkboxes/fields will be available in the Submittal, Project 
Maintenance and Company Control screens. 
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Subcontract Log – Remaining to be Paid (2) is Added (19.91381) 

Added another column in the Subcontract Log for Remaining to be Paid (2) which is determined in the 
following formula: 

Posted Subcontract + Posted Subcontract Change Orders - Posted Request For Payments (gross) 

 

 

The previously existing Remaining to be Paid Amount remains unchanged. 

Original (and still existing) Remaining to be Paid is based on the following calculation:  
Posted SC + Posted SCCO's - Posted RFP (gross) - Pending SC RFP (gross) 

 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  701 

 

Meeting Minutes - Facilitate Best Practices with Meeting Minute 
Item Numbering (19.70980/PM-966) 

Add the following instructions in the space next to the Meeting Mask ID and Item ID Mask: 

*Tip: To follow industry best practice for Meeting Item numbering we recommend using the following 
steps when creating your Meeting and Item ID Mask 

1)  Create a Meeting ID Mask beginning with two (2) letters and three Next Available Number 
 characters (***). Example: HS*** 

2)  Create a Item ID Mask that includes the Meeting ID Mask (nnnnn-) followed by three Next 
 Available Number characters (***).  

3)  Resulting Item ID Mask nnnnn-*** 

Also added special text at the botton of track creation screen. 

 

 

Below is the example for Meeting Minutes with Meeting ID Mask amd Item ID Mask : 
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Meeting Minutes – Enhancements to Agenda Items Notes History 
(19.70980/PM-975, PM-1073) 

The Show History section of Agenda Items has been modified to use switches that can be turned 
ON/OFF for all agenda items Notes - (Show All Histories), or for individual agenda items Notes - 
(Show History): 

 

In Edit Mode, these Agenda Item Notes History switches are shown as blue when turned ON or grey 
when turned OFF. 

Agenda Item Notes have been modified to be called “Starred” if they are Open or “Unstarred” if they 
are Closed. 

Starred refers to a yellow star that is filled - , and Unstarred refers to a star that is unfilled - .  
The user can also choose to see only Open Notes by switching to “Starred Only”. 

Clicking on the Star can switch it between Open and Closed and vice-versa.  There is a tooltip that is 
displayed when the cursor hovers over the star. 
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Below is an example where the user chose to show the History of a single agenda item, and only the 
Starred Notes: 

  

Displaying Closed Notes (Unstarred) in the Meeting Report 

CMiC has added the checkbox “Include Unstarred Notes” to the Meeting Report Print popup box. 

When this checkbox is checked, Closed notes (Unstarred) will be included in the report. 
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Subcontract Log – Remaining to be Paid including Retainage is 
added (20.25909) 

Subcontract Logs - Added a new column Remaining to be paid including Retainage Amount which is 
determined by the formula:  

 

Remaining to be Paid Including Retainage = Total Contract Amount – Total Amount paid + (Total  
                                                                                        Retainage Amount – Total Release amount)     
                  
                                                                         = [t_contr_amt - t_paid_amt + (t_retain_amt - t_released_amt)] 
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Below is the example for calculation of this column: 

 

Created a Subcontract  and Posted  : Amt – 15,0000 

Posted RFP = 2,000 

Retainage = 200 

 

 



706  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

 
 

 

Payment on ADF side – Prepared checks = 1,764 (Amount paid) 

 

 
 

According to the formula: 
[Remain to be Paid Including Retainage] = t_contr_amt - t_paid_amt + (t_retain_amt - t_released_amt) 
                                          
                                                                   =   15,000 – 1,764 + (200  -   0) = 13,436 
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Print Multiple Options in MIP: Added Page Numbering and Location 
of Page number (20.31950) 

The MIP Document Printing has been enhanced by adding Page Numbers and other details right 
before the Report Generation screen. If Cold Storage/ Cold Storage with Preview is selected, a 
number of fields: Page Numbering, Document Type, Document Name, Report ID, Report Title and 
Description are listed on the Print Setup Screen. 

 

Two new Text fields added: File Name and Page Numbering. The Page Numbering has a dropdown 
list as Top Right, Bottom Right to fit the page number and lastly, NONE option selected results in no 
numbering in the Page Document. 
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JSP ChatBot Removed (20.35173) 

CMiC has removed the old Freshdesk Chat Bot. 

The ChatBot which was added to JSPs in V12-009 has been now been removed. 

 

 

 
 

Subcontract Entry – Vendor and Contract ID Switched (20.34936/PM-

1065) 

In Subcontract Entry, the Contract Number field has been placed after the Vendor field to resolve the 
issue faced by users where, when a mask is set with the Override setting, if the user entered a 
subcontract number, it was later overwritten by the subcontract number created from the mask after 
the vendor was selected, without the user realizing until the subcontract was saved.  

With the Vendor field first, the subcontract number from the mask is created after the vendor is 
selected, but it can still be overridden by the user before proceeding to the remaining fields and 
saving the subcontract record. 

BEFORE: 
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AFTER: 

 
 

Punch List Item - Added History Tab (20.34666/PM-1098, PM-1184) 

A History tab has been added to the Punch List Item object.  It will show an audit of the following 
actions for the Punch List Item record: 

• Changing Punchlist item Status 

• Changing Responsibility 

• Adding additional reviewer  

• Changing reviewer status 

• Adding new document 

• Adding new notes 

 

 

It also monitors Current Responsible Contact and the guidelines for that are: 

a) the TO field of a Record 
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b) the Reviewer in the Reviewers Table closest to Step 1 who is both Required and Does Not yet 
have a Status and Action Date populated 

 

 

 
 

Cost/Budget Status Queries (Category) –  Category Name Added 
(20.32174) 

CMiC has added new column pmojsq_cat_name ( for Category Name) to the Cost Status Query 
(Category) and Budget Status Query (Category) Logs. 

Cost Status Query (Category): 

 

 

Budget Status Query (Category): 
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Daily Journal -  “New” Flag added in Email Notification (20.32010/PM-

349) 

An Email Notification  checkbox/drop-down option for “New” records has been added for the Daily 
Journal object, under the “All” section. 

Any project contact user with this option set will receive a notification for all new Daily Journals that 
are Submitted on projects that that User is assigned to. 

Checkbox option: 

 

Drop-down option: 

 

Email Notification for Replies to Notes (20.31941/PM-1029)  

Modifications have been made to send an Email Notification (based on project contact Email 
Notifications settings) when a reply to a Note is made directly in the PM object (such as RFIs, Issues, 
Submittals etc.). 

Documents Bulk Edit - Prompt Value added for Revision Date 
(20.33050/PM-1017) 

The following enhancements have been made to the Batch (Bulk) Edit popup screen for Documents: 

a) The former “Date” label has been changed to “Received Date” 
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b) Revision Date has been added: 

 
 

PCI Markup Rules - Sorting Ability Added to the Details Section 
(20.33269) 

CMiC has added sorting ability to the details section of the PCI Markup Rules screen.  

Sorting can now be performed on the Job, Phase and Category columns in both the “Calculate On” 
and “Allocate To” sections of the screen. 

 

Subcontracts Entry - Summary Block Rework (20.30964) 

The Summary block of the Subcontract Entry screen has undergone some rework. 

• Added space to separate Original Completion, Days Changes, Current Completion from the 
table.  

• Not-null values for the above 3 fields are shown in grey font color 

• Null or blank values are now shown as ‘N/A’ and “Not Defined” 
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PSPDF Viewer Enhancements and Fixes (18.50703 - 86 – 104) 

Enhancements 

1) Saving Y coordinate of annotation using bottom value from XFDF in Pmannotations table. 

2)  Hiding the Create Revision option on old revisions of documents.  

3)  Opening up the Linked Documents (From PSPDF) revision in new window, so already loaded 
 Drawing does not go away. 

4)  Modified the PSPDF Viewer program to display all annotation type except which has type 
'location'. Some other team are creating TEXT, LINK, etc. so these types should be displayed 
in viewer. 

5)  Added logic to Hide/Delete annotation  

6)  Display type of object on tooltip after linking with annotation.  

7)  Replacing \t with blank string from data which is used for building tree view. 

8)  Allow user to remove (i.e. delete) annotation if it is not saved into database. 

9)  Added privilege to allow user Edit/Delete the LINK type annotation on PSPDF Viewer for 
 Drawing Management; Added new tooltip design for LINK type annotations for Drawing 
 Management. 

 DETAILS  

There is a new annotation type “LINK” created by a server-side process which updates the 
Pmannotations table and is being displayed on PSPDF Viewer.  These are the elevation 
hyperlinks that are created during the Drawings Extraction job, representing the relationships 
(links) between  drawings (documents).   
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a. In this new implementation, we have created a new tooltip for LINK type annotations such 
that when the LINK annotation is clicked there are no options like 'LINK', 'PUBLISH' or 
'DELETE' as with other annotation, instead it shows a thumbnail of the document which is 
linked with that annotation. 

b. There is an option to delete the linked document using the trash icon on it, and this trash icon 
is controlled by the Project Role privilege "Administrate Detail/Elevation Hyperlinks" under 
Drawing Management for a Project Role. 
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c.  There is an option to open the linked document in the same or a separate window. If the 
thumbnail is clicked the linked document will be opened in the same window and when the 

arrow icon   is clicked, the linked document will be opened in a new window. 

d.  If the user has the "Administrate Detail/Elevation Hyperlinks " privilege then the user can 
move the LINK type annotation around but when this privilege is off then the LINK type 
annotation is locked and the user will not be able to edit/move this annotation.  It means the 
annotation toolbar will be inactive for any change.   

e. Once the LINK type annotation becomes deselected by any action, the PSPDF Viewer 
toolbar will become active for normal operations. 

Defects resolved 

• Fixed issue where, if annotation is hidden on a revision, it should not be displayed on next revisions.  

• Fixed document disappear issue from Document Strip, incorporated check of document oraseq when 
checking if there is associated document is present for an object. 

• Fixed error while creating annotation and setting color of text before clicking on page itself. (Removed 
console.logs) 

• Fixed Publish annotation after linking with object.  

• Fixed Publish button still being enabled after publishing annotation.  

• Fixed annotation linking issue (Incorrect annotation oraseq being passed to backend routine). 

• Fixed Filtering slowness issue for DRAWMGMT type documents with multiple pages. (Although PDF 
with multiple pages are not allowed for DRAWMGMT type) 

• Fixed "Delete" key press issue - When an annotation is selected user cannot press Delete key and 
delete annotation from Drawing. We have a different mechanism to delete the annotation via [Delete] 
button displayed on tooltip. 

• Fixed Backspace key issue when an annotation is selected. 
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User Maintenance – Search Feature (21.36771) 

CMiC has implemented the Search feature for the User Maintenance screen in JSP. 

The search term entered can be in mixed, upper or lowercase, and can include the wildcard ‘%’: 

 

Meeting Minutes - Edit Capability for Historical Notes (20.35121,PM-1180) 

When reviewing the History section in Edit Mode of an Active or Closed Meeting, the Historical Notes 
can be edited by clicking the Pencil icon near the Date. Also, the dialogue box is made bigger 
dynamically.  
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The security privilege "Edit Own Notes" determines if the Pencil icon is available or not. 

 

Meeting Minutes – Create Next Meeting Link (19.70980, PM-1243) 

CMiC has applied changes to hide the [Create Next Meeting] button and create a link to Next Meeting 
(in the now Closed Meeting resulting from the action) after creating the Next Meeting. 

This is to ensure that when the user is creating a follow-up meeting, only a single version of that 
follow-up meeting is created, not multiple branches of a meeting. 

This also ensures that Item Numbering is consistent. 
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Meeting Minutes - Added  [Next Meeting Info]  link to CLOSED 
Meetings (19.70980, PM-1183, PM 1243) 

For Closed Meetings, CMiC has added a link to the Next Meeting via the Next Meeting information so 
that users are able to view the Next Meeting Information and Edit it (with privileges), such as 
reschedule it if necessary. 

 

Clicking on the link will display the latest scheduled meeting: 

 
 

Meeting Minutes Reports Enhancements (19.70980, PM-1109, PM-1181, PM-

1222) 

A new report option has been added to the Meeting Minutes Report printing box.   

The new option is “Meeting Minutes Report” (report code = PMMEET1000) and has a different set of 
parameters that go with it.  The word “Note(s)” has been changed to “Minute(s)” as well. 
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The “Include Last Historical Minute” flag is now independent of the “Include Minutes” checkbox, for 
the Meeting Minutes Report (PMMEET1000). 

The flag “Include Last Historical Minute” which was previously available for the Meeting Minutes 
(PM1000) report has been removed. 
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Sample report (PMMEET1000): 

 
 

Meeting Minutes - Save State of the Show/Hide History and Starred 
Only (19.70980, PM-1106, PM-1219) 

When the user is using the Historical section of the Meeting, CMiC will be maintaining the toggle 
states of the switches according to the user’s changes during the navigation between view/edit modes.  
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Once the user leaves the record and returns to the meeting, it will open again with the default view – 
that is, Show All Histories and Show History as depicted below: 
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Web Based Drawing Extraction and Upload Tool (20.28379, 20.34253, 

20.24744, 20.33968, 20.30177) 

A:  Quartz scheduler DrawingMgmt for Drawing Sets – 20.34253 

a)  CMiC is no longer using the LowPriority scheduler for [Download Drawing Set] tasks, but now 
 includes the latter under the new quartz scheduler "DrawingMgmt" for Drawing sets;  

b)  The Drawing set upload, link and cleanup processes are all run using the DrawingMgmt 
quartz  scheduler. 

 

 

B:  The Web-based Drawing Set Upload 

CMiC has introduced a new menu item “Drawing Upload” in the PM JSP tree-view which can now be 
used to upload drawing sets and extract them into their individual sheets with embedded links intact. 

1. Security Setup 

Security setup for access to the new menu item is required and any custom tree-view will 
need to be modified if access is desired. 

 

From the PM JSP tree-view, the path to take is:   Security > Role Maintenance > Assign 
Menu  Items 

         

 

 

2. Drawing Upload Process 
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Click the Drawing Upload menu item on the PM JSP tree-view after security setup, to display the 
upload screen:               

 

The screen displays an informational message that tells what can be done.  The message can be 
dismissed to give more space to work with but will be re-displayed in new browser sessions.  

The user uploads drawings (using either [Upload Drawings] button or drag + drop/clicking on the 
“Drop files here to upload”), enters Version Name, Revision Date, Received Date.   

One or more drawing sets can be uploaded at the same time as long as the total upload size is within 
the upload size limit permissible for the user/server. 

Next, the user clicks the [Select Extraction Areas] button. 

The Drawings are scanned and the user must then select the Sheet Number and Sheet Name 
regions, and click [Process] – displayed after the Sheet Name region is selected. 

                   

 

 

A message is displayed that the user will be notified after the sheets are extracted: 
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Click [Okay] – the user is returned to the Drawing Upload screen where the previously entered data 
has been wiped out to make way for additional uploads. 

At this point, the user can use the Job Scheduler menu item (assuming security access) to monitor 
the progress/status of the extraction job (scheduler = DrawingMgmt – Job History tab when the job is 
completed): 

 

 

 

 

When the job is completed successfully, an email notification is sent to the user’s email address. If no 
email is received, the user should check the History tab of Job Scheduler job DrawingMgmt (as 
shown in the screenshot directly above). 

If the Status is FAILED, the [Show Details] popup window will give details of the failure. 

 

Email received from successful job: 
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From the email received, the user clicks the [View Results] button to review the results of the 
extraction (logging into the CMiC system may be necessary if no CMiC system browser sessions are 
active on the user’s screen). 

 

The drawings are accessible from this email via the [View Results] button for one week or until they 
are published to the project. 

 

3. Extraction Verification  

The user accesses the extraction results grid: 

Example 1 
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Example 2 

 

 

• on the Extracted Data Verification grid, the user can select a new Extraction Region for a 
selected sheet if needed other cleanup activities can be carried out:  

Edit – select the checkbox to the left for mass Editing (Batch Edit) or make changes directly 
to  individual records:    

 

Unsaved individual Edits are evidenced by a small yellow triangle in the upper left corner of 
the field: 

                                                                         

 

  Batch Edit also offers “Find and Replace” for/by a given string.  

  

Delete - (by first selecting the sheet (s) using the checkbox to the left (for mass deletion) or 
using  the trash bin icon for individual deletions. 

If the user attempts to delete records but also has some unsaved changes, an alert will be 
displayed: 
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• Duplicated Sheet Numbers are not allowed.  If the user attempts to publish with duplicate 
Sheet Numbers, a message will be displayed: 

 

 On refreshing the screen, the duplicates will be highlighted by the  icon: 
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• The user can also sort, group by 

• Changes are saved using the [Save] button. 

• Use the [Publish Drawings] button when all changes are committed and ready to be 
Published to the Project. 

 

4. Publish Drawings 

 When the [Publish Drawings] button is clicked an initial message is displayed saying that the 
 drawings are being published.  Once completed, a second message is displayed: 

              

 

• Published records are in the Drawing Management documents folder. 

• Thumbnails of PDFs can be viewed. 

                             

 

 

5. Email Notification of Sheets Processed and Links Generated for Drawing Set 

 Another email is also sent to the current user’s email address, after publishing.  If no email is 
 received, check the History tab of Job Scheduler job DrawingMgmt: 
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Project Maintenance - Addition of 'Sync Data' Button (21.37090) 

The [Sync Data] button has been added to the Data Exchange and Pay Request tabs of the Project 
Maintenance screen.  This button will do the initial push of system level data and setup information 
needed to be able to run Data Exchange or Pay Request applications. The button will not be visible 
until projects are published.  Once a Sync is effected with the [Sync Data] button it becomes disabled 
after the data push is complete. 

Reviewers - Default Flag for Required Reviewer (21.37752) 

Reviewers - On the ‘Add New Reviewer’ window, the ‘Required’ flag is checked by default. This 
change is made to resolve the issue with non-Required reviewers holding up the review process. 
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Logs – Set as Default no longer tied to “Admin” Role (21.39684) 

Logs - Removed the dependence of "Set as Default" button from the 'Admin' role. It is now controlled 
only by the privilege called "Logs - Set Default Log Configuration". 
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New PM Notifications - Email Template Enhanced (20.35433) 

 

• PM Notifications for all collaboration objects like RFI, Issues, Communications are now in the 
Template form (New and Modified notifications).  

• IOS and Android Links added. 
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• "Powered by CMiC" mark – has been added. 

Drawing Upload - Revision and Received Dates (20.28379 - PM-1459) 

Drawing Upload – newly added features 

• Revision and Received Dates are now mandatory. 

•  Added Received Date to Batch update screen. 

• When Date field is clicked, it will show a date format as a watermark (placeholder); populating 
PMDOCTRADESHEETNUM table with lookup data for all tenants. 

 

 
 

Notifications for Action Items (21.37638) 

• Added a new flag "Send PM Notifications for Action Items" to the PM System Options. 

• New Notification email in template form- the user receives an email notification in Template 
form with a URL link of the record. 
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Documents - URL Referenced File 'Upload' (21.36933) 

• File uploads to the Document now has reference URL that references an actual document 
outside of CMiC So we Can maintain the location of the file while still referencing it on other 
records and providing a place to access these files from within CMiC. 

• URL checkbox is changed to a toggle and the corresponding Reference Link field is added to 
the Document upload tool to allow for sharing of a URL for shared documents. 
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Documents - Add Document Revision Received Date to Document 
Log (21.37326, PM-1251) 

• In left Tree Menu, select “File Maintenance” -> “Log Builder”, In right Content Pane, in  

“System Log”, select “Document: Attachment”, “PMD_RECVD_DATE” should appear.  

under “column”.  

• In left Tree Menu, select “Document Management” -> “Documents”, in right Content 

Pane, in “Document”, select “Attachments”, scroll to right, there is a column “Last.  

Recvd. Date”.  
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Project System Options: Move Spec Section Settings to Submittal 
Tab (21.40756 – PM-1047) 

The Spec Section LOV Options and Spec Sub-Section LOV Options in General tab of Project System 
Options is moved to the Submittal tab as these setting s are related to the Submittal program. 

 

 

Field Security for Project Start and Bid Won Lost Date (PM-1117) 

Field Security for Project Start Date and Bid Won Lost Date has been added. 
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Submittals Log – Batch Edit (20.33391) 

The following enhancements have been made to the Submittal Log: 

• Checkbox added to group header rows, so the records could be selected in groups. 

• [Batch Edit] button added. When select all check box or Group checkbox is checked the 
Batch edit button becomes live. 

• Batch Edit functionality helps in group edit with update, clear form and start new session. 
Success or Failure message displayed. 
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Submittal Response: Set Default Status in Submittal Status 
Maintenance (21.39109- PM-1294) 

Two new columns have been added to the Submittal Status Maintenance screen. 

1) Class (Before it was shown only when adding a new status but now class is added as a 
column in the log) 
a) This will display the class associated with each status. 
b) Statuses should be grouped by class to better facilitate.  

 
2) I/O Response Default - The I/O Response Default column will allow users to set what the 

default status should be for a user responding to a Submittal I/O at the stage they are 
responding. 



740  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

a) Only one status should be selected per Class. 
b) Only these four special classes (Received, Sent, Reviewed and Forwarded) have this 

option. 
c) The Statuses are grouped alpha-numerically within their classes. 
d) Classes are arranged as follows (which follows the order of the review process): 

i. Received 
ii. Sent 
iii. Reviewed  
iv. Forwarded 
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Print Multiple Reports – Save Selection (20.33391) 

 

The previous selection in Print Multiple Reports is now successfully saved for future printing. 

Subcontract Change Order – Tax Field Read-only (20.33996) 

Field security for the Tax fields in the SOV of Subcontract Change Order is added. 

The default field security level for these fields is UNRESTRICTED on the *ALL* role. 

 

Example 
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Project Control - Populate Billing Amt from RFQ Tab (20.35351) 

• Added the flag “Populate Billing Amt from RFQ Tab” to Change Management tab of Company 
Control. When checked, this flag will Auto-populate Billing Amount from the RFQ.  

• Also added field security for the flag. 
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Punch List item Email Notification (21.38329) 

• Addition of Punch List Items Notification Row to System Contact, Project Contact, Role Default 
Email Notification Screens 
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Daily Journal – Labor -Trade LOV Added (20.33984) 

• Addition of Trade LOV in Labor Tab of Daily Journal.  

• Addition of Field Security for Trade in Labor Tab of Daily Journal 
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Field Security Screen Adjusted to Show Max Number of Records 
Possible (21.39123)  

 

The user interface on the field security screen now shows the maximum number of records possible 
dynamically based on the view port height. 

Subcontract – Contract Type field Placement Changes (21.40790) 

The Contract Type field is moved under Vendor and above Contract No.  This ensures the 
Subcontract number is created after selecting the vendor but it still can be overridden by the user 
before proceeding to the remaining fields and saving the record. 
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Project Maintenance – Field Security for Start Date and Bid 
Won/Lost Date (21.38098) 

 

Project Maintenance - field security added for Start Date and Bid Won/Lost Date has been added. 

Save Reminder (Mutation Observer) for RFI Changes (21.38442, PM-320) 

CMiC has created the Save Reminder (aka Mutation Observer) utility to monitor changes on a JSP 
page  

 that the user can be notified in case he leaves the page without saving the changes. 

This utility can be turned on by the PM System Options flag: ‘Save Record Reminder’: 

 
 

This is applicable for RFIs.  The message that will show if changes are made and the user tries to 
leave without saving is: 
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Self Service Prequalification Message Key for Federal Tax ID 
(21.39115) 

Subcontractor Prequalification - Self Service - Addition of message key to make the prompt for [Enter 
Federal Tax ID] changeable. 
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Contract Forecast (Kendo Version) as Menu Item (19.83741) 

Contract Forecast - Added the ability to run new version of Contract Forecast by adding new menu 
item  using Menu Maintenance:  add  

URL as   ../JcContractForecast1/?showKendoFcast=Y 

Target = Content Frame 

 

 
 

Added WBS Fields to Request for Payment Screen (21.41719) 

• Added WBS Fields as Read-Only in Request for Payment screen. 

• Added Field Security for WBS Fields with two options : Unrestricted and Read-Only 

• The values in WBS fields are passed from Subcontract screen to RFP screen.  
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Contract Forecasting - New column Profit Budget Amount (21.41947) 

New Column JCCF_CURR_PROFIT_BUDG_AMT - Profit Budget Amount - is added to JSP Contract 
Forecasting screen. 

Formula for the column is:  

JCCF_CURR_PROFIT_BUDG_AMT =  JCCF_CURR_BILL_BUDG_AMT – 
JCCF_CURR_COST_BUDG_AMT (Profit Budget Amount =  Current Bill Budget  -  Current Cost 
Budget 
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Meeting Minutes - Allow Users to Enter Notes and View/Edit History 
Before 'Start Meeting' (21.43089, PM-1558) 

Modifications have been made to allow users to enter Notes and View/Edit the meeting history 
(i.e.star or unstar any historical minutes) before starting a meeting. 
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Request for Payment - Added WBS Name columns to SOV (21.41399) 

WBS Name columns have been added to detail lines and the field security is set to Read-only on the 
*ALL* role. 

 

 

 

 

Download Multiple Documents At the Same Time (21.41087,PM-745) 

In the Document log, the user can now use the multi-select checkboxes to select one or more 
documents that they wish to download. Once the records are selected the [Download] button 
becomes enabled. 

There is also a choice to Include All Revisions. 

On Download the user gets a notification email and can download the documents for storage to a 
desired location. 
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Allow Removal of Attendees from an Active Meeting (21.42265, PM-1540) 
When a Meeting is in Active status, Meeting Attendees from the list of Required and Optional attendees can be removed so required and 

optional attendees can be more accurately reflected after the meeting has commenced. 

 

 
 

RFI - Current Responsible Partner Name and Contact Name Added 
(21.45014,PM-375) 

The Current Responsibility field now appears on the RFI screen.  The Current Responsibility Partner 
Name and Contact Name columns have been added to the RFI Log. 
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Drawings Upload - Implemented Location Code (20.28379, PM-794) 

 

CMiC has added a Location field (uses LOV) to the Drawing Sets Upload screen. 

Also: 

• added a tooltip to Location column (displays location description).  

• default size for file upload is set to 100MB if not provided at system/user level.  

• Sheet Number added to the DRAWMGMT log 
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• Location description is displayed on verification screen instead of Location Code 

• Changed prompt description from Trade to Discipline on verification screen 

 

• Location code is read-only in Edit mode now.  Added Location LOV in ADD mode. Introduced 
validation for location code. 

• Location code now are accepted in upper case only (including import functionality). 

• Sort order number column has been removed. 

• Added a Job Detail section to show the progress/ status of the Drawing Sets Upload job: 
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Checklist Enhancements continued (18.60270/PM-618/PM-1091/PM-1633) 

Added the General tab with necessary fields. (PM-1486, PM-1487, PM-1494) 

 

When assigning the checklist to a project, corresponding default issue type will be copied.  

Default contact is also added at project checklist, which can be accessed via general tab.  

 

 

CMiC added new static fields such as Created by, Created Date, Status and Submitted Date to 
bothchecklist template and project checklist. 

 
 

In the project checklist, sections that are inherited from the checklist template are modified to Read-
only (non-editable) and the Delete icon removed.  
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The Documents section has been added to checklist template and project checklist:  

 

 

• Documents of checklist template will be automatically copied to project checklist when it is 
assigned from checklist template. 

• Documents from checklist template inherited by project checklist cannot be edited or deleted 
(its buttons are hidden) whereas documents that are saved directly in project checklist will be 
as usual.  

 

 

• Checklist Maintenance enhancements - Active, Inactive tab included. Made changes in their 
log and view option; Reactivate icon is added to the menu in both Checklist Template as well 
in Project Checklist.  
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• for Project Checklist, Delete Question option is hidden for questions which are copied from 
Checklist Template. 

 
 

• Removed multi-select option and Assign button in inactive log screen. 
 

 
 

Action Item Notifications Continued (21.37638//PM-907) 

All Action Items created from Project Calendar will trigger an Action Item Notification. There is no 
control to turn On or Off these Notifications. 

All Action Items created from OM Action Items will trigger the Action Item Notification. There is no 
control to turn On or Off these Notifications. 
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Punch List Item - Added Create Date (21.43711/PM-1392/PM-1740) 

CMiC has added the Create Date to the Punch List Item entry screen and log. 

       

 

 
 

PCI Markups - Selective Markups for PCIs (21.40801 (PC-376) 

A new column ‘Markup’ has been added and the flag in the column is enabled by default. 
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When the Markup flag is enabled, only the selected lines will have a markup applied IF the job, cost 
code, and category satisfy the markup rules.  

Users can enable/disable the Markup flag before and after markups have been generated for the PCI. 
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Punch List Item/Submittal/RFI – Hide Reviewers Section (21.45884) 

A “Hide Reviewer Section” flag has been introduced in Project Roles – for each of the PM objects – 
RFI, Submittals, Punch List Item. 

When checked, the Reviewers section of the particular PM object will be hidden for the PM role that 
has the flag checked. 

 

 

     

Cost Code Template - Bid Item Entry and Add Phase ‘on the fly’ 
(20.21125) 

The following screens were modified to accommodate changes made to facilitate the use of Cost 
Code Templates in “Bid Item Entry” and “Add Phase/Category  on the fly” screens: 

PM System Options 

Added new flag option 'Apply Job template to cost codes in Bid item' under General tab.  When this 
flag is checked the Cost  Code Template feature for each screen takes   effect and are described 
further below.  

 

Add Phase/Category ‘on the fly’ 

Modifications were made to add a new Phase template field to filter Phase LOV based on template 

assigned against the job in the Job Entry – General tab in ADF.  If no template is there then it brings 
all phases including master phase. 

 

Bid Items 

Modifications were made in the Bid Items entry screen to filter phase LOV based on template flag 
from PM System Options. Also included validation for the template for the Bid Item Import. 
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Action item Adjustments (21.46291/PM-1685) 

When a Recurring Action Item is created, only the earliest one or the 1st action item will send the 
email notification, thereby avoiding receiving a large number of Action Item notifications all at once. 

 

 

 

 

Subcontract/RFP - Down Payment and Amortization (20.31609) 

New columns Deposit Amount, Deposit %, Amortization amount and Amortization % are added. 

Down Payment and Amortization - Added field security options for columns contract deposit amount, 
percentage for SC entry screen and current deposit amount, percentage for RFP screen 

 

    

 

Example with 1 SOV on Subcontract:  
 1. Posted Subcontract with one SOV and 10% retainage. a. Total Contract Amount: $70,000  
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 b. Total Deposit Amount is $3,600  

 c. Total Retainage is $7,000 (10% of Total Contract Amount)  
2. vendor submits RFP #1 for 25% of Original Contract Amount for SOV ($17,500). The following 
calculations are performed:  

• Deposit Amount (Amount posted in Accounts Payable as a Deposit against the  
 
Subcontract): Read only value displays $3,600  
• Amortization Amount (Amount of the Deposit not yet allocated to Invoices): 3,600 – Sum of all 
Amortization Amounts on posted RFPs  

• Amortization Amount (Amount of Deposit to be applied to the current Request for Payment): .25 * 
3,600 = $900  
• Net Payable Amount (Amount Payable on this Request for Payment after Retention ($1,750) and 
Deposit have been applied): 17,500 – 1750-900 = $14,850  
 3. Post the RFP. Standard posting routines apply. In our example, the net payment amount is 
$14,850 • Deposit Amount: Read only value displays $3,600  

 • Amortization Amount: $2,700 = 3,600 – 900 (Deposit Amount - sum of all Amortization 
Amounts on posted RFPs)  

 • Amortization Amount: $360 = .1 * 3,600 (Percent Complete value * Deposit Amount)  

 • Net Payable Amount: $5,940 = 7,000 – 360 (Current Amount – Applied Deposit Amount – 
Current Retainage Amount)  

1. Vendor enters a second RFP for 10% or $7,000.  
 

Calculations:  
Example with Multiple SOV on Subcontract:  

1. Posted Subcontract with 3 SOV and 10% Retainage: a. Total Contract Amount: $1,539,656.13  

i. SOV 1: $534,187.5 

ii. SOV 2: $335,156.13  

iii. SOV 3: $670,312.5  
 
b. Total Deposit Amount: $461,896.84  

i. SOV 1: $160,256.25  

ii. SOV 2: $100,546.84  

iii. SOV 3: $201,093.75  
 
 

• 2. Vendor enters RFP using Percent Complete in each SOV.  
                    a. Current Amount  
                         i. SOV 1: 15% = $80,128.13  
                   ii. SOV 2: 12% = $40,218.74  

                   iii. SOV 3: 20% = $134,062.5  

                   iv. 10% Retainage: $25,440.94 

   b. Deposit Amount Applied for each line: 

                    i. SOV 1: 15% = $24,038.44  

                    ii. SOV 2: 12% = $12,065.62  

          iii. SOV 3: 20% = $40,218.75  
 

   c. The Net Pay is Deposit Amount – Retainage – Amortization Amount   

                    i. SOV 1 = 80,128.13 - 8,012.81 - 24,038.44 = $48,076.88  

          ii. SOV 2 = 40,218.74 – 4,021.87 - 12,065.62 = $24,153.12  

          iii. SOV 3 = 134,062.5 – 13,406.25 - 40,218.75 = $80,437.50  

          iv. Net Pay for entire payment: $152,645.62  
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Menu Item Security/Privilege for New Checklist (Beta) Program 
(21.42556/PM-1571) 

A Menu Item Security/Privilege has been added for New Checklist (Beta) program. This privilege will 
determine whether a given user’s role has access to the new Checklist Execution screen.               

Meeting Minutes - Date, Time, Location Editable in Active Meeting 
(21.42266 /PM-1541) 

Location, Date and Time are editable while a meeting is Active. 
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Next meeting date should not change without approval. 

 
 

Added Field Security for WBS fields for PCI, SC and SCCO (21.42451) 

• Added Field Security for WBS Fields for PCI, SC and SCCO screens with three options: 
Unrestricted, Hidden and Read-Only. 
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Subcontract ID Generated on Saving (21.44825) 

In the Subcontract Entry screen when adding a subcontract, the logic has been changed to generate 
Subcontract ID ON SAVING a subcontract, when auto-numbering is in use, instead of after entering 
the Vendor (previously), to avoid the system trying to assign the same Subcontract ID to multiple 
users who might be in the Add Subcontract screen at the same time. 

 

Punch List Item Log Enhancements as Standard Log (21.39438/PM-1395) 

The following modifications have been made to the Punch List Items Log: 

• List of items removed: 

Welcome Message 
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Default Grouped by Punch List 

Color coding for Punch List Item Status 

Drawing Location Icon 

Share Feature 

• Batch Edit is completely modified by introducing a grid to trace updated records with/without 
errors, export chosen records.  

• Validations are added for batch edit fields (error messages) 

• Back To Log will direct to standard Punch List Item log 

 

 

 
 

• Added security privilege to Punch List Item log Edit and Delete buttons. 

• Edit button will only be enabled if User has Update All privilege for Punch List Items: 
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Contract Forecast – Cost Budget/Revenue Budget Posted PCI 
(21.45017) 

• Added columns JCCF_PCI_COST_BUDGET and JCCF_PCI_REVENUE_BUDGET. 

• Added field securities for new columns JCCF_PCI_COST_BUDGET and 
JCCF_PCI_REVENUE_BUDGET in forecast. 
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Subcontracts – Invoiced Amount Remaining Including Retainage 
(21.42169) 

 

Added new Column - SCMST_REMAIN_INV_INCL_RET_AMT to the Subcontract Log, which is the 
Invoiced Amount Remaining Including Retainage. 

It is calculated as: 

Remaining to be Invoiced Including Retainage =  (Contract amount – (RFP Gross Amount- Retainage 
Amount)). 

NOTE: This new column only considers Posted Invoices, unposted invoices are not included. 

Expose the Flag for Update with Latest Revision (21.40497) 

CMiC has exposed the PM System Options flag “View Latest Revision of Attachments by Default” by 
displaying it on the user interface screen.  In the database it is the field 
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da.PMSYS_UPDATE_WITH_LATEST_REV, and controls whether all revisions or only the latest 
revision of an attachment is shown in the Attachments tab of PM objects. 

NOTE: This setting (ON/OFF) only takes effect with new records that are created after it is changed 
(requiring a new browser session as well). 

 

 
 

Meeting Minutes - Allow Creation of Multiple Action Items 
(21.40919/PM-1296, PM-1297)  

Changes have been made to enable the creation of multiple Action Items for a single agenda item. 
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Also, changes include the carrying forward of Meeting Minute Action Items as well as the 
Responsibility, as long as the Agenda Item or Action item is still open. 

Action items created in the current meeting show as a blue link and the action item carried forward is 
shown with a green link (screenshots shown below). 

 
 

 
 

Security Role Flags to Limit Roles Selected in Gateway (21.41705) 

The following changes were made for this enhancement: 
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• Addition of an Internal Only Flag to the Role Maintenance screen to limit Roles selected in 
Gateway 

• P type user will only see external roles in role assignment. 

• Project Maintenance - Modified Gateway project and security roles not to show ‘Internal Only’ 
roles. 
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Reviewers Component Enhancements (21.44326) 

 

The following enhancements have been made to the Reviewers component in PM JSP (Punch List 
Item and RFI). 

• Cycle Number field and [New Cycle] button added. 

• Reviewers sequence validation – there must at least one other required reviewer between 
subsequent same reviewer. 

• A new cycle is created with the same reviewers set but new due dates 

• Ability to navigate between cycles 

• Previous cycles are not editable. 

• The same reviewers must have a different mandatory reviewer in between  

Self Service and Subcontractor Prequalification – Enhancements 
(21.38593) 

Enhancements have been made in both Subcontractor and Self Service Prequalification screen. 
Some items have been added/removed. 

Self Service Prequalification enhancements: 

Field Security has been added for the “Select All Regions” checkbox in the region section on Page 1. 
It can be made ‘Hidden’ or ‘Unrestricted’ in the Security > Role Maintenance screen (for the Prequal 
Self Service program). 
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• In ‘Financial Information’ section (page no. 4), changes have been made to default Fiscal Date to Dec 

31 vs Jan 31. 
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• A new button [Assign Classifiers] has been added to the Prequalifications Control screen next to 

[Checklist Maintenance] button. This button has been secured by Field Security 

(Hidden/Unrestricted). 

 
 

 
 
Clicking on the button displays ‘Assign Classifiers’ pop-up, in which six classifier columns have been added 
for ‘References’ section on Page 5. 
 
NOTE: CMiC Classifiers functionality does not support Drop-Down type and it can only be an LOV. 
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• In the Prequalifications Control screen, the ‘Self Service – Other Attachments’ drop-down list has 

been replaced with a Multiselect LOV pop-up. This pop-up determines which Document Types are 

available in the Document Type drop-down list in the Attachments section on page 6 of the Prequal 

form. The LOV has three checkboxes: 

1. Include (multiple Records - determines if the associated Document Type will show up in the 

drop-down list in the Attachments section on page 6 of the Prequal form. When unchecked the 

Required and Display by Default flags are disabled.) 

2. Required (determines if the Document Type is required for form submission. When checked 

Display by Default checkbox will be automatically checked and disabled.) 

3. Display by Default (ensures that a line in the Attachments section is shown by default with this 

Document Type pre-selected from the drop-down list, however, uploading a document of this type 

will be optional if the required flag is not checked.) 

On clicking the Accept button on the LOV, changes to both Financial Attachments (if any) and Other 
Attachments will be saved. The selected Document Types will be available in Attachments section on Page 6 
as Document Type drop-down list for each attachment. 
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NOTE:  For each Document Type (Financial and Other attachments) for which Display by Default flag is 
checked, one row will be created in the Attachments section with this Document Type pre-selected from the 
drop-down list. 

• If the Document Type is set as Required, the Required icon is displayed next to the Description 
prompt and all the existing logic for required attachments is applied. 

• If it's not required but set as [Display by Default] in Prequal Control then on page navigating and 
submission, a soft-warning message will remind users that they have not uploaded documents of this 
type and ask if they would like to return to the form before proceeding. 
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Radio options have been added for ‘Self Service – Financial Attachments’ which allow the user to   select: 

1. List Only 

2. Required (Display by Default) 

The Attachments section on Page 6 will display the default values (Rows can be added or removed as per 
requirement). Default value will be either the Attachment Type defined as Financial Attachments, if Financial 
Attachment checkbox is checked or [Other Attachments] default Type. 
 

 
 
Added row for each Display by Default Document Type. 
 

 

 

Added validation of required and display by default document types and to show warning messages or 
prevent form submission 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  781 

 
 
 

• Classifiers (Added in Assign Classifiers pop-up) have been added to SC Prequalification screen – 

References tab. 

 

Checklist Maintenance (Beta) – More Enhancements (18.60270) 

Action Item are now included in Checklist Maintenance (Beta) screen as shown below. 



782  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

                 

 

 

Clicking on the ‘Calendar’ icon displays the Action Item pop-up, where the user can create new action 
items or can edit or delete the existing action items. 

 

 

Clicking on ‘Create New Assignment’ gives the screen to add new Action Item.  

A new feature ‘Kendo multicolumn combo box’ has been added for Urgency dropdown. 

 

 

A particular Action Item can be assigned to multiple contacts. 
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User can create action items with or without recurrence and can Update them. 

 
 

 

After updating, the Calendar icon pop-up displays the list of all recurring and non-recurring Action 
Items. 

User has the ability to Edit it by selecting it and to Delete it by clicking on Delete icon. 
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The Action items (recurring / non-recurring) added in the Checklist maintenance screen appears on 
the Project Calendar screen. 

 
 

Checklist Maintenance (Beta) – Ongoing Enhancements (18.60270) 

Following enhancements have been made in Checklist Maintenance (Beta) screen: 

• A new PUSH functionality has been added for Global templates. It allows the user to assign the 
selected global templates to multiple projects. 
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• COPY functionality has been added for both Global and Local Templates. User can copy one or 
multiple templates (Global or Local).  
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• DELETE functionality has been added for both Global and Local templates. User can delete one or 
multiple checklists (Global and Local). 

NOTE: The checklist templates that do not have any child records get deleted by clicking on Delete. 
And the templates with child records become Inactive when user click on [Delete] button. These 
Inactive templates then appear in the “Inactive” tab for that project checklist. 

 

 

 

• Mass Archive functionality has been added for both Global and Local checklist templates. The 
archived records become inactive, and they appear in the ‘Inactive’ tab of the Checklist Template.  
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• Lock feature has been added to Project Checklist, after the Checklist record is Completed or 
Submitted. 
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➢ This feature is added to protect the data integrity of Submitted checklist records by restricting 
the users from editing project checklist templates once at least one record of the type has 
been saved/submitted (child record). 

➢ Once child records have been created for a given Project Checklist Template – then clicking 
on ‘Edit’ button in such a template will display a modal dialogue (as shown in the screenshot): 

 

 

 

➢ Click on [OK] in the dialogue box. User will be able to Edit the Project Checklist Template. 
Then click on [Save] and user will be presented with another modal dialogue: 
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➢ When user click on [Save & Archive] in the popup: 

 Then the original template becomes inactive. 

 Modified version of template will be saved as a Copy. 

 The Copy should inherit – Modified template configuration, Security settings, default issue 
contact and type, and all active assignments. 

                       

 

➢ When user click on [Save as Copy] in the popup: 
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 Then the original template will remain as-is. 

 The modified version will be saved as a copy. 

 Copy process should be same as above, except that the active assignments will not get 
copied (to avoid duplication – since the original template will still be active). 

                             

 

• New cloned section can now be deleted from Delete section menu in floating panel. 
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Notes - Project Checklists 

Current Delete Checklist Button in field security applies to the old functionality but will be modified to 
include the new Delete function currently under development. 

 

Reviewer Email Notifications (19.71811) 

Reviewer email notifications have been updated for Submittals and RFIs. The user contact must have 
‘CC’ checked for Submittal and RFI in Project Contact Directory screen ‘Email Notifications’ tab.  

The following enhancement have been made: 

o Non-mandatory reviewers receive email notification when they are added as reviewers. 
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o If a reviewer is mandatory (required) they receive notification when the previous mandatory 
reviewer has completed his action and they are the next responsible reviewer. 
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SCCO: Modification of Item Code on SCCO When Linked to Posted 
PCI (21.41307) 

New functionality has been added which allows the user to modify Item Code on Subcontract Change 
Order. The item code is created on a posted PCI’s detail line and carries forward when that PCI is 
linked to an unposted SCO.  

Points to keep in mind while testing: 

The modified item code on the SCO will not update the Task code on the PCI. 

Users cannot modify Item Code on posted SCO 

A new security privilege has been added that controls whether a user can modify the item code on an 
unposted SCO, IN Security > Role Maintenance > Select role and assign privileges screen. 

 
 
Example: 

1. Create a PCI with task code ‘PCI21.41307’ and post it. 

 
 

2. The posted PCI is added to an unposted subcontract change order (associated with the same SC 
used in the above PCI) using the [Add PCIs] button on the SCO screen. The item code is 
automatically populated with ‘PCI21.41307’ (carried forward from the PCI). 
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NOTE:  Users can modify all fields (Item code, Unit, Rate, Amount, Long Description, Main Asset, Sub Asset, 
Cost Type, Document) of the SOV except for JOB/PHASE/CATEGORY/WM. The modified fields do not 
update the PCI. Users will be allowed to insert new lines in the SOV additionally to the ones transferred from 
the PCI. 

 

 

 

3. In SCO screen, in edit mode – changed the item code from ‘PCI21.41307’ to ‘PCI-SCO-TEST-1’.   

             NOTE: Only users with security privilege can modify the item code. 
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4. The modified item code in SCO screen does not update the PCI Detail line Task ID. 

 

Request for Documents (20.32911) 

The Request for Documents program has been developed to extract project documents as part of 
Project Closeout procedures. 

The program has been added under Document Management node in the tree-view. 

Access to it based on the user’s role and Assign Programs and Assign Menu Items privileges. 
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Features of the Program: 

Precondition: 

Upload a drawing and publish. The dates used in drawing upload will be used in Date type filter while 
creating the Request for Documents. 

 

• The user can create a Request by selecting different filters and parameters from the screen 
and schedule job which extracts the documents matching the filter criteria. 
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A request can have different statuses and they are each outlined below. 

[Pending]: As soon as user creates a new request, its status is marked as Pending. In this state user 
can Schedule or Cancel the request.  
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[Scheduled]: All pending requests can be Scheduled to start extraction process. As Schedule button 
is clicked the job scheduler creates a new job for this request and status would be changed to In 
Progress.  

 

NOTE: The status may remain Scheduled as job scheduler (CmicScheduler) may take some time 
(few seconds) to start the job execution if it is available. If the job scheduler is not available, its status 
would remain Scheduled until job scheduler is available and picks up the job to extract documents. 

 

 

[In Progress]:  As soon as the document extraction job is started, an email is sent to the user saying, 
“Your request has been accepted and in progress”. User will be notified as it gets completed with 
download link. 
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[Completed]: The document extraction process is completed, and user would receive email with the 
link to download the zip file of the documents.  

NOTE:  The download link will be available for 14 days. If user hits the link in the email, it may not 
work as some extra characters being inserted by Outlook on the hyperlinks for security, in that case 
user may copy the link and paste into the new window on browser. 
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[Failed]:  There has been an error while job is executing, in this case user would receive an email for 
job failure. 
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NOTE:  When user does not add appropriate data in the Request screen – user will receive the 
document extraction email followed by “No documents found” email. 

 

 

• User can edit existing Request parameters and save them back. 

• The user can perform search by entering keyword in search box being provided on grid. e.g. 
"req-8".  

 

 

• Filtering and Sorting options have been provided on the grid. 
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• Three buttons have been added on Request logs: 

[Create New Request for Documents]: User can create new requests and select parameters/filters 
to extract documents.  

[Refresh Logs]: User can refresh the grid to view the latest of all Requests. 

[Export to Excel]: To download all requests in xlxs file. 
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A few enhancements have been made in RFD screen: 

• RFD job has been modified to allow Null Status in request. 

 

• RFD job has been modified to allow multiple Created By users. 

 

• Field Security (Unrestricted and Read-Only) has been added on “Link Active Days” and 
“Downloads” fields. 
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• Annotations added on the Drawing document will now be visible on the extracted document, 
after the Request has been Completed. 

 

Steps followed: 

➢ Uploaded a drawing in Drawing Management (ECM) and added an annotation to it. 

➢ Published the annotation and linked a PM Object to it. 

➢ Created a new Request to extract the uploaded Drawing document. 

➢ Received email notifications for processing and download archive. 

➢ Downloaded the archive from the link or button in the email. 

➢ Opened the downloaded document. 

➢ It displays the annotation that was added to the drawing document in Drawing Management. 

➢ Click on the link – it opens the related object linked to the annotation. 
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Location Added to Punch List Item Import (21.47354) 

New functionality has been added in Punch List Items Import. A new column ‘Locations’ has been 
added in the .ctl file for importing Punch List Items.  

NOTE:  The Locations can be added in File Maintenance > Local Tables > Locations Maintenance 
screen. 

In the Import pop-up user has an option to validate the values being imported. During the import 
process user will get an option to see the values and to add the new location code. 
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Example: 

Click on [Import] button in the Punch Lists log screen. 

 

Select the file to be imported and click on [Upload]. 

 

Validation screen appears. In this screen, select the values in Location field from the LOV and click 
[Re-Validate] and [Accept]. 
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Refresh the Punch List Items log screen and the imported items with Location code appear in the log 
screen. 

 

 

 

Open a record to verify if the ‘Location Code’ field displays the correct value. 

 
 

Punch List Items Trade Type Maintenance (21.48888) 

A new column: ‘Description’ has been added in Trade Type Maintenance screen. User can drill down 
into this column’s value and can add multiple sub-descriptions to a particular Trade Type. 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  811 

 

 

Clicking on the description value link opens a small window to add and save sub descriptions. 

 
 

 
 

NOTE:  For a Trade Type record, Description field value appears ‘0’ when no sub-description is 
added. This value changes based on the number of sub-descriptions added to it. E.g. if 2 sub-
descriptions are added, ‘Description’ column will show ‘2’. 
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Show Related Annotation Documents (21.48954/PM-1760) 

Enhanced the Related Objects pop-up to display both Related Objects and Documents.  

Additionally, some changes have been made in the Related Objects pop-up: 

o [Assign Objects] button have been removed from the header bar 

o Action icon (Delete) has been removed. 

 

Outline 

Open Documents > Drawing Management document type. 

 

 

Open an existing recently updated Drawing record or upload new drawing set for testing. 

 

In the record detail screen, click on the latest revision’s file name. It opens the drawing in PSPDF 
Viewer. 
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Add annotations to the drawing and link them to PM Objects and Documents. 

 

After saving the annotations, click on the download icon for the same drawing to download its pdf. 
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In the PDF, click on the annotation to which PM Objects were linked. 

 

 

Clicking on the annotation displays the Related Objects pop-up, in which all the PM Objects and 
Documents linked to the annotation appears. 

NOTE:  In the Related Objects pop-up, [Assign Objects] button and Delete Action icon have been 
removed. 
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Drawing Sheets Upload – More Extraction Enhancements (21.50002)  

An enhancement has been done in Drawing Upload screen to allow the user to adjust the size of the 
Extraction Region box. 

The rectangle annotation resize grab handles have been enabled, which gives the user full control of 
adjusting the extraction region box’s size and placement. 

When the user confirms the selection, the annotation gets locked, so that user can focus on next 
annotation. 

 
 

SC SOV Import – Modified to support WBS Codes (21.46108) 

The SC SOV Import Schedule has been modified to support WBS Codes Import functionality on 
Subcontract SOV lines.  A new import file has been provided for the user which allows the user to 
import WBS Codes on Subcontract SOV. 

Import file layout  (pmscsov.ctl) 

fields terminated by "," optionally enclosed by '"' 
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  pmsovi_task_code         varchar2(16) 

 ,pmsovi_task_name         varchar2(200) 

 ,pmsovi_unit              number 

 ,pmsovi_wm_code           varchar2(2) 

 ,pmsovi_unit_rate         number 

 ,pmsovi_amt               number 

 ,pmsovi_job_code          varchar2(10) 

 ,pmsovi_phs_code          varchar2(16) 

 ,pmsovi_cat_code          varchar2(16) 

 ,pmsovi_jb_bill_code      varchar2(50) 

 ,pmsovi_tax1_code         varchar2(11) 

 ,pmsovi_tax1_taxable_flag varchar2(1)    'Y/N' 

 ,pmsovi_tax2_code         varchar2(11) 

 ,pmsovi_tax2_taxable_flag varchar2(1)    'Y/N' 

 ,pmsovi_tax3_code         varchar2(11) 

 ,pmsovi_tax3_taxable_flag varchar2(1)    'Y/N' 

 ,pmsovi_hldbk_pct         number 

 ,pmsovi_apexp_code        varchar2(10) 

 ,pmsovi_long_desc         varchar2(2000) 

 ,pmsovi_wbsv_code1        varchar2(60) 

 ,pmsovi_wbsv_code2        varchar2(60) 

 ,pmsovi_wbsv_code3        varchar2(60) 

 ,pmsovi_wbsv_code4        varchar2(60) 

 

Import Process Outline 

Opened an unposted subcontract. 
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In Edit mode, clicked on [Import Schedule] button. SC SOV Import Schedule pop-up appears. Select 
the import .exe file and click on [Upload]. 

 

 

The SC SOV Import Validation screen appears. In this screen review the error and warning 
messages and click on [Accept Valid]. 

 

 

The SOV lines with WBS Codes are getting imported successfully. 
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Submittal Logs – New Columns Added (20.33745) 

The following new columns have been added in Submittal logs: 

o Return Review Lead Time 

o Return Review Start Date 

o Return Review End Date 

o Current Return Review Start Date 

o Current Return Review End Date 

o Record Status 

The user can Add/Remove these columns with the Log Builder.  

Subcontract Change Order - Added GCS Pay Request Flag (19.86283) 

Subcontract Change Order - Added GCS Pay Request flag to the screen to indicate that the change 
order can be processed through GCS for payment: 
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IO Email Template Customizations (21.48278, PM-352) 

A new look email has been designed for outbound I/Os. 

 

Cost Status Query Enhancement - Added PCI Description to PCI 
Transactions popup (21.44330) 

Added PCI Description to the PCI pop-up window in the Cost Status Query and Budget Status Query 
(category and non-category). 
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Cost status Query 

Internal and Transfer CO 

External CO,  

Pending CO, 

Prepending CO 

Proceeding Projected, 

Non-Proceeding CO 

 

Cost Status Query (Category) 

Internal and Transfer CO 

External CO,  

Pending CO, 

Prepending CO 

Proceeding Projected, 

Non-Proceeding CO 

Budget status Query 

Internal and Transfer CO 

External CO,  

Pending CO, 

Prepending CO 

 

Budget Status Query (Category) 

Internal and Transfer CO 

External CO,  

Pending CO, 

Prepending CO 
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Contract Forecast – Added Group Code columns to Configure view 
and Forecast screen (21.42765) 

An enhancement has been made in Contract Forecast screen. 5 Group Code columns have been 
added to the Configure View and Contract Forecast screens. 
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When the ‘visible’ checkbox for all 5 Group Codes is checked in Configure view screen and [Save] is 
clicked; then the Forecast screen refreshes and displays the new added Group Code columns. 

 

 

Contract Forecast – Changed the Formula for Cost to Complete 
(21.51712) 

The formula for ‘Cost to Complete’ in Contract Forecast has been changed. 

Now, Cost to Complete (CTC) = Projected Cost Forecast – Spent/Committed (In scope). 

NOTE: This formula should work when the CTC is overridden; and when the overrides are cleared. 
The Cost to Complete column value should always reflect the subtraction of Project Cost Forecast 
and Spent/Committed (In scope). 
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Subcontract Prequalification – Added Currency field to 1st 
Financial tab of Subcontractor Prequal and Page 4 of Self Service 
Prequal (22.52898, CF-661, CF-662) 

A new field “Currency” has been added to the 1st Financial tab of Subcontractor Prequalification and 
to Page 4 of Self Service Prequal (‘Financial Information’ section). 
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Subcontractor Prequalification – Added Calculation for Single and 
Aggregate Award Limits (22.55253, CF-1060, CF-1076, CF-737) 

A new flag “Default Project Limits Based on Working Capital Ratio” has been added to 
Prequalification Control screen. 

  

 

When this flag is checked (Y), then ‘Aggregate Project Limit’ and ‘Single Project Limit’ fields will 
default as 2x the value from the ‘Working Capital’ field (This field is in Financials tab – Contractor 
Prequalification screen). 

These default values can be overridden by the user, who have access to the field. 

The default values will get re-calculated (clearing any overrides) in case the Financial values are 
updated. 
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NOTE: When an applicant submits their questionnaire the Single and Aggregate Project Limits would 
calculate as 2x working capital. This will be a one-time calculation per applicant, per renewal period. 
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PCI Entry – Added ‘Allow Cost’ flag to PCI header (21.38030) 

A new flag 'Allow Cost' has been added to the PCI header in PCI Entry screen. This flag gets default 
value based on Allow Cost flag from relevant PCI Type on Maintain PCI Types setup.  

Field Security of ‘Unrestricted’, ‘Read-Only’ and ‘Hidden’ has been provided for the Allow Cost flag in 
PCI Entry screen.  

 

The Allow Cost flag, on PCI Entry screen, gets default value from the PCI Type setup: 
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NOTE: The new flag is editable for the unposted and posted PCIs. When unchecked, the PCI does 
not appear for selection in cost transaction screens, MCT, Crew timesheets, Imaging, JC transaction, 
etc. 

When a PCI is created and is unposted, if the user changes the PCI Type, the ‘Allow Costs’ flag 
defaults the value for the updated PCI Type from the PCI Type setup screen in ADF. 
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This flag is enabled for unposted and posted PCIs on PCI entry screen and can be updated when 
needed. 

 

Unposted PCI: 

 

 

Posted PCI: 
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When the Allow Cost flag is unchecked, the PCI will not show in LOV on relevant screens. 

Below is an example from JC Cost Transaction Entry screen: 

 

 

The relevant LOV is not showing the posted PCI because Allow Cost is unchecked for it, as shown in 
the previous screen shots. 

NOTE: In the Enter Cost Transaction screen – WBS Code column associated with PCI will become 
enabled only when user selects the phase and category for the Transaction detail line, same as the 
created PCI’s phase and category. 

 

 

 

NOTE: Value of ‘Allow Cost’ flag in PCI Setup entry screen will not impact the PCI’s availability in the 
relevant LOVs. For the example in above screenshot – the PCI will not be visible even when Allow 
Cost flag is checked on the PCI Type setup screen. 
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Now, when Allow Cost flag is saved as checked on the PCI, this PCI becomes available in the cost 
transaction entry screen’s (and other relevant programs) LOV, irrespective of the setup’s flag value, 
as shown below. 

 

 

 

If the Allow Cost flag is changed to unchecked in the relevant setup and saved, even then the PCI will 
continue to be available in the relevant cost transaction entry LOVs, unless the Allow Cost flag is 
changed to Unchecked on the PCI entry screen, as shown below: 
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The setup’s Allow Cost flag is changed to Unchecked, but the PCI still shows in the cost transaction 
entry screen’s LOV: 

 

I/O Email - Added Option to Share Large Attachments via Download 
Link (22.54468/CF-228) 

The option to share large attachments with a download link is available when sending large       
attachments via IO Email, instead of attaching the files to the email. 

• Added new field prompt and checkbox “Share via download link” to IO Email pop-up 
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➢ When checked- it includes a link(s) to download the selected attachments in the body of the IO Email.  
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➢ When unchecked - the IO email will be sent as a file(s) (no change) 
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• Download links expiration date will be set based on Project System Options> Maximum Download 
Link Expiration (days) field.  

       NOTE: The Maximum Download Link Expiration (days) value must be an integer greater than 
or equal to 1. 

 

➢ If “Maximum Download Link Expiration(days) is 1 or above 
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➢ If “Maximum Download Link Expiration(days) is invalid 
 

 

Project System Options - Added a New Drop-down List on General 
Tab (22.55773) 

• Added a new drop-down list on General page (Project System Options) for user to set up 
default issue priority. 

• A tooltip in General page for default issue priority. 

• Added a new column to default issue priority 
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Submittal Package - Added Prepared By Column (22.53671) 

• Added an additional column in the Submittal multi-select LOV with the “Prepared By” 
partner organization displayed - to facilitate the selection of the intended submittals.  

• Search bar at the top of this LOV hits the “Prepared By” field when filtering - to allow 
users to search by the partner who prepared the submittal. 
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Submittal - Added Procurement Log dates to Submittal Log 
(22.52604/CF-26) 

Added Fabricated Date, Delivered Date and Arrived Onsite Date columns to the Log Builder for the 
Submittals object: 

 

https://cmic.atlassian.net/browse/CF-26
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RFIs - Schedule Impact & Cost Impact Fields to Default to the Value 
"NO" (21.52335/CF-137)  

RFIs - during the creation process - Schedule impact & Cost impact fields to default to the value "NO"  

User just need to change messages like below, in Prompt Maintenance: 

pmscrfi.impact.option1.code = N 

pmscrfi.impact.option1.desc = No 

pmscrfi.impact.option2.code = P 

pmscrfi.impact.option2.desc = Potentially 

pmscrfi.impact.option3.code = Y 

pmscrfi.impact.option3.desc = Yes 
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Meeting Minutes - Confirmation Pop-up before Deleting Meeting 
Topic (21.51912/CF-122) 

• Meeting Minutes Click “Delete” topic button, shows confirmation popups saying “The 
Meeting Topic will be deleted. Do you want to continue?”, click “OK”, the topic removed 
from the screen, after save, it is also removed from database. click “Cancel”, nothing 
changed in screen and database. 
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Subcontracts - Field Security for Deposit Amount Remaining 
(21.50894) 

Field Security to hide Deposit Amount Remaining has been added. 
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Submittals - Response Block Brought Back for GC and Owner 
Modes (21.50200) 

The Response block has been brought back to Submittal for both GC and Owner modes. It is 
controlled by field security (Un-restricted, Read-only, Hidden) with hidden as default. 
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Submittal/RFI – Added Submitted, Returned, Closed Dates to Log 
(21.50071) 

RFIs 

• Added field to record [Date_Record_Closed] 

• added field [Date_Record_Closed] to log builder for "Request For Information" log view 
 
Submittals 

• added field to record [Date_Record_Submitted] *New* related to custom 

• added field to record [Date_Record_Closed] 

• added field [Date_Record_Closed] to log builder for "Submittal" log view 
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RFI - Option to Copy Related Objects to Forward RFI (21.45536) 

Added "Copy Related Objects" option to Forward RFI popup window. 
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• Add "Copy Related Objects" option to Update Ref. RFI popup window which is available for the 
forwarded RFI. 

 

PCI Markup Rules - New Rounding Options; Removed References 
to Dollar (21.42130) 

Maintain PCI Markup Rules screen will now include the following Rounding rule/options while setting 
up the markup rule: 

• No Rounding 

• Round to Nearest .01 

• Round to Nearest 1 

• Round to Nearest 10 

• Round to Nearest 100 

• Round to Nearest 1,000 

• Round to Nearest 10,000 

• Round to Nearest 100,000 
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• Round to Nearest 1,000,000 

 

 

 

PCI - Added Vendor Name Column to RFQ Tab (21.38805)  

Now Vendor Name also populates in the RFQ tab.  
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Project Gateway Contact - Added Radio Button on Multi-user LOV 
to filter P Type users only (21.47711) 

• Project Gateway Contact LOV -Added radio button on Multiuser LOV to filter P Type 
users only. 
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Trade Maintenance – Modified Company Level Prompts (22.54467) 

Modified Title and Column names in Company level Trade Maintenance page.  

Below are the changes made :  

1. Trade Type Maintenance → Trade Maintenance 

2. Type Code → Trade Stamp 

3. Type Description → Trade Name 

 

Restricted the Trade Stamp field up to 4 characters. 

 

File maintenance > Local Tables > Trade Maintenance 

System Contact User Defaults – Added New Field Locale 
(Language) (22.53123) 

New field Locale(Language) is added to System Contact User Defaults. The default language for 
prompts for the users can be defined in JSPs through this field. 
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Documents - Locking/Unlocking Mechanism (22.55559) 

Modified the screens to Lock and Unlock the document and added drop zone based implementation 
for uploading the document.  

Added field security for Lock Button, Unlock Button, Checkin Button and Checkout button. Field 
Security has two options : Unrestricted and Hidden.  

 

 

1. [Lock Document]  

This will only Lock the Document without Downloading the document. 

 

 

2. [Unlock Document] 

This will unlock the document without checking in a document 
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3. [Checkin Document] 

This will bring up a pop-up as shown below, providing option to Unlock document and Check 
in/Upload a new revision . 

 

 

4. [Checkout Document]  

This will bring up a pop-up as shown below, providing option to Lock and Checkout/Download a 
document. 
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Checklist Maintenance Template, Project Checklists (22.60875,CF-2265) 

Changes have been applied to the JSP Checklist Maintenance (Beta) program and the Checklist 
(Beta) item (which is applicable only for Mobile) to remove the word "Beta" from them.  

The Checklist Maintenance (Beta) is now Checklist Maintenance Template and Checklist (Beta) is 
now Project Checklists: 
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DocuSign 

Project Maintenance – Added flag 'Use System Contacts for 
Contact Selection' (20.30678) 

CMiC has added the  flag 'Use System Contacts for Contact Selection' to Esign Maintenance tab in 
Project Maintenance per Objec t Type as  well as the [Defaults] popup screen for Esign defaults by 
PM Object. 

 
 

 

When the new flag is checked, it allows the user to select from System Contacts thus the Company 
field is displayed in the Esign tab of the defined object so that the user can select the Company and 
Contacts to whom the documents must be sent.  When the flag is not checked, only the Contact can 
be selected (for Project Contacts), as per the original implementation. 

 

IMPORTANT NOTE: 
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By default, Project Contacts are used (the same as the flag being unchecked), unless the document 
being sent is not associated with a project, for example, with Subcontractor Prequalification objects.   

In this case the flag can only be set for System Contacts by doing so in the database, not from any 
existing user interface. 

 

E-Time 

E-Time: Addition of the Hint Line for Job, Cost Code and Category 
fields (16.15684) 

CMiC added a Hint line for Job, Phase Code and Category fields on E-Time Entry screen and on the 
Timesheet Approval screen. 
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Addition of a new button “Workflow Audit” to the E-Time Entry for 
each line (16.18390) 

CMiC modified an e-timesheet entry screen to add a new BUTTON for each timesheet entry line. The 
button is enabled only when user has activated a work flow on e-timesheet. The new button is labeled 
as 'Work Flow Audit'. The button opens a new popup window to display the work flow audit history for 
each individual line. The new popup window will run in view only mode only.  

 

1 In order to see a new button, user has to submit e-timesheet entry. 

 

2 When user clicks the [Show List] button, the new popup window opens with the 
information about the work flow actions regarding the e-time entry.  
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3 On the Workflow-> Notification List screen, in the left block of the screen, there is a 
workflow notification displayed asking to approve the timesheet line for specific 
employee, pay run and pay period. 

 

 

4 In the right block, user can review Timesheet Line Details, Audit History, Link to Approval 
Screen and some other details related to the timesheet. User is allowed to Approve, 
Reject and Reassign submitted timesheet to another approver.  
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5 After user approves the timesheet, the status of the workflow notification is changed.  

 

User selects the notification and clicks Submit in order to submit the changes done for this particular 
timesheet entry. 
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Modifications to Crew Timesheet Entry Screen. (16.28211) 

CMiC has made the following modifications to the 'Crew Timesheet Entry' screen and program. 

The Total field and columns have been moved from right to left side panel beside the employee 
information. The entire Left side section is frozen. The Crew Timesheet detail section is converted 
into two frames: Employee Entry and Timesheet Entry 

The Timesheet Entry section has scroll bar down below. 

The Employee Entry section will always be static. 

First and Last Record buttons are added to the Crew Timesheet Entry screen. The new arrows will 
be added to allow users to move to the first and last columns. 

Added [Allow Multiple Employee] selections for deleting/removing employee(s). 

Existing ‘Delete’ icon is replaced with the checkbox to allow users to select one or many employees 
and delete multiple records. Currently, we have ‘X’ icon to delete one employee timesheet at a time. 

[Copy Timesheet] button has been added to copy timesheet from previous day.  

Crew Timesheet Entry Screen 

The Total field and columns have been moved from right to left side panel beside the employee 
information. The entire Left side section is frozen. The Crew Timesheet detail section is converted 
into two frames: Employee Entry and Timesheet Entry. 

 

The Timesheet Entry section has scroll bar down below. 

The Employee Entry section will always be static. 
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First and Last Record buttons are added to the Crew Timesheet Entry screen. The new arrows are 
added to allow users to move to the first and last columns. 
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Existing ‘Delete’ icon is replaced with the checkbox to allow users to select one or many employees 
and delete multiple records. Currently, we have ‘X’ icon to delete one employee timesheet at a time. 

Added ‘Allow Multiple Employee’ selections for deleting/removing employee(s). 
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[Copy Timesheet] button has been added to copy timesheet from previous day.  

Enter Job, Date and Crew Code. User can type a new crew code or the same crew code. Select 
[Refresh] button to load a blank Crew Timesheet.  

 

Note: [Copy Timesheet] buttons is only enabled and appears if the Crew Timesheet is empty. 
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Select [Copy Timesheet] to copy previous existing timesheets. A popup opens for the user to select 
and copy previous crew timesheets. 
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Timesheet from 207-03-16 is copied. 
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Save Timesheet and Submit for Approval 

 

Crew Timehseet Approval Screen 
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Responsible Person Search Filter in Crew Time Approval (21.46333) 
 

Added search filter field for responsible person to E-Time Crew Timesheet approval program.  

Responsible person is assigned to each crew in the Crew Time Mobile App.  

Added a column Responsibility LOV in header filters.   
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E Time Access Code - Email Notification and Setups (21.50017) 

Overview 

This document provides an overview of how the email address fields are used in the Access Code 
screen in E-Time. 

Access Code 

 

Access Code Screen in Log View (Table Mode) 

 

Access Code Screen in Record View (Form Mode) 

The Access Code screen is used for setting up access codes and specifying timesheet/expense 
approvers and unapprovers for those access codes.  
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There are two types of access codes: Personal and Group. The type of access code used in this 
example is “Personal”.   

For Personal access codes, the password is not used as users will be automatically logged-in based 
on their SSO user, so users are not able to update or modify the password, the employee number nor 
the SSO User. For Group access codes, the password and SSO User can be updated if required. 

Access Code Detail 

The Access Code Detail section of the screen contains two categories for email addresses: 

• Use Direct Access Code Emails 

• Use Employee Profile Emails 

Use Direct Access Code Emails 

This section of the screen is used to manually enter email addresses for the user of that access code 
and for the approver of that access code. We do not recommend to use this option, as this would 
overwrite the emails used with these “hard-coded” ones instead of using them from the employees 
themselves based on employee profile. 

Timesheet Approver Email 

The email address entered here will be the one used for approving the timesheets for this 
access code. If this field is left blank, the email address used will be the one from the employee 
profile (specifically the read-only field Timesheet/Expense Approver Email) 

Email For Unapproved Timesheets/Expense 

The email address entered here will be the one used if a timesheet for this access code is 
unapproved by the approver. If this field is left blank, the email address used will be the one from 
the employee profile (specifically the read-only field Timesheet/Expense Unapprover Email) 

Expense Approver Email 

The email address entered here will be one used for approving the expenses for this access 
code (based on the access codes security groups). If this field is left blank, the email address 
used will be the one from the employee profile (specifically the read-only field 
Timesheet/Expense Approver Email). 

Use Employee Profile Emails (Based on Access Code Approver) 

When email addresses are not manually entered (hardcoded) in the Use Direct Access Code Emails 
section of the screen, the email addresses shown in this section will be used. This is the 
recommended setting. 

Timesheet/Expense Approver Email 

This email is based on the first approver of the access code, which is set-up in the Approver’s tab of 
the Access Code Administration screen. For this approver’s access code, the email of the employee 
linked to it (as personal access code) will be taken. Also, the email to be taken from the employee 
could be either work email or personal email based on a company control flag. 
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Timesheet/Expense Unapprover Email 

This email is based on the employee that is assigned to this very same access code (as it is a 
personal access code), Also, the email to be taken from the employee could be either work email or 
personal email based on a company control flag. 

 

 

Access Code Administration Screen 

 

Company Control Screen 
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Added Checklist Programs to E – Time (21.51397/HCM-447) 

Overview 

Checklists provide a way to ask foremen and crew members a series of questions prior to timesheet 
sign-off. This feature can be used to ensure that proper safety procedures have been followed on the 
job site. 

Adding Checklist Programs to E-Time 

Users should add the Check List Maintenance and Crew Check List programs to both the E-Time role 
and their own personal user role in the Security Roles screen. Examples are shown below. 

 

 

After adding these programs they should appear in the E-Time menu, as shown below. 

https://docs.cmicglobal.com/portal/Content/E_Reference_Material/CMiC_Field/Reference/Security/Security_Roles.htm
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Creating Checklists 

Basic information about setting up checklists can be found at Checklist Maintenance (Beta). The 
process for creating checklists is much the same for the Field and E-Time applications. However, 
there are some key features specific to the E-Time version which this article covers below. 

Upon creating a new checklist template in E-Time, the below screen appears. 

 

Category Code 

Select from the following options: 

https://docs.cmicglobal.com/portal/Content/E_Reference_Material/CMiC_Field/Reference/File_Maintenance/Local_Tables/Checklist_Maintenance__Beta_.htm
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Benefit/Deduction Checklist: used for signing off on benefits and deductions. 

Crew Checklist: available for any crew member when signing off. 

Employee Sign-off Checklist: available for employees when signing off. 

Foremen Checklist: available for foremen during the sign-off process. 

Employee Console 

Modifications to Employee Salary Maintenance Screen (16.21517) 

CMiC has made the following modifications to the 'Employee Salary Maintenance' screen and 
program. 

The New and Modified fields and labels on the screen are as under:  

Employee Salary Maintenance Screen 

Effective Date: ‘Raise Date’ is renamed to ‘Effective Date’. Enter/Select to specify the effective date 
when the change is to take effect. The Details section will reflect this change and display the field as 
Effective Date for the Salary changes. 

Position: This field is modified to display the selected Trade Code and the full description. Selected 
position will now display the full Trade description, enabling the users to view the employee(s) title not 
just the trade code. 

Salary: Displays employee’s current salary. The field is modified to display two decimals and a $ 
sign. The Details section will display the $ sign with the two decimals.  

Merit %: Enter Merit percentage amount. Modified field to display two decimals and a percentage % 
sign. If user did not enter amount with a decimal, then in the Details section the amount will be 
displayed with two decimals. 

 
Promotion %: New field/column labelled as ‘Promotion’ with a ‘%’ sign is added to the screen.  
Enter Promotion percentage amount. The Promotion field follows Merit and is included in Total Raise 
calculation. This field allows users to enter ‘Promotion’ percentage. The calculated percentage will 
include the new amount in the total increase. The input allows two decimals. In the Details section, 
amount will reflect and display two decimals. 
 
New Salary/New Rate: This field is labelled based on the employee type. For salaried employees the 
field will display the label as New Salary. For hourly employees the field label will display New Rate. 
The New Salary or New Rate amount is displayed and calculated based on the Cola, Merit, 
Promotion and Total Raise percentage. Modified New Salary field is to calculate by rounding in 
increment of $100 with two decimals added to the field. The Details section is changed to display a $ 
sign and two decimals. Increment of $100 is only applicable to Salary Type employees and NOT 
Hourly.  
(Example: $177091.2 = $177100.00) 
 
Total Raise: Modified field to increase Total Raise calculation in $100 increments with ‘$’ sign and 
two decimal places added to the field. This is calculated field that populates the total increased 
amount (total raise) based on the percentages entered in Cola, Merit and Promotion fields. Total 
Raise calculation is increased in $100 increments with a $ sign and two decimals. The Details section 
is also changed to reflect this modification. (Example: 1046.10 = $1100.00) 
 
Bonus %: Renamed ‘Bonus Particpation’ field to ‘Bonus%’ to enter bonus percentage amount. Bonus 
field now has a two decimals. NOTE: The input allows two decimals. The details section is changed 
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to display the % symbol and two decimals. Bonus percentage is only for reference and reporting 
purposes. Bonus percentage amount is NOT included in the calculation of New Salary and Total 
Raise. 

Payroll Date: New field/column labelled as ‘Payroll Date’ is added to the screen to allow users to 
enter the Payroll Effective date for reference only. User can Enter/Select to specify the Payroll Date 
for references only. 

To request a salary change for an employee, click the [Add] button along the top-right of the screen.  
The screen to enter the fields for a salary change will be displayed, as shown in the screenshot 
below. 

 

 
 

Enter the Effective Date field to specify when this change is to take effect.  Next, use either the 
Cola%, Merit% or Promotion% field (or all) to specify a percentage to increase the salary by. The 
New Salary field will display the new salary based after the previous fields have lost focus.   

 

 
 

After tabbing or clicking away from these fields, the New Salary field will display the new calculated 
salary amount respectively. The Total Raise field will be populated with the total amount increased 
based on the percentages entered in Cola, Merit and Promotion. The New Salary or New Rate 
amount is displayed and calculated based on the Cola, Merit, Promotion and Total Raise percentage.  

 
New Salary field is to calculate by rounding in increment of $100 with two decimals added to the field. 

 
Total Raise calculation is increased in $100 increments. 
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The Promotion % field follows Cola% and Merit% fields and is included in Total Raise calculation. 
This field allows users to enter ‘Promotion’ percentage. The calculated percentage will include the 
new amount in the total increase. 
 

 
 

When finished, click the [Save] button, along the top of the screen. 
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In the Details section, Cola%, Merit%, Promotion% and Total Raise% amounts are displayed with 
correct decimal points and values as input. Total Raise has incremented to $100.  

 
To apply the salary change directly to the system, click the [Apply Payroll] button. This action will 
apply the salary change made on the Employee Salary Maintenance screen on the effective date 
creating an Employee History record in Payroll. 

 
To delete the record and changes made on the Employee Salary Maintenance Screen, click the 
[Delete] button, highlighted above. 

 
 

 
 
 

History Log Tab – Displaying History 

 
 

New enhanced ‘Employee Bonus History’ and addition of 
‘Employee Bonus Payment’ program (16.25454) 

Overview: CMiC has made the following modifications to Employee Bonus History Program to 
enhance the functionality and processing order in HCM JSP.  
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HR Benefit Master Maintenance: Created a new JSP screen named HR Benefit Master 
Maintenance under HCM File Maintenance. Addition of a New flag named ‘Bonus’ to this HR Benefit 
Master screen. Function of the flag is to display the benefit in HCM Employee Console, Bonus History 
screen. CMiC has also included the HR related flag for ‘dependent enrollment’ in this screen. The 
new flag ‘Bonus’ introduced is only available in HR Benefit Master screen. 

Employee Console - Employee Bonus Payment: CMiC has relabeled the existing Employee Bonus 
History screen to ‘Employee Bonus Payment.’ There will be no change to program code and 
functionality; screen fields will remain the same. 

Employee Console – New Employee Bonus History: Created a new program and screen called 
Employee Bonus History. Addition of new fields to the new developed Employee Bonus History 
Screen.  

The following new fields are added for transactional data retrieval. The new screen is a log with the 
option, enabling the user to filter and sort bonus history. User can view transactions by using the new 
fields on the Log screen: 

Addition of Benefit Column on the header to display all benefits and allow users to filter Bonus by 
selecting the benefit code in the header column. The following are the added objects: 

Code: Free format text field 

Description: Free format text field  

Show Bonus Only – Check Box 

From Year: Numeric field 

To Year: Numeric field 

Note: From and To year fields will always default to current year. User can enter the year and retrieve 
data for the specific year. 

View Results - Button 

Step 1: PY Company Control Setup  

Company Control: Post Transaction by Hour Type in Job Cost Flag should be checked. 
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Step 2: PY Master Benefit Setups  

Created three new bonuses. Bonuses with Job allocation flag enabled and disabled. 
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Step 3: HCM File Maintenance – HR Benefit Master Screen  

The two newly created Bonus Benefits should now display on the JSP HR Benefit Master Screen. 
The New Benefit Master Maintenance JSP screen will be available and maintainable via the HCM 
JSP under File Maintenance. 

Note: Other benefits and bonuses from PY and HR Master Benefit screen in FORMS are also 
feeding into the new JSP HCM HR Benefit Master Screen 

 

User can selec the [Edit] Log Button to check and uncheck flag. 
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Unchecked Bonus flag and saved. CBON Bonus flag is disbaled. 

 

Check Flag for Bonus will mark the EBON Code with description EE Bonus Benefit as Bonus. 
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Step 4: Employee Console – Employee Bonus Payment 

Employee Bonus Payment program is a relabel of the existing Employee Bonus History screen. 
There will be no change to program code and functionality. Screen fields are the same.  

Add employee bonus payment. User can only add a bonus that is job allocated on this screen. 
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Enter Max Bonus Amount and Save record. 

 

Employee Bonus Payment Record Saved 
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Step 5: PY Adjustment Entry Screen – Processing Bonus Pay 

Process bonus payment for the employee and cut check. 
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Step 6: Employee Console – Employee Bonus History  

Note: Screen below displays the employee bonus history prior processing the new bonus. 

 

After processing the new bonus via the Payroll Adjustment entry screen. User can review the bonus 
history in the ‘Employee Bonus History’ screen in HCM. 

The screen will always default to current year, displaying the current year transactions. 

 

The ‘Employee Bonus History’ program will consider the new created ‘Bonus’ flag added to the 
Benefit Master table. User can view transactions by using the new added fields. User can also filter 
and view transactions by using the Benefit Column fields on the header. The Employee Bonus 
Program is log with an option enabling user to filter and sort bonus history. User can view 
transactions by using the new fields. The following fields allow users to filter and view benefits: 

Code: Free format text field 

Description: Free format text field  

Show Bonus Only – Check Box 

From Year: Numeric field 

To Year: Numeric field 

Note: From and To year fields will always default to current year. User can enter the year and retrieve 
data for the specific year. 

View Results – Button 

Show Bonus Only – Check Box 
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View transaction by Code: User can type benefit code in the ‘Code’ field as free form text.  

Note: There is no LOV selection. 

 

View transaction by Description: User can type benefit description in the ‘Description’ field as free 
form text.  

Note: There is no LOV selection. 
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View transaction From Year to Year: User can type From and To Year as free form text.  

The screen will always default to current year, displaying the current year transactions. 

Note: There is no LOV selection. View Results for transactions in year 2017. 
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Step 7: Employee Console – Employee Bonus Payment Log 

Employee Bonus Payment will now display the Total Paid and Total Unpaid amounts under the 
employee bonus summary tab. 

 

After processing 2017 Bonus payment 

 

User can select the log button under [Action] column to view the details of the payment. 
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Employee Self Service 

Ability to change verbiage on Change Benefit in Open Enrollment 
within Employee Self Service (16.24089) 
Overview: Ability to change verbaige on Change Benefit Option screen in open enrollment program 
within Employee Self Service (ESS) via ‘Prompt Maintenance’ screen in HCM. 
 
CMiC has modified the Open enrollment program within employee self service to allow users to 
change headings through prompt maintenace for all hard-coded text. 
Human Capital Management > File Maintenance > Prompt Maintenance Screen 
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Step 1: HCM – File Maintenance > Prompt Maintenance Screen 

Go to HCM > File Maintenance, under ‘Prompt Maintenance’ screen, and select Query Mode. 

 

 

Message Key is ‘ESS_Employee_Eligible_Amount’.  

In the Message Key field search for ESS_Employee_Eligible_Amount as shown below. Then select 
the message key. 

 

 
 

Select the Message Key ‘ESS_Employee_Eligible_Amount’ and click on ‘Execute Query’ button to 
execute the query for the Message Key. 
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Execute query below: 

The Message Key is ‘ESS_Employee_Eligible_Amount’ and the Message is ‘Employee Eligible 
Amount. 

 

 

Step 2: Edit/Change ‘Message’ verbiage – Prompt Maintenance  

Edit the Message text display: Under Action click 'Edit Log' to edit the text Message currently 
displayed for the Message Key. 

 

To edit the Message, Double Click on the Message field to edit value. 
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Message value is edited and changed to 'Per Pay Premium Amount'. Accept the change maded. 

 

 

 

Step 3: Update Change – Prompt Maintenance  

Once the change is accepted, user has to click on the ‘Update’ button to update the change. 

 

 
 

Go back to Query Mode and Execute Query for the Message Key ‘ESS_Employee_Eligible_Amount’ 
to verify the update made. 
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Open Enrollment now displays the column as Per Pay Premium Amount. 
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Modification to Open Enrollment Program- Adding Field Security 
(16.24187) 

Overview: Field Security . The ability to hide the column ‘Total Amount’ and ‘Employer Amount’ in 
ESS Application Open Enrollment benefit CMiC has made modifications to Open Enrollment program 
to allow users to hide ‘Total Amount’ and ‘Employer Amount’ column by field security under Role 
Maintenance. 

Security and Role Maintenance 

Users are now able to restrict and hide ‘Total Amount’ and ‘Employer Amount’ column through Role 
Maintenance and field security.  

 

 

 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  895 

 

 

 

ESS Application – Open Enrollment 

Log into ESS Application: Under Payment Administration > Open Enrollment, Select Enroll Now 
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Click Changes button to verify the column display. 
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Submitted Changes 
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Reviewed the changes: 

 
 

Employee Profile Information 2.0 (20.19981) – BETA Version 

The JSP Employee Profile Information screen has been modified to improve the general visual 
appeal and user experience. The new version 2.0 is a Beta release and under development and 
testing. 
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Impersonation Process – Employee Self Service (17.40965)  
 
CMiC has created a NEW program in the Employee Self Service (ESS) module to allow a Self-
Service (SS) user who has been assigned impersonate privileges to select and impersonate an 
employee to review and perform specific actions on that selected employee’s record on their behalf. 
SS users can log in with their individual credentials, and with proper authentication, can view a 
selected employee’s information. The ESS module will automatically switch all SS programs to use 
the impersonated employee rather than the logged-in user’s employee number. The ESS module has 
been modified to add NEW audit information to record the SS user’s information who initiated the 
impersonation process. The impersonator user can VIEW changes or requests made by the original 
employee OR continue making changes and submit the changes on behalf of the employee. 
 
The NEW screen for open enroll enrollment will be created to allow USERS to view only mode to 
review what employee have made changes and guide them as per their selection. The screen only 
displays the information SAVED by the employee and does not work as screen sharing. 

Pre-requisites 

Security access must be granted for the Employee Impersonate program to be added to the ESS 
menu. To be able to see this program, users must have this menu item assigned. 
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Modifications 

A new program called Employee Impersonate has been added to the ESS menu, under the Manager 
Self Service submenu. 
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Implementation 

The Employee Impersonate program is the last program listed in the Manager Self Service submenu. 
After clicking on the Employee Impersonate menu item, users must select the employee from the 
Select Employee field and press the [Start Impersonate] button. This will start the impersonation 
process and trigger the menu to impersonate the selected employee. 
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The impersonated employee’s name will be displayed in red.  

 

The impersonator user can see all data related to the employee and make any changes and submit 
them. 
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Clicking the [End Impersonate] button will stop the impersonation process and bring back all data 
related to the impersonator user.  

 
 

ESS & E-Time Registration – Access Code & SSO Consolidation 
(Single Sign On) - (20.33309) 

Consolidate Access Code With SSO.   

Overview   

CMiC has revised the process of Creating an Access code for E-time.   

In patch V12-014-1 and up there will be no menu to create an access code, the process is changed, 
once employees receive the email for registration and complete the registration process, the system 
automatically sets the user with the basic access in the access code administration screen, the 
access code administration can be edited based on the employee’s responsibility. There is a new flag 
added “OWNER” which represents that the access code is the owner for this code and this flag 
cannot be edited.    

  

 Enterprise User.  

Once Employee is hired and a User login for the user has been created under the system user 
maintenance screen an email can be sent from the HR employee maintenance screen for 
registration.   
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User Maintenance Screen  

 

 

HR Employee Maintenance Screen  

 
 

An employee receives the email and goes through the registration process.  

Since employee already in the user maintenance they will not be required to create an account, 
instead they will be asked to login using their user ID and password.   
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Using the User ID and Password employee will be redirected to the Etime menu screen.   
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Once the registration process is completed, an access code will be automatically created for the user 
(with the same Username used to login) and Basic administration roles will be established under the 
access code administration screen.  

 

Employee Tab, The access code is directly linked with the employee number and the 'Owner' 
checkbox is checked, marking the employee as the owner of the specified access code.   

NOTE: This flag cannot be edited. 

Payrun Tab, remains blank since the employee is only responsible for their timesheets, however, if 
the employee is required to enter time for others, then the pay run tab can be edited.   

Jobs Tab, Employee will be granted access to the jobs based on the User Job Security with access 
to all jobs, all cots and, all categories, again this can be edited based on the employee’s 
responsibilities.   

Approvers Tab, the approver is determined based on the HCM position, if under the system option 
you have the “HCM Position Synchronize From Payroll” flag turned on, then your Reports To will be 
the approver, if under the system option you have the “HCM Position Synchronize From Payroll” flag 
turned Off, then your Direct Manager from the employee profile will be the approver.   

Accounts Tab, This tab remains blank and requires to be edited based on the employee access to 
company departments.   

Non-Enterprise User  

Once the employee is hired and setup is completed in the employee profile, access can be granted to 
the employee from the HR employee maintenance screen for E-time registration.  

 

 

An employee receives the email and goes through the registration process.  
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NOTE: For registration process please see the ESS Employee Registration Process Document.   

Once the registration process is completed, an access code will be automatically created for the user 
(with the same Username used to login) and Basic administration roles will be established under the 
access code administration screen.  

Also, an entry will be established under the JSP User Maintenance as a Ldap user for that access 
code.   

Access Code Administration  

 
 

  

 

Employee Tab, The access code is directly linked with the employee number and the 'Owner' 
checkbox is checked, marking the employee as the owner of the specified access code.   

NOTE: This flag cannot be edited.    

Payrun Tab, remains blank since the employee is only responsible for their timesheets, however, if 
the employee is required to enter time for others, then the pay run tab can be edited.   

Jobs Tab, Employee will be granted access to the jobs for the payroll company with access to all 
jobs, all cots and, all categories, again this can be edited based on the employee’s responsibilities.   

Approvers Tab, the approver is determined based on the HCM position, if under the system option 
you have the “HCM Position Synchronize From Payroll” flag turned on, then your Reports To will be 
the approver, if under the system option you have the “HCM Position Synchronize From Payroll” flag 
turned Off then your Direct Manager from the employee profile will be the approver.   

Accounts Tab, this tab remains blank and requires to be edited based on the employee access to 
company departments.  
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LDAP USER   

  

 

ESS Registration Flow: 

When user gives access to ESS (Employee Self Service), you offer them the ability to access and 
manage 

Essential information such as payroll, vacation, benefits, and timesheets-without having to engage 
directly with members of the HR team. You need employee with Email address setup in Employee 
profile under Address tab. 

We need to create SSO user since, In User maintenance screen, employee number should be 
assigned against SSO user. 

 

By checking flag for ESS in user maintenance screen system verifies Email address on Employee 
profile (setup under Address tab) and Email will be send to Employee. 

The registration requires Employee to verify SSN, DOB, and Employee number for identity check. 
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Program verifies if the employee number is assigned on User Maintenance screen. 

If the employee number is assigned, then program tells you your SSO username and requires you to 
log in with existing user ID. 
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If the employee number is not assigned, then it asks user to create its SSO user. 

When employee creates a user on registration, program automatically assigns employee number to 
the User Maintenance table. 
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User ID for both ESS and E-time should be the same. System does not allow user to choose different 
User ID. 
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Employee Dashboard – Access Code & SSO Consolidation (Single 
Sign On) - (20.33309) 

Access Code Maintenance screen is now removed from the E Time menu as a part of enhancements 
to consolidating Access Code and Single Sign On for ESS and E Time registration process.  

 
 

In this old screen: 

The access code is manually created. This code is not specific to any employee. 

Once created, the SSO user is manually assigned to the access code. 

Other attributes can be set, such as: Project Manager Flag, Maximum Normal Hours, Approver Email, 
Expense Approver Email, and Unapproved Email. 

 

The access code can be disabled if desired. 

This existing screen has been replaced and will no longer appear in the E-Time Menu. 

This means that: 

Access codes are no longer manually created. 

Access codes can no longer be shared among different users. 

Each new SSO user will now be automatically linked to a new access code. 

The access code will have the same name as the SSO User. 

It will be automatically linked to that employee. 

That employee will be the owner of the access code 

It will be given default and basic access to the eTime and ESS modules. 

All this automatic setup will be done in the ESS/eTime registration process. 

A new screen has been created to replace the previous screen. 

 

The following pages describe all the functionalities of the new screen. 

 

New Screen: HR Employee Dashboard 
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This new screen can be found at the following menu path: 
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Licenses: This section shows a quick reference to the used and available eTime and ESS licenses 
(Read Only) 

Selection Criteria: 

Employee: Allows you to select the desired employee. 

[Save]: Press this button to save any changes made to the employee record. 

 

Employee Details: This section shows the employee’s basic information based on the data in their 
employee profile. (Read Only)  

It has two buttons (shortcuts): 

[Go to Employee Profile]: Launches the Employee Profile Screen 

[Go to Employee History]: Launches the Employee History Screen 

 

Employee’s Contact/SSO User/Access Code:  

This section shows the Contact-SSO User-Access Code linked to the employee. 

 

It has two main parts: 
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Multi-record grid: 

Contact Code & Name: Shows the contact linked to the employee (Read Only) 

SSO User: Shows the SSO User linked to the employee (Read Only) 

Access Code: Shows the access code linked to the employee as owner (Read Only) 

 

Important: In those cases in which an employee already has an SSO username but not an access 
code, this field becomes editable for a one-time access code manual assignment. This allows existing 
employees (i.e. ones created before these changes) to be manually linked to the proper access code 
if they are already using or sharing one with other users. 

 

This functionality has limitations:  

The LOV will only show access codes that are not already linked to an employee. 

The LOV will only show access codes to which the employee has been added in the Access Code 
Administration screen. 

Once an access code is manually assigned to one employee it cannot be assigned to another. The 
assigned employee is the owner of that access code. 

 

 
 

HR Role Code & Name: Shows the contact’s HR Role. This information can be edited here. 

 

Contact Company Code & Description: Shows the company assigned to the contact (Read Only). 

Note: If the contact’s company differs from the employee’s company, it will be highlighted in yellow 
with a warning stating so. Similarly, if the name does not match between the contact and the 
employee, it will also be highlighted in yellow. This is not an error; this is just to point out that 
important information does not match between the employee and contact records. 
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It is expected for each employee to have only one record here, but due to incorrect data or setup, or 
because an employee could have multiple access codes in the previous functionality, there could be 
more than one. It is recommended that this be manually fixed, and to have only one SSO User and 
one Access Code linked to each employee. 

[Create Contact] Button: This button automatically creates and link a new contact to the employee 
and the employee’s company. 

NOTE: This button will only be shown when the employee is not linked to a contact. 

 

 

Employee Security Tab: This section shows all payroll security groups and which ones are assigned 
to the employee. This information can be edited here. 

 

Originally, this could only be changed in Employee Profile, as shown below: 
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User Access Tab: This section shows all information related to the system users, as shown below: 
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Enterprise User: If the employee is an enterprise user; the user login, the contact and company 
directly linked to the enterprise user are shown here. (Read Only) 

There is also a button to open the Enterprise User Maintenance Screen from here. 

Note: If the enterprise company differs from the employee’s company, it will be highlighted in yellow 
with a warning stating so. Similarly, if the name does not match between the contact and the 
employee, it will also be highlighted in yellow. This is not an error; this is just to point out that 
important information does not match between the employee and contact records. 

 

SSO User Roles (Portal User Roles): If the employee is linked to a portal user, all portal roles will 
be shown here with the option to directly assign and unassign them to this employee (Editable) 

 

Three main functionalities in this section: 

Multi-record grid: As stated above, this grid will show all portal roles and will allow the user to 
assign/unassign them to the employee. 

 

Filter HR Roles flag: Since portal roles are used for several modules, the list can be extensive and 
many of them may not be relevant. Thus, a filter has been added to only show the HR/Payroll related 
roles. 

 

SSO Roles Preferences: This is a shortcut to a new SSO Roles Preference screen. This screen does 
not relate to a specific employee and is shown below: 
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Role code: Lists all the SSO Roles (Portal Roles). The Role Code and Role Name fields cannot be 
edited here. (Read Only) 
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HR Role Flag (Editable): Determines which portal role is an HR Role/Payroll Role. Note: This is the 
value used by the “Filter HR Roles” flag 

 

 

HR Role Default Type (Editable): Determines which portal roles will be assigned to each new 
ESS/eTime user. 

 

Employee Access Tab: This tab shows all information related to the employee’s access to 

ESS and ETime (Editable) 

 

ESS Access & eTime Access Flags:  

These flags determine if the employee has been invited to use ESS or eTime. 

Both flags will be disabled if the employee is not linked to a Portal contact. 

Important: Checking/unchecking these flags only gives/removes access for the employee. It 
does not send the invitation email to register users for ESS/eTime, or the email notifying that 
ESS/eTime access has been revoked. For new employees registering to ESS/eTime these flags 
will still need to be checked in the existing “Employees Maintenance” JSP Screen, as shown 
below:  

 

NOTE: This functionality will be added in the future. 
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Enterprise Menu:   

 
 

Talent Management Menu: 
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Access Code: Shows the employee’s access code (Read Only). There is also a button to the 
Access Code Administration screen, which is disabled when the employee does not have an access 
code. 

 

Access Code Attributes (Editable): This section provides all the access code fields that used to be 
found in the previous Access Code Maintenance screen. These fields are now all editable and can 
now only be changed in this screen. The fields are: Maximum Normal Hours, Allow Expenses Flag, 
Filter for Approver Flag, Project Manager Flag, and eTime roles. 

 

The eTimes Roles Edit Button: As in the previous screen, it shows a list of all eTime roles and 
which ones are assigned to this employee, as shown below. 

 
 

Default to myself when entering eTime flag (Editable): This flag is only editable when the 
employee who owns the access code is not the default employee of their own access code. Once 
clicked and saved, they will become the default employee in this access code while all other 
employees in this access codes will be set as “Not Default”. 

Once the owner of the access code is the default employee, the flag will become disabled. To define 
someone else as default, go to the Employee tab in the Access Code Administration screen.  

 

Enter eTime for other employees (Read Only): This flag is display only and shows whether the 
employee has access to enter etime for other employees. This can be changed in the Employee tab 
of the Access Code Administration screen. 

 

Approvers List (Read Only): This list shows all the approvers defined for this employee; it feeds 
from the Approvers Tab within the Access Code Administration Screen. It is shown here as a quick 
reference. 
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NOTE: Going forward, all approvers will be shown with employee and access codes information as 
every employee will have only one access code assigned to them. But, for existing old data, you may 
see only the access code populated in that list. 

 

Other employees who can enter my eTime List (Read Only): This list shows all the other 
employees and access code with access to enter eTime for the user. This list can be changed, in the 
Employee tab of the Access Code Administration screen. 

ESS Qualifying Event Update/Redesign– (20.34822 HCM - 246) 

ESS - Report & Review Qualifying Event 

A Qualifying Event (QE) is a change in your circumstances that makes you eligible to add or remove 
dependents from your benefits plan or make new plan selections, outside of the regular Open 
Enrollment period. Users can report and review qualifying event during the year to enroll into their 
Benefit Plan. Qualifying Event is available to employees. General Open Enrollment occurs only once 
in year. 

 

 

New hires and current employees can use Qualifying Event program to submit their changes for 
Benefit Enrollment. 

Changes are submitted to Manager for approval.  
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Changes are approved by Manager. 

 
 

The approved qualifying event is now available and pending for enrollment under ESS Payment 
Adminsistration sub-menu - Benefit Enrollment screen. 

ESS Benefit Enrollment Redesign– (20.34822 HCM - 9) 

CMiC Employee Self Service (ESS) is a web-based application that provides employees with a 
convenient way to access their personal information and dependent details online. ESS open 
enrollment allows employees to view and change their employee profile e.g. address information, 
dependent information, and benefit enrollment evaluations. 
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Personal: This Screen displays the details from payroll employee profile. 

During open enrollment employee can verify details. 

Any Profile changes must be submitted as a request by employee via Profile screen in ESS. 

Employee is required to log into Employee self-service with their username and password and make 
the necessary changes. 

Employees can use the Profile Information screen in ESS to modify their basic information. This data 
is originally entered on the Employee Profile screen. 

These changes can be made by using the Effective date on the screen above and creating a change 
request and can be saved and submitted for manager approval. 

Note: Only one change request can be made at a time.  

Once Manager approves the request employee can view the submitted changes, they are visible as 
Current Profile in personal screen of ESS. ↓ 
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Family: In this screen employee can view the existing family members and verify their details and 
can also add more dependents by clicking Add Family Member button or edit or delete the existing 
records from below screen. 

 

 

When Add Family member is selected the below screen appears. 

This screen allows user to add the member to the screen, Employee save the details and continue 
adding the family members by clicking the Add Family Members.  

Note: There should be a Dependent and Beneficiary Flags so member can be indicated for the 
applicable category. 

Dependents are added and saved, submitted, and approved by HR, and will be visible under HR 
Employee Relatives. 
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Once dependents are added in the family screen, they should be available on the Benefit screen, 
employee should not have to wait for the manager approval to view the dependents for the benefit 
selection. 
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Benefits: 

 

 

In this screen employee can see all the benefits and deduction plans that, they are eligible showing 
all the plan options such as, Employee, Emp + Child, Emp + spouse, and Family.  

Displaying the $ value of what employee will pay, what employer will contribute and what will be the 
total amount. 

Documents:   

Employee can download the document which provide the details of the particular benefit policy by the 
benefit provider, they are normally added by the HR department, and it is uploaded from the Benefit 
Master screen. 

Statuses: 

New Enrollment means they have recently enrolled. 

Currently Enrolled means what employee have for the current time. 

Not Enrolled means that employee is not currently enrolled and needs to review and select based on 
their requirements. 

Change:  

By clicking on the change button against Benefit/Deduction will allow employee to make the changes 
to the current election. 
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Employee can switch from one plan to another. 

Employee Can edit the existing plans. 

Employee can enroll the newly added plans. 

Employee can edit the dependent during open enrollment in the benefit screen.  

Employee can add or remove the dependent by checking or unchecking the selection box. 

The employee dependent screen will reflect based on the employee being either Dependent or 
beneficiary if dependent has the beneficiary flag checked the screen will show the percentage and the 
type, if the dependent is primary or contingent. 

If dependent is not a beneficiary and only flagged as a dependent the screen will show the benefit 
start and end dates. A Dependent can be both dependent and beneficiary at the same time 

Enroll: 

By Clicking on the Enroll option employee will be able to enroll themselves as well as their 
dependents into this new plan. 
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Beneficiary: 

Based on the Master benefit flag, dependent allowed or beneficiary allowed block will display. 

Note: In the master screen both flags cannot be selected for the same benefit\deduction 

If Beneficiary is selected the screen will appear as below. 

 

 

Dependent as Beneficiary with Plan that has ‘Beneficiary’ flag enabled. 
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Dependent selected for a plan without the ‘Beneficiary’ flag disabled. The screen will not have the 
percentage and type columns and the heading Beneficiary will display ‘Dependent’ with the 
enrollment date and end dates of the benefit. 

 

 

Confirmation: 

Employee will confirm all the details for the Family Members and Benefit Enrollment and will check 
the consent check box and will save and submit. 
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NOTE: In HR Prompt Maintenance each customer can define their own consent verbiage. 

Generic can appear as default as specified above, but we should give the ability to customer to define 
their own consent. 

ESS – General Open Enrollment Process 
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Approval process 
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Approved Plan – View Plans 
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Overview of ‘Adding’ and ‘Deleting’ Family Members during Open Enrollment process: 
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The added family member is included and enrolled in the plans: 

 

 

Deleting the added family member after his/her inclusion in the plan: 
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The added family member is now removed successfully. 
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HR Relatives screen dispalying the ‘Active’ dependents/relatives. 

 

 

HR Election By Employee screen displaying the ‘Elected’ plans after the benefit General Open 
Enrollment process approval. 
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Azure Authentication Enabled for ESS (21.40302 & 21.52029) 
Overview 

CMiC has added a new checkbox in the Self Service tab of System Options. This box, ‘Azure 
Authentication enabled for ESS’, should be checked to ensure Azure Authentication is enabled for the 
Employee Self Service module. 

 

Prerequisites 

1. Check the ‘Access To Self Service’ box for the employee in the Employee Self Service 
Maintenance screen. This checkbox determines the workflow when an employee is 
invited to ESS. 

 

2. Set the employee email address in the Employee Profile. 
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Modifications 

If the ‘Azure Authentication Enabled for ESS’ box is checked, the Employee Self Service 
Maintenance screen will validate the below information before it allows users to enable ESS 
registration.  

 
1. The ESS Maintenance screen will validate if the email address is set up on the Employee 

Profile. 
 

2. If found, the screen will then search for that email address in the LDAP directory to see if 
it corresponds to a USERID.  
If multiple USERIDs are found for the same email address the program will display an 
error message, shown below, prompting the user to clean up their AD account setup. 
Please note that if emails are set up with multiple USERIDs, then AD may fail.  

 

 
If the email address is not found in the LDAP directory, then an error appears stating that 
an AD account is not set up for this employee and email address. 

 
 

3. The program will then search the portal sec user in CMIC for the same USERID found in 
the LDAP directory. If the USERID already exists in the portal sec table for another 
employee, the program will display an error. 
If the USERID already exists in the portal sec table without an employee, then the 
program will sync the employee number in the SYSCONTACT table. 
If the information is not found, the program will create a portal sec user and contact for 
the USERID and sync with the employee number. 

4. If all the above conditions are met, the program will then display the USERID on the 
screen and will allow the user to check the ESS box if all the above conditions are met. 
The registration email containing the ESS link and USERID is then sent to the employee. 
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Implementation 

This section provides examples of using the new functionality. 
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ESS & E Time New Enhancements (21.45876 – Beta Release) 

NOTE: E-time & ESS new enhancements are under development and QA testing. This is a Beta 
Release. 

When creating new employee as a new hire, user now has the option to create a contact code on 
Employee profile.  

E-time and ESS Changes.  

Create contact code manually by pressing “Create Contact” button in Employee profile under “HCM” 
Tab: 
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When using the E-time registration  

User mapped to employee validation 

This means every user must be mapped to the employee.  
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Upon Failure: 

User will get the error "User XXXXX is not mapped to any employee. E-Time access cannot be 
validated" (This only happens when there is a broken link between Contact and employee ID).  

E-time Access validation. 

This means very user /Employee must have the E-time Access  enabled under HR>Employee 
Maintenance. 

 
 

Upon Failure  

Employee gets the error “ Employee ‘XXXXX” does not have access to e-time. 

 
 

E-Time Registration 

Once give the E-time Access employee must go through the E-time registration process to be able to 
successfully log into E-time.  

Upon Failure  

For any reason employee does not complete the registration process employee will get the error “ 
Employee XXXX has not completed the E-Time Registration” 
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Disabled Access code. 

This error only appears when access code is being disabled manually for the personal access code. 

 

 

With the new changes now, the system will look in the Access code to check if the employee is linked 
to the personal access code or to the Group access code.  
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The access code screen only allows creating a Group access code, the user will not be able to create 
any personal access codes. The personal access codes are for view and allow making limited edits 
such as. 

Maximum Hours 

Disabled the Access code flag 

Specify Days until the password expires 

Change password  

Project manager flag 

Group Access Code.  

 

No employee number is assigned to the group access code. 

No SSO user is assigned to the group access code. 

The Group access code has access to the company and pay-runs under the Access code 
administration screen.  

Pay Runs 

 

Jobs. 
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Accounts. 

 

Approver. 

 
 

Group Access Code Logins. 

Employee without E-time Access code.  

When an employee/ user logs into E-time who does not have the Access code, the system will 
prompt for the access code and password, the user will only be able to use the Group access code to 
log into the E-timesheet.  
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Employee Login using the Group Access code and Password. 

 

Employee With E-Time Access Code.  

Switching Between Access Codes.  

Employee / User logins with their Username and password, because their Access code is linked with 
the SSO system does not ask for the E-time access code and password. 

 

As indicated below we are now showing the access code. 

As highlighted below the Username is different from the access code. 
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A new icon is introduced to switch the personal access to a grpup asscee code by clicking on the 
doube arrow keys.  

 

As soon this icon is clicked system will ask for the group access code and password and login. 

  

Same User is now shown logged in as Group Access code. 

Switch Back to Personal access code. 

User can click on the double arrow to switch back to their personal acc code and system will 
automatically take user back to their personal access code.  
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E-mail notification-Personal access code: 

Setup unapproved Emil address from employee profile- Email in access code screen coming from 
Employee Profile: 
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As soon as you setup approver in access code administration, then Email addres will be populated in 
access code table mode: 
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When Employee submit the timesheet, Email notification will be send out to approver: 

 
 

 

Employee will get notification for unapproved timesheet: 
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Enterprise Content Management 

Outlook Plugin (19.74990) 

Notifications for ECM Outlook Plugin - creation of pull notification web services that will return the 
newly created documents in CMiC system after a particular timestamp. 

ECM (Desktop) Explorer (21.41433) 

Specifications Management (Hyperlink support) - added feature to navigate to document record via 
Link Annotations for SPECMGMT type documents. The ECM explorer is generating the Links on PDF 
files for SPECMGMT document types. When these PDF files are opened in PSPDF viewer, and when 
user clicks on Link Annotations, we are navigating to the respective document. 

PSPDF Viewer - Enabled Image Annotations; Publish Link 
Annotations (21.39616, DMW-59) 

Drawing Management Enhancements 

1. Enabled Image annotations on PSPDF Toolbar.  

 

2. Allowed user to Publish/UnPublish Link annotations; buttons have been added to Thumbnail 
header of linked document. 

Publish Button: 
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Un-Publish Button: 

 

 

Equipment Costing 

Ability to Copy Equipment Class Revenue Rates (15.01986) 

The Equipment Class Revenue Type Detail screen in ADF is modified with the addition of a button in 
the header block to copy the equipment class rates along with allocation overrides if any, from one 
company to another. 
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The pre-requisite for a full copy is that, the target company must also have the same transaction 
codes and the Revenue Types defined with Revenue Allocation for ‘Target Company’. If the target 
company does NOT have all transaction codes or Revenue allocation, then only those matching in 
both source and target companies will be copied over. 

Users must note that, if there are any rates that is ‘in-active’ then they will NOT be copied over.  ‘As of 
Date’ all those ‘active’ rate definitions will be copied over. 

 

 

Ability to Copy EQ Rates at the Job/Class Level (19.84735)  

Overview 

Ability to copy equipment rates from one job to another job at Job/Class level.  

Modifications 

• Added a new button ‘Copy Job/Class Rate’ on ‘Equipment Job/Class’ rate setup screen in 
‘Equipment Rate by Type’ program. 

• A new pop-up program ‘Equipment Class/Job Revenue Type Detail’ is created for this 
purpose. 

The following screen shows the modification performed. 
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Equipment Costing > Setup > Local Table > Rates by Type > Job/Class 

Copying Process 

Users must enter the selection criteria in the main screen in order to start the copy process. 

 

Enterable Fields: 

Equipment Class:  The class value is defaulted from the main screen. 

Effective Date: Users must enter a date value, from which the copied rates would be effective in the 
new job. 

Job Company/Job Code: Enter the Company /Job Code to which the rates are to be copied. 

[Copy Job/Class Rates]: Click on this button to complete the copy process. 

[Cancel]: Exit without copy process. 
 
After successful copy, an alert message is displayed as “Rates copied successfully to job”. 

 

Equipment Costing > Setup > Local Table > Rates by Type > Job/Class – [Copy Job/Class Rates] pop-up 
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Implementation 

The following example shows the copy feature at job/class level.  

Copying rates to a job where no rates exist. 

Rates at Job 1000. 

 

Equipment Costing > Setup > Local Table > Rates by Type > Job/Class 

Copying rate from job 1000 to job DHC0000001. 

 

Equipment Costing > Setup > Local Table > Rates by Type > Job/Class – [Copy Job/Class Rates] pop-up 
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Alert message is displayed when the rates are copied successfully. Click [OK]. 

 

Equipment Costing > Setup > Local Table > Rates by Type > Job/Class – [Copy Job/Class Rates] pop-up 

Rates copied successfully. 

Rate at job CCC-00001. 

 

Equipment Costing > Setup > Local Table > Rates by Type > Job/Class  
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Copying the rates to DHC0000001, where same revenue type rate exist but the effective date is 1st 
July. 

 

Equipment Costing > Setup > Local Table > Rates by Type > Job/Class – [Copy Job/Class Rates] pop-up 

 

Equipment Costing > Setup > Local Table > Rates by Type > Job/Class – [Copy Job/Class Rates] pop-up 
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Rates copied successfully for 1st July.  

 

Equipment Costing > Setup > Local Table > Rates by Type > Job/Class  

 

Equipment Costing > Setup > Local Table > Rates by Type > Job/Class  

Revenue Type rates at job CCC00004. 

 

Equipment Costing > Setup > Local Table > Rates by Type > Job/Class 
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Copying the rates to DHC0000001, where IDLE revenue type rate exists in 11th June. 

 

Equipment Costing > Setup > Local Table > Rates by Type > Job/Class – [Copy Job/Class Rates] pop-up 

If same revenue type rate exists on the destination job, an alert message is prompted. Rates are 
found on or after effective date. Do you want to delete them and copy the rates with this new effective 
date?  
 
Yes: It will delete the same revenue type rate on destination job and copy the new rates. 

No: Copying process will be aborted. 

 

Equipment Costing > Setup > Local Table > Rates by Type > Job/Class – [Copy Job/Class Rates] pop-up 
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Equipment Costing > Setup > Local Table > Rates by Type > Job/Class – [Copy Job/Class Rates] pop-up 

 

Verified the rate at Job DHC0000001. 

‘IDLE’ revenue type is copied with new rates. 

 

Equipment Costing > Setup > Local Table > Rates by Type > Job/Class  

It will also override the rates for 1st July as the rates were copied with effective date of 11th June. 

Ability to Restrict Transfer of Equipment on the Same Day (19.91100) 

Added a control file flag to allow same day transfer of equipment. 

Overview 

This functionality restricts user to transfer the equipment on the same day. 

Modifications 

Flag ‘Allow Same Day Transfer’ is added to Equipment Costing Control File.  

Allow Same Day Transfer – Checked (Y) 
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 User can transfer the equipment on the same day it is commissioned. 

Allow Same Day Transfer – Un-checked (N) 

 User will be restricted, and transfer of equipment is not allowed on the same day it is 
commissioned. 

 

 

Asset Management > Equipment Costing > Setup > Local Tables > Control File  

 

Implementation 

Company: DHCOM, added a new equipment CYBER-T3 

Allow Same Day Transfer: Checked (Y) – Equipment can be transferred on the same day it is 
commissioned. 

 

Asset Management > Equipment Costing > Setup > Local Tables > Control File 
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New equipment CYBER-T3 is added on 12-05-2020. 

 

Asset Management > Equipment Costing >Setup > Enter Equipment 

 

Transferring ‘CYBER-T3’ on 12-05-2020 to BEJOB location. 

 

Asset Management > Equipment Costing > Transaction > Actual Location Transfer > Enter Transfer Transaction 

Equipment transferred successfully. 
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Asset Management > Equipment Costing > Transaction > Actual Location Transfer > Enter Transfer Transaction 

Allow Same Day Transfer: Un-checked (N) - User will be restricted, and transfer of equipment is not 
allowed on the same day it is commissioned. 

 

Asset Management > Equipment Costing > Setup > Local Tables > Control File 
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Added new equipment: CYBER-T6 with commission date 13-05-2020. 

 

Asset Management > Equipment Costing >Setup > Enter Equipment 

 

Transferring equipment on 13-05-2020. 

 

Asset Management > Equipment Costing > Transaction > Actual Location Transfer > Enter Transfer Transaction 

Equipment cannot be transferred on the same day it is commissioned and the ‘Allow Same Day 
Transfer’ flag is un-checked.  

Error is thrown ‘Transfer to the new location cannot be on the Current Location Start Date’. 
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If an equipment is transferred to a job and user wants to transfer the same equipment to another job, 
then the ‘Allow Same Day Transfer’ flag must be checked.  

Transferring equipment ‘CYBER-T3’ from ‘BEJOB LOC’ to ‘LOC1’ on 25-05-2020. 

 

Asset Management > Equipment Costing > Transaction > Actual Location Transfer > Enter Transfer Transaction 

Unchecking the ‘Allow Same Day Transfer’ flag: N 

Transferring equipment ‘CYBER-T3’ to ‘BEJOB-2’ location. 

 

Asset Management > Equipment Costing > Transaction > Actual Location Transfer > Enter Transfer Transaction 

Error is thrown ‘Transfer to the New Location cannot be on the Current Location Start Date’ 
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‘Allow Same Day Transfer’ – Checked (Y) 

Transferring equipment ‘CYBER-T3’ to ‘BEJOB-2’ location. 

 

Asset Management > Equipment Costing > Transaction > Actual Location Transfer > Enter Transfer Transaction 

 

Modifications to EREC Process to Account for Rented Equipment. 
(19.83242) 

Ability to process EREC for rented equipment and modifications to EREC process. 

Overview 

Added new field EREC flag in Equipment Home Location. Modified to read the EREC flag from home 
location and not to create EREC transaction if transfer of an equipment to a job with transaction code 
AVAL and stayed for 7 days. 

 

Modifications 

A flag ‘EREC Flag’ is added in Home Locations screen. The flag is hidden by default and user must 
use Lite Editor to make this flag visible.  

The default state of the flag unchecked (N). 

User must check (Y) the EREC flag on the Home Location(s) where they want equipment to process 
EREC.  
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Asset Management > Equipment Costing > Setup > Local Tables > Home Locations  

If the ‘Available for Transfer Trans Code‘ on ‘Ownership Reconciliation Setup’ screen matches with 
the Actual Location Transfer Transaction Code and equipment stayed for 7 days of a period with the 
same transaction code on a job, then it will be included in the EREC process. 

 

Asset Management > Equipment Costing > Setup > Local Tables > Ownership Reconciliation Setup 

 

Asset Management > Equipment Costing > Transactions > Actual Location Transfer > Enter Transfer 
Transactions 
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Restrict Sub Class Only on Equipment (20.24578) 

The System Options>Assets tab is modified with an addition of a new flag ‘Restrict Sub Class only on 
Equipment’. When checked, Equipment Class program and Equipment Maintenance will not allow 
any controlling class being selected. When un-checked the standard functionality applies, allowing 
any class in equipment. The standard Rule of only two levels of hierarchy of classes, Controlling and 
a sub class are allowed. 

New System Options Flag under Assets tab: ‘Restrict Sub Class only on Equipment’. 

 

When the Flag: ‘Restrict Sub Class only on Equipment’ is checked, the following will happen: 

1. Enabled the Controlling Class field on Equipment Classes setup screen and added the validation, 
not to allow to enter controlling class if it is already been used on any of the equipment as a class. 
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2. Modified the Equipment Entry program, where validation was added on equipment class field, not 

to allow to enter equipment class if it was already used as a Controlling Class on Equipment 

Class setup screen. 
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Ability to Copy EQ Rates to Controlling Job and/or Sub Job (20.23790) 

Overview 

Added the feature to copy equipment class rates to controlling job and/or sub job.  
User can copy billing rates and/or charge rates. 

Modifications 

The following fields are added. 

Rate: Rate radio button is used to select the rates to be copied. By default, ‘Both’ is selected. 

• Both: Billing Rates and Charge Rates are copied 

• Billing: Only Billing Rates are copied 

• Charge: Only Charge Rates are copied  

Copy Rates to Controlling Jobs Only Checkbox -Default state of the flag is checked. 

• Checked – Rates are only copied to ‘Controlling Jobs’. 

• Un-checked – Rates are copied to controlling job and sub job. 

➢ Rates must exist for the selected ‘As of Date’. 

➢ If rates already exist for the destination class on the selected ‘As of Date’, the rates will not be 
modified/copied. 

 

Asset Management > Equipment Costing > Local Tables > Rates > Class – EQ Class Rates: [Copy to Job/Class] 
pop-up 

Implementation 

Main Job: DH0006 

Sub Job: DH000601 

Rates does not exist in both the jobs. 
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Asset Management > Equipment Costing > Local Tables > Rates > Job/Class - Rates by Class/Job 

 

Asset Management > Equipment Costing > Local Tables > Rates > Job/Class - Rates by Class/Job  ‘DH-
TRUCKS’ Class Rates 

 

Asset Management > Equipment Costing > Local Tables > Rates > Class – Rates by Class/Job 

[Copy to Job/Class] 

Copying rates to ‘DH-LOW’ class, only charge rates are being copied. 
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Asset Management > Equipment Costing > Local Tables > Rates > Class – Copy Job/Class Rates pop-up 

Charge Rate copied to controlling job only. 

 

Asset Management > Equipment Costing > Local Tables > Rates > Job/Class - Rates by Class/Job 

 

Asset Management > Equipment Costing > Local Tables > Rates > Job/Class - Rates by Class/Job 

Copying Billing Rates to controlling job only. 
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Asset Management > Equipment Costing > Local Tables > Rates > Class – Copy Job/Class Rates pop-up 

Billing Rate copied successfully to controlling job.  

 

Asset Management > Equipment Costing > Local Tables > Rates > Job/Class - Rates by Class/Job 

 

Asset Management > Equipment Costing > Local Tables > Rates > Job/Class - Rates by Class/Job  

Added NEW RATES for ‘DH-TRUCKS’ with new effective date. 
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Asset Management > Equipment Costing > Local Tables > Rates > Class  

Scenario 1: Copied only Billing Rates to DH-LOW with 2.5% cap – As of Date ’15-10-2020’ 

Scenario 2: Copied Both Rates to ‘DH-LOW’ with 2.5% cap – As of Date ’01-11-2020’ 

➢ Billing Rate should exist for sub job as of 15/10. 

➢ New Rates (Billing & Charge) should exist for sub job as of 01/11 

➢ New Rates (Billing & Charge) should exist for controlling job as of 01/11 

 

 

Asset Management > Equipment Costing > Local Tables > Rates > Job/Class– Rates by Class/Job 
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Asset Management > Equipment Costing > Local Tables > Rates > Job/Class – Rates by Class/Job 

Added ‘Quantity’ in Actual Location Transfer Bulk Item Import 
(21.41989) 

Overview 

Added quantity field to Actual Location Transfer bulk item import. (Program-EMALTR) 

Modifications 

Added quantity field to Actual Location Transfer bulk item import file EMTRAN_ACTLOC. 

Implementation 

Quantity field is added in import table as well as import file da_emtran_actloc. 
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Asset Management> Equipment Costing> Transactions> Actual Location Transfer> Enter Transfer Transactions 

 

EMTRAN_ACTLOC 

Copy Equipment (20.34147) 

Overview 

Added ‘Copy Equipment’ functionality in equipment maintenance program. 

Modifications 

‘Copy Equipment’ button is added to equipment maintenance program.  
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Equipment Costing > Setup > Enter Equipment 

Mandatory fields in Copy Equipment pop-up:  

Copy From Equipment: Select the equipment code which is to be copied. The equipment from 
which the [Copy Equipment] button is accessed/clicked will be defaulted in this field. 

Copy To Equipment: Enter the new equipment code and equipment name. 

Serial Number: Enter a unique serial number.  

Actual Location: Select the actual location of the equipment from LOV. 

NOTE: Equipment code must be entered in upper case 

 

Equipment Costing > Setup > Enter Equipment > Copy Equipment pop-up 

Implementation 
Equipment: CYBER-T3 
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Equipment costing > Setup > Enter Equipment 

 

Equipment costing > Setup > Enter Equipment – Transaction Codes 
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Equipment costing > Setup > Enter Equipment – Truck Detail 

 

Equipment Costing > Local Tables > Rates > Equipment 

[Copy Equipment]  
Copy To Equipment: EQP-109 
Click on [PROCESS]  

 

Equipment costing > Setup > Enter Equipment – Copy Equipment pop-up 
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Query for the new equipment ‘EQP-109’ 
Equipment is copied successfully. Transaction code and Truck Detail tabs are also copied.  

 

Equipment costing > Setup > Enter Equipment 

 

Equipment costing > Setup > Enter Equipment – Transaction codes 
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Equipment costing > Setup > Enter Equipment – Truck Detail 

Equipment Rates for ‘EQP-109’ 

 

Equipment Costing > Local Tables > Rates > Equipment 

Group Location Transfer Entry- Adding Transfer time and LOVs to 
Job, Phase, and Category Code (21.42282) 

Overview 

Added Transfer time to control block and basic table block, and LOVs to job, phase and category 
code. 

Modifications 

1. Transfer time field is added to Group Location Transfer entry screen.  

2. Added LOVs to job, phase, and category code. 
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Asset Management > Equipment Costing> Transactions > Actual Location Transfer> Group Transfer Selection 

Implementation 

Transfer time field is added with a default value of ’19:00’ in it.  

 

Asset Management > Equipment Costing> Transactions > Actual Location Transfer> Group Transfer Selection 

Make the Equipment Selection and click on ‘Process’ button to post the transaction.  After clicking on 
‘Process’, go to ‘Enter Transfer Transactions’ and it prompts the same batch number with the 
selected equipment with all the records pre-filled except for ‘Transfer Number’. 
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Asset Management > Equipment Costing> Transactions > Actual Location Transfer> Group Transfer Selection 

Fill the ‘Transfer Number’ and check all the details and click on ‘Post’ button in the train. 

 

Asset Management > Equipment Costing> Transactions > Actual Location Transfer> Group Transfer Selection 

Check the ‘Batch Number’ and ‘Post Date’ and click on ‘Post’ button to get the batch posted. 

EC Program/Manual- Sensitive Terminology Replacement (21.47732) 

 

Overview 

All References to the Terminology 'Master/Slave' is replaced with 'Primary/Secondary' throughout the 
software and the Equipment Costing Manual. 

Modification 
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Following screen shows the updated terminology:  

Assemble Equipment Unit: 
 

 

Equipment Costing > Setup > Assemble Equipment Unit  

 

 

Equipment Costing > Setup > Assemble Equipment Unit – Tool tip 

 

 

Equipment Costing > Setup > Assemble Equipment Unit – Tool tip 

 

 

Equipment Costing > Setup > Assemble Equipment Unit – Tool tip 
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Equipment Costing > Setup > Assemble Equipment Unit – [Search]  

 

 

Equipment Costing > Setup > Assemble Equipment Unit – [Search] 

 

 

Equipment Costing > Setup > Assemble Equipment Unit – Validation  
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Equipment Costing > Setup > Assemble Equipment Unit – Validation 

 

Actual Location Transfer Entry:  
 

 

Equipment Costing > Transaction > Actual Location Transfer > Enter Transfer Transaction – Validation  
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Equipment Costing > Logs > Equipment Units History Log  

 

 

Equipment Primary/Secondary Report 

 



1002  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

 

Equipment Primary/Secondary Report 

 

Purge Non-Chargeable Auto Charge Transactions (21.43479) 

Overview 

New fields have been introduced in EC control file to purge non-chargeable equipment list. They are 
hidden by default and user must use lite editor to make them visible.  

Suppress Non-Chargeable records in Review Auto-Charge out program: Flag is un-checked (N) 
by default. If the flag is checked, Cut-off date field will be enabled. Once checked, user must specify 
the cut-off date to filter the non-chargeable equipment list in auto-charge out program.  

Cut-off Date: This field is only enabled when ‘Suppress Non-Chargeable records in Review Auto-
Charge out program’ flag is checked.  

While processing auto-charge out, non-chargeable equipment whose location transfer date is less 
than the cut-off date will not be generated and hence not displayed in the non-Chargeable section in 
Review auto-charge out program.  

 

Equipment Costing > Setup > Local Tables > Control File > Charge/Reconciliation tab 
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Equipment Costing > Setup > Local Tables > Control File > Charge/Reconciliation tab 

Modifications 

The following screen i.e EC control file is modified.  

When Suppress Non-Chargeable records in Review Auto-Charge out program flag is checked, 
cut-off date field is enabled.  

User must specify cut-off date if the field is enabled.  

 

Equipment Costing > Setup > Local Tables > Control File > Charge/Reconciliation tab 

Implementation 

Equipment: SCL55, SCL56 & SCL57.  

Transfer Date to job location 1050.  

SCL55: 1st Nov 2021 

SCL56: 1st Nov 2021 

SCL57: 1st Dec 2021 
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Equipment Costing > Queries > Equipment/Location Query  

EC Control file: Suppress Non-Chargeable records in Review Auto-Charge out program field is not 
checked. Non-chargeable equipment will not be purged in this case. 

 

Equipment Costing > Setup > Local Tables > Control File > Charge/Reconciliation tab 

Auto-charge out is carried from 1st Nov 2021 to 30th Nov 2021.  
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Equipment Costing > Transactions > Automatic Charge-outs 

Auto-charge out is processed successfully, SCL55 and SCL56 equipment has non-chargeable 
transactions as shown in the screenshot below.  

 

 

Equipment Costing > Transactions > Automatic Charge-outs – Review Transactions  

Case 1:  

Suppress Non-Chargeable records in Review Auto-Charge out program: Checked (Y)  

Cut-off Date: 31st Oct 2021 
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Equipment Costing > Setup > Local Tables > Control File > Charge/Reconciliation tab 

Since the equipment transfer date is greater than the cut-off date, non-chargeable equipment list will 
be shown in auto-charge out review program.  

 

 

Equipment Costing > Transactions > Automatic Charge-outs – Review Transactions  

Case 2: 

Suppress Non-Chargeable records in Review Auto-Charge out program: Checked (Y)  

Cut-off Date: 2nd Nov 2021 

The cut-off date is greater than the equipment transfer date, in this is case non-chargeable equipment 
list will be purged. Since the auto-charge out is processed for SCL55 and SCL56, no transactions will 
be created in this case.  
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Equipment Costing > Setup > Local Tables > Control File > Charge/Reconciliation tab 

SCL55 an SCL56 equipment transactions will not be created. 

 

 

Equipment Costing > Transactions > Automatic Charge-outs 

Alert message is displayed since no transaction are created in this case of auto-charge out process.  
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Equipment Costing > Transactions > Automatic Charge-outs – Alert message 

 

Equipment Costing > Transactions > Automatic Charge-outs – Processing Log  

Case 3:  

Suppress Non-Chargeable records in Review Auto-Charge out program: Checked (Y)  

Cut-off Date: 2nd Nov 2021 

Equipment used in auto-charge out process:  

SCL55: Transfer Date 1st Nov 2021 

SCL56: Transfer Date 1st Nov 2021 

SCL57: Transfer Date 1st Dec 2021 

Here, SCL57 equipment is non-chargeable but will be processed in the auto-charge out program as 
its transfer date is greater than the cut-off date. 

From Equipment: SCL55 

To Equipment: SCL57 
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Equipment Costing > Transactions > Automatic Charge-outs 

Processing completed successfully and 1 transaction is created.  

 

Equipment Costing > Transactions > Automatic Charge-outs 

SCL57 equipment is processed for auto-charge out program. SCL55 and SCL56 are non-chargeable 
equipment, which are purged in the review transaction program as the cut-off date is greater than the 
equipment transfer date.  
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Equipment Costing > Transactions > Automatic Charge-outs – Review Transactions  

Estimate Management 

Estimating Markup Enhancements (18.56073) 

The following enhancements have been made for Markups for Cost/Revenue: 

1. A new checkbox has been added in the Base Job Markups screen:  

“Use % Revenue/ Estimate (Cost)” 

Field security can be applied to the checkbox.  The default value is set as HIDDEN on the 
*ALL* security role.  Possible values are: Unrestricted, Read-only, Hidden: 

 

 

2. When the field security is set as Unrestricted or Read-only, the checkbox is visible on the 
Markups screen: 
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3. When the checkbox is checked the %Cost column is added to the Markups screen, and the 
original % column is further distinguished as %Revenue: 

 

Only Markup lines which are set as ‘Active’ are included in the markup calculations.  If a figure is 
included in the %Cost column, and the markup is active, the markup is applied to Estimate Amount 
when the sub-job is released, and the resulting bid item is created for the markup. 

The %Revenue is calculated as before and updates the Revenue Amount column of the bid item 
created when the sub-job is released. 
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Example  

 

 

 

%Revenue = 3.2%  X  100000 = 3200  (Revenue) 

%Cost         = 1.7%  X  100000 = 1700  (Estimate) 

When the sub-job is released, the Bid Items screen shows: 
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Example 2 

Markups 

 

 

Estimate Summary 
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Bid Items after sub-job released 

 

Rates by Phases for Cost and Billing (18.59602) 

Added new functionality where users can define separate rates by phases for cost and for billing in 
Estimate Management. 

The changes of the enhancements include the following: 

1. Enhanced the Craft Rate Maintenance screen to be named “Craft & Trade Rates 
Maintenance” since it now includes a  tab for “Trade”:               

 Use this screen to create and maintain Trade Rates. 

 

The Trade Code, Description, Actual Rate/Hour and Bill Rate/Hour are fields to maintain.  
Trade Code and Trade Description are mandatory. 
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If the user tries to delete a Trade Code in the Trade Code Maintenance screen and it is being used in 
Estimate Detail, a message will be displayed (after a confirmation to delete the record): 

                 

2. Estimate Detail 

 Addition of a Trade Code LOV displaying entries from the Trade Code Maintenance:
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Once the Trade is selected, the rates are pulled in where appropriate, and the calculations adjusted 
accordingly. 

               

 

To remove a Trade Code without deleting the Estimate Detail Line, select the Trade Code with 
Description “Remove Bill Rate Calc” : 
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Fixed Assets 

Modification in Depreciation Calculation Using Straight Line 
Method Only (19.88769) 

To modify the depreciation calculation, if an asset is activated on any date other than first day of the 
month. This modification is requested when using Straight Line method only. 

Modifications: 

Straight Line method will be using a proportional calculation, if an asset is activated on any date, 
other than the first day of the month. Proportional calculation will be based on number of days an 
asset was active in the initial month.  

The new proportional calculation ratio is as follows: 

(Number of Depreciable days / Number of days in initial month) * Monthly Depreciation amount  

Ex: An asset activated on 16th day of January: (16/31) * 10,000.00 = 5,161.29 

Insurance, license and interest amounts will also be using proportional calculation based on the 
activation days and number of days in the initial month. 

Posting of the Difference of depreciation Amounts: 

Since this modification potentially reduces the depreciation amount for the initial month, the difference 
or remaining amount will be posted in the month after the last month as per the expected life of asset 
ends.  

Ex: The difference Amount due to reduced initial depreciation = 10,000 – 5,161.29 = 4,838.71 

This will be posted after the last month as per expected life.  
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Example: 
 
ASSET: TRUCK 
Activation Date: 10th March 2020 
Number of days in initial month: 31 
Monthly depreciation: 7500 
Depreciable days in initial month: 22 

Depreciation in initial month: [(22 / 31) * 7500] = 5322.58 

Interest monthly: 333.33 
Interest in initial month: [(22/31) * 333.33] = 236.559 

License monthly: 16.67 
License in initial month: [(22/31) * 16.67] = 11.83 
 

Monthly Insurance: 320.83 
Insurance in initial month: [(22/31) * 320.83] = 227.69 
  

 

Asset Management > Fixed Assets >Enter Asset (Asset Maintenance) 

 

Asset Management > Fixed Assets >Enter Asset (Asset Maintenance) > Depreciation 
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Fixed Assets > Transaction > Calculate Monthly Expense 

 

 

Fixed Assets > Transaction > Calculate Monthly Expense – Edit Monthly Expense 

 

Depreciation Posting Report (31-02-2020) 

As the asset was not activated on 1st of the month, it will calculate proportional charges for the first 
month and the remaining amount will be posted in subsequent month when the expected life of asset 
ends.  

Last posting for asset ‘TRUCK’ would be as follow: 

Remaining amount: 7500 – 5322.58 = 2177.42 
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Depreciation Posting Report (31-03-2021) 

The asset was activated in March 2020, with an expected life of 12 months. The asset was fully 
depreciated in March 2021. The depreciation in March 2021 would be the remaining amount from the 
proportional calculation of 1st month.  

Note: Proportional calculation will not apply to License, Interest and Insurance amount in the last 
month of depreciation. These amounts will be calculated fully.  

 

 

Fixed Assets > Query > Asset Transaction Detail Query  

Addition and Betterment 

Resetting Expected Life: The expected life cycle will be renewed from the month when betterment is 
added, and expected life is reset.  

 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  1021 

ASSET EXPECTED LIFE ACTIVATION BETTERMENT MONTH IN 
WHICH ASSET IS 
TOTALLY 
DEPRECIATED 

ASSET-1 12 1ST FEB 2020 N/A JAN 2021 

ASSET-2 12 15TH FEB 2020 N/A FEB 2021 

ASSET-3 12 1ST FEB 2020 MAY 2020 – 
RESET LIFE 

APRIL 2021 

ASSET-4 12 15TH FEB 2020 MAY 2020 – 
RESET LIFE 

MAY 2021 

ASSET-5 12 15TH FEB 2020 MAY 2020 – NO 
RESET 

MAY 2020 

 

Ability to Create Journal Entries for Activation, Addition and 
Betterment, and Disposal of an Asset (19.88705)  

Ability to create journal entries for activation, addition and betterment, and disposal of an asset. The 
Journal entries created must be automatically posted to GL. 

Modifications 

Fixed Assets > Control File: Added the following new fields to the control. These fields will be used as 
default values when creating new assets. 

• Default Asset Department 

• Default Asset Account 

• Asset Acquisition/Betterment Department 

• Asset Acquisition/Betterment Account 

• Asset Disposal Department 

• Asset Disposal Account 

Asset Maintenance > Distribution Tab: Added new fields  

• Distribution Tab:   

o Asset (Department, Account, Account Name)  

o Acquisition/Betterment (Department, Account, Account Name) 

o Disposal (Department, Account, Account Name) 

o Asset Acquisition Value 

o Asset Acquisition Override Amount 

o Create and Post Transaction button 

System > Security > Role Privileges 

• A new privilege ‘FACHGACVAL’ is added to ‘System Privileges’.  
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• When checked, allows to adjust the Asset Acquisition Value.  

• The ‘Asset Acquisition Override Amount’ field will be enabled, when the flag is ‘checked’ and 
disabled if it is ‘un-checked’. 

Additions and Betterments: 

• Added [Create and Post Transaction] button and ‘Batch’ display column.  

• Batch column will display the batch number of the posted transactions.  

• Create and Post Transaction button will post the selected additions and betterment to GL. 

Disposal of Fixed Assets: 

• Debit Department & Account 

• Credit Department & Account 

• Post Date 

• Batch 

• Create and Post Transaction button 

NOTE: The new fields may be hidden as default for all users. When required, users may use the Lite 
Editor to make them available. 

Following screens show modifications performed: 

 

Fixed Assets >Setup> Local Tables> Control File 
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Fixed Asset > Enter Asset > Distribution Tab 

 

Fixed Asset > Assets > Enter Additions and Betterments 

 

Fixed Asset > Assets > Disposal of Assets 
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Processing & Posting 
 

1. Acquisition Value & posting: 

When a new asset is activated, the asset is facilitated to make journal entry and automatically post 
transaction to GL.  

Asset Maintenance > Distribution – If the account and department fields for ‘Asset’, 
‘Acquisition/Betterment’, and ‘Asset Disposal’ are not entered, the values will be defaulted from 
control file. 

If department and account fields are mentioned in the distribution tab, then this will override the 
values in the control file.  

The posting distribution will be as follows: 

 

  Department Account 
Account 
Name 

Asset  00 1100.200 
Asset 
Account 

Acquisition/Betterment 00 1100.300 

Asset 
Acquisition 
Betterment 
Account 

Asset Disposal 00 1100.400 

Asset 
Disposal 
Account 

 

Asset Acquisition Value 12500.00 

 

Department Account Account Name Debit Credit 

00 1100.200 Asset Account 125,000.00 0.00 

00 1100.300 

Asset Acquisition 
Betterment 
Account 0.00 125,000.00 

 
If the asset acquisition value is to be adjusted, enter the new value in ‘Asset Acquisition Override 
Value’ field and click on ‘Create and Post Transaction’. 

 

Asset Acquisition Value 12500.00 

Asset Acquisition 
Override Value  150000.00 
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Department Account 
Account 
Name Debit Credit 

00 1100.200 Asset Account  0.00 125,000.00 

00 1100.300 

Asset 
Acquisition 
Betterment 
Account 125,000.00 0.00  

00 1100.200 Asset Account 150,000.00 0.00 

00 1100.300 

Asset 
Acquisition 
Betterment 
Account 0.00 150,000.00 

 

2. Additions and Betterments 

When Additions and Betterment are performed on an asset, it would create a journal entry and 
automatically post transaction to GL. Add the betterment to the asset: 

Select * Asset Code Asset Name Description * Date Amount Batch 

N EXCAVATOR EXCAVATOR 

PARTS 
CHANGED 
#1278 11-03-2020 42300.00 12210.00 

 
Select the asset and click on ‘Create and Post Transaction’ button. 
 
The posting distribution will be as follows: 

Department Account Account Name Debit Credit 

00 1100.200 Asset Account 42300.00 00 

00 1100.300 
Asset Acquisition Betterment 
Account 00 42300.00 

 
The accounts are defaulted from the control file. 

3. Disposal of Assets 

Select the asset to be disposed, enter the ‘Disposal Date’ and click on Save. 
If an asset has ‘Amount Recovered’ it must be entered. If there is a value in ‘Amount Recovered’ field, 
the ‘Debit’ & ‘Credit’ department, and account field is enabled. Enter the department and account to 
which the recovered amount is to be posted. 

NOTE: User can use the Asset Acquisition Override Value even if the asset is disposed. 
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There can be four cases of posting while disposing an asset, as follows: 

a)  

Net 
Book 
Value  

AMOUNT 
RECOVERED  

7500 0 

 

Department Account 
Account 
Name Debit Credit 

00 1000.100 
Operating 
account 0.00 7500 

00 1100.400 

Asset 
Disposal 
Account 7500 0.00 

 

b)  

Recovered amount is posted to the accounts entered in the ‘Disposal of Fixed Asset’ screen.  

  Department  Account 
Account 
Name 

Debit 00 1100.400 

Asset 
Disposal 
Account 

Credit 00 1100.200 
Asset 
Account 

 

Net 
Book 
Value 

AMOUNT 
RECOVERED  

7500 5000 

 

Department Account 
Account 
Name Debit Credit 

00 1000.100 
Operating 
Account 0.00 7500 

00 1100.200 
Asset 
Account 0.00 5000 

00 1100.400 

Asset 
disposal 
Account 7500 0.00 

00 1100.400 
Asset 
disposal 5000 0.00 
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Department Account 
Account 
Name Debit Credit 

Account 

 

c)  

Net 
Book 
Value 

AMOUNT 
RECOVERED  

0 0 

 
No GL line is created for ‘0’ line. 

d)  

Net 
Book 
Value 

AMOUNT 
RECOVERED  

0 5000 

 

Department Account 
Account 
Name Debit Credit 

00 1100.200 
Asset 
Account 0.00 5000 

00 1100.400 

Asset 
Disposal 
Account 5000 0.00 

 

 

Examples: 

A new asset ‘TRUCK-M’ is added in fixed asset. In ‘Distribution’ tab of fixed asset, enter the asset 
acquisition value and click on ‘Create and Post Transaction’ to make a journal entry posting to GL. 
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If the ‘Asset’, ‘Addition/Betterment’, and ‘Asset Disposal’ department and account are entered here, 
they will override the default accounts in the control file. If no department and accounts are 
mentioned, the control file department and accounts are defaulted here.  

Upon clicking on ‘Create and Post Transaction’, a pop-up launches which prompts user to enter the 
posting date. 

 

After clicking on POST, an alert message is displayed ‘Asset Acquisition Transaction Created and 
Posted successfully against batch number:’. Batch number is generated, and corresponding posting 
is done in GL. 
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Click ‘OK’ to go to ‘Report Configuration’ pop-up. 

 

Click ‘Run Report’ to view the report, click ‘close’ to close the pop-up. After generating the report or 
closing the report configuration pop-up, batch number is shown on distribution tab of the asset. 
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Also, the Asset Acquisition Override Values field is now enabled, as the ‘FACHGACVAL’ flag is 
checked in System Privileges. 

 

The ‘Asset Acquisition Override Value’ field is only enabled in the following cases: 
 

1) ‘FACHGACVAL’ flag is check in System Privileges 

2) The asset has ‘Asset Acquisition Value’ and acquisition value transaction is posted in GL 

NOTE: If there is no ‘Asset Acquisition Value’, then there is no value to be overridden. 

If the ‘Asset Acquisition Value’ needs to be adjusted, then enter the new adjusted asset acquisition 
value in ‘Asset Acquisition Override Value’ and click on ‘Create and Post Transaction’ to make a 
journal entry and post the transaction to GL. While posting system will reverse the transaction of old 
batch against new batch if any and create a new transaction under the new batch with new amount. 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  1031 

 

 

If the asset value is needed to be adjusted, enter the ‘Asset Acquisition Override Value’ and click on 
‘Create and Post Transaction’.  
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The ‘Asset Acquisition Value’ and Batch number are updated with new values. 

 

 

ADDITIONS AND BETTERMENTS 

Add the asset to which betterments are to be added in ‘Additions and Betterments’ screen. 

 

 

After adding betterments to the asset, click on Save. Saving the betterments would enable the 
‘Select’ checkbox. 
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Select the asset to which additions and betterments are to be posted and click on ‘Create and Post 
Transactions’. 

Upon clicking ‘Create and Post transaction’, a pop-up launches to select the post date. 

 

 

After clicking on POST, an alert message is displayed ‘Addition/Betterment Transaction(s) Created 
and Posted successfully against batch number:’. Batch number is generated, and corresponding 
posting is done in GL.  

 

 

Click ‘OK’ to go to ‘Report Configuration’ pop-up. Click ‘Run Report’ to view the report, click ‘close’ to 
close the pop-up. After generating the report or closing the report configuration pop-up, batch number 
is shown in the batch column against the corresponding asset. 
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Once the transaction is posted, the selected line is locked for update. 

 

DISPOSAL OF FIXED ASSETS 

Select the asset to be disposed, enter the disposal date. 

 

Click on Save to enable all the fields 

 

Enter the disposal approval code, customer for sale of asset and Invoice for sale of asset field. If 
there is any ‘Amount Recovered’ after sale of asset, it must be entered in the ‘Amount Recovered’ 
field. If there is no amount recovered, it should be left blank. The Debit and Credit Department and 
Account field will be enabled if there is a value in ‘Amount Recovered’. Enter the department and 
accounts to which the recovered amount is posted.  
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Click on ‘Create and Post Transaction’ button to make a journal entry and post to GL. Upon clicking 
create and post transaction, an alert message is displayed ‘Asset Disposal Transaction Created and 
Posted successfully against batch Number:’. Batch number is generated, and corresponding posting 
is done to GL. 

 

Click ‘OK’ to go to ‘Report Configuration’ pop-up. Click ‘Run Report’ to view the report, click ‘close’ to 
close the pop-up. After generating the report or closing the report configuration pop-up, batch number 
is shown in the batch column against the corresponding asset. 
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Disposal of Fixed Asset: 
 

Asset  

Net 
Book 
Value 

 Amount 
Recovered 

Amount 
Posted  

Asset-
1 8000 0 8000 

Asset-
2 8000 8000 16000 

Asset-
3 0 0 0 
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Asset  

Net 
Book 
Value 

 Amount 
Recovered 

Amount 
Posted  

Asset-
4 0 8000 8000 

 

No GL transaction would be created for ‘0’ line.  

The ‘Net Book Value’ amount is posted to the default accounts in control file.  

Asset Maintenance – Import Function (20.24714) 

Added the ability to import records in Asset Maintenance program. 

The following are the fields that can be imported for an asset. 

Asset Code*, Name, Description, Type*, Capital Approval Code, Insurance Group, Activation Date*, 
Interest Type, Fair Market Value, Interest Rate Override, Replacement Value, Lease Type*, Tax 
Exempt*, Is there a Lien? *, Category*, Depreciation Method, Economic Life, CCA Class, Expected 
Life in Months, Residual Value, Original Cost, Initial Depreciation, Initial Months, Equipment Class, 
Home Location, Actual Location. 

 

Asset Management > Fixed Assets > Assets > Enter Assets 

The import function follows standard CMiC Import process, where users will be able to download a 
csv template, create a csv file of asset records and upload for validation and import into the Asset 
Maintenance screen. 

Added “Include Disposed Off Assets” Checkbox in ‘Asset Query’ 
Program (22.54640) 
New “Include Disposed Off Assets” Checkbox is added in ‘Asset Query’ Program.  
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When the Checkbox: “Include Disposed Off Assets” is checked then the Disposed off Assets will get 
displayed in the Assets Query. 

When the Checkbox: “Include Disposed Off Assets” is Unchecked then the Disposed off Assets will 
NOT get displayed in the Assets Query. 

Modification with an example: 

Asset: ASSET201 – Not Disposed yet. No Disposal Date. 

 
 

In Asset Query when User Unchecks the “Include Disposed Off Assets” Checkbox then Asset201 is 
displayed. 
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Asset: ASSET201 – Asset is Disposed successfully. Disposal Date: 27-05-2022 

 

 

In Asset Query when User Checks the “Include Disposed Off Assets” Checkbox then Asset201 is 
displayed. 

 

 

In Asset Query when User Unchecks the “Include Disposed Off Assets” Checkbox then Asset201 is 
NOT displayed. 
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Form Letters 

This section is currently under development. 

General Ledger 

Year End Procedure – Reopen Previous Year Button (16.14184) 
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Retearn.fmx 

Added a button 'Re-Open Previous Year' to the Year End Procedure form.  When pressed, the 
company current fiscal year (comp_fiscal_yr) will be kep equal to the current, the department current 
year (dept_yr) to the current, and department closed year (dept_close_yr) to the one before 
previous.For example, if the company current year is 2016, then re-opening previous will do the 
following: comp_fiscal_yr = 2016, dept_yr = 2016 and dept_close_yr = 2014 
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This button is secured with a privilege ‘GLREOPENYR’. The default value is un-checked for all roles. 

Users have to assign this previlege to roles/users as required. 

 

When pressed, will popup a confirmation message for the users to accept or cancel the action. 
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If a specific department is to be re-opened, then enter the value or else leave blank for all 
departments. 
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Ability to Deactivate a Department – User Document (16.14679) 
 

All examples and screenshots are from TESTV10_X environment. 

Overview: 

In order to provide the new functionality of deactivating a department, CMiC has added a new flag 
"Active" to the Department Entry program. Also, a new user privilege "View Inactive Departments" 
has been added to the system. This new privilege is used in the database view DA.DEPT, so the 
standard validation routines would validate only active departments.  

If the user has this new privilege, then he will be able to see both active and inactive department 
codes in department LOVs for all screens where department LOVs exist (the same way how the 
system worked before incorporating these new changes).  If the user does not have this privilege, 
then he will see only the active department codes in the department LOVs. 

Note: The only exception from this rule is the Maintain Departments program (General Ledger -> 
Setup -> Local Tables -> Maintain Departments):   
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This program allows to change the status of a department by checking /unchecking the corresponding Active 
Flag; therefore, both active and inactive departments are visible for the users, regardless the user’s privilege 
“View Inactive Department”.  
  
Settings and Examples: 
 
All examples below are using the settings above: there are only two department codes; the department code 
“00” is active and “01” is inactive. 
 
Example 1: The user has the System Privilege GLVINADPT (“GL: Allow User To View Inactive 
Departments”): 
 

 
 
In this case the user should see both “00” and “01” codes in the department LOVs. A couple of screenshots 
below would demonstrate this functionality: 
 

a. GL User Defaults screen (LOV for Default Department): 
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b. Account by Department screen (LOV for Dept Code): 

 
 
Note: The user will see the same Department List (both “00” and “01” codes) on all screens where 
department LOV exist. 
 
Example 2: The user does not have the System Privilege GLVINADPT (“GL: Allow User To View Inactive 
Departments”): 
 

 
In this case the user should see only the department code “00” in the department LOVs. In order to 
demonstrate this, we would use the same screens as in the Example 1: 
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a. GL User Defaults screen (LOV for Default Department): 
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b. Account by Department screen (LOV for Dept Code): 

 
 
Note: The user will see the same Department List (only the “00” department code) on all screens where 
department LOV exist except “Maintain Departments” screen. 
 
Summary: 
 
CMiC has introduced a new functionality: the ability to activating/deactivating a department. To implement it 
CMiC has added a new flag "Active" to the Department Entry program. The new user System Privilege "Allow 
Users To View Inactive Departments" has been added to the system. This new privilege is used in the 
database view DA.DEPT, so the standard validation routines validate only active departments.  
 
The users with this privilege are able to see both active and inactive department codes in the department 
LOVs for all screens where the department LOVs exist; the users without the privilege could see only active 
department codes in the department LOVs. 
 
The GL Maintain Departments program screen is the only exception: both active and inactive department 
codes are visible for all users regardless their status of “Allow Users To View Inactive Departments” privilege.  

Ability to Allocate Different Percentage for Each Account in ‘Cost 
Pool Allocation’ (19.90824) 

Ability to add different allocation percentage for each account in ‘Accumulate’ pop-up screen for ‘Cost 
Pool Allocation’. 

Modifications 

• Added a new field ‘Allocation Percentage’ in accumulated pop-up screen. 

• Use Lite Editor to display the new hidden field ‘Allocation Percentage’. 
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• Total allocation will be calculated on the new Allocation Percentage for each account 
defined in the accumulated pop-up screen. 

The following screen shows the modification performed 

A new column added in ‘Accumulated’ pop-up screen. Allocation percentage can be mentioned to 
determine the amount to be calculated to prorate for each account. If allocation percentage is NULL, 
then it will be treated as 100%. ‘Allocation Percentage’ can be defined in the range of 0% - 100%. 
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Examples: 

Cost Pool Allocation screen   

 

 

Accumulate pop-up screen 
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Allocating cost pool 

 

 

Leaving the allocation percentage null 
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Allocation percentage 50% 
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Ability to Close Period for Individual Modules for Multiple 
Companies Simultaneously (19.86332)  

A new program ‘Multi company Period Close’ is added in GL which allows users to close period for 
individual modules for multiple companies simultaneously. 

Modifications 

General Ledger > Period End > Multi Company Period Close 

Program added in GL > Period End > Multi Company Period Close 

New program added: GL > Period End > Multi Company Period Close  
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Select Char Code: Enter the chart code. 

 

This program allows user to close period of multiple companies and different module simultaneously. 

 

Next Year: Enterable field, enter the next fiscal year for the company or module.  

Next Period: Enterable field, enter the next period for the company or module. This should be a valid 
period in period table.   

 

Year-end procedures are not incorporated – user must manually perform year-end using Perform 
Year End program. 

GL period cannot be closed individually for any company. GL period (Company current period) should 
be in sync with period of all modules and must be closed along with all the modules. 

Modules current period can revert till Company Current Period 

Period cannot be changed to a GL Period which is already closed 

AP, AR period cannot close if unposted batch exist in the period 

GL period of a company will be closed when following requirements are met: 

All the modules should be in same period as of company current period 

All modules checkbox should be selected and processed along with the GL  

Note: Only GL period of a company cannot be updated  

 

Implementation 

To change the GL period of HLTEST1: 

 

GL > Period End > Multi Company Period Close 

Select all the checkboxes and enter valid Next Period and Year. 
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GL > Period End > Multi Company Period Close 

Click on Process. 

Period of all the modules and company GL period changed successfully. 

 

GL > Period End > Multi Company Period Close 
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Multiple Company period change  

 

GL > Period End > Multi Company Period Close 

Click on [Process] to change the company period. 

 

GL > Period End > Multi Company Period Close 



1058  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

Multiple modules period closed. Period of a module can be reopened till the current period of 
company. 

 

GL > Period End > Multi Company Period Close 

 

AP Period of HLTEST3 company – reverting to 2019-01 period 

 

GL > Period End > Multi Company Period Close 
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AP Period changed to previous period successfully. 

Closing period 12 for a company (year-end)  

 

 

Company period and all modules period changed to next fiscal year and 1st period successfully.  

NOTE: To perform Year-end procedure, user must manually perform year-end procedure in GL > 
Period > Perform Year End. 

Module period cannot be closed if unposted batch exists for current period. 
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Unposted batch in AP for HLTEST1. 

 

Changing period of AP in Multi Company Period Close. 
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Alert message is shown if unposted batch exist in AP Current Period. 

Accounts Receivable 

 

 

Closing current AR period in Multi Company Period Close. 
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Alert message is shown if there are unposted batch in AR Current Period. 

Ability to Process Multiple Cost Pool Using Pick List (19.90825)  

Ability to process multiple cost pool using pick list.  

Modifications 

Added new program in GL > Setup > Local Tables: ‘Cost Pool Pick List’. 

New field is added in GL > Transaction > Allocate Cost Pool: ‘Cost Pool Pick List’. 

 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  1063 

The following screen shows the modification performed. 

 

General Ledger > Setup > Local Tables > Cost Pool Pick List 

‘Cost Pool Pick List’ program will allow user to create a pick list for cost pool.  

 

Pick List Code – Section 

This section is used to create pick lists. Use the Pick List Code and Description fields to enter a 
code and description for a pick list. 

If the pick list being defined is to be dynamic, meaning that cost pools are added based on the 
specified criteria when the pick list is used (including any new ones), then check the ‘Dynamic’ 
checkbox. 

To enter the selection criteria for creating a dynamic list, use the [Selection Criteria] button. If 
the list is small and not required to be dynamic, move directly to the Fixed Entity List section to 
manually enter the required cost pools for the pick list being defined. 

Dynamic – Checkbox 

If the pick list being entered is to be dynamic, meaning that each time it is used, the module will 
re-create the list, ensuring that any new cost pool that match the entered criteria will be captured 
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in the list, check this box. If this box is unchecked, the list is to be static, meaning the module will 
not recreate the list each time it is used, and the cost pool in the list are manually entered in the 
Fixed Entry List section. 

NOTE: If the list is dynamic, it is possible to still use the Fixed Entity List section to append cost 
pools to the cost pool selected by the selection criteria. 

[Selection Criteria] – Button 

 

Pgm: SDPICKR – Selection Criteria 

This button’s Pick List Selection Criteria pop-up window is used to build a pick list of cost pool 
based on the selection criteria lines specified in the second Selection Criteria section. All cost 
pools satisfying the specified criteria lines will be added to the pick list. 

In the second Selection Criteria section, use the Field Code field to select a cost pool record’s 
field to use to create a selection criteria line for finding the desired departments to add to the 
pick list. Only one field code is available for Cost Pool Pick List. 

Use the Operator Code field to select the required comparison operator for the selection criteria 
line. 

The Value field is used to enter the value to compare against the selected department record’s 
field: 

If the selected comparison operator is “=”, the Value field’s value needs to be literal. 

If the “Like” operator is selected, use the % wildcard in the Value field (e.g., %23%).  

If the “In” operator is selected, enter literal values in the Value field separated by commas. 

To view the results of the selection, press the [Show Matching] button. 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  1065 

[Delete Pick List] – Button 

Select a pick list using the selection area and click on the [Delete Pick List] button to delete the 
pick list. 

Fixed Entity List – Section 

This section is used to manually enter the required cost pool for a fixed pick list. It is also used to 
enter cost pool to append to a dynamic pick list of cost pools. 

Example: 

 

General Ledger > Transaction > Allocate Cost Pool 

To process a cost pool pick list, select the new field ‘Cost Pool Pick List’ in the ‘Allocate Cost 
Pool’ program. 

All the cost pool in the cost pool pick list are processed together and allocated. 

Period End Unrealized Foreign Currency Gain/Loss Posting (19.90246) 

– Beta Version 

A new program ‘Accrue Unrealized FX Gain/Loss’ is added to GL>Utilities menu. 

This is to identify all open AP Vouchers & AR Invoices with the transaction currency being different 
from the Company currency, calculate the currency Gain/Loss on the outstanding amounts, and post 
as GL accrual transactions.  

To print an edit list and posting reports of ‘Unrealized FX Gain/Loss’ transactions.  

This program is added under the GL>Utilities menu in the CMIC standard tree view. 

Modifications: 

Created a program to generate accrual transactions for unrealized foreign exchange Gain/Loss 
amounts on ALL ‘open’ AP Vouchers and AR Invoices and then post. 

• Added AP Control > Accounting > Unrealized FX Gain/Loss Account Field. 

• Added AR Control > Accounting > Unrealized FX Gain/Loss Account Field. 

• Added a Program to the Menu > GL > Utilities > Accrue Unrealized FX Gain/Losses. 
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o Added a Program Train ‘Accrue Un-Realized FX GAIN/LOSS’, with the following 
programs: 

▪ Create Transactions 

▪ Print Edit List 

▪ Post Transactions 

Important Notes:  

• Since this is an accrual posting, users must perform this as a month end (End of GL Period) 
task. 

• This must be performed only once at the end of each period, to avoid the risk of accruals 
posted multiple times.  

• The Generated Transactions will be posted as ‘Accrual’ transactions. (Accrual flag set as ‘Y’). 

• Accrual reversals can be performed either manually or automatically with the GL Control flag 
for automatic reversal checked as ‘Y’. 

• The postings will be one set of GL Entries for AP Gain/Loss and another set for AR Gain/Loss 
for each currency with open voucher/invoices. 

• The GL Transaction postings are summed up amounts per currency. 

• The unrealized FX Gain/Loss accruals will be posted in GL, to the AP/AR Control Currency 
Gain/Loss accounts. The posting will be exactly as the actual posting of Currency Gain/Loss 
would take place. The newly created accrual accounts will be used as off-set accounts for 
these accruals.  

Programs and Changes: 
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Accrue unrealized FX Gain/Loss: 

 

 

Accrual Processing Example with distribution: Exchange Rate Setup: 

 

 

AP / AR Voucher/Invoice Posting: 

 

Comp 
Business 
Partner 

Type 
BP Code Curr Invoice# 

AP/AR Invoice 
Posting 

Amount 
Currency 

Conversion 
Exchange 

Rate 

ZZ Vendor BP7777 CAD BP7777-11 January 1, 2020 10000.00 CAD to USD 0.7702278 

ZZ Vendor BP7777 CAD BP7777-12 January 1, 2020 18000.00 CAD to USD 0.7702278 

ZZ Vendor LENOVO MXN LENOVO-11 January 1, 2020 25000.00 MXN to USD 0.0528036 

ZZ Vendor LENOVO MXN LENOVO-12 January 1, 2020 20000.00 MXN to USD 0.0528036 

ZZ Customer CANCOM CAD AR000016 January 1, 2020 45000.00 CAD to USD 0.7702278 

ZZ Customer CANCOM CAD AR000017 January 1, 2020 32000.00 CAD to USD 0.7702278 

ZZ Customer ZZ-EANDL MXN AR000018 January 1, 2020 70000.00 MXN to USD 0.0528036 

ZZ Customer ZZ-EANDL MXN AR000019 January 1, 2020 55000.00 MXN to USD 0.0528036 
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Outstanding AP Vouchers /AR Invoices: 

 

Comp 
Business 
Partner 

Type 
BP Code Curr Invoice# 

AP/AR FX 
Gain/Loss Accrual 

as of  

Vou/Inv 
Outstanding 

Amount 

Currency 
Conversion 

Exchange 
Rate 

ZZ Vendor BP7777 CAD BP7777-11 March 31, 2020 5000.00 CAD to USD 0.7461807 

ZZ Vendor BP7777 CAD BP7777-12 March 31, 2020 10000.00 CAD to USD 0.7461807 

ZZ Vendor LENOVO MXN LENOVO-11 March 31, 2020 10000.00 MXN to USD 0.0509681 

ZZ Vendor LENOVO MXN LENOVO-12 March 31, 2020 12000.00 MXN to USD 0.0509681 

ZZ Customer CANCOM CAD CANCOM-11 March 31, 2020 10000.00 CAD to USD 0.7461807 

ZZ Customer CANCOM CAD CANCOM-12 March 31, 2020 16000.00 CAD to USD 0.7461807 

ZZ Customer ZZ-EANDL MXN EANDL-11 March 31, 2020 40000.00 MXN to USD 0.0509681 

ZZ Customer ZZ-EANDL MXN EANDL-12 March 31, 2020 25000.00 MXN to USD 0.0509681 

 

 

 

 

 

Accrual Posting Distribution: 

 

Company Department Account Account Name Dr Cr Source Currency 

ZZ 00 5000.105 AP/AR Currency Gain/Loss   360.71 AP CAD/USD 

ZZ 00 5000.105 AP/AR Currency Gain/Loss 625.22   AR CAD/USD 

ZZ 00 5000.115 FX Currency Gain/Loss Accrual 360.71   AP CAD/USD 
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Company Department Account Account Name Dr Cr Source Currency 

ZZ 00 5000.125 FX Currency Gain/Loss Accrual   625.22 AR CAD/USD 

        
Company Department Account Account Name Dr Cr Source Currency 

ZZ 00 5000.105 AP/AR Currency Gain/Loss   40.38 AP MXN/USD 

ZZ 00 5000.105 AP/AR Currency Gain/Loss 119.31   AR MXN/USD 

ZZ 00 5000.115 FX Currency Gain/Loss Accrual 40.38   AP MXN/USD 

ZZ 00 5000.125 FX Currency Gain/Loss Accrual   119.31 AR MXN/USD 

 

 

 

 



1070  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

Print GL Documents in a Different Currency (20.23040) 

Added the ability to present financial data in a currency different from the home currency of 
companies used in the consolidation code. 

When printing a GL Document, user will be able to optionally specify in which currency all financial 
information should be presented on the report: 

 
 

The system will determine conversion rate from home currency of the consolidation code used in the 
report and the report currency. This rate will be determined as GL Exchange Rate as of the last day 
of the report’s fiscal period: 

 

All amounts calculated in the home currency will be multiplied by this conversion rate thus converting 
them to the report currency. If currency is not specified, then report will calculate amounts in home 
currency.    
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Restrict Posting of own batches in AP & GL (19.88285) 

Created a system options flag and two role privileges that the users can be restricted to post their 
own batches in AP & GL application. 

To provide a new functionality for controlling transaction batch postings in Accounts Payable and 
General Ledger applications. This modification is aimed at segregation of duties and to stop 
false/incorrect transactions. 

The users who create AP/GL transaction batches, must NOT be allowed to post their own batches.  

A system Options flag ‘Restrict posting of current users own GL/AP batch’ is created for this purpose. 

When checked, the new functionality is applicable, and the following will happen:  

 

• In Transaction Entry Programs: Users can Edit their own Batches but should NOT be able to 

view or Edit Other Users Batches. 

• In Print Edit List Program: All the Users Batches Must be present in Print Edit List for view, for 

all the Users. 
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• In Posting Screens: Users can post Other Users batches but will NOT be allowed to Post 

their own Batches. 

• Users will not be allowed to print their own AP manual checks only. 
 

Two Role privileges are programed, one each for AP and GL. 

• APPOSTCUR - Allow to post current users AP batches 

• GLPOSTCUR - Allow to post current users GL batches 

Only those users with the new privileges will be able to View/Edit other Users Transactions and 
allowed to post their own and other’s batches as well.  
 
The Programs where this modification applies are: 

• GL Enter Transactions (TRANENT) 

• GL Posting (GLPOST) 

• GL Create Recurring Transactions (RECURPST) 

• AP Prepare Vouchers Program (APRGPUSH) 

• AP Voucher Entry program (VOUCHENT) 

• AP Enter Debit Credit Memo (VMEMOENT) 

• AP Adjust Voucher (VOUADJ) 

• AP Process Recurring Entries (RECVCRE) 

• AP Posting (APPST) 

• AP Enter Manual Check (APCHQMAN) 

When this modification is in effect with the System Options Flag checked (Y), the following existing 
role privileges will be ignored. 

• APPB   - Allows the user access to AP batches belonging to other users 

• GLPB  - Allows the user access to GL batches belonging to other users 

• GLRECENT - Allows the user access to GL recurring entries belonging to other users 

NOTE: No other programs in AP & GL are modified. This modification applies only when the System 
Options Flag is checked (Y). 

 
Modification Details with Examples: 
 
System Options: A flag ‘Restrict posting of current users own GL/AP batch’ option has been added 
to System Options > Financials Tab. The default Value is Un-Checked (N). 

 

 

Role Privileges: Added two system privileges ‘Allow to post current users GL batches’ and ‘Allow to 
post current users AP batches’. The default Value is Un-Checked (N). 
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Examples: 
 

GL Enter Transactions (TRANENT): Batch LOV will show only those batches that have been 
created by the user 

 

 

GL Posting (GLPOST): Batch LOV will not display any batches created by the user. 
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The following error is returned if users try to post any batch created by themselves: 

 

 

GL Create Recurring Transactions (RECURPST): Added condition on Batch Number LOV so that 
user cannot update transactions created by other users. 

 

 

AP Prepare Vouchers Program (APRGPUSH): Added condition on Batch Number LOV. Users can 
only view batches created by themselves. 
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AP Voucher Entry program (VOUCHENT): Added condition on Batch Number LOV. Users can only 
view batches created by themselves. 

 

 

AP Enter Debit Credit Memo (VMEMOENT): Added condition on Batch LOV. Users can only view 
batches created by themselves. 

 

 

AP Adjust Voucher (VOUADJ): Added condition on Batch LOV. Users can only view batches 
created by themselves. 
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AP Process Recurring Entries (RECVCRE): Added condition on Batch LOV. Users can only view 
batches created by themselves. 

 

 

AP Posting (APPST): Batch LOV will not display any batches created by the user. User gets below 
error message when manually enters batch number created by themselves and tries to post it. 

 

 

AP Enter Manual Check (APCHQMAN): Users will not be allowed to print their own AP manual 
checks. User gets below error when Print Check button is clicked, for the batch created by the user 
themselves. 
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Month-End Foreign Currency Reporting (19.90246) 

Requirements 

Provide utility to recognize unrealized foreign currency exchange gain/loss (further as FX Gain/Loss). 
This transaction is different from already existing Accrue FX Gain/Loss transaction as follows: 

- It is not an accrual transaction 

- It uses FX Gain/Loss and Owner Equity accounts 

- It considers currency rate used in the previous transaction 

Important Notes:  
1. Existing program Accrue Unrealized FX Gain/Loss is further modified to allow for creation of non-

accrual transactions that affects existing FX Gain/Loss account and an Owner Equity account (a 

new account).  

2. Users can create such transaction as often as once per GL period.  

3. Important element of recognizing unrealized FX Gain/Loss is that every time we can only 

recognize a gain or loss that occurred since previous recognition or invoice entry, whichever 

comes last.  

4. In order to know when the previous recognition was and how gain/loss changed since then, 

system needs to store currency conversion rates used in previous recognition in the History 

Table. 

Change Request 

1.  “Accrue Unrealized FX Gain/Losses” program under GL Utilities menu node has been labeled as 

“Process Unrealized FX Gain/Loss”.  

2. Window name of the program has been changed to “Process Unrealize FX Gain/Loss” so that it 

matches the menu node label. 

3. A new Checkbox “Recognize FX Gain/Loss” has been added. Value of this checkbox will 

determine what kind of transaction is created. If the value is N (unchecked), then the program will 

create accrual transactions (current functionality). If the value is checked, then a non-accrual 

transaction 

4. Each time FX Gain/Loss transactions are created (accrual and non-accrual) its information is 

stored in a new DB table GLFXRECHIST_TN. 

5. To keep information of Historical Rates, a new DB table GLFXRECHISTDET_TN is created. 

6. Added AP Control > Accounting > FX Gain/Loss Adjustment field. 

7. Added AR Control > Accounting > FX Gain/Loss Adjustment field. 

8. If checkbox “Recognize FX Gain/Loss” is unchecked, then the program continues functioning as 

before – creating accrual transaction.  

9. If checkbox “Recognize FX Gain/Loss” is checked, then the program creates a non-accrual 

transaction as described in the Example below. 
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Example  

 

 
Company CAN1, Currency CAD 

1 invoice weas entered in March of 2020: 

Date Item Amount Currency FX Rate 

5-Mar-20 AP Invoice 1 1,000.00 USD 1.35 

 

At the end of March (Fiscal year 2020, fiscal period 3) currency conversion factor was as follows: 

From Currency To Currency  FX Rate 

USD CAD 1.38 

 

Unrealized FX Gain/Loss was recognized at the end of March. Amount of gain or loss was determined using 

the following rule 

FX Gain/Loss = (Outstanding Invoice Amount) * (Current Conversion Rate – Invoice Conversion Rate) 
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For USD AP Invoice 1 FX Gain/Loss was equal to 1,000.00*(1.38 – 1.35) = 30.00 CAD 

Distribution of this transaction was recorded as: 

AP FX Gain/Loss 30.00   CAD 

AP Realized FX Gain/Loss   30.00 CAD 

 

At the time of posting of these transactions, current conversion rates used in calculations were stored in 

History log: 

Company  Year Period From Currency To Currency FX Rate Rate Date 

CAN1 2020 3.00 USD CAD 1.38 31-Mar-20 

 

Rate date is always recorded as the last date of the GL period. 

By the end of April, 2020 outstanding amount in AP was: 

Date Item Amount Currency FX Rate 

5-Mar-20 AP Invoice 1 1,000.00 USD 1.35 

 

At the end of April, 2020 (Fiscal year 2020, fiscal period 4) currency conversion factors were as follows: 

From Currency To Currency  FX Rate 

USD CAD 1.36 

 

Unrealized FX Gain/Loss was recognized at the end of April. Since FX Gain/Loss was already recognized 

previously, we need to start using historical rates recorded at that time. If invoice date is prior to the historical 

rate date, then we can only recognize gain/loss relevant to that historical rate. If, however, invoice date is after 

the historical rate date, then we need to recognize loss relevant to the invoice rate. In our example historical 

rates were recorded as of March 31 2020. This rule can be formulated as follows: 

FX Gain/Loss = (Outstanding Invoice Amount) * (Current Conversion Rate – Starting Rate) 

Where Starting Rate = latest of Historical Rate and Invoice Rate 

If Historical Rate does not exist, then Starting Rate = Invoice Rate 

Applying the rule to each invoice, still outstanding in April, we determine the starting rate: 

Date Item Curr Relation to Rate Date Starting Rate FX Rate 

5-Mar-20 AP Invoice 1 USD Before Historical 1.38 

 

For USD AP Invoice 1 FX Gain/Loss is equal to 1,000.00 * (1.36 – 1.38) = -20.00 CAD 

Distribution, related to USD invoices: 

AP FX Gain/Loss   20.00 CAD 

AP Realized FX Gain/Loss  20.00  CAD 

 

Again, when these transactions are posted, currency conversion rates need to be recorded in History Log: 

Company  Year Period From Currency To Currency FX Rate Rate Date 

CAN1 2020 4 USD CAD 1.36 30-APR-20 
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Programs and Changes 

AP Control: 
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AR Control 

 
 

“Accrue Unrealized FX Gain/Losses” program renamed as “Process Unrealized FX Gain/Loss” & New 
Checkbox: “Recognize FX Gain/Loss”. 
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Added Attachments and Notes to Toolbar of Reverse/Recreate 
Posted Transactions program (20.24460) 

Requirement: 

To retrieve documents attached to posted General Ledger Transaction, Attachments and Notes are 
added to Toolbar of Reverse/Recreate Posted Transactions program. 

Functionality Design: 

When Attachments or Notes are added in any batch of GL Enter Transactions Program, after posting 
the batch, the Attachments or notes can be found under GL>Utilities>Reverse/Recreate Posted 
Transactions program with the same batch number. 

Also, User will be able to add more attachments and Notes through Reverse/Recreate Posted 
Transactions program for the same batch Number. 

Example: 

In GL Enter Transactions Program, User has added 1 Attachment and 1 Notes to Batch: 5303 and 
posted the batch. 

 

 

After Posting the Batch, User goes to GL>Utilities>Reverse/Recreate Posted Transactions program. 

Batch: 5303 contains the same Attachment and Notes as attached in GL Enter Transactions 
Program. 

Also, User can add more Attachments and Notes to the Batch. 
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Import Functionality added to Enter Bank Transfers Program 

(20.27483) 

Functionality Design: 

Import Functionality has been added to Enter Bank Transfers Program. 

 

Reports - Financial Document Formatter 2.0 (Beta Version) (21.42181) 
 

Overview: 

The Financial Document Formatter 2.0 will allow users to easily create financial statements to show 
trends and identify the business cash position. These operations are performed using the process 
train that runs along the top of the main page. 

Version 2.0  
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Modifications: 

Process:  

A new train process has been added to include Document Formatter 1.0 and 2.0 programs. 

 

 

General Ledger> Reports> Financial Document Formatter 

Create Document: 

 

To add a document in Financial Document Formatter 2.0 use the create document button in the 
toolbar. 

 

Newly Created FDF 2.0 Documents automatically get version number 2 stamped on them. 

 

FDF 2.0 will not allow documents created in FDF 1.0 to open in FDF 2.0 directly. Those documents 
will have to be copied to Version 2 using Copy Document functionality. 

 

 

General Ledger> Reports> Financial Document Formatter> Financial Document Formatter 2.0 window 

Version 2.0 Flag: 

The copy program now has the conversion process to upgrade Documents created in Financial 
Document Formatter 1.0 to be accessible in the Financial Document Formatter 2.0 Program. 

 
Copy Document window from Financial Document Formatter 
 

From Document Field Shows from Document version (1.0 or 2.0) while selecting the document to be 
copied from the LOV. 
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A checkbox "Version 2.0" beside the To Document field. If From Document is already of version 2.0, 
then this checkbox will be checked and disabled - user will not be able to downgrade 2.0 to 1.0. 

Column Title Filled in: 

Description Line 1 and Description Line 2 are filled in by default while creating a new document in 
FDF 2.0 and are limited to 15 characters long. Users have the option to maintain the default 
description or change it based on the need. Unless entering Description Line 1 user cannot save the 
column created, meaning Description Line 1 cannot be left blank. 

Column description is filled in FDF2.0 for those documents which previously did not have any 
descriptions/titles during Copy Document functionality from Version 1.0 to Version 2.0. 

 

Add New Column window while creating a new document. 

T6 Total Line: 

Ranges created in Financial Document Formatter 2.0 will automatically reserve T6 for Total lines. T1-
T5 are available to store all other totals that are not applicable to ranges. T6 will no longer be 
accessible in the Total LOV. 
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Sub-total level in New Document Creation window. 

Print: 

The Print report setting allows for currency selection when executing a browser print.  

 

New Document Creation window with print report settings for print preview 
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Print Preview 

BI Query: 

A default query has been applied for Range rows ‘GL Transaction Drill Down’. The Company, 
Account, and Year fields parameters are passed from Financial Document Formatter to query when 
the drill is applied. 

 

 



1088  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

HIDE Flag: 

Print flag is renamed as the HIDE flag, both in row and column definition. The functionality of HIDE 
checkbox in FDF 2.0 is the same as Print checkbox in FDF 1.0. 

When a line item or Column item needs to be hidden while printing the document, check the HIDE 
flag. 

 

HIDE Flag in Row definition in Document Creation window 
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HIDE Flag in Column definition in Document Creation window 

Renamed Column Functions in FDF 2.0: 

Following are the Functions and their Function Code under Column definition whose names have 
been renamed from that of FDF 1.0. 

 

Function 
Code Old Code New Code 

P5 Prior Period Current Balance Previous Period Current Balance 

P6 
Prior Year Curr Period 
Balance Previous Year Current Period Balance 

Y5 PRPERIOD YTD Balance PRPERIOD Current Balance 

YA Prior Year End MTD PRV Year-End MTD 

YB Prior Year End Balance Prv Yr End Balance 

YQ Prior Year End QTD PRV Year-End QTD 

 

The above Functions can be seen in the below screen in Column definition in FDF 2.0. 
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Function LOV while add a New Column 

 

 

Function LOV while add a New Column 

Added Import Button to Maintain Department Program (21.48741) 
Added Import button to Maintain Departments program 
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Importing Data: 

The [Import] button is added to the Maintain departments screen. 

 
 

Import a few departments. 
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Data imported successfully. 

 

Updating Inactive Department (22.52670) 

Overview 

Role level system privilege is added to allow users to update inactive department.  

GLINVADPT: Allow User To View/Update Inactive Department. By default, this is checked for user.  

 

 
 

Modifications 

Case 1: GLINVADPT – Un-checked (N) 

 
 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  1093 

Validation is raised upon updating an inactive department  

 
 

Case 2: GLINVADPT – Checked (Y)  
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User can update inactive department successfully.  

 
 

Case 3: Adding New Department  

New Department added and deleted successfully.  
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Case 4: Deleting department with transactions  

 
 

Case 5: Posting to an inactive department.  

 

 

Update Transaction TAC Values (21.49642) 

Overview 

Converted Update Transaction Values in GL Utility to R12. 

Modifications 

‘Update Transaction TAC Values’ program is added in General Ledger utility  
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Path: General Ledger > Utilities > Update Transaction TAC Values  

 

 

General Ledger > Utilities > Update Transaction TAC Values 

This program allows the entry and/or update of any of the 4 available GL TAC code values if the TAC 
code has been defined for the Consolidation Chart of the company. The 4 GL TAC columns also have 
LOV's available. 

 

Company: Select the company code from LOV  

Journal: Select the journal code from LOV  

 

Further data can be queried using selection criteria fields i.e., Account Pick List, Account, From Post 
Date, To Post Date, Batch, Department 

 

Exclude Adjustment and Year End Transactions – Check the flag to exclude Adjustment and Year 
End Transaction from the queried data. By default, this flag is checked.  

After selecting criteria, users must click on [Query Data] button.  

Implementation 

Chart Code: CCCHART  

TAC Codes are defined for CCCHART. 
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TAC values are defined for TAC1 under CCCHART  

 

 
 

Update Transaction TAC Values  

Populate selection criteria and click on [Query Data] button.  

 

General Ledger > Utilities > Update Transaction TAC Values 

GL TAC Activity Report (GL2500)  

 

GL Report – TAC Activity Report (GL2500) 

GL TAC Activity Report by TAV Values (GL2501) 
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GL Report – TAC Activity Report by TAV Values (GL2501) 

Update Transaction TAC Values  

 

Updated TAC values for account 1000.100, 1000.200, and 5000.100.  

 

General Ledger > Utilities > Update Transaction TAC Values 

Update is validated in GL2500, GL2501 report and Transaction Query screen. 

GL TAC Activity report (GL2500)  

 

GL Report – TAC Activity Report (GL2500) 
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GL TAC Activity Report by TAV Values (GL2501) 

 

GL Report – TAC Activity Report by TAV Values (GL2501) 

 

GL Transaction Query  

 

GL Transaction Query 

Human Capital Management 

Addition of a new field “Mid Amount” to the HCM Salary Grade 
Maintenance screen. (16.19956) 

CMiC added a new field “Mid Amount” on Salary Grade Maintenance screen under HCM File 
Maintenance to allow users to enter a mid-range salary by grade. 

Note: Please note that salary range information entered here is for informational purposes only. It 
would be a separate modification to utilize this new information on any other screens or report. 
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Adding Salary Grade 

To add a Salary Grade, use the [Add] button at the top of the screen. This will open two new fields 
above the list of Salary Grades already defined. Code and Description are required fields. 
Enter/Select Code, Description is populated based on selected Code, enter Min.Salary, Mid.Salary, 
Max.Salary amount with effective date and applicable currency. Click on the [Save] button to save 
the record. 

To exit Add Mode without saving any changes use the [Cancel] button. 

Select [Add] Button. 

 

 
 

Enter the required information and [Save] record. 
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Addition of new screen ‘HR Benefit Master Maintenance’ – HCM 
File Maintenance (16.25454) 

Overview: The addition of a new screen ‘HR Benefit Master Maintenance’ works in conjunction with 
the modifications made to Employee Bonus History Program in Employee Console, to enhance the 
functionality and processing order in HCM JSP. 

HR Benefit Master Maintenance: CMiC has created a new JSP screen named ‘HR Benefit Master 
Maintenance’ under HCM File Maintenance. Addition of a New flag named ‘Bonus’ to this HR Benefit 
Master screen. Function of the flag is to display the benefit in HCM Employee Console, Bonus History 
screen. CMiC has also included the HR related flag for ‘dependent enrollment’ in this screen. The 
new flag ‘Bonus’ introduced is only available in HR Benefit Master screen. 

Step 1: PY Master Benefit Setups  

Created three new bonuses in FORMS. Bonuses with Job allocation flag enabled and disabled. 
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Step 2: HCM File Maintenance – HR Benefit Master Screen  

The two newly created Bonus Benefits should now display on the JSP HR Benefit Master Screen. 
The New Benefit Master Maintenance JSP screen will be available and maintainable via the HCM 
JSP under File Maintenance. 

Note: Other benefits and bonuses from PY and HR Master Benefit screen in FORMS are also 
feeding into the new JSP HCM HR Benefit Master Screen 

 

User can select the [Edit] Log Button to check and uncheck flag. 
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Unchecked Bonus flag and saved. CBON Bonus flag is disbaled. 
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Check Flag for Bonus will mark the EBON Code with description EE Bonus Benefit as Bonus. 

 

Apply Field Security to ‘HR Training Classes Program’ – HCM 
Security & Role Maintenance (16.28449) 

Modification made to HR Training Class Program to allow users to Unrestricted and or Hide the Items 
below: Add, Delete and Edit Buttons through Role Maintenance and field security.  
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Security and Role Maintenance 

Under Security>Role Maintenance: Select Assign Field Security 

 
 

Select Program HR Training Classes to assign the field security 
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Add Button, Delete Button and Edit Button are all unrestricted. 

 

 

Assign field security for each of the items, as required: 

 

Update (save) changes 

 

HR Training Classes – Maintain and Schedule Classes 

Go Back to HR Training Classes Screen: As per the field security assigned, HR Training Maintain 
Schedule Classes screen has Add button visible and unrestricted. The Delete and Edit buttons are 
hidden as per assigned field security under the HR Training Classes Program. 

Open previous classes and verify if the field security has been applied. 
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Previous class – Accounting Basic I on the Maintain and Schedule Class has applied field security for 
items Edit and Delete buttons. These items are now hidden and not available on the screen. Only 
Add button is available as per defined security by the user. 

 

 

With the new field security assigned, Add and Schedule a new Class 
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Saved Class 

 

 

Back to Log, Select Class 

 

 

ESS - Open Enrollment & Qualifying Event Rejected Email Notes 
(17.31050) 

CMiC has modified and added the feature to include Notes from a rejected ESS transaction in the 
‘Rejected’ email message that is send to the employee for both Qualifying Events & Open 
Enrollment.  

The open enrollment and qualifying events email subject will now include all notes and 
communication when sending an email to Employee. All notes will be included in the email, by order 
of latest notes first. 

NOTE: Approver does not receive email when employee submits.  
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Prompt Maintenance  

Prompt Maintenance – Rejected Email Text and Properties 

Go to HCM > File Maintenance, under ‘Prompt Maintenance’ screen, and select Query Mode. 

Message Key for Open Enrollment is ‘ESS_Request_Reject_Email_OE’ and Qualifying Event is 
‘ESS_Request_Reject_Email_QE’. Select Query mode, enter the above and execute query. 

User can edit the CMiC standard email message text here, but should not remove the parameters of 
{0}, {1} & {2}. 

HCM Field Tracking new added columns (17.40876) 

CMiC has made modifications to Field Tracking program adding 4 more columns. Column names and 
their mapping details are as follows: 

1. POSITION – is retrieved from Employee profile > HCM Tab  

2. PAY RATE – is based on "Preferred Pay Rate" setup in Employee Profile. 

3. JOB LAST PAID - This information is available in Human Resource > Personal > Employee 
Query and will be retrieved from this form and populate in field tracking HCM screen. 

4. LAST PAID DATE – is retrieved Job Last Paid. This information is available in Human Resource 
> Personal > Employee Query and will be retrieved from this form and populate in field tracking 
HCM screen. 

NOTE: Employee ‘Preferred Pay Rate’ setup – If employee is unionized then system will retrieve rate 
from Union/Trade setup. If Employee is non-unionized, then system will retrieve from trade setup. If 
no setup is found rate will be ‘0’. 

User must have the ‘Include In Field Tracking’ flag checked on the employee profile for the employee. 

User must setup Contact information for the employee in project management under contacts 

HCM Manager – Employee Field Tracking Screen 

Employee Field Tracking screen has the four added columns displayed and populated. 
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Human Resource 

Addition of a new field “Years of Service Update Reason Code” to 
HR Company control screen (15.08775) 

CMiC added a new field under HR - Setup - Local Tables - Control to allow users to setup a Reason 
Code for 'Years-of-Service History Change by Nightly Process'. The nightly utility is modified to use 
the newly added reason code when creating history records instead of using the current default 
reason code from payroll control. 

 

 
 

When the Nightly Payroll Years of Service Update ran, the system updated the Years of Service and 
added a History Record with a Reason Code selected on HR Control. 
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Imaging 

Imaging Control – Third Option (“Mix”) for Use Pretax Amount 
(20.25180) 

 

Added a third option for Use Pretax Amount for Registered Pay Requests drop-down field. The New 
option is "Mix".  In this case, the customer will enter tax included amount in debit column for indirect 
tax and pretax amount in pretax field for direct tax. 
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Job Security for Images in Imaging (20.21738) 

 

A flag has been added to the Imaging Controls screen: “Enable Job Security in Imaging”.  This flag, 
when checked, allows users to view  

only the images tied to the Jobs they have access to, and only applies to the images in Imaging.  It 
does not apply to Images with flysheets that are blank. 

The images that appear in the tree-view on the left in the Image Manager are determined by a 
database view that filters them based on the security setup.   

This new flag to observe job security is in addition to the normal Imaging security. 

NOTES: 
➢ Non-invoice document types and invoice documents with blank flysheets.  Only users in the 

‘Submitters’ imaging security group will see these images. 

➢ The flysheet has been filled in for a registered invoice, and no routing job was specified.  Again, 

only users in the ‘Submitters’ imaging security group will see these images. 

➢ The flysheet has been filled in for a registered invoice or registered RFP, and the routing job is 

specified and found in the secured job view.  The secured job view is used to filter the list. 

➢ the flysheet has been filled in for a voucher-based RFP, and the routing job is specified and found 

in the secured job view.  The secured job view is used to filter the list. 
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Workflow Notifications View Options (20.33953) 

 

Another flag has been added to Imaging Controls Screen: “Close Image Window when invoice 
window is Closed”, This flag when checked, allows users to close the Image as well as the Image 
Manager Flysheet Screen. This flag when unchecked, lets the user have the Image on screen even if 
the flysheet window is closed allowing for any changes to be made. This is an important feature for 
the UI Config with Separate Window Selection. 

Image Manager (Beta) (19.77639, 20.31769) 

 

What has changed: 

• All detail flysheets now use kendo, regardless of if they are Form view or Tabular. 

• Many stylistic changes. 

• The Header buttons now use a spill over menu. 
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• LOV in the header flysheet has been changed. 

Features 

Header strip shows: 

 Document Type   Status 

 Source    Posted indicator (Y/N) 

 Date     Oraseq 

 [Swap View] button – to toggle the view between the document type and the image 

NOTE:  Clients who wish to use this beta version can add it to their JSP tree-view using Menu 
 Maintenance: 

 Example url: test2v12.cmic.ca:xxxx/cmictest12c/SdMenuMaint/showTree.do  

 Example Beta version url:            
 http://test2v12.cmic.ca:xxxx/cmictest12c/ImgMgrBeta/imgMgrStart.do 

 

Added Copy User Comment from Notification to Audit History Flag 
(21.37756) 

This flag is added to make it easy for users to input comments from either of the screens.  

Users can add comments/notes either directly from Subcontract’s screen (for SCRFP) or from 
Notification’s screen. 

To access this functionality: User can go into ADF screen >> Click on Enterprise Content 
Management>> Go to Imaging>> Setup >> Imaging Controls. 

 

 

http://test2v12.cmic.ca:xxxx/cmictest12c/ImgMgrBeta/imgMgrStart.do
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Once the flag is checked, the user can go to Workflow Notifications and add the comments within the 
comments screen as shown below:  

 

The comment then appears within the notes screen: under Review/ Approval. 

Dynamic Flysheet Builder (20.30012) 

This feature encompasses a pipeline process from creation of a flysheet to generating PDFs from it. It 
is a helpful tool to quickly create flysheets adding the required text boxes, fields, radio buttons, 
checkboxes and so on. 

Setup: 

Flysheet Builder can be navigated as follows: 

Path: ADF> Enterprise Content Management> Imaging > Setup> Flysheet Builder 

Once the page opens, the pop up for the fields in a row requirement will come up on the screen.  
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The user can begin by selecting the number of fields: 3 or 4, depending on the Flysheet Design 
Requirement. 

The Flysheet Name can be added, for example: SC RFP Header, Details Flysheet and so on. 

This is a simple Drag and Drop Process: where the fields can be dragged from the right corner and 
placed in any row as follows:  

Main Flysheet 

Hidden Inputs 

Inactive Inputs. 

Process: 

Once the fields are added into the various groups/ areas, the flysheet can be Saved as Draft.  After 
saving, it can be finalized, and the flysheet structure is created successfully. 
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The Generate PDF button click event would open this popup where when the fields are added from 
the Flysheet, that would be used in the PDF that will be generated later. 

This PDF would have editable fields and can be downloaded once the Create Empty PDF is clicked. 

 

NOTE: The fields added can be designed according to the desired length, validations, dropdown texts 
and so on.  
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PDF Generator (21.39092) 

The PDF Generation application can generate dynamic layout PDFs as defined on the Flysheet 
Builder.  Also, it allows radio buttons, checkboxes and dropdown lists as defined in the Flysheet 
Builder.  

It generates the old-style pdf if the flysheet is not dynamic, so if any flysheet is generated from Image 
Manager and not dynamic then it will generate the old-style pdf. 

Source Selection Option (21.38804) 

Once the Flysheet is added and finalized, the Source is created for the Document Type. The 
Document Type can be added in the Source of the user’s choice. The Flysheet Builder once finalized 
creates the Flysheet Structure. Once it gives the popup that the Flysheet Builder structure is created, 
the Source automatically gets added in the backend. 

The Checkbox in Imaging Controls is shown as below. 

The field for source for Collaborate Pay Request group is added as shown in fig 2. 

 

Fig 1: 
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Fig 2: 

 
 

Flysheet Builder – More Enhancements (21.44996) 

Enhancements: 

PM Attachment dropdown- Allows user to select if the Flysheet should go into PM Attachment. 

 

Adding the fields from the Panel to the left side (Flysheet Header) will let user create the header 
Flysheet and corresponding Document Type. The fields can be added in the first part of the Flysheet.  

Save as Draft- Saves the flysheet and creates a background Document Type- that can be opened 
within Image Manager. 

NOTE: Fields cannot be added directly to Inactive inputs- They can be dragged from the Inputs in the 
first section. 

Features: 

Fields can be modified – adding character length, Field name, Radio button options, Checkbox 
options, Dropdown lists, etc. 
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Finalize- Creates a Flysheet Structure successfully as shown in screenshot below. 

 

 

Generate PDF screen will allow user to add fields to the PDF so that user can download PDF to the 
local machine. 

 

Key Points: 

1. Flysheet Builder basically helps to create only the Header Flysheets for any Document Type. 
2. When we create a Header Flysheet from Flysheet Builder- we can add Flysheets to that Flysheet 

from ADF Screen.  
3. Once we create a Flysheet from Flysheet Builder- and if I edit it from ADF program- it can no 

longer be seen in the LOV within Flysheet Builder. 
4. Any fields from panel cannot be moved directly into Inactive Input. First, it can be moved to Inputs 

and then from there, user can drag and drop to Inactive input (Else error message popup occurs) 
5. When you type a flysheet name within Flysheet Builder – the background processor creates a 

same name – Document Type- which can later be edited from ADF screen. Only fields cannot be 
edited- If you do- you won’t be able to see it in the LOV again. 

6. Character length, Mandatory/non-Mandatory fields can be adjusted from the Flysheet Builder.  
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Document Types – Added Show in Tree-view Flag (22.54645) 

Added new flag “Show in Tree-view” in Document types screen.  

Only the document types for which the flag “Show in Tree-view” is checked will be visible in Image 
Manager Document types drop-down.  

 

 

Image Manager 

 

Flysheet Definition – Added New Field 
APRI_TOTAL_PAY_AMT_LESS_HLDBK To RAD_APREGINV_V 
table (22.53352) 

New field APRI_TOTAL_PAY_AMT_LESS_HLDBK is added to RAD_APREGINV_V table. 

This field can be added to flysheet from flysheet definition.  
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Changed the Name for Image Manager and Image Manager Beta 
(22.56020) 

Image Manager is changed to Image Manger Old. 

URL: <server>:<port>/<environment>/ImgMgrOld/imgMgrStart.do 

 

Image Manger Beta is now change to Image Manager (standard). 

URL: <server>:<port>/<environment>/ImgMgr/imgMgrStart.do 

Flysheet Builder – Added Create New Feature (21.50592) 

Added [Create New] button to flysheet builder application.  

User will receive a pop-up “This action will erase your current work, do you want to create a new 
flysheet?” when [Create New] button is clicked from the existing flysheet page. 
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Added Two Flags to populate Original Amount and Routing 
Job/Dept for Comdata Invoice Import (22.58858) 

To populate Original Amount and Routing Job/Dept when Comdata Imaging Invoices are imported in 
Imaging. 

Modification: 

These two flags are added to Imaging Control > Import Invoices Screen. 

1. Populate Original Amount 

2. Populate Routing Job/Dept 

By default, the flags will be unchecked. 

When these two flags are checked, it will populate the Original Amount and Routing Job/Dept when 
Comdata Imaging Invoices are imported. 
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Imaging < Setup < Imaging Control – Import Invoices 

Infrastructure 

Password Requirements For Cloud (20.34663) 
 

The layout of the "Change your Password” page" for Cloud has been updated to include the following 
text indicating the Password requirements: 

1. Minimum of 10 characters 
2. Minimum of 1 upper case character 
3. Minimum of 1 lower case character 
4. Minimum of 1 numerical value 
5. Minimum of 1 special character 
6. Maximum of 2 repeated characters 
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Example: 

 

I/O Email 

This section is currently under development. 

Inventory 

Added Import Feature to Inventory Locations (21.52227) 

Added Import feature in Inventory Location. 

Modifications: 

CMiC has enabled the import for CILOCATION table with the following fields: 

• Location Code 

• Description 

• Type 

• Control Location 
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• Department 

• Invoice Series 

• Zone Code 

NOTE: The location Type must be W (Warehouse) or B (Bin Location). Control Locations must be 
imported first in a separate file. The system validates if the Control Location exists before allowing the 
user to create that record, so the user will need to import all the control locations first, save them, and 
after that import all the child locations that use those records. 

Setup and Import: 

 

The [Import] button is added to the toolbar 

 

 
 

Sample Import file: 

 

 
 

Import the file created above: 
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Jasper Server 
This section is currently under development. 

Job Billing 

G/C Prepare Billing – OCO column in Change Orders pop-up 
(15.08702) 

The G/C Prepare Billing is modified with the following changes: 

1. Terminology of ‘Change Orders’ as PCI 

2. Owner Change Order Column in the ‘PCI’ popup screen 

3. Option to NOT to Re-Calculate ‘Current Complete’ column when ‘Clear Overrides’ is 
performed 

Modifications: 

G/C Prepare Billing: 

1. Main Screen – ‘Change Orders’ button label is modified to read as ‘PCI’ 

2. Billcode Details popup - ‘Change Orders’ button label is modified to read as ‘PCI’ 
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Job PO/WO# assignment and Free Form Invoice Printing (16.23419) 

Added Ability to assign PO/WO Numbers to the Job and allow selection of the Contract using PO/WO 
Number in G/C Prepare Billing program. Also, modified free form invoice format setup with an option 
to print PO/WO# on the free form invoice header. 

Modifications: 

Job Entry Program: 

A new tab PO/WO number is added to the job entry screen. This tab allows users to add PO/WO 
code and description. There is no validation on the PO/WO code, however, no duplicate entries will 
be allowed.  

 

JC > Job Setup Program 
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JC > Job Setup Program > PO/WO tab 

 

JC > Job Setup > PO/WO tab 

The PO/Work Order Number field length is 30 characters and the Description field allows 200 
Characters maximum. These are optional entries for a Job record. If required users may create as 
many records as they require and are free form style without any validations. No duplicate codes are 
allowed. 

G/C Prepare Billing Program: 

The G/C Prepare Billing Screen is also modified with an additional PO/WO Number parameter 
selection. This is optional only. When NOT used, users will still be able to select a Job or Contract 
Code and proceed with Billing preparation. 
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When selecting a PO/WO Number as a parameter, it will be validated against the job Setup table.  

 

JB > G/C Prepare Billing Program 

Also, provided the ability to add new PO Numbers on the fly as well. Users can press the button ‘Add 
New PO/WO’ and invoke the setup screen. 

 

JB > G/C Prepare Billing > ‘Add New PO/WO Entry pop-up program 
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Free Form Invoice Options: 

The JB Invoice Format Setup is modified with a new check box ‘Print PO Number’ under Invoice 
Options tab. 

 

JB > Invoice Format Setup > Invoice Options 

Users may use this option as checked, FOR Free Form Invoice format ‘JBINVPRT’ and during invoice 
printing, the selected PO/WO Number upon billing generation will be printed on the header. 

Auto Add Bill Code to Contract (17.32445) 

Added A control flag in JB Setup to Auto Add Bill Code to Contract. 

CMiC has provided an option on the Job Billing Control File to always add the bill code to the contract 
whenever a phase/category combination is added to the job. If the option is switched on, a new 
phase/category being added to the job will have its associated bill code automatically added to the 
billing contract. 

NOTE: The contract must already exist for the bill code(s) to be added. The user will be required to 
set bill code budgets or manually enter budgets on the contract for these newly added bill codes. This 
is similar to the case when the bill code is automatically added to the contract when phase/category is 
added ‘on the fly’. 

Auto PO# Populates on JBBILL2 (18.59716) 

A new flag "Default" added to the PO/WO Popup on the job setup screen as well as the popup for 
creating new PO/WO on the G/C Prepare Billing Screen. 

The G/C Prepare Billing program modified so that the PO/WO field that has been flagged as default 
will auto populate when the contract/job is specified. The user can change it by selecting a different 
one from the List of Values.  
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NOTES: 

There can only be one default at a time. 

If it is a revision then the program will retrieve the previous PO/WO code from the previous draw. 

If it is a new draw then the program will retrieve the default PO/WO code from JC Job. 

 

Added a new flag ‘Default’ to the PO/WO Popup on the job setup screen 

 

Added a new popup for creating new PO/WO on the G/C Prepare Billing Screen 

 

Add Amount Certified to Standard JBPB Invoice Formats (19.74249) 

Add the Current Payment Due amount to the right section of the Billing invoice, it will be added under 
Certificate of Payment replacing the line on the right side of the word Amount. 

This will be enabled by a new invoice format option that will be added to the Job Billing invoice 
Format setup screen. 
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Modifications are made to all JBPB standard formats. (Including JBPB_U10, JBPB_U11, and 
JBPB_U14 ) 

E.g. 
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Added Column in Cost Transactions Pop-up (19.87635) 

Added the following column to the ‘Cost Transactions’ pop-up in ‘Job Billing preparation’ program. 

PY Tran Desc – Payroll Transaction Description 

This column shows the value posted to the “PY Transaction Description” column in “JCDETAIL” table 
from Payroll application.  

This column is hidden by default and users may unhide and use it next to the already available PY 
Transaction Type field, using the lite editor. 

 

G/C Prepare Billing > Cost Transactions 

Added Clear Overrides Buttons by Bill Code Line (19.75671) 

Modified the G/C Prepare billing screen (ADF JBBILL2) to add 2 new buttons to each tab Group 1 
Summary, Group 2 Summary, Group 3 Summary, Group 4 Summary, Group 5 Summary and Bill 
Code Detail.  

These new buttons will be: 

"Clear Billed Amount Overrides" that will show a pop-up to prompt the user, giving them an option 
whether to clear billed overrides of all records or current record of a particular tab. 

"Clear Retainage Overrides" that will show a pop-up to prompt the user, giving them an option 
whether to clear retainage overrides of all records or current record of a tab. 
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Also provided a checkbox on the group codes / bill codes details. If the user selects group or bill code 
lines and then presses the "Clear Override" button on the group / bill code tabs, the overrides will be 
cleared only from the selected records. In this case there will be no option given to the user to choose 
which lines they want to clear the overrides from. 

 

The user must recalculate the bill once overrides are cleared at the group code / bill code level. 

The PCI detail billing related options (combined, original, changes) will be respected when clearing 
overrides at these levels. 

This will only be done in ADF version. 



1138  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

Added Colors to the Override Lines like in Forms Version (19.78425) 

Added logic to color the override lines in G/C Preparing Billing (JBBILL2). This change is 
implemented in all tabs Summary, Group 1 to 5 Summary and Bill Code Detail. It is also applied to 
the Notification field in the Draw Info section when the message is “Recalculate Bill”. 

TAB: Summary  

 

TAB: Bill Code Detail 
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Added Panel Stretch Layout Components in JBBILL2 (17.44215) 

Added Panel Stretch Layout components to JBBILL2. The components will stretch the tab and the 
table of Bill Code Detail section to occupy all the available space gained by collapsing the top 
sections of the program. 
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Custom Modification: 5 Levels of Grouping in Job Billing (19.86729) 

Provides support for up to 5 separate levels of grouping in the below invoice formats: 

• JBPB_U10 

• JBPB_U10_OWNER 

• JBPB_U10OC 

• JBPB_U10Q 

• JBPB_U10Q2 

• JBPB_U10SC  

• JBPB_U11 

• JBPB_U11CM 

• JBPB_U11PA 

• JBPB_U11VN 

• JBPB_U12 

• JBPB_U13 

• JBPB_U14 

• JBPB_U15 

• JBPB_U15PB 

• JBPB_U16 

• JBPB_U17 

• JBPB_U20 

• JBPB_U21 
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Test Case: 

1. Set up 5 levels of group mapping code. 

 

 

 

2. Set up Group Summary in Invoice Formats program.   
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Print JB invoice (e.g. JBPB_U21)         
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Print VAT Tax Number in Free Form Invoice (20.20290) 

Ability to print VAT tax in Free Form Invoice Format.  

Overview 

Added a new flag to show VAT tax in Free Form Invoice Format (JBINVPRT). 

Modifications 

This modification is only applicable to JBINVPRT format. A flag is added in Invoice Format program.  

‘Show VAT Tax’ flag is added to JB > Setup > Local Tables > Invoice Formats – Invoice Option Tab. 
Flag is unchecked by default; user has to check the flag to show VAT tax on JBINVPRT free form 
invoice format. 

 

JB > Setup > Local Tables > Invoice Formats – Invoice Option Tab 
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Implementation 

Company: CCC 
Vat: VAT#12345 
Tax Registration 2: TAX#222 

Case 1:  

 

GL > Setup > Maintain Companies 
 

 

JB > Setup > Local Tables > Invoice Formats – Invoice Option Tab 
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Job Billing > Billing > G/C Prepare Billing  

 

 

Job Billing > Billing > G/C Prepare Billing 
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 The above report shows the VAT Tax on invoice, as the Show Vat Tax flag is checked.  
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Case 2:  

VAT# - NULL  
Tax Registration 2: TAX2#222 

 The values of VAT tax are removed, only Tax Registration 2 value is available.  

 

GL > Setup > Maintain Companies 

 

Show VAT Tax flag - Checked 

If VAT tax is NULL and Tax Registration 2 value is available, Tax Registration 2 value is printed on 
invoice.  
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Case 3:  
Company: CCC 
Vat: VAT#12345 
Tax Registration 2: TAX#222 

Show VAT Tax flag: Un-checked 

 

 

GL > Setup > Maintain Companies 
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JB > Setup > Local Tables > Invoice Formats – Invoice Option Tab 

 

When flag is un-checked, VAT tax is not printed on the invoice. 

 

 

Show New Notary Section in Invoice Formats (20.23956) 

Added option in invoice format to show new ‘Notary Section Details’ in JBPB_U11 & JBPBU15. 

Billing Group Codes – Import Function (20.21523) 

Added [Import] function button to Job Billing Group Codes Maintenance Program. 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  1151 

 

Job Billing > Setup > Local Tables > Group Codes 
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Notifications in G/C Prepare Billing (JBBILL2) (20.28279) 

 

The notification text for all notifications are changed with red background for easy identification by 
users. Previously only the 'Recalculate Billing' was having the red background. 

JBBILL2 -Added new fields to Cost Transactions pop-up (19.83338) 

 

Added the following columns to the Job Billing > G/C Prepare Billing >Cost Transactions pop-up 
screen. 

• Union Code 

• Union Name  

• PCI Control Code 

The new fields are hidden by default. Users must add them as required using the Lite Editor. 
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Free Form Invoice Format changes (20.29696) 

Free Form Invoice Format (JBINVPRT) is modified as follows: 

• Logo stacked on top of the Company Address 

• Logo and Address are left aligned 
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Creation of Stored Materials in RFP Screen (19.86625) 

The feature is to incorporate and process Stored Material information when entering Request for 
Payments. Stored Materials allows subcontractor to bill for an amount of material that is not yet used 
on the project. 

1. Material Stored Is Only Applicable to Subcontracts Invoiced via SC. 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  1155 

 

2. The following new flags have been added to ‘Subcontract Maintenance’, ‘Edit CO’ and ‘Modify 
Original Contract’ screens: 

• Material Stored included in the Completed Amount: 

When checked, material stored override in Request for Payment programs will be 
considered as included in the calculated billing amount. The amount in Store Materials is 
just a reference. 

• Previous Completed Amount includes Material Stored: 

When checked, during invoice printing, the Previous Completed Amount column includes 
and prints material stored amount as well. 

This flag is enabled only when the ‘Material Stored Includes in Calculated Current 
Amount’ is enabled. 

*Important Note*:  

Although these two flags have been added to the mentioned screens, they will NOT be available for 
user to see or change. The Columns are hidden and not visible for all users. 

The standard setup has been considered, (the two flags are set to Y by default), which means 
'Material Stored always Included in the Completed Amount'. 

 

Modifications 
1. Enter Request for Payments (SCPAYREQ): 

The following new columns have been added to ‘Request for Payments’ screen in SOV detail and 
Amount Summary Tab:  

• Current Material Stored Amt: Identifies Material Stored on the current RFP 

• Previous Material Stored Amt: The total of previously posted Material Stored amounts.  
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Corresponding fields have been added to the screen under ‘Amount Summary’ tab that indicates total 
amounts of the above columns at the Subcontract level. 

 
2. Prepare Billing (JBBILL): 

New columns ‘Override Material Stored’ and ‘MS Ovr’ have been added to Billing Details section. 
Existing ‘Material Stored’ column has been disabled to be consistent with other overrides columns 
and holds the same functionality. 
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When user overrides Material Stored, followed by ‘Recalc Notification’ message and ‘ReCalc Billings’, 
the colored columns ‘Override Material Stored’ and ‘MS Ovr’ with letter ‘O’ indicate that the Material 
Stored Amount has been overridden. 

 
 
3. G/C Prepare Billing (JBBILL2): 

New columns ‘Override Material Stored’ and ‘MS Ovr’ have been added to ‘Group 1 Summary’ to 
‘Group 5 Summary’ and ‘Bill Code Detail’ Tabs. ‘Override Material Stored’ column is hidden in all tabs 
to be consistent with other overrides columns and holds the same functionality. 
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A new button called ‘Clear Material Stored Override’ has been added to Summary and ‘Bill Code 
Detail’ Tabs to clear MS Override Amounts and restore the calculated ones.  
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4. Cost Transaction pop-up (JBBILLTRANS): 

A new column has been added to Cost Transaction pop-up screen that indicates Material Stored Amt 
on the Cost level of the associated Billing Detail line. The column is display only and cannot be 
updated. 
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Invoice Format JBPB_U10TR (20.34285) 

Overview: 

To create a Progress Billing Invoice Format JBPB_U10TR based on JBPB_U10OC. 

 

Modifications: 

The following two columns are added to the report for JBPB_U10TR Invoice Format 

1. Transfer Budget Amounts column: 
a. Transfer Budget Amounts column will list the sum of all posted Transfer PCI amounts 

associated with a bill code line. 
b. Subtotal will be shown.  

2. Revised Schedule Value/Revised Budget column: 
a. This column will show the sum of Original Budget (Scheduled value) +Transfer Budget 

Amounts 
b. Subtotal will be shown. 

The columns are added after the column ‘C ‘(Scheduled value/Original Budget column) 

Screen Prints: 

RV123456 / 1200M / Draw 3 /Rev:0 

 

JBPB_U10OC Invoice Format: 
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JBPB_U10TR Invoice Format with modifications made (with added TRN Budget Columns): 
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Modification to Invoice Format JBPB_U10 (20.33992) 
 

Overview: 

Changed the Application and Certification for Payment. 

 

Modifications: 

Added a new field (checkbox) ‘Show Remit To’ to the invoice format program to either display the 
word Architect (Default) or ‘Remit to’ when checked for the standard formats. 

 

Setting and printing the JBPB_U10 Report: 
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Job Billing> Setup>Local Tables > Invoice Formats 

 

Job Billing> Setup>Local Tables > Invoice Formats 
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The Application and Certificate for Payment report is modified to show the “Remit to” field. 
 

 
 

Ability to Mass Update values to ‘NULL’ (21.37725) 
 

Overview: 

Added a ‘Blank’ checkbox to use during Mass update. 

 

Modifications: 

Users may now specify ‘Blank’ as a value to use during Mass Update. This can be done by checking 
a checkbox. Using ‘Blank’ has the effect of erasing values for a field. 

 

Although the ‘Blank’ checkbox is provided for many fields, only the following fields can be mass 
updated to ‘NULL’:  

• Max Billing Amt 

• Group 1 

• Group 2 

• Group 3 

• Group 4 

• Group 5 

The following mandatory fields cannot be updated to ‘NULL’: 

• Type 

• Weight Measure code 

• Invoice format 

• Job 
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• Cost Code 

• Category 

• Retainage Code 

 

 

JB>Contract>Enter Contract 

Click on Apply. The selected fields are mass updated to null/ blank. 

 

 

 

The same functionality holds true for WO contracts. 
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JB>Contract>Enter Contract 

Click on Apply. The selected fields are mass updated to null/ blank. 

 

 

Modify Surcharge program to include “Job” field and “Hour Type” 
field.  (20.18406) 

Modify the existing Surcharge program to include “Job” field and “Hour Type” field. This will allow 
users to calculate add-ons/surcharges for specific jobs and hour types and then specify which bill 
code the add-on/surcharge will be applied to.  
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1. Job field 

The Job LOVs show all jobs for the company, including ‘*’ for all jobs.  

 

2. Hour Type field: 

The Hour Type LOVs show hour types for the company, including ‘*’ for all hour types.  
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Job, phase, and category are required fields. For hour type, a null value will be considered as ‘All 
hour types’ while calculating surcharge.  

Modified the surcharge calculation to consider the new fields. 

 

NOTE: Surcharges use the billing rate column of the Billing Rate table only. WM of the surcharge 
billing rate must be HR. 

 

 

Add the Group codes 1 to 5 to the Detail tab in G/C Prepare Billing 
screen (20.33779) 

Modify the G/C Prepare Billing (JBBILL2) screen to add the Group Codes 1 to 5 to the CMiC catalog. 
The fields will be available to be added manually by the user to the screen via Lite Editor. Columns 
are hidden by default. 
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Fields will be available to be added to the Bill Code Details tab. 
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Modified the Report - JBPB_C11 to Add Two Fields ‘NEQ’ and 
‘RBQ’ (21.40962) 

Modified the Report - JBPB_C11 to add two fields ‘NEQ’ and ‘RBQ’ 

Modifications: 

A new view will be used in BI with the following columns: 

- Two new free form text fields ("NEQ","RBQ") is added to GL Company setup. By default, its hidden, 
user will have to make these fields visible through light editor. 
- Added the new codes to the invoice format program to display/hide on the Report. 
- Modified the Report to add the two new fields accordingly. 

 

These fields are used when the business in operating in Quebec. 

 

Setup and Printing reports: 

 

Two new text fields added to the GL Company Setup. 

 

GL>Setup>Maintain Companies 

Added flags `Show NEQ’ and `Show RBQ’ in the Invoice Options tab, on Progress Billing Style 
Invoice Options section on ADF program Invoice Formats. 

-These flags will not be visible by default. User would be able to make them visible using Lite Editor 

- By default, the flags will be assigned `N’. 
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JB>Setup>Local Tables>Invoice Formats 

QST is the tax code that should added on the contract and bill code level. 
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The short name and tax registration number of the tax 2 identified in the contract screen can be found 
under the corresponding company in Enterprise > System > Global Table > Tax code. 

 

Enterprise > System > Global Table > Tax code 

 

JB Contract>Enter Contract 
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Print the JBPB_C11 report 
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New JB Billing Format-JBPB_U10CR (21.40891) 

Created a new JB Billing format (JBPB_U10CR) Invoice with currency. 

Modifications: 

Created a new Job Billing invoice JBPB_U10CR as follows: 

1- Page 1 will be Tax Invoice as specified from Billing Contract and AR. Both the contract currency 
name and symbol will be shown on the Report. 

2- Page 2 will be G703 with total amount of change orders and currency symbol displayed along with 
the amounts. 

3- Section 3 (CONTINUATION SHEET) displays the details section like JBPB_U10 existing invoice 

4- Section 4 Change Orders, displays the change orders details from Detail PCI Billing grouped by 
owner change orders. 

 

Setup and Invoice Printing: 

Created a new JB Bill invoice format CURR (JBPB_U10CR). 

 

 

JBPB_U10CR report printed as follows: 
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NOTE: In Section 4, for Non-PCI Billing items, the Change Order list is printed as follows grouped by 
owner change orders. 
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JB Trade list Mappings – Ability to add Custom Fields (21.45828) 

Added the ability to add Custom / User Defined Fields in JB Trade List Mappings to PY Program in 
the ‘Trade Code Mapping’ block. 

 

JB Rate Maintenance - Sub Rate Custom Fields (21.45472) 

Added the ability to add Custom / User Defined Fields in ‘Billing Rate Maintenance > Sub Rate 
Details Section’ using the lite editor. 
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Added Remittance Details on Owner Bill (21.42020) 

Changed Remit on Owner Bill. 

Modifications: 

a. Provided a field (optional) to enter remittance details on the company control in JB. 

b. Provided a field (optional) to enter remittance details against the contract. 

c. Provided an option on the invoice format to print the remittance details. 

 

If the option on the invoice format is switched on, the system will check to see if there are remittance 
details against the contract. It will print them. If there are no details against the contract, it will print the 
one from the company control.  

Printing of remittance details will remove the printing of the address (as it does currently with your 
custom format). 

Setup and Printing the Invoice: 

Added a field (optional) to enter remittance details on the company control in JB. 
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JB>Local Tables>Control 

Added a field (optional) to enter remittance details against the contract. 

 

JB>Contracts>Enter Contract 
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Added an option on the invoice format to print the remittance details. 

 

JB>Local Tables>Invoice Formats 

Print the invoice when the contract has remittance details maintained against it. The invoice prints the 
remittance details maintained at the contract level. 
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JB> Billing > Print Invoices 

Print the invoice when the contract has no remittance details against it. The invoice prints the 
remittance details maintained at JB Control level. 

 

JB> Billing > Print Invoices 

Print the invoice when the option on the invoice format is switched off so that it doesn’t print the 
remittance details. 
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JB>Contracts>Enter Contract 

Added New Invoice Format Option-California Notary (21.46227) 

New invoice format option (California Notary) 

Modifications: 

Added a new invoice format option (California Notary), when checked it will print the California G702 
Notary format. The ‘Show California Notary’ flag will be hidden, and user will need to add it using the 
Lite Editor. 

All the standard reports will be modified to print the new notary format. 

Setup and Printing: 

Check the ‘Show California Notary’ flag. 
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JB>Local Tables>Invoice Formats 

Print the invoice. The invoices print the California G702 Notary format. 
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JB> Billing > Print Invoices 

G/C Prepare Billing: Mass Update Taking Absolute Value (21.49233) 

CMiC have modified GC prepare Billing to allow the users to mass updating the ‘ret %’ and ‘% 
completed’ of group 1~5 and bill code tab if there is a negative amount on budget. 



1188  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

 

 

 

 

JB Transaction Detail Log: Added “Company” Field in Search as 
Well as Column in the Table (21.48508) 

Added "company" field in search as well as column in the table. 
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Added Print Verbiage Flag to Invoice Format Program (22.60211) 

A verbiage has been added to the cover page of Invoice Report (JBPB_C10). This is not applicable to 
Draft Invoice printing. 
 

Modification: 

A flag has been added to Invoice Format Program. By default, this is hidden and unchecked and can 
be added through Lite Editor. 

When mouse pointer is hovered over the new flag, the note will read: “The noted Verbiage will print 
on JBPB_C10 Invoice Report”. 

 

Job Billing>Setup >local tables>Invoice formats- Under Invoice Options-progress Bill Style Invoice Options 
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Job Billing>Setup >local tables>Invoice formats- Under Invoice Options-progress Bill Style Invoice Options 

When the flag is checked on the Invoice Format screen for Report: JBPB_C10, the verbiage “This is 
intended as a proper invoice” will be printed on Invoice. 
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Job Costing 

Ability to duplicate a Job to a New Job (16.19624) 

CMiC has added button [Duplicate Job] on the Job Entry Screen which provides a functionality to 
user to duplicate a new job from the existing job. Clicking on Duplicate button will launch a Pop up to 
enter New Job Code, name and Controlling Job code. After entering the required job code, name and 
control job code if User clicks the Process Duplicate Job button details of source job will copy to new 
job. 
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G/C Prepare Billing > PCI pop-up screens 

Added ‘Owner Change Order’ column to display the OCO# associated with the PCI detail. 
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Added a flag ‘Do NOT Recalculate Current Complete’ to  

JB Control > Billing Tab. This serves as default to Billing Contract Entry screen 

JB Contract Entry > Defaults Tab. This flag defaulted from the control file may be overridden as 
needed.  

The default value is set as ‘N’ (un-checked). The existing functionality applies in this state. 

When checked, the ‘Clear Overrides’ function when performed, the Current Complete column values 
will NOT be recalculated, but set to same as the ‘Cost Column’ values. Also, this is applicable only to 
‘COST’ type billcodes. 
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JB Control > Billing Tab 
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JB Contract Entry > Defaults Tab 

When the flag is checked, when ‘clear overrides’ is performed, the ‘Cost Amount’ column will be 
copied to the ‘Current Completed’ column for all ‘COST type lines only. 
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Calculate Billing for selected Job/Phase/Category (16.23290) 

Modifications: 

 

G/C Prepare Billing 

The Billing Recalculation pop-up is modified with a button [Select Criteria]. 

When this button is pressed, the system opens a ‘Transaction Criteria’ pop-up screen as shown 
below. 
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G/C Prepare Billing > Recalculate Billings > Select Criteria 

There are three blocks of display records with a checkbox for user’s selection against each record. 
The default value for the selection check boxes is Un-Checked (N). 

Job Code 

The Job Code block displays all the jobs that share the same contract code. Users may select 
(checked) one or more jobs, or leave as unselected (Un-Checked) for recalculation. 

Phases 

The Phase block displays all the phases including controlling phases codes that are assigned to any 
or all the jobs under this contract. Users must understand that the explicit selection of the phase 
records is required to include a billcode for recalculation.  

Selecting a controlling phase alone does NOT mean that all the sub-phases are automatically 
included in recalculation. For example, selecting the phase 01 will do nothing, as there are no 
categories directly assigned to that phase in any of the jobs. Users must select the phase 01-100 to 
include the billcodes with this phase for recalculation. 

Categories 

The Category block displays all categories including any controlling categories that are assigned to 
any or all the jobs. Here again users must explicitly select any category that needs to be included in 
recalculation. 

How to use the ‘Select Criteria’ pop-up screen? 

Users must have through understanding on the Billing Recalculation popup functionality. 
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There is a JB Control File flag ‘Show Billing Recalculation Popup When Creating New 
Draw/Revision’. 

Un-Checked: When creating a New draw, system will NOT show the recalculation popup and hence 
all the billcodes will be considered as per the ‘Period Ending’ date parameter and users will NOT be 
able to control using the new ‘Select Criteria’ popup  

If required to recalculate only on a specific job/phase/cat, then users have to delete the draw and then 
recreate with the Billing Recalculation popup and then open the criteria pop-up for selection. 

Checked:  

When creating a new Draw, the Billing Re-calculation popup will show, where users may specify the 
‘Selection Criteria’ to include only those required job/phase/cat. 

 

JB Control > Billing  

 

Implementation Details 

When users do NOT open the ‘Select Criteria’ pop-up, then the existing standard functionality applies. 
The recalculation is performed for all jobs/phases/categories. 

Example: 
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Create a New Draw 

 

Recalculate Billings 
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After Recalculation 

After this stage, any further ‘Recalculation’ with the ‘Selection Criteria’ of jobs/phases/categories  
controls specific billcodes for recalculation in addition to the already created draw. 

In order to remove an already included cost transaction from the billing draw, users have to either 
manually ‘Defer’ as per the standard functionality or delete the entire draw and recreate with specific 
filters applied. 
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G/C Prepare Billing – Selection Criteria amendments as of 01-Mar-2017 
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Changes as per discussions in issue notes: 

Add an ‘Accept’ button to the left of the Close button. ‘Accept’ saves the selection and ‘Close’ closes 
the window. There will also be a message if users do not ‘Accept’ before pressing the ‘Close’ button 
that essentially says... "Are you sure you want to close without saving your changes?"  

The Phase/Categories must NOT list controlling phases/categories as they may confuse the users. 
But they must be available, if transactional level details exist 

Implementation: 

Pressing the ‘Selection Criteria’ button opens the ‘Transaction Criteria’ pop-up screen. 

Three blocks of data records are displayed with a ‘Recalc’ check box against each row. Default value 
is un-checked. 

3. Job Code 

4. Phase 

5. Category 

The phases & categories blocks will show all distinct records from all the jobs. 

Users may select any number of rows from any of the blocks, or leave one or many or ALL records 
un-checked. 

When NO record is selected in a block, the system assumes as ‘ALL’ and all rows will be considered 
in transaction selection. 

When one or more records from a block is selected, then the selected rows will only be included in 
the selection. 

The program will logically select all the transactional data, as per the Job/Phase/Category selections. 
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‘Accept / Close’ buttons functionality: 

No records Selected – Accept / Close buttons will simply close the pop-up and get back to the 
Recalculation pop-up. This is because when nothing selected, system assumes ‘ALL’ included in the 
selection criteria and hence no explicit confirmation required. 

When one or many records selected: 

• ‘Accept’ button will close the popup and goes back to recalculation popup. The selected records will 
be used in the selection criteria for transactions. 

• ‘Close’ button will pop-up a confirmation message for closure. 

• ‘Yes’ will close the popup without saving any changes and recalculation will simply recalculate ‘All’ 

• ‘No’ will allow the user to review the selections criteria and update as required. 
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Phase / Category List: 

The Phase Category list excludes the Controlling Phases & Categories to avoid any confusion to 
users. The above screen shows say for example the phase 01-100. The controlling phase ‘01’ is not 
listed. Whereas, the initial screen prints in the beginning of this document shows ‘controlling’ phase & 
categories as well. 

The controlling phases / categories may be available only when transactional data exists against the 
same. 

Requested Cost Type - Consumables (18.66427) 

Added a new Cost Type ‘Consumables’ to the Maintain Categories screen. 
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JC Inter Branch Report (JC3000) Jasper conversion (19.81557) 

JC Inter Branch Report (JC3000) is now converted into Jasper Reports. 

Add “Duplicate Record” button to Project Maintenance Tool Bar in 
ADF (18.48366) 

Project maintenance provided with “Duplicate Record” button in tool bar to duplicate existing project. 

 

Upon clicking “Duplicate Record” button, a pop-up window shows. User can enter new project code 
and name, and process with duplication. 

 

JC Control Exclude from WIP flag (19.80194) 

Add a new flag "Exclude from WIP" to JC Control File. It will be hidden in ADF and the user will be 
able to add it manually. The default value of the flag will be 'N' to maintain existing functionality. 
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Modify a trigger of table JCJOB_TABLE to default the value of the new flag 'Exclude From WIP' from 
JC Control File. It will be done regardless of the source of creation. 

 

This new functionality will work only for new Jobs, existing jobs will not be updated.  

This change will be made only in ADF program R12. 

Ability to Define Overhead Cost Code (19.91112) 

Added the ability to define ‘Overhead Cost Code’ along with the existing Overhead Category for the 
purpose of posting Overhead Charges to a job. 

Modifications 

• Added a field, ‘Default Overhead Cost code” in ‘Additional Charges’ tab in JC control file. 

• Also added a column ‘Overhead Cost Code’ in ‘Assign Overhead Cost Rates’ screen. 

Existing Functionality for posting JC Overhead Cost 

The Overhead Cost will be posted to the transaction cost code/overhead category defined in the 
‘Assign Overhead Cost Rate’ Maintenance program. When the category is NULL, then the JC Control 
> default Overhead Category will be used. 
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Users do NOT have the ability to choose a specific cost code to post the overhead charges. 

Modified Functionality for Posting JC Overhead Cost 

• If Overhead Cost Code is defined in ‘Assign Overhead Cost Rate’ maintenance program, 
then JC Transaction posting will post overhead cost to the specified cost code. 

• When left as NULL, then the default ‘Overhead Cost Code’ defined in JC Control file will 
be used. 

• If the default ‘Overhead Cost Code’ both in JC Control and in ‘Assign Overhead Cost 
Rate’ maintenance programs are left NULL, then the overhead cost will be posted to the 
transaction cost code. This is the existing functionality prior to the modification. 

The following screen shows the modifications performed. 

The ‘Default Overhead cost code’ is the new field defined in the additional charges tab in JC control 
file. The default value is NULL and is NOT mandatory to maintain the existing functionality. 

 

JC Control File 

Added the column ‘Overhead cost code column’ in Assign overhead cost rates screen. Cost code 
added here will override the default overhead cost code in JC control file. If ‘Overhead cost code’ and 
‘Default Overhead cost code’ both are null, then the overhead cost will be posted to the same cost 
code that the actual job cost was posted to. 

 

JC Assign Overhead cost rates 
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Setup & Posting Example: 

 

 

JC Cost Transaction report: 
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GL transaction Posting Report: 

 

 

Ability to Exclude Sub Job from Charge Cap Value (19.87458)  

Ability to exclude a sub job from charge cap value.  

Modifications 

• Flag ‘Exclude Job from Charge Cap Value’ is added in Job Costing > Job > Enter Job. 

• By default, the flag is hidden. User must use Lite Editor to display the flag. 

• ‘Exclude Job from Charge Cap Value’ will be enabled depending upon the value in 
‘Control Job’ field. 

o Control Job: ALL – The ‘Exclude Job from Charge Cap Value’ flag is disabled. 

o Flag is disabled for Controlling Job, it is exclusively for a sub job. 
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Following screens shows the modifications performed: 

 

Job Costing > Job > Enter Job 

 

Control Job – Flag is disabled for a Control Job 

 

Job Costing > Job > Enter Job 

‘Exclude Job from Charge Cap Value’ if the flag is checked, charges continues to hit the sub job 
without capping the charge value. 
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Calculations: 
 

Contr
ol Job 

Charge 
Cap % 

Sub 
Job 1 

Exclude 
from 
Charge 
Cap 

Charge 
Cap % 

Sub Job 
2 

Exclude 
from 
Charge 
Cap 

Charge 
Cap % 

Equi
pme
nt 

Equipme
nt Value 

BEJO
B 10 BEJOB-1 N 2 BEJOB-2 Y 0 

CAP
-
EQP 10000 

 

Equipment 
Rates 

Auto charge without charge 
cap 

100 (daily) 1200 

100 (daily) 1400 

150 (daily) 4650 

Note: Sliding Scale is OFF 

  
No. of days for equipment at 
location 

BEJOB 12 

BEJOB-
1 14 

BEJOB-
2 31 

 
 

Auto Charge 
Out  

 Charge 
Amount    

      

BEJOB 1000 Capped due to 10% charge cap of main job 

BEJOB-1 

0 Capped due to total charge cap of 1000. 
BEJOB already charged for 1000 

BEJOB-2 
4650 No charge cap - Excluded from Charge Cap 

Value  
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Example: 

Controlling Job 

 

Job Costing > Job > Enter Job 

 

Sub Job – 1: BEJOB-1 

 

Job Costing > Job > Enter Job 
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Sub Job – 2: BEJOB-2  

 

Job Costing > Job > Enter Job 

 

Equipment  

 

Equipment Costing > Setup > Enter Equipment 
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Equipment Rates  

 

Equipment Costing > Setup > Local Tables Rates > Equipment 

 

➢ Transferred equipment to BEJOB, BEJOB-1, BEJOB-2 

Creating Auto charge  

 

Equipment > Transactions > Automatic Charge-Outs 

 

 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  1221 

 

Equipment > Transactions > Automatic Charge-Outs 

Report: 
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Creating further auto charge – equipment is at Sub job 2 (exclude charge cap flag is checked).  

Moving to Main Job (BEJOB).  

 

Moving to BEJOB-2 (sub job 2) 
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Automatic charge-out: 

 

Equipment > Transactions > Automatic Charge-Outs 

 

 

Equipment > Transactions > Automatic Charge-Outs 

Posted successfully 
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Report: 

 

 

Ability to Enter PCI when Job is Set NOT to Allow Transactions 
(19.80740) 

New flag ‘Allow PCI entry’ is added to Job Maintenance program which, when checked, allows to 
create PCI’s for the purpose of adjusting the budgets, when the job itself is set NOT to allow 
transactions.  

 

Modifications: 

1. Job Setup: New flag ‘Allow PCI Entry’ is added.  

a. It is sub flag for ‘Allow Transactions’ and available only when the ‘Allow Transactions’ is 
un-checked.  

b. The default is unchecked, to preserve the existing functionality. 

2. PCI entry screen: When Transactions are NOT allowed on a job, then the PCI entry program 
checks the status of the ‘Allow PCI Entry’ flag on the job.  

a. Checked (Y): PCI Entry is allowed. 

b. Un-Checked (N): PCI creation is NOT allowed. 

3. CMiC Field Application (PMJSP) will also follow the same. 

 

Following shows the modifications performed: 

JC > Enter Job – Settings tab ‘Allow PCI Entry’ flag is available only when ‘Allow Transaction’ is not 
checked: 
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Not available when ‘Allow Transaction’ is checked: 

 

PCI entry screen: When Transactions are NOT allowed on a job, then the PCI entry program checks 
the status of the ‘Allow PCI Entry’ flag on the job.  

Checked (Y): PCI Entry is allowed. 
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CMiC Enterprise (ADF): User is able to enter PCI 
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CMiC Field (PMJSP): User is able to Enter PCI 

 

 

PCI entry screen: When Transactions are NOT allowed on a job, then the PCI entry program checks 
the status of the ‘Allow PCI Entry’ flag on the job.  

Un-Checked (N): PCI creation is NOT allowed. 
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CMiC Enterprise (ADF): User is not allowed to enter PCI 
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CMiC Field (PMJSP): User is not allowed to Enter PCI 

 

 

 

Include Pending PCI in Current Cost To Complete (15.07959) 

Added a JC Control flag 'Include Pending PCIs in Current Cost to Complete' to address the Internal 
PCIs totaling up in the Projected Cost Forecast column (Custom Forecasting only). The Default Value 
is 'Y' and this must be set as ‘Y’ (checked) for all other clients. 

Automatically Create Project When a Job is Created (19.84714) 

Added the ability to automatically create a Project when a Job is created. 

This is to facilitate clients that do not use PM application, but need to use Change Management and 
Subcontract applications to create PCIs and Subcontracts, where a project code is required. 

Modifications: 

Added two flags in the System Options>Projects Tab 

1. Auto Create Project for Jobs 

2. Auto Create Project for Sub Jobs – Enabled only when the first flag is checked (Y) 
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System Options > Projects Tab 

These two flags are hidden by default. Clients that need to use this functionality may make it visible 
using the ‘Lite Editor’. 

The default values for both flags are Un-Checked (N). 

Un-Checked (N): Existing functionality applies. Job Creation will NOT auto create projects. 

Checked (Y): New Functionality takes effect. Job creation will automatically create projects. 

Implementation: 

When the System Options flags are checked, the following programs will automatically create 
projects. 

1. Job Entry upon save, will create a project for the job. 

2. Win/Lose Bid Program upon winning a job, will create a project for the job. 

3. Job Import utility, upon import of jobs, will create as many projects for the imported jobs. 

NOTE: Since this is a system level option, this functionality is applicable to all the companies. 

Transaction Entry – Import Function Quick Mode (20.26353) 

Added a checkbox ‘Quick Mode’ to the import popup in Cost Transaction Entry, that will allow the 
user to switch between the V10x Import mode that can expire due to large dataset and the R12 
import mode that may be taking a long time but not expiring. 

The default value is checked for quick mode import of smaller data files. 
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Calculate Value Functionality in Enter Budget Screen (20.31776) 

Overview 

Ability to use calculate value functionality in Enter Budget screen. Calculate Value button is removed 
from Enter Budget screen and three new columns are added.  

Pre-requisites 

Three new columns added to Enter Budget screen  

• Budgeted Cost Amount Calculate Value 

• Budgeted Quantity Calculate Value 

• Budgeted Unit Rate Calculate Value 

Values allowed in these three fields are Y, N or NULL. If user enters any other value, the program will 
change it to N. When one column is set to Y, the other two fields will be set as N. The column which 
is set to Y will be highlighted in yellow and text displayed in bold green color.  

Modifications 

The highlighted field shows 3 new columns  
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Job Costing > Job > Enter Budget  

 

Job Costing > Job > Enter Budget 

Implementation 

The following screen shows calculated values for the selected job.  
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Job Costing > Job > Enter Budget 

 

Following matrix shows the values updated and calculated upon using the Calculate Value function.  
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METHOD

BUDGETED 

COST 

AMOUNT 

Budgeted 

Cost 

Amount  

Calculate 

Value 

BUDGE

TED 

QTY

Budgete

d 

Quantit

y 

Calculat

e Value

BUDGETED 

UNIT RATE

Budgeted 

Unit Rate 

Calculate 

Value

BUDGET

ED REV. 

RATE

BUDGETE

D REV. 

AMOUNT 

PROJECT

ED FINAl

P 100000 Y 10000 10 10 100000 100000

50000 Y 5000 10 10 100000 50000

300000 Y 5000 60 60 300000 300000

300000 5000 Y 60 60 300000 300000

500000 5000 Y 100 100 500000 500000

100000 5000 Y 20 20 100000 100000

100000 5000 20 Y 20 100000 100000

600000 5000 120 Y 120 600000 600000

1200000 10000 120 Y 120 600000 1200000

U 200000 Y 20000 10 10 200000 200000

100000 Y 10000 10 10 200000 100000

400000 Y 10000 40 40 400000 400000

400000 10000 Y 40 40 400000 400000

500000 10000 Y 50 50 500000 500000

600000 10000 Y 60 60 600000 600000

600000 10000 60 Y 60 600000 600000

300000 10000 30 Y 30 300000 300000

150000 5000 30 Y 30 300000 150000

A 100000 Y 5000 20 20 100000 100000

200000 Y 10000 20 20 100000 200000

400000 Y 10000 40 40 400000 400000

400000 10000 Y 40 40 400000 400000

200000 10000 Y 20 20 200000 200000

300000 10000 Y 30 30 300000 300000

300000 10000 30 Y 30 300000 300000

500000 10000 50 Y 50 500000 500000

250000 5000 50 Y 50 500000 250000

Y
SET AS Y TO 

CALCULATE VALUE

OVERRIDE

NO CHANGE 

UPDATED

 

Calculated Values from Enter Budget Screen 
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Ability to Store Forecast for Selected Records (20.30063) 

Overview 

Checkbox is added in ‘Enter Manual Forecast’ program to store forecast for selected records.  

• User must select detail line for which forecast needs to be stored  

• Alert message is displayed prompting user to select ALL or SELECTED records to store 
forecast  

➢ ALL: All the records will be stored in the forecast  

➢ SELECTED: Only selected records will be stored  

• If no record is selected, forecast is stored for all the records and alert message will not be 
displayed 

Modifications 

‘Select’ column containing checkbox is included in ‘Enter Manual Forecast’ program. 

 

Job Costing > Forecasting > Enter Cost Forecast 

Implementation 

Comp: CCC 

Job: FCATJOB 

Selected few records as highlighted and click on [Store Month] 

In alert prompt, click on [SELECTED] 

Forecast stored to 2021-3 
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Job Costing > Forecasting > Enter Cost Forecast 

Forecast stored only for selected records.  

 

Job Costing > Work-In-Process Adjustments > Enter and Post Adjustments  

Select record as highlighted below and click on [Store Month]. 
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Job Costing > Forecasting > Enter Cost Forecast – [Store Month] - Alert 

Click on [ALL] to store all the records in forecast for 2021-4.  

All records are stored in forecast when user clicks on [ALL] button. 

 

Job Costing > Work-In-Process Adjustments > Enter and Post Adjustments 

No Record selected  

If no record is selected, upon clicking [Store Month] alert message is not displayed.  
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Job Costing > Forecasting > Enter Cost Forecast – [Store Month] pop-up 

 

Job Costing > Work-In-Process Adjustments > Enter and Post Adjustments 

Project Entry – Added Owner Field (19.83413) 
 

Overview: 

Added ‘Owner’ and ‘Owner Name’ field to Project Entry Program. 

Modifications: 

The Owner field LOV shows list of ‘Active’ customers. Users may select a customer value and save to 
be the owner of the project. 
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Project Controls> Job Costing> Job> Enter Project 

 

Project Controls> Job Costing> Job> Enter Project 

Cash Flow Report-Modified to add Suppress Zero Flag (21.40574) 

Overview: 

To add suppress zero flag to the Report JC7001-Job Cash Flow Report 

Modifications: 

The suppress zero flag was added to the report JC7001 and the JSR views were modified to handle 
the new suppress zero flag. 
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a. When Suppress Zero flag is set to ‘No’ (Show Zero lines): All the jobs in the range will appear in the 

report including the Zero lines. 

 
b. When the Suppress Zero Flag is set to ‘Yes’ (Suppress Zero lines): All Zero Jobs will not be shown 

on the Report except in the following case: 

When the include sub-jobs, flag is ‘Yes’ and the sum of the transactions of the sub-jobs is greater 
than zero then the Zero lines for the control job will also be shown. 

 
RV123456 
Main job:21.40574M 
Sub job:21.40574S1 and 21.40574S2 
 
1.Show Zero lines: Suppress Zero flag set to ‘No’ 
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2.Suppress Zero lines: Suppress Zero flag set to ‘Yes’  

 

 

Cost Code Template Deletion in R12 (21.36618) 
 

Overview: 

To provide the ability for the user to delete a Cost Code Template in R12. 
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Modification: 

A ‘Delete Template’ button is added on the template header in the ‘Cost Code Template 
Maintenance’ screen. 

Screen Prints: 

When a template is deleted using this ‘Delete Template’ button, user will be prompted with a warning 
message to confirm whether to proceed with the deletion or not. 
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Assign Job Cost Code Screen-Notes button enabled in the toolbar 
(20.35204) 

Overview: 

To enable Notes button in the tool bar for the ADF version of Assign Job Cost Codes program. 

Modifications: 

The Assign Job Cost Codes screen will now have the ‘Notes' button enabled in the tool bar where 

the user can enter notes against a particular cost code entry. 



1246  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

Screen Prints: 
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New Enhancement: Security in Customer Mapping (21.41775) 

The ability to restrict user access to the Timesheet Import Template and Customer Mapping Code 
that is assigned to the job that the user has access to via job security.  In other words, users should 
only have access to specific Import Templates and Customer Mapping Code. 

Reason: In the existing modification if a user has access to the Timesheet Import Template program, 
then they could modify the details for any template.  There is no way to restrict access to specific 
import templates.  

Modifications: 

 
1. The Job Entry screen is modified to have an [Edit] button added next to Timesheet Import 

Template field. Clicking on Edit displays the template details for the queried template code. No 
other template is displayed, and user cannot navigate to a different template within the pop-up. 

2. [Edit] button added next to Customer Mapping Code field. User can only modify the details for 
'MAPPINGCODE' and cannot modify the details for any other mapping code within the pop-up. 

Testing the setup: 

 
2. Add an ‘Edit’ button next to the Timesheet Import Template field in Enter Job screen.  

a.  Clicking Edit button will open the Timesheet Import Template in a pop-up window and 

display the template details for the template that is defined on that job. 

b. Within the pop-up window, users can only modify the template that is defined on that job. 

In the Edit pop-up window users cannot navigate between templates.  

c. Users cannot Insert, Update or Delete the Timesheet Import Code in the header block. 
However, the user can modify the description in the header and also the detail records of 
the queried record.  
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3. Add an ‘Edit’ button next to the Customer Mapping Code field in Enter Job screen 

a. Clicking on Edit button will open the Customer Mapping Code setup screen in a pop-up 

window and display the mapping details for the code that is assigned to that job. 

b. Within the pop-up window, users can only modify the Mapping Code details that is 

assigned to that job. In the Edit pop-up window users cannot navigate between Mapping 

Codes.  

c. Users cannot Insert, Update or Delete the Customer Mapping code in the header block. 
However, the user can modify detail records of the queried record. However, the user can 
modify the description in the header and the detail records of the queried record.  
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Category Maintenance – Ability to add Custom Fields (21.45471) 

Added the ability to add custom/user defined fields in category maintenance program. 
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New Enhancement: Phase Code Structure by Department/Job 
(20.21125) 

Overview: 

The cost code template is a mechanism that allows collection of cost codes and be applied to a job as 
opposed to setting each cost code individually on a job(s). If the mechanism of templates was not 
available, a user would have to set all cost codes on each job individually. 

 
a. To setup templates, each cost code (regardless of its level) currently is required to be setup 

at the master level. The request being made against this enhancement is to remove the condition 

of the cost code being setup at the master level to setup the template.  

b. The other request is to allow the use of templates in various screens, including setup of cost 

code on the fly. 

Modifications: 

The following modifications has been made to allow the user to setup templates and add cost codes 
that are not in the Master Cost Code list: 

 

1.The following new flags has been added: 

   Job Cost Control File->Job Setup->Validate Cost Code Master- Not visible in the screen 

   System Options->Projects->Validate Cost Code Master (Added via Lite Editor) 

The default value for this flag is ‘Y’. If ‘Y’ (when the flag is checked), the cost codes added via 
‘Template Cost Codes’ or ‘Assign Cost Codes to Job’ will be validated against the Master Cost Codes 
list and the Cost Codes must exist in the master list. 

If value is set to ‘N’ (when the flag is unchecked), then the user can add cost codes that does not 
exist in the Master Cost Codes list. 

2. Cost Code Template Maintenance: The templates can now be created without the cost codes 
being setup at the master level. For this the flag Validate Cost Code Master under System Options 
should be unchecked. 

3. Job Setup Screen: A change is made to the job setup screen so that the user can specify a 
default template code.  

            A new optional field ‘Cost Code Template’ is added  

            A new flag ‘Automatically Apply Template to Job’ is added.  

If a template is specified and the flag is checked this template will default on the Assign Cost Codes 
screen for the job. The user will be able to change it and use a different template if needed. 

4.Assign Job Cost Codes screen: 

-This screen has been modified so that it defaults the cost code template if it is specified in the job 
setup. 

-It allows the user to add cost codes on fly.  

If the flag ‘Validate Cost Code Master’ is set to ‘Y’ and the cost code added is not in the master     
error message will be shown on saving. 

If the flag ‘Validate Cost Code Master’ is set to ‘N’, then the cost code added will be assigned to the 
job even if the cost code is not in the master list 
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-If a template is specified in the ‘Use Cost Code Template’ then when using ‘Add Cost Codes’, it will 
show only the template cost codes that were not already been assigned to the job 

-If a template is not specified in the ‘Use Cost Code Template’ then when using ‘Add Cost Codes’, it 
will show only the cost codes from the Master Cost Codes list that were not already been assigned to 
the job  

5.Quick Cost Code/Category Insert: The user now will be able to specify a template when 
assigning cost codes on the fly. For this the flag Validate Cost Code Master under System Options 
should be unchecked. 

-A new field ‘Cost Code Template’ has been added in the Quick Cost Code/Category Insert 

-The Cost Code LOV has been modified in such a way that if a template is specified in the Cost Code 
Template field, then the LOV will retrieve all cost codes of the template. If a template is not specified, 
then the LOV will show all the cost codes from the Master Cost Codes list. 

-If segmentation is enabled, and the template is specified then the field Segments LOV will retrieve all 
cost codes of the template. If the template is not specified, then the field Segments LOV will retrieve 
all the cost codes present in the Master Cost Codes list. 

Screenshots: 

System Options->Projects->Validate Cost Code Master (Added via Lite Editor) 
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Cost Code Template Maintenance: 

If the flag ‘Validate Cost Code Master’ under System options is unchecked (set to ‘N’) the new cost 
codes added is not validated against the master list. The new cost codes can be added and saved 
successfully. 

 

If the flag ‘Validate Cost Code Master’ under System options is checked (set to ‘Y’) the new cost 
codes added is validated against the master list. If the new cost codes are not in the master list, then 
it will show an error when saving. 
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Job Setup Screen: 

TEMPC1 is the template assigned to the job 20.21125 and the flag ‘Automatically Apply to Job’ is 
checked. 
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Assign Job Cost Codes Screen: 

The template defaults from the Job set up screen. The cost codes from TEMPC1 template are 
assigned to the job on ‘Assign Cost Codes’ screen 
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Template specified in the Use Cost Code Template and adding Cost Codes via Add Cost 
Codes button 

 

 

 

 

 



1256  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

Template not specified in the Use Cost Code Template and adding Cost Codes via Add Cost 
Codes button 

 

 

Assigning Cost Codes to the job that are not in the Master Cost Code List or the template 
(Cost Codes on fly): 

Validate Cost Code Master is set to ‘N’, cost codes assigned to the job successfully.  

 

 

Validate Cost Code Master is set to ‘Y’, and if the cost codes are not in the master list, then it will 
show an error when saving. 
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Quick Cost Code/Category Insert: 

A new field ‘Cost Code Template’ has been added in the Quick Cost Code/Category Insert that will 
list all templates available for the given company. 
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If a template is specified in the Cost Code Template field, then the Cost Code LOV will retrieve all 
cost codes of the template and show the cost codes in the following two sections: 

• Assigned Cost Codes 

• Template Cost Codes 
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If a template is not specified, then the Cost Code LOV will show all the cost codes from the Master 
Cost Codes list and displays the cost codes under the following two sections: 

• Assigned Cost Codes 

• Unassigned Cost Codes 

 

 

 
 



1260  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

Phase segmentation: 

If the segmentation is enabled, and if a template is specified in the Cost Code Template field, then the 
Segments LOV will retrieve all cost codes of the template and show the cost codes in two sections: 

• Phase Assigned to the Project via Job 

• Phases Template 
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If the segmentation is enabled and if a template is not specified, then the Segments LOV will show all 
the cost codes from the Master Cost Codes list and displays the cost codes under the following 
sections: 

• Phase Assigned to the Project via Job 

• Master Phases 
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New Enhancement: Self Perform View (20.21126)-Beta Release 

Overview: 

A new tab Cost Status Query Mapping has been added to the Job Setup Screen. This tab allows the 
user to link one or more Main controlling jobs either from the same company or from a different 
company. Once the jobs are linked, the user can see all the linked jobs and its sub-jobs under Cost 
Status Query/Cost Status Query (Category) or other similar reports so that the user can get an 
accurate view of a project along with Cost/Budget details. 

Modifications: 

The Job Setup Screen has been modified to include the Cost Status Query Mapping tab which is 
added to the screen via lite editor. 

This Cost Status Query Mapping tab is enabled only for the Main Controlling Jobs. For sub jobs, this 
tab is disabled. 

The Cost Status Query Mapping has the following blocks. 

 

Category block: This block shows all the Categories belonging to the Parent job. If a category is 
assigned to more than one cost code on the Assign Cost Code screen, then only distinct categories 
will be displayed. This block includes the following flags: 

 

Exclude Cost Budget flag- When this flag is checked the following columns in the Cost Status 
Query (PMJSP) /Cost Status Query (Category) will display the value as 0 only for the 
checked/selected categories. Categories for which the flag is not selected/checked, these columns 
will display the actual values. 

              PMOJSQ_ORIG_BUDG_AMT  
              PMOJSQ_CURR_BUDG_AMT 
              PMOJSQ_PROJ_AMT 

Exclude Costs- When this flag is checked the following columns in the Cost Status Query 
(PMJSP)/Cost Status Query (Category) will display the value as 0 only for the checked/selected 
categories. Categories for which the flag is not selected/checked, these columns will display the 
actual values. 

              PMOJSQ_SPENT AMT 
              PMOJSQ_EXT_CO_AMT 

Exclude Cost Forecast -When this flag is checked the following columns in the Cost Status Query 
(PMJSP)/ Cost Status Query (Category) will display the value as 0 only for the checked/selected 
categories. Categories for which the flag is not selected/checked, these columns will display the 
actual values.                                         

             PMOJSQ_CALC_PROJ_AMT  
 

Related Jobs Block: 

Under this block the user can link jobs from the same company or from a different company. The 
Related Company LOV/Related Job LOV displays only the companies/jobs to which the user has 
security access to. 

1.When the Parent job is linked to some other job either from the same company or a different 
company   then the linked job will now become the child. The Parent job can have multiple child 
records. Note that only main controlling jobs can be linked together, and sub jobs are not available for 
linking 
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2.Once the jobs are linked in a Parent-Child relationship the following rules apply: 

-The Child jobs will not be available for linkage to any other Parent. The linked job (Child Job) 
will not be available in the Related Job LOV for linking to some other Parent. 

-Once linked to a Parent, the Child job cannot have other main controlling jobs linked to it. In 
other words, the Child job cannot become a parent for other jobs. The category block of the 
Child job will be disabled. The Insert, Insert Multiple, Delete option in the tool bar under the 
Related Jobs Block will no longer be available for Child Job once it is linked to a parent 

-The Parent job cannot be linked to any other main controlling jobs as a child. In other words, 
if a parent has a child, then the Parent job cannot become a child for other main controlling 
jobs. If the parent job has already available linked jobs under the Related Jobs block, then 
the Parent job will not be shown in the Related Job LOV and will not be available for linking to 
other main controlling jobs 

3.The Related Jobs Block has the following flags. These flags will apply for all related jobs 
assigned/linked to the Main Parent job 

 

Exclude Revenue Flag: When this flag is checked then the following columns in Cost Status Query 
(PMJSP) will display the value as 0 for the selected/checked related job. 
 

PMOJSQ_ORIG_BUDG_REV_AMT 
PMOJSQ_CURR_BUDG_REV_AMT 
PMOJSQ_IDEAL_REV_AMT 
PMOJSQ_EXT_CO_REV_AMT 
PMOJSQ_PENDING_CO_REV_AMT 
PMOJSQ_PREPENDING_CO_REV_AMT 
PMOJSQ_PROJ_REV_AMT 
PMOJSQ_PROCEED_CO_REV_AMT 
PMOJSQ_NON_PROCEED_CO_REV_AMT 
PMOJSQ_CALCULATED_REV_AMT 
PMOJSQ_ETC_PROJ_REV_AMT 

 

Exclude Billing Flag/Exclude Contract Flag: When these two flags are checked then the following 
columns will display the value as 0 for the selected/checked related job 

 

PMOJSQ_BILL_AMT 
PMOJSQ_BILLED_COMMITTED_AMT 
PMOJSQ_UNBILLED_JOB_AMT 

 

Active Flag: When this flag is unchecked, the related job will be excluded from the Cost Status 
Query or other reports. The job will be no longer displayed in these reports when active flag is 
unchecked. To make the job visible again in the Cost Status Query or other reports this active flag 
should be checked for the job. 
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Screenshots: 

Adding Cost Status Query Tab via Lite Editor: 
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Linking Parent and Child jobs: 

Company LOV: Shows the list of companies to which the user has security access to. 
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Job LOV: Shows the list of jobs of the selected company to which the user has security access to. 

 

 

Main controlling jobs from the same/different company is linked as child jobs to the Parent job. 
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Once linked the category block for the Child job will be disabled and Insert/Insert Multiple/ Delete 
option will no longer be available for the Child job: 

 

 

Now, trying to link the Child job 20.21126M1 to some other Parent and as per the rule it is not 
displayed in the LOV and not available for linking. 

 

 



1268  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

Now, trying to link the Parent Job 20.21126M to some other Main Controlling job and as per the rule it 
is not displayed in the LOV and not available for linking. 

 

 

Category Block Flags: 

Exclude Cost Budget flag: 

This flag is checked for the following categories of the Parent Job:  

1000,3000 
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Before the flag is checked: 

Columns displays the actual values before the flag is checked: 
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After the flag is checked: 

The columns PMOJSQ_ORIG_BUDG_AMT, PMOJSQ_CURR_BUDG_AMT,      
PMOJSQ_PROJ_AMT in the Cost Status Query(PMJSP) for the checked categories is shown as 0. 

 

 

Exclude Costs flag: 

This flag is checked for the following categories of the Parent Job: 1000,3000. 
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Before the flag is checked: 

Columns displays the actual values before the flag is checked. 

 

 

 

After the flag is checked: 

The columns PMOJSQ_SPENT AMT and PMOJSQ_EXT_CO_AMT is shown as zero. 

Note that some of the features for this flag is still under development and only beta version is 
released for this patch. 
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Exclude Cost Forecast Flag: 

This flag is checked for the following categories of the Parent Job: 1000,3000 

 

 

 

Before the flag is checked: 

Columns displays the actual values before the flag is checked 
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After the flag is checked: 

The column PMOJSQ_CALC_PROJ_AMT is shown as zero. 

 

 

 

Related Jobs Block: 

NOTE: Note that only Beta version has been released for this patch. Some of the features are still 
under development. 

New Fields Added to the Document Options (21.44750) 

Overview: 

To add additional fields to the Document Options->Document Tab Program 

Modifications: 

The following three fields has been added to the Document Options->Document Tab program. 

• Sheet Name 

• Location 

• Discipline 

These fields are available for every document type. The field accepts alphanumeric values, and each 
field has an active flag where the user can turn these fields off for document types (like Attachments) 
that do not require those fields. Fields are turned off by unchecking the ‘Active’ flag. 

SCREENSHOTS: 
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Added flag “Show Spent as Actual Cost In WIP” to Job Setup 
(21.46567) 

A new flag is added to Job Setup > Settings tab, called “Show Spent as Actual Cost In WIP”. The flag 
will only be available when the “Show CPR as Cost Amount” flag at job level is checked. 

When “Show Spent as Actual Cost In WIP” is checked, the “Spent” column in the WIP program will 
show actual cost instead of the CPR Amount. 
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Added ‘Notes’ Button into the Tool bar for Enter Manual Forecast 
Screen (21.48682) 

Modified Enter Manual Forecast program (JCREVCAF) to change the Notes function from button to 
toolbar. User can add new, delete, edit, and close notes in the Notes popup window.  

Please note, Notes added to one record will be shown for all records with the same Cost Code. 
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Contact Code Made Mandatory for Saving Key Player in Project 
Maintenance Screen (20.36293) 

Modified ADF Project Maintenance screen to require Contact if Partner (Company code) is entered 
on Key Player tab to be in sync with PMJSP. 
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New Report Parameter 'Show Quantity' Added for JC Cost 
Transaction JC2000 Report (21.48963) 

A new parameter added to the existing JC Cost Transaction Report (JC2000) to show/hide the 
quantity column in the report. 

When Show Quantity is set to ‘Y’ the quantity column will be displayed in the report. While exporting 
to excel the quantity column will be visible. 

When Show Quantity is set to ‘N’ the quantity column will not be displayed in the report. While 
exporting to excel the quantity column will not be visible. 

Show Quantity set to ‘Y’. 

 
 

The Quantity column is shown in the Excel. 
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Show Quantity set to ‘N’ 
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Enhancement-Locking Cost Codes from Deletion/Deactivation Beta 

Version (21.42643) 

Implementation is in progress and Beta version is available for this patch 

Overview: 

The enhancement will allow the user to lock cost codes in the template and once the template is 
assigned to the job, the locked cost codes cannot be deactivated or removed from the job. This 
enhancement will only be available for R12 Enterprise version. No changes will be made to any 
reports or non-ADF programs 

Modifications: 

The modifications are made to the following programs. 

Job Cost Control File- JCCTRLFM: 

The following fields are added to the Job Cost Control File:  

1. Lock Cost Codes And Categories In Template Assigned To Job: When this flag is 
enabled, the Locked column will be visible on the Cost Code Template Maintenance 
screen. 

2. Job Cost Code Template: If a template is defined, then all the new jobs created will 
have that template defaulted on the job. 

3. Automatically Apply Template To Job: If enabled, the flag is automatically enabled on 
the job. 
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System Privilege 

New System privilege JCLOCKCC is added. When enabled it will allow users to lock/unlock the Cost 
Codes from the Cost Code Template screen. 

 

Win Lose Bid (JCBIDPRO) 

The column Cost Code Template is added. The template will default from Job Cost Control. Users 
can change from one template to another.  

If Copy Cost Codes is enabled and a template is defined, then both Bid Job Cost Codes and 
Template Cost Codes will be assigned to the job. 
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Cost Code Template Maintenance (JCPHSFM) 

The following modifications are made to the Cost Code Template Maintenance screen. 

 

1. A new column ‘Locked’ is added to the Cost Code Template screen. When the locked flag is 

enabled the template cost codes assigned to a job cannot be removed, and if the template cost 

codes are in the Master list, then it cannot be removed from the master. This new flag will appear 

in the screen only when “Lock Cost Codes And Categories In Template Assigned To Job” is 

enabled in Job Control screen. 

Only users or roles that have the privilege JCLOCKCC enabled will be able to lock/ unlock the cost 
codes. 



1282  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

 

 

Users or roles without the privilege JCLOCKCC will not be able to lock or unlock the cost codes. 

 

 

 
2. When the Cost Code is Locked, then the “Active” flag is disabled. 
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Cost Codes that are Locked cannot be deleted. But if the user has the privilege JCLOCKCC then 
cost codes can be unlocked and deleted. Users without the privilege should contact the system 
administrator. 

 

 

3. Similarly, when the Cost Code is Locked then the Active flag for its categories will be disabled and 

delete button will not be visible. 
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Active button is enabled for the categories for which cost codes are not locked and delete button is 
also available. 

 

 

Assign Job Cost Codes (JCPRODSU) 

The following modifications are made to the Assign Job Cost Codes screen 
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1. When a template is assigned to the job and if the cost codes from the template are locked, then 

those cost codes cannot be deleted from the job. Alert message is displayed when a user tries to 

delete the locked cost codes from the job. 

 

 

2. For Cost Codes that are Locked in a Template, the Active flag will be disabled.  

 

 
3. When the template is assigned to the job and if the template has cost codes that are locked, then 

the active flag for the categories of the locked cost codes will be disabled. Delete button will also 

be not available for those categories. 
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4. When using Add/Remove Categories button, Categories that are included in a Locked Cost Code 

will not be allowed to delete and the Selected flag will be disabled. 

 

 

5. If the Categories are added manually (not available in the template) to a locked cost codes on 

Assign Cost Code screen, then the Selected flag and delete button will be enabled for those 

categories. 
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6. When Lock functionality is enabled, then a different message will appear when using 

Add/Remove Categories from the Selection Criteria block. Only Categories that are not included 

in a Locked Cost Code will be removed from the Cost Codes. 
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Enter Cost Code (JCPHSMST) 
 

1. If the cost codes added in the template are locked then those locked cost codes cannot be 

deleted from the Master list. If user tries to delete the locked cost codes from the Master list then 

an alert message will be displayed. 

 

 

2. For Cost Codes that are Locked in a Template the Active flag will be disabled. 
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3. If a Cost Code is Locked in a Template, then the delete button will not be visible for the 

categories that are included in the locked Cost Code and the Active flag will be disabled. 

 

 

4. When Lock functionality is enabled then a different message will appear when using 

Add/Remove Categories from the Selection Criteria block. Only Categories that are not included 

in a Locked Cost Code will be removed from the Cost Codes. 
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Enter Budget (JCBUDGET) 

Active Category flag will be disabled if the Category is included in a Locked Cost Code. 

 

Revise Budget (JCBUDGUP) 

Active Cost Code and Active Category flags will be disabled when the Cost Codes are locked, and 
the Category is included in a Locked Cost Code. 
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Material Sales 

‘Print Address’ Option in Billing Invoices (15.11148) 

To provide the ability to print or suppress the Company Address Information in MS Billing Invoices. 

There may be a case where the company logo itself may have the address information hence printing 
of address details again may NOT be necessary. 

Modifications: 

The MS Control form > Invoices Tab is modified with a new checkbox ‘Print Company Address On 
Invoice’. 

The default value is ‘Checked’. The address information will always be printed, which is the existing 
functionality.  

When ‘un-checked’, then the address information will NOT be printed. 

 

Examples: 

The following examples show, that the new flag controls the printing of the address on the MS Billing 
invoices. 

Existing Functionality: When Checked: 
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New Functionality: 

When Un-Checked: Address Information Will NOT be Printed. 
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The following screens show how the logo file is determined for printing. 

When the Default Invoice Series Code has logo file path defined, then the specific logo will be printed. 
When no logo file path defined, then Company logo will be printed. This is an existing functionality 
and the following screens show an example of the same.  
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MS Ticket Entry > Column for ‘Dump Fee’ Amount (15.12164) 

The MS Company Control File is modified with a check box ‘Display Dump Fee’ under Sales Order 
Tab. The default value is ‘N’. 

 

 

Also added the ‘Dump Fee’ Column in the following screens: 

Sales Order Entry > ‘Origin/Destination’ popup screen > Next to Pay Rate column 
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Ticket Entry program > Next to the Trucker Pay Column 

When the flag in control file is checked, then the system will display the ‘Dump Fee’ column in both 
programs specified above. 

Sales Order Entry: 

 

 
 

The Sales Order Entry allows users maintain a ‘Dump Fee Rate’ against an Origin/Destination 
combination record.  

Ticket Entry: 

The Ticket Entry program, when users specify the Origin/Destination values and enter the item 
quantity, the dump fee will be calculated and populated as 

Dump Fee = Quantity * Dump Fee Rate 

This field is updateable and users may override the amount as required.  

Also, regardless of whether the trucker’s payroll or Billing Invoice are posted or not, this field is 
always updateable.  

This value is only for reference and may be used for any custom queries or reports. 

No other standard programs, queries or reports will be impacted with this change. 
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Note: 

When users want a different set of origin/destination, they have to delete the line and then reenter to 
have the dump fee recalculated. Otherwise the previously populated or overridden value will be 
retained. 

Sales Order Entry > Service Charge Override Changes (15.11193) 

Added two columns in Service Charge Override popup in Sales Order Entry header. 

Vendor class  Varchar2(4) 

Vendor Code  Varchar2(8) 

Users may enter or select valid values from the LOV. Users are allowed to select either one of the 
column values and not both. When users select any one column value, the other column will be 
cleared.  

The system will auto-populate the Service Charge values as per the Service Charge Maintenance, if 
available. These values may be overridden as required by the users. 

 

MS > Sales Order Entry > Service Charges popup 

The following two screens show the Service Charge Maintenance where the charges are maintained 
at Vendor or Vendor Class Level. These values will be defaulted accordingly, when users selection of 
Equipment Class, Vendor Class or Vendor accordingly. 
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Added Preview Posting option to Post Inventory Ticket Program 
(21.37851) 

Overview 

• ‘Print Preview’ flag is added to ‘Post Inventory Ticket’ program  

• Program: MS_POST_TICKETS 

Modification 

Highlighted flag shows the new ‘Preview Posting’ flag.  

 

Material Sales > Ticket > Post Inventory Tickets 

Microsoft Integration Package 

MIP - Adding Logos Based on Company (19.79674) 

Changes have been made to allow Microsoft Integration Programs (MIPs) to use the same template 
for all companies but be able to change the logo as needed, replicating Forms behavior. 

These changes include allowing merge documents to use .png and .jpg in the template for the logo. 

To maintain these logos, a new menu item has been created “Document Merge Logo Maintenance”: 
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Security access will be required and any custom tree-view will need to be adjusted to make this menu 
item available to users. 

 
 

Any logo maintained in this screen for a Company (1 per company) will replace the default logo in 
MIP templates. 

 

If no logo was uploaded for the current company the default logo will not be replaced. 
If no logo was included in the template the merge will still proceed correctly. 
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Example: 

Template with default logo: 

 

 

Log Maintenance screen with Company Logo to use: 

 

 

When a MIP document is printed using the template above, the logo in the maintenance screen is 
used: 
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Mobile  

MCT 

The mobile web service build B44 is included in this patch set. This build contains web services 
needed for future releases of our mobile applications. Please see the change log below: 

FIXED Web-service optimized to significantly increased performance of the 
application (saving, submitting, data retrieving, etc. operations) 

FIXED Web-service to avoid unnecessary 0 hours in each cell in timesheets 

ENHANCED Web-Service to handle timesheets properly when being modified using 
multiple sources (synchronization issue) 

FIXED Web-service to modified to allow creating activities with the same name 

FIXED MCT shift is now fully supported 

FIXED MCT timesheet shift is now defaulted based on system settings 

NEW Web-service to improve error handing mechanism. Added button "Share 
logs" for unhandled exceptions and sent email to centralized email 
address monitor by development and support. 

ENHANCED login errors now show proper error messages 

ENHANCED Cost code" and "Category" activity fields are now mandatory and it's not 
possible to save timesheet when they are empty. 

It’s possible, however, to have them stored locally with no values. 

FIXED Web-service to support available hour types for each crew member based 
on access administration and setup 

FIXED each crew member now has proper other hours' values 

 

Opportunity Management 

Customer/Vendor Indicators in Organization program (15.11857) 

The Organization program is modified with display only checkboxes to indicate whether the business 
partner is already a customer/vendor in one or more companies. 
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OM JSP Contact Hyperlink in ADF (15.10771) 

New Hyperlink is implemented on the Team tab on the Opportunity Screen beside the Contact Name 
under Contact column. 

 

 
 

 

Hyperlink directs users to the contact pop up to access the contact information. 
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BP Address Code Security based on Remit-To Flag (15.11856) 

Overview: 

CMiC has created a new security on the business partner Remit-To addresses. For that purpose the 
new system option flag “Secure Remit-To Address” and a new privilege “SYS-Allow Edit of Remit-To 
Address” have been introduced.  

When the system option flag “Secure Remit-To Address” is checked Remit-To addresses become 
protected and only users with the privilege “SYS-Allow Edit of Remit-To Address” will be able to edit 
them including checking on and off the Remit-To flag itself. 

Note: The users without this privilege are still able to edit business partner alternate addresses that 
do not have the flag Remit-To checked though they cannot change the status of Remit-To flag.  

Also the users without this privilege can create new business partner alternate addresses (where they 
did not exist). In this case the flag Remit-To (either checked or unchecked during the address 
creation) will become protected (disabled) immediately upon saving the record.   

This new business logic affects Maintain Business Partner, Maintain Vendor, Maintain Customer, and 
Organization ADF programs.   

Settings and Examples: 

To check on/off  the system option flag “Secure Remit-To Address” go to: 

System -> Setup -> System Options -> Global tab: 
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1. To assign/revoke the new privilege “SYS-Allow Edit of Remit-To Address” to a user go to: 

System -> Security -> User -> User Maintenance -> System Privileges tab -> EDREMITADD 
Privilege Code: 

 

 
 

2. The Remit-To flag locates on Address Tab of the Business Partner Maintenance screen: 
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3. The business partner alternate address screen could be accessed via different programs: 

a/  Account Payable -> Setup -> Maintain Business Partners program -> Click Edit Icon next to 
the Business Partner Code  -> Address tab 

b/  Account Receivable -> Setup -> Maintain Business Partners program -> Click Edit Icon next 
to Business Partner Code -> Address tab 

c/  Account Payable -> Setup -> Maintain Vendors program -> Click Edit Icon next to the 
Business Partner -> Business Partner Address tab 

d/  Account Receivable -> Setup -> Maintain Customers program -> Click Edit Icon next to 
Business Partner -> Business Partner Address tab 

e/  Opportunity Management (ADF) -> Organizations -> Click Edit Icon next to Organization -> 
Business Partner Address tab. In this particular case the screen has the same content but 
different appearance: 
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Regardless the program the user is utilizing to access the business partner alternate address screen 
the business logic remains the same. 

New functionality summary: 

1. The new system option flag “Secure Remit-To Address” and a new privilege “SYS-Allow Edit of 
Remit-To Address” have been introduced.  

2. When the system option flag “Secure Remit-To Address” is checked the business partner alternate 
addresses that have Remit-To flag checked become protected. In this case only the users with the 
privilege “SYS-Allow Edit of Remit-To Address” will be able to edit these alternate addresses as well 
as to check on and off the Remit-To flag itself. 

Opportunity Revenue Tab – Closing Revenue and Send To 
Spreadsheet (17.34710) 

NOTE: OM JSP has been deprecated. 

Added a Closing Revenue column and the [Send to Spreadsheet] button to the Revenue tab of the 
OM Opportunity screen in PM JSP. 

The prompt for Closing Revenue can be changed to a more suitable name if desired, using Prompt 
Maintenance. 

Field security is available to be set for the two new objects.  The default setting is ‘Hidden on the 
*ALL* role: 
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When the field security is set to ‘Unrestricted’, the objects can be seen on the Revenue Tab of the 
Opportunity screen: 

 

 

The Closing Revenue is calculated: 

Potential Revenue X % chance of closing, and is spread over the number of months: 
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The [Send to Spreadsheet] button will generate a spreadsheet of the data: 
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Opportunities Log – Action Item Date and Note columns added 
(17.34445) 

NOTE: OM JSP has been deprecated. 

 

Added two columns to the opportunities log in OMJSP based on the most recent action item that is 
listed on the opportunity under the Action Items tab.  

a) One column is the Date field from the action item.  

b) The other column pulls data from the Note attached to the action item. 

Addition to Conditional Required Fields Based on Sales Stage 

(19.85683) 

Added a new system privilege "OM: Allows user to bypass conditionally required fields that are setup 
by sales stage".  

 

Modify database routine which checks for conditionally required fields by sales stage, to determine if 
the validation should be triggered based on the new user privilege. 

Setup opportunity required fields as follows: 
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If the privilege flag is off, system will check for required fields.  

 

If the privilege flag is on, system will bypass the conditionally required fields. Validation will not be 
triggered. 
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Conversion of Company Types Program from FORMS to ADF 
(20.29860) 

  

Overview 

Converted Company Types program to ADF. 

Modifications 

Company Type menu added to Customer Relationship Management > Opportunity Management > 
Setup > Company Types. 

 

Customer Relationship Management > Opportunity Management > Setup > Company Types 
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Implementation 

Company Types LOV is available for user in the following programs: 

1) Organization Management 

2) Business Partner Maintenance 

 

Customer Relationship Management > Opportunity Management > Organizations 
 

 

Financial > Accounts Payable > Setup > Maintain Business Partner – Company Type tab 
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Added Ability to Import Notes (21.40230) 

Overview 

Added Import button to import notes in Opportunities. 

Modifications 

Added ‘Import’ button under ‘Notes’ tab in Opportunities.  

 

Customer Relationship Management> Opportunity Management> Opportunities Implementation 

 

Customer Relationship Management> Opportunity Management> Opportunities 

Download the CSV template and input and save you input your Notes in it. Upload the saved notes 
and click on ‘Validate File’ button. 
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Customer Relationship Management> Opportunity Management> Opportunities 

Once notes are validated, click on ‘Import File’ button to import notes. 

 

Customer Relationship Management> Opportunity Management> Opportunities 
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Customer Relationship Management> Opportunity Management> Opportunities 

Payroll 

Modifications to Expense Functionality (15.10038) 

CMiC expanded the expense functionality to allow users to setup expense codes with a calculation 
method based on a percentage of base rate. The master setup was changed to add a new drop down 
for Expense Type called "Percent of Base Pay Rate". Upon selection of the type, the system will allow 
users to setup a percentage of the expense. All current timesheets programs have functionality to 
retrieve the rates based on employee preference. The same functionality will be utilized to retrieve the 
rate in order to calculate the percentage of expense base on employee pay rate. Applicable timesheet 
programs will display the calculated rate based on employee pay rate and percentage setup on 
expense category screen for the specified expense code on the timesheet. The user MUST enter the 
quantity in order to calculate the amount for the expense. 

All timesheets including regular and mechanics timesheets are modified to allow users to enter 
expense code along with the described functionality above. The expense claim entry screen will also 
be modified to allow users to enter the new expense category. 

Base Rate: The base pay rate is the employee pay rate setup in CMiC payroll. The pay rate can be 
setup by employee, Job, Union or trade. The profile allows users to set the preference hierarchy for 
pay rate in order to get the pay rate when entering timesheets. 

1. On the Expense Maintenance screen added a selection for “Percent of Base Pay Rate” to the 
“Unit” field.  
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2. Existing "Expense Rate" field will be used to enter the "Percentage".  Entering 35 means 35% of base 

pay rate. The "Expense Rate" field is on the expense maintenance screen when Unit is "Percent of 
Base Pay Rate".  
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3. There is a new field was added to Regular Timesheet Entry “Expense Hour Type” with a 4 

options in drop down menu: Normal, Overtime, Double, Other. 

 

 
 

4.  When a "Percent of Base Pay Rate" Expense is entered, the program calculates the default 
expense "Rate" by taking the expense master "percentage" value and multiply by timesheet 
normal pay rate (exp.pct x payrate/100). This calculated expense "Rate" id displayed on the 
timesheet screen and cannot be overridden by the user. Total expense amount will be calculated 
as usual by taking (expense quantity X expense rate) rounded to 4 decimal places. 
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In the above example, the program calculated the Expense rate by taking 35% from Regular pay rate: 
Regular Pay Rate $38 * 35% = $ 13.30. User needs to enter the quantity and the program will 
calculate the Expense Amount automatically. 
 

Addition of ‘Trade’ field to PY Overhead Cost Rates Form (16.18438)  

Addition of ‘Trade’ Column/Field: CMiC has modified and added a ‘Trade Code’ option to PY 
Overhead Rate Setup under PY> Setup> Jobs-Overhead Code> Overhead Rates Screen. The 
TRADE field/column is added after the Pay Group column and field. The new TRADE column/field will 
allow users to setup overhead rates by Trade. The default value for the TRADE would be ‘ALL’. The 
overhead calculation program is modified to consider this new field and option. If an overhead rate is 
setup by specifying the ‘Trade’, then the Trade Code would take precedence, otherwise system will 
use the ‘ALL’ value. 
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Pgm: PYOVHEAD – Payroll Overhead Cost Rates 

The Payroll Overhead Cost Rates form is for creating and maintaining Overhead Codes for 
application of overheads to Jobs and Departments. These overheads can be either Rate or Amount 
based, and may be general, or very specific in their determination of amounts to be charged to a job 
or a department. Multiple Overhead Codes may also be assigned to any job through the Assign 
Overhead Rates to Job form. 

NOTE: Overheads will only be applied at the Timesheet Posting, and only when the flag for ‘Calculate 
Overhead’ is checked on the Timesheet Posting form. 

 

NOTE: Final Posting will calculate Overhead Markup (%) on benefit Tran Types (transaction lines), 
provided the benefit has the ‘Calculate Overhead’ flag checked and is Job Allocated to that 
Job/Phase/Category. 

Use Case Scenario: Entered timesheet for an hourly employee Trade Code 220 with a job allocated 
to DMSR benefit. Entered another timesheet with a different job that is not allocated to DMSR benefit 
for an hourly employee with a different Trade Code ZZ10. In this example, the DMSRB benefit is job 
allocated with a 2.5% markup. The benefit should calculate 2.5% overhead on employee’s basic 
wage, expense and a 2.5% overhead cost against Union and Non-Benefits against Trade Code 220 
as specified on the Payroll Overhead Cost Rate Setup Form. 
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Entered and posted Timesheets for the two hourly employees with 2 different Trade Codes. 

EE: CA-EMPLOYEE11 with Trade Code 220 has calculated 2.5% Overhead on Wages (NWHR, 
OVHR, DTHR) (1200 + 60 + 90 = 1350) 2.5% of 1350 = 33.75. 2 Expenses (31.50 + 9 = 40.50) 2.5% 
of 40.50 = 1.02. Total DMSR = 34.77 

EE: ZZ-100 with Trade Code ZZ10 did not calculate 2.5% DMSR Benefit on Wages and Expenses. 

Timesheet Job Costing Report 
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Processed Payroll, Printed Checks and completed Final Payroll Posting. 

Job Costing Final Posting Report 
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Addition of the ACH Date Format option on the Bank Setup screen. 

(16.20718) 

Overview 

CMiC added an ACH Date Format option on the Bank Setup screen.  

The default date format will remain "YYMMDD" if the new date format field is NULL. 

 

Modification: 

1. A new field “ACH Date Format” has been added on the Bank Maintenance screen to allow user to set 
the desired date format of the ACH Check/Register Reports. 
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2. When the ACH Date format is setup on the Bank Maintenance screen, the ACH file uses this format 
on the EFT report. 
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3. When the ACH Date format is setup as NULL/blank on the Bank Maintenance screen, the ACH file 
uses a default format “YYMMDD”. 
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4. The Company Number on the ACH file is preceded by the Region Code which is setup on the 
Company Control screen->Direct Deposit tab. 
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Modifications to ‘401K Filing Parameter’ Form (16.24454) 

Overview:– Added Report options by Tran Date and Post Date on the 401K Filing Parameter screen. 
Program has been modified to look at posting date instead of transaction dates for Multiple Company 
option. CMiC has made the following modifications to ‘401K Filing Parameter’ screen:  

Addition of two new drop down options for  401K file creation when Multiple company plan code is 
selected. The new "REPORT DATE BY" option will be availabe with two drop down selections: 

1- Transaction Date:   ( This will be the actual transaction Date between the Date From and To) 

2-Posting Date:  (This will be the actual posting date between the Date From  and To)) 

There will be no change in programing when the Multiple Company option is not selected by user. 

Note:  If the plan code has multiple companies then the user is not allow to select Pay run and Pay 
period because multiple companies may have different pay frequency and/or  period start and end 
dates. The user is allowed to enter only a start date and end date for timesheet transaction date. The 
system will pick all the timesheet transactions between the start date Brinderson requires and end 
date. 

 

Step 1: PY Setups 

Govt Forms: 401K Plan Maintenance – Multiple Company Plan Code 
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Step 2: PY Govt Forms – 401K Parameter Screen Processing  

Generating the 401K XML File with Report Date by Option: Posting Date Vs Transaction Date 

REPORT DATE BY" option will be available with two drop down selections: 

1- Transaction Date: This will be the actual transaction Date between the Date From and To 

2-Posting Date: This will be the actual posting date between the Date From and To 

There will be no change in programing when the Multiple Company option is not selected by user. 

Note:  If the plan code has multiple companies then the user is not allowed to select Pay run and Pay 
period because multiple companies may have different pay frequency and/or period start and end 
dates. The user can enter only a start date and end date for timesheet transaction date. The system 
will pick all the timesheet transactions between the start date and end date. 
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Report Date By: Options added  

 

Generating 401K. XML File: 401K Parameter Screen with Report Date by: Posting Date 

Note: This will be the actual posting date between the Date From and To 



1334  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

 

With Posting Date option, the 401K ASCII file created and processed with 3463 employees. 

Generating 401K. XML File: 401K Parameter Screen with Report Date by: Transaction Date 

Note: This will be the actual transaction Date between the Date From and To 
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With Transaction Date option the 401K ASCII file created and processed with 3464 employees. When 
compared to Posting Date, file generated with option of Transaction Date has 1 extra employee 
picked from pay period 23. Generated 401K XML File successfully with option Transaction Date. 

 

Posted Crew Timesheet Screen (16.24261) 

CMiC has made the following modifications in Crew Timesheet Program. 

A new feature/screen has been added on the tree view called 'Posted Crew timesheets'.  It has the 
same appearance as the Crew Timesheet Approval option, except that, it will display a log for all 
posted timesheets. The log will display Job Company, Job Code, Date, Shift and Crew code with a 
radio button for the user to select the timesheet to display. Once the crew timesheet is selected, the 
program will open the timesheet in a popup window with LOCKING MODE.  

The log will display the 'Originator' or 'Crew timesheet Owner' by pulling the name of the person 
who generated this timesheet. 

A new screen has been added to the PYE Application Tree View called ‘Posted Crew Timesheets’. 

[Copy Timesheet] button has been added to copy timesheet from previous day.  

Enter Job, Date and Crew Code. User can type a new crew code or the same crew code. Select 
[Refresh] button to load a blank Crew Timesheet.  

[Copy Timesheet] buttons is only enabled and appears if the Crew Timesheet is empty. 

Select [Copy Timesheet] to copy previous existing timesheets. A popup opens for the user to select 
and copy previous crew timesheets. User is able to search by Crew Code. 

Posted Timesheet from previous period is available to be copied over to current. 

[Copy Timesheet] feature to copy an Unposted Timesheet. 

Unposted (submitted) Timsheets are also available to be copied via [Copy Timehsset] button. 

[Recall Previous Header] button is enabled as soon user submits the crew timesheet. 

Timesheet is available to be submitted and approved in Crew Timesheet Approval screen. Crew 
Timesheet is avilable for Timesheet Posting. 

Posted Crew Timesheet Screen & Log: 

Posted Crew Timsheet Screen only display the logs for Posted Timsheets. User can review the 
Posted Crew Timsheet and log under the new added ‘Posted Crew Timesheet’ Screen. 

User can select the Posted Timesheet to review. The posted timesheet is in Locked Mode. 

User can search Posted Crew Timesheet from Created By: 

The log will also display the 'Originator' or 'Crew timesheet Owner' by pulling the name of the person 
who generated this timesheet. 

Crew Timesheet: Addition of Comment & Notes Field (16.24242) 

CMiC has made the following modifications in Crew Timesheet Entry and Approval screens: 

1- Addition of Comment field per employee row. The Comment Field is added to Employee Section 
on the Crew Timesheet Entry and Approval Screen only. 
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2- A ‘New Table’ is created for the Crew Time Comment field to store data per line. Comments and 
notes are available to the user and displayed on Crew Timesheet and Approval screens. 
Comments & Notes entered buy the user, is applied per line. 

NOTE:  Printing Crew Timesheet Comments and Notes on report is not in scope. CMiC has not 
modified any Crew Timesheet and Edit Listing Reports, other than Crew Time Entry and Crew Time 
Approval Screens for addition of Comments Field. 

The Comment & Notes field is on Employee Entry Screen after the Union Code field. The Comment & 
Notes is a Static field. User can enter notes and text wrap with the length of the note. User can 
double click on the Comment Field, to open a small popup window and enter and/or edit the value. 
The Comment filed also has a Spell Check feature. Special Charcaters are also allowed and will be 
saved with no errors. 

The user entered comments and notes are saved in the crew timesheet entry screen and submitted 
for Approval. Crew Timsheet is posted via the Approval Screen with the inserted comments and 
notes. 

Timesheets entered notes in the comment field will be deleted when user deletes the Timsheet. 
Delete Multiple Rows with comments and notes is also available. 

Crew Timesheet: ‘Copy Previous Record’ button to copy 
Equipment hours (17.3377) 

CMIC has modified ‘Copy Previous Record’ program with the functionality to copy the Equipment 
information along with Employee information. 

‘Copy Previous Record’ button is available to copy both employee and equipment information from 
the previous day. 

Pre-Requisites: Under Crew Timesheet Configuration and Setup check the flags for the following to 
enable this functionality: 

Copy Previous Timesheet hours 
Copy Equipment Hour 

Enter timesheet and select ‘Copy Previous Record’ button to copy both employee and equipment 
information and hours from the previous day (Crew Timesheet) to the current Crew Timesheet entry 
and date. 

 

 

E-Time Job Security per Enterprise (17.31773) 

Overview of the modification: To limit an employee’s job access in E-Time to only those 
Jobs/Projects that, the employee has access to in Enterprise when there is an asterisk (*) assigned to 
the Job field in E-Time Access Code Administration. If there is no (*) asterisks specified, then security 
should work as is. 

CMiC has modified E-Time Job Security by adding three new flags on the system to allow users to 
filter Job LOV. The new added flags are as under: 
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Added 'Allow E-Timesheet Entries' flag on the Payroll Tab of Job Maintenance Module. To Allow 
Transactions against the Job in E-Time Entry Screen, if it is 'Y' 

Added ‘Allow All Allocations When Access Code Allows None’ Flag on 'E-Timesheet' Tab of System 
Option module. If 'Checked' then Allow All Allocations When Access Code has no setup on 
Job/Account Tab and Override PY Company Control Level Setup 

Added ‘Restrict To Enterprise Job Security’ flag on the ‘E-timesheet Role Maintenance’ module to 
allow users to restrict by job security (My Jobs). When the flag is ‘Checked’ then user is only allowed 
to enter secure jobs. All Jobs, radio button will not be available to user in the Job LOV. This function 
will only be available if, feature ‘Allow Access to all jobs where access is null’ has been enabled. 

Job Costing - Job Setup Screen: A New flag is added on the Job Setup screen in addition to ‘Allow 
Transaction’. The new flag is called ‘Allow E Timesheet Entries’. The default value for the flag will be 
CHECKED. The new flag will allow users to Un-Check the flag to remove the job from timesheet entry 
screen including E-Time, Crew Time and Mechanics time entry screens. E-Time users will not be able 
to enter time once the flag is Un-Checked.  The existing ‘Allow Transactions’ flag functionality will 
remain the same. The ‘Allow Transactions’ flag will supersede the new ‘Allow E-Timesheet Entries’ 
flag. Once the ‘Allow Transactions’ flag is un-checked, the job setup will automatically un-check the 
new ‘Allow E-Timesheet Entries’ flag. The ‘Allow E-Timesheet Entries flag is disabled when ‘Allow 
Transactions’ flag is un-checked. 

Hour Type Job Mapping Screen in E-Time: Additional modification is made for Hour Type Job 
Mapping in E Time. The Job LOV is modified to consider hour type mapping when ‘Restrict To 
Enterprise Job Security’ flag is checked. Job LOV will now apply and consider E Time Hour Type Job 
mapping in Secure Job mode.   

NOTE:  Enterprise Job Security will only apply, if the Job field under User Access Code 
Administration is null and empty. If there are (*) Asterisks and or values, then the job security will be 
applied as per the user access code and defined in the Job field.  

Job Costing – Job Setup screen 

In Job Costing module > Job > Enter Jobs > Query the Job > Go to Payroll tab and check the flag 
“Allow E-Timesheet Entries”. When this flag is checked, the program allows user to create 
transactions against this Job in E-Time, Crew Time and Mechanic Time 
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System Options – E Timesheet Tab 

On the Main Menu > System > Setup > System Options > E-Timesheet tab > check the flag “Allow 
All Allocations When Access Code Allows None”. When this flag is checked and the Job is not 
setup on the Access Code Administration screen, then the program will display all Jobs in the Job 
LOV on the E-time Entry screen and, also Override PY Company Control Level Setup. 

 

On the E-time tree view > Select E-time Role Maintenance > ‘Restrict To Enterprise Job Security’ flag 
feature is added on the ‘E-timesheet Role’ Setup screen. When this flag is ‘Checked’ then user is only 
allowed to enter jobs which are setup under the Enterprise user Job Security group, when unchecked 
user can enter any job. 

 

Enterprise User 

The Job LOV restricts and displays the jobs for the user based on the Enterprise Job Security. 

NOTE:  The Access Code Setup (Master) in this condition has no Job assigned under the Access 
Code Administration, Job Tab. The Job Tab is empty and has no values. 
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Scenario 1: 

When the flag ‘Restrict To Enterprise Job Security’ is unchecked under E-Time Role 
Maintenance, the Jobs LOV displays 2 radio buttons: My Jobs and All Jobs. This is under a 
condition where there is no Job setup under Job field in the Access Code Administration screen. 

My Jobs radio button displays Jobs based on user’s enterprise job security. 

All jobs radio button displays all jobs based on the access code security. 

When the flag ‘Allow All Allocations when Access Code Allows None’ is unchecked, then ALL 
Jobs radio button will not display ALL jobs and retrieve any records for the user. 

Scenario 2: 

In E-Time Role Maitenance: ‘Restrict To Enterprise Job Security’ flag is checked. 

Access Code Administration Setup: User Access Code has a Job assigned under Job tab. 
Access Code has a Job defined under Job tab. The Job LOV, will display as per the Access 
Code setup. 

Hour Type Job Mapping – Restrict to Enterprise Job Security Mode 

The job lov is modified to consider hours type mapping in security job mode. 

In E-Time Role Maitenance: ‘Restrict To Enterprise Job Security’ flag is checked. 

Access Code Administration Setup: User Access Code has no Job assigned under Job tab. 

Under Company Profile, E-Time tab, ‘Filter Phases for Default or E-Time’ flag is checked. 

When entering Vacation Hour Type as per defined Hour Type Job Mapping in ETime, with ‘Restrict 
To  Enterprise Job Security’ flag checked. The Job LOV will consider the hour type job mapping setup 
and displays the jobs that the user has security access in Enterprise. 

Restrict Phase Codes in E-Time (17.31775) 

To restrict phase codes in E-time based on Category. The E-Time category flag should drive phase 
codes availability in E-Time. When a specific phase code does not contain a category that is selected 
for E-Time use, then it should not be available in E-Time Application.  

NOTE:  This functionality is in conjunction with 17.31773 (E Time Job Security and Restriction flag)  

CMiC has made the following functionality modifications to accommodate Restrict Phase Codes in E-
Time functionality. 

In Payroll Company Control > E-Timesheet Tab the following changes are made: 

Default Category field is not a required field anymore, when the ‘Filter Phases Category’ flag is 
checked. User, can enter and or leave the field blank. 

Hint on ‘Filter Phases for Default Category is changed accordingly. 

Program changes is applied for both FORMS and ADF. 

The label for ‘Filter Phases of Default Category’ is changed to ‘Filter Phase for Default Or E-Time 
Category’. 

E-Time JSP program is changed to apply the new logic below: 
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When Default Category field/column in the PY Company Profile is Null, then program should retrieve 
ALL the Phases for ALL the Categories that have E-Time flag checked under the E-Time Categories 
setup screen. This is the logic condition and program should validate this against E Time Categories 
screen in Payroll. 

Payroll Company Profile Maintenance screen 

Payroll Company Profile Maintenance screen: Filter Phases for Default Or E-Time Category. Hint is 
also changed as per the functionality and logic. When flag is Checked: Phases will be filtered on the 
basis of default category in E-Timesheet. 

Setup Conditions & Implementation  

User can check the Filter Phase for default or E-Time Category, without entering the ‘Default 
Category’ field.  

Scenario 1: E Time Categories are all checked and available for E Time. 

Scenario 2: Filter Phases for Default Or E Time Category is checked with Default Category field null. 

Removed Categories 1300 and 4000 from E-Time under Payroll E-Time Categories screen.  
UserAccess Code in E Time has defined Job in the Job field tab under Access Code Administration. 
Job is specific, Phase and Category is (*). Testing in conjunction with Restrict To Enterprise Job 
Security flag and Allow All Allocations When Access Code Allows None functionality and logic. 

Filter Phases for Default or E-Time Category has only made Category 1100 available in the Category 
LOV on E Timesheet entry screen, when user is entering time. Categories 1300 and 4000 are not 
avilable in E-Time since the flag is unchecked in Payroll E-Time Categories screen. E Time JSP logic 
applied to filter the categories against E Time Categories screen and filter the categories, even 
though the user access has an (*) asterisks for Category field.  

E-Time JSP Logic 

E-Time JSP Program is modified to apply the new logic, that if the ‘Default Category’ column is the 
Company Profile is null, then, it should retrieve and pull ALL the Phases for ALL the Categories that 
have the E-Time flag checked under the E-Time Categories setup screen in payroll module. This logic 
is now fixed and  applies to both, a) when the user Access Code has Job setup with (*) asterisk 
and/or b) Job Setup as ‘Null’ without any (*) asterisk. 

 
 

Setup Condition 1: If user access code job tab setup is null with no Job/Phase/Category, and Filter 
Phases for Default Category flag is checked with ‘Default Category’ field as null, then E Time JSP 
Logic will filter the category through E Time Category setup screen to verify if the E Time flag is 
checked or un-checked.  

The Job LOV will also retrive based on Job Security Access and Restriction to enterprise job security 
flag (if enabled). 

Setup Condition 2: If user access code job tab setup is null with no Job/Phase/Category, and Filter 
Phases for Default Category flag is checked with ‘Default Category’ field entered ( Category 1300) to 
restrict to a sepcific Category, then E Time JSP Logic will filter the category through E Time Category 
setup screen to verify if the E Time flag is checked or un-checked.  

 
E Time Category restriction and filtering: E Time JSP Logic will now filter the category through E Time 
Category setup screen to verify if the E Time flag is checked or un-checked.  
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Import Timesheets from Oracle – Utility (17.35950 &17.37335)  

CMiC has made modifications to the Import Timesheet from Oracle Program, adding the WBS and 
PCI along with other additional columns in the utility. The import program is modified to add all WBS 
columns along with their validations. The import will ONLY consider WBS values provided in ASCII 
file when JOB information is available on the same line. If the WBS is not enabled on the JOB, the 
import routine will ignore all WBS data provided in the ASCII File. The CSV file format is also modified 
adding the new WBS columns at the end of the file. The Oracle Control File layout (CTL File 
Template) is also modified to reflect this change.  

The rate is derived from the employee profile and these fields are now optional within the import.     

PCI value will be validated only, if entered. The import program will validate WBS entries. 
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Under the Utilities Payroll menu, select Import Timesheets>Import Timesheets from Oracle.   

[Import ASCII File to Oracle Table] – Button 

 

Pgm: PYTIMIMP- Time Sheet(s) Import Utility 

The [Import ASCII File to Oracle Table] button on the form allows users to directly import an ASCII 
file to the Oracle Timesheet table PYEMPTIMSHT_IMP.  This button is active if there is no 
information filled in on this screen.  It will open an ASCII import popup for importing the ASCII file. 

In the popup, select the [Browse] button to find the file to import.  Select the import button to import 
the data. The number of lines read and imported will be displayed.  Once, the import has completed 
and the window is closed, the Oracle Timesheet Import procedure can begin.  Rate calculation 
considers the shift code when determining the rate.  The enhanced program will consider and include 
the new added fields below along with validations: 

IMP_TSH_EXP_CODE ,  

IMP_TSH_EXP_QUANTITY ,  

IMP_TSH_EXP_RATE ,  

IMP_TSH_EXP_AMOUNT , 

IMP_TSH_WBSV_CODE1, 

IMP_TSH_WBSV_CODE2, 

 IMP_TSH_WBSV_CODE3, 

 IMP_TSH_WBSV_CODE4, 

 IMP_TSH_WBSV_PCI_LINE_ORASEQ, 

IMP_TSH_OVERRIDE_REF_CODE,  

IMP_TSH_OVERRIDE_REF_DES ,  

IMP_TSH_PRIOR_PERIOD_FLAG,  

IMP_TSH_ACTUAL_WORK_DATE),   

The Import Timesheets from Oracle program is modified to validate the expense code defined in 
payroll setup, based on the expense type and Qty/Amount fields. The following conditions and rules 
are taken into consideration for Expense Code, Expense Type, Quantity and Amount: 
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If the Expense Code is setup as type ‘Actual’ on the expense master setup, the QTY/AMT value is 
considered as a flat amount. 

If the expense Code is setup other than ‘Actual’ type, on the expense master setup, then the import 
program will consider the EXP_QTY and EXP_AMT, and the EXP_RATE, specially for the Expense 
that is not setup as Actual. In a scenario where the expense and timesheet hours are provided in the 
same record, the program will create an hours and expense with the Job/Phase/Cat Code or 
Overhead Department and Account. 

 The ASCII file imported must be comma delimited and match the order below.  

1.  IMP_TSH_EMP_NO                  VARCHAR2(16)  

2.  IMP_TSH_DATE                    DATE DD-MON-YYYY 

3.  IMP_TSH_JOB_CODE                VARCHAR2(10)  

4.  IMP_TSH_PHASE                   VARCHAR2(16)  

5.  IMP_TSH_CATEGORY                VARCHAR2(4)  

6.  IMP_TSH_NORMAL_HOURS            NUMBER (16,8)  

7.  IMP_TSH_OT_HOURS                NUMBER (16,8)  

8.  IMP_TSH_DOT_HOURS               NUMBER (16,8)  

9.  IMP_TSH_OH_HOURS                NUMBER (16,8)  

10.  IMP_TSH_OH_TYPE                 VARCHAR2(4)  

11.  IMP_TSH_WORK_COMP_CODE          VARCHAR2(2)  

12.  
IMP_TSH_DEPT_CODE               VARCHAR2(6) Optional – based on Control File 

Flag 

13.  
IMP_TSH_GL_ACC_CODE             VARCHAR2(8) Optional – based on Control File 

Flag 

14.  IMP_TSH_WORK_LOC                VARCHAR2(4)  

15.  IMP_TSH_EQP_HOURS               NUMBER (16,8)  

16.  IMP_TSH_DOCUMENT_NO             VARCHAR2(30) Optional 

17.  IMP_TSH_TRADE_CODE              VARCHAR2(4) Optional 

18.  IMP_TSH_UNION_CODE              VARCHAR2(4) Optional 

19.  IMP_TSH_OH_RATE_CODE            VARCHAR2(4) Optional 

20.  IMP_TSH_CKLOC_CODE              VARCHAR2(16) Optional 

21.  IMP_TSH_SHIFT_CODE VARCHAR2(1) Optional 

22.  IMP_TSH_NH_RATE NUMBER (16,8) Not Required 

23.  IMP_TSH_OT_RATE NUMBER (16,8) Not Required 

24.  IMP_TSH_DOT_RATE NUMBER (16,8) Not Required 

25.  IMP_TSH_OH_RATE NUMBER (16,8) Not Required 

26.  IMP_TSH_SECTOR_CODE   

27.  IMP_TSH_SCHEDULE_CODE   

28.  IMP_TSH_EXP_CODE VARCHAR2(4)  

29.  IMP_TSH_EXP_QUANTITY  NUMBER (16,8)  

30.  IMP_TSH_EXP_RATE   

31.  IMP_TSH_EXP_AMOUNT   

32.  IMP_TSH_WBSV_CODE1  VARCHAR2 (10) Required, if enabled on Job 

33.  IMP_TSH_WBSV_CODE2 VARCHAR2 (10) Required, if enabled on Job 

34.  IMP_TSH_WBSV_CODE3 VARCHAR2 (10) Required, if enabled on Job 
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35.  IMP_TSH_WBSV_CODE4 VARCHAR2 (10) Required, if enabled on Job 

36.  IMP_TSH_WBSV_PCI_LINE_ORASEQ NUMBER (16,8) Required, if enabled on Job 

37.  IMP_TSH_OVERRIDE_REF_CODE   

38.  IMP_TSH_OVERRIDE_REF_DESC   

39.  IMP_TSH_PRIOR_PERIOD_FLAG   

40.  
IMP_TSH_ACTUAL_WORK_DATE 
DATE 'DD-MON-YYYY' 

  

[Import Oracle Table] – Button 

The [Import Oracle Table] button allows users to import data directly from the Oracle Timesheet 
table PYEMPTIMSHT_IMP.  The import utility is modified to consider and include the new added 
field/columns for WBS and PCI. The Import Timesheets from Oracle program is modified to validate 
these fields. This screen is used when not entering timesheets directly into Enterprise.  It is used to 
import unposted timesheet data into Enterprise’s Payroll module via a .CSV spreadsheet file.  For 
details about the fields and format of the import file, refer to this section’s Import File’s Fields & 
Format subsection. 

The import process requires 3 steps, if there were no issues with the entries in the import file. 

Step 1 

The first step is to import the import file’s data into a temporary table in the system via the 
[Import ASCII File to Oracle Table] button. 

 

Step 2 

Once, the ASCII file is imported to Oracle Table, then user can enter the mandatory Company 
Code, Pay Run, Year and Period into which timesheet data will be imported. The Period LOV will 
display the current period and the next 3 open periods. The Default Category field assigns that 
category if the category imported is null. Enter the Document Code which will be assigned to the 
unposted timesheets created if the document code is null on the imported timesheet. 

Then, the mandatory Company, Pay Run, Import into Pay Year, and Import into Pay Period 
fields are used to specify the Company, Pay Run, Pay Year and Pay Period for the timesheets 
being imported. 

The Default Category and Default Document No fields are optional. 
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Step 3 

Then, the temporary table’s data is imported into Payroll as unposted Timesheets using the 
[Import Oracle Table] button. 

If there were any issues with some entries in the import file during the second import, a message will 
be reported stating how many were rejected with the Error reason. 

The rejected entries can be corrected via the [View Rejected Entries] button’s popup, and once 
corrected, the import process can be retried for these entries via the popup’s [Import] button. 

Selection Parameters 

 

Pgm: PYTIMIMP- Time Sheet(s) Import Utility 

Company 

Company Code must be entered. 

Pay Run 

Enter pay run into which the timesheet data should be imported.  

Import into Pay Year 

Pay Year into which the timesheet data should be imported 
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Pay Period  

Enter Pay Period into which the timesheet data should be imported 

Default Category 

Enter default Category to be used with Job and Phase, if Category is NOT imported with 
timesheets. 

Default Document No 

Enter the Document Code which will be assigned to the unposted timesheets created, if the 
document code is null on the imported timesheet. 

[Import Oracle Table] – Button 

 

When the [Import Oracle Table], button is selected, the number of Timesheet records 
processed, inserted and rejected are displayed at the bottom the screen.  

 

The rejected entries can be corrected via the [View Rejected Entries] button’s popup, and once 
corrected, the import process can be retried for these entries via the popup’s [Import] button. 

The [View Rejected Entries] button opens a screen with rejected entries where user can edit 
the data until all record(s) are valid. When the record(s) are rectified and valid, select the Import 
button on the Rejected Timesheet(s) Entries screen to import the corrected entry record and 
insert into the timesheet. 

Once, the record is corrected, user saves and selects the Import Button to import the corrected 
record. 
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[Delete Import Oracle Table] – Button 

 

The [Delete Import Oracle Table] button deletes imported timesheet data from the Import table 
PYEMPTIMSHT_IMP. 

 

The [Delete Rejected Entries] button deletes the rejected entries from the import. 

Import Scenario – Prior Period Flag and Actual Work Date 

Scenario with importing values for IMP_TSH_PRIOR_PERIOD_FLAG and 
IMP_TSH_ACTUAL_WORK_DATE DATE 'DD-MON-YYYY’. This is used when making a correction 
to a date in a prior period. If the value for this Prior Period flag field is inserted as Y then, it will allow 
user to put in the prior period date and the time posts to that prior period reference date instead of the 
date in the current period. 

IMP_TSH_PRIOR_PERIOD_FLAG,  

IMP_TSH_ACTUAL_WORK_DATE),   

NOTE:  For IMP_TSH_PRIOR_PERIOD_FLAG: User should enter a value of Y or N. If a value of Y is 
entered on the ASCII file, the import program will recognize it as Checked for Prior Period Flag in the 
timesheet. For IMP_TSH_ACTUAL WORK_DATE field : The Actual Work Date for prior period must 
be before current period start date. 

Import File Fields – CTL File Template Changes 

The Ascii to Oracle Import program template now has the following new added fields: 



1348  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

The WBS fields and PCI field may be left blank if not applicable for the timesheet line, but the comma 
after each should be there.   

IMP_TSH_EXP_CODE ,  

IMP_TSH_EXP_QUANTITY ,  

IMP_TSH_EXP_RATE ,  

IMP_TSH_EXP_AMOUNT , 

IMP_TSH_WBSV_CODE1, 

IMP_TSH_WBSV_CODE2, 

 IMP_TSH_WBSV_CODE3, 

 IMP_TSH_WBSV_CODE4, 

 IMP_TSH_WBSV_PCI_LINE_ORASEQ, 

IMP_TSH_OVERRIDE_REF_CODE,  

IMP_TSH_OVERRIDE_REF_DES ,  

IMP_TSH_PRIOR_PERIOD_FLAG,  

IMP_TSH_ACTUAL_WORK_DATE),   

The following table provides details about the fields in the import file: 

 

Import File Field Description Required Type Length 

Employee 
Number 

Employee Number – must be a valid employee 
for the company 

Yes Varchar2 16 

Reference Date 

Actual date of Timesheet 

NOTE: Date worked MUST be of the DD-MMM-
YYYY format, otherwise the hours will go to the 
final day in the pay period. 

Yes DATE  

Job The timesheet Job Code 

Yes, if 
timesheet 
is for a 
Job 

Varchar2 10 

Phase Code The timesheet Phase Code (Cost Code).  
Yes, if Job 
Code is 
entered 

Varchar2 16 

Category The timesheet Job Category. 
Yes, if Job 
is entered 

Varchar2 16 

Normal Hours 
The number of Normal Hours (regular time) for 
timesheet. 

See NOTE 
1 

Number 16,8 

Overtime Hours 
Number of Overtime Hours for timesheet – 
leave blank if not applicable 

See NOTE 
1 

Number 16,8 

Double Overtime 
Hours 

Number of Double Overtime hours for timesheet 
– enter 0 if not applicable 

See NOTE 
1 

Number 16,8 
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Other Hours 
Number of Other Hours for timesheet –  leave 
blank if not applicable 

See NOTE 
1 

Number 16,8 

Other Hours Type 
The type of Other Hours - must be a valid Other 
Hour Code in CMiC 

Yes, if 
Other 
Hours are 
entered 

Varchar2 4 

Company Company handling Job Yes Varchar2 8 

Department 

This is the Dept Code the time is charged to if a 
G type of timesheet OR leave this field null to 
auto-populate with the Payroll Dept from 
Employee Profile. 

See NOTE 
2 

Varhcar2 6 

GL Account Code 

GL Account to charge time to if not a Job 
Timesheet OR leave this field null to auto-
populate it with Wage Account from Employee 
Profile. 

See NOTE 
2 

Varchar2 

16 

 

 

 

 

Work Location A valid Work Location. No Varchar2 

15 

 

 

 

 

Equipment Hours 
Number of hours Equipment was utilized for 
Job. 

No Number 16,8 

Document 
Number/Code 

Timesheet Document Grouping No Varchar2 30 

Trade Code 
Enter Employee Trade where employee worked 
this week or leave it null to populate from 
employee profile. 

No Varhcar2 4 

Union 

Enter Union Code where employee worked for 
this period or leave it null to populate from 
employee profile if employee is  

Unionized 

No Varhcar2 4 

Other Hours Rate 
Code 

Other Hours Rate Code 

No,  

If blank, 
import 
uses rate 
code from 
employee 
profile. 

 

Varhcar2 4 

Check Location 
Code 

Check Location Code No Varchar2 16 

Shift Code Shift Code No Varchar 2 1 
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Normal Hours 
Rate 

Normal Hours Rate No  Number 16,8 

Over Time Rate Over Time Rate No Number 16,8 

Double Time Rate Double Time Rate No Number 16,8 

Other Hour Rate Other Hour Rate No Number  16,8 

Sector Code Sector Code    

Schedule Code Schedule Code    

Expense Code Expense Code No Varchar2 4 

Expense QTY 

Based on the Expense Type: If the Expense 
Code is setup as type ‘Actual’ on the expense 
master setup, the QTY/AMT value is considered 
as a flat amount and should be entered in the 
import file 

If the expense Code is setup other than ‘Actual’ 
type, on the expense master setup, then the 
import program will consider the value as 
quantity and multiply the value with the rate 
defined in the expense master screen. 

Yes, if 
expense 
code is 
entered 

Number 16,8 

Expense Rate Expense Rate    

Expense Amount Expense Amount    

WBSV Code 1 WBS Code 1 

Yes, if 
enabled 
on Job. 

Varchar2 10 

WBSV Code 2 WBS Code 2 

Yes, if 
enabled 
on Job. 

Varchar2 10 

WBSV Code 3 WBS Code 3 

Yes, if 
enabled 
on Job. 

Varchar2 10 

WBSV Code 4 WBS Code 4 

Yes, if 
enabled 
on Job. 

Varchar2 10 

WBSV PCI 
ORASEQ 

 PCI 
Yes, if 
enabled 
on Job. 

Number 16,8 

Override 
Reference Code 

Override Reference Code    

Override 
Reference 
Description 

Override Reference Description    

Prior Period Flag Prior Period Flag    

Actual Work Date 
'DD-MON-YYYY' 

Actual Work Date 'DD-MON-YYYY'    
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Revenue Billing Rate Calculation – GC Monitor Template (17.38407) 

To obtain the calculated bill rate by the payroll function instead of getting from Job Billing Rate Table 
setup. 

CMiC has modified and added a new flag on the JCJOB table for 'Use Calculated Bill rate from 
Payroll Function for GC Monitor'. When GC monitor requests bill rate with Job information, the system 
will look at the New flag and determine to use the calculated bill rate from the payroll forecasting 
function or use the bill rate from Job Billing rate table. 
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Functionality 

 

Scenario A: 

Existing functionality using Job Billing Rate. If user does not check Use Payroll Bill Rate, and 
does not check/enable the new flag ‘Use Calculated Bill Rate From Payroll Function For GC 
Monitor’ under the Job Billing Tab, then GC Monitor will determine to use the calculated bill rate 
from Job Billing rate Table instead of the payroll forecasting function. 
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GC Monitor will use Job Bill Rates Table to multiply and get the Billing Rate 

Scenario B: 

Modification and the new functionality - When the new flag ‘Use Calculated Bill Rate From 
Payroll Function For GC Monitor’ is Checked and enabled on the Job Setup under Job Billing 
Tab, then GC Monitor will determine to use the calculated bill rate from the payroll forecasting 
function and ignore using the Job Bill Rate from Job Billing rate table. 
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Scenario C: 

If user chooses to only check the flag for Use Payroll Bill Rates, without checking the new flag 
for Use Calculated Bill Rate from Payroll Function’ under Job Billing Tab, then GC Monitor will 
calculate the Bill Rates using the Payroll Bill Rates as per specified setup for the employee. 
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In this case GC Monitor should calculate the Bill Rates for employee as per employee profile 
preferred rate setup. 

E-Time Audit Flag Trigger (17.45331) 

CMiC has modified Company Control Screen to add this flexible time functionality. A new column will 
be added in E-Timesheet Tab to give an option to set a ‘Time’ to allow users to enter E-Timesheet 
Entry. 

Furthermore, existing trigger/functionality will also be modified to allow users to enter E-timesheet 
data as per new setup. 

A new field is added in PY Control named ‘Hours Offset from Server Location’. System will utilize this 
field to check E -Timesheet in JSP program to control time of E-Timesheet Entry. 

User needs to enter the number of hour offset from the server in this field on the Company Control. E-
Timesheet JSP program is also modified to allow users to enter timesheet based on offset hour 
settings on the Company Control. 

Example: If your E-Timesheets become available at midnight 12:00 AM, and you would like to 
change time to 8:00 PM (which is 4 hours earlier), then user should enter -4 (negative 4) to apply the 
4 hour early timing. 
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Expense Rate & Amount Field Security (17.45308) 

Modification to hide expense rate and amount fields on Crew Timesheet. 

CMiC has implemented field security on expense rate and amount columns. User can then apply field 
security based on roles.  
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Crew Timesheet without expense rate and amount field prior to assigning Field Security under 
Security and Role Maintenance. The Expense Rate and Amount fields are visible and displayed on 
the crew timesheet entry screen for E Crew Time Paymaster. 

Assiging Field Security to Roles. Select Role Maintenance under Security. Select the Role that 
requires field security for Crew Timesheet Expense Rate and Amount.  

Role Maintenance 

 

 

Select Program ‘Crew Timesheet’ and change Field Security for Expense Amount and Expense Rate 
field from Unrestricted to Hidden. 
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Once you have assigned the field security to the Role, the user with Role is unable to see the fields 
for Expense Rate and Amount. These two fields will be hidden and not displayed on the Crew 
Timesheet Entry Screen. 

Employee Re-Numbering & associated Benefits/Deductions (17.44747) 

Modifications made for using the Employee Re-Numbering utility. System will also renumber 
associated records for employee level benefits and deductions and loans and advances. 

CMiC has made the following modifications: 

Employee History screen to show a new popup if the user changes Employee's Pay Group or Pay 
Run values. This new popup will ask if user also want to transfer Benefit/Deduction from the old Pay 
Group/Pay Run to the NEW Pay Group or Pay Run.  

The program will ONLY transfer all benefit/deduction assigned at the employee level. If user selects 
'OK', then the Employee's Benefit and Deduction setup will transfer on employee level with the new 
Pay Group/Pay Run. 

Programming Logic: It will transverse and go thru every Benefit Setup for this Employee. 

PAY GROUP Change Conditions: If the Benefit/Deduction is Setup exists at the Company level with 
this New Pay Group or ALL or NONE, Then, OK, No Action is Needed, since the Employee Benefit 
Setup has no Pay Group Attribute. The Benefit/Deduction records will be transferred to the new Pay 
Group assigned at Employee level. 

If the Benet/Deduction does not exist at the Company Level with this New Pay Group or ALL or 
NONE, then, display the following Warning Message in a Pop-Up. 

If OK is selected, Employee Pay Group is changed; but Employee will not be paid the Benefit 
in next Payroll, unless the Benefit is setup in the New Pay Group before next Payroll processing. 

 

PAY RUN Change Conditions: If the Benefit/Deduction is Setup exists at the Company level with this 
New Pay (Go thru every Benefit/Deduction Setup for this Employee Where Pay Run = Old Pay Run). 
Then, OK, Update this Employee Benefit/Deduction Setup from Old Pay Run to New Pay Run. The 
Benefit/Deduction records will be transferred to the new Pay Run assigned at Employee level. 
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If the Benefit/Deduction does not exist at the Company Level with this New Pay Run, then, display the 
following Warning Message in a Pop-Up. 

If OK is selected, Employee Pay Run is changed; but PYEMPBEN is not changed, and Employee will 
not be paid the Benefit/Deduction in next Payroll, unless the Benefit/Deduction is setup in the New 
Pay Run before next Payroll processing. 

 

 

PY Positive Pay Format for CIBC Bank (19.71751) 

CMiC has added a new Positive Pay format for CIBC Bank in PY Check/EFT program. The ASCII File 
(CSV) is created as per CIBC Bank Positive Pay Specifications. The format is as per Standard Fixed 
Length File Format. 

Pre-Requisites: 

Customer should ensure to have their Banking Information and setup completed in CMiC System 
under Global Tables→ Banking Maintenance. 

CMiC has added a new option/format in Check EFT Register (PY1081) Program to generate Positive 
Pay _CIBC Bank (CSV) file. 

Process payroll and print checks. Under Processing > Reports > Check/EFT Register, select bank 
format: Positive Pay – CIBC (CSV) to prepare the data and download the file in Notepad. 
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Check/EFT Register Program – PY1081 

The Check / EFT Register will print a listing of all checks printed on a particular Pay Run for a given 
period and employee range. The Paychecks listing for Employee Report will print a listing of the 
checks and direct deposit payments made on a particular check run.  
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Pay Register displaying for 2 employees 

 

 

Crew Timesheet Reporting (18.60602) 
 

Overview: Create a new report based on Crew-Time Data. The report has options to select range of 
date/days to run the report for a single job. The report output is as per current standard Crew 
Timesheet Report. The report is developed in Jasper version only. 

Program Modifications: 

A new program called ‘Crew Timesheet Report’ has been added to the E-Time Tree-View Menu. The 
report can be launched by clicking on Crew Timesheet Report program on the Tree-View Menu under 
E-Timesheet. 
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The Selection Criteria to run the report consists of following fields: 

From Date: This is a Mandatory field. Enter the Start date to report on. 

To Date: This is a Mandatory field. Enter the End Date to report on 

Company: This is an Optional field. Enter the Company to report on. If left blank, the report runs for 
ALL Companies. 

Job: This is an Optional field. Specify the Job to report on. If left blank, the report runs for ALL 
Companies. This field is linked to Company field and will only be enabled if Company is specified. 

Transaction Type: Select the type of Transaction to report on-Posted, Unposted, Both. 
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Pay Register – Addition of flag to omit Employer Burden (19.71462) 

CMiC has added a flag on Pay Register (PY1057) parameter screen to give an option to hide 
‘Employer Burden’ on the report. Report is modified to hide the Employer portion, if the new 
parameter is passed to hide it. Changes are applied on both reports being called from the parameter 
screen (Main PY1057 and Summary PY1057SUM). 
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Program Modifications: 

A new flag “Print Employer Burden” has been added to the parameter screen of Payroll Register 
Report. The flag controls whether Non-Cash Benefits, Deductions and Employer Paid Taxes are 
printed on the report or not. The flag is checked by default, in which case, Employer Burden is printed 
on the far-right side under column “Employer Part”. If a user chooses to uncheck the flag to hide 
Employer Burden, the column ‘Employer Part’ will be omitted from the report and Employer Burden 
will not be printed.       

New flag added to the screen: 

 

Employer Burden is printed if the report is run with this flag in checked state: 
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Employer Burden is NOT printed if the report is run with this flag in unchecked state: 
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US Tax Changes – New Federal Form W4 January 2020 (19.81036) 

In 2020, Form W-4 eliminates some withholding allowances and adds other items to determine 
appropriate federal withholding for employees. 

NOTE: The filing status you provide will be critical to the application in determining which calculation 
path is followed. Use one of the prior year filing statuses (Single or Married) when the employee(s) 
W-4 is from a year prior to 2020. 

Use one of the new filing statuses when the employee uses the new 2020 W-4. If a valid filing status 
is not provided, the application will use the new filing status of Single or Married Filing Separately and 
will calculate tax withholding using the new calculation logic for 2020. 

Calculate Withholding Using 2020 Form W-4 Data  

Vertex calculates employee withholding using information from the 2020 Form W-4 as follows:  

• Basic withholding requires the following: 

o Wages 

o Filing status from the federal tax handle 

• Filing status options are as follows: 

o Head of Household (ID 3) 

o Married Filing Jointly (ID 16) 

o Single or Married Filing Separately (ID 62) 

If Vertex receives an invalid filing status, Single or Married Filing Separately is used, along with the 
standard withholding rate table. 

The number of allowances no longer affects tax calculation. Vertex disregards withholding allowances 
if the information is passed in. 

CMiC Program Modifications 

CMiC has added four new fields to the pop-up window launched from the [Exemptions] button on the 
Tax tab of the Employee Profile to comply with the new Federal W-4 changes of 2020: 

• ‘Multi Job’ checkbox to indicate employee having multiple jobs. 

• Dependent Tax Credit Amount  

• Other Income Amount  

• Other Deduction Amount  

Steps to Calculate Withholding 

For Employees 

The 2020 Form W-4 is now broken up into five steps for employees to complete (or to skip if they are 
not applicable):  
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1. Enter personal information, including filing status. 

2. Account for multiple jobs. 

3. Claim tax credits for dependents. 

4. Make other adjustments. 

5. Sign and date under penalties of perjury. 

Steps 1 and 5 are required. Adjustments on steps 2, 3, and 4 are optional and are designed to make 
withholding calculations more accurate. 

For Employers 

Here are the steps employers will follow, based on employee entries on Form W-4. 

When employees only complete steps 1 and 5, employers will withhold using the appropriate method 
based on the filing status and wage amounts.  

When employees complete at least one of steps 2-4, employers will need to take these steps: 

• Step 2: When an employee checks the box on Line 2, the employer will figure withholding from 
the higher rate tables, which will mean higher withholding. If the employee chooses one of the 
other two alternatives to account for multiple jobs, the additional withholding will be included with 
any other additional tax amounts per pay period in step 4, Line 4c. 

• Step 3: Employers will use the amount entered by employees on Line 3 to claim their dependents 
as an annual reduction of tax. Employers should use the amount entered on Line 3 even if it is 
not equal to the sum of any amounts entered by employees on the left in step 3 because Line 3 
may be used to take into account other tax credits. 

• Step 4: Employers will increase the annual amount of wages subject to withholding by the annual 
amount shown in Line 4a and reduce the annual amount of wages subject to withholding by the 
annual amount shown in Line 4b. Employers will increase withholding by the per pay period tax 
amount on Line 4c. Line 4d is where employees can claim an exemption from withholding. 

Calculation Process  

Vertex calculates withholding from information on the 2020 Federal Form W-4 using the following 
process:  

1. Annualize current wages by number of pay periods. 

2. If the Line 4a (Other income) amount is provided, add the amount to annual wages. 

3. If the Line 4b (Deductions) amount is provided, subtract the amount from annual wages. 
Wages are also reduced by the value of the standard deduction. 

4. Calculate tax on adjusted wages using the percentage method. 

If the Form W-4 Step 2 checkbox (Multiple jobs) is cleared, Vertex uses the standard 
withholding rate schedule. 

If the Form W-4 Step 2 checkbox is selected, Vertex uses the Step 2 withholding rate 
schedule. 

5. Divide the calculated annual tax by the number of pay periods to determine the pay period 
withholding amount. 

6. If the Line 3 (Dependents) amount is provided, divide this amount by the number of pay 
periods to determine the pay period amount. 

7. Subtract the tax credits amount from the pay period withholding amount. 
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If the result is negative, tax is zero. 

8. If the Line 4c (Extra withholding) amount is provided, add the amount of extra withholding to 
the pay period tax amount. 

NOTE: If you pass in old Federal filing statuses with the new W4 data, the new data will be ignored. 
Same follows for the new filing statuses. If you pass us a new Federal filing status, Vertex will ignore 
the old number of exemptions data. 

Federal Tax Changes 

Federal Tax Changes effective January 1, 2020 based on December 2019 Vertex Release. 

• Added the following standard deduction amounts: 

o $12,900.00 for Married Filing Jointly filers 

o $8,600.00 for Single or Married Filing Separately and Head of Household filers 

• Increased withholding allowance from $4,200.00 to $4,300.00. 

• The additional withholding amounts for Nonresident Aliens are as follows: 

o $12,400.00 for employees who have filed a 2020 form W-4 

o $8,100.00 for employees who have not filed a 2020 form W-4 and have a prior version on 
file 

• Revised withholding tables. 
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Payroll Processed with Pay Date in 2020 

Calculation Examples  

This section provides examples of Vertex calculations.  

Example 1: Pre-2020 Form W-4  

The following table shows the calculation process when information from a pre-2020 Form W-4 is 
passed in for an employee filing as Married (ID 2) with four exemptions:  

Step Action Result Example 

1 Multiply wages by the number 
of pay periods. 

Annual wages 1,000.00 x 52 = 52,000.00 

2 Calculate the withholding 
allowance amount. 

Withholding 
allowance amount 

4 x 4,300.00 = 17,200.00 

3 Subtract the withholding 
allowance amount. 

Annual taxable 
wages 

52,000.00 – 17,200.00 = 34,800.00 

4 Subtract the standard 
deduction. 

Net taxable wages 34,800.00 – 31,650.00 = 3,150.00 

5 Calculate the tax using the 
married filing jointly standard 
withholding rate schedule. 

Annual tax 3,150.00 x 12% = 378.00 

378.00 + 1,975.00 = 2,353.00 

6 Divide the annual tax by the 
number of pay periods. 

Pay period tax 
amount 

2,353.00 / 52 = 45.25 

 

Employee Setup 
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Example 2: 2020 Form W-4, Step 2 Checkbox Cleared  

The following table shows the calculation process for the following information:  

• 2020 Form W-4 with a cleared Step 2 (Multiple Jobs) checkbox 

• Single or Married Filing Separately (ID 62) 

• No exemptions 

Step Action Result Example 

1 Multiply wages by the number 
of pay periods. 

Annual wages 1,750.00 x 52 = 91,000.00 

2 Subtract the standard 
deduction. 

Annual taxable 
wages 

91,000.00 – 8,600.00 = 82,400.00 

3 Calculate the tax using the 
Single or Married Filing 
Separately standard 
withholding rate schedule. 

Annual tax 82,400.00 – 43,925.00 = 38,475.00 

38,475.00 x 22% = 8,464.50 

8,464.50 + 4,617.50 = 13,082.00 

4 Divide the annual tax by the 
number of pay periods. 

Pay period tax 
amount 

13,082.00 / 52 = 251.58 
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Employee Setup 
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Example 3: 2020 Form W-4, Step 2 Checkbox Selected  

The following table shows the calculation process for the following information:  

• 2020 Form W-4 with a selected Step 2 (Multiple Jobs) checkbox 

• Single or Married Filing Separately (ID 62) 

• Other Income Step 4a (12,000.00) 

• Deduction Step 4b (5,000.00) 

• Dependents tax credit Step 3 (4,000.00) 

 

Step Action Result Example 

1 Multiply wages by the number 
of pay periods. 

Annual wages 2,884.50 x 52 = 149,994.00 

2 Add the Other income 
amount. 

Total annual 
wages 

149,994.00 + 12,000.00 = 161,994.00 

3 Subtract the deduction. Net wages 161,994.00 – 5,000.00 = 156,994.00 

4 Subtract the standard 
deduction. 

Because the Step 2 (Multiple 
Jobs) checkbox is selected, 
the standard deduction is 0 
(zero). 

Annual taxable 
wages 

156,994.00 – 0.00 = 156,994.00 

5 Calculate the tax using the 
Single or Married Filing 
Separately Step 2 withholding 
rate schedule. 

Annual tax 156,994.00 – 109,875.00 = 47,119.00 

47,119.00 x 35% = 16,491.65 

16,491.65 + 23,683.75 = 40,175.40 

6 Divide the annual tax by the 
number of pay periods. 

Gross pay period 
tax amount 

40,175.40 / 52 = 772.60 

7 Determine the pay period 
Dependents tax credit and 
subtract it from the gross pay 
period tax amount. 

Dependents tax 
credit 

4,000.00 / 52 = 76.92. 

8 Subtract the tax credit from 
the gross pay period tax 
amount. 

Net pay period tax 
amount 

772.60 – 76.92 = 695.68 
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Employee Setup 
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National Bank Positive Pay File (19.88126) 

CMiC has added a new Positive Pay format for National Bank in PY Check/EFT program. The ASCII 
File (CSV) is created as per National Bank Positive Pay Specifications. The format is field delimiter 
(Comma,) with ‘Amount’ format decimal included (example 123.00) 

Pre-Requisites: 

Customer should ensure to have their Banking Information and setup completed in CMiC System 
under Global Tables→ Banking Maintenance. 

Modifications: 

CMiC has added a new option/format in Check EFT Register (PY1081) Program to generate Positive 
Pay National Bank file. 

Process Payroll and print checks. Under Processing > Reports > Check/EFT Register, select bank 
format: Positive Pay – National Bank to prepare the data and download the file in Notepad. 
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Check/EFT Register Program – PY1081 

The Check / EFT Register will print a listing of all checks printed on a particular Pay Run for a given 
period and employee range. The Paychecks listing for Employee Report will print a listing of the 
checks and direct deposit payments made on a particular check run. 
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New E-Time Entry – Work Category & Types (19.79654) – BETA Version 

New E-Time Entry by Work Category and Work Category Types – Beta Version (In Programming/Not 
Released). 

In this release we have added two new screens under US Payroll Local Tables. 

Work Category Screen – New Screen 

 

A new screen is programmed to allow users to create ‘Work Categories’. Employees would utilize 
these work categories when entering timesheets to create analytics on the employee spent time 
during the day. The screen will consist of two columns Category code and descriptions. 

Work Category Details – New Screen 

In order to manage these categories by employee and trade, these categories will be assigned to a 
specific group. 

 

A new screen is programmed to allow users to create ‘Work Category Types’. Users will be creating 
‘Work Category Type’ based on employee trades daily work. The screen will have header to create 
Work Category Type and detail section to add work categories. The third block will allow users to 
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assign trade code where work Category type is applicable. This would allow e-timesheet program to 
filter categories by employee trades and they will only see work categories applicable to their trades. 

Employee Profile – Employee Creation Process Modifications 

The Work Category Type will be assigned on employee level, the employee creation process will be 
modified to assign the Work Category Type automatically to the employee based on employee trade.  

The process will search Work Category and assign trades to employees where trade code matches 
with employee trade. Users will continue to have an override feature to assign work category 
manually. 

Employee Profile Work Category Tab > Work Category Type 

 

The screen will be created for users to review and assign work category by employee. 

 

E-Timesheet Entry Screen Modification (In Programming – Not Released in this Patch) 

E-timesheet entry screen will be modified to add a new field called ‘Work Category’ after Job 
Category field. Timesheet will display all Work Categories based on employee assignments. 
Employees will select their work category from a drop-down list when entering timesheets. 

Note: CMiC is adding an option to disable this feature for our existing users when released. 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  1393 

Change Default Posting Date (19.83333) 

Currently the default posting date for payroll void checks is current day.  

Program Modifications: 

Void processing program changes made for the date to default to the latest posting date in a payroll 
calendar that has not been processed. This posting date would be based on Company, Pay Run, and 
Year fields entered. 

CMiC has added a new window popup which is launched automatically after entering Pay Run and 
tabbing out of the Pay Run field. 

The new pop-up window includes the following two options for `default posting date'. 

- Current date (System Date) 

- Latest posting date (based on Company/Pay Run/Year (default)) 

Note: Latest Posting Date is the default setting and is the latest posting date available and open on 
the Company Pay Period screen for the selected Pay Run. 

The new pop-up window is launched automatically after entering Ray Run and tabbing out of the Pay 
Run field. 

User has the option of changing the pay period and posting date on the screen. The popup is only to 
set as default, user can change the posting date with any date after selecting the options on the Void 
Check program Posting Date field. 

Latest Posting Date Option 
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Current Posting Date Option 
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Wells Fargo Bank Positive Pay File – Generic Changes (19.84112) 

CMiC has modified and updated the standard routine for Wells Fargo Positive Pay File to be generic: 

1. Increased the bank account number field on the detail record from 10 to 15 digits. 

2. Removed hard coding of bank ID on the header record. Modified the program to retrieve the ‘Bank 
ID’ from the Bank ID setup on the System > Global Tables > Banking -> Banks screen. 

Previously the Bank ID was hard coded; the routine is modified to get the Bank ID from Bank screen 
under Banking Global Tables instead of having hardcoded bank ID ‘WFBI’. 

Pre-Requisites 

Customer should ensure to have their Banking Information and Bank ID setup completed in CMiC 
System under Global Tables→ Banking Maintenance. 

Process Payroll and print checks. Under Processing > Reports > Check/EFT Register, select bank 
format: Positive Pay – Wells Fargo Bank (ARP). 
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The routine is modified to get the Bank ID from Bank screen under Banking Global Tables instead of 
having hardcoded bank ID ‘WFBI’. 
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Checks issued 
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Employee Pay Rate Shift Code Indicator (19.86120) 

CMiC has added a `Shift Code’ column after the ‘Trade’ column in the `Employee Pay Rates' Screen. 
If the ‘Shift Code’ is changed an alert pop-up message will display, if user wants to update the un-
posted timesheets with new rates based on shift code. 

Modification: 

Employee Pay Rate screen is modified with addition of a ‘Shift Code’ column where an employee 
specific alternate shift pay rate can be entered. The Shift Code column is drop down list with All 
Shifts, Day Shift, Evening Shift and Night Shift values.  

If an employee specific shift pay rate is entered in Employee Pay Rate screen and that specific 
alternate shift code is selected on JSP Crew Time Entry to enter time against Job and/or Equipment, 
then the employee’s wages will be calculated using that specific alternate shift rate as defined on the 
Employee Pay Rate screen. 

Implementation: 

Note: Your Timesheet default shift code is based on the Payroll Company Control settings for E Time 
and Regular timesheets. 

For Regular and JSP Crew Timesheet entry user can change the shift code value when entering time. 

Default shift code for Crew Timesheet is defined and based on System Options settings. 

For JSP E-Timesheet there is no shift column/field available on E Time entry screen. Employee Pay 
Rate is always defaulted to ‘All Shifts’ regardless of Payroll Company Control E Timesheet Tab 
settings for default shift code and/or System Options. 

Company Control - Default Shift code defined ‘Blank’ represents ‘All Shifts’ code in Company Control 

Regular Timesheet entry a blank shift code represents ‘All Shifts’ code value. 

The added shift code column on the Employee Pay Rate screen will default to ‘All Shift’ value. User 
can change and select shift code values from the drop-down list. Un-Posted timesheet are updated 
with a new pay rate change.  

Note: Existing Employee Pay Rate record will default to All Shifts Code. 

Company Control - Default Shift code defined ‘Blank’ represents ‘All Shifts’ code in Company Control 
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Inserting a new record will default to Shift Code value defined on PY Company Control Default Shift 
code setting. 
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User can select shift code value from the drop down list 

 
 

Employee Pay Rate updates unposted timesheets (Regular, E Time and Crew Time) based on 
Effective Date and Shift Code and Trade. 

 
 

Regular Timesheet - Insert record 

 

 

 

 

 

Entering E Time  
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Currently Payroll Company Control default shift is set to ‘Day’ Shift.  

Note: For JSP E-Timesheet there is no shift column/field available on E Time entry screen. Employee 
Pay Rate is always defaulted to ‘All Shifts’ regardless of Payroll Company Control E Timesheet Tab 
settings for default shift code and/or System Options. 
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Update employee pay rate 
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Crew Timesheet Entry 

Payroll Company Control Deafult Shift Code is blank which is set ‘ALL Shift’ 

 

System Options Default Shift Code is set to ‘Night’ 

 

Crew Timesheet will default to System Options Default Shift code settings. 

 

User can change to other alternate shift codes. 
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Employee current pay rate default to ALL Shift under EE Pay Rate screen 

 

Entered crew timesheet for Night Shift 

 

Timesheet Edit listing on Unpost Crew Timesheet displays the current pay rate 
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Timesheet entered for 30/March/2020 as Night Shift. The Rate of 50 per hour was not picked up due 
to the All Shift Code. Working as expected.  
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The new rate is now updated since it fulfills the conditions of Shift Code indicator and effetive date. 

The Night Shift Code along with the effective date on Crew Timesheet Unposted timesheet meets the 
condition and hence the unposted time record is updated. 

 

E-Time Auto Recall for In/Out Time (19.86496) 

Auto Recall functionality has been added in E-Time to Recall In/Out time entered in the last Period 
similar to how time entries can be Auto Recalled from the last period. 

Pre-requisites 

To Auto Recall In/Out time, the role assigned to corresponding E-Time Access code should have the 
flag Allow Auto Recall for In/Out Time enabled as shown in the screenshots below: 

A) Enable the flag for corresponding Role: 

 

 

B) Assign the role with Auto Recall privilege to an Access Code: 
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Modifications 

The modifications made to implement this functionality are as follows: 

1) A flag has been added in E-Time Role Maintenance screen to assign the privilege of Recalling 
in/Out time: 

 

 

2) A new Button Auto Recall has been added to Time Entry screen. Upon clicking this button, In/Out 
Time from last period will be recalled into the current Period: 

 

Implementation 

Just like Auto Recall for time entries, In/Out Time can only be recalled from the immediately 
preceding Pay Period. To Auto Recall time entries and In/Out time, please make sure that they are 
present in the last Pay Period.  
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 Time entries and In/Out Time has been entered, saved as shown below in a Pay Period: 

  

 

 

 

 

To Auto Recall these time entries into the next Pay Period, the Pay Period is loaded, and Auto Recall 
button is clicked: 

 

A) Load the Pay Period: 
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B) Click Auto Recall: 

 

 

Now, to Auto Recall In/Out time, click on Time Entry to load the time entry screen: 

 

 

 

Once the time entry screen is loaded, click Auto Recall button at the top right corner: 

 

 

 

As soon as the button is clicked, the system recalls In/Out Time from last period: 

 

Click Save at the top right corner to save the In/Out Time recalled by the system: 
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Close the Time entry screen and submit time: 

 

 

E-Time Certification Message – Timesheet Submittal (19.88679) 

A confirmation prompt is generated upon Timesheet Submittal in E-Time, requiring user’s 
endorsement before Timesheets are sent for approval. E-Timesheets are not submitted for approval 
until the user agrees to the confirmation prompt, thereby verifying the hours entered for himself or 
other users. 

Pre-requisites        

1) To enable this functionality, the flag Submit for approval E-Timesheet in System Options 
(System Data>>Setup>>System Options>>E-Timesheet tab) needs to be checked.  

If this flag is unchecked, E-Time entries are simply sent for approval on submittal and no confirmation 
prompt is generated. 

The flag is highlighted in the screenshot below for reference: 
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2) Set or update the prompt message/verbiage by going to HCM>>File Maintenance>>Employee 
Console Maintenance>>Prompt Maintenance screen and changing the prompt message/verbiage 
for Message key Confirm_Submit (highlighted in the screenshot below). 

 

 
 

 

 

 

Modifications: 

Two major modifications have been made to implement this functionality: 

1) Flag Submit for approval E-Timesheet has been added to E-Timesheet tab in System Options 
(System Data>>Setup>>System Options).  

2) A confirmation prompt/dialog box has been programmed to show up on Timesheet Entry screen 
in E-Time after user submits time entries. The prompt has a checkbox to endorse the submitted time 
entries for accuracy and 2 buttons-Agree and Submit and Cancel. 

  

Implementation: 

Scenario 1: Generate a confirmation prompt post Timesheet Submittal 
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When flag Submit for approval E-Timesheet is enabled in System Options, the system generates 
a confirmation Prompt upon Timesheet Submittal in E-Time, requiring the user to verify time entries 
for accuracy prior to sending them for approval. The step by step demonstration for this scenario is as 
follows:  

1) Enabled the flag in System Options: 

 
2) Entered, submitted entries in E-Time: 
 
Entered: 

 
 
 
Submitted: Clicked on Submit for Approval button to submit Time entries:  
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As shown above, upon Timesheet Submittal, a confirmation prompt pops up. The prompt has a 
checkbox to agree to the stated message and 2 buttons: Agree and Submit, Cancel   

  
 On clicking Agree and Submit, Time entries are sent for Approval 

 
On clicking Cancel, the entries are not submitted for approval and can be edited, saved and later 
submitted. 
 
 
3) Clicked on Agree and Submit after checking the checkbox to submit entries for approval 
 

4) Entries were successfully sent for approval: 

 

Scenario 2: Do not generate a confirmation prompt post Timesheet Submittal 

1)Disabled the flag in System Options: 
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2) Entered time entries: 

 

3)Submitted time entries: 

 

As can been from the screenshots above, no confirmation prompt was generated in this case and 
timesheets were sent for approval right after clicking Submit for Approval button 
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E-Timesheet Import (19.88826) 

A new feature has been added to the Import Timesheets from Oracle (Multi-User) ADF screen in the 
US Payroll module, which allows users to import timesheet data into the E-Timesheet program. This 
update gives users the option of importing timesheet data into E-Timesheet, in addition to the pre-
existing functionality which allows users to import timesheet data into the Regular Timesheet 
program. This new flexibility has been made available through an update to the System Options 
screen, where users can select whether they are importing into the Regular Timesheet program or 
the E-Timesheet program. In addition, new columns have also been added to the Oracle ASCII File, 
which are Access Code and Comment. 

Import Oracle ASCII File Template (CTL File) 

New fields have been added to the Oracle Import ASCII File Template (PYTIMIMP.CTL). The newly 
added fields are Access Code and Comment. 
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System Options 

 

Pgm: SYSOPT – System Options; standard Treeview path: System > Setup > System Options – E-TimeSheet 
tab 

A new field has been added to the E-Time Sheet tab in the System Options screen, as highlighted in 
the screenshot above. This field is used to select the type of timesheet data to be imported. Two 
options are available in the drop-down menu: “Regular Timesheet” and “E-Timesheet”.  

NOTE: When the program is initially installed, this field will default to a blank value. A blank value is 
equivalent to “Regular Timesheet”. Depending on the type of timesheet data being imported, users 
should select the timesheet program option accordingly.  

Users should ensure that the option selected matches the type of data being imported, otherwise 
imported records will not be inserted into the appropriate timesheet table. For example, if E-
Timesheet data is being imported, and “Regular Timesheet” is selected in this field, records will not 
be successfully imported into the E-Timesheet table. 
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If “E-Timesheet” is selected, as shown in the screenshot above, access codes must be included in 
the import file for timesheet data to be successfully validated and imported into the E-timesheet table.   

User Maintenance 

 

Pgm: SDUSRMNT – User Maintenance; standard Treeview path: System > Security > Users > User 
Maintenance – System Privileges 

The system privilege ‘PYIMPUSRTM – PY: Allows User to Validate/Edit PY Timesheet Imported by 
Other Users’ has been created on the System Privileges tab of the User Maintenance screen. If 
checked, this privilege allows user to validate/edit/build/delete timesheet data imported by other 
users.  

This security privilege must be assigned to the user/user’s role to allow that user to 
validate/edit/build/delete timesheet data imported by other users on the Timesheet Import Multi User 
screen (standard Treeview path: US Payroll > US Payroll > Utilities > Import Timesheets from 
ORACLE (Multi User)). 

Implementation 

Pre-Requisite: Set the new flag in Systems Option Oracle Import Timesheet Utility for (Multi-User) 
under E Timesheets to E-Timesheet. Step 2: Create ASCII File Import with Access Code  
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Step 3: Import ASCII file from Oracle  

Timesheet Import 

 

 

 

Timesheet Import Multi-User 

Pre-Requisite: System Option flag set to E-Timesheet then Import ASCII Oracle file for E 
Timesheets > Go to Import Oracle (Multi-User) program. Step 1: Import Oracle Data Step 2: Validate 
Imported Data Step 3: Edit Imported Data Step 4: Build Timesheet 

 

Import Oracle Data 
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Validate Imported Date – Select Record 

 

The timesheet is imported into multi oracle import routine by document number in header table both 
fields will be added into .CSV file format. Document Number is not a mandatory requirement in the 
ASCII file or program routine. However, the document number is part of the header and timesheets 
will be grouped by document number when passed from ASCII import file, even when it is null. 

 

Edit Imported Data – Select record 
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Re-Validate all records to display and report errors 

 

The `Access Code' should not be NULL when importing into e-timesheet table and will be validated. 
Import Routine will validate the file and generate and error message. 
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User can run Validate Report to review the generated error 
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User can enter the missing ‘Access Code’ save and re-validate all records. Once the status is Valid, 
user can build timesheet and import into E Timesheet. 
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Build Timesheet – Select record 

 

 

 

 
Timesheet is built and data is imported into E Timesheet Table 

 

E-Time (JSP) 

When ‘E-Timesheet’ has been chosen by user in system option, after click on ‘Build Timesheet’ in 
Timesheet import from oracle (Multi-user) ADF screen, user should see all records in E-Time JSP 
Screen. 
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Timesheet Records – Multiple Document Numbers in ASCII File 

The timesheet is imported into multi oracle import routine by document number in header table both 
fields will be added into .CSV file format. Document Number is not a mandatory requirement in the 
ASCII file or program routine. However, the document number is part of the header and timesheets 
will be grouped by document number when passed from ASCII import file, even when it is null. 
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Privilege and Access  

Users without access and privilege cannot use Import Multi-User to validate/view/edit imported data. 
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Regular Timesheet (ADF) 

The approved E Timesheets should be available in Regular Timesheet entry. The imported records 
with ‘Document Default Code’ should be displayed with their ‘Document Numbers’. The imported 
records without a ‘Document Number’ should display with ‘E Timesheet Document Code Format’ as 
specified in System Options E Timesheet tab. 

 



1428  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

 

 

Imported records with document number will default to their imported default document number. 

Imported records without a document number will default to E Timesheet Document Code Format as 
specified on the System Options E Timesheet Tab 

 

Document Code – ETIME1 
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Imported/Approved E Time records with default document code ETIME2 

 

Imported/Approved E Time records with default document code ETIME3 

 
 

Imported/Approved E Time records with default document code ETIME4 
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Imported/Approved E Time records without default document code will default to E Timesheet Format 
Code set on System Options  
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Regular Timesheet Import  

Pre-Requisite: System Option flag set to Regular Timesheet then Import ASCII Oracle file for 
Regular Timesheets > Go to Import Oracle (Multi-User) program: Step 1: Import Oracle Data, Step 2: 
Validate Imported Data, Step 3: Edit Imported Data, Step 4: Build Timesheet.  

When ‘Regular Timesheet’ has been chosen by user in system option, after clicking on ‘Build 
Timesheet’ in Timesheet import from oracle (Multi-user) ADF screen, user should see all records in 
regular timesheet screen.  

Regular Timesheet Import Logic: System looks for the last open period to import and not the actual 
date. When there are open periods it will import records in that open period with Actual dates on the 
import. 
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Delete Imported Data 

Imported data can be deleted when import is completed in multi-user program. User can select the 
record with a status of ERROR and VALID and delete the imported data. BUILD statuses cannot be 
deleted. 
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Delete Oracle Table 

Delete imported records from Oracle table  
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Employee SSN Validation – New Flag (19.92676) 

CMiC has modified the employee profile screen to raise an error message as soon as user enters an 
existing SSN number. A new check box ‘SSN Unique by Employee Table’ is added to System 
Options under Payroll tab to validate the uniqueness of the SSN in the employee table.  

By default, the flag for this option is set to ‘N’. 

If this flag is checked for the check box ‘SSN Unique by Employee Table’ in System Options, then the 
SSN validation rule defined and set under Company Control is overwritten by System Options 
checkbox. 

If ‘SSN Unique by Employee Table’ in System Options is un-checked, then system will consider the 
SSN unique validation rules set in Company Control. 

 

The new added flag SSN Unique by Employee Table is set to ‘N’ (Null value) by default. 
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The new added flag and check box ‘SSN Unique by Employee Table’ validates the uniqueness of 
employee SSN at the beginning of employee creation in employee profile, when entering the SSN 
and tabbing out of the SSN field.  

 

Payroll Company Control flag defined setting for SSN validation 

 

 

Creating a new employee record with an existing SSN will generate an error upon entering at the 
beginning of employee creation. 
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The employee SSN uniqueness is validated at the beginning of the employee record creation, upon 
entering and tabbing out of the employee field. 
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Addition of A/C Name in PY General Ledger History Log (19.93119) 

 

CMiC has added an ‘Account Name’ column after the ‘Account Code’ column in PY General Ledger 
History Log screen to view the account name of the account number. 

 

Payroll Exempt Employee Utility (19.76464)  

CMiC has created a utility called Employee Exempt Rules Processing. Users can assign a maximum 
number of hours for a pay run and designate an hour type where any hours charged over and above 
the maximum number of hours should be adjusted (e.g. JCHR). The processing will automatically 
split normal hours into NWHR and JCHR in the timesheet table and it will pro-rate hours accordingly 
based on job. Only employees who have been designated as exempt will have the ability to charge 
additional hours in a pay run. 

The Employee Exempt Process screen is used to apply the exempt rule to employee(s), as well as to 
define any additional application criteria, such as pay run, pay year, and pay period. The screen 
processes un-posted timesheets as per setup and will automatically adjust time entered over 
maximum hours in a pay run and create a new line in the timesheet table as JCHR Hours for adjusted 
hours based on setup selections. Creating an adjustment line for JCHR hour type is beneficial for 
payroll processing as JCHR hours don’t go into the payroll table, making your payroll much cleaner.  
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Pre-requisites 

On the Employee Profile screen, an employee must be set up as “Hourly” and the FLSA type must be 
set as “Exempt”, as shown in the screenshot below. 

 

NOTE: The Apply Exempt Employee Hour Restriction field drop-down menu should be set to “None” 
on the Payroll tab of the System Options screen (standard Treeview path: System > Setup > System 
Options – Payroll tab). 

 

Modifications 

With this modification, users will be able to allow Exempt employees to charge additional hours in 
excess of the maximum number of hours allowed for a specific pay run but employees will only be 
paid for hours up to the pay run’s maximum established limit. For example, for a weekly pay run, an 
Exempt employee could charge over 40 hours in a week to jobs for the weekly pay run but would only 
be paid for the 40-hour work week.   
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This enhancement will allow hourly employees to charge more time to jobs, time actually worked so 
the company can get reimbursed. 

NOTE: The Employee Exempt Process screen will consider other hours part of an employee’s regular 
hours based on the new ‘Exempt Rule’ flag introduced on the Hour Types screen. 

Implementation 

The processing routine will calculate total number of hours per period based on employee pay run on 
profile. 

The program will take an employee’s total work hours/year or total work days/year from the Employee 
Profile screen or it will take total work hours/year and work days/year from company Payroll Control 
screen to calculate total number of hours in a period.  

For example, if using the company Payroll Control screen to calculate total number of hours per 
period, the calculation would be as follows: 

Total days in a year in company Payroll Control screen is 260. 

Total hours in a year in company Payroll Control screen is 2080. 

The processing will divide 2080/260=8 hours per day and it will calculate total hours per pay 
period by taking period start date and end date. 

NOTE: Part-time employees are set up on the Employee Profile screen using either hours/year or 
work days/year. If total hours/year is set up as 1100, then the formula would be 1100 divided by the 
total number of days set up on the company Payroll Control screen (i.e. 260). For example, 1100/260.  

Please see below example of semi-monthly Full-time employee pay run calculation: 
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The following is a semi-monthly pay run start with September 16th until September 30th, which is 16 
days. The system will calculate working days as 11 days and then multiply hours per day 8 by 11 = 88 
hours. 

 
 

Insert timesheet for that period which is total of 88 hours. 

TRAN – Training hours are not included in processing. 
VAC – Vacation hours set up as include in Job cost hours processing (i.e. ‘Exempt Rule’ box checked 
for VAC code on Hour Types screen).  
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If total hours for the period for regular hours are 88, then in above scenario employee actually entered 
96 hours as regular hours because 8 vacation hours will be considered as regular hours as per hour 
type using new ‘Exempt Rule’ flag and 10 hours for training time will be considered as additional 
hours paid to this employee. 

 
 
So, the calculation will be as follows: 
80 hours as NWHR 
8 hours as Vacation 
10 hours as Tran 
8 hours as JCHR 
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Post the timesheet and run the reports: 
 

 
 
 



1446  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

 

New E-Time Entry – Work Category & Types (19.79654) – BETA Version 

New E-Time Entry by Work Category and Work Category Types – Beta Version (In Programming/Not 
Released) 

In this release we have added two new screens under US Payroll Local Tables. 

Work Category Screen – New Screen 

 

A new screen is programmed to allow users to create ‘Work Categories’. Employees would utilize 
these work categories when entering timesheets to create analytics on the employee spent time 
during the day. The screen will consist of two columns Category code and descriptions. 

Work Category Details – New Screen 

To manage these categories by employee and trade, these categories will be assigned to a specific 
group. 
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A new screen is programmed to allow users to create ‘Work Category Types’. Users will be creating  

‘Work Category Type’ based on employee trades daily work. The screen will have header to create 
Work Category Type and detail section to add work categories. The third block will allow users to 
assign trade code where work Category type is applicable. This would allow e-timesheet program to 
filter categories by employee trades and they will only see work categories applicable to their trades. 

Employee Profile – Employee Creation Process Modifications 

The Work Category Type will be assigned on employee level, the employee creation process will be 
modified to assign the Work Category Type automatically to the employee based on employee trade.  

The process will search Work Category and assign trades to employees where trade code matches 
with employee trade. Users will continue to have an override feature to assign work category 
manually. 

Employee Profile Work Category Tab > Work Category Type 

 

The screen will be created for users to review and assign work category by employee. 
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E-Timesheet Entry Screen Modification (In Programming – Not Released in this Patch) 

E-timesheet entry screen will be modified to add a new field called ‘Work Category’ after Job 
Category field. Timesheet will display all Work Categories based on employee assignments. 
Employees will select their work category from a drop-down list when entering timesheets. 

Note: CMiC is adding an option to disable this feature for our existing users when released. 

Mobile Crew Time – Trade Code Claiming (19.90341) 

Trade Code Claiming-Restrict Trade codes for jobs as per setup on Job Pay Rates program   

Overview 

Employee Trade codes available for time submission on Crew Timesheet Entry program can be 
restricted to Trades available on Job Pay Rates program for PW Jobs, All Jobs or no jobs at all, 
depending on the state of flag Restrict Trade LOV by Job Pay Rate setup for on Crew Timesheet 
Configuration screen  

Pre-requisites 

Set field Restrict Trade LOV by Job Pay Rate setup for on Crew Timesheet Configuration screen 
to desired state to restrict trade codes for all jobs, PW jobs or no jobs at all. 

 

 

Modifications 

Drop down field Restrict Trade LOV by Job Pay Rate setup for has been added on Crew 
Timesheet Configuration screen with 3 options: 

-All Jobs: Select this option to restrict Trade Codes as per setup on Job Pay Rates screen for all 
Jobs 

-PW Jobs: Select this option to restrict Trade Codes as per setup on Job Pay Rates screen for PW 
Jobs only 

-None: Select this option to not restrict Trade Codes for any job which means time can be submitted 
against any available Trade Code regardless of setup on Job Pay Rates screen  

Implementation 

The following example demonstrates how Trades can be limited for PW Jobs: 

 

1) Set field Restrict Trade LOV by Job Pay Rate setup for to PW Jobs: 
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2) For the corresponding PW Job, setup desired Trade Codes for employees on Job Pay Rates 
screen:  
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3) On Crew Timesheet Entry screen, select the corresponding Job, Employee, and open Trade 

LOV: 

 

 

 
 

4) Select an employee not listed on Job Pay Rate screen and open Trade LOV for him.  

Employees not listed on Job Pay Rates screen for the corresponding Job can only enter, submit time 

against their default Trade i.e. the Trade assigned to them on their Employee Profile: 
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5) Post time for the employee and confirm Pay Rate is in accordance with setup on Job Pay Rates 

screen: 

 

Mobile Crew Time – Crew Time Approval (19.90345)  

CMiC has added the following filters on JSP Crew/Mechanics Time Approval screen, to allow users to 
search for posted and unposted timesheet. 

Additional filters required on the screen to query and find timecards. 

New filters have been added to Crew Timesheet Approval screen to enable refined searching of 
submitted Crew Timesheets. Additionally, new Column headers have been added to allow easier 
search and analysis of time entries.   

Also, Posted Crew Timesheets log has been created to search, analyze crew time entries that have 
been posted. 

Pre-requisites 

A) Crew Timesheet Approval: 

Enter, submit crew time from Crew Time Entry program. Once submitted, entries would show up on 
this screen for approval/Posting.  

B) Posted Crew Timesheets: 

Post Crew Time entries. Once posted, this log will store, display records for them  

Modifications 

1) Crew Timesheet Approval program has been modified to enable a more refined search through 
addition of filters. Also, new column headers have been added for easier searching and analysis: 

a) Filters available on the program now are: Crew Code, Job Company, From Date, To Date, Job, 
Created Date, Created By. 

These fillers can be used either exclusively or in conjunction to filter the desired crew timesheets from 
the list.  
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b) Filter Job Company is defaulted to the Company setup as default company for the corresponding 
access code on Access Code Administration screen. If no company is set as a default company for 
the access code, the field will be blank by default, but a value can be selected for it at any time to 
refine searching of timesheets accordingly.  

 

c) Additional column headers have been to Crew Timesheet Approval screen. Available headers are: 

Job, Shift Code, Responsibility, Submit Status, Create Date, Create By, Submit Date, Submit By   

2) Posted Crew Timesheets: This log has been added to display posted crew time entries. 

This is a standard log screen that displays posted crew time entries. It has a standard set of filters 
available to refine your search.  

Implementation 

A) Crew Timesheet Approval: 

 Step 1: Enter, Submit time on Crew Timesheet Entry: 
 

 
 
Step 2: Move to Crew Timesheet Approval screen to approve the submitted time. Observe how field 
Job Company defaults to the default company for the corresponding Access Code:   
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Default Company setup on Access Code Administration screen: 
 

 
 
Step 3: Use filters to refine the search and narrow down to the submitted timesheet: 
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Step 4: Post the timesheet: 
 

 
 
B) Posted Crew Timesheets: 
 
To examine Posted Crew Timesheets, “Show Filter” button on this program can be clicked to enable 
the filter and search the desired crew timesheet. This log only displays crew timesheets that have 
been posted.  
Step 1: Click “Show Filter” button to open filter and enter, apply the desired filtering criteria: 

 Open Filter: 
 

 
 
Enter Filtering criteria And Apply Filter: 
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Step 2: Analyze the Posted Crew Timesheet: 
 

 

Crew Timesheet Audit Log (19.90346) 

Timesheet/Crew Audit program has been created to keep track of all data; status changes made to 
crew timesheets from the time they are first saved to the time they are posted. The log stores and 
displays information for each change made to saved crew timesheets including change date, change 
user, change type, change column, initial value, new or revised value etc.   

Another program Crew Timesheet Report has been added to generate posted, unposted crew 
timesheets. The report also displays total labour, Equipment hours per crew code. 

Pre-requisites 

A) Timesheet/Crew Audit program: 

The Audit Timesheet flag on Payroll Control program needs to be checked to generate audit logs. 
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Once the flag is checked, all changes made to crew timesheets will be logged. 

B) Crew Timesheet Report: 

There is no pre-requisite to this. If there are posted, unposted crew timesheets in the system, they will 
be displayed when this program is run.  

Modifications 

2 new programs Timesheet/Crew Audit, Crew Timesheet Report have been added to E-Time tree 
view: 

1) Timesheet/Crew Audit: This program stores and displays logs for Crew Timesheets.    

The columns available on this log are: 

Comp Code, Pay Code, Pay Year, Pay Period, Date, Job Code, Crew Code, Change Date, Change 
User, For User, Change Type, Change Column, Initial Value, Revised Value, Record Status  

A filter is also available to filter entries by one or more columns 

2) Crew Timesheet Report: This program displays posted, unposted crew time entries along with 
total Labor, Equipment hours per Crew Code.  

The fields available in the Selection Criteria of this program are: 

From Date, To Date, Company, Employee No, Job, Document Code/Crew Code, Transaction Type-
Posted, Unposted, Both 

The Document Code field on this Selection Criteria filters the LOV by Company, Job  

Implementation 

A) Timesheet/Crew audit Log: 

 Step 1: Enable Audit Timesheet flag in Company Control: 
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Step 2:  Enter, Save time entries on Crew Timesheet Entry screen: 
 

 
 
Step 3: Verify the saved entries on Timesheet/Crew Audit report: 
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Step 4: Make changes to the saved entries on Crew Time Entry screen and submit them: 
 

 
 
As can be seen above, changed Trade, hours, Phase for the saved time entry. 
Step 5: Open Timesheet/Crew Audit program and use the filter to display desired Crew Document: 
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Step 6: Verify changes to trade, hours, phase are recorded on the Audit report: 
 

 
 
B) Crew Timesheet Report: 
Step 1: Enter, Submit time against employees, equipment on Crew Time Entry: 
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Step 2: Go to Crew Timesheet Report program and enter the selection Criteria. Select value 
Unposted for field Document Code as the Crew document created in Step 1 above is not posted 
yet: 
 

 
 
Step 3: Run the report by clicking Print Report: 
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As can be seen above, the report displays Labor, Equipment time entries summarized by Job, Cost 
Code. The report also displays total Labor, Equipment hours per Crew Code. 

Print Pay Stub/Multiple Pay Periods (20.18524) 

CMiC has enhanced the existing Pay Stub Printing program to allow users to be able to enter a range 
of periods to print several pay stubs at one time for an employee. Now if an employee is chosen 
across multiple periods, only one email will be sent to that employee with multiple pay stubs in that 
PDF file. 

Pre-requisites 

The following new fields on the Pay Stub Printing screen will need to be enabled using Lite Editor: 

• Period 

• To Period 

• Pay Date 

• To Pay Date 

Modifications 

This modification has been implemented for all Standard Pay Stubs. New fields have been added to 
the Pay Stub Printing screen that will need to be enabled using Lite Editor: Period, To Period, Pay 
Date, and To Pay Date.   

When multiple periods are chosen, the stubs can be grouped by employee + period combination. 
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The Sort By field option in the Pay Stub Printing screen will be disabled (grayed out) if from and to 
periods are both the same and by default, the pay stubs will be sorted by check sequence number. If 
from and to periods are different, pay stubs can be grouped by employee and periods.  

 

Implementation 

Unhide the fields in Pay Stub Printing screen, as shown in the screenshots below. 
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If printing a pay stub for a range of pay periods (multiple periods), then the Sort By field on the Pay 
Stub Printing screen will become enabled. There are two available options in the Sort By field: 
“Default” and “Employee and Period”, as shown in the screenshot below. If “Default” is selected, then 
the pay stub will be sorted by check sequence number, and if “Employee and Period” is selected, 
then the pay stub will be sorted by Employee and Period.  
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When the [Process] button is pressed, a pop-up window will appear which enables users to run stubs 
with different destinations such as “Preview”, “Email”, “Printer”, etc. 

 

If “Email” is chosen as the destination, then two radio buttons will be displayed in the pop-up window 
to schedule whether the pay stub printing should be run now or later at a specified time. These radio 
buttons will only be enabled if users have the system privilege ‘SCHREPORT – SD: Allows the User 
to Schedule Reports’; otherwise, they will be disabled and greyed out. If users have the system 
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privilege, these radio buttons can be used to schedule the pay stub printing, as shown in the 
screenshot below. Once scheduling is complete, click [Run Report]. 

 

 

 

The system privilege that allows a user to schedule a report is located on the System Privileges tab of 
the User Maintenance screen in the System Data module, as shown below.  

 

Pgm: SDUSRMNT – User Maintenance; standard Treeview path: System Data > Security > Users > Users 
Maintenance – System Privileges. 

Trade Code Field Extended to 30 Characters (20.23964) 

CMiC has modified the payroll master trade table extending the trade code length to 30 characters. 
All application modules have been enhanced where trade code is referenced. Routines have been 
modified to apply the trade code increased length. 
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Mobile Crew Time – Quantity Claiming (19.90342) 
A field for notes associated with each claimed quantity has been made available. This note would be 
posted to the spot where notes post when doing quantity batches 

Pre-requisites 

None.      

Modifications 

2 fields have been added on Crew Timesheet Entry program: 

1) Unit Completion: A text field that accepts numbers. This field can be used to enter the number of 
Units completed for each activity. 

 

2) Completion Notes: A text field next to Unit Completion field for entering notes/comments 
regarding quantity completed. Double clicking on this field opens a pop-up window that allows  
multiple line visibility and offers spellcheck feature.   
 
These 2 new fields are highlighted in the screenshot below: 
 

 

Implementation 

On Crew Timesheet Entry, a user can enter Unit Quantity in Unit Completion field for each activity. 
Another field Completion Notes allows the user to enter a brief description for the corresponding 
Unit Completion field.  

These fields are editable on Crew Timesheet Entry program until posting, provided the user has 
relevant privileges assigned.  
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Once Posted, the time entries will be accessible on Units Completed Query program in Job 
Costing>>Query, with value in Unit Completion field copied to Quantity and Completion Notes 
copied over to Notes field. The Notes field remains editable.  

Step by Step Demonstration: 

1) Enter Units Completed, Completion Notes for an activity: 

 

 

 

Double click on Completion Notes to open the enlarged pop-up window: 
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2) Enter and Submit time: 

 

As highlighted above, Unit Completion and Completion Notes can still be edited by clicking on Edit 
button:  

3) Post the Timesheet by clicking on Post Timesheet Button: 
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4) Move to Units Completed Query program in Job Costing and enter the required parameters to 
load the posted crew timesheet: 

 

  



Working Document R12 New Functionality R12 New Functionality (Draft)  •  1471 

 

 

As can be seen above, values in fields Unit Completion and Completion Notes was copied over to 
Quantity, Notes, respectively.  

 
Notes on this screen can still be edited and saved as shown below: 
 
A) Before Edit: 
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B) After Edit: 
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Payroll Posting Routine (20.20714) 

CMiC has created an after posting routine to debit the cash account on posting date and credit salary 
payable account (XXXX). The other two entries would be on pay date credit to salary payable (XXXX) 
and credit cash.  

A new flag option is available in Company Control under Accounts tab with three new fields Cash 
Department, Cash Account and Salary Payable Account. 

When the new checkbox `Enable after posting routine to move GL dates to Pay date’ is checked and 
the Cash Department, Cash Account and Salary Payable Account are provided the GL entries for the 
company in the cash account and cash department are supplemented by new GL entries that move 
the money to the salary payable account for the Payment date. 

Implementation 

The Cash account is mapped and will be retrieved from Company> Pay Group setup. The Account 
Numbers (Cash and Salary Payable) are NOT hard coded in this posting routine and are dependent 
on the new setup available in Company Control Accounts tab. 

The first entry will debit the Cash account (XXXX) and credit Salary Payable account (XXXX) on 
Posting Date.  

The second entry will Debit Salary Payable (XXXX) and Credit Cash (XXXX) on Payment Date (Pay 
Date).  

The after posting routine is for final posting and can be disabled by unchecking the flag. Users can 
also change and specify the value of these 3 fields as required. 

PY Setups: Company > Control > Accounts Tab 

Ensure your accounts are setup and mapped appropriately. 

 

PY Setups: Company > Pay Groups 

Cash Account Setup and mapping 
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Pay Date and Post Date are different on pay period 

 

 

Final Payroll Posting - Enabled after posting routine to move GL dates to Pay date on the Company 
Control under Accounts tab. 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  1475 

 

 

 

 

General Ledger – Posting Report Batch 15525 
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Delete Unposted Timesheet Utility (20.24275) 

A new utility is created to delete ‘Payroll Unposted Timesheets’. The utility will have the following 
mandatory parameters as the selection criteria: 

Company 

Pay Run  

Year 

Period  

From and To Document Code is ‘Non-Mandatory’ field. 

Implementation 

Pre-Requisite: User should have a privilege that allows the user access to timesheets belonging to 
others. 
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NOTE: Timesheet entries imported via timesheet import tool bar and feature are not considered as 
imported. They are flagged as regular timesheet entries in the database.  

Deleting timesheets with a document code reference will only delete available unposted records in 
the referenced From and To Document Code. 

Deleting without checking the flag for Imported Timesheet will delete all the available unposted 
timesheets, both imported and non-imported records. All time entries are deleted regardless of these 
entries being imported or not.  

When user does not check the flag to delete Imported TS entries, system will delete all the unposted 
entries in that specified Pay Run, Pay Period and Document Code. 
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Deleting with checking the flag for Imported Timesheet will delete all the available unposted imported 
timesheets. When user checks the flag to delete Imported TS entries, system will delete all the 
unposted entries in that specified Pay Run, Pay Period and Document Code. 

Scenario: Delete Unposted Imported Timesheet flag checked should only delete the 14 records that 
were imported into timesheet entry for the specified period. 
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Timesheet Entry now has 19 records in total (14 imported and 5 manual) 

 

 

Delete Unposted Imported Timesheet flag checked should only delete the 14 records that were 
imported into timesheet entry. 
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E Time Entry – Added Expense, Sector & Schedule Code (20.26074) 

CMiC has added the expense, sector, and schedule columns to E-Timesheet entry screen.  
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Sector and Schedule are added for J-line entries. Expense and related fields have been added for G-
Line entries.  

Generate Vertex Employee Tax Report (20.24236) 

A utility screen to generate and display the Vertex Tax XML Report of an employee for a selected 
year and period in a structured and readable format with a XSL (XML Style Sheet) applied, along with 
a provision to download in HTML format to view later.  

Users are required to add the utility program to the tree view menu under US Payroll Menu>Utilities> 
Generate Vertex Employee Tax Report. 

1. Fields like Payroll Company, Payrun Code, and Employee Number can be selected from the LOV 
or entered manually.  

2. If no Period From and Period To are provided, the system will fetch results for all the periods  

3. Enter the form details and click “Show Results”. 

 

 

4. Click on “View Report” to view the generated vertex report of the required pay period.  
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5. A pop-up window with results displays the vertex tax report information.  
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6. At the bottom of the pop-up window, there are 2 options ‘Print’ and ‘Close’.  

7. ‘Print’ button will enable the user to download the report in HTML format to be saved and viewed 
later. ‘Close’ will close the pop-up window.  

 

 

When check is printed the Check Number will be reported under the ‘Check No.’  
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Menu Info: If the menu option is not available, please perform the following steps: 

Go to the environment home screen. In the Left section (“Development Tools”), under “Select a Tool”, 
select “Treeview Builder”, and under “Select an Environment”, select your preferred environment. 
Click on “Launch Dev Tools” 
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In the new Pop-up window, filter results by entering the Code as “R12STDMENU” and hit “Search”. 
This will return the Standard R12 CMiC Menu. Click on “OK”.  

In the middle frame titled “Current Menu”, navigate to CMiC R12 Default Menu > Human Capital 
Management > US Payroll > Utilities.  

Right Click on Utilities > Add New. This will create a New Item at the very end of “Utilities” Option. 
Click on “New Item”.  
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In the right frame with the details, provide label as “Generate Vertex Employee Tax Report”. 

In the App Code LOV, select “PY”. 

Select the “Icon Type” as “Icon”, and “Default Item State” as “Close”. 

Select the “Target Type” as “JSP Direct Call” 

In the “Target Name” LOV, select the name “PY - Vertex Employee Report”. 

Select “Target Window” as “Replace Content”. 

Click on “Save” at the top right. The menu option will now be available at given path. 
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Changing the Subject/Body of Emailed Paystub (20.26978) 

CMiC has modified the Direct Deposit email subject line and added the email body. 

Pre-requisites 

Employee E-mail address and preferred method for Direct Deposit Stub needs to be SETUP in 
Employee profile under Rate/Salary tab: 

 

Modifications 

Subject line will be as: <employee Company Name> Paystub for Pay Date <Payroll Period Pay 
Date>. 

Email Body: Dear <employee First name> <employee last name> 

Attached, you will find your Paystub for the pay date %PPR_PAY_DATE% 
To view your pay stub, please open the attached file and enter your unique password (if required). We encourage you to 
save this document in a secure/private location for your future reference. 
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If you have any questions regarding the contents of the attached, please contact <From email Address> 
Thank you, 

<Company Name> Payroll Department 

Implementation 

Please see below Email: 

 

Dear Mike S Nichols 
 

Attached, you will find your Paystub for the pay date 09/04/2019. 

 

To view your pay stub, please open the attached file and enter your unique 

password (if required). We encourage you to save this document in a 

secure/private location for your future reference. 

 

If you have any questions regarding the contents of the attached, please 

contact payroll department. 

 

Thank you, 

Canadian Company Payroll Department 

 

Employee History Import (20.29265) 

Employee history import program allows the user to import employee history records in a CSV file 
(excel sheet) with a specified format of existing employees in a company to update their pay rates 
(hourly rate, charge out rate and billing rate). 

Pre-requisites 

Employee profile needs to be set before importing any employee history records. 

Modifications 

The program updates employee information in terms of hourly rate, charge out rate and billing rate. 
The screens that are mainly affected by this program are employee profile, employment history, as 
well as timesheet entry.  

Implementation 

This section provides examples of using the new functionality, enhancement or change request. 

To start importing data the first step to be taken is pressing import file: STEP 1. 

mailto:payroll@milton.ca
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Choose the file that needs to be imported. The file must be a .CSV format. 

 

The following is a sample file with the following order: ID, first name, last name, effective date, 
reason, hourly rate, charge out rate, billing rate.  

 

After clicking import click on close and move to STEP 2.  
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After clicking import file: STEP 2. The file is now imported showing the date and the user that 
imported the data as well as the time it was imported under the comments field. 

 

Select the file and click on validate imported data button it will indicate if there valid and invalid 
records. 

 

You can edit the invalid records by checking the checkbox of the file and pressing on edit imported 
data.  
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The records imported are shown on the following screen. The “valid” field tells whether the record is 
valid or invalid.  

The invalid records need to be corrected before the records can be written to employees’ history. 

The “errors/warnings” button show all the errors that need to be corrected. 

Once corrected click on the “Re-Validate” button to ensure that all errors were corrected. 

 

 

 

Once all records are validated showing Valid status. Save and close this pop-up window. 
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Select the file and click “create employee history”. 

 

The following message is displayed on the screen and you can no longer see the imported file. 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  1493 

 

New T4 Box Codes & Reporting Requirements (20.31003) 

Canada Revenue Agency has introduced an additional reporting requirement for the T4 slip for the 
Tax year 2020. For the tax year 2020, in addition to reporting employment income in Box 14 or Code 
71, use new other information codes when reporting employment income and retroactive payments in 
the following periods: 

Other Box Codes 57, 58, 59 and 60 T4 Mapping – There is no requirement to setup the Box Code # 
57, 58, 59 and 60 in the T4 mapping parameter screen. The employment income for the below 
periods and Box Codes are reported based on setup against the Box # 14 ( and if applicable Box 71) 
in the T4 mapping parameter screen. 

Amount against Box Code # 57, 58, 59 and 60 is already part of Employment Income (Box #14). 
Reporting employment income is only for the following periods. 

Code 57: Employment income , March 15 to May 9 

Code 58: Employment income , May 10 to July 4 

Code 59: Employment income , July 5 to August 29 

Code 60: Employment income , August 30 to September 26  
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Pay Periods Paid 

 
 

T4 XML File generated 

 

Box 71 – T4 Generation for Employee with an Aboriginal Status in Employee 
Profile 

T4 Mapping is required to generate Box 71. Users need to map Box O71 to the transaction types.  
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Employee profile setup 
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Tax Overrides 

 
 

Employment earned income for period 10 and 11 in Year 2020 

 

 
 

Generated T4 – Box 71 should report employment income and box 14 should report 0.00 
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T4 XML including the Box 71 Employment Income earned. The income was earned in Box 71 falls 
into COVID Period 2, box 58. 

Box 58 is also reported. 
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T4 FORMS Summary 

T4 FORMS Summary report generated for all the printed T4’s for all provinces. Including Other Boxes 
57, 58, 59 and 60 with Box 71. 

 
 

 

Trustmark National Bank ACH Bank Format File (20.34398) 

CMIC has added a new ACH Bank Format File - Trustmark national bank to the check/EFT Register 
screen. 

Pre-requisites 

Payroll Processing, Check Processing, and Check Printing needs to be processed before printing 
Check/EFT Register report. 

Modifications 

After filling the required fields on the Check/EFT Register page. Upon checking ASCII File 
option>Bank Formats become active and a drop-down window is generated with a list of banks. As 
seen in the following screenshot the Trustmark National Bank is now one of those selections in the 
LOV.  
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Implementation 

Upon selecting ACH- Trustmark National Bank the format of the report will change accordingly. Use 
the following steps on how to print this bank format: Click on “Generate File” to generate data with the 
new bank format. 

 

Once the alert pops up with successful data preparation. Press ok then download the file. 
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Add a file name then press download. A (.txt) File with this format will be generated.  

Validated based on the ACH record format description on page 4-6. 

 

Scotia Bank ACH Bank Format File (STD-152) (20.36363) 

CMIC has added a new ACH Bank Format File – Scotia Bank (Standard 152) to check/EFT Register 
screen. 

Pre-requisites 

Banking setups and mapping, Payroll Processing, Check Processing, and Check Printing needs to be 
processed before printing Check/EFT Register report.  
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Show Payroll Post Update on JC Detail + Premium (20.23960) 

1) Rate Code can be assigned to individual Other Hour types to enable calculation of pay rate by 
specific other hour code used on Timesheets. This provides the flexibility to setup different premiums 
for different Other Hour codes.  

2) Job Premium Rate Policies can be created to override the default rate code definition, which allows 
setting up of different rate code definitions for different jobs as each job can be assigned a policy of 
its own    

Pre-requisites 

1) Flag Post Transactions by Hour Type in Job Cost should be enabled in Company Control (US 
Payroll>>Setup>>Company>>Control) 

 

Modifications 

1) Columns Rate Code, Rate Name have been added on Hour Types program (US 
Payroll>>Setup>>Company>>Hour Types). This allows users to assign Rate Codes to individual 
other Hour Types: 
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2) A new program Job Premium Rate Setup (US Payroll>>Setup>>Jobs>>Job Premium Rate 
Setup) has been created to allow users to create a Job Premium Rate Policy, which can then be 
assigned to individual jobs: 

 

 

Implementation 

A) The following example demonstrates how Rate Codes can be assigned to individual Other Hour 
types to calculate pay rates accordingly on Timesheet Entry: 

 

Step 1: Create Rate Codes on Rate Codes program: 
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Step 2: Setup default Rate Codes on Company Control: 

 

 

Step 3: On Hour Types program, assign a Rate Code to Other Hour Types as shown below. Note 
that Rate Code is not a mandatory field on this program and can be left blank in which case the 
system will use default other hour Rate Code set on Employee Profile. 

 

 

Step 4: Enter time against VAC Other Hour Type on Timesheet Entry program and verify rate 
calculation. As shown below, as soon as VAC is selected in Type LOV, the Rate Code mapped to it 
on Hour Types program is displayed in field Rate Code: 
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The Pay Rate for this employee is 25.00 and hence the pay rate calculation for VAC other hour code 
is 25.00*1=25.00  

Step 5: Enter time against WFH Other Hour Type on Timesheet Entry program and verify rate 
calculation. As shown below, as soon as WFH is selected in Type LOV, the Rate Code mapped to it 
on Hour Types program is displayed in field Rate Code: 

 

 
 

The Pay Rate for this employee is 25.00 and hence the pay rate calculation for WFH other hour code 
is (25.00*1.25) + 5=31.25+5=36.25 
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Step 6: Enter time against UH Other Hour Type on Timesheet Entry program and verify rate 
calculation. As shown below, as soon as UH is selected in Type LOV, Rate Code Z400 is displayed 
in field Rate Code. This happens because UH is not mapped to any Rate Code on Hour Types 
program and hence, the system uses default other hour rate code (on company control) for this Other 
Hour Type: 

 
 

The Pay Rate for this employee is 25.00 and hence the pay rate calculation for UH other hour code is 
(25.00*1.5) + 10=37.5+10=47.5 

B) The following example demonstrates how Job Premium Rate Policies can be created to setup 
Rate Codes with new definitions which override default definitions on Rate Codes program for the 
assigned jobs: 

 

Step 1: Create a new Job Premium Rate Policy on Job Premium Rate Setup program (US 
Payroll>>Setup>>Job>>Job Premium Rate Setup). On the policy, new definition can be given to 
desired Rate Codes. For the Rate Codes not mentioned on this program, system will use the default 
definition on Rate Codes program: 
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Step 2: Rate Code definition on Rate Codes program is as follows: 

 
 

Step 3: Assign the Job Premium Rate Policy created in step 1 to a job on Job Setup program under 
Payroll tab as shown below:  

 

 
 

Step 4: Enter time against the job and observe how Rate Code definitions on Job Premium Rate 

Policy override the default Rate Code definitions: 

Enter time against WFH other hour type which is mapped to Rate Code RC01.  

Rate Code RC01 has a multiplier of 2.5 and Premium Per Hour amount of 10.00 on the Job Premium 
Rate Policy, whereas it is 1.25 and 5.00 respectively on the Rate Codes program. As shown below, 
Rate Code definition for RC01 on Job Premium Rate policy overrides the definition on Rate Codes 
program: 

 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  1513 

 
 

The Pay Rate for this employee is 25.00 and hence the pay rate calculation for WFH other hour code 
is (25.00*2.5) + 10=62.5+10=72.5  

Enter time against VAC other hour type which is mapped to Rate Code Z100.  

Rate Code Z100 is not defined on the Job Premium Rate Policy and has a multiplier of 1 on Rate 
Codes program. As shown below, system in this case goes by the definition on Rate Codes program 
as Rate Code Z100 is undefined on the job premium rate policy: 

  

 
 

The Pay Rate for this employee is 25.00 and hence the pay rate calculation for VAC other hour code 
is (25.00*1) + 0=25  
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Step 5: Set Billing Rate for Other Hour Types VAC, WFH on Billing Rates program: 

 

 
 

Step 6: Post Timesheet: 

 
 

Step 7: Verify Billing Rate on JC Transaction Detail log: 
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For Other Hour type WFH, multiplier and premium per hour amount on billing rate table is 1.5 and 15. 
Charge amount for the employee is 97.50 and hence, billing rate= 97.5*1.5+15=146.25+15=161.25 

Similarly, for Other Hour type VAC, multiplier on billing rate table is 3. Charge amount for the 
employee is 35 and hence, billing rate= 35*3=105.00 

Allow Bill Rates Setup by Detail Burdens (20.23961) 

CMiC has made the following enhancements to allow Bill Rate setup and summarized posting by 
individual Other Hour Type Codes and individual burden codes. 

Overview 

1) Bill Rate can se setup for specific other hour codes in Bill Rate Table. This allows summarization of 
timesheet posting by individual other hour codes.  

This provides flexibility to setup different bill rate for different other hour codes.  

2) Bill Rate can be setup for specific burden transaction codes in Bill Rate table. This allows 
summarization of JC transactions by individual burden codes upon final payroll posting. 

This provides flexibility to setup different bill rate for different burden codes.  

 

Pre-requisites 

1) Flag Job Summary By should be set to one of following options: 

a) Job by Employee 

b) Employee by Date 

c) Time Sheet 
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2) Flag Post Transactions by Hour Type in Job Cost should be checked: 

 
 

3) Flag Post Burdens By should be set to Transaction Type and Code: 
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Modifications 

1) In Bill Rate table, PY Tran Code LOV lists individual Other Hour codes: 

 

2) In Bill Rate table, PY Tran Code LOV lists individual burden codes. Ex: 

A) For benefits, PY Tran Code LOV lists all benefits: 

 
 

B) For Taxes, PY Tran Code LOV lists all Taxes: 
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Implementation 

A) The following example demonstrates how Bill Rate can se setup for individual Other Hour codes 
and how timesheet posting summarizes cost by other hour codes: 

 

Step 1: Setup Bill Rate for individual other hour codes in Bill Rate table: 
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Step 2: Enter time against other hour codes: 
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Step 3: Post Timesheet: 

 
 

Step 4: Review the posted transactions in JCDETAIL table: 

 
 

1st row: For PTO other hour code, multiplier is 1.00 and Premium per hour amount is -5.00. 

Bill Rate would be 119.5*1-5=119.5-5=114.50 

 

2nd row: For WFH other hour code, multiplier is 1.50 and Premium per hour amount is 4.00. 

Bill Rate would be 151*1.5 +4=226.5+4=230.50 

 

3rd row: For MVAC other hour code, multiplier is 1.75 and Premium per hour amount is 1.00. 

Bill Rate would be 102*1.75+1=178.5+1=179.50 

 

4th row: For VAC other hour code, multiplier is 1.25 and Premium per hour amount is -3.00. 

Bill Rate would be 100*1.25-3=125-3=122.00 

 

B) The following example demonstrates how Bill Rate can se setup for individual burden codes and 
how payroll posting summarizes cost by burden codes:  
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Step 1: Setup Bill Rate for individual burden codes in Bill Rate table. Following is the bill rate table 
exported to a file: 

 
 

Step 2: Post a period: 
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Step 3: Review the posted burdens in JCDETAIL table: 

 
 

 

1st row: For ZZ20 deduction code, multiplier is 1.75. 

Bill Rate would be 249.48*1.75=436.59 

 

3rd row: For JS01 Public Liability code, multiplier is 3.25. 

Bill Rate would be 104.95*3.25=341.09 

 

4th row: For CC benefit code, multiplier is 3.50. 

Bill Rate would be 95.95*3.5=335.83 

 

6th row: For ZME1 tax code, multiplier is 4.00: 

Bill Rate would be 27.83*4=111.32 

 

8th row: For JS01 Workers Comp code, multiplier is 5.00. 

Bill Rate would be 3.48*5=17.4 

WBS, Import Timecard and Customer Data Mapping (20.23962) 

Enhancements: 1) Allow automatic mapping of Cost Code, Category by Trade Class for Timesheet 
imports if they are missing in Import File. 2) Allow Customer Data Mapping for Employee Number, 
Shift Code and Earning Code/Hour Type  

Overview 

NOTE: These changes ONLY apply to Import Timesheets from ORACLE utility. 

1) System will allow auto population (or mapping) of Cost Code, Category in Timesheet Entry 
program by Trade Class and Trade Code if they are missing in Import File. If Cost Code, Category 
are specified in Import File, system will ignore the mapping and cost code, category specified in 
import file will be used to create time entries. This utility is useful if cost codes, categories are decided 
by Trades and it allows the user to skip entering cost code, category in import file in which case, 
system looks them up in the import template set by the user and assigns cost code, category values 
accordingly when creating time entries.  
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2) Through Customer Data Mapping, system allows mapping external Employee Numbers, Shift 
Codes, Hour Type Codes to CMiC Employee Numbers, Shift Codes, Hour Type Codes. These 
mappings are then used during Timesheet Import if import file contains external employee numbers, 
shift codes, Hour Type Codes. In cases when external employee numbers, shift codes, hour codes 
are not used in import file, system creates time entries as before relying completely on data specified 
in import file.  

 

Pre-requisites 

1) To use cost code, category mapping by Trade’s feature, a timesheet import template must be 
created and then assigned to corresponding job on Job Costing>>Job>>Enter Job program under 
Payroll tab as shown below: 

 

 

2) To use Customer Data Mapping feature to map external employee numbers, shift codes, hour type 
codes, a mapping code must be created and then assigned to corresponding job on Job 
Costing>>Job>>Enter Job program under Payroll tab as shown below: 
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Modifications 

1) New program Timesheet Import Template for Cost Code has been added to US Payroll>>Imports 
section: 
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2) New Program Customer Data Mapping has been added to US Payroll>>Imports section: 

 
 

Implementation 

A) The following example demonstrates how system maps Cost Code, Category when it is not 
specified in import file. It also shows how system skips mapping process when Cost Code, Category 
are specified in the import file and simply creates time entries with specified values: 

Step 1: Create an import template and assign it to a job. As shown below, Cost Code and Category 
have been mapped to different Trade Classes, Trade Codes:  
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Step 2) We will be importing time entries for the below employee in this example: 

 

 

Step 3) As shown below, first row in the import file does not have any value in Cost Code, Category 
Columns for the employee. However, the 2nd row has all values specified. For the first row, system 
will lookup Cost Code, Category from import template and create time entries accordingly. For the 2nd 
row time entry will be created with values specified in import file: 
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Step 4: Import the file: 

 

 

Step 5: As shown below, time entries are created successfully: 
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B) The following example demonstrates how system maps external employee numbers to CMiC 
Employee numbers when external employee number is used in the import file: 

Step 1: Create a mapping template and assign it to a job. As shown below, external Employee 
Numbers are mapped to valid CMiC Employee Numbers: 

 

 
 

 
 

Step 2) As shown below, import file contains external employee numbers in Employee Column. When 
this file is imported, system looks up the external employee numbers in mapping template and picks 
up valid CMiC employee numbers accordingly to create time entries: 
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Step 3: Import the file: 

 
 

Step 4: As shown below, system mapped external employee numbers to valid CMiC employees: 

 
 

NOTE: External Shift Codes, Hour Type Codes can be mapped to CMiC shift codes, Hour Type 
codes in a similar way. 
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Auto-Populating Company Pay Periods & Pay Dates (20.30010) 

Auto-Populating Company Pay Periods and Pay Dates Auto-Populate 

This modification will allow the user to change the default values in the Pay Date and Posting Date 
columns by adding a number of days instead of changing the dates manually for each pay period. 

 

 

Pre-requisites 

A pay period should be set up for the pay run and the year. 

Modifications 

CMiC has added two new fields: Add Days for Posting Date and Add Days for Pay Date in the Pay 
Run section of the Pay Period screen. This allows the user to calculate pay period and posting date. 
The program calculates the process date and the start and end of the pay period as per current logic. 
If the above days are provided, then they are added to the Posting Date and Pay Date values. If 
these fields are left empty, the system will work as per existing functionality and the posting date and 
pay date will be calculated based on the start date and end date. 

 

Implementation 

Enter the number of days to add to the Add Days for Posting Date and Add Days for Pay Date fields. 
Please note, that these fields should not be the same. 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  1531 

 

 

As shown in the screenshot above, the dates in the Posting Date column are calculated by adding 3 days and 
the dates in the Pay Date column are calculated by adding 5 days. 

Added Popup Validation for Unavailable Company/Union/Trade 
Rates (Alternate Feature) (20.29408) 

Added trigger in Employee Profile and Employee History to validate if the rates are setup for specific 
Trades or Unions when setting up an employee. The validation is available by enabling the ‘Alternate 
Feature’ in the database. The validation is triggered when the “Preferred Rate/Charge or Bill Rate” 
drop down is used to select Trade or Union. If the Trade or Union exists, another validation fires to 
validate if rates have been set up. If rates have not been set up the system gives a soft warning. If the 
rates are set up, there will be no warning or popup. 

Example: 

User creates a new employee which belongs to Union 1000 and trade 102E. There are no Rates 
setup for Union 1000 and Trade 102E. 
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When user tries to select “Preferred Pay Rate” by Trade, the popup message is displayed warning 
user that “No Pay Rate Defined for Trade 102E”. When click “OK” the program navigates to 
“Preferred Charge Out Rate” field. 
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When user tries to select “Preferred Charge Out Rate” by Union, the popup message is displayed 
warning user that “No Pay Rate defined for Trade 102E No Charge Out Rate Defined for Union 1000 
and Trade 102E”. When click “OK” the program navigates to “Preferred Bill Rate” field. 

 

 

When user tries to select “Preferred Bill Rate” by Job/Union/Employee, the popup message is 
displayed warning user that “No Pay Rate defined for Trade 102E No Charge Out Rate defined for 
Union 1000 and Trade 102E No Bill Rate Defined for Trade 102E”. When click “OK” the program 
navigates to next field. 
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The same popup message is displayed when user selects “Preferred Rate” by Job/Union for Pay 
Rate. 

 

 

Union will always check union rates then trade rates just as the following screenshot. 
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Trade will only check for trade rates within the program. 
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The modification is also applied to other “Preferred Rate” drop down menu options which are related 
to Trade and Union: Job/Trade, Job/Union and Job/Union/Employee. 
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The same Company/Union/Trade Rates validation pop up has been introduced for the 
following JSP screens: 

Employee Console-> Employee Profile  

HCM >Hired Applicant screen when hiring hired applicant and creating a new employee.  

Canadian Custom Stubs (20.32566) 

CMiC has created a new format for Canadian pay stubs and pay checks. The new format codes are 
“PYSTB08C” and “PYCHK08C”. 

 

Pgm: PYPAYPRD – Pay Period Maintenance; standard Treeview path: US Payroll > Setup > Company > Pay 
Periods 

Pre-requisites 

Set up pay run for employee with the check format “PYCHK08C” and the stub format “PYSTB08C”.  
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Modifications 

On the Pay Periods screen, added “PYCHK08C” to list of available check formats in the Check field 
and “PYSTB08C” to the list of available stub formats in the Stub field.  

User must insert timesheet for hourly employee, post timesheet, process payroll, and process check 
and pay stub.  

Examples of the two templates are provided below. 

Template of PYCHK08C: 
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Template of STB08C: 

 
 

Dynamic Employee Pick List (21.38287) 

Add emp_home_comp_code to Dynamic Employee Picklist Criteria. 



1540  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

This modification allows the user to add the employee home company code from Employee Profile 
into the Employee picklist. 

 

 

Pre-requisites 

The user should go to Employee Pick List screen, insert a new pick list code, and press [“Selection 
Criteria] button. In the Selection Criteria popup screen insert a new line and enter 
“EMP_HOME_COMP_CODE” in the Field Code field. 

 

 

Press the [“show Matching”] button to display all the matching values in the Fixed Entity List section. 
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Modifications 

CMiC has enhanced the employee pick list functionality to add EMP_HOME_COMP_CODE into the 
Selection Criteria section. This will allow the user to create a dynamic employee picklist by choosing 
the home company code. 

Below, a new value of “EMP_HOME_COMP_CODE” has been added to the employee pick list. 
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Charging Job Timesheets Directly in Job Company Currency 
Without Currency Conversion from Payroll Company Currency 
(21.41765) 

Overview 

This enhancement will charge Job Timesheets to Job (in Job Costing) directly in Job Company 
Currency without converting the amount from Payroll Company Currency at all.  

For example, if 10 hours are entered by a Canadian Employee (with Hourly Pay Rate of 100 CAD) 
against a US Job Company, the US job would be charged 1000 USD directly instead of converting 
1000 CAD to USD before charging the job 
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Pre-requisites 

1) Flag Calculate Charge and Bill Amount in Work Company Currency should be enabled in 
Company Control (US Payroll>>Setup>>Company>>Control) 

 

 
 

Modifications 

1) New flag Calculate Charge and Bill Amount in Work Company Currency has been added on 
Company Control (US Payroll>>Setup>>Company>>Control): 

 
 

Implementation 

The following example demonstrates the implementation of this enhancement: 

Step 1: check flag Calculate Charge and Bill Amount in Work Company Currency in Company 
Control (US Payroll>>Setup>>Company>>Control) 
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Step 2: Enter time for a US Employee (Payroll Company currency is USD) against a Canadian 
Company Job (Work Company Currency is CAD): 

 

 

As shown below, Payroll Company uses USD as currency: 
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As shown below, Job Company uses CAD as currency: 

 

 

Step 3: Post Timesheet. As shown below, labor cost charged to job was not converted from Payroll 
Company Currency to Job Company Currency. Instead, labor cost is simply charged to job in Job 
Company currency:  

Employee Charge Amount in USD (Payroll Company Currency): 
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Job Charge Amount in CAD (Job Company Currency) with no currency conversion from Payroll 
Company Currency:  

 

 

GL Report: 
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Step 4: Run Payroll Processing, Check Processing and Print Checks.  

Step 5: Do Final Payroll Posting. As shown below, payroll burdens are calculated in Payroll Currency 
(USD) and then converted to Job Company currency (CAD) to be charged to Job: 
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Timesheet/Final Posting – Details in General Ledger (21.43289) 

A new flag added to the Payroll Company Control under ‘Rules’ tab to allow Timesheet Posting and 
Payroll Posting to be grouped by job when posting into General Ledger. 

The flag allows entries into GL to split for each job.  

1. Check the flag for Post Timesheet/Final Posting as Details in General Ledger. 

 

Select Job/Phase/Category for the Job summary by field. 
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Enter timesheet if the employee is hourly. 

 

 

 

 



1550  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

Timesheet Posting: 
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Payroll processing: 

 

 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  1553 

Check Processing: 

 

 

Check Printing: 
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Payroll Posting: 
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G/L Transaction Detail Report: 
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When the flag is unchecked the G/L Transaction Detail Report is not grouping by job. 

 

 

Certified Payroll Report Enhancements (21.43741) 
 

Overview 

The Certified Payroll Report screen (PY1096) will be modified with new columns and functionality. 

Pre-requisites 

The user should map Transaction Codes in the Certified Payroll Mapping screen. The “Employer’s 
Contr.Flag” field has been added to the table as shown in the screenshot below. 
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Modifications 

1. CMiC will be modifying existing Federal Certified Report. In the existing Certified Payroll mapping 
screen, all contributions & payments (including employer contributions) are charged to a specific 
job. A new column has been added to the report mapping screen called “Employers Contr.Flag”.  

The value for this column can be “No”, “Yes”, and “All”, as is the case in the W2 Mapping screen. The 
default value for this column is “No” as the current mapping screen only includes employee 
contribution by default. Select “Yes” to only include employer contribution value or “All” for both 
Employee and Employer contribution. 

 

No- Transaction code takes only the Employee’s contribution 
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Yes- Transaction code takes only the Employer’s contribution 

All- Transaction code takes both Employer’s and Employee’s Contribution. 

 

This will require changing the standard federal certified report to change all boxes to include this new 
option on the mapping screen. 

 

2. CMiC will add a new option on the standard certified report parameter called “Fringe Calculation 
by” with possible values of ‘All Project Hours’ or ‘Project Hours’. The default value for the column 
will be ‘All project Hours’. 

 

 

The report will sum the total value of transactions mapped in the Fringe Benefit column in the 
mapping utility as per current functionality and divide the total depending on the option selected on 
the parameter screen. The formula is given below: 

 

Fringe Calculation (All Project Hours option) 

$= Total value of ‘Fringe Benefit’ column / All Projects hours 
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Fringe Calculation (Project Hours) 

$= Total value of ‘Fringe Benefit’ Column/ Currently Selected Project hours 

 

3. The fringe benefit column will be expanded and display all transactions mapped in the Fringe 
Benefit column similar to the Other column. 

CMiC has added a new ‘Print Fringe Benefit Detail’ checkbox to the Certified Payroll Report 
Parameter screen. If checked, the Fringe Benefits section will show the list of all the mapped fringe 
benefits. If unchecked, the summary of fringe benefit rates and amounts will be shown, if mapped. 

 

Implementation 

Below is an example of the report with selections of both “No” and “Yes” in the Employers Contr Flag 
field. 
1. Employer’s contribution set to “No”. 
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2. Employer’s contribution set to “Yes”. 
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Annual Accrual Leave Cap (21.40679) 

A new field ‘Annual Accrual Leave Cap’ is added to the Company Leave screen for accruing accrued 
leave in a year. If total accrued leave max at a Leave cap level, then system will stop accruing it 
within the Leave year. If employee uses the same leave within the leave year, then system will not 
accrue anymore since it has already reached, the Annual Cap Level. 

NOTE: System will consider employee level first. System will consider Table Base, if Leave has a 
Table Base and Employee Level is setup as Null. Zero is considered as maximum cap ‘0’. 

Annual Accrual Leave Cap on Company Level, with Max Accrual and Annual Cap Limit values.  

No Table Base. No Employee Level setup overrides. 

Condition below was to set Eligible Days and Hours higher than the allowed eligible to accrue faster.  

Leave Setup Conditions: Table Base (Null), Employee Level (Null), Company Level Setup with max 
accrual and annual cap. 
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Annual Accrual Leave Cap with a Table Base 

Basic Table Setup as Factor with Company Level. The Employee Leave stopped accruing when 
reached max accrual and Annual Cap. Employee did not accrue hours after the Annual Cap Limit was 
reached. 

Leave Code PLT is setup as Hours. The Table Setup has both Max Accrual value as well as Annual 
Cap Value.  
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Leave accrued hours correctly as per Table Setup and stopped accruing hours based on the table 
setup and Annual Cap Limit set on the table base. 

 

 

 

 
 

Annual Accrual Leave Cap on Employee Level Setup with Leave Table Base.  

Once employee reaches the table base annual accrual leave cap. Enter and set Annual Accrual 
Leave Cap on employee leave setup. Leave Accrued Amount by Hours.  

Table base but employee override of the Annual cap leave is reached, and employee uses leave 
hours. 
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Employee leave setup takes precedence over leave table base.  

System stopped accruing leave hours as the employee reached the annual accrual leave cap of 8 
hours. 
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Employee Profile Photo Upload (21.44833) 

Overview 

 

Pgm: PYEMPLOY – Employee Profile; standard Treeview path: US Payroll > Setup > Employees > Employee 
Profile – Personal tab 

CMiC has added a new feature which gives users the option of adding a photo to an Employee 
Profile. The location of the employee profile photo is in the top-right corner of the Personal tab, as 
shown in the screenshot above. 

Pre-requisite 

A pre-requisite to uploading an employee profile photo is that an HCM Contact record must be 
created if it doesn’t already exist for the employee. If an HCM Contact record doesn’t exist for the 
employee, the [Upload Photo] button will not be enabled on the Personal tab of the Employee 
Profile. 

A Contact record is created for the employee on the HCM tab of the Employee Profile. 
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Pgm: PYEMPLOY – Employee Profile; standard Treeview path: US Payroll > Setup > Employees > Employee 
Profile – HCM tab 

For existing employees, the [Create Contact] button will be enabled on the HCM tab. Click this 
button to create a Contact record linked to the employee. 

 

Once a Contact record is successfully created, a confirmation message will be displayed, as shown 
above.  
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Pgm: PYEMPLOY – Employee Profile; standard Treeview path: US Payroll > Setup > Employees > Employee 
Profile – HCM tab 

After a Contact record is created for the employee, the [Create Contact] button will disappear and 
the ‘Contact Created’ checkbox will be checked at the bottom of the HCM tab. In addition, the Contact 
Code and Contact Company fields will be displayed.  

On the Personal tab, the [Upload Photo] button will now be enabled. 

Implementation 

 

Pgm: PYEMPLOY – Employee Profile; standard Treeview path: US Payroll > Setup > Employees > Employee 
Profile – Personal tab 

The [Upload Photo] and [Remove Photo] buttons will be enabled on the Personal tab of the 
Employee Profile only if the employee has an existing Contact record created, as detailed in the 
previous Pre-requisites section. 
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Pop-up window launched from [Upload Photo] button on Employee Profile 

Click the [Upload Photo] button to launch the Attachments pop-up window, where a classic upload 
screen is used to upload a photo.  

 

Pgm: PYEMPLOY – Employee Profile; standard Treeview path: US Payroll > Setup > Employees > Employee 
Profile – Personal tab 

Once the photo is successfully uploaded, it will be displayed on the Employee Profile. 

This photo will be synchronized with the ADF User Maintenance screen and ESS Profile Information 
screen. 
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In the ESS Profile Information screen, the same photo will be automatically displayed. 

Users can update the photo from the ESS screen when the status is “Pending” or “Rejected”.  

 

 

Pgm: SDUSRMNT – User Maintenance; standard Treeview path: System > Security > Users > User 
Maintenance - General tab 

In the ADF User Maintenance screen, the same photo will be automatically displayed.  

NOTE: In all these screens, only one photo can be uploaded. Uploading more than once will only 
replace the photo previously uploaded. The photo uploaded in any of these screens will be reflected 
in all screens, since it is the same employee and only one profile photo is kept for each individual 
employee in the system. 

New York Certified Payroll (21.46636) 

Overview 

CMiC has developed and added a custom Certified Report called ‘New York Certified Payroll Report’. 
This report DOES NOT replace the standard CMiC Certified Report. 
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Pre-requisites 

The user should map Transaction codes in the certified Payroll Mapping screen. A new column 
“Journeyman/Apprentice” has been added to the Trade Code screen. This column is hidden by 
default so the user should enable it through Lite Editor. In the Certified Report Info tab of the Job 
Work Location screen, a new field Employer Email field has been added. 

 

 

 

Modifications 

The heading of the Certified Payroll will be the same as for the DEP Certified Payroll.  

The header will include the following columns: 

 

Employer Name is Job Company Name 

Employer Address is Job Company Address  

Payroll# is Period Number  

Working Ending date is Period End Date 
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Name of Prime Contractor is Job Company Name  

Employer Email address - add the email address field on Job Work Location screen 

Contract Registration - which has been setup under Job Work Location screen. 

Employer Phone# - add a contact number for certified report verification 

Agency - add a field and users can add agency information as free form text (no validation) up to 15 
characters  

Employer Tax ID - Federal Id Number (FEIN) of the company 

Agency Pin - add a field and users can add agency pin information as free form text (no valid ation) 
up to 15 characters. 

Project Name - Job name 

Project Address - Job Address  

This report should show the last four digit of the employee’s SIN#   

Mask the social security up to last four- digits. 

Column 2 (Exemptions) has been removed from the report 

Work Classification should include local number and check box for Journeyman/Apprentice should be 
the top line and OT should be underneath ST- The local number is the union code and the short 
description of the union. 

Walsh will update all existing trades with the proper value and will continue to update the value when 
adding new trades in the future. 

If the value is not defined as J or A, then default value will be taken as J- Journeyman. 

Columns 4, 5, 6 and 7 are correct 

Column 4 weekdays are correct on existing federal certified report. 

Column 5 total hours are also correct, and no change is required. 

Column 6 hourly rate & column 7 gross amount are also correct. 

Column 8 will be one column for “Withholding and Deductions” 

Remove the separate Columns for Fed, Tax, FICA, Local/State Tax. SDI and Vacation Holiday. They 
should be aggregated. The amount in this column should be difference between Gross Pay and Net 
Pay. All the mapping columns will be removed except “Fringe Benefits” and “Others”. These 2 will 
remain on the report. 

Column 9 should be “Net Pay”, remove check NO 

The Net Pay remains as is with the same calculation to add all employees gross wage minus 
deductions. 

The final column should be “Hourly Contributions to Benefits Funds” (Total Benefits) 

The rest of the columns from the New York Certified report will not be considered in this work order 

Parameter screen 

 All the options will remain. The “Print Benefit by Trade” checkbox will only work for mapping columns 
for “others” and “Fringe Benefit”. 
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The bottom of report should have the disclaimer and signature lines. 

 

NOTES: This enhancement is not to create the same report available on New York DOL website (see 
report below). 

The report is not a replacement for the federal certified report. 

This report will be a permanent custom report for Walsh for NY. 

Implementation 

The report should be added to the menu through Treeview builder. Target name is PY -JSREP- NYC 
Federal Certified Payroll. 
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Oracle Import – Addition of Employee and Customer Number 
(21.48401) 

Overview 

A new column has been added to Import Timesheets from Oracle CTL file. This column will allow 
customer data mapping. Through customer data mapping, system allows mapping external employee 
numbers, shift code, hour types of codes to CMIC employee numbers, shift codes, hour type codes. 
These mapping are then used during timesheet import if the import file contains external employee 
numbers, shift codes, and hour type codes.  

Pre-requisites 

1) To use cost code, category mapping by trades feature, a timesheet import template must be 
created and then assigned to a corresponding job on Job Costing>>Job>>Enter job program 
under payroll tab as shown below: 
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2) To use Customer Data Mapping feature to map external employee numbers, shift codes, hour 
type codes, a mapping code must be created and then assigned to corresponding job on Job 
Costing>>Job>>Enter job program under Payroll tab as show below: 

 

Modifications 

A new column was added to the ctl file on import timesheet from oracle. This column 
“IMP_TSH_CUST_EMP_NO” was added to the end of the ctl file to allow customer data mapping 
easily.  

Note: If this column is not to be used a comma must be added for the last column to allow a 
successful import. 

 

Implementation 

The following example demonstrates how the system maps customer data when it’s specified in the 
import file. 

Step 1: Create an import template and assign it to a job. As shown below, cost code and category are 
mapped to a trade class, trade code: 
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Step 2: Create a customer data mapping template and assign a customer employee to an employee: 

 

Step 3: As shown below, the employee number does not have a value and the trade code is left blank 
as well. 

 

Step 4: Import the file:  
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Step 5: As shown below, the timesheet entry is created successfully and employee number was 
picked up as per the mapping: 

 

New PY Positive Pay File Format for Citibank (21.49766) 

New PY Positive Pay file format for Citibank 

Modifications: 

CMiC added a new positive pay format for Citibank under Check EFT Register. 
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Able to generate format and download it. 
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New setup screen created for the existing Work Status field in the 
Employee Profile screen (22.52534) 

Overview 

CMIC has created a new setup screen for the existing Work Status field in the Employee Profile 
screen. When an employee is on unpaid leave, they receive no paid wages or allowances. The new 
setup screen will allow users to put an employee on permanent unpaid leave for a longer period 
instead of entering unpaid leave timesheets. The employee can be active but on an unpaid leave for 
as long as required. 

Pre-requisites 

Before changing the work status for the employee, create a new “Inactive” work status.  

 The “N” code has the ‘Active Status’ box unchecked. 

 The “W” code cannot be changed as it is system defined. 
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Modifications 

The work status code can be up to 4-characters. 

These codes can be used in employee profile.  

The processing has been modified to look up the new “Active” status from the setup table for work 
status. If the work status has an unchecked status flag, then it will not be included for processing. 

Note: Timesheet entry will be modified in the next patches to warn users if the employee work status 
is inactive. 

 

Implementation 

 

Above is an example of an employee with an inactive work status. 

Below shows that the Employee History work status is in sync with the Employee Profile. 
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Shown above is an entered timesheet for the month for the inactive employee and processed payroll. 

Note: A warning on timesheet will be added in the next patch 
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An amount of 0 pay is shown below as the employee is inactive for the period. The employee will 
receive 0 funds. 

 
 

US payroll includes the same modification. 

Testcase #1: Employee with an inactive status. 
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The inactive employee has benefits which do not show on mid year pay history even though the 
exclude without wages box is not checked. 

 

The employee is processed without a timesheet. 
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Nothing is being processed as the employee is inactive for the period. 

 

Testcase # 2: Employee with an active work status. 
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Payroll process will process this status as the employee is active. 

 

Show Reprint ALERT on Pay Stub Printing Screen (22.53072) 

Overview 

CMiC has added more flexibility to pay stub printing. Now when printing pay stubs using the Payroll 
Check Printing screen, users have the option to avoid re-printing pay stubs that have already been 
printed. In addition, this functionality has also been added as an alternate feature to the Pay Stub 
Printing screen. The alternate feature on the Pay Stub Printing screen is disabled by default and will 
need to be activated by a programmer (i.e., feature is not enabled/disabled on the Payroll Control 
screen). 

Pre-requisites 

To use the re-print alert functionality on the Pay Stub Printing screen, the new alternate feature will 
need to be enabled: “SHOW REPRINT ALERT ON PAYSTUB PRINTING SCREEN”. 

Modifications 
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Enhancements have been made to the Payroll Check Printing screen (standard Treeview path: US 
Payroll > Processing > Check Printing) and the Pay Stub Printing screen (standard Treeview path: 
US Payroll > Processing > Pay Stub Printing). In the Payroll Check Printing screen, when the ‘Print 
Direct Deposit Stub’ checkbox is checked and the [Print] button is pressed, the Pay Stub Printing 
screen is launched as a pop-up window. The first time this printing process takes place (i.e., no stubs 
have been previously printed) for the company, pay run, year, period, pay group, and employee 
combination entered in the Payroll Check Printing screen, all pay stubs will be printed or emailed.   

If the printing process is repeated a second time and some pay stubs have already been printed for 
that company criteria, the Payroll Check Printing screen will launch a pop-up Alert message to 
confirm if the user wants to “Reprint Checks?”. If the [Yes] button is pressed, all pay stubs will be 
printed or emailed. If the [No] button is pressed, only unprinted stubs will be printed. 

NOTE: The Alert message is only triggered on the Payroll Check Printing screen after the print 
process is repeated a second time. It will not appear again if the process is repeated three or more 
times. 

For MOSS, an alternate feature was added to the stand-alone Pay Stub Printing screen, which is 
launched from the Treeview. The alternate feature is called: “SHOW REPRINT ALERT ON PAYSTUB 
PRINTING SCREEN”. When this feature is enabled in the stand-alone Pay Stub Printing screen, the 
screen will function in the same fashion as the Payroll Check Printing screen, but the Alert message 
will continue to be triggered if the printing process is repeated when pay stubs have already been 
printed for specific company criteria.   

Implementation 

When the alternate re-print alert feature is enabled in the Pay Stub Printing screen, if no stubs are 
printed for a company, pay run, year, period, pay group, and employee combination, all the pay stubs 
will be printed. If unprinted stubs exist for the above combination, a pop-up Alert message will confirm 
if the user wants to “Reprint Stubs?”. If the [Yes] button is pressed, all pay stubs will be reprinted, and 
if the [No] button is pressed, only unprinted pay stubs will be printed. 

 

Pgm: PYSTUB – Pay Stub Printing; standard Treeview path: US Payroll > Processing > Pay Stub Printing 
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NOTE: Please note that this feature applies to Standard Stubs, not Customized Stubs. 

If a user runs it again from the Payroll Check Printing screen, the Alert message will not be displayed. 
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Re-Calculate Salary Charge Rate New Option (22.54668) 

Overview 

A new option “Employee total cost charge per period by default charge rate {profile}” is added on the 
payroll control file to re-calculate the salary charge rate. The existing re-calculate salary charge rate 
works based on an existing calculation and on employee salary paid in the period. The user can now 
change to the new method which is based on the total cost for the period based on the employee 
default charge rate setup in employee profile.  

Pre-requisites 

1) Select the new option of re-calcuate charge rate based on “Employee total cost charge per period 
by default charge rate {profile}. 

 

2) Set salary charge rate calc method, the flags and salary charge rate processing option as per the 
screenshot below. 
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Modifications 

A new option of “Employee total cost charge per period by default charge rate {profile}” is added to re-
calculate charge rate based on dropdown menu. This will allow user to use the charge out rate set on 
employee profile. 

The processing of the re-calculate charge rate is also modified to consider the new option. Both the 
below highlighted options use the new base method for calculation.  

 

Implementation 

The following are examples of how the new functionality can be used: 

Example #1: The following is an employee with charge out rate of $40. Worked 50 hours per week. 
The charge out rate and amount are adjusted as per the new functionality.  
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Formula: ((THP * ECR)/ THW) * THW 

Formula: ((Total hours in a weekly period * employee cost (charge) rate)/ Total hours worker)* Total 
hours worked. 

((40*40)/50) * 50 = 1600 
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Example #2: The same employee with 60 hours of work in a week. 

 

 
 

Formula: ((40*40)/60) * 60 = 1600 
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Payroll (Non-Us/International) 

Transfer of Employees Between International Companies (21.45778) 

A new flag is added under system options to allow the transfer of employees from one international 
company to another in a different country. 

Overview 

CMiC has added a new flag under the system options screen in the payroll section. The option will 
determine if the user implemented a CMiC international payroll. The flag can be checked or 
unchecked. When the flag is checked, the users are allowed to access all employees in profile and 
history for all companies for all countries without changing “default company” only in international 
payroll. 

NOTE: Payroll processing changes are not in scope for this modification. The modification only 
considers Employee profile, Employee History and Employee Import changes. Payroll processing will 
generate an error against these employees since the tax related tab is not populated.  

Pre-requisites 

The flag must be checked under payroll tab in system options for the functionality to be enabled.  

 

Modifications 

When the flag is checked under system options the employee profile and history screens will hide all 
tax related information from international payroll screens. The company LOVs is modified to display 
all companies along with the country code. 
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The validation on employee profile and history remains intact and all information are validated based 
on the company selected such as pay run, pay group or union code.  

The triggers will be created defaulting required values for tax-related fields in profile and history 
tables.  

Implementation 

Employee profile can now be saved with a payroll company that is different than the home company. 

 

The same changes can be made to employees under employee history for existing or a newly 
created employee.  
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This change is also applied to import in employee profile. The employee import feature within the 
ADF screen is modified to ensure that users can import employees without validating tax information.  
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Timesheet can be entered and posted for these employees with the change.  
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New Calculation Method Added for Base Wage – Dubai Region 
(21.47918/HCM-421 and HCM-434) 
 

Overview 

CMIC has added calculation support for the Dubai region to the International Payroll module. The 
definition of the base wage in Dubai is a monthly salary which includes monthly allowances. Full 
wage includes basic salary plus all the employee benefits/allowances. Benefits are calculated as 
allowances.  

Pre-requisites 

The employee package must include the employee monthly salary and the benefit paid to the 
employee. Therefore, the employee must have both their benefits that are included in the package 
and those that are not. The non-package allowances are comprised of company contributions and 
provisions not paid to the employee. 

Those benefits can be elected to the employee in the HR module. 

 

Modifications 

The international Employee Profile is modified with a new option to allow users to define salary as 
monthly for the middle east region to avoid rounding issues. The annual salary is changed to salary 
frequency. Two options are provided in the frequency field: “Annual” (the default option) and 
“Monthly”. The Employee Package screen can be viewed from the Employee Profile. 
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Benefits that are marked as a “Package” are displayed below. All non-package benefits are displayed 
in the below section.  
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Implementation 

ALEC employees enter timesheets for their time worked.  
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Once payroll is processed, the amount paid to the employee is calculated as:  

The pay amount calculation = Base wage + All allowances (part of the package and non package) = 
22,500 (in this case) 
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New Calculation Method Added for Pro-ration of Lump Sum 
Benefits – Dubai Region (21.47918/HCM-468) 

Overview 

CMIC has implemented the functionality of pro-ration for employees hired or terminated mid period. 
Employees are paid monthly allowances for travel, food, and housing, depending on the camp in 
which they are housed. These allowances may change mid month if the employee changes 
jobs/camps or if the employee changes employment situation.  

NOTE: This functionality is available for US Payroll and International Payroll. 

Pre-requisites 

1) Alternate work days must be setup for 7 working days as per Dubai region.  

 

2) The master benefit screen has two new checkboxes included in package and pro-rate lump sum 
benefits 

To pro-rate for a lump sum benefit this the pro-rate lump sum benefit box should be checked.  
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Modifications 

The benefit master setup screen has a new checkbox for lump-sum burdens to be pro-rated.  

 

Implementation 

An example of an employee terminated mid period and re-hired mid period is shown below. 

The following is the employee package with all of the employee’s allowances. 
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1) Timesheet was entered for the employee for two months and checks were printed.  
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2) Employee got terminated mid period on the 16 of March,2021. 
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3) Timesheet was entered for 16 days of work. 

 

 

Printed check for period 3 
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. 
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4)  Calculations of the pro-rated benefits and BW: 
 

Period 3 

Month Days 31 

Worked Days 16 

Benefit Changed  

Leaves 0 

FDLA 600/31 *16 =309.677 

GNLW 3000/31*16= 1548.3871 

HSLW 1500/31*16= 774.19 

MDLW 2000/31*16=1032.25 

SCLW 1200/31*16=619.35 

TRANS 1200/31*16=619.35 

BW 14000/31*16 = 7225.806 
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5) The employee got re-hired the 15 of April 2021. 
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6) The benefits were re-elected. 
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7) Timesheet is entered for the employee for 15 working days starting April 15. 

 

 

8) Calculations of the pro-rated benefits and BW: 
 

Period 4 

Month Days 30 

Worked Days 16 

Benefit Changed  

Leaves 
0 

FDLA 600/30 *16 =320 

GNLW 3000/30*16= 1600 

HSLW 1500/30*16= 800 

MDLW 2000/30*16=1066.66 

SCLW 1200/30*16=640 

TRANS 1200/30*16=640 

BW 14000/30*16 = 7466.66 
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New Calculation Method Added for Cash and Non-Cash Lump Sum 
Benefits – Dubai Region (21.47918/HCM 467 and HCM-468) 

Overview 

CMIC has implemented a new method to calculate cash and non-cash lump sum benefits. 
Percentage benefits cannot be pro-rated or part of a package. 

Pre-requisites 

1) Alternate Workdays should be set to 7 working days as per Dubai region. 
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2) Non-cash benefits should not be part of the package or have pro-rate lump sum benefit box is 
checked. The paid in cash box should be unchecked.  

 

Modifications 

Include in Package and Pro-rate Lump Sum Benefit boxes are unchecked when the benefit is a 
percentage. Percentage benefits are paid in cash. 
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Implementation 

The following is an example using a no-packaged percentage benefit.  

An employee is hired on 10th of January,2021 with a non-packaged percentage benefit. The benefit 
will not pro-rate as a lump sum benefit. Non-cash benefits pay amounts are part of this example. 

 

 

Noncash benefits setup is shown below. 
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Percentage cash benefit setup is shown below. 
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1628  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

  

 

Base wage pro-rated for 22 days = 12000/31*22 = 8516.12 
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Another example with pro-ration of a benefit for an employee hired mid period with a non-cash 
benefit. 

Hired employee 10/Jan/2022 elected a non-cash benefit of CMP1 that is part of the package and with 
pro-ration box checked. 
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After processing payroll to ensure that the benefit pro-rated. The CMP1 benefit was pro-rated for 22 
working days starting 10th of Jan until the 31st of Jan.  
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PYC – QC Group Insurance Maintenance (21.49034/18.64007)  

WORK DESCRIPTION: 

Ability to change the Employer Contribution based on the Work province of the employee under the 
QA Group Insurance Maintenance screen. The Company will continue the pay the 70% of the 
insurance prime in province of Quebec but needs to pay the insurance prime at 100% outside 
province of Quebec (QC). 

PROGRAM MODIFICATIONS: 

Province Override Tab: 

CMiC has modified the Quebec Insurance Group Maintenance Screen by adding a new tab called the   
"Province Override". Province and Employer Contr. Percentage columns will be displayed on the 
screen. User will be able to enter alternate percentage values for other provinces against the 
Company and Group Code selected on the main screen. No changes will be done under Group 
Item/Deduction Codes block. 

The existing column "Employer Contr. Percent" on the main screen will be considered as a Quebec 
Percentage, whereas for the other Provinces user will be able to enter different percentages under 
this new Override Popup screen. If the Override values are available for the work province of the 
employee, then system will take that percentage, otherwise system will take percentage from the 
main screen as per current functionality. 

Pre-Requisites 

Insurance Benefit Setup – Deduction Codes in CMiC System 

 

The employer contribution of the deductions in the insurance group can be determined with the ability 
to group a set of related deductions into an insurance group. The user can specify the employer 
contribution for the group expressed as a percentage, specify the priority order when allocating the 
employer portion, and specify if each deduction in the group is subject to employer contribution. The 
amount paid by the employee is not tax deductible, but the amount paid by the employer can be 
subject to tax. 

 

An Insurance Group can be set up in the Administration -> Deductions -> Quebec Insurance Group 
screen. The employer maximum contribution is specified as a percentage of the total employee 
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insurance premium. The deductions in the group are assigned a priority to specify the order in which 
the deductions will be distributed, allocating as much as it can to each until the maximum is reached 
or there are no more deductions. 

Added a new entry of employer contribution percentage override by work province. 

 

 

The deductions are set up at the Master, Company and Employee level if necessary. The Employer 
Contribution flag at the Master Level will indicate if the deduction has an employer contribution or if 
the deduction is only paid by the employee.  

Deduction HLTH Setup:  
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Deduction DISS Setup: 
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In the Tax Elements and Tax Elements by Transaction screens, the user can specify whether the 
employee deduction is tax deductible or whether employer portion is subject to tax. A deduction code 
can only have one or the other selected but not both. 

 

 

During payroll processing, the maximum for the insurance group is determined by the percentage 
defined for the group multiplied by the total amount of the employee portion of the deductions. 

Test Case Example: ON Province should be calculated at 70% 
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The employee total insurance premium amount is $220 (100 + 120) and the maximum employer 
contribution percentage for the insurance group is 70% for Province of Ontario -ON which is setup 
under the Province Override Tab. System will calculate the maximum employer contribution amount 
as 220 X 70% = $154.  

In order of priority, the employer contribution amount is distributed to deduction HLTH (HINT) first at 
$100 and the employee contribution amount is reduced by $100 which is 0. Then deduction DISS 
Employer is calculated at $54, and the employee contribution amount ($120) is reduced by $54 which 
is $66.  Total of above employee and employer deduction premiums are equal to $220 (54 +66 +100). 

 

Test Case Example: QC Province should be calculated at 50% 
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The employee total insurance premium amount is $220 (100 + 110+10) and the maximum employer 
contribution percentage for the insurance group is 50% for QC (setup on the main screen). System 
will calculate the maximum employer contribution amount as 220 X 50% = $110. In order of priority, 
the employer contribution amount is distributed to deduction HLTH (HINT) first at $100 and the 
employee contribution amount is reduced by $100 which is 0. Then deduction DISS is calculated at 
$10 and the employee contribution amount 120 is reduced by $10 which is $110.  

Total of above employee and employer Deduction premiums are equal to $ 220 (10 + 110 + 100). 
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Annual Leave Processing - New Calculation Method Added to 
Calculate Annual Leaves in Dubai Region (21.50021/HCM-455) 

Overview 

CMIC has added a new drop-down column with multiple options on the Hour Type screen to calculate 
annual leave based on either “Wage”, “Partial package”, or “Full Package”. UAE and its regions have 
various types of leaves paid for employees. Some of them are regulated by the UAE labour law, such 
as annual leave. For annual leave, the worker must receive their basic salary in addition to a housing 
allowance if such an allowance is stipulated in the contract.  

Pre-requisites 

1) Alternate Workdays has to be setup to 7 working days as per Dubai region. 

 

2) Annual leave setup is required. 

 

 

3) Setup the Hour Types screen to have annual leaves based on wage, partial package, and full 
package just like AL1, AL2, and AL3 below. 
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Modifications 

Employees are entitled to an annual leave of: 

2.5 days per month, if they have completed six months of service, but not one year. 

30 days, if they have completed one year of service. 

The calculation of the duration of annual leave will include official holidays specified by law or by 
agreement and any other leaves caused by sickness if they fall within the annual leave. 

Implementation 

Testcase #1: Validate an employee annual leave after 6 months of service and validate annual leave 
base wage calculation. 

 
 
Printed checks for 6 months 
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Entered time for period 7 for 15 days of work and 15 days of vacation. 
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Validate base wage is calculated as: 

 

Leave amount paid (Monthly wage/days in a 
month/ hours per day) * 
leave hour taken 

(14000/31/8)*8 = 451.61 
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Testcase # 2:  Validate an employee annual leave after 1 year of work 

Processed for 12 months: 
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Testcase #3: Validate an employee with full allowance of leave.  

 

 
 

Checks must be printed for 6 months. 

 

NOTE: ENTERED 8 HOURS FOR AL2 FOR PERIOD 7. 

 

Leave amount paid (Base with all allowances/days 
in month/hour per day) * leave 
hours taken 

(24500/31/8) * 8 = 790.32 
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Testcase # 4: Validate an employee with Partial allowance of leave 

 

  

 

Partial package hours entered: 

 

 
 

Leave amount paid (Base with All alowances 
excluding food/days in 
month/hour per day) * leave 
hours taken 

(23900/31/8) * 8 = 770.97 
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Testcase # 5: Validate an employee annual leave with full package and partial package using two 
leave codes 
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Full and partial leave hours entered: 

 

  

 

Leave amount paid (Partial 
Package) 

(Base with All alowances 
excluding food/days in 
month/hour per day) * leave 
hours taken 

(23900/31/8) * 8 = 770.97 

Leave amount paid (Full 
Package) 

(Base with all allowances/days 
in month/hour per day) * leave 
hours taken 

(24500/31/8) * 8 = 790.32 
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Testcase # 6: Validate an employee with benefit increase in the middle of a period (OT and leave) 

 

  

 
 



1660  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

 
 

OT CALCULATIONS will not consider or include pro-ration. 

Medical allowance would calculate as per the increase. 

 
 

MDLW: 2000/30*14 + 2500/30 *16 = 2266.66  
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Overtime Rate Calculation on Wages, Partial Packages, and Full 
Packages - Dubai Region (21.50023/HCM-424) 

Overview 

CMIC has implemented a new method to calculate overtime rates based on package. The Hour 
Types screen has two new columns: “Based on Package” and “Exclusion”. The former is a drop down 
that shows the three types of packages: wage, partial package (which allows the exclusion of 
benefits), and full package.  

Pre-requisites 

The Alternate Work Days setup required for 7 days a week is shown below.  
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The two new columns added to Hour Types must be added from the lite editor. Setup under hour 
types is required for overtime. Below is the setup for overtime packages. 

 

 

The partial package below excludes food. 

 

Modifications 

When the based-on package is set to “Wage”, the other type of overtime calculation are based on the 
employee’s basic salary. This type of calculation does not include any allowances in the OT rate 
calculation.  

When the based-on package is set to “Partial Package”, CMIC payroll allows users to set up OT 
based on the employee’s gross wages with the ability to include specific allowances. As shown 
below, the employee continues to receive all allowances except food in the OT rate calculation.  
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When the based-on package is set to “Full Package”, the calculation will include all allowances 
benefits employees receive in monthly pay marked as package allowance. Any benefit that has the 
box checked for include in package will be included in the OT rate calculation. 

Implementation 

1) Below is an example where the hour type is based on “Wage. 

 

Entered OT hours for a wage package. 
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OT calculation for base wage only. 

 

OT Rate Per Day Base wage * Total Months/Total Days 12000*12/360 = 400 

OT Rate per Hour OT rate per day/Work hours per day * 
OT rate multiplier (1.5 per hour) 

400/8*1.5 = 75 

OT Paid Amount OT rate per hour*OT hours worked 75*10 = 750 

 

 

Net pay calculated with all allowances. 
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2) An example when hour type is based on “Partial Package” where food allowance has been 
excluded. 

 

Entered OT hours for a partial package. 
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OT calculation for partial package: 

 

OT Rate Per Day Base wage * Total Months/Total Days 20,900*12/360 = 696.67 

OT Rate per Hour OT rate per day/Work hours per day * 
OT rate multiplier (1.5 per hour) 

696.67/8*1.5 = 130.625 

OT Paid Amount OT rate per hour*OT hours worked 130.625*10 = 1306.25 
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Gross wage calculation: 

 

Sum of allowances: 

 

3) An example when hour type is based on “Full Package”. 

 

Entered OT hours for full package. 
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OT calculations for full package. 

 

OT Rate Per Day Base wage * Total Months/Total Days 21,500*12/360 = 716.67 

OT Rate per Hour OT rate per day/Work hours per day * 
OT rate multiplier (1.5 per hour) 

716.67/8*1.5 = 134.38 

OT Paid Amount OT rate per hour*OT hours worked 134.38*10 = 1343.75 

 

 

Gross wage calculation. 
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4) An example of two overtime packages (Full and partial package OT hours). 

 

 

OT partial calculations: 

 

OT Rate Per Day Base wage * Total Months/Total Days 20,900*12/360 = 696.67 

OT Rate per Hour OT rate per day/Work hours per day * 
OT rate multiplier (1.5 per hour) 

696.67/8*1.5 = 130.625 

OT Paid Amount OT rate per hour*OT hours worked 130.625*10 = 1306.25 
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OT full package calculations: 

 

OT Rate Per Day Base wage * Total Months/Total Days 21,500*12/360 = 716.67 

OT Rate per Hour OT rate per day/Work hours per day * 
OT rate multiplier (1.5 per hour) 

716.67/8*1.5 = 134.38 

OT Paid Amount OT rate per hour*OT hours worked 134.38*10 = 1343.75 

 

 

Company Loans and Advances – Added New Pro-Rate Flag 
(21.50025/HCM-560) 

Overview 

CMIC has implemented a new flag to pro-rate loans and advances for Dubai region. Loans and 
advances will now pro-rate based on the number of days the employee started working or got 
terminated. This functionality is like the pro-ration of lump sum benefit amount. 

NOTE: This functionality is available for US Payroll and International Payroll. 

Pre-requisites 

3) Alternate work days under company is required to be set to 7 working days as per Dubai region 
working days. 
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4) The pro-rate loan amount flag needs to be added from the lite editor: 

 

Modifications 

The loan processing is modified to pro-rate the loan principal or interest amount based on employee 
workdays.  

Company loan and advances screen has a new flag of “Pro-rate loan amount” added.  

 

Implementation 

An example of an employee hired mid period with a loan that has its pro-ration loan amount flag 
checked. 

1) Employee hired mid period 16 of January 2021.  
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Employee package screen: 
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2) Assign the loan to the employee under employee loan and advances screen: 

 

 

3) Enter timesheet for the employee for 16 days of work: 
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4) Mid year pay history would show the amount calculated after payroll processing: 

 

5) Calculations for LP and LI pro-rated for 16 days of work: 

LP = 1666.67/31 * 16 = 860.22 
LI = 18.33/31 * 16 = 9.46 
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6) LP and LI will show in full amounts for the next periods of work: 

 

 

 

7) Employee gets terminated in the middle of Nov. 20 th the processing will remain to deduct the 
default principal amount from the employee loan payment.  

Note: There will be no pro-ration or remaining loan adjustment.  

Note: The employee was hired in the middle of the month of Jan. 

In the above scenario, payroll will deduct 860.22 in period 1 and 1,666.67 between 2 and 12. 
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Printed checks up to period 12 

2,473.08 is the remaining amount after period 12 this amount requires an adjustment 

 

Period 11 and 12 paid the loan with no pro-ration in full amount. 
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Addition of New Employee Package Screen to Employee Profile as 
a Tree View Program for Companies in the UAE (21.50722/HCM-466, 467) 

Overview 

The Employee Profile has a new [Employee Package] button to display package information. This 
button will display a screen with the employee total base wage and both package and non-package 
allowances. The amount will be displayed based on the employee pay run frequency. The screen 
displays all active benefits without an end date. 

Note: This functionality is available for US Payroll and International Payroll. 

Pre-requisites 

1) The employee package screen in Employee Profile and salary frequency must be added from the 
lite editor as shown below: 

Note: All employees in ALEC are salaried employees with a monthly salary frequency. When a 
monthly frequency is selected you can add a monthly salary in the rates/salary tab of the 
Employee Profile.  
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2) The standalone employee package program can be added from the treeview builder as shown 
below. 
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3) Benefits are elected for each employee from HR> benefit administration> benefit/deduction 
administration> election by employee program, as shown below.  

 

Modifications 

The Hour Types screen (under Setup> company) can now be based on types of packages. 

The Based-on Package and Exclusion columns can be added from the lite editor as shown below. 
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Two new checkboxes have been added to the Benefit Master screen: 

1- Include in package – When this box is checked the benefit will be part of the package calculation. 

2- Pro-rate Lump Sum Benefit – When this box is checked the benefit calculations will pro-rate 
based on the start date of the employee.  

These checkboxes can be enabled through the lite editor as shown below. 
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The Employee History program also has the employee package and salary frequency, just like the 
Employee Profile. These fields can be added from the lite editor as shown below. 
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Implementation 

The following example shows an employee with elected benefits from HR. This is the standalone 
program showing benefits that are included as part of the package and benefits that are not part of 
the package.  
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The same can be viewed from the Employee Profile.  
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New Employee Leave Encashment Utility to “Cash” the Leave 
Amount (21.51518/HCM-472) 

Overview 

CMIC developed a new utility that can be run prior to payroll processing for the period to determine 
how many employees’ yearly leave cycles have been completed and how much leave encashment 
the employee is due. The utility checks if the employee anniversary date falls in the period entered on 
the header and only displays the balances of those employees in the detail section.  

NOTE: This functionality is available for US Payroll and International Payroll. 

Pre-requisites 

1) Alternate workdays should be set to 7 working days as per Dubai region. 

 

2) The employee must have worked for a year. If they did not use their leaves then the new utility 
will pay the employee, the leave days in cash. 

Modifications 

 The new utility will allow users to select all employees who have a remaining balance. 

 The user will select all employees who have been selected to encash the leave amount. 

Once employees have been selected, the [Submit] button will insert the data into the adjustment 
table. The popup will be displayed for all users allowed to choose the pay year and period for leave 
processing. The popup will default the current open period for the company and pay run from the 
header. The utility will insert the data into the payroll adjustment table with the leave encashment box 
checked. 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  1687 

The data can be reviewed by the user and adjusted if needed once verified in the Adjustment screen. 

 

 

Implementation 

An example of employee encashment is given below for when an employee doesn’t use all of their 
yearly vacation days. 

Checks are printed for 12 months. 
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Employee leave encashment program and check the box (include flag) for the employee: 
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Select the period where this employee was last paid and click on [Accept/Process]. 

 

 

 

The employee encashment information will be transferred to the Adjustment screen where it can be 
reviewed. 
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Unpaid Leave Calculation - New Setup Screen Created for the 
Existing Work Status Field in the Employee Profile Screen 
(22.52534/HCM-471) 

Overview 

CMIC has created a new setup screen for the existing Work Status field in the Employee Profile 
screen. When an employee is on unpaid leave, they receive no paid wages or allowances. The new 
setup screen will allow users to put an employee on permanent unpaid leave for a longer period 
instead of entering unpaid leave timesheets. The employee can be active but on an unpaid leave for 
as long as required. 
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NOTE: This functionality is available for US Payroll and International Payroll. 

Pre-requisites 

Before changing the work status for the employee, create a new “Inactive” work status.  

 The “N” code has the ‘Active Status’ box unchecked. 

 The “W” code cannot be changed as it is system defined. 

 

Modifications 

The work status code can be up to 4-characters. 

These codes can be used in employee profile.  

The processing has been modified to look up the new “Active” status from the setup table for work 
status. If the work status has an unchecked status flag, then it will not be included for processing. 

NOTE: Timesheet entry will be modified in the next patches to warn users if the employee work status 
is inactive. 
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Implementation 

 

Above is an example of an employee with an inactive work status. 

Below shows that the Employee History work status is in sync with the Employee Profile. 
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Shown above is an entered timesheet for the month for the inactive employee and processed payroll. 

NOTE: A warning on timesheet will be added in the next patch 
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An amount of 0 pay is shown below as the employee is inactive for the period. The employee will 
receive 0 funds. 

 
 

US payroll includes the same modification. 

Testcase #1: Employee with an inactive status. 
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The inactive employee has benefits which do not show on mid year pay history even though the 
exclude without wages box is not checked. 
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The employee is processed without a timesheet. 

 

Nothing is being processed as the employee is inactive for the period. 
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Testcase # 2: Employee with an active work status. 

 

Payroll process will process this status as the employee is active. 
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Leave Accruals - Job Allocation checkbox added to the Master 
Leave Setup (22.52955/HCM-472) 

Overview 

Some leaves are accrued in a certain region and must be charged to the job. The leave accrual must 
also accrue based on worked hours in a period for salaried employees. The worked hours are paid 
wage hours and not the timesheets hours. To enable this, CMIC has added a new Job Allocation 
checkbox on the Master Leave Setup. 

NOTE: This functionality is available for US Payroll and International Payroll. 

Pre-requisites 

1) Alternate Work Days should be set to 7 working days as per Dubai region working days. 
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2) Job allocation flag should be added from the lite editor and checked. 

 

Modifications 

The Job Allocation checkbox is only enabled when the accrued box is checked. The payroll 
processing has been modified to allocate the accrued leave on jobs similar to other burdens. Accrual 
must be allocated to the job charged on leaves only. 

 

Implementation 

The following are examples of how this functionality is used. 
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JOB1 
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JOB2 
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Before printing checks: 
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Employee leave after printing check for period 1. 
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Employee Leave Details – Accrued Leave on the Job/Cost Code and Category 
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ALEC01 Job Accrued based on the Formula as under: Leave Hours Accrued = Working Days * 
(Yearly Eligible Hours/12 Months) / 31 (days in month of January). 

18 Working Days * (240 Eligible Hours/12 Months = 20 Hours) / 31 days for the month of January = 
11.61 Hours Accrued 

ALEC02 Job Accrued based on the Formula as under: 

13 Working Days * (240 Eligible Hours/12 Months = 20 Hours) / 31 days for the month of January = 
8.387 Hours Accrued (rounded to 8.39) 

PERIOD 2: 18 DAYS OF ALEC01 JOB AND 10 DAYS OF ALEC02 JOB 

ALEC01 = 18 Working Days * (240 Eligible Hours/12 Months = 20 Hours) / 28 days for the month of 
January = 12.86 Hours Accrued 

ALEC02 = 10 Working Days * (240 Eligible Hours/12 Months = 20 Hours) / 28 days for the month of 
January = 7.14 Hours Accrued  

 
 

PERIOD 3: 18 DAYS OF ALEC01 JOB AND 13 DAYS OF ALEC02 JOB 

ALEC01= 18 Working Days * (240 Eligible Hours/12 Months = 20 Hours) / 31 days for the month of 
January = 11.61 Hours Accrued 
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ALEC02= 13 Working Days * (240 Eligible Hours/12 Months = 20 Hours) / 31 days for the month of 
January = 8.387 Hours Accrued (rounded to 8.39) 

 

 

PERIOD 4: 18 DAYS OF ALEC01 JOB AND 12 DAYS OF ALEC02 JOB 

ALEC01= 18 Working Days * (240 Eligible Hours/12 Months = 20 Hours) / 30 days for the month of 
January = 12 Hours Accrued 

ALEC02= 12 Working Days * (240 Eligible Hours/12 Months = 20 Hours) / 30 days for the month of 
January = 8 Hours Accrued (rounded to 8.39) 

 

 

Test Case 2 – Timesheet entry with Leave code taken against ‘G’ line in the next period against the 
accrued job leaves. 

Leave – Other hour type JL2 is entered as a ‘G’ Line in timesheet entry screen 
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TESTCASE #3: G Lines for JL1 (Partial leave package) and JL3 (Base wage) 

JL1 EXCLUDES FOOD: 
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Preventative Maintenance 

Ability to Import Quick Inventory Issue to Equipment for Multiple 
Warehouse (19.89834) 

Ability to import quick inventory issue to equipment for multiple warehouse. 

Modifications 

• Program added to Asset Management > Preventive Measure > Utilities > PRM Quick 
Inventory Issue to Equipment 

• Inventory from multiple warehouse can be issue to equipment. 

Control File Format 

Column 
Name 

Screen 
Prompt 

Description Required Type Length 

C_01 Comp 
Inventory company issuing 
the item. This must be a 
valid CMiC company code. 

Yes Char 8 

C_02 
Item Class 
Code 

Item class code issued.  
This must be a valid item 
class code for the 
inventory company. 

Yes Char  

C_03 Item Code 
Item code issued. This 
must be a valid item for 
the inventory company. 

Yes Char 16 

C_04 Item Type 
Valid item type code. This 
must be a valid type for 
the item/company. 

Yes Char 2 

C_05 
Location of 
Issue 

Location issued from.  This 
must be a valid 
warehouse/bin location 
with enough stock on hand 
of the item. 

Yes Char 7 

C_06 WM Code Weight Measure Code Yes   

C_07 
Transaction 
Date 

Actual date of the issue in 
the format of 
MM/DD/YYYY. 

Yes Date  

C_08 
Equipment 
Code 

Valid equipment code to 
which inventory is issued. 

Yes   

C_09 
Transaction 
Quantity 

Quantity issued in WM 
code previously declared. 

Yes Num 16,8 
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The following screen shows the modifications. 

 

Asset Management > Preventive Maintenance > Utilities > PRM Quick Issue Inventory to Equipment 

Example 

• Added program in Asset Management > Preventive Maintenance > Utilities > PRM Quick Inventory 
Issue to Equipment 

 

Asset Management > Preventive Maintenance > Utilities > PRM Quick Issue Inventory to Equipment 

• Click on [Import File] button to import the file. 
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Asset Management > Preventive Maintenance > Utilities > PRM Quick Issue Inventory to Equipment 

• Dialog box opens, click on browse to select the import file.  

 

Asset Management > Preventive Maintenance > Utilities > PRM Quick Issue Inventory to Equipment 

• Select the file to import and click on Open. 

• Click on [Import] to import the selected file. 

 

Asset Management > Preventive Maintenance > Utilities > PRM Quick Issue Inventory to Equipment 

• After successfully importing file, a message is displayed with total records inserted. 
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Asset Management > Preventive Maintenance > Utilities > PRM Quick Issue Inventory to Equipment 

• Click on [Close] to close the Import File pop-up. 

• After importing the file, click on [Validate Imported Data] to validate the records, this will enable the 
rest of the buttons on screen. 

 

Asset Management > Preventive Maintenance > Utilities > PRM Quick Issue Inventory to Equipment 

 

Asset Management > Preventive Maintenance > Utilities > PRM Quick Issue Inventory to Equipment 

Message box displays the number of imported records, and the imported data is valid or invalid. 

• Click on [Edit Imported Data] to edit the data and verify errors. 

 

Asset Management > Preventive Maintenance > Utilities > PRM Quick Issue Inventory to Equipment 
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Pop-up screen is displayed to edit the imported data.  

[Validate All Records]: Check, if all the records need to be verified.  

[Re-Validate]: Click the button to re-validate record(s). 

[Close]: Click on close button to close the pop-up screen. 

 

Asset Management > Preventive Maintenance > Utilities > PRM Quick Issue Inventory to Equipment 

[More Errors]: Clicking the button opens a pop-up display showing more information on any error 
imported data. 

 

Asset Management > Preventive Maintenance > Utilities > PRM Quick Issue Inventory to Equipment 

[Delete Imported Data]: An alert message box id displayed to confirm the deletion of records. 

 

Asset Management > Preventive Maintenance > Utilities > PRM Quick Issue Inventory to Equipment 
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Click [Yes] to delete all the records and [Cancel] to abort the process. 

• [Create Transaction]: Click on create transaction button to create unposted transactions for the 
imported data. ‘Issue to Equipment creation was successful’ message is displayed in the message 
box when unposted transactions are created. 

• Unposted transactions are created in Inventory > Processing > Issue Without Requisition program. 

 

Asset Management > Inventory > Processing > Issue Without Requisition 

• Unposted batches are created depending upon the warehouse locations. 

 

Asset Management > Inventory > Processing > Issue Without Requisition 

• Records in the batch are identified depending upon the warehouse location.  
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Asset Management > Inventory > Processing > Issue Without Requisition 

 

Asset Management > Inventory > Processing > Issue Without Requisition 

 

Reports: 
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Purchase Order 

Add the column “Item Description” in PO Job Query (15.13574) 

CMiC has modified the PO Job Query Screen and added: 

1. The button [Query] in the Selection Criteria section of the PO Query by Job;   
2. Three new columns named "Item Name", “Requisition Number”’, and “Requisition Date” in the 

Detail Block of the Purchase Order Query by Job.  
 

These new columns will display Inventory Items, Non-Stock Items and Free Form Items entered on 
the Purchase Orders. All fields in the Detail section including the newly created columns will be 
populated upon pressing the new button Query that initiates the PO query based on the Selection 
Criteria.  

 

 
 

Setting and Examples: 
1. In order to see all existing Purchase Orders (POs) with “J” distribution for the company the fields Job 

and Item Code should be left blank. The user has to press button [Query] initiate the query and to 

populate the  Detail section: 
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Note:  When the Detail section is already populated then checking/unchecking the boxes “Include Closed PO” 
and/or “Include Voided POs” will automatically add/remove the qualified records – the user does not have to 
press the [Query] button again.  
 

2. If the user would like to narrow down the POs for the specific Job then the Job code has to be 

entered (chosen from LOV) and [Query] button clicked: 

 
 

3. If the user would like to narrow down the POs for the specific Item Code then the user has to enter 

Item Code (choose from LOV) and press [Query] button: 
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4. To see the POs for the particular item and particular Job both fields Job and Item Code should be 

populated; than the button [Query] should be clicked: 

 
 

Modifications: 
 

1. Now the user will be able to search the POs by Item Code in addition to pre-existing ability to search 

POs by Job. 

2. The user will be able to see the corresponding Item Name, Requisition Number and Date (if exist) for 

the each Purchase Order Item. 

3. The new button [Query] has to be pressed in order to initiate the query and subsequently populate the 

Detail section of the screen.  

Purchase Order Import (Custom) (19.87822)  

An export file created from a third-party application (Rubber Stamp) will be uploaded into CMiC PO 
application. This import will update the Purchase Order Tables so that, the PO with the details is 
created, posted and the JC commitments are updated. 
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Ability to Use Job PO Mask while Copying PO (20.25669) 

Overview 

This enhancement provides ability to use Job PO number mask upon using Copy From feature in PO 
Entry screen.  

Pre-requisites 

PO control file must have Job PO Number Mask setup and Auto Number Flag should be checked. 
New fields are only enabled when user is copying from a PO which has Job Code associated with it. 

Modifications 

New fields introduced in Copy Purchase Order screen.  

To Job: Select a job from LOV to which needs to be associated to new PO. 
To Cost Code: This field is only enabled once user select job in To Job field. User must select valid 
cost code for the job.  
To Category: This field is only enabled once user select job from To Job field. User must select valid 
category for the cost code.  
 

 

Purchase Order > Process > Enter Purchase Order > [Cope From] – Copy Purchase Order pop-up 

Implementation 

Comp: CCC 
Job PO Number Mask: POjjjj**** 
Job Code: FCATJOB 
PO: POFCAT00001 

Use [Copy From] to copy POFCAT00001 to a new PO.  
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Purchase Order > Process > Enter Purchase Order  

Select job from To Job LOV.  

 

Purchase Order > Process > Enter Purchase Order > [Copy From] – Copy Purchase Order pop-up 

Once user selects a job, To Cost Code and To Category fields are enabled.  
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Purchase Order > Process > Enter Purchase Order > [Copy From] – Copy Purchase Order pop-up 

Select valid cost code and category for the selected job.  

Click on [ACCEPT] to create a new PO which will follow Job PO Number Mask setup in control file. In 
PO number, the ‘j’ will use the new job selected from To Job field.  

 

Purchase Order > Process > Enter Purchase Order > [Copy From] – Copy Purchase Order pop-up 
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The new PO number generated is POJOB-00001. 

 

Purchase Order > Process > Enter Purchase Order  

PO Control – A Checkbox "Populate Item Description to Item 
Comments" Added (21.40253) 

Overview: 

The new feature is to populate Item Description to PO/POCO detail line comments field while entering 
a PO (without pass through a requisition) for a non-stock item. 

Modifications: 

The following are the changes made to two of the programs POCTRLFM and POENTRYC. 

Added Checkbox "Populate item description to Item Comments" on PO control file (POCTRLFM). 

PO/POCO entry program (POENTRYC) modified to add item description field on item LOV, to 
populate item description to PO/POCO detail line comments field based on the new flag. 

The New Flag "Populate item description to Item Comments" added in PO Control File is unchecked 
and hidden by default. User needs to add it through the Lite Editor. 

When the Flag is unchecked as shown below, while entering a PO through Enter Purchase Order 
program, in the Purchase Order Detail, the Comments field does not automatically pull the data from 
Non-Stock item program’s description field. 
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Asset Management> Purchase Order > Local Tables> Control 

 

 

Asset Management> Purchase Order > Process> Enter Purchase order 

 

When the Flag is Checked in Control File as shown below, while entering a PO through Enter 
Purchase Order program, in the Purchase Order Detail, the Comments field does automatically pull 
the data from Non-Stock item program’s description field. 
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Asset Management> Purchase Order > Local Tables> Control 

 

 

Asset Management> Purchase Order > Process> Enter Purchase order 

The data in the PO Detail Comments field is pulled from Non-Stock item program’s description field. 
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Asset Management> Requisitions> Setup> Non-Stock Item 

Lot/Lumpsum POs (20.31584) 

Overview: 

Often a supplier will provide a ‘lot’ price for material, comprising dozens or hundreds of items, rather 
than price each item individually. This is especially true for specialty fixtures comprised of many 
separately sourced, delivered, and invoiced components. 

We want to record the lump sum amount as the first PO line item (e.g., the complete fixture cost), 
followed by the individual components with quantities but no amounts. Moreover, some of the 
components are often supplied by a third party other than the original supplier, which is why there are 
usually several receipts and invoices for the PO.  

We want the ability to receive the quantities against the actual PO line items, but invoice against the 
lump sum PO line, so invoicing is effectively based on the invoice amount rather than invoiced 
quantities.  

To summarize the requirement, we want the ability to have multiple lump sum PO lines in a PO, and 
multiple receipts and invoices against a lump sum line. 

 

Modifications: 

The following changes have been made in Purchase Order and Accounts Payable applications to 
fulfil the business requirement:  

 

PO Control File: 

A WM code needs to be setup for Lumpsum PO’s. The defined WM on the control file when selected 
will default the Price to 1. The Price field In Enter Purchase Order program becomes disabled and 
Quantity is enabled for entry. 

Users must set up the default weight measure code in Purchase Order Control > Purchase Order 
Defaults. 
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‘WM Code to Receive in Dollars’ field value is set to $. 

 

Purchase Order>Setup>Local Tables>Control 

Purchase Order Header: 

• A new flag ‘Lumpsum Purchase Order’ is added on the PO Header. This flag is hidden by default 
and can be made visible using the Lite Editor. The default value is un-checked. 

• This will default the ‘WM code to Receive in Dollars’ from the control file setup. 

• If flag is selected on the header at least one detail line needs to be flagged as Lump sum.  

 

 

 

Purchase Order>Process>Enter Purchase Order 
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Purchase Order Detail: 

• New flag for Lumpsum line is displayed on the PO detail block. 

• When the flag is enabled, Item Type will default to FREE FORM and default the WM defined on 
Control file.   

 

Purchase Order>Process>Enter Purchase Order 

 

• The Allocation Button is used to enter all the sub-items associated to the Lump sum price entered 
creating a hierarchy. 
Note: Multiple Lump sum lines can be entered. Each line will have allocations specifying the sub-
items that are associated to the Lump sum line. 

• Allocation pop-up window will hold all sub-items associated with the lumpsum line. 

• New columns marked in RED namely Item Type, Item and Item name is added to the allocation 
window. This will be available for Lumpsum PO only. 

• Order quantity is the actual receiving quantity, at the time of PO Shipment receiving. The 
expected price amount will be 0 for the allocated items. 

• Distribution type and other details is taken from the PO Detail line, and it cannot be modified. 

• For Lumpsum Purchase Order the cost will be generated at the time of invoice posting. 
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Purchase Order>Process>Enter Purchase Order 

NOTE: Tax will be used/specified on Lump sum line only. Lump sum amount will be a pre-tax 
amount. 

Change Order Detail: 

The same changes as PO program will be applicable here. While posting the Change orders the PO 
Details will be updated. 

 

Receipt Entry: 

The lumpsum line will not be included in the Received items block. A new field ‘Lump sum Reference’ 
will be available and needs to be added via the Lite Editor. It provides the reference of the lumpsum 
line to the sub-item.  

 

 

Purchase Order>Receipts>Enter Warehouse Receipt 
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NOTE: You cannot receive both a lumpsum PO and a regular PO together. A validation will be 
issued. 

 

Purchase Order>Receipts>Enter Warehouse Receipt 

 

AP Enter Voucher 

 

• New checkbox Lump sum PO is added. This flag is hidden and can be brought up by Lite Editor. By default, it 

will be unchecked.  

• If this flag is checked, only lump sum PO will be visible in Purchase Order Selection 

 

Accounts Payable>Vouchers>Enter Vouchers 

 

• In the PO Detail pop-up, the lumpsum lines is visible along with its allocated sub-items. 
The Lump sum line is visible in a different color. 

• The invoice amount will be recorded only against the lumpsum line items. 
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Accounts Payable>Vouchers>Enter Vouchers>PO Selection screen 

 

NOTE: If using tax, Invoice amount will be a pre-tax amount and tax will be created on invoice 
amount. User would have an option to override the tax amount.  

 

 

AP Registered Invoice Entry 

• The program ‘Register Invoices’ is modified to carry over the lump sum details to voucher. 

• New checkbox Lump sum PO is added. This flag is hidden and can be brought up by Lite Editor. 
By default, it will be unchecked.  
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Accounts Payable>Vouchers>Register Invoices 

Unit Price added in Enter Job Receipt program (21.49621) 

Unit Price added in the Enter Job Receipt program 

Functionality Design: 

In the PO Job Receipt program (POJOBREC) a new display column is added on detail level to show 
the Unit Price ( POS_EXPTD_PRICE_AMT ) from PO detail for the receiving item. There is no 
calculation, just display only. 

By default, this field will be hidden, user will have to make this new field visible through lite editor. 

Modification Details with Examples: 

Through lite Editor User can add the new field ‘Expected Price’ and click on Save. 
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The New field ‘Expected Price’ is visible now. 

 
 

Purchase Order Entry – Changes to Detail Entry & Save (22.57797) 

 
PO Header to be Saved before entering PO Detail lines 

Modifications: 
o Purchase Order entry program is modified to use SAVE button before entering PO detail 

lines.  
o [Insert] and [Insert Multiple] toolbar button will only be visible when purchase order header is 

saved.  
 
Testing: 
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Requisitions 

PO Non-Stock Item Comments Enhancement (20.24491) 

To support longer input for non-stock item description in Requisition application. 

 
1. Requisitions Entry Screen:  

a. When searching for a ‘Non-Stock’ item, users have a new option to search by Description 
in the LOV. 

b. The detail section of the record has a new ‘Comments’ field. When creating a requisition 
detail for a Non-Stock Item, the Non-Stock Item Description will be auto populated from 
Non-Stock maintenance screen. Users may update the comments as needed.  

2. When creating a Purchase Order from a requisition, the comments field value will also be carried 
over to the PO.  
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Following screens show the modifications performed: 

New Search option to search by Description in the Item Code LOV. This populates in case of Non-
Stock item type only. 

 

Description column is populated from Description on non-stock item (Requisitions → Setup → Non-
Stock Item, screenshot below): 

 

Description from the above LOV is populated in the Comments field on Requisition Details and is 
editable for the user to input any additional information: 

 

When PO is created from requisition, the comments above populates on the Purchase Order Detail: 
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Requisition Entry – Inventory Item Code LOV Changes (21.36849) 

Overview: 

Added the ability to select the inventory item without selecting the class code and added duplicate 
functionality in ‘Requisition Entry’ program. 

Modifications: 

The following are the changes to Requisition entry program (PORQENTC).  

 
1. Item code LOV is modified to show the item codes even though class code is not specified. Class 

code is back filled which is associated with the selected item. 

If the class code is specified, then item code LOV is filtered and will show only those item codes 

which are associated with the specified class code.  

2. Added a Toolbar button [Duplicate Record] that allows user to copy data from the previous 

record into the new record. The record is duplicated with all column values except the ‘Quantity’ 

column. User must enter a quantity and ‘Save’. 

 

 
Project Controls> Asset Management > Requisitions> Enter Requisitions 
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Project Controls> Asset Management > Requisitions> Enter Requisitions 

 

 

Project Controls> Asset Management > Requisitions> Enter Requisitions 

Resource Planning 

This section is currently under development. 

Scheduling 2.0 

Earned Value Management - Beta (19.78641/PC-141) 

Overview 
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The Earned Value Management program is being developed to monitor and report on Planned vs 
Actual quantities and units for a project to see if it is on track. 

Earned Value Management identifies how much of the budget and time should have been spent, 
considering the amount of work done so far for self-performed projects. 

 

Setup 

The standard CMiC JSP security procedures apply. 

Program Features 

CMiC is releasing some of the development of the Earned Value Management (aka Project Planner) 
in Patch V12-013-1: 

 Activity Cost Details  

 Activity Cost Mapping  

 Related Reports   
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Activity Cost Details Planning 

The Activity Cost Details program provides the structure for defining the Planned Value (PV) to create 
a budget. The planned units for schedule activities are associated with CMiC Cost Codes via the 
Activity Cost Mapping. 

It spans the activity from its start to finish dates. 

Planned units are tracked on the user’s selection of daily, weekly, or monthly periods. 

 

The Actuals come from the following sources (and are based on the mappings): 

• CMiC E-Time: Timesheet entry and Crew Time Entry 

• Mobile Crew Time: Phase Quantity 

• Project Management: Daily Journal Units Complete Tab 

• Mobile Field: Daily Journal Units Complete Tab 

• Job Costing: Phase Quantity Completion  

 

Breakdown 

Daily – used to plan out units and hours for each day within a date range. 

Weekly – used to plan units and hours weekly. The units and hours entered in the weekly view is 
stored on the last day of the week from the project calendar. 

Monthly – used to plan out units and hours by months. Progress captured during the month is stored 
against the last business day of the month as per the activity calendar. 

Use the [Update View] button to update the details on the screen to the selected view after selecting 
the Breakdown. 
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Planned dollars/budget    = Hour Rate * Planned Hours 

  indicates that the Actual figures have been manually entered 

 

 

Position the cursor in the yellow field to see the Actual value (if any) from the posted transactions: 
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Activity Cost Mapping 

Schedule Activities are mapped to Cost Codes so that Actuals posted in the CMiC applications can 
be brought in for comparative analysis with Planned. 

Activity Cost Mapping is used to map schedule activities to combinations of job, cost code, category, 
and WBS codes.  

The units, hours, and amounts posted rolls into the Activity on the Activity Cost Details screen. 

 

• An Activity can be mapped to a Cost Code 
• Multiple Activities can be mapped to a single Cost Code 

• An Activity can be mapped to multiple Cost Codes 

 

Examples: 
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Report Samples 

Progress Report 

 

 

Additional Reports 
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Calculations 

Example: 

Currently for Week Oct 14-20, 2019 the graph shows: 

Earned = 2.813k 

Actual = 3.780k 

Planned = 2.500k 

 

 
 

The calculation of the Earned Value is verified below: 

 

 
 
Total Budgeted Cost = Budgeted Output Units / Budgeted Productivity * Budget Input Rate 
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 TBC = 4000/100*25 = 1000 
 
Budget Cost of Work Performed = Current Output Units / Budgeted Productivity * Budget Input Rate 
 BCWP = 4500/100*25 = 1125 
 
Actual Cost of Work Performed = Current Output Units / Current Productivity * Current Input Rate 
 ACWP = 4500/80*25 = 1406.25 
 
Forecast = Forecast Output Units / Current Productivity * Current Input Rate 
 Forecast = 4000/80*25 = 1250 
 
Earned Value Percentage = Actual Cost of Work Performed / Forecast 
 EVP = 1406.25/1250 = 1.125 
 
Earned Revenue = Contract Amount * Earned Value Percentage 
 EV = 2500*1.125 = 2812.5 = 2813 (rounded) = 2.813K 
 

Subcontract Management  

Add Column Vendor Name to Change Compliance Form 
(SCTABCOM) (15.12602) 

Overview: 

Change Compliance Status form is modified with addition of Vendor Name Column under each tab. 

Modifications: 

The Vendor Name column is added to each tab in SCTABCOM.FMX form. User can query the data 
based on vendor name. Vendor name column is added under every tab.  
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Subcontract Management>Status. Change Compliance Status 

Subcontract Related Queries conversion into ADF (15.13413) 

Converted the following queries from oracle forms version to ADF. 

1. Executive Query by Vendor 

2. SC Compliance Summary Query 

3. SC Compliance Detail Query 

 

 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  1757 

 

 

SC Control - PwP with ‘Invoiced Via Accounts Payable’ (14.94773) 

An enhancement has been made to ensure that the Pay When Paid (PwP) flag can remain checked 
when a subcontract is created and the user selects ‘Invoiced via Accounts Payable’.  Prior to this 
enhancement, the PwP flag was getting un-checked (after being previously checked in the SC 
Control as a default) if the user selected ‘Invoiced Via Accounts Payable’ when creating a 
subcontract. 

To achieve this, an additional checkbox has been introduced in the SC Control (FORMS and ADF), 
and the original checkbox has been re-labelled to distinguish the one used for SC and the one used 
for AP:    
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Insurance Bonding Companies – UE Fields (19.81491) 

Enabled the ability to add custom or pre-defined fields (User Defined) to the Insurance/Bonding 
Companies Program. 
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SC Compliance Import (18.64708) 

Added the ability to import Subcontract Compliance using the ‘Import’ tool button.  
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This is a Standard CMiC Import functionality as available in other programs, where users will be able 
to download a ‘csv’ template and then upload the file with data or copy/paste the data from MS Excel. 

 

 

Print Certificate of Payment – Vendor Name Column (19.91829) 

The Print Certificate of Payments program has been modified. A column ‘Vendor name’ has been 
added to the right-hand side of the ‘Vendor Code’ column. Users can reorder columns as per the 
CMIC standard program tools. 
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Subcontract Import Program (19.86361) 

The program will read data from a txt or csv file and then will insert into import tables to validate the 
data. Once the data is validated then the data will be processed and inserted into tables SCMAST 
and SCDETAIL and then will be posted. 

Import file: sc_import.ct 
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Subcontract Import  

 
 

You can click on the “Edit Imported Data” button to review the data and correct if needed: 

 
 

Once data is corrected then press on “Re-Validate” button to re validate a specific record or click on 
“Validate All” flag and then “Re-Validate” button to re validate all records. The Valid field must be Y if 
the data is correct: 
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Close the Imported Data pop-up and then click on “Process Imported Data” button to import the valid 
Subcontracts: 

 
 

If all records were imported successfully and posted successfully then a message in blue will appear 
on the screen. 

 

Please note the following: 

1. Auto numbering for the contract cannot be used. Contract must be provided in the import file. 

2. Completed amount and current amount will always be 0. Because there is no supporting document 
to set them up. 

3. Cannot import subcontract linked to PCI. Subcontract imported not created through change order. 

4. The import file has fields from SCMAST and SOV. Import support one file only. 

5. The utility will have (Import, Validate and Post). 

6. Completed amount, current amount, % of completion cannot be imported.  

7. This work order excludes the following items: Reports, Workflows, Data Conversion. 

 

Add a Column “Entered Amount” to SC Queries (19.86979) 

Added column “Entered Amount” to the following programs: 

Subcontract Executive Query by Job (SCEXQRYJ) 
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Subcontract Executive Query by Vendor (SCEXQRYV) 

 

 

 



Working Document R12 New Functionality R12 New Functionality (Draft)  •  1767 

Pay Request Entry – Save and New Button (18.66928) 

Added [Save and New] button to the request For Payment Entry program. 

Similar to the Voucher Entry screen, the Pay Request Entry is added with a [Save and New] button, 
which saves the record and then clears the screen for insert mode for a creating a new record. 

 

Subcontract > Payments > Enter Request For Payment 
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Change Order Entry > Import Button Added (19.80821) 

Added [Import] button to the SC Change Order Detail Block.  

 

 

Change Compliance Status – Ability to Hide Tabs (20.30292) 

Added the ability to hide the tabs in Change Compliance Status screen using Lite Editor. 
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Compliance Pop-Up – Added Notes Button (20.29196) 

Added [Notes] button to Compliance pop-up screen (INSINFO). Users may click on any compliance 
record in the details block and add notes as a CMiC standard Notes functionality.  

The program can be called from either AP or SC applications and all these calls will have this Notes 
button. 
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Print Certificate of Payment (SC320_3) (19.90687) 

Added the ability to reprint the certificate of Payment report SC320, once the RFP is posted. 

This allows users to re-print the reports after RFPs are posted, if required for backup. 

Modifications: 

Created a new Report SC320_3 based on SC320 (Certificate of Payment) Report. This report will run 
as standalone and not from the Print Certificate Payment Screen. The Report parameters as follows: 

o Company 

o Job 

o SC Contract Code 

o From Vendor 

o To Vendor 

o Posting Status: Posted, Unposted or Both 

o From Invoice Code 

o To Invoice Code 

The report will print the same columns as in the existing Print Certificate of Payment SC320, but the 
data is based on the selected invoice(s) regardless of newer invoices (RFPs). 
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Creation of Stored Materials in RFP Screen (19.86625) 

The feature is to incorporate and process Stored Material information when entering Request for 
Payments. Stored Materials allows subcontractor to bill for an amount of material that is not yet used 
on the project. 

Material Stored Is Only Applicable to Subcontracts Invoiced via SC. 



1772  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

 

 

Modifications 
1. Enter Request for Payments (SCPAYREQ): 

The following new columns have been added to ‘Request for Payments’ screen in SOV detail and 
Amount Summary Tab:  

• Current Material Stored Amt: Identifies Material Stored on the current RFP 

• Previous Material Stored Amt: The total of previously posted Material Stored amounts.  

Corresponding fields have been added to the screen under ‘Amount Summary’ tab that indicates total 
amounts of the above columns at the Subcontract level. 
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2. Prepare Billing (JBBILL): 

New columns ‘Override Material Stored’ and ‘MS Ovr’ have been added to Billing Details section. 
Existing ‘Material Stored’ column has been disabled to be consistent with other overrides columns 
and holds the same functionality. 
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When user overrides Material Stored, followed by ‘Recalc Notification’ message and ‘ReCalc Billings’, 
the colored columns ‘Override Material Stored’ and ‘MS Ovr’ with letter ‘O’ indicate that the Material 
Stored Amount has been overridden. 

 
 
3. G/C Prepare Billing (JBBILL2): 

New columns ‘Override Material Stored’ and ‘MS Ovr’ have been added to ‘Group 1 Summary’ to 
‘Group 5 Summary’ and ‘Bill Code Detail’ Tabs. ‘Override Material Stored’ column is hidden in all tabs 
to be consistent with other overrides columns and holds the same functionality. 
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A new button called ‘Clear Material Stored Override’ has been added to Summary and ‘Bill Code 
Detail’ Tabs to clear MS Override Amounts and restore the calculated ones.  
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4. Cost Transaction pop-up (JBBILLTRANS): 

A new column has been added to Cost Transaction pop-up screen that indicates Material Stored Amt 
on the Cost level of the associated Billing Detail line. The column is display only and cannot be 
updated. 
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SC Revised Amount Viewable in Table Mode-R12(20.25430) 

Overview: 

A ‘Current Amt’ field is now made available in the Table mode of Lite Editor in Subcontract Entry 
program. 

Modifications: 

Added a field ‘Current Amt’ in the Lite Editor > Table mode, that contains the current SC amount 
including the change order amounts. 

To add this column in the table mode the user needs to add it using Lite Editor. 

Lite Editor       Table Mode       Current Amt column under Fields available       Move       Save. 

After refreshing the screen, the current Amount (SC Revised amount) column will be viewable in table 
mode. 

Screen Prints: 
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"Delete" Button Added to the Tool Bar in Modify Original Contract 
(21.41899) 

Added "Delete" button to the tool bar in Modify Original Contract program. 

 
Modifications: 

Added a “Delete” button to the Schedule of values and enabled the button for newly created records. 

For existing records, “Delete” button will be disabled.  

Users will be able to delete the newly created records up to moment when contract is posted. Once 
the contract is posted, records will have the “Delete” button disabled. 

 
Modify Original Contract setup: 
 
‘DELETE’ button disabled for existing SOV lines. 
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SC Utilities>Modify Original Contract 

Insert a new SOV Line. ‘DELETE’ button enabled. 
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Post the newly added line. ‘Delete’ button is now disabled again. 

 

 

Control Contract Amount Field on Modify Original Contract Screen 
(20.26264) 

Modified the Modify Original Contract screen to add field SC Control Contract Amount. 

Pre-requisites 

Control Contract Amount is set up in PMJSP Subcontract Entry. 

Modifications 

- The field Control Contract Amount will be hidden by default; user will add it manually to the screen. 

- The field is disabled, and the amount is only applicable to base contract. 

-  At posting, the total amount of SOV should match with Control Contract Amount (if the amount 
exists). If not match, system shows error message. 
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New Column ‘Insurance Exp date’ Added to SC Compliance Report 
(21.44955) 

Add new column 'Insurance Exp date' to SC Compliance Report (SCCOMPLREP). 

Modifications: 

New column ‘Insurance Exp date' added to SC Compliance Report (SCCOMPLREP). 
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New Reverse/Calculate Checkbox Added in Reverse/Calculate CDI 
Program (21.44792) 

Overview: 

Fix is provided so that when the user filters the data in the Reverse/Calculate CDI Charges program, 
the charges are reversed/calculated only for the filtered jobs and not for all jobs. 

Modifications: 

The program has been modified so that the user will now be able to select the job by using the 
Reverse/Calculate checkboxes available at the top in the header.  

The buttons Select All/Unselect All calculate, and Select All/Unselect All Reverse is no longer 
available 
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Screen Prints: 

Reverse/Calculate Checkboxes: 

 

 

Filtering data and Calculating: 
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Filtering Data and Reversing: 
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New Flag 'Include Taxes In Invoice Amount' Added to SC310 Report 
Parameters (21.39540) 

A new flag ‘Include Taxes In Invoice Amount’ has been added in the report parameters for SC310 
to hide/show invoice taxes. 

Modifications: 

The program has been modified so that the report parameters for SC310 will now have a new flag  

‘Include Taxes In Invoice Amount’ 

If this flag is set to ‘Include Taxes’ while printing the SC310 report, the report will include the taxes in 
the invoice amount. 

If this flag is set to ‘Exclude Taxes’ while printing the SC310 report, the report will not include the 
taxes in the invoice amount. 

Screen Prints: 
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SC310 Report Parameters: 
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When the flag is set to ‘Exclude Taxes’, the report did not include the taxes in the invoice amount. 
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When the flag is set to ‘Include Taxes’, the report printed included the taxes in the invoice amount. 

 

 

New SC Lien Waiver (21.44416) 

 
Added new SC Lien Waiver reports for Final and Partial. 
 
Modifications: 
 
Created a new Lien Waiver (SC_LIEN_WAIVER) with fields in the template: 
1. Through_____: is the invoice date 
2. To____: is the Company Name from Maintain Company  
3. Sum of $_____: Populated from the check date, check number, check amount, 
4. Job: Job information from Maintain Job 
5. Following described property: Populated from Maintain Project>Address Tab>Site Address 
6. Lienor: Subcontract Name and address (same as existing template) 
7. All the notary information: Blank 
8. Dated On: Blank 
 
Created a new parameter 'Print Report Version' with below 2 options: 
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1. VERSION1: Prints the current standard waivers. 
2. VERSION2: Prints the new version reports. 
 
Print the SC Lien waiver for the new version ‘Version2’. 
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Control Contract Amount Field added in Modify Original Contract 
Program (21.51285) - Beta version 

 
Warning: When the Control Contract Amount is populated in CMIC Field and posted, the 
clients will no longer be able to modify the SOV amounts via Modify Original Contract program 
in Enterprise. 
 
Implementation is in progress and the fix will be available for next hotfix/patch release. 
 
Overview: 
 
A new field Control Contract amount is added to the Modify Original Contract screen 
 
Modifications: 
 
A field Control Contract Amount is added to the Modify Original Contract screen. 
 

• The field is hidden by default, users may add this field via Lite Editor 

• This defaults the value from Control Contract Amount of the base contract in CMIC Field. 

• When a subcontract is modified via Modify Original Contract in ADF, the total amount of SOV 

should match the Control Contract Amount. If the total amount of SOV does not match the 
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Control Contract Amount, users will not be allowed to proceed with an error message 

displayed. Users must fix the sum of SOV amounts to match the control contract amount. 

Screenshots: 
 

 
 

 
 
If the total amount of SOV does not match the Control Contract Amount, error message is displayed at the 
time of posting. 
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The following error message is shown at the time of posting 
 
The sum of all amounts of SOV (2000.00) is not equal to the Contract Control Amount (1500.95) 
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System Data 

User Maintenance - Create Database User (17.46726) 

The User Maintenance program is modified: 

- a new flag ‘Database User’ was added, which creates database user for FORMS application for 
new users. Default value is unchecked. 

 

 

- a new button ‘Create Database User’ was added, which creates database user for FORMS 
application for existing users. The button is visible only for users with unchecked flag ‘Database 
User’ 
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Ability to Prevent Duplicate Invoice Number Across Same Vendor 
in Different Companies (19.88590) 

Modifications 

• Added a new flag ‘System Wide Unique Vendor and Invoice code on AP’ in ‘Financial’ tab in 
‘System Options’. 

• Default state of flag is ‘Checked’. 

• If user needs previous functionality of duplication invoice number across same vendor in 
different companies, flag should be ‘Unchecked’. 
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The following screen shows the modification performed. 

 

‘System Wide Unique Vendor and Invoice Code on AP’ : When checked, it will prevent duplication of 
invoice number across different company with same vendor. If user wants to use duplicate invoice 
invoice number, this flag must be un-checked. 

Examples 
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Added Privileges to Allow Users to Export and Import Data (20.20106) 

Added a system privilege “UIREXPORT: Allows the user to export data”, which applies explicitly to 
export function button. 

Also, modified the previously existing "UIRIMPEXP" privilege to read as "UIRIMPORT: Allows the 
user to import data” and applies only for the import function button. 

These system security role privileges can be overridden at user level as required. 
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UIRIMPORT privilege: 

Checked:  The [Import] button in the tool bar is available for the user.  
Un-checked:  The [Import] button in the tool bar is hidden. 

UIREXPORT privilege: 

Checked: The [Export] button in the tool bar is available for the user. 
Un-checked: The [Export] button in the tool bar is hidden. 
 

Test Case 1:  

UIRIMPORT: Checked 
UIREXPORT: Un-checked 

 

 

User > User Maintenance > System Privileges  

In the above screen user has privilege only for UIRIMPORT, import button is available for user, where 
as the export button is hidden. 
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GL > Transaction > Enter Transaction  

 

Test Case 2:  

UIRIMPORT: Checked 
UIREXPORT: Checked 
 

 

‘UIRIMPORT’ and ‘UIREXPORT’ privileges are checked for the user 
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GL > Transaction > Enter Transaction 

Both, [Export] and [Import] buttons are available for the user.  
 

Test Case 3:  

UIRIMPORT: Un-checked 
UIREXPORT: Checked 

 

 

‘UIEXPORT’ privilege is checked for the user 

If only the ‘UIEXPORT’ privilege is checked for the user, only export button is available, and the import button is 

hidden for the user.  
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GL > Transaction > Enter Transaction 

‘WELFARGO_4’ File Format for Check Reconciliation (20.21034) 

Create a new Check Reconciliation Comma Delimited CSV file format for Wells Fargo Bank 

Modifications: 

The below fields will be used for Check Reconciliation and must be present in the file. File must only 
contain the paid check transactions only. 

1. Account Number (Bank Account Number) 
2. Serial Number/Reference Number (Cheque Number) 
3. Amount (Cheque Amount) 
4. Posted Date (Paid Date) 

This will be done on V10X and R12 ADF. 

Setting up File Format 

 

AP > Setup>Global Tables > EFT Formats 
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Assign the File Format to the bank. 

 

System Data> Global Tables > Banking> Banks 

 

System Data> Global Tables > Banking> Electronic Reconciliation >Bank Reconciliation 

Sample Bank Reconciliation file: 

 

New Currencies (21.40210) 

The following 4 currencies are added in the Currency table:  

1. Swiss Franc - CHF 

2. Danish Krona - DKK 

3. Swedish Krona - SEK 

4. Norwegian Krona – NOK 



1806  •  R12 New Functionality (Draft) Working Document R12 New Functionality 

 

System Data> Global Tables> Banking> Currencies 

Increased IBAN Number Code Limit (21.40616) 

Increased IBAN number code in the bank code setup from 22 Characters to 34 characters.  

 
Modifications: 

 

System Data> Global Tables> Banking> Bank Account 

French and Spanish Translations – BETA Version (21.37298) 

Overview 

CMiC has released French and Spanish translations for ADF programs (UIRuntime, UIConsole, etc.). 
These two translations were released in patch 14-2 for Cloud and patch 15-1 for Enterprise 
customers. 

The language pack was initially machine translated and we are in the process of reviewing its 
accuracy. Until we have completed this analysis, we will be publishing the language pack as BETA. 
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NOTE: Currently, not all screens support French and Spanish as display languages (e.g. JSP).  

Modifications 

 

Pgm: SDUPREF –User Preferences; standard Treeview path: System > Preferences > User Preferences 

The User Preferences screen in the System Data module is used to define preferences for the 
selected user. 

 

Pop-up window launched from Default Local field 
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The Default Locale field is used to define the display language for ADF software screens (i.e. 
UIRuntime, UIConsole, etc.). By default, this field is set to "en_US" which displays ADF screens in US 
- English. With this enhancement, Spanish and French are now available as base languages, so local 
codes which start with the prefix "es_" (e.g. es_US, es_Spain, etc.) will display in Spanish and local 
codes which start with the prefix "fr_" (e.g. fr_Canada, fr_France, etc.) will display in French. 

NOTE: As soon as 15-1 is installed, users whose Default Locale field is set to anything that starts with 
“es” and “fr” will see all the text on their screens translated to their language. 

 

User Settings pop-up window launched from console 

The default display language can also be set in the User Settings pop-up window launched from the 
user’s console. 
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Implementation 
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Pgm: SDUPREF –User Preferences; standard Treeview path: System > Preferences > User Preferences 

Open the User Preferences screen and click on the Default Locale field to launch the Local Code 
Lists pop-up window, which lists base languages and their associated country-specific variants. 
Select “fr_CA”, which will switch the default display language to "French - Canada" (i.e. the base 
language will be French and the locale will be Canada). Click [OK] to close the window.  

 

 

Click [Save] on the console to save your changes.  
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Click the Refresh icon on the console and in the treeview to refresh the screen and update the default 
display language.  

 

 

Example of Default Locale Set to French – Canada 

The text in the treeview menu and the screen is displayed in French - Canada. 
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ComDataScheduler Job Frequency Update (21.48630) 

 

System Data > Utilities > Scheduler Log 

The ComDataScheduler log displays the details of every run with Date/Time stamp. The default value 
is set at 60 minutes, which means it runs hourly. System Administrators/Database Managers may set 
the frequency to as low as 5 minutes to a maximum of 60 minutes as required. 

 

Scheduler Log – COMDATA Scheduler Enhancement (22.52820) 

The COMDATA Scheduler is now a standalone job dedicated for COMDATA processing to ensure 
uninterrupted running when other jobs such as Thumbnail Generator might interrupt due to high 
volume data. 

This ensures COMDATA Scheduler run at pre-determined frequency un-interrupted so that payment 
processing happens as per schedule. 

 

System Data>Utilities>Scheduler Log >ComDataScheduler 
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System Data>Utilities>Scheduler Log >CMiCScheduler 

COMDATA – Processing Improvements (19.84365-35/36) 

COMDATA Processor is enhanced to skip any invalid files and continue to process the files in the 
folder and successfully import them into CMiC Check preparation program. The Comdata File folder 
on the server would have the invalid files left on the server, and users may review as required. 

 

Toolbars (Screen & Block Toolbar) 
This section is currently under development. 

UI Runtime System Options 

This section is currently under development. 

UI Runtime Enhancements 

This section is currently under development. 

 

Tools 

User Defined Color (skin) selection for UI Console (18.61272) 

CMiC has modified UIConsole, UIRuntime and UILogs2 programs to use the new setting to apply 
color changes. 
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Added the ability to change the application skin color in UIConsole, UIRuntime and UILogs2. By 
default, screen color (theme) will be set at the system level (SYSOPT). If a Default Theme is not 
chosen at the system level and this field is left empty, then the CMiC Default Theme will apply. 

 

It can be overridden at the user level. Click on user name in the the top right-hand corner of screen to 
modify the screen colour in the User Settings pop-up window. 
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Save the new theme and refresh the menu. If a Default Theme is not chosen at the USER level and 
this field is left empty, then the SYSTEM level Default Theme will apply. 
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Addition of New Console Text Field (18.64874) 

CMiC implemented a new Console Text field which can be used instead of a logo image or in addition 
to a logo image. This new field can be found either in System Options under the Logo Path tab or in 
Edit Mode. The text size and font will be the same as the standard CMiC ENTERPRISE console logo. 
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Implementation: 

There are three ways to display console text. 

1. Display console text after the console logo. In this case, the Logo Path field should NOT be null 
as well as the Console Text field. Console text can be defined either from the System Options 
screen or in Edit Mode. 

 

NOTE: Console text added at the system level from the System Options screen can be substituted at 
the user level or group level by clicking on the Edit Mode tab on the console. 
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2. Display only logo if Console Text field is set as “<none>” in Edit Mode. It will suppress the text 
given in System Options OR if Console Text field is null in both System Options and Edit Mode. 
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3. Display only console text from Console Text field if logo Path is null. 
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Changes To Standard R12 Treeview 

The Standard R12 Treeview has been updated and all the applications are now categorized under 
specific Treeview groupings. For example, the “FINANCIALS” grouping contains applications such as 
GL, AP, and AR. This update makes the R12 Treeview more compact when users launch the 
console. 

 

 

NOTE: Dashboard screens previously located under the Query menu in each of the system’s 
applications are obsolete and no longer included in the updated R12 Treeview. For example, the 
Dashboard screen previously located under General Ledger > Query > Dashboard is obsolete and 
will no longer appear.  
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Standard ADF Menu Changes 

The ADF Logs and Queries will be removed from the Standard Menu as of patch V12-11-01.  

This change will only impact customers using the R12STDMENU, specifically the GL, AP and AR 
modules. Customers who have implemented custom ADF menus will see no change to their menu.  

If customers prefer to use the ADF Logs and Queries they can still switch their console to use the 
V10XSTDMENU menu. Alternatively, users can create a hybrid menu in Tree View Builder which can 
include both BI Queries and ADF Logs/Queries. 

The BI Queries being implemented have the same (or very similar) features as the ADF 
Logs/Queries. Using BI Queries, users will also gain some additional features like Subtotals, 
Groupings, Pivots and Drilldowns. Users will still have the flexibility to send to Excel, and PDF for 
output with no formatting constraints. 
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NOTE: 

Admins must assign BI Queries to the appropriate enterprise security roles. Only users who have 
been assigned these roles will be able to view the BI Query. This can be done using the Assign Roles 
to BI Dashboard, or mass security updates can be accomplished in Analytics. 

List of BI Queries Included in R12STDMENU 

General Ledger Accounts Payable Accounts Receivable 

GL Dashboard 1 
Chart of Accounts 
Account Balances 
Transaction Listing 
Activity by Month 
Activity by Account 

Dashboard 1 
Vendors 
Invoices 
Checks 
Aged Payable Summary 
Aged Payable Detail 

Dashboard 1 
Customers 
Invoices 
Cash Receipts 
Aged Receivables 
Summary  
Aged Receivable Detail 

Assign Roles to BI Queries Via ADF 
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Assign Roles to BI Queries via Analytics Canvas 

 

Export Queue (21.46306) 

Overview 

CMiC has developed a new Export Queue screen, which is a read-only log or program that displays 
information about exports, either launched from the toolbars or other programs and logs. 

Pre-requisites 

Add the new Export Queue screen (Pgm: SDEXPORTQUEUE) to the menu. The Target is called 
“SYS-Export Queue to call program SDEXPORTQUEUE”. We recommend adding it as a menu item 
under System Data > Utilities.  

After the screen has been added, export any file. 

Modifications 

Created a new screen called Export Queue (Pgm: SDEXPORTQUEUE) that can be added to the 
menu. This screen will provide the following information about file(s) being exported: 
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Session ID, user, module/application code, program that initiated the exported data, view/table name, 
number of exported rows, date and time export requested, date and time export started, date and 
time export completed, and status (PENDING, RUNNING, COMPLETED). 

The export status messages are defined as follows: 

• Pending: File export has been submitted but export has not started. 

• Running: File export process has started. 

• Completed: File export completed successfully.   

  

 

 

Implementation 

The following screenshots show how export information is displayed in the Export Queue screen 
when file exports are in process. In this example, two users are exporting employee profile details 
from their toolbar, so the Export Queue screen lists both users running the export file 
“DA.PY#EMPLOYEE_PROFILE”.  

In the first screenshot, the status for user “HADR12” is initially “PENDING”, and the status for user 
“ZohrehR12” is “RUNNING”. 

 

After the files are successfully exported, the status for both users changes to “COMPLETED”. 
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Vendor Prequalification 

Additional Fields in Safety and Surety Sections (18.49562) 

Subcontractor prequalification (including Self Service) – The following fields have been added: 

Safety tab 

Safety Manager Name,  

Phone, Email,  

Comment One and Comment Two (not in Self Service)  

Surety tab 

Broker Email  

 

Field security can be applied to these fields in both the Subcontractors and Self Service screens.  By 
default, the field security is set as HIDDEN on the *ALL* role. 

Self Service and Subcontractors – Submitted By, Submitting 
Company etc. (19.92096)  

The following enhancements have been  made to the Vendor Prequalification  Self Service and 
Subcontractors screens: 
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- Added [Is Submitting Parent Company Financials] checkbox to Financial tabs and Financial 
Information on Subcontractor and Self-Service Screen respectively. It can be controlled by Field 
Security  - Hidden,Unrestricted and Read Only. 

 

 

 

 

\ 
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- Added "Submitted By" and "Title" input fields to the header in Subcontractor Screen and to Page 
7 in Self Service sceen. It can be controlled by Field Security  - Hidden,Unrestricted and Read 
Only. 
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- Added System and Active Flag columns from newly created Checklist Type table. 

- Added Checklist Maintenance functionality. Checklist Maintenance(New JSP screen) button is 
visible on Prequalification Control screen. It can be controlled by Field Security  - Hidden and 

Unrestricted. 

 

-  Checklist can be added and edited for :  

 1) Insurance Information on Page 3  

 2) Safety Information on Page 3 

 3)  Litigation Information on Page 5 
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Work Order Billing 

Work Order Entry – Job Template and Address Type Definitions 
(15.11677) 

Overview: 

Ability to using the ‘address code’ of a business partner, instead of the location code in Work Order 
Billing module. 

Also added a job template maintenance program to create customer specific templates and used 
when creating a new work order. 

Modifications: 

Currently this functionality is applicable to Enterprise Forms Only. The same will be ported to ADF 
versions in the future. 

The changes are visible in the following forms. 

 
1. Work Order Billing > Work Orders > Enter Edit Work Orders (bladmworkorders.fmx) 

2. Work Order Billing > Custom Programs > Work Order Template (bladmworkordert.fmx) 

Users must ensure that the necessary roles are added to the form security as shown below. Users 
may navigate as follows in order to assign roles to the custom form. 
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Once necessary roles are added, the users with the security roles, will be able to access the work 
order template from the custom programs menu as shown. 

The Work Order Template Form: 
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The Work Order Template form provides the ability to maintain templates under a company. 

The Template Code is a mandatory field. But users are advised to populate the values in all the fields 
as necessary in order for the job and the billing contract table columns to be populated with 
necessary values to produce desired output. 

Company Code: Enter or Select a valid company code. 

Template Code: Enter a unique ‘Template’ Code of 10 characters maximum length. 

Customer Code: Enter or Select a valid Customer Code. 

Billing Rate Table: Enter or select a valid billing rate code. 

Invoice Format: Enter or select a valid invoice Format. 

Work Location Code: Enter or select a valid Job Work Location Code. 

Prevailing Wage Sector Code: Enter or select a valid prevailing wage sector Code. 

Prevailing Job Rate Schedule Code: Enter or select a prevailing job rate schedule Code. 

Market Sector:  Enter or select a valid market sector code. 

Job Security Group: Enter a valid job security group 

Enter/Edit Work Orders Form: 
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The Work Order Entry form is modified with the following new fields. 

 
1. Work Order Template Code 

2. Address Type (Drop Down List with values as Customer, Project, All & Null) 

3. Address Code 

4. PO Number 

 
1. Work Order Template Code: 

When creating a new work order, users may select a template code from the field provided.  The 
column values associated with a template will be applied to the work order and visible in some fields 
in the header section of the screen and at database level more columns updated in the job & billing 
contract tables. Once a new work order is committed, users have to re-query the same to make any 
updates. They will find the template field cleared out, as the program does NOT store the template 
code once all the associated values are applied. 

Users may select a different template along the course of a life cycle of a work order, provided the 
billing state of work items is ‘Not Yet Ready to be Billed’. This may be required in some scenarios 
where the customer is not known when the work order is created and hence the need to change the 
customer code later on. 

It must be understood that as long as there are NO un-posted or posted billings generated for a work 
order, users will be allowed to update the billing status back to ‘Not Yet Ready to be Billed’. Once 
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there exists a generated/posted invoice, then users will NOT be allowed to revert back the status. 
Similarly the ‘Template’ filed will be locked once the status is NOT as described above. 

 
2. Address Type: 

The address type drop down list initially is defaulted as NULL when creating a work order. Users may 
select one of the following values. 

a. Customer 

b. Project 

c. All 

d. NULL 

 
3. Address Code 

The address code column works in accordance with the selection made in the ‘address type’ code 
and displays the values differently as required. 

Users must also note that, once a work order is committed and upon re-query the column is cleared 
and NULL. The address type simply controls the selection of the address code field and once 
committed, the type is cleared. 

When the address type is, 

 
a) Customer – the ‘Address Code’ field LOV will contain only business partner alternate address 

codes. 

b) Project – The selection of project code, along with the ‘Project’ field where a valid PM Project 

code for the customer exists and is selected, will allow the selection of a the ‘Location’ code from 

the global tables. Once the location code is selected, the system will automatically populate the 

address code associated with the location code. Users must note that the address code field is 

display only as the relationship with location code is 1 to 1 and that users will not be able to select 

any other invalid combination. 

c) All – allows the users to select all address codes from the global tables 

d) NULL – When the address type is null and the address code is left as NULL, the system simply 

populated the ‘customer’ address into the relevant table columns. 

 
4. PO Number 

This is a free form field for reference purposes only. Users may enter any applicable PO Number 
related to the work order. The maximum length allowed is 11 characters in this field. 

Validations when un-posted or posted invoices exist for a work order. 
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Billing Invoice printing: 
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The invoice above shows the address details are as found in customer address code from the work 
order header. 

NOTE: As the Payroll Related Information are copied from the Template in to the job table, the 
information flow is ensured to payroll timesheet entry as well. 

Work Order template – Additional Modifications (16.18328) 

Overview: 

To make work order template mandatory and to add additional fields. 

Modifications: 

The Work Order Billing Control File is modified with a checkbox to make the use of work order 
template mandatory. 
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Work Order Billing > Control File (bladmctrlfm.fmx) 

The default value is set as ‘N’ (un-checked). 

When checked, during work order entry, system will force the user to apply a template.  
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Also added a field ‘Default Payroll Overhead Group’ to work order template maintenance screen. 

 

Work Order Billing > Custom programs > Work Order Template (bladmworkordert.fmx) 
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Users may verify in the Job Entry (User must have the privilege set in order to see this in Job Entry) 
that the newly added ‘Payroll Overhead Group field is populated from the template. 

Ability to Select Projects Irrespective of the Customer in W.O.B 
(20.30792) 

Overview 

In W.O.B, projects are visible based on the customer selected. This new flag will give user the ability 
to select project irrespective of the customer selected in work order.  

Pre-requisites 

• ‘Show All Customers Projects’ in WOB control file must be checked.  

• By default, the flag is un-checked.  

Modifications 

• Flag ‘Show All Customers Projects’ added in Work Order Billing > Setup > Local Tables > 
Control  

Following screens shows the modifications performed: 

 

Work Order Billing > Setup > Local Tables > Control  

Implementation 

Customer: 1TIME  
Comp: CCC 
0822 Project is visible in Project LOV based upon the customer. 
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Work Order Billing > Work Orders > Enter/Edit Work Order – Project LOV 

 

Checked the ‘Show All Customers Projects’ in W.O.B control file.  

 

Work Order Billing > Setup > Local Tables > Control 

Enter/Edit Work Order  

Customer: 1TIME 

All the projects are visible upon checking the control file flag.  
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Work Order Billing > Work Orders > Enter/Edit Work Order – Project 
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Workflow 

Workflow Notification – Negative Total Remaining Balance in Red 
(19.93016)  

 

In the Workflow Notification screen changes have been made to show the Total Remaining Balance 
values that are negative (i.e. < 0) as red and bold, so that they stand out. 

Compliance Workflow (19.90300) 

This feature incorporates a scheduler set for emails to be sent to users if the Compliance/Insurance 
will soon expire or has expired. This gives the user a notification so that they can renew their 
license/compliance. 

 

1. Pre-requisite 

The Role Maintenance screen should have the field security as Unrestricted for the Notifications 
Defaults tab of the Project Control screen (see 2b below). 

The contact who will receive the email should also have a key player PM Role for that Project. 

 

2. Setup 

a) Workflow 

 Workflow Lookup rules need to be set as follows: 

 Path: Enterprise ADF > Workflow > Setup > Workflow Lookup Rules: 

Compliance After Role 

Compliance Before Role 

Compliance Days After 

Compliance Days Before 

Compliance Sender Email 
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b)  Project Control 

 The Notification Defaults tab of Project Control is used to set up the text that needs to be in 
 the notification email Before Compliance Expiry and After Compliance Expiry  

 

. 

3. Process    

Once the necessary setup is in place, the compliances are checked on Subcontracts by an overnight 
Workflow process.  If the compliances would expire or have expired based on the Compliance Days 
Before and the Compliance Days After set in the Workflow Lookup screen, notifications will be sent to 
the project contacts who are on the projects with the key player role that has been set up in the 
Workflow Lookup screen. 

 Note—Both, the vendor and the contact will receive the email if the setup is correct and the 
 compliance expiration conditions are met. 

 

 Sample notices: 

 BEFORE EXPIRY: 
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AFTER EXPIRY: 
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[Duplicate Record] Button on Resource Lookup Screen (21.42399) 

The [Duplicate Record] button is added to Values pop-up in Resource Lookup screen. When the 
user inserts a new line and clicks [Duplicate Record] button – it duplicates the values from the line 
above.  

 

 

Stopping Quartz Schedule Task Processes before 
Applying Patches 

1.  Stop Schedule Task from Computer Management.  

a. Go to Computer Management through right mouse button click on : 
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b. Choose Quartz task from Task Scheduler Library for patching environment (the name of 
environment can be revealed as part of name of Schedule Task). Press End to be sure the 
Status of Task is “Ready”.   

 

2.  Shut down the java process from Task Manager. 

a. In Task Manager – go to Processes, sort them by Name, select task from the Java ones with 
Command Line containing jdk1.8.0_151 part, press right mouse button on task then press End 
task.    
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3.  In case there are few Quartz Schedule Tasks in the same machine – stop/interrupt all of them. 

After patch will be applied – restart all Quartz Schedule Tasks.  


